Contents

Chapter 1  New Features in This Release .......................... 1
    Conduit Enhancements ........................................... 1
    Conduit Parallel Routing ....................................... 2
    Sloped Piping Enhancements .................................... 4
    Other Building System Enhancements ........................... 6

Chapter 2  Moving from AutoCAD to AutoCAD MEP ................. 9
    AutoCAD to AutoCAD MEP Task Comparisons .................... 9
    Creating Building Systems ...................................... 10
        AutoCAD MEP Workspaces .................................. 11
        Insertion Tools ............................................. 11
        Layer Keying ............................................... 12
    Modifying Building Systems ..................................... 12
        Associative Movement ....................................... 12
        Grips ....................................................... 14
        Snaps ...................................................... 17
    Automating Design Tasks ........................................ 18
        Domain-Specific Ribbons .................................... 19
        Auto Layout ............................................... 19
        Interference Detection ...................................... 19
        Connectivity Checks ........................................ 19
    Working With Sizing and Calculation Tools .................... 20
        Sizing Tools ............................................... 20
Electrical Circuit Manager ................................................. 21
Plumbing Tools .............................................................. 21
Routing Preferences .......................................................... 22
Solution Tips ....................................................................... 23
Creating Accurate Construction Documents ......................... 23
Section Views ..................................................................... 23
Tagging .............................................................................. 24
Labeling and Annotation Scaling ........................................... 25
Layout Symbols ................................................................... 26
Project Management Tools ..................................................... 27
Schedules ........................................................................... 27
Leveraging AutoCAD Knowledge in AutoCAD MEP .................. 28
Working with AutoCAD Commands in AutoCAD MEP ............... 28
ALIGN .............................................................................. 29
ARRAY .............................................................................. 30
BREAK ............................................................................. 30
CHAMFER ........................................................................ 31
COPY ............................................................................... 31
ERASE ............................................................................. 31
EXPLODE ......................................................................... 32
EXTEND ........................................................................... 32
FILLET ............................................................................... 33
JOIN ................................................................................ 34
LENGTHEN ....................................................................... 34
MATCHPROP ..................................................................... 35
MIRROR ............................................................................ 35
MOVE ............................................................................... 35
OFFSET ............................................................................ 36
PURGE ............................................................................. 36
ROTATE and ROTATE3D .................................................... 37
SCALE ............................................................................... 37
STRETCH ......................................................................... 38
TRIM ................................................................................ 38
Help Resources ..................................................................... 39

Chapter 3  Getting Started ...................................................... 41
About AutoCAD MEP ............................................................ 41
AutoCAD MEP Workflow ..................................................... 42
Intelligent Objects ................................................................. 43
Location of Part Catalogs ....................................................... 44
Analysis Tools ..................................................................... 45
Project Management Tools ..................................................... 45
Contacting Autodesk ............................................................. 46
Getting Help ........................................................................ 47
Training .............................................................................. 47
Discussion Groups ................................................................. 47
<table>
<thead>
<tr>
<th>Chapter 4</th>
<th>Drawing Essentials</th>
<th>99</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawing Preferences</td>
<td>99</td>
<td></td>
</tr>
<tr>
<td>About Layout Preferences</td>
<td>99</td>
<td></td>
</tr>
<tr>
<td>Initialization Preferences</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>Specifying Part Catalogs and Style-Based Content</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>Locations</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>Layout Rules</td>
<td>103</td>
<td></td>
</tr>
<tr>
<td>Defining System Elevations</td>
<td>106</td>
<td></td>
</tr>
<tr>
<td>Configuring Tooltip Settings</td>
<td>107</td>
<td></td>
</tr>
<tr>
<td>AutoCAD MEP Snaps</td>
<td>107</td>
<td></td>
</tr>
<tr>
<td>Mechanical, Electrical, and Plumbing Equipment in Building Systems</td>
<td>110</td>
<td></td>
</tr>
<tr>
<td>About Electrical Equipment</td>
<td>111</td>
<td></td>
</tr>
<tr>
<td>About Pipe Equipment</td>
<td>112</td>
<td></td>
</tr>
<tr>
<td>About Mechanical Equipment (HVAC)</td>
<td>113</td>
<td></td>
</tr>
<tr>
<td>About Plumbing Equipment and Fixtures</td>
<td>114</td>
<td></td>
</tr>
<tr>
<td>Working with Catalog-Based Content</td>
<td>115</td>
<td></td>
</tr>
<tr>
<td>How Catalog Parts are Stored and Referenced</td>
<td>117</td>
<td></td>
</tr>
<tr>
<td>How Catalog Parts Are Defined</td>
<td>119</td>
<td></td>
</tr>
<tr>
<td>Part Sizes</td>
<td>119</td>
<td></td>
</tr>
<tr>
<td>Default Parts</td>
<td>122</td>
<td></td>
</tr>
<tr>
<td>Importing a Building Component into AutoCAD MEP</td>
<td>123</td>
<td></td>
</tr>
<tr>
<td>Working with Style-Based Content</td>
<td>124</td>
<td></td>
</tr>
<tr>
<td>How Style-Based Content is Stored and Referenced</td>
<td>126</td>
<td></td>
</tr>
<tr>
<td>Orthographic and Isometric Views of Style-Based Content</td>
<td>127</td>
<td></td>
</tr>
<tr>
<td>Working with Tool Palettes</td>
<td>129</td>
<td></td>
</tr>
<tr>
<td>Opening the Tool Palette Set</td>
<td>130</td>
<td></td>
</tr>
<tr>
<td>Changing the Active Group in the Tool Palette Set</td>
<td>130</td>
<td></td>
</tr>
<tr>
<td>Modifying the Appearance of the Tool Palette Set</td>
<td>131</td>
<td></td>
</tr>
<tr>
<td>Docking the Tool Palette Set</td>
<td>131</td>
<td></td>
</tr>
<tr>
<td>Hiding the Tool Palette Set</td>
<td>132</td>
<td></td>
</tr>
<tr>
<td>Adjusting the Transparency of the Tool Palette Set</td>
<td>132</td>
<td></td>
</tr>
<tr>
<td>Modifying the Appearance of Tools</td>
<td>133</td>
<td></td>
</tr>
<tr>
<td>Working with the Properties Palette</td>
<td>135</td>
<td></td>
</tr>
<tr>
<td>Opening the Properties Palette</td>
<td>135</td>
<td></td>
</tr>
<tr>
<td>Modifying Object Properties Using the Properties Palette</td>
<td>136</td>
<td></td>
</tr>
<tr>
<td>Modifying Display Properties Using the Properties Palette</td>
<td>136</td>
<td></td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>Modifying the Appearance of the Properties Palette</td>
<td>136</td>
<td></td>
</tr>
<tr>
<td>Docking the Properties Palette</td>
<td>136</td>
<td></td>
</tr>
<tr>
<td>Hiding the Properties Palette</td>
<td>136</td>
<td></td>
</tr>
<tr>
<td>Adjusting the Transparency of the Properties Palette</td>
<td>137</td>
<td></td>
</tr>
<tr>
<td>Working with Systems</td>
<td>138</td>
<td></td>
</tr>
<tr>
<td>About System Groups</td>
<td>140</td>
<td></td>
</tr>
<tr>
<td>Creating Systems</td>
<td>141</td>
<td></td>
</tr>
<tr>
<td>Specifying the Design Rules of a System</td>
<td>143</td>
<td></td>
</tr>
<tr>
<td>Specifying the Rise/Drop Style of a System</td>
<td>145</td>
<td></td>
</tr>
<tr>
<td>Specifying the Display Properties of a System</td>
<td>146</td>
<td></td>
</tr>
<tr>
<td>Attaching Notes and Files to a System</td>
<td>147</td>
<td></td>
</tr>
<tr>
<td>Copying Systems Between Drawings</td>
<td>148</td>
<td></td>
</tr>
<tr>
<td>Purging Systems</td>
<td>149</td>
<td></td>
</tr>
<tr>
<td>Designing Parallel Routing Systems</td>
<td>150</td>
<td></td>
</tr>
<tr>
<td>Selecting a Display Configuration</td>
<td>151</td>
<td></td>
</tr>
<tr>
<td>Essentials of Objects</td>
<td>152</td>
<td></td>
</tr>
<tr>
<td>Object Types</td>
<td>154</td>
<td></td>
</tr>
<tr>
<td>Selecting Objects</td>
<td>157</td>
<td></td>
</tr>
<tr>
<td>Filtering Objects</td>
<td>158</td>
<td></td>
</tr>
<tr>
<td>Justification of Objects</td>
<td>160</td>
<td></td>
</tr>
<tr>
<td>Matching Part Properties</td>
<td>163</td>
<td></td>
</tr>
<tr>
<td>Matching Style and Display Properties</td>
<td>169</td>
<td></td>
</tr>
<tr>
<td>Working with Connected Objects</td>
<td>171</td>
<td></td>
</tr>
<tr>
<td>Viewing Connection Details</td>
<td>172</td>
<td></td>
</tr>
<tr>
<td>Modifying Connected Objects Along a Run</td>
<td>174</td>
<td></td>
</tr>
<tr>
<td>Working with Anchors</td>
<td>176</td>
<td></td>
</tr>
<tr>
<td>Attaching Objects with a Curve Anchor</td>
<td>177</td>
<td></td>
</tr>
<tr>
<td>Attaching Objects with a System Anchor</td>
<td>178</td>
<td></td>
</tr>
<tr>
<td>Attaching Objects with a Reference Anchor</td>
<td>179</td>
<td></td>
</tr>
<tr>
<td>Rotating Objects Attached with Curve Anchors</td>
<td>180</td>
<td></td>
</tr>
<tr>
<td>Releasing Anchored Objects</td>
<td>180</td>
<td></td>
</tr>
<tr>
<td>Part Anchors</td>
<td>181</td>
<td></td>
</tr>
<tr>
<td>Using the Compass</td>
<td>182</td>
<td></td>
</tr>
<tr>
<td>Customizing the Compass Display</td>
<td>185</td>
<td></td>
</tr>
<tr>
<td>Designing with Dynamic Input and Grips</td>
<td>186</td>
<td></td>
</tr>
<tr>
<td>Dynamic Input</td>
<td>186</td>
<td></td>
</tr>
<tr>
<td>Grip Tooltips</td>
<td>187</td>
<td></td>
</tr>
<tr>
<td>Grip Constraints</td>
<td>188</td>
<td></td>
</tr>
<tr>
<td>Trigger Grips</td>
<td>188</td>
<td></td>
</tr>
<tr>
<td>Grip Editing Modes</td>
<td>189</td>
<td></td>
</tr>
<tr>
<td>Drafting with Flow Direction</td>
<td>190</td>
<td></td>
</tr>
<tr>
<td>Regenerating an AutoCAD MEP Model</td>
<td>193</td>
<td></td>
</tr>
<tr>
<td>Viewing Part Properties</td>
<td>193</td>
<td></td>
</tr>
<tr>
<td>Basic Part Information</td>
<td>193</td>
<td></td>
</tr>
<tr>
<td>System Assignments for Parts and Connectors</td>
<td>195</td>
<td></td>
</tr>
<tr>
<td>Part Styles</td>
<td>195</td>
<td></td>
</tr>
</tbody>
</table>
# Chapter 5  Working with Projects

- Working with Drawing Management Projects ........................................ 199
- Establishing Project Standards ....................................................... 201
- AutoCAD MEP Layer Standards ....................................................... 203
  - Layer Standards Overview .......................................................... 203
    - Layer Standards ........................................................................ 204
    - Layer Key Styles and Layer Keys .............................................. 205
    - Layer Standards Drawing .......................................................... 205
    - Layer Properties Manager ......................................................... 206
- Specifying a Layer Standard and a Layer Key Style ......................... 206
- Accessing Layer Key Styles and Layer Keys .................................... 207
- AutoCAD MEP Displays .................................................................... 208
  - Display System Structure ............................................................. 208
    - Display Representations ........................................................... 211
    - Display Sets ............................................................................. 214
    - Display Configurations ............................................................. 214
  - Hierarchy of Display Control ......................................................... 217
    - Managing Display Settings During Project Setup ....................... 218
    - Configuring Display Settings During Design .............................. 221
  - Display of Objects Based on Elevation ......................................... 223
    - Workflow for Displaying Objects Based on Elevation ................. 226
    - Enabling the Elevation-Based Display Components .................... 227
    - Specifying the Cut Plane and Display Range for a Display ... 228
      - Configuration ........................................................................ 228
    - Configuring Elevation-Based Display Components ................... 230
    - Modifying Elevation-Based Display Components on the Properties Palette .......................................................... 231
    - Overriding the Cut Plane .......................................................... 232
  - Display of Crossing Objects in 2-Line Plan Views ......................... 234
    - Configuring the Display of a Gap Between Crossing Objects .... 234
    - Modifying Hidden Lines for Objects .......................................... 235
  - Display of Center Lines on Ducts ................................................ 236
  - Display of a Hatching Pattern to Identify a Duct System .............. 238
  - Display of Objects by Classification ............................................ 239
  - Adding Custom Graphics as a Display Component ....................... 239
  - Troubleshooting Object Display .................................................. 241
- AutoCAD MEP Templates ................................................................. 241
  - Default Drawing Templates ........................................................ 241
  - Creating a Custom Template from a Template or Drawing .......... 243
  - Creating a Custom Template ....................................................... 244
- Working with Referenced Drawings ................................................. 245
  - Attaching or Overlaying Xrefs ..................................................... 246
Chapter 6  **Drawing HVAC Systems**  

HVAC System Overview  
  Workflows  
    Mechanical System Workflow  
    Duct System Workflow  
    Workflow for Using Spaces for Load Analysis  
    Workflow for Calculating Duct Sizes to Optimize Duct System Designs  
HVAC System Settings  
  Duct System Definitions  
  Drawing Ductwork  
    Flexible Duct Runs  
    Auto Layout  
    Multi-Floor Duct Systems in Referenced Drawings  
  Takeoffs  
  Duct Snaps  
  Duct Grips  
    Add Grips  
    Grips for Modifying a Duct Run  
  Duct Elevation Lock  
  Duct Sizing Methods and Tools  
    Duct Sizing Methods  
    Duct Sizing Tools  
    Duct Size Calculator  
    Instant Duct Sizing  
Configuring Duct System Settings  
  Configuring Duct Layout Preferences  
    Configuring Justification for Duct Insertion  
    Configuring Sloped Duct  
    Breaking Duct at Even Intervals During Layout  
    Configuring the Display of Turning Vanes and Flanges  
    Configuring Flexible Duct Preferences  
    Configuring Duct Part Preferences  
    Configuring Duct Connections  
    Applying Insulation or Lining on Duct  
    Applying Label or Flow Arrow Styles to Ducts  
  Configuring Duct System Definitions  
    Creating a Duct System Definition  
    Specifying a Calculation Method for Duct Sizing  
Creating a Duct System  
  Adding HVAC Equipment
Placing a Duct MvPart in a Drawing ........................................ 290
Adding Parts In-Line to Ducts .............................................. 291
Configuring Mechanical Parts for Analysis ........................... 291
Adding Duct ................................................................. 292
Drawing a Duct Run .......................................................... 292
Adding Duct Using Grips ...................................................... 298
Drawing a Vertical Duct Run .................................................. 299
Drawing I-Line Duct ............................................................ 299
Calculating Duct Sizes for a Duct System .............................. 302
Adding a Duct Fitting Manually ............................................. 304
Drawing Flexible Duct ........................................................ 306
Adding a Parallel Duct Run ................................................... 307
Offsetting Duct from Existing Geometry ................................. 308
Drawing Sloped Duct .......................................................... 308
Using the Elevation Lock ...................................................... 309
Connecting Ducts Through Referenced Drawings ....................... 310
Adding a Takeoff to a Duct ................................................... 310
Converting a Line to Duct .................................................... 313
Converting a Polyline, Line, Arc, or Spline to Flexible Duct ......... 313
Adding Turning Vanes to Fittings ........................................... 314
Creating a Custom Duct Fitting ............................................. 316
Using the Part Size Not Found Dialog .................................... 318
Adding a Label or Flow Arrow to Duct .................................... 318
Adding a Hatching Pattern to Identify a Duct System .................. 320
Using Spaces for Load Analysis ............................................. 320
Specifying Space Styles ...................................................... 321
Configuring Space Styles .................................................... 321
Viewing Classification Definitions for Occupant Densities and Air Flows ......................................................... 323
Configuring Zone Styles ...................................................... 323
Adding Spaces to a Floor Plan ................................................. 324
Recommendations for Floor Plans .......................................... 324
Modeling Openings on Spaces .............................................. 325
Modeling Surface Types on Spaces ........................................ 326
Adding Engineering Data to Spaces ....................................... 326
Attaching Property Sets to Zones .......................................... 329
Attaching Spaces to Zones ................................................... 330
Exporting Zones for Load Analysis ........................................ 331
Reviewing Spaces and Zones ................................................. 332
Importing Load Analysis Results ............................................ 334
Using Space and Zone Calculated Data ................................... 335
Calculating Duct Sizes to Optimize Duct System Designs .............. 336
Specifying ASHRAE Fitting Types .......................................... 336
Considerations Prior to Exporting Duct System Data ................... 338
Exporting Duct System Data ................................................ 339
Chapter 7 Drawing Piping Systems 365

Pipe Systems Overview 365
Workflow for Designing a Pipe System 365
Pipe Routing Preferences 367
Auto Layout 370
Routing Solutions 371
Guidelines for Constrained Layout Solutions 372
Sloped Piping 373
Pipe System Definitions 376
Pipe System Displays 377
1-Line Display 378
Graphical 1-Line Display 379
2-Line Display 380
Straight Centerline Display of Elbows 380
Placeholder Parts 381
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pipe Parts Catalog</td>
<td>381</td>
</tr>
<tr>
<td>Pipe Grips</td>
<td>385</td>
</tr>
<tr>
<td>Add Grips</td>
<td>385</td>
</tr>
<tr>
<td>Grips for Modifying a Pipe Run</td>
<td>387</td>
</tr>
<tr>
<td>Pipe Connections</td>
<td>399</td>
</tr>
<tr>
<td>Pipe Connectors</td>
<td>399</td>
</tr>
<tr>
<td>Connector Assignments</td>
<td>400</td>
</tr>
<tr>
<td>Connection Types for Pipe and Pipe Fittings</td>
<td>401</td>
</tr>
<tr>
<td>Male-Female Fittings and Joint Direction</td>
<td>403</td>
</tr>
<tr>
<td>Pipe Joints</td>
<td>405</td>
</tr>
<tr>
<td>Pipe Length and Cut Length</td>
<td>406</td>
</tr>
<tr>
<td>Pipe Snaps</td>
<td>409</td>
</tr>
<tr>
<td>Pipe Elevation Lock</td>
<td>409</td>
</tr>
<tr>
<td>Configuring Pipe System Settings</td>
<td>411</td>
</tr>
<tr>
<td>Configuring Routing Preferences</td>
<td>411</td>
</tr>
<tr>
<td>Creating or Copying a Routing Preference</td>
<td>411</td>
</tr>
<tr>
<td>Configuring Properties for a Routing Preference</td>
<td>412</td>
</tr>
<tr>
<td>Configuring Size Ranges</td>
<td>412</td>
</tr>
<tr>
<td>Deleting a Routing Preference</td>
<td>414</td>
</tr>
<tr>
<td>Configuring System Definitions</td>
<td>414</td>
</tr>
<tr>
<td>Creating a System Definition</td>
<td>414</td>
</tr>
<tr>
<td>Configuring System Definitions for 1-Line, 2-Line, or Single Line Graphics</td>
<td>415</td>
</tr>
<tr>
<td>Configuring Graphics for Single Line Pipe Display</td>
<td>417</td>
</tr>
<tr>
<td>Configuring the Straight Centerline Display of Elbows</td>
<td>419</td>
</tr>
<tr>
<td>Creating a Piping System</td>
<td>419</td>
</tr>
<tr>
<td>Pipe Properties Palette (Add Mode)</td>
<td>420</td>
</tr>
<tr>
<td>Basic Properties</td>
<td>420</td>
</tr>
<tr>
<td>Advanced Properties</td>
<td>424</td>
</tr>
<tr>
<td>Adding Pipe Equipment</td>
<td>427</td>
</tr>
<tr>
<td>Placing a Pipe MvPart in a Drawing</td>
<td>428</td>
</tr>
<tr>
<td>Adding Parts In-Line to Pipe</td>
<td>428</td>
</tr>
<tr>
<td>Adding Pipe</td>
<td>429</td>
</tr>
<tr>
<td>Adding Pipe from the Tool Palette</td>
<td>429</td>
</tr>
<tr>
<td>Configuring Basic Pipe Properties</td>
<td>431</td>
</tr>
<tr>
<td>Configuring Pipe Layout Preferences</td>
<td>432</td>
</tr>
<tr>
<td>Configuring Justification for Pipe Insertion</td>
<td>438</td>
</tr>
<tr>
<td>Specifying Cut Length</td>
<td>438</td>
</tr>
<tr>
<td>Drawing a Pipe Run</td>
<td>439</td>
</tr>
<tr>
<td>Adding Pipe Using Add Grips</td>
<td>445</td>
</tr>
<tr>
<td>Manually Specifying Parts During Layout</td>
<td>447</td>
</tr>
<tr>
<td>Using Routing Solutions to Connect Objects</td>
<td>450</td>
</tr>
<tr>
<td>Adding a Pipe Fitting Manually</td>
<td>452</td>
</tr>
<tr>
<td>Creating a Custom Pipe Fitting</td>
<td>454</td>
</tr>
<tr>
<td>Drawing Sloped Piping</td>
<td>455</td>
</tr>
<tr>
<td>Drawing a Flexible Pipe Run</td>
<td>457</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Specifying Alignment for Cable Tray Insertion</td>
<td>555</td>
</tr>
<tr>
<td>Specifying the Slope for Cable Tray</td>
<td>556</td>
</tr>
<tr>
<td>Breaking Cable Tray at Even Intervals</td>
<td>556</td>
</tr>
<tr>
<td>Specifying Annotation for Cable Tray</td>
<td>557</td>
</tr>
<tr>
<td>Specifying Default Parts for Cable Tray</td>
<td>558</td>
</tr>
<tr>
<td>Configuring Connections for Cable Tray</td>
<td>559</td>
</tr>
<tr>
<td>Configuring Layout Preferences for Conduit</td>
<td>560</td>
</tr>
<tr>
<td>Working with Circuits</td>
<td>562</td>
</tr>
<tr>
<td>Using an Electrical Project Database</td>
<td>562</td>
</tr>
<tr>
<td>How the Electrical Project Database Works</td>
<td>563</td>
</tr>
<tr>
<td>Creating an Electrical Project Database</td>
<td>564</td>
</tr>
<tr>
<td>Linking to the Electrical Project Database</td>
<td>565</td>
</tr>
<tr>
<td>Reloading the Electrical Project Database</td>
<td>566</td>
</tr>
<tr>
<td>Unlinking From the Electrical Project Database</td>
<td>568</td>
</tr>
<tr>
<td>Using Circuits</td>
<td>568</td>
</tr>
<tr>
<td>Creating Circuits Using the Circuit Manager</td>
<td>569</td>
</tr>
<tr>
<td>Configuring a Circuit</td>
<td>571</td>
</tr>
<tr>
<td>Viewing Details in the Circuit Manager</td>
<td>572</td>
</tr>
<tr>
<td>Linking Panels</td>
<td>573</td>
</tr>
<tr>
<td>Managing Circuits in a Project</td>
<td>576</td>
</tr>
<tr>
<td>Creating Electrical Systems</td>
<td>576</td>
</tr>
<tr>
<td>Adding Devices</td>
<td>577</td>
</tr>
<tr>
<td>Configuring the Electrical Connectors of a Device</td>
<td>583</td>
</tr>
<tr>
<td>Example: Aligning a Device to Floor Plan Geometry</td>
<td>588</td>
</tr>
<tr>
<td>Example: Adding Devices at a Specific Distance</td>
<td>589</td>
</tr>
<tr>
<td>Example: Adding a Specific Number of Devices</td>
<td>592</td>
</tr>
<tr>
<td>Example: Inserting a Device into a Wire</td>
<td>595</td>
</tr>
<tr>
<td>Adding Panels</td>
<td>596</td>
</tr>
<tr>
<td>Example: Aligning a Panel to Floor Plan Geometry</td>
<td>604</td>
</tr>
<tr>
<td>Copying Devices and Panels</td>
<td>605</td>
</tr>
<tr>
<td>Example: Copying a Device</td>
<td>608</td>
</tr>
<tr>
<td>Example: Copying a Panel</td>
<td>609</td>
</tr>
<tr>
<td>Adding Wires</td>
<td>611</td>
</tr>
<tr>
<td>Drawing or Generating Wires</td>
<td>611</td>
</tr>
<tr>
<td>Drawing a Home Run</td>
<td>619</td>
</tr>
<tr>
<td>Creating a Wire from a Polyline</td>
<td>620</td>
</tr>
<tr>
<td>Adding Electrical Equipment</td>
<td>620</td>
</tr>
<tr>
<td>Adding Cable Trays and Conduits</td>
<td>622</td>
</tr>
<tr>
<td>Drawing a Cable Tray or Conduit Run</td>
<td>625</td>
</tr>
<tr>
<td>Adding Conduit or Cable Tray Using Grips</td>
<td>629</td>
</tr>
<tr>
<td>Adding a Cable Tray or Conduit Branch</td>
<td>631</td>
</tr>
<tr>
<td>Drawing a Parallel Conduit Run</td>
<td>632</td>
</tr>
<tr>
<td>Adding Cable Tray or Conduit Fittings Manually</td>
<td>638</td>
</tr>
<tr>
<td>Checking Electrical Systems</td>
<td>639</td>
</tr>
<tr>
<td>Calculating Wire Sizes Using the Circuit Manager</td>
<td>640</td>
</tr>
</tbody>
</table>
Chapter 10 Drawing Plumbing Systems ........................................................................... 697

Plumbing Design Workflow ......................................................................................... 697
Adding an Expansion Loop to a Plumbing Run .......................... 738
Modifying Plumbing Systems ........................................... 739
Modifying Plumbing Equipment and Fixtures ......................... 739
Calculating the Slope of a Plumbing Line .............................. 741
Modifying Plumbing Lines and Fittings Using Grips ................. 743
Moving Plumbing Lines and Fittings .................................... 743
Modifying the Length of Plumbing Lines ............................... 744
Rotating Plumbing Fittings .............................................. 745
Modifying Plumbing Lines and Fittings ................................. 746
  Modifying the System Assigned to a Plumbing Line or Fitting .... 746
  Reversing the Flow of a Plumbing Run .............................. 747
  Modifying the Elevation of a Plumbing Line or Fitting .......... 747
  Modifying the Location Coordinates of a Plumbing Line or Fitting ......................................................... 748
  Modifying the Nominal Size of a Plumbing Line Segment ....... 749
  Modifying the Style of a Plumbing Line or Fitting ............... 749
Calculating the Sizes of Supply Plumbing Lines ...................... 750
Sizing Supply Plumbing Lines ......................................... 750
Reviewing the Sizing Results for Supply Plumbing Lines .......... 752
  Calculations for the Longest Run .................................. 753
  Calculations at Selected Component ............................... 755
How the Software Performs Calculations to Size Plumbing Lines ............................................................. 759
Calculating the Sizes of Sanitary Plumbing Lines .................... 760
Overview of Sizing Sanitary Plumbing Lines .......................... 761
  Sanitary Branch Sizing .............................................. 761
  Sanitary Offset Sizing ............................................ 762
  Sanitary Stack Sizing ............................................. 764
Sizing Sanitary Plumbing Lines ........................................ 764
Sizing Sanitary Plumbing Lines for Multiple Floors ................ 765
Reviewing the Sizing Results for Sanitary Plumbing Lines ........ 768

Chapter 11  Drawing Schematic Diagrams .............................. 771
About Schematic Diagrams ............................................... 772
Schematic Lines ................................................................ 773
Schematic Symbols ................................................................ 774
Drawing in Orthographic Mode ........................................... 775
Drawing in Isometric Mode ................................................. 776
Customizing Schematic Content ......................................... 777
Configuring Schematic Settings ......................................... 777
  Creating Schematic System Definitions ......................... 777
  Configuring Styles for Schematic Lines ......................... 778
    Defining Designations for Schematic Line Styles ............. 779

xviii  Contents
Creating a Section View ........................................ 848
Creating an Elevation View ..................................... 852
Updating a Section or Elevation View ......................... 856
Sheets ...................................................................... 857
Creating a Sheet ..................................................... 857
Creating a Cover Sheet ............................................. 859
Ordering Sheets in the Sheet Set ............................... 859
Publishing a Sheet Set to DWF™ ............................... 860
Adding Elevation Labels ........................................... 860
Checking Your Drawings .......................................... 861
Showing Solution Tips ............................................. 862
Showing Connected Runs ......................................... 864
Showing Connected Objects ..................................... 865
Finding Interferences .............................................. 865
Running Interference Detection ............................... 866
Viewing and Resolving Interferences ........................ 868
Tagging Interferences or Openings .......................... 870
Exiting Interference Detection ................................. 872
Excluding a Material from 2D Section Shrinkwrap ....... 872
Collecting Project Data ........................................... 874
Defining Property Set Definitions ............................. 875
Defining Property Set Data ....................................... 876
Using Classifications .............................................. 877
Copying a Schedule Table Style ............................... 877
Purging AutoCAD MEP Objects ............................... 878
Sharing Drawings .................................................. 878
Displaying Custom Objects ..................................... 879
Object Enablers ..................................................... 879
Proxy Graphics ..................................................... 879
Export to AutoCAD ............................................... 880
Posting and Plotting Your Drawings ......................... 881
Plotting ............................................................... 881
Comparing Drawings .............................................. 881
Using Industry Foundation Classes .......................... 882
Select a Style ......................................................... 888

Chapter 13 Customizing Style-Based Content .............. 891
Workflow for Creating Style-Based Content .................. 891
Creating a Style-Based Content Library ..................... 892
Creating the Blocks for a Style ............................... 893
Creating a Style .................................................. 894
Editing Style-Based Content ................................... 896
Configuring Styles ................................................ 896
Specifying the Design Rules of a Style ......................... 896
Defining the Views of a Style ................................... 898
Starting Content Builder for Creating a Parametric MvPart ................................................. 1042
Specifying the Part Configuration of a Parametric MvPart ................................................. 1043
Modeling a Parametric MvPart ............................................................................................... 1045
Adding Connectors to a Parametric MvPart ......................................................................... 1074
Adding Dimensions to a Parametric MvPart ....................................................................... 1081
Generating a Preview Image of a Parametric MvPart ......................................................... 1093
Defining the Part Insertion Behaviors of a Parametric MvPart .......................................... 1094
Validating, Saving, and Previewing a Parametric MvPart .................................................... 1095
Creating a Schematic Symbol of a Parametric MvPart ....................................................... 1098
Modifying Parametric Parts Using Content Builder ............................................................ 1107
Starting Content Builder for Modifying a Parametric Part ................................................. 1108
Working with Block-Based Parts .......................................................................................... 1110
Converting MvBlocks to Block-Based Parts ........................................................................ 1110
Best Practices for Creating a Block-Based Part .................................................................... 1113
Block-Based Part Creation Overview .................................................................................... 1113
3D Model Block for a Block-Based Part ................................................................................ 1113
Schematic Symbol of a Block-Based Part ............................................................................... 1115
Behavior of a Block-Based Part ............................................................................................ 1116
View Blocks of a Block-Based Part ....................................................................................... 1119
Preview Image of a Block-Based Part ................................................................................... 1121
Connectors of a Block-Based Part ........................................................................................ 1122
Property Set Information for a Block-Based Part .................................................................. 1124
Workflow for Creating a Block-Based Part ............................................................................ 1125
Creating Block-Based Parts Using Content Builder ............................................................ 1127
Starting Content Builder for Creating a Block-Based MvPart ........................................... 1131
Defining the Part Behavior of a Block-Based MvPart ............................................................ 1132
Assigning Part Size Names and Views of a Block-Based MvPart ....................................... 1133
Generating a Preview Image of a Block-Based MvPart ....................................................... 1135
Adding Connectors to a Block-Based MvPart ...................................................................... 1136
Adding Property Set Information to a Block-Based MvPart ............................................. 1139
Modifying Block-Based Parts Using Content Builder ........................................................ 1141
Starting Content Builder for Modifying a Block-Based Part ............................................. 1142
Modifying a Block-Based Part ............................................................................................. 1143
Working with Custom Parameter Groups .......................................................................... 1145

xxii | Contents
Chapter 15 Customizing Catalogs ........................................ 1151
  About Catalog Editor ................................................. 1152
  Opening Catalog Editor ............................................. 1153
  Opening a Part Catalog in Catalog Editor ....................... 1154
  Customizing Catalogs in Catalog Editor ....................... 1154
    Working with Part Data in the Tree View .................... 1155
    Working with Part Data in the Table View .................... 1156
    Creating Parts in Catalog Editor ............................. 1158
    Adding Part Sizes in Catalog Editor ......................... 1158
    Adding Custom Data to Parts in Catalog Editor ............. 1160
    Creating Part Catalogs in Catalog Editor ................... 1161
    Working with Part Data in Excel ............................. 1163
  Validating and Regenerating Part Catalogs ..................... 1164
    Validating the Parts in a Catalog ............................ 1164
    Regenerating a Part Catalog .................................. 1165
    Migrating Part Catalogs ....................................... 1167
    Redefining the Catalog Parts in a Drawing .................. 1168

Chapter 16 Customizing AutoCAD MEP ................................. 1171
  Creating Drawing Environment MEP Configurations for Users ...... 1171
  Styles and Support Files ........................................... 1172
  Customizing Tool Palettes ........................................ 1174
    Creating a Tool Palette ...................................... 1174
    Creating a Tool Palette Set .................................... 1175
    Customizing a Tool Palette Set ................................ 1176
      Specifying Different Tool Palettes for the Tool Palette
      Set ....................................................................... 1177
      Renaming the Tool Palette Set ................................ 1177
  Customizing Tools ................................................... 1178
    Creating Tools for Style-Based Content ....................... 1179
    Creating Tools from Routing Preferences ..................... 1181
    Creating Tools from AEC Content in DesignCenter .......... 1182
    Creating Command Tools ........................................ 1183
    Creating Property-Based Tools ................................ 1185
    Changing Tool Properties ........................................ 1185
    Changing Tool Icons ............................................. 1187
    Deleting Tools .................................................... 1188
New Features in This Release

NOTE  AutoCAD® MEP 2011 is built on AutoCAD and AutoCAD Architecture. See the Help systems for those products to learn more about their new features and enhancements.

Conduit Enhancements

AutoCAD MEP features a centralized location for conduit properties and routing preferences.

New Conduit Commands on Properties Palette

Draw new conduit runs or modify existing layouts using the Properties palette on page 528. The Properties palette includes conduit and conduit fitting settings that were originally in the Add and Modify dialogs. Making changes directly on the Properties palette gives you more flexibility in the drawing area for your conduit designs.

Nominal Sizes and Industry-Standard Radius Values for Conduit and Conduit Fittings

AutoCAD MEP supports nominal size (also referred to as trade size) for conduit segments and conduit fittings. Outside diameter and nominal size are now
provided for conduit segments and fittings that support industry-standard radius values.

**Drawing Accurate Conduit Runs**

You can configure conduit routing preferences on page 526 to satisfy variations in industry standards. As a result, the appropriate fittings are automatically inserted into the layout. Auto layout can generate different routing solutions, letting you choose the most appropriate one to suit your requirements.

<table>
<thead>
<tr>
<th>General</th>
<th>Conduit</th>
<th>Part</th>
<th>Part size range</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Conduit</td>
<td>Conduit EMT Set Screw GPM</td>
<td>1/2&quot; to 2 1/2&quot;</td>
</tr>
<tr>
<td></td>
<td>Elbow</td>
<td>Conduit EMT Set Screw GPM</td>
<td>1/2&quot; to 2 1/2&quot;</td>
</tr>
<tr>
<td></td>
<td>Tee</td>
<td>Conduit EMT Set Screw GPM</td>
<td>1/2&quot; to 2 1/2&quot;</td>
</tr>
</tbody>
</table>
|         | Transition - C | Conduit EMT Set Screw GPM | 1/2" to 2 1/2"

**Conduit Parallel Routing**

In AutoCAD MEP you can now design parallel conduit runs on page 632.

**Drawing Parallel Conduit Runs**

Using a single routing as the guide, create a parallel conduit run on page 632 as you design electrical systems. Routing parallel runs ensures that the bend radius values are properly calculated by the software as you make turns and that conflicts in the run can be prevented.
Parallel conduit run

As you draw points along the run, you can specify the type of parallel bend (concentric or fixed radius) on the Conduit Properties palette on page 528. For more information, see Specifying Parallel Bends in the Conduit Run on page 635.

Specifying parallel bend in a parallel run
Making Turns in the Parallel Conduit Run

You can draw parallel conduit runs with 90-degree and non-90-degree turns that automatically calculate the correct radius for each required conduit bend. Additionally, variable radius values are used to maintain consistent spacing.

RELATED See Specifying Parallel Bends in the Conduit Run on page 635.

New Conduit Content

The conduit content has been updated to include separate dimensions for outside diameter. You can also edit conduit size parameters on page 998 in Content Builder.

Sloped Piping Enhancements

The sloped piping feature in AutoCAD MEP expands catalog content and pipe fitting routing preferences on page 367 in support of gravity-based piping designs.

Draw Sloped Piping Layouts

Gravity piping designs now support male-female routing and new content for sanitary drain, waste, vent and sewer/storm drainage systems. Intelligent branch creation accurately orientates tees based on elevation. These
enhancements are designed to improve auto layouts and to satisfy real-world requirements.

**Male-Female Connections**

Additional pipe routing preferences include fittings with male-female connections on page 403. New pipe fittings support additional piping configurations. New content is also available with male, female, or a combination of both types of connectors based on real-world piping requirements.

**Joint Direction**

Joint direction on page 403 determines how male and female connectors on a fitting are oriented in auto layout. If you select male into female, the male connector is orientated to enter into the female connector based on the draw direction, then the female connector after the joint. When adding a branch
to a pipe, tees automatically orientate the male end downward or upward (toward the lower or higher elevation) based on the joint direction.

Transitions, Offset Wyes, and Angled Tees Added to Routing Preferences

AutoCAD MEP supports the design of sloped connections by using offset wyes (laterals) or angled tees to connect a branch to a main. It inserts angled tees/wyes at the correct orientation to connect a sloped branch to a sloped main. You can also choose an eccentric fitting (with different diameter openings at each end with different centerlines) or a concentric fitting (with different diameter openings at each end with the same centerline).

Other Building System Enhancements

The fundamentals for designing accurate building system layouts have been improved in AutoCAD MEP.

Justification of MEP Objects

AutoCAD MEP stores justification on page 160 on 3D segment-based objects, including duct, cable tray, conduit, and pipe. AutoCAD MEP remembers the justification of the object used during layout and updates justification settings when objects are mirrored, regardless of orientation or resizing. Justification is based on the draw direction from connector 1 (start point) to connector 2 (endpoint). 9 options for justification, along with offsets, are available to refine your layout.
**MvPart View Blocks**

Multi-view parts (MvParts) now create and store named AutoCAD blocks inside drawings. This makes it easier to edit the display of MvParts on page 899.

**Rise/Drop Styles**

A rise/drop style specifies the symbols to use in 1-line and 2-line displays of rise conditions and drop conditions on segments and fittings. You can now specify how a rise or drop symbol is displayed on page 914 in the drawing with respect to MvParts, endcaps, or fittings such as elbows, tees, or takeoffs.
AutoCAD MEP, an AutoCAD-based building design solution, enhances AutoCAD functionality with tools designed for mechanical, electrical, and plumbing (MEP) engineers, designers, and drafters. This section describes several features where AutoCAD MEP builds on AutoCAD capabilities for designing building systems.

### AutoCAD to AutoCAD MEP Task Comparisons

The following table contrasts functionality that is available in AutoCAD and AutoCAD MEP.

<table>
<thead>
<tr>
<th>Functionality</th>
<th>In AutoCAD</th>
<th>In AutoCAD MEP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automate sheet management</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Manage and update project standards and deviations</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Edit geometric elements (such as lines, polylines, arcs, and circles)</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Import or export data in DWG, DWF™, IFC, and other formats</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Import or export engineering data in the Green Building Extensible Markup Language (gbXML) format for analysis by third-party tools</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Adjust [annotation](on page 25 style and scaling)</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>
Creating Building Systems

AutoCAD meets the fundamental drafting needs of the AEC, civil engineering, and manufacturing industries. You use basic geometric elements, such as lines, arcs, and circles, to draw engineering layouts.

With AutoCAD MEP, you can create intelligent building systems, functionality that exceeds AutoCAD capabilities. You use MEP parts to create complete, connected systems that contain information you can use to analyze and refine your designs. For example, you can create a duct system on page 290 that contains ceiling diffusers with a specified flow rate. The system can detect the amount of downstream airflow required by the diffusers. You can use sloped piping on page 373 to design gravity-based piping system. You can use circuit features on page 562 to create and manage circuits for your electrical plans. You can place plumbing equipment and fixtures in a drawing to create a plumbing run on page 699.
AutoCAD MEP Workspaces

Out of the box, AutoCAD MEP contains tools geared to mechanical, electrical, and plumbing professionals in the building industry. The workspace environments (electrical, HVAC, piping, plumbing, and schematic) include individual palettes and domain-specific ribbons to optimize your workflow tasks.

Duct system in AutoCAD MEP HVAC workspace

The tool palette includes parts related to the current domain. You can define tool properties from the tool or properties palette. You can also customize the tool palette to include unique tools commonly used in your company’s engineering designs. For more information, see Working with Tool Palettes on page 129 and Customizing Tool Palettes on page 1174.

RELATED See also Workspace Components on page 55.

Insertion Tools

You can use add grips ( ) along with the domain-specific palettes in AutoCAD MEP to add components to your drawings. After adding a part from the tool palette, use add grips on a segment or object to route the pipe,
plumbing, electrical, schematic, or duct system to ensure connectivity along the run. You can draw a run from one end of the part segment, from a midpoint of a part segment, from a multi-view part (called an MvPart), or from a fitting, such as an elbow or a tee. For more information, see Add Grips on page 385.

AutoCAD MEP also lets you automatically insert fittings into a run. For example, AutoCAD MEP can identify the type of elbow fitting to insert into a plumbing layout, based on the preferences defined for the plumbing system. When drawing pipe runs, you can use different routing preferences on page 367 that match your pipe specifications to ensure that the proper fittings are inserted automatically. As you draw conduit on page 526 in the Electrical workspace, the software adds fittings based on the defined preferences.

Layer Keying

As you add parts to your layouts, each object is automatically placed on the correct layer. With layer keying, AutoCAD MEP automatically places an object on a predefined layer that conforms to a particular layer standard. You can modify the layer standards to map to specific company standards. You can also turn layers on or off for a particular system or use filters to disable objects on a particular layer. For more information, see AutoCAD MEP Layer Standards on page 203.

Modifying Building Systems

In AutoCAD, you modify the geometric elements, including lines, arcs, and circles, in your design projects. You use common AutoCAD editing tools, such as COPY, TRIM, and EXTEND.

AutoCAD MEP helps you streamline the task of modifying building systems using techniques such as associative movement, grips, and snaps.

Associative Movement

You can move, shrink, or stretch connected objects (such as part segments and fittings) to a new location in a drawing without breaking the connection between parts or altering other portions of the run.

With associative movement, you use grips to move the connected parts as a single unit while other parts remain in place in the same layout. The software identifies the parts that are connected and maintains their connectivity. The
following illustrations show the progression of the associative movement feature in the Piping domain.

**Moving pipe using location grip**

**Dragging to new location**

**Resulting layout**

**NOTE** Associative movement lets you move objects in the XY plane. You can also modify the elevation of connected parts relative to their top, centerline, or bottom orientation in side and isometric views.
Grips

You can use grips to make direct changes to a part segment in a drawing. Hovering over a grip displays a tooltip describing the grip’s function. Some tooltips also suggest options, such as using the CTRL or ALT keys. For more information, see Designing with Dynamic Input and Grips on page 186.

Several types of grips are available:

- **Add grips** ([+] ) add segments, such as duct, pipe, plumbing line, wire, cable tray, or conduit, to a new or existing run without sacrificing connectivity along the run.

  **Pipe segment**

  ![Pipe segment diagram]

  **Pipe fitting (elbow with flange connections)**

  ![Pipe fitting diagram]

  **Base-mounted pump (MvPart)**

  ![Base-mounted pump diagram]

- **Location grips** ([ ] ) move a component in the current XY plane. Location grips appear at the insertion and connector points on a part.
- **Lengthen grips** change the length of a part segment. Lengthen grips use the segment's current orientation to maintain connectivity in the existing run.

- **Flip grips** switch the orientation of some parts (such as fittings or takeoffs) based on the direction of the grip.
Takeoff selected — Flip grip shown

Orientation flipped

- Diamond-shaped rotate grips (▲) in isometric views rotate an object around its centerline to any angle, if that object has round connectors on opposite ends. Rotate grips are available on parts and fittings that can be rotated without breaking the connection with existing objects.

**Rotating a damper in an isometric view**

- Elevation grips (▲) modify the elevation of part segments in side and isometric views relative to the top, centerline, or bottom of the segment. Elevation grips appear at the insertion and connector points on the specified part segment.
Snaps

AutoCAD MEP includes AutoCAD object snaps and AutoCAD MEP snaps. You use object snaps to snap drawing points to geometric locations on other objects. For example, you can snap to the endpoint of a line or snap to the intersection of 2 lines.

AutoCAD MEP snaps connect MEP objects to other objects, maintaining the integrity and connectivity of the system. For example, you can use pipe snaps to connect a pipe, fitting, or MvPart directly to a pipe end connector at the end of a pipe segment. AutoCAD MEP snaps are available in all the engineering workspaces. For more information, see Configuring AutoCAD MEP Snaps on page 109.

Segments, such as duct and pipe, contain end connector snaps and curve connector snaps. End connector snaps connect new objects to the ends of existing objects. Curve connector snaps connect a segment anywhere along the centerlines of existing objects. For example, when you can use pipe curve connector snaps on an existing pipe run, the software inserts a pipe fitting in the resulting branch, as shown next.

**Snapping a pipe to an existing run using the pipe curve connector**
Resulting branch with an inserted fitting

You can use electrical snaps to wire a junction box to a light. You can also use wireway snaps to make connections to a cable tray, conduit, or electrical MvParts.

Electrical

Wireways

Automating Design Tasks

In AutoCAD, design tasks are performed manually. AutoCAD does not automatically update the part specification data in construction documents.

AutoCAD MEP includes features that automate many engineering tasks and provides immediate feedback as you perform those tasks.
Domain-Specific Ribbons

Out of the box, each engineering workspace in AutoCAD MEP includes a contextual ribbon with preferences and system definitions unique to the active domain. You can use preferences to automate many design layout functions. For example, you can define default parts to use during layout, and you can also specify properties, such as annotation labels, connection behavior, and display settings.

AutoCAD MEP provides system definitions, such as design rules on page 143, display properties on page 146, and rise/drop on page 145 configurations. System definition settings control the appearance and functions of parts in a system. You can also override system settings to accommodate unique part requirements. For more information, see Workspace Components on page 55.

Auto Layout

Auto layout can generate routing solutions that you can use as you lay out duct, pipe, cable tray, or conduit runs. AutoCAD MEP automatically inserts the appropriate segments and fittings based on the current part or routing preferences. For more information, see Auto Layout on page 370.

Interference Detection

You can improve project coordination using the interference detection tool. The software checks for interferences between different types of objects, such as between ducts and pipes or between these MEP objects and architectural/structural objects, such as walls. Interference detection can occur on objects within the current drawing, objects in referenced drawings (xrefs), or objects in both the current drawing and in an xref. AutoCAD MEP shows interferences as mass elements in the drawing. You can add tags to the mass element and insert opening symbols that get captured in a linked interference detection schedule. For more information, see Finding Interferences on page 865.

Connectivity Checks

The built-in connectivity tools ensure that objects are properly connected and that adjacent objects are updated accordingly. Connectivity tools also promote the precision of the sizing and calculation tools.
You use the Show Connected Run command to verify the connectivity in a duct, pipe, plumbing line, conduit, cable tray, or wired electrical run. This functionality is especially useful with complicated designs.

You use the Show Connected Objects command to identify the other objects that are connected to a particular object. The software verifies that adjacent parts are properly connected and that connectivity is continuous throughout the run or branches. In the Electrical workspace, the Show Connected Objects command checks the connectivity between the lighting devices, wires, junction boxes, and switches in a lighting network, as well as between MvParts and conduit or cable tray runs.

**Working With Sizing and Calculation Tools**

AutoCAD MEP includes several built-in sizing and calculation tools.

**Sizing Tools**

Because duct systems connect intelligently, AutoCAD MEP can calculate duct sizes. The software uses the air flow values you assign for the outlet parts in a duct system. The Duct System Size Calculator computes duct sizes for an entire connected system or for portions of a system. The Instant Sizing Calculator computes sizes for ductwork as you draw duct runs or when you modify existing runs.
Instant sizing tool

For computing sizes for ductwork

Electrical Circuit Manager

You can configure circuits and panels for electrical systems. When you assign devices to a circuit, the device loads are automatically added to the circuit load. The Circuit Manager displays circuit load, circuit information, or a circuit report for one or more selected devices. The Circuit Manager also displays overloaded circuits in red. You can turn on a feature to be notified when a circuit is overloaded as you are assigning devices to circuits. For more information, see Checking Electrical Systems on page 639.

Plumbing Tools

Out of the box, AutoCAD MEP includes sample sizing tables for supply lines and sanitary lines, based on typical industry standards. Supply plumbing line sizing tables specify the equivalent plumbing line length values for fittings and valves. Sanitary plumbing line sizing tables specify the maximum allowable fixture unit loads for different types of sanitary runs (stacks, branches, and offsets). You can also customize the sizing tables to meet your project requirements or conform to applicable codes.
You can also use the plumbing line slope tool to compute the start elevation, end elevation, or slope of a plumbing line based on the starting or ending points in the run. The software prompts for one of three entries — starting point of the segment, ending point, or slope. For more information, see Calculating the Slope of a Plumbing Line on page 741.

**Routing Preferences**

AutoCAD MEP uses pipe or conduit routing preferences as specified in the domain's Style Manager to insert the appropriate fittings as you draw a run. Auto layout can generate different routing solutions, from which you can choose the best one to suit your requirements. If you try to add or modify a part, angle, or transition that is not defined in the current routing preference, AutoCAD MEP prompts you to make a part substitution. For more information,
see Pipe Routing Preferences on page 367 or Conduit Routing Preferences on page 526.

Solution Tips

AutoCAD MEP displays optional solution tips that highlight where invalid connections exist between objects in the layout. Solution tips describe the problem and offer one or more possible solutions. For more information, see Showing Solution Tips on page 862.

Creating Accurate Construction Documents

In AutoCAD, there is no automated way to revise construction documents to reflect changes in your original drawing or to automate the creation of section views. As the design changes, manually updating section views is not only time-consuming but also error-prone. You also would need to use a text editor in AutoCAD to perform tasks, such as adding labels to objects, formatting text, justifying positioning, or setting scale representations.

In AutoCAD MEP, you can maximize your productivity using automated tools, such as tagging, labeling, annotation scaling, and layout symbols. Because project drawings are created, stored, and maintained using the drawing management tools in AutoCAD MEP, the resulting construction documents are updated automatically when changes get made.

Section Views

You can create section views from your AutoCAD MEP model, as shown next.
Specifies the parts of the drawing to include in the new section view.

You can regenerate section views after you change any aspects of the model. Because you view AutoCAD MEP systems in 3 dimensions, you can also create elevation and detail views. For more information, see Creating a Section View on page 848.

**Tagging**

AutoCAD MEP automates part tagging. For example, as you create a building system, you can add part number tags to objects in the drawing.
Property set data for a ceiling diffuser

Each tagged part contains a property set that you configure on the Properties palette based on the part specification. Part schedules linked to the drawing reflect the tagged data. For more information, see Defining Property Set Data on page 876 and Tags on page 835.

Labeling and Annotation Scaling

AutoCAD MEP lets you add labels and flow arrows as you lay out a run. You can specify the number of labels or flow arrows and the placement of the annotation. As you make changes, the labeling updates automatically.

The annotation scaling feature lets you specify different annotation scales for model space and for individual viewports in paper space. The annotation
scales and plots accurately even if different scales for the viewports in the layout are used.

| 1:100 | 1:1 |
| 1:64" = 1"-0" | 1:60" = 1"-0" |
| 1:32" = 1"-0" | 3/64" = 1"-0" |
| 1/6 = 1'-0" | 3/32" = 1'-0"

Layout Symbols

AutoCAD MEP displays symbols that represent unique conditions in the layout. For example, rise/drop symbols reflect the elevation direction of vertical segments in the layout for any predefined orthographic view (top, bottom, left, right, front, or back).

You can display objects differently based on elevation on page 223. You can also change the appearance of hidden lines, layers, line types, or color for crossing or overlapping objects at different elevations in 2-line plan views. For example, AutoCAD MEP displays hidden lines as dashes, as shown next.
For more information about the various display options in AutoCAD MEP, see AutoCAD MEP Displays on page 208.

Hidden lines shown as dashes

Project Management

AutoCAD MEP controls the management of project sheets and views through the use of the Project Navigator. As you design systems in AutoCAD MEP, you develop 3-dimensional models that are saved in construct drawings.

Construction documents consist of views and sheets. A view references the model in the construct drawing, and it consists of one view of the model with a specific drawing scale. Two examples of view drawings are a cross-sectional view of an HVAC system and a floor plan of a lighting system.

Views are referenced onto sheets for plotting or transmitting. Because views and sheets reference the model, you only need to update the model, and the changes are automatically propagated through the views and sheets.

Schedules

Creating and maintaining accurate schedules can be complex, error-prone, and time-consuming. However, AutoCAD MEP automates this task by linking the schedule to the original AutoCAD MEP designs.

An MEP schedule displays tagged parts, along with selected attributes for each part, in tabular form, as shown next.
Device schedule

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
<th>Quantity</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>T</td>
<td>12&quot; X 24&quot;</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>2&quot; X 24&quot;</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>12&quot; X 24&quot;</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>12&quot; X 24&quot;</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>12&quot; X 24&quot;</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>12&quot; X 24&quot;</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Because schedules built in AutoCAD MEP are linked, any changes, additions, or deletions to the existing tagging data or part specifications are automatically updated in the schedule. The schedule format inherits the schedule table style assigned to the schedule tool. However, you can modify the table style to reflect the desired data format.

**Leveraging AutoCAD Knowledge in AutoCAD MEP**

The AutoCAD user interface guides you through the CAD design process. AutoCAD MEP builds on the fundamental infrastructure, capabilities, and familiar AutoCAD user interface. Therefore, you do not need to toss away your knowledge about AutoCAD.

Your familiarity with AutoCAD helps you lessen your learning curve and maximize your productivity. The contextual ribbon structures, domain-specific tool and properties palettes, and task-oriented dialogs in AutoCAD MEP reflect the particular task-based design work you are performing. For more information, see *Workspace Components* on page 55.

The AutoCAD command line is also available at the lower left corner of the AutoCAD MEP user interface. When you enter a command, the software prompts you with the next step. For more information about the command line, see *The Command Window*.

**Command line**

```
Command: Anchor
Anchor [Cell/Bundle/Leader/Object/Volume/Identify/Release]
Cell anchor [Attach object/Get cell/3Scaling/Copy to each cell]
Invalid option keyword.
Cell anchor [Attach object/Get cell/3Scaling/Copy to each cell]
Invalid option keyword.
Cell anchor [Attach object/Get cell/3Scaling/Copy to each cell]
```

**Working with AutoCAD Commands in AutoCAD MEP**

Because AutoCAD MEP is built on the AutoCAD infrastructure, all of the commands in AutoCAD are available in AutoCAD MEP. However, some
Differences exist between the commands to modify basic AutoCAD objects, such as lines, polylines, and arcs, and the commands to modify intelligent building systems objects, such as parts, fittings, and segments of duct, pipe, or cable tray.

This section provides guidance on using AutoCAD commands in an AutoCAD MEP environment. The effects of commands on building systems objects are discussed, and, where applicable, alternative or more enhanced methods of accomplishing tasks are suggested.

**ALIGN**

The ALIGN command moves, rotates, and tilts objects so they align with other objects.

When you use ALIGN to align an object in AutoCAD MEP, you can snap and attach the object to another at the new location, but the command does not intelligently connect the 2 objects. This action results in an invalid connection in the overall building system.

To maintain the connectivity of objects, use Alignment grips to align devices or panels, and use Location or Rotate grips, snaps, and polar tracking to align other objects. The grips enable you to move or rotate objects while optionally maintaining their connections to other objects.

For more information, see the following topics:

- Moving Duct Components Using Location Grips on page 342
- Rotating Duct Components on page 345
- Moving Pipe Components Using Location Grips on page 470
- Rotating Pipe Components on page 473
- Moving a Device or Panel on page 648
- Modifying the Layout of a Cable Tray or Conduit Run on page 669
- Rotating Cable Tray or Conduit Fittings on page 680
- Moving Plumbing Lines and Fittings on page 743
- Rotating Plumbing Fittings on page 745
- Align Objects
ARRAY

The ARRAY command creates copies of objects in a rectangular or polar (circular) pattern called an array.

In AutoCAD MEP, you can use ARRAY to create arrays of a selection set of objects (for example, a complete duct branch). If possible, the software connects a suitable object in each copy of the selection set, such as a tee or takeoff, to a segment at each destination.

Unlike COPY or MOVE, ARRAY does not align or orient the copies of the selection set when it connects them to objects at their destinations. The copies maintain the alignment and orientation of the original selection set.

For more information, see Create an Array of Objects.

BREAK

The BREAK command breaks an object between 2 points that you specify and optionally creates a gap between the new objects that are created.

In AutoCAD MEP, when you use BREAK to break segments of duct, pipe, cable tray, or conduit, or to break plumbing lines, the software connects the 2 new segments if the first and second specified break points are the same. However, when you break a segment where a takeoff is connected, the software connects the takeoff to only 1 of the 2 new segments. You should reposition the takeoff as needed.

You can break one or more duct, pipe, cable tray, or conduit segments into multiple segments of a specific length. For more information about breaking segments into multiple segments in AutoCAD MEP, see:

- Breaking or Merging Duct Segments on page 352
- Breaking or Merging Pipe Segments on page 480
- Breaking and Merging Cable Tray or Conduit Segments on page 677

For more information about BREAK, see Break and Join Objects.
CHAMFER

The CHAMFER command connects 2 objects with an angled line. It is typically used to represent a beveled edge on a corner, but it can also be used to extend 2 objects until they intersect.

In AutoCAD MEP, CHAMFER only works on AutoCAD objects, such as lines, polylines, and 3D solids. It does not work on building systems objects, such as schematic lines, plumbing lines, or duct, pipe, cable tray, or conduit segments. To extend and connect these types of objects, use FILLET, EXTEND, or a combination of grips, snaps, and polar tracking.

For more information, see Create Chamfers.

COPY

The COPY command creates duplicates of objects at a specified distance and direction from the originals.

In AutoCAD MEP, when you use COPY to copy a selection set of objects (for example, a complete duct branch), the software copies the objects and, if possible, connects a suitable object in the selection set, such as a tee or takeoff, to a segment at the destination. When connecting the object, the software breaks into the segment and then aligns and orientates the object (and the selection set). For more information, see Copy Objects.

To copy a device or panel, use Alignment grips instead. The grips enable you to align the copy perpendicular to an object, such as a wall. For more information, see Copying Devices and Panels on page 605.

ERASE

The ERASE command removes a selection set of objects from a drawing.

In some cases in AutoCAD MEP, ERASE joins the objects that remain after you erase an object. For example, it joins remaining duct or pipe segments when you erase inline parts. However, when you erase fittings, the software disconnects the remaining objects because it does not know how to join them. In these cases, you can connect or merge the disconnected objects to reflect the desired design.

**NOTE** Erasing objects does not remove unused, named items from a drawing. You must purge them.
For more information, see the following topics:
- **Breaking or Merging Duct Segments** on page 352
- **Breaking or Merging Pipe Segments** on page 480
- **Breaking and Merging Cable Tray or Conduit Segments** on page 677
- Erase Objects

## EXPLODE

The **EXPLODE** command breaks a compound object into its component objects.

In **AutoCAD MEP**, the first time that you explode a building systems object (for example, a part or fitting), the software converts the object to an anonymous block reference and changes its Z (elevation) value to zero. You can then explode the object again to convert it to its primitive AutoCAD components, such as lines, arcs, and splines.

Typically, you explode the objects in a drawing in order to share the drawing with users who do not have AutoCAD MEP or an **AutoCAD MEP object enabler**, or who have a version of AutoCAD not supported by the Export to AutoCAD commands.

**WARNING** Exploding a building systems object causes the object to permanently lose its connectivity with other objects, among other changes. For this reason, always create a copy of the source drawing, and then explode the objects on the copy.

For more information, see **Export to AutoCAD** on page 880.

## EXTEND

The **EXTEND** command extends objects to meet other objects.

In **AutoCAD MEP**, **EXTEND** works on duct, pipe, cable tray, and conduit segments, and plumbing lines. However, fittings are not automatically inserted. To have fittings inserted automatically based on the preferences in the drawing, use **Add grips** instead.

You can also extend plumbing lines and schematic lines using the **FILLET** command.
For more information, see the following topics:

- Adding Duct Using Grips on page 298
- Adding Pipe Using Add Grips on page 445
- Drawing a Plumbing Run Using Add Grips on page 731

**FILLET**

The FILLET command fillets and rounds the corners of objects. If you use this command to connect 2 objects and set the fillet radius to zero, the command trims or extends the objects until they intersect but does not create an arc.

In AutoCAD MEP, you can use FILLET to fillet not only AutoCAD objects, such as lines, polylines, and arcs, but also schematic lines and plumbing lines. By using FILLET with a fillet radius of zero (default), you can easily connect schematic lines or plumbing lines by extending or trimming them. You can use the command in orthographic mode or isometric mode.

Filleting plumbing lines

1. Draw 2 plumbing lines.
2. Enter FILLET command, then select first segment.
3. Select second segment.
4. Result.
NOTE The resulting single schematic line or plumbing line has the properties of the segment that you select first, such as system, style, and flow direction. In the case of plumbing lines, the resulting plumbing line also has an elbow of the type specified for the plumbing system. For more information, see Specifying the Default Fittings for a Plumbing System Definition on page 718.

For more information, see FILLET or EXTEND.

JOIN

The JOIN command combines similar objects to form a single, unbroken object. You can also use it to create complete circles and ellipses from arcs and elliptical arcs.

In AutoCAD MEP, JOIN only works on AutoCAD objects, such as lines, polylines, arcs, and splines. However, you can join duct, pipe, cable tray, or conduit segments, as well as plumbing lines, by merging them. You can also connect plumbing lines or schematic lines with the FILLET command.

For more information, see the following topics:
- Breaking or Merging Duct Segments on page 352
- Breaking or Merging Pipe Segments on page 480
- Breaking and Merging Cable Tray or Conduit Segments on page 677

LENGTHEN

The LENGTHEN command changes the length of lines, polylines, arcs, and splines and the included angle of arcs.

In AutoCAD MEP, LENGTHEN does not work on duct, pipe, cable tray, or conduit segments. Rather, you can use Lengthen grips to modify the length of segments. Depending on the editing mode you select, the grips move or lengthen connected objects to maintain their connectivity.

For more information, see the following topics:
- Lengthening a Duct Segment on page 344
- Modifying the Length of a Pipe Segment on page 473
- Modifying the Length of Cable Tray or Conduit Segments on page 673
MATCHPROP

The MATCHPROP command copies some or all of the properties of one object to other objects.

In AutoCAD MEP, MATCHPROP only copies AutoCAD object properties, such as color, layer, linetype, and lineweight. To copy building systems object properties, such as system, elevation, and size, use the Match command option when adding or modifying an object. For more information see the following topics:

- Matching Part Properties on page 163
- Work with Object Properties

MIRROR

In AutoCAD, the MIRROR command creates a mirror image copy of an object. MIRROR works similarly in AutoCAD MEP. For more information, see Mirror Objects.

MOVE

The MOVE command moves objects a specified distance in a specified direction.

In AutoCAD MEP, when you use MOVE to move a selection set of parts, fittings, and segments (for example, a complete duct branch), the software moves the objects and, if possible, connects a suitable object in the selection set, such as a tee or takeoff, to a segment at the destination. When connecting the moved object to the segment, the software breaks into the segment and then aligns and orients the object (and the selection set). However, the command does not connect or adjust disconnected objects that remain at the original location.

As an alternative to MOVE, use Location grips to move parts, fittings, segments, and schematic symbols. Depending on the editing mode you select, the
Location grips move or adjust all affected objects to maintain the connectivity of the run.

To move devices or panels, use Alignment grips. The grips let you accurately align a device or panel perpendicular to an object, such as a wall.

To move schematic lines, use MOVE or enter a new location on the Location tab of the Schematic Line Properties dialog.

For more information, see the following topics:
- Moving Duct Components Using Location Grips on page 342
- Moving Pipe Components Using Location Grips on page 470
- Moving a Device or Panel on page 648
- Modifying the Layout of a Cable Tray or Conduit Run on page 669
- Moving Plumbing Lines and Fittings on page 743
- Rotating Isometric Symbols on page 807
- Moving Schematic Lines on page 800
- Move Objects

OFFSET

The OFFSET command copies a selected object, giving the copy a shape that reflects the original. Because OFFSET offsets polylines, in AutoCAD MEP you can use it to offset schematic lines.

You can also use this command to offset individual segments of duct, pipe, cable tray, or conduit, and individual plumbing lines. However, because the command does not support the selection of multiple objects, you cannot use it to offset a complete run.

For more information, see Offset an Object.

PURGE

The PURGE command removes unused, named AutoCAD objects, such as blocks, layers, and styles, from a drawing.
Because PURGE purges only AutoCAD objects, in AutoCAD MEP you should purge unused building systems objects first, and then use the Style Manager to purge unused system definitions.

For more information, see the following topics:

- Purging AutoCAD MEP Objects on page 878
- Purging Systems on page 149
- Erase Objects

**ROTATE and ROTATE3D**

The ROTATE command rotates an object around a base point. The ROTATE3D command rotates an object around a 3-dimensional axis.

In AutoCAD MEP, you can use ROTATE3D to rotate fittings around a specified axis and connection point. However, a quicker and easier alternative is Rotate grips. In plan or isometric views, you can use Rotate grips to rotate both fittings and inline parts. The grips adjust connected objects and maintain their connectivity whenever possible.

For more information, see the following topics:

- Rotating Duct Components on page 345
- Rotating Pipe Components on page 473
- Rotating Cable Tray or Conduit Fittings on page 680
- Rotating Plumbing Fittings on page 745
- Rotate Objects

**SCALE**

The SCALE command makes an object uniformly larger or smaller.

In AutoCAD MEP, SCALE properly resizes schematic symbols, electrical devices, electrical panels, plumbing fittings, and plumbing valves. You can also resize schematic symbols using their grips in Scale grip mode.

For more information, see the following topics:

- Resizing Schematic Symbols on page 809
STRETCH

The STRETCH command relocates the object endpoints that lie across or within a crossing window selection.

In AutoCAD MEP, STRETCH increases the length of ducts, pipes, cable trays, conduits, and plumbing lines, but it does not adjust connected objects and can break their connectivity. For this reason, use Lengthen grips, instead of STRETCH, to modify the lengths of segments. Depending on the editing mode you select, the Lengthen grips move or lengthen connected objects to maintain their connectivity. On unconnected segments, you can also use the Start or End grips to change both the length and angle of the segment. To stretch or change the angle of a schematic line, drag a grip point to a new location.

For more information, see the following topics:

- **Lengthening a Duct Segment** on page 344
- **Modifying the Length of a Pipe Segment** on page 473
- **Modifying the Length of Cable Tray or Conduit Segments** on page 673
- **Modifying the Length of Plumbing Lines** on page 744
- **Modifying the Length of Schematic Lines** on page 804
- **Resize or Reshape Objects**

TRIM

The TRIM command trims objects at a cutting edge defined by other objects.

In AutoCAD MEP, TRIM only works on plumbing lines and segments of duct, pipe, cable tray, and conduit. However, fittings are not automatically inserted. For more information, see Trim or Extend Objects.
Help Resources

The AutoCAD MEP Help provides various help resources. Click ? and then click a help resource in the list. You can also explore various help resources in the Welcome Screen page in AutoCAD MEP.
Welcome to AutoCAD MEP 2011, an AutoCAD-based building design and construction documentation solution for Mechanical/Electrical/Plumbing engineers, designers, and drafters. This section introduces you to the software and describes how to contact Autodesk, get help, navigate the user interface, and perform basic but important tasks.

About AutoCAD MEP

AutoCAD MEP is designed for the MEP (mechanical, electrical, piping, and plumbing) disciplines in the building industry. It includes:

- Catalogs of drawing objects that represent the real-world parts in building systems and that connect intelligently to one another.
- Tools specific to the mechanical, electrical, and plumbing disciplines, such as analysis tools for sizing systems for optimal performance.
- Common design tools that you can use in all 3 disciplines:
  - Project management tools that integrate building system designs with architectural building plans.
  - Tools for specifying design preferences that control how objects appear and behave.
- Drawing templates with basic, standards-based settings to get you started quickly.

You can use the software to design comprehensive systems for commercial, institutional, and residential building plans.
AutoCAD MEP Workflow

AutoCAD MEP provides features that allow the creation of very complex designs. While the software has many intricacies, there is a basic workflow for using it. Use the following table to navigate to detailed workflows for designing mechanical, electrical, and plumbing systems.

<table>
<thead>
<tr>
<th>General task</th>
<th>View more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Establish high-level project parameters, and create document sets</td>
<td>Define project standards, the look of the drawing area, the look of parts, the tool catalogs to use, and other settings. See Working with Drawing Management Projects on page 199. Create sheets, sheet lists, and cover sheets for construction document sets. See Construction Document Workflow on page 813.</td>
</tr>
<tr>
<td>Link to architectural floor plans</td>
<td>Use Project Navigator to create cross references to the floor plans onto to which MEP designs will display. See Working with Referenced Drawings on page 245</td>
</tr>
<tr>
<td>Create preliminary domain outlines using flow and 1-line diagrams</td>
<td>Use the schematic tool in MEP to create concept designs. See About Schematic Diagrams on page 772</td>
</tr>
</tbody>
</table>
| Create detailed domain designs using catalog parts and custom content | Create:  
  - HVAC designs on page 251  
  - Electrical designs  
  - Plumbing designs  
  - Radiant heating system designs  
  - Piping system designs |
Intelligent Objects

AutoCAD MEP is an object-based CAD application. When you design in the application, you use large collections of objects that represent the real-world components in mechanical, electrical, and plumbing systems. Examples of these objects include segments of duct, pipe, cable tray, and plumbing lines; fittings of all types; and equipment—called multi-view parts or MvParts in the software—such as air handling units, electrical transformers, and drinking fountains.

AutoCAD MEP objects are composed of lines, arcs and other standard AutoCAD objects, but they also contain information that allows them to function like the real-world components that they represent, to relate intelligently to one another, and to display in a 2-dimensional (2D) or 3-dimensional (3D) context. The objects have specially designed connection points called connectors that enable them to connect intelligently to appropriate objects and transfer information, such as shape, size, and system.

As an example, you can insert a variable air volume (VAV) box into an HVAC system drawing, and then draw a duct from one of its connectors. When you draw the duct, the software detects the size and shape of the connector on the VAV box and draws an appropriate duct segment as shown.
To continue the example, you can draw and connect additional duct segments, fittings, and HVAC equipment that are all intelligently connected in the same manner. As you do so, the software inserts and adjusts the objects in the run to maintain their connectivity. For example, it inserts appropriately-sized fittings as you lay out duct segments. It also inserts an appropriately-sized transition fitting if you change the size of a segment.

The ability of the software to detect the attributes of objects and act accordingly to maintain the connectivity of the system is an important aspect of the software. It enables you to design fully connected systems quickly and preserves their connectivity when you modify them.

**Location of Part Catalogs**

AutoCAD MEP includes objects that include hundreds of industry-specific, standards-based fittings and multi-view parts called MvParts. The objects are organized into part catalogs, which you access when you add or modify objects in your drawings.

The following part catalogs are available in both imperial and metric units:

- Cable Tray
- Conduit
- Duct
- MvParts on page 110 for all building systems disciplines
- Pipe

The software also includes additional content for style-based objects: electrical devices and panels, plumbing fittings and valves, and schematic symbols.

For more information on part catalogs, see Working with Catalog-Based Content on page 115.

Analysis Tools

Mechanical, electrical, and plumbing systems require analysis to ensure proper sizing and operation. AutoCAD MEP includes several, integrated engineering tools for performing analyses:

- Before you begin to design, you can model spaces and zones to determine the heating and cooling loads for a building plan. You can also export the engineering data in Green Building Extensible Markup Language (gbXML) for analysis by third-party tools, and then import the results into your drawing. For more information, see Calculating Duct Sizes to Optimize Duct System Designs on page 336.

- As you draw, you can use instant sizing tools to calculate duct or wire sizes. For more information, see Drawing a Duct Run on page 292 or Drawing or Generating Wires on page 611.

- After you complete your design, you can analyze the HVAC, electrical, or plumbing system to check loads and resize components for optimal performance. For more information, see Calculating Duct Sizes for a Duct System on page 302, Calculating Wire Sizes Using the Circuit Manager on page 640, Calculating the Sizes of Supply Plumbing Lines on page 750, or Calculating the Sizes of Sanitary Plumbing Lines on page 760.

Project Management Tools

AutoCAD MEP includes tools that formalize and automate the processes related to building model design and documentation:

- a Project Browser—Use this tool to create design projects and specify high-level project information and settings, such as the project number, project name, and the file locations of the tool palettes and content library to use on the project.
a Project Navigator—Use this tool to perform project-specific tasks, such as defining building levels and divisions, creating drawings, and creating plotting sheets.

When you manage your project using the Project Browser and Project Navigator, you have consistency in all aspects of the project. Everyone on your design team has a centralized project environment from which to access the most current information, tools, and documents—from project templates to composite views and construction documents.

For more information, see Working with Drawing Management Projects on page 199.

**Contacting Autodesk**

Use the following resources to contact Autodesk about AutoCAD MEP and other Autodesk products.

**Corporate Headquarters**

For general inquiries and information, contact Autodesk corporate headquarters:

Autodesk, Inc.
111 McInnis Parkway
San Rafael, CA 94903
USA
Phone: 415-507-5000, Web site: [http://www.autodesk.com](http://www.autodesk.com)

**Sales Information**

To purchase additional Autodesk software, contact your local reseller. For the name of the authorized reseller nearest you, call 1-800-964-6432 or refer to the Reseller Center Web site: [http://www.autodesk.com/resellers](http://www.autodesk.com/resellers).

**Technical Support**

If you have a technical question, contact your local reseller or refer to the AutoCAD MEP Web site: [http://www.autodesk.com/support](http://www.autodesk.com/support). The Web site provides links to frequently asked questions, a searchable knowledge base, and searchable discussion groups.

For information on other help resources, see Getting Help on page 47.
Feedback

If you have a suggestion for a product enhancement, a compliment, or a complaint, or if you think you have found a defect, we would like to know about it. To provide feedback, visit the AutoCAD MEP Web site: http://www.autodesk.com/contact.

Getting Help

AutoCAD MEP includes several resources designed to help you learn the software.

Training

Training programs and products from Autodesk help you learn the key technical features of your Autodesk software and improve your productivity. For the latest information about Autodesk training, visit http://www.autodesk.com/autocadmep-training or contact your local Autodesk office.

Discussion Groups

Autodesk provides searchable, peer-to-peer discussion groups and blogs in which you can ask questions and share information with other users of Autodesk products, including AutoCAD MEP. For more information, see the Autodesk Web site: http://www.autodesk.com/autocadmep-community.

Additional Resources

From the Help menu in the software, you can access additional help resources, including but not limited to a searchable AutoCAD MEP knowledge base, resources for developers, and support services for members of the Autodesk Subscription program.

Updating AutoCAD MEP

AutoCAD MEP includes a notification tool called the Communication Center that keeps you informed about service pack availability. If you are a member of the Autodesk Subscription program, the Communication Center also notifies
you of additional product information, such as extension availability, tips, and support information. You can set the Communication Center to notify you of updates and other information daily, weekly, or monthly, or you can update on demand. For more information, see Overview of Communication Center.

The AutoCAD MEP 2011 Drawing Domain

The AutoCAD MEP 2011 user interface provides access to the commands and controls that enable the production of intricate M/E/P designs. Later sections describe this workspace in detail. By way of introduction, here are the highlights:

Ribbon

Using the Microsoft Office 2007 model, AutoCAD MEP 2011 now uses the ribbon as the central access point for commands. The ribbon contains a number of tabs on which commands are grouped according to conceptual task types or selected objects.

The ribbon replaces the menu bar and the toolbars as the primary command access point.

Application Menu

The application menu contains basic commands pertaining to the drawing as a whole: Open, Save, Print, Export etc. Like the menu browser it replaces, the application menu is accessed by clicking in the upper-left corner of the workspace.
Workspaces

AutoCAD MEP is equipped with six workspaces (HVAC, Piping, Electrical, Plumbing, Schematic, and Architecture). The default workspace after initial installation is HVAC, but can be user-defined (see Workspace Settings on page 54).

**NOTE** The tool palette groups associated with all the workspaces are available from the context menu of the tool palettes set.

Drawing Status Bar Menu

The drawing status bar menu has been removed from AutoCAD MEP 2011. Commands formerly found there can now be accessed from the application menu.
Commands on the old menu

<table>
<thead>
<tr>
<th>Commands on the old menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawing Setup...</td>
</tr>
<tr>
<td>Drawing Properties...</td>
</tr>
<tr>
<td>Plot Preview</td>
</tr>
<tr>
<td>Plot... (Ctrl-P)</td>
</tr>
<tr>
<td>Publish...</td>
</tr>
<tr>
<td>Publish to Web...</td>
</tr>
<tr>
<td>Publish to MapGuide...</td>
</tr>
<tr>
<td>Publish to 3D PDF...</td>
</tr>
<tr>
<td>eTransmit...</td>
</tr>
</tbody>
</table>

Help Access

With the removal of the menu bars, the commands to access Help features have been moved into the InfoCenter at the top right of the application window. Here, you can find the online resources of InfoCenter and the Help menu, which lets you access Help and other interactive resources.

Toolbars

Toolbars have been removed from AutoCAD MEP. Commands formerly found on toolbars can now be accessed from the ribbon.

Autodesk Seek

You can use Autodesk Seek to find product design information. Many content providers, both corporate partners and individual contributors, publish to Autodesk Seek. Content includes 3D models, 2D drawings, specifications, brochures, and other descriptions of products or components.
Import design content into AutoCAD MEP 2011

You can also share your own content with others using Autodesk Seek. Upload drawings or blocks to Autodesk Seek to give your partners and customers ready access to your content.

Workspace Fundamentals

Workspaces are user interface configurations that determine the ribbon panels that display in the drawing window. For example, the workspace determines whether the Tool Palettes window and Command Line window float or dock to specific sides of the application window.

If you work in a multi-disciplinary firm and perform several different design tasks, such as the design of HVAC and piping systems, workspaces are particularly useful. You can use them to save user interface configurations that are tailored to different tasks. Once the workspaces are created, you can quickly switch between them as needed.
Default Workspaces in AutoCAD MEP

AutoCAD MEP includes pre-built workspaces for several building systems disciplines.

<table>
<thead>
<tr>
<th>Workspace</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HVAC</td>
<td>Configured for the design of HVAC systems. Ribbon tabs are populated with HVAC tools and commands, and the HVAC tool palette group is displayed.</td>
</tr>
<tr>
<td>Piping</td>
<td>Configured for the design of piping systems. Ribbon tabs are populated with piping tools and commands, and the Piping tool palette group is displayed.</td>
</tr>
</tbody>
</table>
Creating Workspaces

You can create your own personal workspaces or, if your design organization requires more control over your drawing environment, your CAD manager can create read-only workspaces designed to be shared by many users.

To create a personal workspace

1. Arrange the ribbon panels in the drawing environment as desired.

2. On the application status bar, click the active workspace ➤ Save Current As.

3. Enter a name for the workspace, and click Save.

For more information on workspaces, including information on modifying workspaces and the differences between workspaces and profiles, see Create Task-Based Workspaces.

Switching Workspaces

To activate a workspace, select the workspace name from the drop-down list on the application status bar.

<table>
<thead>
<tr>
<th>Workspace</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical</td>
<td>Configured for the design of electrical systems. Ribbon tabs are populated with electrical tools and commands, and the electrical Electrical tool palette is displayed.</td>
</tr>
<tr>
<td>Plumbing</td>
<td>Configured for the design of plumbing systems. Ribbon tabs are populated with plumbing tools and commands, and the Plumbing tool palette group is displayed.</td>
</tr>
<tr>
<td>Schematic</td>
<td>Configured for the design of schematic diagrams. Ribbon tabs are populated with schematic tools and commands, and the Schematic tool palette is displayed.</td>
</tr>
<tr>
<td>Architecture</td>
<td>Configured for the design of architectural plans. Ribbon tabs are populated with architecture-specific tools and commands and the architecture tool palette group is displayed.</td>
</tr>
</tbody>
</table>
Workspace Settings

Select Workspace Settings from the drop-down list on the application status bar to:

- Set the default workspace (MyWorkspace)
- Change the order of the workspaces list
- Add separators
- Specify whether to automatically save workspace changes
Workspace Components

The workspace consists of a drawing window with ribbon, tool palettes, and other controls that you use to set up a M/E/P project, create your design, and generate construction documents.

In the following sections, each component of the workspace is described in detail. Components can be turned off and on for different workspaces, depending on your requirements.

For an interactive guide to the user interface, click the Help button in the InfoCenter on the top right of the application window and click User Interface Overview.
Ribbon

The ribbon is the central location for accessing commands in AutoCAD MEP 2011. The ribbon is organized into tabs that reflect common tasks in the drawing process. There are 2 types of tabs:

- **Static tabs** are available regardless of whether objects are selected in the drawing area. The commands on these tabs previously appeared on menus and toolbars.

  **Static Home tab**

- **Contextual tabs** display depending on the object selected in the drawing area. When you select a duct, the ribbon displays a contextual tab for Duct. The commands on the contextual tabs reflect the commands on the context (right-click) menu of an object.

  **Contextual tab for duct objects**

Displaying the Ribbon

To display the ribbon if it is not displayed in your workspace, or has been turned off, enter `ribbon` on the command line.

You can use the button at the right of the tab names to modify the appearance of the ribbon as follows:

- To display only the panel titles of the ribbon tabs, click (Minimize to Panel Titles) at the top right of the ribbon.
To display only the tab names as titles, click [▼] again (Minimize to Tabs).

To display the full ribbon again, click [▼] a third time (Show Full Ribbon).

Using the Ribbon

To start a command from the ribbon

1. If the ribbon is not displayed by default, enter **ribbon** on the command line.
2. Click the desired tab.
3. Move the cursor over the commands on the tab as needed to view tooltips describing the commands.
4. Click a command.

Some ribbon commands are grouped under a drop-down menu. You can access them by clicking the arrow next to the command.

**Example of drop-down menu**

Some panels have an expansion arrow [▼] to indicate that the panel can be expanded. The expanded part typically contains commands that are less frequently used.
5 The expanded panel is displayed when you click the arrow ▼. To pin the expanded part of the panel onscreen, click .

To tear of a panel from a static ribbon tab

6 If you want a panel from a static tab to remain in your workspace when you switch to another tab, you can tear the panel off its tab and use it as a floating palette. To do so, move the cursor over the title bar of the panel, and then drag the panel off the ribbon and into the drawing area.

The software automatically saves any changes you make to the workspace unless you changed the default workspace setting on page 54 for saving changes.
To return a floating panel to the ribbon

7 Move the cursor over the floating panel, and click Return Panels to Ribbon.

To hide and display tabs and panels

8 To hide or display tabs and panels:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>hide a tab</td>
<td>right-click anywhere on the ribbon, click Tabs and click the static tab to deselect it.</td>
</tr>
<tr>
<td>display a tab</td>
<td>right-click anywhere on the ribbon, click Tabs and click the static tab to select it.</td>
</tr>
<tr>
<td>hide a panel</td>
<td>click the tab you want to modify, click Panels, right-click on the ribbon, and click the panel name to deselect it.</td>
</tr>
<tr>
<td>display a panel</td>
<td>click the tab you want to modify, click Panels, right-click on the ribbon, and click the panel name to select it.</td>
</tr>
</tbody>
</table>

A check mark next to each tab or panel name indicates that it is currently being displayed on the ribbon.
Locating Commands in the Workspace

The ribbon is intuitive and task-related, and so the transition from menus and toolbars to the new UI will in most cases be quick and easy. However, it is a new design and so the following tips might be helpful to be productive without a break.

Where is My Command? Tool

The Where is my command? tool is a help file that lists all commands by their previous menu location and displays their current location on the ribbon.

Where is My Command? tool

You can access the Where is My Command? tool from the Help menu ➤ Where is my Command, or from the landing page of the regular Online Help.

Home Tab

The Home tab contains the most frequently used commands within the software. Basic object and drawing tools can be found here, as well as frequently used utilities like modification tools, layers, and basic annotation. Use the Home tab as your starting point in a new drawing.
Application Menu

The application menu has a Search mode, where you can enter a full or partial command name, and see a list of locations in the user interface where the command can be accessed. For more information, see Application Menu on page 70.

Context Menu

Commands that refer to a selected object appear on the contextual tab for that object. Commands disappear from the ribbon after the object is deselected.

Duct context tab

The command layout of the contextual tab of an object is in most cases based on the structure of commands on the context menu of the object.
**Duct context menu**

For example, on the context menu of a duct you can find the Add Selected command. On the contextual Duct tab, you can find the Add Selected command on the General panel.

**Finding More Information about the Ribbon**

Click ➤ User Interface Overview. Select UI Tour Movie to learn how to use the ribbon.

**Static Ribbon Tabs**

The workspace comprises a set of static tabs that are optimized for M/E/P tasks. The default HVAC workspace for the US version of AutoCAD MEP 2011
includes the following static tabs on the ribbon. The following sections describe these tabs and the panels they contain.

**Home Tab**

The Home tab contains the most frequently used commands within the software. Basic object and drawing tools can be found here, as well as frequently used utilities like modification tools, layers, and basic annotation.

- **Build.** Contains the basic commands for adding the most commonly used objects, like ducts, duct fittings, and equipment, as well as commands for opening the tool palettes on page 129, Properties palettes on page 135, and the Content Browser Overview.

- **Draw.** Contains common linework tools, like lines, polylines, and rectangles, as well as hatch and boundary tools and polygons.

- **Modify.** Contains commands for manipulating objects and linework in a drawing. In addition to standard commands like Move, Rotate, Erase, Offset, Mirror, Scale, Array, Explode, Join, there is also a command for converting AEC objects to mass elements and converting mass elements to 3D Solids.

- **Layers.** Contains commands that you need to work with layers. You can open the Layer Manager and the Layer States Manager from here.

- **Annotation.** Contains basic commands for inserting text, leaders, and dimensions. For more information, see Annotate Tab on page 65.

- **Inquiry (Schematic and Architecture workspaces only).** Contains commands for measuring distance and areas, and the AutoCAD list command. Furthermore, you can find commands for evaluating architectural spaces.

- **Section and Elevation.** Contains commands for generating sections and elevations of your plan or model. To create sections and elevations with callouts, see the Callouts panel on the Annotate tab on page 65.

- **Details.** Accesses Detail Component Manager from which you can insert detail components directly into drawings or onto tool palettes.
Floating View Panel

The floating View panel offers access to the commands for Views, visual styles, and the Zoom and Pan tools. This panel is not docked to the ribbon by default, so you can access it independently of the current ribbon tab. You can dock the floating View panel to the Home tab, if desired.

Insert Tab

The Insert tab lets you work with references, blocks, multi-view blocks, attributes, and content from external sources like Content Browser and Autodesk Seek.

- Reference. Contains commands for working with external references (xrefs), DWF/DWFx files, DGN underlays, and raster images.
- Block. Contains commands for inserting and editing blocks and multi-view blocks.
- Attributes. Contains commands for creating and editing attributes.
- Import. Contains commands for importing Radiator, WMF, ACIS, 3D Studio Max, DGN, and LandXML files.
- Content. Contains commands for inserting content from Content Browser Overview, from DesignCenter, or from Autodesk Inventor into your drawing.
- Seek Panel: The Seek panel lets you search online for prefabricated design content. For more information about Seek, see Use Autodesk Seek to Add and Share Drawings.
Annotate Tab

The Annotate tab contains commands that help you to mark up your drawing files.

Annotate tab

- Text. Contains all commands for text and text styles and accesses the Fields editor.
- Dimensions. Contains commands for inserting and editing both AEC and AutoCAD dimensions.
- Scheduling. Contains commands for inserting schedule tables on page 842 for basic objects, creating and inserting schedule tags on page 842, and running a space evaluation. Additionally, you can create schedule table styles, and renumber property set data on page 876.
- Callouts. Contains commands for placing title marks, sections, elevations, and detail views.
- Label. Provides commands for attaching MEP Labels and leaders.
- Keynoting. Contains commands for adding sheet and reference keynotes, keynote legends, opening the keynote editor, and selecting a keynote database.
- Markup. Accesses commands for marking up a drawing for review. You can add revision clouds, mask blocks, wipeouts, open the Markup Set Manager, and load a markup DWF.
- Annotation Scaling: Commands here let you add the current scale to objects, display and edit the scale list, and add and delete scales for annotative objects.

Analyze Tab

The Analyze tab contains all the commands you need to make engineering calculations on the objects in the current workspace. These calculation tools vary from the HVAC workspace to the Electrical and other workspaces.
Inquiry. Provides tools to check for interferences between MEP objects and mass elements, to determine the distance between or area bounded by selected objects, and the QuickCalc tool for performing calculations.

HVAC. Provides a duct size calculation tool, plus a way to import DuctXML and gbXML data.

Space and Zone: Provides tools for adding spaces and zones to your drawings, and to create and modify space/zone templates.

**View Tab**

The View tab is the central location for defining and changing views and navigating the drawing.

**NOTE** The View tab contains a number of commands also found on the application status bar.

- Navigate. Contains the ViewCube and SteeringWheels, as well as the Pan, Zoom, and Orbit commands.

- Appearance. Here, you can select predefined views, create new views, open View Manager, select a visual style, open the Visual Styles Manager, and define Walk and Fly settings. You can access predefined display themes. You can also adjust clip planes and access the Regenerate commands.

- Coordinates. Contains commands relevant to the World Coordinate System (WCS) or User Coordinate System (UCS).

- Viewports. Here you can switch between different viewport configurations, create new viewports, and clip and join viewports.

- Face Effects. Contains commands for defining object settings, including shading, color, face lighting, and x-ray.
- **Edge Effects.** Contains commands for defining edge settings, including facet edges, isolines, edge overhang, jitter, and silhouette. You can also define the color of obscured edges and edge intersections here.

- **MEP View.** Provides tools to see the flow direction of ducts and pipes, a command to display broken connections (solution tips), and a way to adjust the compass settings. The expanded tab provides a way to hide the compass bar, and a tool for controlling the size of solution tips.

- **Windows.** Contains most of the commands that were on the Windows menu in previous versions. Here you can switch between open drawings, arrange open windows onscreen, lock the workspace windows, display and hide the drawing window status bar on page 78, turn items on the drawing window status bar on or off, and display the text window.

### Manage Tab

On the Manage tab, you can find features for advanced users and CAD managers.

- **Action Recorder.** Contains commands for recording and playing action macros.

- **CAD Standards.** Contains commands for configuring AutoCAD standards, check your drawing for standards violations, and start Layer Translator.

- **Project Standards.** Contains commands associated with project standards for an AEC project. You can configure project standards, synchronize the project with its standards, synchronize standards with each other, and audit projects and drawings.

- **Style and Display.** Accesses the Style Manager, the Display Manager, the AEC Dimension Style Wizard, the structural member catalog, and the structural member wizard. You can also define and insert profiles.

- **Preferences (HVAC, Piping, Electrical, and Plumbing workspaces only).** Provides a way to set or modify preferences.

- **MEP Content.** Provides commands to launch Content Builder and Catalog Editor. The expanded panel provides tools to change, test, and migrate...
catalog data, as well as tools to batch convert and decompose drawing components.

- **Applications.** Contains commands for loading extra applications, like ARX, LSP, or VB applications, and running user-defined scripts and VBA macros. Also accesses the VBA Manager and the Visual Basic and Visual Lisp editors here.

- **Customization.** Accesses the User Interface Editor (CUI) and the tool palettes on page 129.

### Contextual Tabs

The following table lists and describes the contextual tabs in AutoCAD MEP. All contextual tabs include a General panel containing several generic commands, such as Select System, Object Viewer, and Isolate Objects.

<table>
<thead>
<tr>
<th>Contextual Tab Name</th>
<th>Unique Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duct</td>
<td>Insert Equipment, Duct Properties, Duct Modify, Duct Length, Calculate Duct Sizes, Set Flow Direction, Show/Update Flow</td>
</tr>
<tr>
<td>Duct Fitting</td>
<td>Insert Equipment, Duct Fitting Properties, Duct Fitting Modify, Add/Remove Vanes, Calculate Duct Sizes, Set Flow Direction, Show/Update Flow</td>
</tr>
<tr>
<td>Duct Custom Fitting</td>
<td>Insert Equipment, Custom Fitting Properties, Calculate Duct Sizes, Set Flow Direction, Show/Update Flow</td>
</tr>
<tr>
<td>Duct Flex</td>
<td>Insert Equipment, Flex Duct Properties, Flex Duct Modify, Calculate Duct Sizes, Set Flow Direction, Show/Update Flow</td>
</tr>
<tr>
<td>Pipe</td>
<td>Insert Equipment, Pipe Properties, Modify Run, Pipe Length, Set Flow Direction, Show Flow</td>
</tr>
<tr>
<td>Pipe Fitting</td>
<td>Insert Equipment, Set Flow Direction, Show Flow</td>
</tr>
</tbody>
</table>

68 | Chapter 3   Getting Started
<table>
<thead>
<tr>
<th>Contextual Tab Name</th>
<th>Unique Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pipe Custom Fitting</td>
<td>Insert Equipment, Custom Fitting Properties, Set Flow Direction, Show Flow</td>
</tr>
<tr>
<td>Plumbing Line</td>
<td>Insert Fitting, Modify Plumbing Line, Add Expansion Loop, Merge Plumbing Line, Size Plumbing Line, Show Objects for Sizing, Reverse Flow</td>
</tr>
<tr>
<td>Plumbing Fitting</td>
<td>Show Connected Objects</td>
</tr>
<tr>
<td>Cable Tray</td>
<td>Modify Cable Tray, Cable Tray Properties, Cable Tray Length</td>
</tr>
<tr>
<td>Cable Tray Fitting</td>
<td>Modify Fitting, Fitting Properties</td>
</tr>
<tr>
<td>Conduit</td>
<td>Insert Equipment, Modify Run, Conduit Length, Show Connected Objects</td>
</tr>
<tr>
<td>Conduit Fitting</td>
<td>Insert Equipment, Show Connected Objects</td>
</tr>
<tr>
<td>Equipment</td>
<td>Modify Equipment, Equipment Properties, Convert to Device, Update Flow</td>
</tr>
<tr>
<td>Panel</td>
<td>Convert to Other Panel, Remove Connection, Circuit Manager, Panel Schedule</td>
</tr>
<tr>
<td>Wire</td>
<td>Circuit Manager</td>
</tr>
<tr>
<td>Schematic Line</td>
<td>Insert Symbol</td>
</tr>
<tr>
<td>Schematic Symbol</td>
<td>Show Connected Objects</td>
</tr>
<tr>
<td>Multiple Objects</td>
<td>Dimensions, Send To..</td>
</tr>
<tr>
<td>Edit in Place: Interference</td>
<td>Zoom to, Tags, Opening Symbols</td>
</tr>
</tbody>
</table>
Application Menu

The application menu contains commands that are relevant for the drawing as a whole.

The application menu contains commands for the following file operations:

- Create new drawings and projects
- Open drawing files, project files, DGN files, and IFC files
- Save drawings to the current file format, to AutoCAD 2007 file format, as DWT file, or as DWS file
- Export files to DGN, DWF, PDF, IFC, gBXML, and DuctXML formats, and previous versions of AutoCAD
- Plot drawings
- Publish drawings to Mapguide, DWF, Seek, and eTransmit
- Access drawing setup and drawing utilities
- Access the program options
- Close drawings and projects
- Exit AutoCAD MEP

Accessing the Application Menu

To access the application menu, click at the upper-left corner of the workspace.

The application menu remains open as long as the cursor is located inside the application menu window. To close the application menu, either activate a menu command, or click outside of the application menu window.

Using the Application Menu to Locate Commands

In the application menu, you can search for a command and then select it from the list of matches. Search results are retrieved from the following locations:

- Application menu
- Static ribbon tabs
- Any contextual tab currently on display
- Quick Access toolbar

You can enter the following strings to search for:

- Display name of the command in application menu, ribbon or Quick Access toolbar. For example, you can enter “Style Manager” or “Plot Preview”.

- Part of the display name: If you are not sure what the exact name is you can enter a part of the name, for example “Style” or “Save”. This will retrieve all commands that contain that string.
Actual command name: You can enter the name of a command as it would be typed on the command line, for example “aecstylemanager” or “dist.” This will retrieve all locations this command can be found in.

**IMPORTANT** When searching for AutoCAD MEP 2011 commands, you must include the Aecb prefix (for example, aecbPipeAdd instead of PipeAdd) to the command.

In addition to instances of the search string, the results include the contents of the associated tooltip and any search tags you have defined in the Customize User Interface editor (CUI). For information about search tags, see Assign Search Tags.

1. At the upper-left corner of the workspace, click to open the application menu.
2. In the text entry box at the top of the menu, enter the desired search term.

A list of matches replaces the regular application menu display.
3 To select one of the found commands, click it.

4 To return to the regular application menu display, click \(\times\) at the right side of the text entry box.

**Displaying Recently Opened Documents in the Application Menu**

The application menu lets you display a list of recently opened documents according to preferences you specify.

1 Click \(\text{Application Menu}\) to open the application menu.

2 At the top of the menu, click Recent Documents. 
3 At the top of the menu, under Recent Documents, specify how you want documents grouped:
■ By access date
■ By Size
■ By Type (DWG, APJ, and DGN)
■ By Ordered List (alphabetical order)

4 At the top right of the list of documents to specify whether to display file type icons or preview images next to the document names.

5 If you want to keep a document in the list, regardless of its last-saved date, click its pushpin so that the image changes from to . The document will remain in the list until you unpin it.

Displaying Currently Open Documents in the Application Menu

The application menu lets you display currently open documents.

1 Click to open the application menu.

2 At the top of the menu, click Open documents .

3 At the top right of the list of documents, to specify whether to display file type icons or preview images next to the document names.
Changing the Number of Recent Files and Actions in the Application Menu

Use this procedure to change the default number (9) of recent documents displayed in the application menu:

1. Click \( \text{\textbullet} \) to open the application menu.
2. At the bottom of the application menu, click Options.
3. On the Open and Save tab of the Options dialog, under Application Menu, change the value for Number of recently-used files.
4. Click OK.

Quick Access Toolbar

The Quick Access toolbar is a customizable toolbar located at the top of the application window, just to the right of the application menu button.

By default, this toolbar contains a set of frequently used commands for the application. You can add and remove commands as needed.

To add a command from the ribbon

1. On the ribbon, locate the command you want to add.
2. Right-click the command, and click Add to Quick Access Toolbar.

NOTE Not all commands can be added to the Quick Access toolbar. If a command is ineligible, the Add to Quick Access Toolbar command is not visible in the context menu.

To add other commands to the Quick Access Toolbar

3. On the Quick Access toolbar, click the down arrow at the right end of the toolbar, and select More Commands.
4. In the Customize User Interface Editor, select the command you want to add and drag it onto the Quick Access toolbar.
To remove a command from the Quick Access toolbar

➤ Select the command on the Quick Access toolbar, right-click, and click Remove from Quick Access Toolbar.

Context Menus

When you right-click in the drawing area, the content of the context menu depends on the currently selected object(s). For example, if one or more duct objects are selected, a duct-specific context menu is displayed as shown.

Duct context menu

Most commands that can be found on the context menu of an object exist in the contextual ribbon tab of the object, too.
If more than one type of object is selected, the context menu includes only those commands that can be applied to all the selected objects. Likewise, the ribbon displays a Multiple Objects contextual tab that contains only the applicable commands. If no objects are selected, the general context menu is displayed as shown below. This menu contains non-object-specific commands.

**General drawing context menu**

![General drawing context menu](image)

**Tool Palettes**

Tool palettes provide the main method for accessing tools to create objects in your model. You can have tools for standard objects as well as for objects with specific styles and properties. Tool palettes are organized by tool palette groups in a tool palettes set. You can create your own tool palettes, or you can copy existing tool palettes from the Content Browser.

For more information, see [Working with Tool Palettes](page) on page 129.

**Properties Palette**

The Properties palette provides a central location to view and modify both the physical and graphical properties of an object. The object can be one you are about to draw, or one that is already selected in the drawing area. Using the Extended Data tab of the Properties palette, you can also attach other kinds of information to an object, such as classifications, notes, reference documents, hyperlinks, and property set data. You typically keep the Properties palette open during an AutoCAD MEP session.
For more information, see Working with the Properties Palette on page 135.

**Drawing Status Bar**

Located at the bottom of the drawing area, the drawing status bar displays status information about the current drawing and provides access to the following commands that can be applied to the drawing.

The drawing status bar contains the following information and controls:

- **Project Information**: If the drawing is part of an AutoCAD MEP project, this information includes the name of the project and the type of file, (such as View or Construct). For more information, see Concepts of Drawing Management.

- **Annotation Scale**: To change the annotation scale for the current viewport, click the current value, and select a new one from the list. Changing the scale may also change the Level of Detail setting described below.

- **Annotation Visibility**: Click to show annotative objects for all scales. Click to automatically add scales to annotative objects when the annotation scale changes.
- Level of Detail: Shows the current display configuration of the active viewport and provides a drop-down list from which you can select another configuration.

- Cut Plane: Identifies the global cut plane height for the active display configuration and provides access to a dialog that lets you adjust the setting. For more information, see Overriding the Cut Plane on page 232.

- (Surface Hatch Toggle): Lets you switch the display of surface hatching on or off. For more information, see Working with Surface Hatches.

- (Layer Key Overrides): Lets you switch layer key overrides on or off in the Layer Key Overrides dialog. For more information, see Layer Key Overrides.

- (Isolate Objects): Lets you hide or display objects you have selected in the drawing.

- (AEC Project Standards): When a project is loaded, click here to synchronize or configure standards for the current project. For more information, see Project Standards Overview.

- (Autodesk Trusted DWG): This icon indicates that you have opened a DWG, DWT, or DWS file that is created using Autodesk applications or RealDWG™-based applications.

- (Manage Xrefs): Click to open the External References palette, where you can reload xrefs that are associated with your current drawing.
Missing Standards File(s): When applicable, this warning indicates that standards files are missing in the current drawing; you can then check settings for the standards and configure them as necessary. For more information, see Configuring Project Standards.

Drawing Status Bar Menu: A drop-down list of the settings and commands available for display on the drawing status bar.

Showing and Hiding Commands on the Drawing Status Bar

You can specify which features on the drawing status bar menu are shown or hidden as needed.

1. At the right end of the drawing status bar, click the drawing status bar menu arrow.

2. Select commands you want show, and clear commands you want to hide.

Showing and Hiding the Drawing Status Bar

The drawing status bar can be turned on and off from the ribbon or from the application status bar on page 81.

To show and hide the drawing status bar, click View tab ➤ Windows panel ➤ Drawing Status Bar.
Command Line

You can directly enter commands using the command line window located immediately below the drawing status bar.

To hide and display the command line window, click View tab ➤ Windows panel ➤ Command Line .

If you want to hide the floating command line window except for its title bar when you are not using it, click on the title bar of the command line window. Moving the cursor over the title bar will redisplay the command line window. This icon is not displayed when the command line is docked at the bottom of the drawing area.

Floating command line

Application Status Bar

The application status bar contains settings for the current drawing session. Some settings, such as options for different elevations, only display if you are working within a project.

The group of commands on the left side of the application status bar can be displayed as icons or text labels.

Commands displayed as icons

Commands displayed as text labels

To change the display of these commands right-click any of them, and select Use Icons.
To activate or deactivate any of the commands in this group, click the icon or label. Blue indicates an active control; gray indicates an inactive control. To change the settings for one of these commands, right-click the icon or label, and click Settings.

For detailed information about these options, see Use Precision Tools.

The following commands and settings are available on the application status bar:

- **Cursor coordinate values**: Controls the coordinate format as either relative or absolute. For more information, see Overview of Coordinate Entry.

- **(Snap)**: Lets you restrict the movement of the cursor to the drawing grid.

- **(Grid)**: Lets you display a rectangular grid as a drawing aid.

- **(Ortho)**: Lets you restrict cursor movement to horizontal and vertical directions when creating and modifying objects.

- **(Polar Tracking)**: Lets you restrict cursor movement to specified angles.

- **(Object Snap)**: Lets you restrict movement of the cursor to specified points on objects, such as the midpoint or an intersection point.

- **(Object Snap Tracking)**: Lets the cursor track along alignment paths based on other object snap points when specifying points in a command. This feature can be used only in conjunction with Object Snap.

- **(Dynamic UCS)**: Lets you temporarily and automatically align the XY plane of the UCS with a plane on a solid model while creating objects.

- **(Dynamic Input)**: Lets you enter values for objects directly onscreen near the cursor. Dynamic input can be turned on and off during creating or editing an object in the drawing area.

- **(Lineweight)**: Lets you turn the lineweight display component on or off for objects in the drawing. In model space, lineweights are displayed...
in pixels and do not change when zoomed in or out. Displaying the lineweight could create some very heavy line display.

- **Quick Properties**: This feature is intended for AutoCAD objects and is turned off in AutoCAD MEP.

- **Model Space** or **Paper Space**: Switches between layouts. For more information, see Work with Model Space and Paper Space.

- **Quick View Layouts**: Lets you preview model space and all layouts in a drawing as a horizontal row of images. Click on a preview image to display the layout. For more information, see Quick View Tools.

- **Quick View Drawings**: Lets you preview all currently open drawings with their model space and layouts. Click on the preview image to display the drawing or layout. For more information, see Quick View Tools.

- **ShowMotion**: Provides an onscreen display that can be used to create, select, and play back cinematic camera animations called shots. These animations can be used for presentation purposes or for navigation. For more information, see Define and Change Views with ShowMotion.

- **Pan**: Lets you drag the view to reposition it within the drawing area.

- **Zoom**: Lets you increase or decrease the apparent size of objects in the drawing area.

- **SteeringWheel**: Lets you display a tracking menu containing different navigation tools. For more information, see Navigate with SteeringWheels.

- **Workspaces**: Lets you switch between workspaces. For more information, see Workspace Fundamentals on page 51.

- **Toolbar/Window Positions**: Lets you switch between docked windows and toolbars and floating windows and toolbars.
■ **Elevation**: Click to open the Elevation Offset dialog. Select a level for the calculation of the elevation offset. This option is available only if your current drawing is a construct drawing from an AEC project.

■ **(Replace Z value with current elevation)**: Can be switched on or off, replacing the existing Z value with the current elevation.

■ **(Clean Screen)**: Click to switch between the standard screen and a full screen. In full-screen mode, all toolbars and palettes (except the tool palettes) are hidden. Hidden palettes retain their current state.

### Showing and Hiding Commands on the Application Status Bar

You can show or hide individual commands on the application status bar menu.

1. At the right end of the application status bar, click the application status bar menu arrow.

![Application Status Bar Menu](image)

2. Select commands as desired.

**NOTE** Alternatively, you can click View tab ➤ Windows panel ➤ Status Bar to access these commands.
# Project Navigator Palette

The Project Navigator palette is the central location to create, modify, and access AutoCAD MEP project files. You typically have the Project Navigator palette open in the workspace while you work on a project. For more information, see Concepts of Drawing Management.

---

## Finding Information in AutoCAD MEP

In addition to online help, AutoCAD MEP provides various ways to quickly access the information you need to be successful with new and existing features. Review the sections below to learn how you can get help quickly and with minimal disruption of your workflow.

---

## InfoCenter Toolbar

InfoCenter is a central location where you can search for product-related help and other information sources. You can search for information through keywords (or by typing a phrase), display the Communication Center panel for product updates and announcements, or display the Favorites panel to access saved topics.
When you enter keywords or type a phrase, and then press ENTER or click the Search button, you search multiple Help resources in addition to any files that have been specified in the InfoCenter Settings dialog. The results are displayed as links on a panel. You can click any of these links to display the Help topic, article, or document.

In addition, Communication Center displays Did You Know balloons for selected feature areas. These balloons provide knowledge base information and general instructional messages such as tips. You can click on the arrow icon to expand the balloon to view the detailed information.

**Example of Did You Know balloon**

For detailed information about InfoCenter, see Find Information Using InfoCenter.

**Help Menu**

With the removal of the menu bars, the commands to access Help features have been moved into the InfoCenter at the top right of the application window. Here, you can find the Help menu that lets you access Help and other interactive resources.
Help menu

Communication Center

Communication Center is accessed from the InfoCenter toolbar. This resource displays links to information about product updates and product announcements, and may include links to Subscription Center, CAD Manager specified files, and RSS feeds.

F1 Context Help

For many commands and dialogs you can access a context-related Help topic using one of the following methods:

- Press F1 while a command is active or a dialog is open.
- Press F1 while a ribbon tooltip is displayed.
- Click the Help button in a dialog.

Tooltips

In addition to interactive tooltips that help you to create and edit objects (see Direct Editing with Grips and Dynamic Dimensions), AutoCAD MEP provides tooltips that display information about the command, option, or file over which you pause the cursor.
Command Tooltips

A short description displays whenever you pause the cursor over a command in any of the following locations:

- The ribbon
- The Quick Access toolbar

For some commands, an extended tooltip displays after a user-specified time interval.

**Standard tooltip for command**

![Standard tooltip example]

**Extended tooltip for command**

![Extended tooltip example]

Controlling the Display of Command Tooltips

You can change the display of command tooltips. For extended tooltips, you can define a time interval between the display of the basic tooltip and the extended tooltip.

1. Click ➤ Options.
2 Click the Display tab.
3 Under Window Elements, select Show Tooltips.
4 If you want to change the time interval between displaying the basic tooltip and the extended tooltip, select a different value for Number of seconds to delay. If you want to turn off the extended tooltip information completely, deselect Show extended Tooltips.

Dialog and Palette Tooltips

The following dialogs and palettes support extended tooltips:

- Project Browser dialog
- Project Navigator palette
- Drawing Compare palette
- Interference Detection palette
Object Rollover Tooltips

When you pause the cursor over an object in the drawing area, an informational tooltip displays basic information about the object.

Unlike the rollover tooltips provided for AutoCAD objects, such as lines or polylines, this information is standardized and cannot be changed. For information on how to configure rollover tooltips for AutoCAD objects, see Rollover Tooltips.

Property Palette Tooltips

The Properties palette displays tooltips when you hover the cursor over a property in the list.
Thumbnail (Preview) Tooltips

In the Project Navigator, you can display thumbnail previews of project drawings. The preview can be a graphic or a detail, or a combination of both. Displaying thumbnails can be helpful when you are navigating large projects with many drawings.

To activate preview tooltips in Project Navigator

1 On the Quick Access toolbar, click (Project Navigator).
2 Open the Constructs, Views, or Sheets tab
3 Right-click in the toolbar area at the bottom of the tab.
4 Click Tooltip style, and select one of these options:

<table>
<thead>
<tr>
<th>Tooltip Style Option</th>
<th>Tooltip Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays only the name of the drawing file. Use this option if you want to maximize the file tree visibility.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays only a preview image of the file. You can specify the preview size (Small, Medium, or Large).</td>
</tr>
<tr>
<td>Tooltip Style Option</td>
<td>Tooltip Display</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Details</td>
<td>Displays a text description of the file, identifying its location, size, last-saved date, and last editor.</td>
</tr>
<tr>
<td>Preview &amp; Details</td>
<td>Displays a preview image and a text description. You can specify the preview size (Small, Medium, or Large).</td>
</tr>
</tbody>
</table>

5 If you want to display the information provided with the preview and detail tooltips, right-click, and click Preview/Details Pane. This option displays either a text description, or a preview of a selected graphic in an area below the file tree.

**Solution Tips**

The intended interaction among objects in an AutoCAD MEP drawing depends on various rules about how objects are placed in relation to one another.
Whenever the software identifies a problem with the placement of objects or their components, a solution tip icon is displayed to identify the location of the problem, as shown.

Move the cursor over the icon to display a message that describes the problem and provides one or more possible solutions. Some solution tips provide complete instructions for resolving the problem. Where more detailed instructions are required, you can press F1 to access the relevant topic in Help.

Note that not all object configuration problems have an easily identifiable cause or a specific solution. This is often true in the case of boolean operations where an entity such as a body modifier is added to or subtracted from an object. In these cases, the solution tip identifies the kind of object or component involved and suggests corrective action. You may be advised to modify the location or the geometry of the object, but it is essentially a trial-and-error approach. The messages are tips rather than guaranteed solutions.

By default, solution tip icons are displayed when you are drafting, but not during plotting or publishing. You can change these settings in the Options dialog using the following procedure:
1 Click ➤ Options.
2 In the Options dialog, click the AEC Editor tab.
3 In the Solution Tip panel, select or clear Drafting and Plotting/Publishing as desired.

**Object Grip Tooltips**

Objects in AutoCAD MEP have grips to manipulate them. Each grip has a tooltip that displays the function of the grip.

Pipe fitting grips and tooltip

When you use a grip to edit an object, in many cases additional information appears in a tooltip, helping you to perform the grip action.

For more information, see Direct Editing with Grips and Dynamic Dimensions.

**Working in Model Space and Paper Space**

There are 2 distinct working environments in which you can create objects in an M/E/P drawing:

- **Model Space.** This space is a limitless, 3D drawing area. In model space, you draw, view, and modify your building system designs.

- **Paper Space.** This space is a 2D sheet layout environment. In paper space, create specific views of your designs, add annotation, and create plotting sheets.

In AutoCAD MEP, these spaces are accessible on 2 or more tabs at the bottom of the drawing area: the Model tab, the Work tab, and one or more sheet tabs. They are turned off by default.
- **Model Tab.** This tab is available on both the model and sheet templates. It can be set to only TILEMODE 1, which means you can divide the drawing area into multiple viewports (a process called tiling). Each tiled viewport can display a different view of the model. For example, one viewport might display a plan view, and another might display a side view. The same display configuration must be used in all tiled viewports, and you cannot use floating viewports or freeze different layers in different tiled viewports.

- **Work Tab.** Available on the model templates, this tab enables you to work with your design in both plan and 3D at the same time. The tab contains 2 viewports, each of which is assigned a default display configuration. One viewport is assigned a Top (plan) view direction for working with schematic, single-line, double-line, or reflected ceiling plans. The other viewport is assigned an isometric view direction for creating isometric drawings and performing other tasks better suited to an isometric view. You can create a copy to add a second work tab, or delete the work tab if it is not needed for a particular project.

- **Sheet Tabs.** These tabs (also called layout tabs) are available on the sheet templates. Use the tabs to configure a layout of your drawing for plotting or printing. The sheet tabs include a border and title block, which you can modify and apply to your projects or replace with a custom border and title block.

There are advantages to working on tabs other than the Model tab. On other tabs, you can assign different display configurations to different viewports, freeze different layers in different viewports, and use floating viewports.

By default, you can switch between tabs using the status bar buttons on the application status bar.

The tab controls are provided as status bar buttons to maximize your drawing space.

To display the actual tabs, right-click the Model or Work icon, and click Display Layout and Model tabs.

The default templates provided with the software each include one or more layout tabs for designing and plotting building systems. The tabs are configured to promote efficient and accurate designs.
For more information on working in model space and paper space, see Work with Model Space and Paper Space.

Customizing the Display of MEP Objects

Custom Display is a special editing mode for making on-screen changes to the components of an MEP object in plan view. For example, you might want to add unique line work, such as vanes, hangers, and accessories to objects and fittings. Or, while working on a mechanical layout with piping, you might have a rack layout to which you want to add pipe breaks in order to see multiple elevations of the rack in a plan view. Finally, while placing equipment, such as electrical panels or base-mounted pumps, you might want to use a hidden line to indicate equipment pads or the access space required by the manufacturer around the equipment.

NOTE You can edit duct, pipe, cable tray, conduit, Multi-View Parts, wires, devices, and panels using Custom Display. However, Custom Display is not available for plumbing lines and fittings, or for schematic objects and symbols.

You can use Custom Display to edit objects that reside in externally referenced drawings (xrefs). When you save the changes, they do not affect the xref drawing itself. The custom display is valid only as long as the xref is associated with the same host drawing.

When the Custom Display mode is active, you can continue to add to other MEP objects in the drawing, but not to the object being edited. Also, you can use commands to add and delete linework for the object being edited.

NOTE If you share drawings with users who are using an earlier version of AutoCAD MEP, they will be able to see and remove custom displays. However, they will not be able to edit the custom displays.

Using Custom Display

When you begin a Custom Display session, a temporary in-place edit profile is drawn around the object being edited, and all other objects in the drawing are unavailable and dimmed.
NOTE You can change the brightness of the dimming that appears during a Custom Display mode session. Click ➤ Options ➤ Display tab. Under Fade Control, for In-place edit and annotative representations, enter a value or drag the slider, then click OK.

After making changes, you can save the changes and exit the Custom Display session. Alternatively, you can discard the changes before exiting to revert to the original state of the object.

To customize the display of an object

1. On the command line, enter `objectgraphicsedit`.
2. Select the object to edit.
3. To zoom to the object, click Edit In Place ➤ Graphics panel ➤ Zoom To.
4. Add to, modify, or delete the graphics for the object.
   For example, you might want to add linework to indicate an equipment pad and an access area for a chiller.
5. To save the changes and exit, click Edit In Place ➤ Edits panel ➤ Finish. Otherwise, to discard the changes and exit, click Edit In Place: Graphics tab ➤ Edits panel ➤ Cancel.

NOTE Objects edited using Custom Display use the Custom Graphics display component. After an object has been edited using this method, any display overrides applied to the object, its style, or its system are ignored.

To remove the custom display for an object

1. On the command line, enter `objectgraphicsoverrideremove`.
2. Select the object from which to remove the custom display.
   You can also select the object, right-click, and click Remove Custom Graphics.

NOTE With the exception of MvParts, when an object is moved, custom displays are removed.
Drawing Essentials

Default preferences, such as part catalogs and system layout settings, can be specified once and used repeatedly. Using one set of preferences for multiple drawings can help to maintain conformity to project standards, but designers can also draw systems without having to configure preferences first.

Drawing Preferences

Drawing preferences control the form and function of your designs. There are 2 general types:

- Layout preferences
- Initialization preferences

You can specify preferences for a single drawing, or save them in a template to be shared by a design team.

The AutoCAD MEP sample templates include default preferences, so you can begin designing immediately. As you become more familiar with the software, you can experiment with different settings until you create the drawing environment that best suits your needs.

About Layout Preferences

Layout preferences are based on specific drafting or design requirements. Typically, you apply them to a specific mechanical/electrical system and change them as needed to achieve the desired design. Examples include settings for the
default parts and the connections to use during layout. For more information, see

- Configuring Duct Layout Preferences on page 279
- Configuring Pipe Layout Preferences on page 432
- Configuring Layout Preferences for Cable Tray or Conduit on page 554

**NOTE** You can specify additional preferences for electrical and plumbing drawings. For more information, see Configuring Electrical Preferences on page 538 and Specifying Plumbing Preferences for Labels and Flow Arrows on page 727.

### Initialization Preferences

Initialization preferences are settings that you typically specify at the start of a project, you apply to all systems, and you do not change during the design process. Examples include settings for crossed objects, general connection rules, and the file locations for catalogs and style-based content.

Initialization preferences can be accessed from the Options button on the Application menu. Drafting settings control the on-screen behavior of the cursor by specifying parameters such as snap increments for distances and angles. They also control how an object being drawn will snap to existing drawing objects. The Options dialog also contains settings for default part catalogs, building elevations, drawing layout behavior, and tooltip displays.

### Specifying Part Catalogs and Style-Based Content Locations

1. Click ➤ Options.
2. In the Options dialog, click the MEP Catalogs tab.
3 Under Catalogs, expand a domain-specific category (for example, duct) and specify the catalogs you want available during layout. Part catalogs have an APC (Autodesk Part Catalog) file extension. If you want to... Then ...

- **add a catalog**
  - select the category to which you want to add the catalog, and click Add. In the file selection dialog, navigate to the catalog (APC file), select it, and click Open.

- **remove a catalog**
  - select the catalog, and click Remove.

- **specify a different catalog**
  - Select the catalog that you want to replace, and click Browse. In the file selection dialog, navigate to the catalog (APC file), select it, and click Open.
If you want to ... Then ...

re-order catalogs select the catalog, and click Move Up or Move Down as needed. The order in which the catalogs are listed on the MEP Catalogs tab is also the order in which they are listed during part selection during layout.

4 Under Style-Based Content Paths, for each type of content (electrical devices, electrical panels, plumbing fittings, and schematic symbols), specify the folder that contains the content you want available during layout. To do so, click the value for Path, and click . In the folder selection dialog, browse to the folder, select it, and click Open.

NOTE The Shared Content Path specifies the location for generic part templates, primitives (limited part models from which you can quickly build complete parts), and other configuration files required by the software. It is shared in the sense that it is required by the software regardless of the specific content packs (Global, U.S. Metric, and so on) you are using.

AutoCAD MEP includes part catalogs and content libraries, respectively, containing hundreds of industry-standard parts and style-based objects. However, you can also create your own custom catalogs and custom content. For more information, see Customizing Catalogs on page 1151, Customizing Catalog-Based Content on page 957, and Customizing Style-Based Content on page 891.

IMPORTANT To facilitate the process of upgrading to a new version of AutoCAD MEP, add all of your custom parts to custom catalogs; do not add custom parts to the catalogs provided with the software. When you upgrade, this allows you to easily move your custom catalogs to the appropriate locations in your new installation (where new versions of the catalogs provided with the software are located).

In the Options dialog, you specify the locations of the content (part catalogs and style-based content) you need available during layout. If the content is stored on your computer, you specify local locations in the dialog. If it is stored on a network because it is shared by multiple users, you specify network locations.
You can specify multiple part catalogs for a category. For example, you can specify the duct catalog provided with the software and a custom duct catalog for the Duct category. However, if 2 parts in different catalogs have the same ID or the same name, only the part in the catalog that is higher in the list will be displayed during part selection (for example, when adding MvParts to a drawing or when selecting pipe fittings for a routing preference definition).

**Layout Rules**

You can configure layout rules for system connections, the use of non-standard parts, and the display of interferences between drawing objects.

**Part Connection Rules**

You can allow or prevent connections between dissimilar parts. In general, you do not want to connect dissimilar systems. For unique design situations, however, you might want to allow such a connection or be prompted on a case-by-case basis.

For example, you might be drafting a water supply layout where you define one system for cold water and another for hot water. During layout, rather than having a third system for the main supply that enters the building, you might draft the main supply pipe on the cold water system and connect to the hot water heater that is a part of the hot water system. In this case, you would want to connect the hot water and cold water systems. You could configure layout rules to either allow the connection automatically or prompt you before making the connection.

For a connection to be valid, the connected parts must be assigned to the same system group and the connector style rules must be met. System groups are configured for part system definitions, and they enable you to connect different part systems that are assigned to the same system group. For example, you can connect medium-pressure supply duct to low-pressure supply duct if both are assigned to the supply system group.

When a connection test fails, you can prevent a connection from being made. You can also allow a connection of dissimilar systems, or allow a connection when the system of the part being drawn is automatically changed to match the system to which it is connecting.

**NOTE** It is recommended that you use Prompt for user input as the default preference until you become familiar with AutoCAD MEP.
## Configuring Connection Test Rules

1. Click ➤ Options.
2. In the Options dialog, click the MEP Layout Rules tab.
3. Under Connection Test Mismatch, select a rule:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>Then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>draw the part to the selected point without connecting to the existing part</td>
<td>select Do not make connection.</td>
</tr>
</tbody>
</table>
| be prompted before connecting to an existing system | select Prompt for user input. If you accept a connection between dissimilar systems, you have 2 options:  
- You can establish a valid connection by changing the part’s system to match the existing system.  
- You can ignore the system and create an invalid connection. |

**NOTE** If you select this option, when you are connecting devices with wires, and the system of the wire does not match the system of the electrical connector on the device, you cannot add the wire.

**NOTE** If you select this option, when you are connecting devices with wires, and the system of the wire does not match the system of the electrical connector on the device, you are prompted to accept the change of the system of the connector. If you do not accept the change, you cannot add the wire. The system of the device, which only determines how the device is displayed, is not affected.
Then…

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>Then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>always connect the parts and change the part’s system to match the existing system</td>
<td>select Automatically match and make connection.</td>
</tr>
</tbody>
</table>

**NOTE** If you select this, when you are connecting devices with wires, and the system of the wire does not match the system of the electrical connector on the device, you can add the wire. The system of the connector on the device is automatically changed. The system of the device, which only determines how the device is displayed, is not affected.

### Standard and Custom Part Sizes

You can specify that custom sizes can be used for parts during layout, or you can allow only defined part sizes in the part catalog. For example, when creating a piping layout you might need an elbow with an angle that does not match any elbows in the part catalog. An elbow with the custom angle can be automatically created in your layout.

If you use custom sizes, any custom parts created are available only in the current drawing and are not saved to the part catalogs for future use. If your designs require custom sizes on a regular basis, see Customizing Catalog-Based Content on page 957.

### Configuring Part Selection

1. Click ➤ Options.
2. In the Options dialog, click the MEP Layout Rules tab.
3. Under Part Selection, select the sizing option you want to specify:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>Then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>allow only standard sizes from the part catalog</td>
<td>select Use Catalog Parts Only.</td>
</tr>
</tbody>
</table>

Initialization Preferences | 105
If you want to... | Then...
---|---
be prompted before choosing a custom size for a part | select Prompt when Non-Standard Parts are Needed. If you accept the proposed part, the custom part is created. If you decline, the last segment drawn is removed.
always allow custom sizes for parts | select Use Non-Standard Parts.

Defining System Elevations

1 Click ➤ Options.
2 In the Options dialog, click the MEP Elevations tab.
3 Define the elevation:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>add an elevation</td>
<td>click and specify the name, elevation, and description.</td>
</tr>
<tr>
<td>edit an elevation</td>
<td>select an elevation. Click in the name, elevation, or description field and edit the text.</td>
</tr>
<tr>
<td>delete an elevation</td>
<td>select an elevation and click .</td>
</tr>
</tbody>
</table>

You can define elevations to use for your systems during layout. You can create elevations for different systems on the same floor or for multiple floors in a single building. You can also manually enter elevations as you add parts, but using defined elevations maintains accuracy and saves time.

For example, if you want all air supply ducts on the first floor to have an elevation of 12'-0'', create an elevation of 12'-0'' with the name Supply - 1st Floor. You can select this elevation when adding duct in the drawing. All non-vertical duct segments and fittings in the run are automatically placed at 12'-0''.

106 | Chapter 4  Drawing Essentials
Configuring Tooltip Settings

Tooltips are displayed when you hover the cursor over items such as menus, icons or palettes. AutoCAD MEP tooltips provide a quick view of object information, such as the object name, the system to which it is assigned, and its elevation.

To specify the information displayed in AutoCAD MEP tooltips

1. Click ➤ Options.
2. In the Options dialog, click the Display tab.
3. Under Window Elements, specify the desired tooltip options.

You can also control the color, size, and transparency of tooltips. See Tooltip Appearance Dialog Box for more information.

AutoCAD MEP Snaps

AutoCAD MEP includes 2 kinds of snaps:

- **Object Snaps.** These are standard AutoCAD® snaps that allow you to snap drawing points to geometric locations on other objects. For example, you can snap to the endpoint of a line, or snap to the intersection of 2 lines.

- **AutoCAD MEP Snaps.** These enable you to snap objects intelligently to other building system objects, thereby creating valid connections with existing systems. AutoCAD MEP snaps are available for schematic, duct,
pipe (also used for plumbing), electrical, and wire way systems (cable tray or conduit). You can use the snaps to quickly and precisely draw a system that is fully connected. For example, if the snaps for pipes are turned on, you can draw a pipe and connect it to an existing pipe run. When you snap the pipe to the run, the software creates a valid connection, which maintains the integrity of the pipe system.

There are 2 types of AutoCAD MEP snaps: end connectors (often referred to as just connectors) and curve connectors. Use end connectors to connect new objects to the ends of existing objects. Use curve connectors to connect new objects anywhere along the centerlines of existing objects.

When you use AutoCAD MEP snaps, the software inserts an appropriate fitting when needed, as shown in the following example of adding a pipe branch.

When you turn on AutoCAD MEP snaps, they remain on until you turn them off. If the snaps are off when you use an Add command, the relevant AutoCAD MEP snap is turned on only for the Add command. For example, if all AutoCAD MEP snaps are off and you start the plumbing line Add command, the Pipe Curve and Pipe Connector snaps are turned on. Once you exit the plumbing line Add command, the Pipe Curve and Pipe Connector snaps are turned off.
**TIP** Press Shift-F3 to toggle AutoCAD MEP snaps on or off. You can also enter the following AutoCAD MEP snaps on the command line, which can be helpful if you miss a connector during object selection: SCON (Schematic Connector), DCON (Duct Connector), PCON (Pipe Connector), ECON (Electrical Connector), WCON (Wire Way Connector), SCUR (Schematic Curve), DCUR (Duct Curve), PCUR (Pipe Curve), ECUR (Electrical Curve), and WCUR (Wire Way Curve).

**RELATED** For more information, see Pipe Snaps on page 409, Duct Snaps on page 264, and Electrical and Wire Ways Snaps on page 523.

### Configuring AutoCAD MEP Snaps

Use this procedure to turn AutoCAD MEP snaps on or off.

1. On the application status bar, right-click (object snap), then choose Settings.
2. In the Drafting Settings dialog, click the Object Snap tab, and then scroll down to AutoCAD MEP.

![Object Snap Settings](image)

3. Click to select the snaps you want to activate. You can also click the check box to the right of the AutoCAD MEP title bar to select...
all the snaps at one time. Click the check box again to clear all the AutoCAD MEP snap selections.

**TIP** As a shortcut, press Shift-F3 to toggle AutoCAD MEP snaps on or off.

### Mechanical, Electrical, and Plumbing Equipment in Building Systems

You can lay out a building system design by adding mechanical, electrical, and plumbing equipment to your drawing or modifying the layout as the design changes.

In the software, equipment is referred to as Multi-view Parts, MvParts, or parts. MvParts model the size and shape of a part, and they can intelligently connect to AutoCAD MEP parts. The software includes hundreds of MvParts commonly used in commercial, institutional, and industrial building systems. You can place these parts accurately in your drawing and also modify their size, elevation, or location. See the following topics for more information:

<table>
<thead>
<tr>
<th>MvPart</th>
<th>Adding</th>
<th>Modifying</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical</td>
<td>Adding Electrical Equipment on page 620</td>
<td>Modifying Electrical Equipment on page 668</td>
</tr>
<tr>
<td>Pipe</td>
<td>Adding Pipe Equipment on page 427</td>
<td>Modifying Pipe Equipment on page 474</td>
</tr>
<tr>
<td>Duct</td>
<td>Adding HVAC Equipment on page 290</td>
<td>Modifying HVAC Equipment on page 346</td>
</tr>
<tr>
<td>Plumbing (and fixtures)</td>
<td>Adding Plumbing Equipment and Fixtures on page 728</td>
<td>Modifying Plumbing Equipment and Fixtures on page 739</td>
</tr>
</tbody>
</table>

MvParts are organized by type and stored in part catalogs. You or your CAD manager can customize part catalogs or create custom parts to meet company standards or project requirements. For more information, see About Catalog Editor on page 1152 and Content Builder on page 964.
The part catalogs available to you during a drawing session are specified in the initialization preferences. For more information, see Specifying Part Catalogs and Style-Based Content Locations on page 100.

Architectural drawings referenced in an AutoCAD MEP drawing can contain MvBlock parts that might be useful as MvParts. MvBlocks are similar to MvParts in that they can be viewed from different directions (such as isometric or orthographic). However, MvBlocks cannot connect intelligently in a building system. Instead, you can convert MvBlocks into MvParts and then assign engineering information and connectors to them for use in the building system.

For example, in the HVAC workspace on page 53, the reference drawing may contain an MvBlock of an air grille that you want to connect to your HVAC network. You can convert the grille to an MvPart with duct connections. Similarly, a plumbing drawing might contain a sink as an MvBlock that you want to connect to your plumbing system. You can convert the sink to an MvPart and then specify the water supply and drain connectors. For more information, see Converting MvBlocks to Block-Based Parts on page 1110.

The following sections describe the different types of equipment.

**About Electrical Equipment**

Unlike devices, panels, and wires, electrical equipment does not work with circuits. You can only connect equipment to physical wireways such as conduit and cable tray. In some cases, such as a junction box, there are both devices and MvParts available in the electrical catalogs. The junction box device works with circuits and connects to wires. The junction box MvPart connects with conduit based on the conduit’s nominal size. Nominal size (also called trade size) is a diameter dimension provided in addition to actual outside diameter values, in compliance with industry standards.

Electrical drawings are usually shown in 2D, where devices and panels are represented with symbols, and wiring is represented with single lines. In plan

About Electrical Equipment | 111
view, electrical MvParts display the actual part geometry to scale. You can
display equipment in 3D. For example, you might want to show a 3D model
that includes the electrical equipment, conduits, and cable trays for the
building. In this case, you can display the real-world geometry of the objects
in a 3D view.

Examples of electrical equipment

For more information, see Adding Electrical Equipment on page 620 or
Modifying Electrical Equipment on page 668.

About Pipe Equipment

The software includes a plumbing part catalog that contains hundreds of parts
in thousands of sizes. Pipe MvParts range from large equipment, such as chillers
and cooling towers, to small components, such as valves and fire sprinklers.
The following example shows Pipe MvParts in an isometric view.
You can change an MvPart from one type to another on page 477. For example, you can change a ball valve to a butterfly valve. In the part catalogs, parts are divided into types, such as valves. The Valves type is divided into subtypes such as ball, butterfly, gate, and globe.

For more information, see Adding Pipe Equipment on page 427 or Modifying Pipe Equipment on page 474.

About Mechanical Equipment (HVAC)

The software includes an HVAC part catalog that contains hundreds of parts in thousands of sizes. The part types range from large components, such as rooftop air conditioning units, to small components, such as grilles. For some HVAC parts, such as air terminals and VAV boxes, you can assign flow values; these values can be used to calculate duct sizes.

The following example shows mechanical MvParts (HVAC domain) in an isometric view:
About Plumbing Equipment and Fixtures

The software includes a plumbing part catalog that contains hundreds of parts in thousands of sizes. The part types include plumbing equipment, such as pumps and water heaters, and plumbing fixtures, such as drains, water closets, and sinks. The following shows a few examples.

Plumbing equipment

- Hot water boiler
- Rack-mounted water filter
For more information, see Adding Plumbing Equipment and Fixtures on page 728 or Modifying Plumbing Equipment and Fixtures on page 739.

Working with Catalog-Based Content

Building systems are typically assembled from fabricated, off-the-shelf components. Catalog-based content refers to objects defined by part definitions and associated part models, and that are grouped into part catalogs. The part catalogs included with AutoCAD MEP offer an extensive collection of parts for use during design. You can query the part catalogs to assist with part selection, retrieve parts for integration into your designs, and store parts you create in a catalog for future use.

You specify systems for catalog-based content. A system stores properties that are shared by all building system objects assigned to the system. This gives a consistent look and feel to the building systems in a drawing. For more information, see Working with Systems on page 138.

Parts of a mechanical system
Parts of an electrical system

Parts of a plumbing system

The following part catalogs are available in both metric and imperial units:

- Cable Tray
- Conduit
- Fittings
- Duct
- Pipe
- MvParts on page 110 for all building systems disciplines

NOTE U.S. metric content is developed based on the U.S. General Services Administration (GSA) standards for metric design. U.K. and Global metric content is developed based on the British Standards Institute (BSI) standards for metric design.

As you design systems, the parts and style-based content available to you depends on the catalogs and content locations you have specified on the MEP Catalogs tab of the Options dialog. For more information, see Specifying Part Catalogs and Style-Based Content Locations on page 100. If you require a part that is not available, you can create catalog parts using Content Builder, a content creation tool that includes 3D modeling and 2D drawing features. You can create 2 types of parts: parametric or block-based.
RELATED For more information about each type, see Understanding Parametric and Block-Based Parts on page 957. To create parametric or block-based content, see Working with Parametric Parts on page 970 or Working with Block-Based Parts on page 1110. For information about using Content Builder to create parts, see Building Parametric Fittings Using Content Builder on page 970 and Creating Block-Based Parts Using Content Builder on page 1127.

BEST PRACTICE To facilitate the process of upgrading to a new version of AutoCAD MEP, add all your custom parts to custom catalogs. Do not add custom parts to the catalogs provided with the software. When you upgrade, this allows you to easily move all of your custom catalog content as a whole to the catalog folders for the new version (where new versions of the catalogs provided with the software are also located). You can use both types of catalogs during layout if you specify multiple catalogs for a domain, as described in Specifying Part Catalogs and Style-Based Content Locations on page 100.

How Catalog Parts are Stored and Referenced

AutoCAD MEP part catalogs are typically organized in chapter folders grouped by related parts. Within the chapters reside part families that store individual part sizes. A part family is a group of related part sizes. The following example shows the organization of a pipe part catalog.

Example of US Imperial pipe parts catalog

NOTE The organization of the pipe parts catalog varies depending on the profile in which you are running AutoCAD MEP. For more information, see Pipe Parts Catalog on page 381.

You can browse part catalogs through the Add and Modify dialogs, which give you direct access to the parts currently available to integrate into your designs.
When you select a part from a part catalog, you are selecting a specific part size that is defined in a part family.

In the Add Multi-view Parts dialog and Multi-view Part Modify dialog, you can also use the Part Filter tab to specify part properties to query a part family to find a specific part size. You can view the part sizes available in a part family by clicking Details. The available part sizes are presented in an easy-to-navigate part size table. Select Display/Hide additional parameters to show all the parameters in the table.

**NOTE** The Visible attribute is initially set in the Parameters Configuration view in the Size Parameters dialog in Content Builder. For more information, see Size Parameter Attributes on page 121.
How Catalog Parts Are Defined

A catalog part is defined by the associated files, or definition files, that store the part information:

**DWG file.** The drawing stores the model geometry that defines the appearance and enables the display of the part.

**BMP file.** Stores the preview image of the part, which helps to identify the part during part selection.

**XML file.** The extensible mark-up language (XML) file stores the part size and additional part properties that define the part.

Each part family in a catalog contains references to the associated definition files. If a file is missing, the part cannot be defined and is not available during part selection. The definition files are saved in the associated catalog folder in the \ProgramData\Autodesk\MEP 2011\enu\AEC Content directory.

**NOTE** AutoCAD MEP provides a catalog editor that a CAD manager or advanced user can use to browse, edit, or add part content to part catalogs. For more information, see About Catalog Editor on page 1152.

Part Sizes

To understand how individual part sizes relate to the definition files of a part, it is important to understand how the part data is defined in the XML file. Part data stored in the XML definition file consists of 2 types of properties: common parameters and size parameters.

Common parameters remain constant for all part sizes. They are defined once in a part family and are shared by all part sizes. If you change a common parameter, it is updated for all part sizes. Common parameters include domain,
type, and subtype. The following examples show common parameters for a mechanical, electrical, and plumbing part size.

- **Mechanical**: Common parameters for the 6 x 4 inch Rectangular Floor Register part size are as follows:

<table>
<thead>
<tr>
<th>duct component</th>
<th>air terminal</th>
<th>rectangular floor register</th>
</tr>
</thead>
</table>

- **Electrical**: Common parameters for the 13 Hole Large Outlet Box - 1 inch Conduit part size are as follows:

<table>
<thead>
<tr>
<th>conduit component</th>
<th>junction box</th>
<th>square outlet box</th>
</tr>
</thead>
</table>

- **Plumbing**: Common parameters for the 5 x 5 inch Rectangular Floor Drain part size are as follows:

<table>
<thead>
<tr>
<th>pipe component</th>
<th>drain plumbing</th>
<th>rectangular floor drain</th>
</tr>
</thead>
</table>

Size parameters include a set of parameter attributes such as name, description, and units; and parameter values such as size dimensions and material type. A size parameter can define one or more part sizes depending on how the size parameter is stored in the part family. Different storage methods enable multiple part sizes to be defined by various combinations of size parameters.
Parameter attributes are defined by both fixed and extensible lists of values. Attribute values are specified by AutoCAD MEP and cannot be changed; however, attribute values must be specified for custom data parameters that are added. Fixed data values cannot be edited. Extensible data values can be changed based on a list of predefined values, or extended to accommodate user-defined values. The following table shows the parameter attributes used to define size parameters.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Type of Data</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Extensible</td>
<td>D1, A2, user-defined</td>
</tr>
<tr>
<td>Description</td>
<td>Extensible</td>
<td>Diameter D1, Angle A2, user-defined</td>
</tr>
<tr>
<td>Context</td>
<td>Fixed</td>
<td>Connection Port Diameter, Path Angle</td>
</tr>
<tr>
<td>Index</td>
<td>Fixed</td>
<td>0, 1, 2, 3</td>
</tr>
</tbody>
</table>
Size Parameter Storage Types

Size parameters are separated into 4 types of data, referred to as “storage types.” Each storage type has unique characteristics that determine how the size parameters are used to define the part.

- **Basic Tables.** Store each parameter as a separate column. An entire row across multiple columns defines related parameters of a specific part size. All parameter columns must have the same number of values.

- **Constant Lists.** Store each parameter as a separate list and can be used in combination with other lists of values to define multiple part sizes. Each parameter list is independent and can have an infinite number of values.

- **Constants.** Store each parameter as a separate value that remains the same for all part sizes.

- **Calculations.** Store each part parameter as a formula. Values are calculated for each parameter based on other values specified for the part size.

Default Parts

Default parts are the parts automatically inserted by the software as you lay out runs of duct, pipe, cable tray, or conduit. You can change the default parts during layout.

If you use systems in your designs, you can define different default parts for each system. During layout, if you need to add a part that has no default defined, the software prompts you to select a part to use.

For more information, see:

- Duct: Configuring Duct Part Preferences on page 284
- Pipe: Configuring Size Ranges on page 412
- Cable tray: Specifying Default Parts for Cable Tray on page 558
You can also specify the plumbing fittings used by default for plumbing system definitions. For more information, see Specifying the Default Fittings for a Plumbing System Definition on page 718.

Importing a Building Component into AutoCAD MEP

AutoCAD MEP can import content originally produced by Autodesk Inventor. This capability allows the creation of custom content that can easily be transported to MEP drawings.

Export Requirements in Autodesk Inventor

In order for a building component to be correctly imported into AutoCAD MEP, it must be prepared for export in Autodesk Inventor, and saved as a Building Component Autodesk Exchange file (*.adsk). For more information, consult the Inventor User Guide.

When you import an Inventor building component into AutoCAD MEP, you can choose whether the component is imported as a multi-view part, a multi-view block, or a block. For more information on changing the UCS during import, see Changing the UCS During Import in the AutoCAD Architecture Help.

To import Inventor content

1. Click Insert tab ➤ Content panel ➤ Content Browser drop-down ➤ Building Component ➤ Building Component.
2. In the Import Building Component dialog, select the Autodesk Exchange Format file (*.adsk) that you want to import.
3. Select if you want to import the component as a multi-view part (MvPart), a block, or a multi-view block.
An Import dialog opens to allow you specify a name and description, and to change the orientation of the MvPart, block, or multi-view block during insertion.

4 When inserting a single part, the image in the viewer will be the part that is inserted, i.e front, top, etc. Any axonometric view will insert the 3D part.

If necessary, use the ViewCube in the preview window to display the component in the desired view.

5 Use the Rotate buttons to rotate the model around its X, Y, or Z axis when inserted into the drawing.

6 Select a catalog chapter in which to place the part and click Add.

Depending on the type of component inserted, you have different options for editing it in AutoCAD MEP. For information on multi-view parts, see Behavior of a Block-Based Part on page 1116, and for multi-view blocks, see Multi-View Blocks. For information on blocks, see Overview of Blocks.

**Working with Style-Based Content**

Style-based content refers to objects that are defined by styles. Styles are sets of parameters, properties, and associated view blocks that you assign to objects
to determine their appearance or function. AutoCAD MEP objects that use styles include devices, panels, wires, plumbing fittings, and schematic objects for schematic diagrams.

Styles define additional behaviors that traditional block-based objects do not have. For example, a symbol style determines the appearance of the symbol in different views, how connecting lines are trimmed, and the location and type of smart connectors used to create an intelligent building system.

CAD managers and engineers can create style-based content by defining new object styles using the Style Manager. You assign a style to all instances of an object that share the same characteristics. For example, you can assign one symbol style to all 3-way float valves and another symbol style to all 3-way pneumatic valves. For an overview of this process, see Working with Style-Based Content on page 124.

You can define the appearance of style-based content by assigning block-based graphics to specific views of the style. This enables you to convert traditional block-based objects, such as symbols, into usable content in AutoCAD MEP. Hundreds of add-on block-based objects are available from third-party vendors. Many building product manufacturers provide inventories of block-based symbols, and many design offices now sell libraries of custom block-based symbols. With the ability to create new styles, you can easily convert symbol libraries into style-based content and customize AutoCAD MEP to suit your needs.

Additionally, there are several ways to convert single objects or batches of objects to device styles or schematic symbol styles. You can:

- Convert a single AutoCAD block, MvBlock, or MvPart on page 110 to a device. In addition to the converted device, this creates the associated device style.
- Convert the device styles or schematic symbol styles provided with AutoCAD MEP to their individual components (the settings and the view blocks), customize the components, and then convert the components back to styles.
- Convert a batch of AutoCAD blocks in a custom block library to device styles or schematic symbol styles.

The key to working with style-based content is organizing the content in a logical way. You can organize related style-based content in libraries and categorize the libraries into smaller subsets of related content. To understand the operations, commands, and options available with style-based content in AutoCAD MEP, it is important to understand how style-based content is stored.
and referenced in a drawing. Central to working with style-based content is understanding style definitions.

**RELATED** To create style-based content, see [Customizing Style-Based Content](#) on page 891.

### How Style-Based Content is Stored and Referenced

In AutoCAD MEP, schematic symbols, devices, panels, and plumbing fittings are style-based content. Each piece of style-based content is defined by a style. You can create style definitions using Style Manager or one of several conversion tools provided by the software. (For more information, see [Customizing Style-Based Content](#) on page 891.) Style-based content can be stored in individual drawings. However, it is better to store style-based content in libraries that can be categorized and accessed through the dialogs and worksheets in the software.

A style definition is similar to an AutoCAD® block definition, which consists of all information associated with the block. Style definitions store all information associated with a piece of style-based content. The key difference between a block definition and a style definition is that a block definition stores information related only to appearance, whereas a style definition stores additional information related to function and behavior. For example, a traditional block-based symbol definition stores the geometry of the symbol. A style-based symbol definition stores the geometry of the symbol for each view direction. It also specifies how connecting lines are trimmed, defines the location and type of smart connectors used to create intelligent building systems, and determines the display properties of the symbol. For more information about defining styles, see [Configuring Styles](#) on page 896.

Style definitions are referenced when you add style-based content to your drawing. AutoCAD MEP does not copy information from the style definition to the drawing area. Instead, it establishes a link between the style-based content and the style definition. If the style definition is changed, all references are updated.

Style-based content can be stored in libraries. Generally, your drawings include symbols that you draw repeatedly, such as schematic symbols, devices, panels, and plumbing fittings. Style-based content libraries eliminate the need to redraw objects or copy and paste objects between drawings. You can create style-based content and store related content in a single drawing file that acts as a library. You associate the drawing file, or library, with your drawing in the Options dialog, so it can then be accessed through the Add dialog, Modify dialog, and Select worksheet (accessed from the Properties palette). For more
Orthographic and Isometric Views of Style-Based Content

Style-based content can have different appearances, depending on the display representation and view direction. Styles have view assignments that enable you to assign a specific view block to each view direction of a display representation. For example, a symbol can have one appearance when viewed from the top in plan view and another appearance when viewed from the left in plan view. For more information, see AutoCAD MEP Displays.

You can assign appearances to style-based content for both orthographic and isometric views in the plan display representation. 2-dimensional (2D) plan view drawings are the most common type of drawing created to represent design layouts. You can create both orthographic and isometric 2D plan view drawings in AutoCAD MEP.

When working with plan and isometric views of style-based content, 2 modes are available for creating, adding, and modifying style-based content:

- **Orthographic mode.** Works in the standard orthographic drafting view directions (top, bottom, front, back, left, right, and 3D).
- **Isometric mode.** Works in the standard isometric drafting isoplanes (left, top, and right), with the associated iso rotations (up, down, left, and right).

For each view of style-based content, additional view blocks must be created and assigned to a specific view in the style definition. The assigned views determine the appearance of the style-based content in your drawing. For orthographic views, you can create 6 plan/elevation view blocks and assign them to each ortho view respectively, or use a 3D model block to represent the ortho view. For information on view settings, see Defining the Views of a Style on page 898.
Orthographic view directions (for recessed double duplex receptacle)

For isometric views, twelve view blocks should be created for each piece of style-based content.

Isometric view directions and orientations

When creating or editing style-based content, you specify the mode on the Views tab in the Style Definition dialog. In Orthographic mode, you can assign view blocks to each orthographic view direction. In Isometric mode, you can assign view blocks to each iso rotation for each isoplane. For more information, see Defining the Views of a Style on page 898.

When adding or modifying style-based content, you specify the mode on the Properties palette, Add dialog, or Modify dialog. In Orthographic mode, you can draft your layout in the top view, add style-based content in plan view, and then change the view direction to view your layout and style-based content from the bottom, front, back, left, right, or in 3D. In Isometric mode, you can draft your layout on the different isoplanes and insert style-based content with the appropriate iso rotation.
Working with Tool Palettes

AutoCAD MEP includes a large inventory of tools organized into both discipline-specific and common tool palettes. For example, there are several tool palettes containing documentation tools, such as those for annotation and callouts. There are also numerous tool palettes containing tools for mechanical, electrical, piping, schematic, and plumbing design. To explore palettes:

1. Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Tools.
2. To browse the complete collection of tool and tool palette catalogs provided with the software, click Home tab ➤ Build panel ➤ Tools drop-down ➤ Content Browser.

The tool palette set is the collection of tool palettes specified for the current profile in the Tool Palettes File Locations setting.

1. Click Options.
2. In the Options dialog, click the Files tab.

If the tool palette set contains a large number of tool palettes, you can create tool palette groups for the current profile and organize the palettes in the tool palette set inside the groups. This enables you to display either all of the
palettes in the tool palette set or only those in a single group, switching between tool palette groups as needed. The profiles included with the software define several tool palette groups for the tool palettes, including HVAC, Piping, Electrical, Plumbing, Schematic, and Architectural.

If you are working in a project, the tool palette set also includes a tool palette group for the project. When you set a project as current, the software appends the AutoCAD® Tool Catalog (ATC) file location for the project-specific tool palettes to the path for the tool palette set. When you close the current project or set another one as current, it removes the project-specific tool palettes from the path.

You or your CAD manager can customize the existing tool palettes and tools as well as create new ones. You can also make customizations to a tool palette set. For information, see Customizing Tool Palettes on page 1174 or Customizing Tools on page 1178.

Opening the Tool Palette Set

Use any of these methods to open the tool palette set specified for the current profile:

- Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Tools.
- Press CTRL+3

Changing the Active Group in the Tool Palette Set

1. On the title bar of the tool palette set, click (Properties).
2. On the context menu, select the tool palette group that you want to display.
Modifying the Appearance of the Tool Palette Set

The tool palette set has several display options that you can set according to your design preferences.

Docking the Tool Palette Set

1. On the title bar of the tool palette set, click (Properties), and then click Allow Docking.
2. Click the title bar, and then drag the tool palette set to one side of your screen.

   The software displays a preview graphic to indicate the proposed position of the docked tool palette set.
Release the mouse button when the tool palette set is in the location that you want.

To undock the palette, click the palette near the top and then drag it into the drawing area.

**Hiding the Tool Palette Set**

When you enable the auto-hide feature of the tool palette set, the software hides all but its title bar when you move your pointing device away from it. This gives you greater visibility over your design at times when you are not working with tools.

To enable the auto-hide feature, click (Auto-hide) on the title bar of the tool palette set. In this mode, you can display the tool palette set again by hovering your pointing device over the title bar.

To disable the auto-hide feature, click (Auto-hide) again.

**Adjusting the Transparency of the Tool Palette Set**

You can display the tool palette set while retaining a view to the drawing underneath by applying transparency to the tool palette set.
NOTE Transparency is not available if the palette is docked or hardware acceleration is enabled.

To adjust the transparency of the tool palette set

1. On the title bar of the tool palette set, click \textsuperscript{Properties}, and then click Transparency.
2. In the Transparency dialog, adjust the transparency.

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>increase the transparency</td>
<td>drag the slider to the right.</td>
</tr>
<tr>
<td>decrease the transparency</td>
<td>drag the slider to the left.</td>
</tr>
<tr>
<td>turn off transparency</td>
<td>select Turn off window transparency.</td>
</tr>
</tbody>
</table>

Modifying the Appearance of Tools

You can modify the appearance of tools in the following ways:

- increase or decrease the size of tool images
modify the display and arrangement of tools. You can display tools with icons only; icons with text, or in single-column list view that includes icons and text.

The same tool palette with three different views

Several factors can influence the appearance that you select for tools, such as the need for additional drawing space, your familiarity with the tools, and the complexity of the tool images. For example, new users might choose to display tools with small images in a single-column list, which provides the aid of the tool name as well as the image. Alternatively, experienced users might choose to display tools with medium-sized images and without names in order to maximize drawing space.

To modify the appearance of one or more tool palettes

1. If you want to modify the appearance of only a single tool palette, open that palette.
2. Right-click the palette that is currently open, and click View Options.
3. Drag the Image size slider to the left to decrease the size for tool images or to the right to increase it.
4. Select an appearance:
   - tool images only
   - Icon only for View style.
Working with the Properties Palette

The Properties palette provides a central location to view the properties of an object. You can review information about the style, dimensions, location, property set data, and other important characteristics of an object. You typically keep the Properties palette open during an AutoCAD MEP session.

Opening the Properties Palette

Use any of the following methods to open the Properties palette:

- Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Properties.
- Press CTRL+1.
- Select an object in the drawing, right-click, and click Properties.
- Double-click an object in the drawing.
Modifying Object Properties Using the Properties Palette

You can use the Properties palette to modify the properties of one or more objects at the same time. However, keep in mind the following:

■ Changes are applied only to the objects you select. They are not applied to other connected objects in the system.

■ When you modify multiple objects simultaneously, you can only modify the properties that are editable and have the same name, category, and possible values for all of the selected objects. Properties that do not have the same name and category are not displayed on the palette. If the value of a displayed property is the same for the objects, the palette displays the value; otherwise, it displays *VARIES*.

Modifying Display Properties Using the Properties Palette

You can use the Display tab on the Properties palette to control the graphical properties of an object by adjusting the settings for its individual display components, such as contours and center lines. The changes you make on this tab are immediately visible in the display representation currently in effect, such as Plan or Model, and you have the option of applying your changes to other display representations as well. For more information, see Modifying Elevation-Based Display Components on the Properties Palette on page 231.

Modifying the Appearance of the Properties Palette

The Properties palette has several display options that you can set according to your design preferences.

Docking the Properties Palette

1. On the title bar of the Properties palette, click (Properties), and then click AllowDocking.
2 Click the title bar, and then drag the palette to one side of your screen.
   The software displays a preview graphic to indicate the proposed position of the docked palette.

3 Release the mouse button when the palette is in the location that you want.

To undock the palette, click the palette near the top and then drag it into the drawing area.

**Hiding the Properties Palette**

When you enable the auto-hide feature of the Properties palette, the software hides all but its title bar when you move your pointing device away from it. This gives you greater visibility over your design at times when you are not working with the palette.

To enable the auto-hide feature, click (Auto-hide) on the title bar of the Properties palette. In this mode, you can display the palette again by hovering your pointing device over the title bar.

To disable the auto-hide feature, click (Auto-hide) again.

**Adjusting the Transparency of the Properties Palette**

You can display the Properties palette while retaining a view to the drawing underneath by applying transparency to the palette.

**NOTE** Transparency is not available if the palette is docked or hardware acceleration is enabled.

To adjust the transparency of the Properties palette

1 On the title bar of the Properties palette, click (Properties), and then click Transparency.

2 In the Transparency dialog, adjust the transparency.

<table>
<thead>
<tr>
<th>If you want to</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>increase the transparency</td>
<td>drag the slider to the right.</td>
</tr>
</tbody>
</table>
Working with Systems

In AutoCAD MEP, a system is a network of connected parts that represents a real-world building system. The connected parts act together by maintaining the same look and feel throughout the system. For example, a network of connected parts including duct, pipe, fittings, and equipment can represent an air supply system, or a network of connected parts including conduit, wiring, devices, and panels can represent a power supply system.

Systems store properties that remain constant for all parts within a network of connected parts. When systems are used during design layout, new parts inherit the current system’s property defaults, such as size and shape. This provides a fast and consistent method of laying out parts. Systems make it easier to modify connected parts by simultaneously applying changes to the entire network of parts.

Including systems in your project standards has several benefits:

■ You have the ability to define and work with multiple systems within a single drawing.

■ You can apply default system properties to components during layout, which saves time and provides consistency.

■ It is easier to manage parts in your design drawings through display representations.

■ You can manage complete building models within a single drawing by grouping systems.

Systems can be created as needed during design layout. However, it is recommended that a series of systems be defined at the start of a project and maintained throughout its life. AutoCAD MEP provides a set of predefined systems based on common industry standards. Each system has default definitions including system abbreviations, layer keys, and display properties.

Electrical and plumbing systems are also categorized by system type. System types control unique behaviors of related systems. In electrical systems, the
system type controls properties such as the number of poles. In plumbing systems, the system type controls pipe sizing, fitting orientation, and fixture connections.

Systems are style-based, and, as a result, you access them through Style Manager.

**Duct systems**

Systems are loaded through AutoCAD MEP templates. If you are not using an AutoCAD MEP template, you can import system definitions from other drawings with Style Manager. Additional system definitions can be found in the System Definitions.dwg, which is located in a subfolder of the following folder: \ProgramData\Autodesk\MEP 2011\enu\Styles. For more information about sharing system definitions between drawings, see Copying Systems Between Drawings on page 148.

The topics in this section provide information about working with systems in all building systems disciplines. For discipline-specific information, see:

- Configuring Duct System Definitions on page 288
- Configuring System Definitions on page 414
- Creating Electrical System Definitions on page 534
About System Groups

System groups associate related systems without changing individual system properties. This enables you to connect different systems within a single drawing while maintaining display flexibility. You can define a system group to include any number of individual systems.

As an example, assume you want to connect a recirculating hot water line to a supply hot water line. You assign both system definitions to the same system group: non-potable water. When you draw the pipe runs, you can connect the recirculating line to the supply line and still have a connected pipe system. The following pipe run shows how the recirculating line (HWC) is connected to the supply line (HWS).

If 2 systems are not assigned to the same system group and you try to connect them, you are prompted to change the system of the connecting run to match the system of the receiving run. If you do not change the system of the connecting run, the appropriate fitting is inserted to connect to the receiving run, but the system is not connected. The connecting run is not a part of the system, so any changes you make to that system are not applied to the connecting run.
The following are examples of the benefits of grouping systems in the mechanical, electrical, and plumbing modules.

- **Mechanical:** If you are designing a heating supply system, you can create a separate system for each zone of a building, and then group the individual systems together as one complete heating supply system for the building.

- **Electrical:** If you are designing a power supply system, you can create a separate system for each voltage rating within the building, and then group the individual systems together as one complete power supply system for the building.

- **Plumbing:** If you are designing a sanitary waste system, you can create a separate system for each floor of a building, and then group the individual systems together as one complete sanitary waste system for the building.

System groups can be created as needed, but it is recommended that you create them when creating systems.

**NOTE** If dissimilar systems are allowed to connect and no system group has been defined, the connection is not valid. (If solution tips are turned on, a solution tip marker is displayed at the invalid connection. For more information, see Part Connection Rules on page 103 and Showing Solution Tips on page 862.) If you create a system group after you have laid out system components, the related invalid connections are dynamically updated to be valid.

## Creating Systems

**IMPORTANT** When defining a sanitary pipe system that uses gray water or black water, you need to define the system type as Waste. Otherwise, the Size Sanitary Pipe command will not recognize the system as a sanitary pipe system, and you will not be able to size the pipe run.

To create a system

1. Within the domain-specific workspace on page 53, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down, and click one of the following:
   - HVAC System Definitions
   - Piping System Definitions
2 Create a new system:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>create a system with default properties</td>
<td>in the left pane of the Style Manager, right-click System Definitions, and click New.</td>
</tr>
<tr>
<td>create a system from an existing system</td>
<td>in the left pane of the Style Manager, right-click the system you want to copy, and click Copy. Right-click the copy, and click Paste.</td>
</tr>
</tbody>
</table>

3 Enter a name and description for the new system, and press ENTER.

4 Specify the general properties of the system. For help, see:
   - Specifying the Design Rules of a System on page 143
   - Specifying the Rise/Drop Style of a System on page 145
   - Specifying the Display Properties of a System on page 146
   - Attaching Notes and Files to a System on page 147

5 Specify any discipline-specific properties of the system. For help, see:
   - Configuring Duct System Definitions on page 288
   - Configuring System Definitions on page 414
   - Configuring Plumbing System Definitions on page 717
   - Creating Electrical System Definitions on page 534
   - Creating Schematic System Definitions on page 777
Specifying the Design Rules of a System

The design rules of a system definition are properties that determine the behavior and display of the system.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abbreviation</td>
<td>Identifies the system to which the parts are assigned. This is a short system name, typically two or three characters in length. The abbreviation can be used when labeling objects and creating schedules.</td>
</tr>
<tr>
<td>System Group</td>
<td>Identifies the group of related systems with which the system is associated. System groups allow you to connect different systems while maintaining their individual system properties. For more information, see About System Groups on page 140.</td>
</tr>
<tr>
<td>System Type</td>
<td>Identifies the type of system. Available in electrical and plumbing systems only. Power &amp; Lighting and Cable Tray are 2 examples of system types in electrical systems. Every electrical system must have a specified system type. Hot Water and Waste are 2 examples of system types in plumbing systems. A plumbing system does not require a system type. However, sanitary pipe systems that use gray water or black water must specify the System Type as Waste. Otherwise, the Size Sanitary Pipe command does not recognize the system as a sanitary pipe system, and you are not be able to size the pipe run.</td>
</tr>
<tr>
<td>Layer Key</td>
<td>Identifies the layer to which objects in the system are added.</td>
</tr>
</tbody>
</table>

To specify the design rules of a system

1. Within the domain-specific workspace on page 53, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down, and click one of the following:
   - HVAC System Definitions
   - Piping System Definitions
   - Electrical System Definitions
   - Plumbing System Definitions

Creating Systems | 143
2 In the left pane, select the system, and, in the right pane, click the Design Rules tab.

**Design Rules tab for an electrical system definition**

3 Configure the design rules:

<table>
<thead>
<tr>
<th>If you want to specify...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>system abbreviation</strong></td>
<td>for Abbreviation, enter an abbreviation.</td>
</tr>
<tr>
<td><strong>system group</strong></td>
<td>for System Group, select or enter a group name. New names are added to the list of existing names.</td>
</tr>
<tr>
<td><strong>NOTE</strong> A blank selection allows a connection to any system group.</td>
<td></td>
</tr>
<tr>
<td><strong>system type</strong></td>
<td>for System Type, select the applicable component to connect to the system. The list is not customizable.</td>
</tr>
</tbody>
</table>
If you want to specify... then...

**NOTE** For Electrical or Plumbing system definitions only

| layer key | for Layer Key, select a layer key. The list of available layer keys depends on the layer key style specified for the drawing. To create a layer key override, click [...] beside the appropriate Layer Field, select an override value in the dialog, and click OK. |

---

**Specifying the Rise/Drop Style of a System**

Rise symbols and drop symbols represent the elevation direction of vertical segments in your layout for any predefined orthographic view (top, bottom, left, right, front, or back).

Rise/drop styles define the graphical appearance of rises and drops in your layout. You can assign different rise/drop styles to different systems. For information about creating a rise/drop style, see Rise/Drop Styles on page 911.

**To specify the rise/drop style of a system**

1. Within the domain-specific workspace on page 53, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down, and click one of the following:
   - HVAC System Definitions
   - Piping System Definitions
   - Electrical System Definitions
   - Plumbing System Definitions
   - Schematic System Definitions
2. In the left pane, select the system, and, in the right pane, click the Rise and Drop tab.
3 For Rise and Drop Style, select a style from the list. You can select from the rise/drop styles in the current drawing that are appropriate based on the system type of the system. For example, if the system type of the system is Cable Tray, you can select a cable tray rise/drop style, but you cannot select a conduit rise/drop style.

NOTE You might need to regenerate your drawing to display rise graphics and drop graphics for systems that have existing runs drafted.

Specifying the Display Properties of a System

Display properties control how parts that belong to the system are displayed in your layout. System definitions use the display properties configured for the display representations, but you can override display settings to customize display for a system definition.

For information on the AutoCAD MEP display system, see AutoCAD MEP Displays.

To specify the display properties of a system

1 Within the domain-specific workspace on page 53, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down, and click one of the following:
   - HVAC System Definitions
   - Piping System Definitions
   - Electrical System Definitions
   - Plumbing System Definitions
   - Schematic System Definitions

2 In the left pane, select the system, and, in the right pane, click the Display Properties tab.

3 Under Display Representations, select the display representation you want to override.

4 For the selected display representation, select Style Override.
5 In the Display Properties dialog, modify the display properties of the display components as needed. To edit each property, click its field.

6 Click OK twice.

### Attaching Notes and Files to a System

1 Within the domain-specific workspace on page 53, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down, and click one of the following:
   - HVAC System Definitions
   - Piping System Definitions
   - Electrical System Definitions
   - Plumbing System Definitions
   - Schematic System Definitions

2 In the left pane, select the system to which you want to attach notes or files and, in the right pane, click the General tab.

3 Click Notes.

4 To add a note, click the Notes tab, and enter a note.

5 To work with reference documents, click the Reference Docs tab:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>attach a reference file</td>
<td>click Add, select a file, and click OK.</td>
</tr>
<tr>
<td>edit the description of a reference file</td>
<td>select the file, and click Edit. Edit the description, and click OK.</td>
</tr>
<tr>
<td>edit a reference file</td>
<td>double-click the reference file name to start its application.</td>
</tr>
<tr>
<td>detach a reference file</td>
<td>select the file name, and click Delete.</td>
</tr>
</tbody>
</table>
Copying Systems Between Drawings

You can manage your systems more efficiently by storing them in a single drawing or template and then copying them into new drawings as you need them.

**NOTE** Additional system definitions can be found in System Definitions.dwg, which is located in a subfolder of the following folder:
\ProgramData\Autodesk\MEP 2011\enu\Styles.

To copy a system

1. Click Manage tab ➤ Style & Display panel ➤ Style Manager.
   The software opens the Style Manager with the current drawing expanded in the tree view. Any drawings open in the current session are also shown in the tree view.

2. Open the drawing into which to copy the system:
   - If you want to... then in Style Manager...
     - copy the system to a drawing that is not open in Style Manager
       click File ➤ Open Drawing, select the drawing, and click Open.
     - copy the system to a new drawing
       click File ➤ New Drawing, enter a name for the drawing, and click Save.

3. Expand System Definitions under the open drawings to display those systems in the drawings.

4. Right-click the system definition to copy to another drawing, and click Copy.
   To copy all system definitions, right-click System Definitions, and click Copy.

5. Right-click the drawing into which to copy the system definition, and click Paste.
   The system definition is copied into the selected drawing. If the drawing already contains a system with the same name, the
duplicate name is displayed in the Import/Export - Duplicate Names Found dialog.

6 Resolve duplicate system names, if prompted:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>prevent Style Manager from overwriting the existing system definition with the new system definition of the same name</td>
<td>select Leave Existing, and click OK.</td>
</tr>
<tr>
<td>replace the existing system definition with the new system definition</td>
<td>select Overwrite Existing, and click OK.</td>
</tr>
<tr>
<td>keep the existing system definition and add the new system definition with a different name</td>
<td>select Rename to Unique, and click OK. Style Manager appends a number to the name of the new system definition. Right-click the system definition and click Rename to change the name.</td>
</tr>
</tbody>
</table>

7 You can click Apply instead of OK to save your changes and continue working in Style Manager.

**TIP** Because systems are style-based objects, you can also perform other actions that you perform on styles, such as emailing a system definition to other users. For more information, see Style Manager in AutoCAD Architecture Help.

---

**Purging Systems**

You can purge any systems that are not applied to parts in the drawing.

**To purge a system**

1. Within the domain-specific workspace on page 53, open the Style Manager and access the system definitions:
   - Click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ HVAC System Definitions 🔄.
   - Click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Piping System Definitions 🔄.
■ Click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Electrical System Definitions.

■ Click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Plumbing System Definitions.

■ Click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Schematic System Definitions.

2 Purge the system definitions:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>purge one unused system definition</td>
<td>right-click the system definition you want to remove, and click Purge.</td>
</tr>
<tr>
<td>purge all unused system definitions</td>
<td>right-click System Definition, and click Purge. When prompted, verify that the system definitions you want to purge are selected, and click OK.</td>
</tr>
</tbody>
</table>

If the system definition you selected to purge remains in the list of system definitions after purging, the system definition is currently applied to parts in the drawing.

### Designing Parallel Routing Systems

Parallel routing is useful when laying out hot and cold piping systems, pipework for radiant heating systems, or conduit runs. One technique for designing parallel routing involves laying out a single run and then offsetting a specific distance from other segments relative to the original segment or from existing geometry, such as a wall. In this scenario, you add one segment at a time. See Offsetting Pipe from Existing Geometry on page 460 or Offsetting Duct from Existing Geometry on page 308 for more information.

In AutoCAD MEP you can simultaneously route parallel runs. This alternative ensures that the turns are properly calculated by the software and that conflicts in the run can be prevented.
For more information on the parallel routing of conduit or pipe/radiant heating systems, see the following topics:

- Drawing a Parallel Conduit Run on page 632
- Adding Parallel Pipes to a Radiant Heating System on page 506

## Selecting a Display Configuration

In addition to using orthographic and isometric views in a drawing, AutoCAD MEP includes many display settings that control how objects appear in a drawing. Display representations control how objects appear in different views. Display configurations are groups of display representations designed for specific tasks. For example, you can change from a 1-line display configuration to a 2-line. You can also change to a discipline-specific display configuration, such as one that shows mechanical systems in specified colors and linetypes yet screens all other types of systems.

The default templates include display settings you can use for all aspects of project design and documentation. You can also customize displays to meet specific project requirements. For more information on displays, see Display System Structure on page 208.

**To change the current display configuration**

1. Click the current display configuration in the Drawing Window status bar.

   The displays included with the drawing are listed.
Select a display configuration from the list.

For more information on the display configurations included in the Aecb Model drawing template, see Display Configurations on page 214.

**Essentials of Objects**

Building systems are typically assembled from fabricated, off-the-shelf parts. With AutoCAD MEP, you create design layouts by assembling objects that represent real-world parts, such as duct, cable tray, pipe segments, fittings, equipment, devices, panels, and fixtures. All parts are classified as specific types of objects. Understanding the different types of objects is crucial to understanding how the software draws parts and applies multiple display representations to those parts.

There are 2 types of parts: block-based and parametric. A block-based part is a specific instance of a part with predefined properties such as shape and size. Block-based parts are predefined based on properties and a series of AutoCAD® blocks. Each block represents the part in a different view, enabling the parts to have different appearances in different view directions.
Different views of a mechanical part

Different views of an electrical part

Different views of a plumbing part

A parametric part is dynamically generated based on predefined or user-defined properties, such as shape and size. The part properties determine how the part is generated. Parametric parts are generated as 3-dimensional model blocks; therefore, different appearances display in different view directions. For more information about parametric and block-based parts, see Understanding Parametric and Block-Based Parts on page 957.

Parts can have specific behaviors, such as automatic cleanup when connecting to other parts, or default insertion under certain design circumstances. Parts can have multiple components, such as a centerline, insulation, and lining. The object type of a part is the basis for controlling part behavior and display representations.
## Object Types

The following table describes the object types in AutoCAD MEP.

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cable Tray Fitting</td>
<td>A part dynamically generated based on predefined properties to which other parts can be connected. It can be inserted during layout and includes as components connector, annotation, centerline, and rise/drop.</td>
</tr>
<tr>
<td>Cable Tray</td>
<td>A part dynamically generated based on predefined properties to which other parts can be connected. It is trimmed when fittings are connected and includes as components connector, annotation, centerline, and rise/drop.</td>
</tr>
<tr>
<td>Circuit</td>
<td>A non-graphical object that represents the connection between electrical components. It has unique identifying properties including system, rating, panel, number of devices, length, number of poles, voltage, total load, demand factor, and estimated demand load.</td>
</tr>
<tr>
<td>Conduit Fitting</td>
<td>A part dynamically generated based on predefined properties. It can be inserted during layout and includes as components connector, annotation, centerline, and rise/drop.</td>
</tr>
<tr>
<td>Conduit</td>
<td>A part dynamically generated based on predefined properties to which other parts can be connected. It is trimmed when fittings are connected and includes as components connector, annotation, centerline, and rise/drop.</td>
</tr>
<tr>
<td>Device</td>
<td>A style-based part that can appear as one of several predefined blocks, depending on the display representation and the direction from which it is viewed. It is used by the Wire object type to complete connections between multiple electrical parts.</td>
</tr>
<tr>
<td>Duct Custom Fitting</td>
<td>A part dynamically generated from a centerline created from user-selected AutoCAD entities, such as lines and arcs, for the geometry.</td>
</tr>
<tr>
<td>Duct Fitting</td>
<td>A part dynamically generated based on predefined properties to which other parts can be connected. The part can be inserted by the software as you lay out duct and includes as components contour, connector, annotation, centerline, insulation, lining, and rise/drop.</td>
</tr>
<tr>
<td>Object</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Duct</td>
<td>A part dynamically generated based on predefined properties to which other parts can be connected. It is trimmed when fittings are connected and includes as components contour, connector, annotation, centerline, insulation, lining, and rise/drop.</td>
</tr>
<tr>
<td>Flex Duct</td>
<td>A part dynamically generated based on predefined properties and a single user-defined centerline to which other parts can be connected. It includes as components contour, connector, annotation, centerline, insulation, lining, and rise/drop; has multiple graphic representations.</td>
</tr>
<tr>
<td>Flex Pipe</td>
<td>A part dynamically generated based on predefined properties and a single user-defined centerline to which other parts can be connected. It includes as components contour, connector, annotation, centerline, insulation, lining, and rise/drop and it has multiple graphic representations.</td>
</tr>
<tr>
<td>Label Curve</td>
<td>A style-based object that uses attributes to query part information for labeling. Each label can be dynamically anchored, yet modified independently of its related part.</td>
</tr>
<tr>
<td>MvPart</td>
<td>A parametric or block-based part that can appear differently in different views based on predefined or user-defined properties or predefined AutoCAD blocks, and depending on the display representation and the direction from which it is viewed. The part can have one or more connection points, and it represents equipment such as air terminals and fans, and fixtures such as lavatories and toilets.</td>
</tr>
<tr>
<td>Panel</td>
<td>A style-based part that can appear as one of several predefined blocks, depending on the display representation and the direction from which it is viewed. It is used by the Wire object type to complete connections between multiple electrical parts.</td>
</tr>
<tr>
<td>Pipe Custom Fitting</td>
<td>A part dynamically generated from a centerline created from user-selected AutoCAD entities, such as lines and arcs, for the geometry.</td>
</tr>
<tr>
<td>Pipe Fitting</td>
<td>A part dynamically generated based on predefined properties to which other parts can be connected. It can be inserted by the software as you lay out pipe and includes as components contour, connector, annotation, centerline, insulation, lining, and rise/drop.</td>
</tr>
<tr>
<td>Object</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pipe</td>
<td>A part dynamically generated based on predefined properties to which other parts can be connected. It is trimmed when fittings are connected and includes as components contour, connector, annotation, centerline, insulation, lining, and rise/drop.</td>
</tr>
<tr>
<td>Plumbing Fitting</td>
<td>A style-based part generated based on predefined properties to which other parts can be connected. It can be inserted during layout and maintains knowledge of flow direction, slope, elevation, and fixture unit load. It includes as components centerline, connector, annotation, rise/drop, slope, and fitting.</td>
</tr>
<tr>
<td>Plumbing Line</td>
<td>A style-based part generated based on predefined properties to which other parts can be connected. It can have different appearances when crossing other segments and different graphical representations for different types of plumbing lines. It is trimmed when additional segments and fixtures are connected and maintains knowledge of flow direction, slope, elevation, and fixture unit load. It includes as components centerline, connector, annotation, rise/drop, slope, and fitting.</td>
</tr>
<tr>
<td>Schematic Line</td>
<td>A single-segment or multi-segment line used to specify the connectivity and logic dependencies of a building systems layout. It has multiple annotation styles for crossing lines and is trimmed when schematic symbols are added. The properties of a schematic line include system, designation, and ID.</td>
</tr>
<tr>
<td>Schematic Symbol</td>
<td>A block symbol used to specify real-world equipment or parts, such as fittings or valves, that works in conjunction with schematic lines. It connects to schematic lines by breaking into the line or attaching to the end of the line when added. The properties of a schematic symbol are system and ID.</td>
</tr>
<tr>
<td>Wire</td>
<td>A style-based part generated based on predefined properties to which other parts can be connected. It has multiple annotation styles for crossing segments and connections, and multiple graphic representation styles for different types of wire. It cleans up when additional wire segments, accessories, panels, and devices are connected.</td>
</tr>
</tbody>
</table>
Selecting Objects

AutoCAD MEP provides several ways to select MEP objects by system, domain, or connected branch within an object's contextual ribbon, at General panel ➤ Select System drop-down.

To select objects by group, domain, or connected branches

1. Select an MEP object, such as a duct, pipe, or plumbing or schematic object.
2. From the contextual ribbon for the object, click General panel ➤ Select System drop-down.
3. Make a selection from the appropriate sub-menu, as explained next:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Use...</th>
</tr>
</thead>
<tbody>
<tr>
<td>select the objects in a particular system, such as an HVAC system</td>
<td>Select System <img src="select_system_icon.png" alt="image" /></td>
</tr>
<tr>
<td>select the objects in all systems</td>
<td>Select System Group <img src="select_system_group_icon.png" alt="image" /></td>
</tr>
<tr>
<td>select the objects in a domain, such as, in the Duct domain, duct segments, fittings, or flex duct</td>
<td>Select Domain <img src="select_domain_icon.png" alt="image" /></td>
</tr>
<tr>
<td>select all components in a run, or a portion of the run</td>
<td>Select Connected Branches <img src="select_connected_branches_icon.png" alt="image" /> and proceed to the next step.</td>
</tr>
</tbody>
</table>

To select connected branches

4. Press tab to cycle through the connection options.
5. When the desired branch is highlighted, press ENTER.

AutoCAD MEP includes other ways to select objects in a drawing, such as:

- Move the cursor over an object, and click it.
- Click outside an object or group of objects, drag a bounding box around the desired objects, and click a second time to select all objects that are completely within the bounding box.
Use icons on the Properties palette:

- Select Objects: To create a selection set with your pointing device, for example, by creating a window selection.
- Quick Select: To create a selection set filtered by a specific property, such as lineweight.

Example on Duct Properties Palette

 RELATED See Select Multiple Objects.

Filtering Objects

To filter objects by system

1. Select multiple objects.
2. On the Properties palette, select the system from the drop-down list.
To filter objects by part properties

1 Select multiple objects using the Select Connected Branches on page 157 command.
   Example: Selecting connected branches in a pipe run

2 Click (Quick Select) at the upper-right corner of the Properties palette.

3 On the Quick Select dialog, specify filter properties for:
   - Object type
   - Properties
   - Operator
   - Value
The following examples show selection sets filtered by part type, where only the elbows in each run are selected.

**Pipe run**

![Pipe run diagram]

**Plumbing run**

![Plumbing run diagram]

In the How to apply section, select Include in new selection set.

(Optional) To append the results of the Quick Select to the current selection set, select Append to current selection set, and click OK.

### Justification of Objects

Justification applies to the orientation of a segment relative to the draw direction and the centerline of the object. Justification is stored on the following 3D segment-based MEP objects:

- Duct (rectangular, oval, round)
- Cable tray (rectangular)
- Conduit (round)
- Pipe (round)

The default justification is the centerline of the object, with no horizontal or vertical offsets. The centerline of the resulting segments and fittings is placed along the points you specify as you draw runs. The elevation specifies the height location for vertical justification.

**Justification along centerline**

The following justification settings are available on the Properties palette:

- Top Left, Center, Right
- Middle Left, Center, Right
- Bottom Left, Center, Right

You can also enter a distance for horizontal or vertical offsets.

**Justification on the Properties palette**

![Properties palette](image)

Justification is based on the draw direction from connector 1 (start point) to connector 2 (endpoint), as shown:

**Draw direction**

![Draw direction diagram](image)

Justification of Objects | 161
The following example contrasts Top Left and Top Right justification of a duct object. Notice that the draw direction, as shown by arrows, determines how justification is represented in the drawing.

**Arrows show the draw direction from the start to the endpoint**

If you start drawing from a fitting that is connected to a segment, the justification of the connected segment is applied to the new segment. If no segment is connected, the last used justification is used.

You can use the AutoCAD MIRROR command to mirror 2 objects on either side of a wall. In this case, justification is adjusted based on the object’s orientation to the wall. The next 2 examples illustrate mirrored ducts. The first example shows the MIRROR command applied to the first duct.
The second example shows the mirrored duct placed on the other side of the wall. Notice the difference in justification of the 2 duct objects based on their orientation along the wall, Top Left versus Top Right.

**RELATED**  For more information on specifying justification, see Configuring Justification for Pipe Insertion on page 438 and Configuring Justification for Duct Insertion on page 279.

# Matching Part Properties

You assign various part properties to AutoCAD MEP objects to define the part in a layout. You can create a new object and match its properties with that of an existing object. Use one of the following methods to access the matching functionality in AutoCAD MEP:

- From the Add command on the command line (such as ConduitAdd), select Match at the command prompt.
- Select an object, and click Add Selected on the ribbon. Select Match at the command prompt.
- Click 📦 (Match) in the Add or Modify dialogs for duct, cable tray, or MvPart.
- Select Match at the prompt on the command line when the Modify Run on page 174 dialog is displayed for pipe or conduit.
Invoke ParallelRouting on page 150 on the command line for pipe or conduit, and select Match at the command prompt.

Click an object name below to expand a list of MEP properties that can be matched.

**TIP** Matching properties vary depending on the function you are performing on an object. The software displays the available options.

**Cable tray**
- System
- Elevation
- Justification
- Part
- Size
- Annotation

**Cable tray fitting**
- System
- Elevation
- Part
- Size
- Annotation

**Conduit**
- System
- Elevation*
- Justification*
- Size*
- Routing preference

*Also available with Parallel Routing
Conduit fitting
- System
- Elevation
- Part
- Size

Wire
- System
- Elevation
- Style

Panel
- System
- Elevation
- Style
- Name
- Voltage Phase for Neutral/Phase
- Rating
- Slots
- Phases
- Rotation
- Main Type
- Panel Type

Duct
- System
- Elevation
- Justification
- Insulation
Lining  
Part  
Shape  
Size

**Duct fitting**

- System  
- Elevation  
- Insulation  
- Lining  
- Part  
- Shape  
- Size

**Custom duct fitting**

**NOTE** Match properties are available from the `DuctCustomFitting` command.

- System  
- Insulation  
- Lining  
- Shape  
- Size

**Flex duct**

- System  
- Elevation  
- Insulation  
- Lining  
- Part
- Size
- Annotation

**Pipe**
- System
- Elevation*
- Justification*
- Routing preference
- Size*
- Insulation*

*Also available with Parallel Routing

**Pipe fitting**
- System
- Elevation
- Insulation
- Part
- Size

**Custom pipe fitting**

*NOTE* Match properties are available from the *PipeCustomFitting* command.

- System
- Insulation
- Size

**Flex pipe**
- System
- Elevation
Insulation
Part
Size
Annotation

**Plumbing line**
- System
- Elevation
- Style
- Size
- Slope

**Plumbing fitting**
- System
- Elevation
- ID
- Rotation
- Style

**MvParts**
- Elevation
- Part

**Schematic line**
- System
- Style
- ID

**Schematic symbol**
- Style
Matching Style and Display Properties

You can match the style and object display properties between AutoCAD MEP objects of the same type. For MEP objects of different types you can match basic AutoCAD properties. Likewise, you can match basic AutoCAD properties between an AutoCAD entity and an AEC object.

When you match properties between some style-based MEP objects, both the style properties and the display properties of the selected source object are applied to one or more selected destination objects. For non-style-based objects and most style-based objects, only display properties are matched. In either case, the display properties are applied to all display representations of the destination object.

<table>
<thead>
<tr>
<th>Object Types for Which Both Style and Display Properties Are Matched</th>
<th>Object Types for Which Only Display Properties Are Matched</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fabrication</td>
<td>Cable Tray</td>
</tr>
<tr>
<td>Hangers</td>
<td>Cable Tray Fitting</td>
</tr>
<tr>
<td>Label Curve</td>
<td>Conduit</td>
</tr>
<tr>
<td>Plumbing Lines</td>
<td>Conduit Fitting</td>
</tr>
<tr>
<td>Schematic</td>
<td>Device</td>
</tr>
<tr>
<td>Wire</td>
<td>Duct</td>
</tr>
</tbody>
</table>
Object Types for Which Both Style and Display Properties Are Matched

Object Types for Which Only Display Properties Are Matched

<table>
<thead>
<tr>
<th>Duct Custom Fitting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duct Fitting</td>
</tr>
<tr>
<td>Duct Flex</td>
</tr>
<tr>
<td>Multi-View Part</td>
</tr>
<tr>
<td>Panel</td>
</tr>
<tr>
<td>Pipe</td>
</tr>
<tr>
<td>Pipe Fitting</td>
</tr>
<tr>
<td>Pipe Custom Fitting</td>
</tr>
<tr>
<td>Pipe Flex</td>
</tr>
<tr>
<td>Plumbing Fitting</td>
</tr>
<tr>
<td>Schematic Symbol</td>
</tr>
</tbody>
</table>

**Overrides**

When you use the match properties feature, any style or object overrides in effect for the source object are applied to all display representations of the destination object. Overrides currently in effect for the destination object will be removed if they conflict with corresponding settings for the source object. If you want to change a setting for a particular display property in a particular display representation, the recommended method is to use the Display tab of the Properties palette. For more information, see Modifying Elevation-Based Display Components on the Properties Palette on page 231.

**To match object properties**

1. Click Home tab ➤ Modify panel ➤ Match Properties.
2. Select the source object whose properties you want to copy.
   The cursor changes to a paintbrush symbol.

170 | Chapter 4  Drawing Essentials
3 Select one or more destination objects to which you want to apply the properties of the source object. Source object properties are applied to each destination object as it is selected.

4 When finished selecting destination objects, press ENTER.

**Working with Connected Objects**

When you place building systems objects in your layout, you connect them using connection points. A valid connection point is a predefined point—called a connector—on a building systems object where properties such as system, shape, and size are conveyed to other building systems objects. Conveying properties between objects creates intelligent building systems. All building systems objects have smart connectors. Objects can have a single connector, such as on a terminal, receptacle, or water meter, or they can have multiple connectors, such as on an air handling unit or junction box.

To ensure that you are attaching to a connector on a building systems object, use AutoCAD MEP snaps. These snaps locate building systems connectors, similar to the way that AutoCAD® object snaps (osnaps) locate connection points, such as an object’s midpoint.

**Connecting flexible duct to an air terminal**

![Connecting flexible duct to an air terminal](image)

**Connecting wiring to a receptacle**

![Connecting wiring to a receptacle](image)

**Connecting a plumbing line to a sink**

![Connecting a plumbing line to a sink](image)
When a connection is made, the new object inherits the properties of the original object. These properties define the new object and can include system, elevation, and geometric properties, such as shape and size.

The connectors of a style define the location of the connection points on the object and specify each connector’s domain. The domain is the type of building system to which the object or connector belongs. For example, an electrical object, such as a junction box, belongs to the electric domain. Building systems objects can have connectors that belong to different domains. For example, an air handling unit belongs to the HVAC domain, but it has multiple connectors that belong to different domains: a connector for gas belongs to the pipe domain and a connector for power belongs to the electric domain. Each domain has a predefined list of properties that can be compared to ensure that valid connections are made.

For more information, see Configuring the Connectors of a Style on page 906.

**Connection Behavior**

Connector styles specify the rules that determine which properties are compared and whether connections are allowed between objects based on the results of the comparison. For example, when connecting pipe to pipe, typically you want to ensure that the 2 pipe segments are the same size and belong to the same system unless specifically designed otherwise.

**RELATED**  
For more information on connector behavior for catalog-based content, see Rules for Connector Behavior on page 974. For more information related to style-based content, see Connector Styles on page 919.

**Checking Connections**

You can verify the validity of connections, runs, and systems. The software provides tools for checking a layout for valid connections, showing the location of disconnected connections, and viewing an entire connected run from start to end. For more information, see Checking Your Drawings on page 861.

**Viewing Connection Details**

Use this procedure to view connection-related properties for pipe, pipe fitting, flexible pipe, conduit, or conduit fitting in the Connection Details worksheet.

1. In the drawing, select an object.
2. On the Properties palette, expand Advanced.
3. Click to open the Connection Details worksheet.
Example of Pipe Connection Details

Example of Conduit Connection Details
The Connection Details worksheet displays the following properties depending on the selected object. Of these properties, only the location and elevation coordinates are editable.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Pipe</th>
<th>Conduit</th>
<th>Pipe Fitting</th>
<th>Conduit Fitting</th>
<th>Pipe Flex</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal size</td>
<td>Size as specified in the routing preference</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flow direction</td>
<td>In, out, or bidirectional flow orientation of the object</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Connection type</td>
<td>Classification of how segments are mounted together</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Maximum tolerance angle</td>
<td>Maximum allowable angle of deflection on page 405 for female fittings (displayed in current angle units)</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current tolerance angle</td>
<td>Current angle of deflection for female fittings (displayed in current angle units)</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>Editable X and Y coordinates</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Elevation</td>
<td>Editable Z coordinate</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**NOTE** A limited set of properties are displayed in the Add mode.

**RELATED** For more information on pipe connection type assignments, see Connection Assignments on page 436.

**Modifying Connected Objects Along a Run**

Use this procedure to modify properties for similar objects in the same pipe or conduit run.
1 Select a pipe or conduit. 

*Shows pipe segment selected in a run*

2 Click Pipe tab or Conduit tab ➤ Modify panel ➤ Modify Run ➤ Modify Run.

3 In the Modify Run dialog, select one or more properties (routing preference, nominal size, system, and elevation), and then specify the change from the corresponding list.

**Modify Run dialog (for pipe or conduit)**

![Modify Run dialog](image)

The dialog displays the current settings for the selected object. Changes made affect similar objects in the run up to an MvPart, reducer, tee, or cross.
Shows changes to routing preferences and system up to reducer (circled)

4 For Pipe, optionally change Joint direction (male into female or female out to male).

TIP If you are drawing pipe in the direction of the flow, choose Male into Female. If you are drawing against the flow, choose Female out to Male.

NOTE You might be prompted to make a part substitution. For more information, see Choosing a Part.

Working with Anchors

An anchor is a general linking mechanism within AutoCAD MEP. Building systems objects can be anchored to each other, enabling you to create a relationship between objects. Anchoring objects can be useful for positioning lavatories or toilets along a wall, or air terminals or light fixtures in a ceiling grid. You can choose from 3 types of anchors to attach building systems objects:

- **Curve anchors.** Attach objects to the base curve, typically the centerline, of other objects.

- **System anchors.** Attach objects to a system run. Anchored objects can be moved along the entire run to other runs assigned to the same system.

- **Reference anchors.** Attach objects by reference to other objects, such as attaching an end-of-line schematic symbol to a schematic line. When the symbol is moved, the line maintains connectivity and is stretched to the new location.
Certain objects are, by default, anchored to other objects; however, their behavior can differ slightly depending on object type. For example, when a schematic symbol is added to an existing line, the symbol is, by default, attached to the schematic line using a system anchor. The symbol can be easily moved along the line or moved to another unconnected line of the same system. It cannot, however, be moved outside a line and stand alone. To do that, you must first remove the anchor between the symbol and line.

**Attaching Objects with a Curve Anchor**

Use this procedure to attach objects with a curve anchor. With curve anchors, you can attach building systems objects to the base curve of other building systems objects. The movement of an object anchored with a curve anchor is constrained by the object to which it is anchored. You can change the position of an anchored object relative to the curve in the X, Y, and Z directions. You can also rotate and flip the object along its axes. Curve anchors are best suited for attaching objects to linear objects like segments.

**To attach an object with a curve anchor**

1. Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Content Browser.
2. Select the MEP Stock Tool Catalog.
3. In the Content Browser, on the left navigation bar, select Common ➤ Common Items.
4. Click the i-drop icon on the Curve Anchor tool, and drag the tool onto your drawing.
5. Enter at (attach object), and then select the object to be anchored.
6. Select a point on the curve to which to anchor the object.
   The object is anchored to the curve at the X position. When the object is placed, the Y and Z positions are 0.
7. To change the position of the anchored object, do any of the following:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then enter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>move the object to a different curve</td>
<td>s (set curve), select the anchored object, press ENTER, and then select a new curve.</td>
</tr>
</tbody>
</table>
Attaching Objects with a System Anchor

Use this procedure to attach objects with a system anchor. With system anchors, you can attach building systems objects to other building systems objects based on their assigned system. The movement of an object anchored with a system anchor is constrained by the object to which it is anchored. You can change the position of an anchored object by dragging the object along the entire system run. You can also drag the anchored objects to other runs assigned to the same system.

To attach an object with a system anchor

1. Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Content Browser ➤ MEP Stock Tool Catalog.
2. Select the MEP Stock Tool Catalog.

If you want to… then enter…

| Change the position of the object along the curve by specifying a distance from the center or end of the curve | \( p \) (\( x \) position), select the anchored object, and select a point on the base curve. Then enter a distance and specify what to measure to: Near edge, Far edge, or Center. |
| Change the rotation of the anchored object | \( r \) (rotation), select the anchored object, press \( ENTER \), and then specify a rotation angle. |
| Rotate the object around the X axis | \( x \) (rotation \( x \)), select the anchored object, press \( ENTER \), and then enter or specify a rotation angle. |
| Rotate the object around the Y axis | \( y \) (rotation \( y \)), select the anchored object, press \( ENTER \), and then enter or specify a rotation angle. |
| Change the anchored end of the object | \( an \) (set anchored), select the anchored object, and then select a point on or near the base curve end. |

8. Press \( ENTER \).
3 In the Content Browser, on the left navigation bar, select Common ➤ Common Items.

4 Click the i-drop icon on the Systems Anchor tool, and drag the tool onto your drawing.

5 Select the object to be anchored.

6 Select a point on the curve to which to anchor the object, and press ENTER.

The object is anchored to the curve at the X position. When the object is placed, the Y and Z positions are 0.

**Attaching Objects with a Reference Anchor**

Use this procedure to attach objects with a reference anchor. With reference anchors, you can attach building systems objects to other building systems objects by reference, or association. The movement of an object anchored with a reference anchor maintains the association between the objects. When you change the position of the anchored object, the reference object is moved along with it. A point of connection is always maintained. Reference anchors are best suited for attaching objects to non-linear objects (like flex duct or wire) that may change in layout frequently.

**To attach an object with a reference anchor**

1 Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Content Browser .

2 Select the MEP Stock Tool Catalog.

3 In the Content Browser, on the left navigation bar, select Common ➤ Common Items.

4 Click the i-drop icon on the Reference Anchor tool, and drag the tool onto your drawing.

5 Select the object to be anchored.

6 Select a point on or near the end of the curve to which to anchor the object, and press ENTER.

The object is anchored to the end of the curve.
Rotating Objects Attached with Curve Anchors

1 Select the object that is attached to a curve, such as the centerline of another object.

2 Rotate the selected object:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>Then right-click, and click…</th>
</tr>
</thead>
<tbody>
<tr>
<td>flip the object along the X axis</td>
<td>Curve Anchor ➤ Flip X.</td>
</tr>
<tr>
<td>flip the object along the Y axis</td>
<td>Curve Anchor ➤ Flip Y.</td>
</tr>
<tr>
<td>flip the object along the Z axis</td>
<td>Curve Anchor ➤ Flip Z.</td>
</tr>
<tr>
<td>rotate the object around the X axis</td>
<td>Curve Anchor ➤ Set Rotation X, enter the number of degrees, and press Enter.</td>
</tr>
<tr>
<td>rotate the object around the Y axis</td>
<td>Curve Anchor ➤ Set Rotation Y, enter the number of degrees, and press Enter.</td>
</tr>
<tr>
<td>rotate the object around the Z axis</td>
<td>Curve Anchor ➤ Set Rotation, enter the number of degrees, and press Enter.</td>
</tr>
</tbody>
</table>

**NOTE** The flip and rotate commands rotate the object relative to the axes of the curve to which it is attached.

If the object is an isometric symbol, it is rotated to the orientation that most closely matches the angle you specify. For examples of these orientations, see Orthographic and Isometric Views of Style-Based Content on page 127.

Releasing Anchored Objects

Use this procedure to release anchored objects, whether anchored with a curve, system, or reference anchor. When you release an anchored object from another object, you remove the relationship between the objects. You can release any anchored object, even those objects anchored by default when added to a drawing.
To release anchored objects

1 Select one or more objects with anchors that you want to release.
2 Release the objects:

<table>
<thead>
<tr>
<th>If you want to release...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>objects anchored with curve anchors</td>
<td>right-click, and click Curve Anchor ➤ Release.</td>
</tr>
<tr>
<td>objects anchored with systems anchors</td>
<td>right-click, and click Systems Anchor ➤ Release.</td>
</tr>
<tr>
<td>objects anchored with reference anchors</td>
<td>right-click, and click Reference Anchor ➤ Release.</td>
</tr>
</tbody>
</table>

The objects are released; however, no change is visible.

Part Anchors

You can access anchor information in two ways in AutoCAD MEP:

- From the Anchor tab in the Multi-view Part Properties dialog (for MvParts)
- From the Properties palette (Piping and Schematic domains)

NOTE The Anchor icon ( ) and associated worksheet on the Properties palette will only appear if the selected pipe fitting or symbol uses anchors.
An anchor links an AutoCAD MEP object to another object or to a layout curve or grid. In the Piping domain, this worksheet applies to fittings that use anchors (i.e., takeoffs). In the Schematic domain, it applies to symbols. You can view and modify the X, Y, and Z insertion points relative to the current coordinate system and rotation angle of the anchor. You can reposition anchored objects along a segment axis by specifying a dimensioned location or by flipping the anchor around the X, Y, or Z axis. The Anchor tab is available only after the objects have been anchored with an anchor tool.

Using the Compass

To create an accurate model of your layout, you often need to draw relative to a particular UCS plane or relative to other objects in your building model. As you draw, you can use the Compass to guide the direction of your run. Any part you add to a layout can be aligned to a specified rotation angle or snap increment angle on the Compass. You can use tick marks on the Compass as a visual reference to guide the alignment of the insertion point and angle of a part. Using snap increments and tick marks provides a fast and consistent method of laying out runs.
Examples of Compass tick mark increment settings

For most drafting tasks, it is useful to assign tick marks based on the specified snap increment. For example, if the snap increment is at 45 degrees, then assign tick marks to appear at 45 or 90 degrees. However, if the snap increment is less than 45 degrees, such as 15 degrees, assign the tick marks to appear at 30, 45, or 90 degrees to avoid a cluttered Compass display.

**NOTE** The snap increment and tick marks are independent settings of the Compass and do not need to match in value. You can place a part by snapping to a specified angle without aligning to a tick mark on the Compass.

You can also change the color and size of the Compass display to enhance the visibility of the Compass as it overlaps and aligns with objects in your drawing. The Compass size is expressed in pixels and remains constant regardless of the zoom scale factor you apply to a drawing.

**Compass diameter changes**

When the Compass is enabled, you can switch the UCS plane you are drafting by using the Plane option. Each time you switch planes the UCS axis changes:

- The X axis switches to the Y axis.
- The Y axis switches to the Z axis.
- The Z axis switches to the X axis.

Understanding this behavior is important when drawing at different angles and elevations using the Compass. The following example illustrates how you
can draw a rigid duct run with segments that are aligned with the 3 different UCS planes when the Compass is enabled.

1 **Draw 2 duct segments in the first UCS plane.**

   ![First UCS Plane](image1.png)
   ![First UCS Plane](image2.png)

   - specify first cable tray segment angle and end point
   - specify second cable tray segment angle and end point

2 **On the command line, enter p (plane), and then draw 2 duct segments in the second UCS plane.**

   ![Second UCS Plane](image3.png)
   ![Second UCS Plane](image4.png)

   - specify third cable tray segment angle and end point
   - specify fourth cable tray segment angle and end point

3 **Enter p (plane), and draw 2 duct segments in the third UCS plane.**

   ![Third UCS Plane](image5.png)
   ![Third UCS Plane](image6.png)

   - specify fifth cable tray segment angle and end point
   - specify sixth cable tray segment angle and end point
4 Enter p (plane) again to return the UCS place to its original orientation.

Customizing the Compass Display

Use this procedure to customize the Compass display. As you draw, the Compass guides the direction of your run. It is helpful to use the Compass to align your parts with walls, ceilings, and other architectural elements in the drawing. You can use the Compass Settings dialog to control tick marks, snap increment, compass diameter, and color. For more information, see Using the Compass on page 182.

To customize the Compass display

1 Click View tab ➤ MEP View panel ➤ Compass .
2 In the Compass Settings dialog, specify the Compass display:

<table>
<thead>
<tr>
<th>If you want to change the...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>diameter of the Compass</td>
<td>enter a value for Compass Diameter.</td>
</tr>
<tr>
<td>display color of the Compass</td>
<td>click ..., select a color tile or enter the name or number of the color you want to use, and then click OK.</td>
</tr>
<tr>
<td>snap increment</td>
<td>select Enable Snap, and enter a value.</td>
</tr>
<tr>
<td>tick mark increment</td>
<td>select Enable Tick Marks, and enter a value.</td>
</tr>
</tbody>
</table>

TIP You can control the number of decimal places, or precision, of the value for the Compass tick mark increment by changing the AutoCAD® Units Precision setting.
Designing with Dynamic Input and Grips

Dynamic input is a command interface that displays near the cursor and includes command prompts, cursor input fields, and dimension input fields.

Grips are small, solid-filled shapes displayed at strategic points on a selected object. You can use grips to modify an object in many ways. For example, you can use grips to lengthen or rotate the object, or modify its location or elevation. You can also use grips to quickly create runs of duct, pipe, cable tray or conduit.

Together, dynamic input and grips enable you to make precise and accurate modifications to your mechanical, electrical, or plumbing design directly in the drawing area. Because you do not divert your attention to the command window and dialogs as frequently, you maintain focus on the design and increase your productivity.

Dynamic Input

Dynamic input is a command interface that displays near the cursor and includes 3 dynamic components:

- Command prompts that instruct you on performing tasks.
- Cursor input fields that allow you to enter relative or absolute coordinates in polar or Cartesian format.
- Dimension input fields that allow you to specify length and angle changes or new overall dimensions.

**Dimension input fields**

Enabling and Disabling Dynamic Input

To disable or enable dynamic input, click 📊 on the application status bar. Dynamic input is enabled by default.

You can also disable, enable, and modify the settings for the 3 components of dynamic input individually. For more information, see Use Dynamic Input.

**Grip Tooltips**

You can hover your pointing device over a grip to display a short description of its function. Depending on the grip and context, the tooltip might also contain information about the available grip editing modes.

**Tooltip for Show all insertion points grip on electrical panel**

Grip Tooltips | 187
Grip Constraints

When you drag a grip on an object in order to change its dimension properties, AutoCAD MEP often constrains the grip to a line, curve, or plane. Whenever the constrained position of a grip differs from the current cursor position, the software displays dotted lines or arcs to inform you of the constraint and its effect.

As an example, refer to the following illustration of lengthening a duct segment. The current cursor position cannot result in an angle change because the software always constrains the Lengthen grip to the current angle of the segment.

Trigger Grips

Unlike grips that you drag in the drawing to change the dimension properties of an object, trigger grips immediately perform an action when you click them.

Some trigger grips change the editing mode of an object. Other trigger grips set the properties of an object. For example, clicking the Rotate grip on an
object rotates it 180 degrees, which changes the value of its Rotation property. Holding the Ctrl key while clicking flips the object 90 degrees.

**Damper before clicking rotate grip**

![Damper before clicking rotate grip]

**Damper after clicking rotate grip**

![Damper after clicking rotate grip]

### Grip Editing Modes

The grip editing mode determines how the action you perform using a grip is executed by AutoCAD MEP. If a grip has multiple editing modes, the software lists them in the grip tooltip, and you must specify the mode to use.

Trigger grips have 1 or 2 editing modes. To use the default mode, simply click the grip. To use the second mode, hold CTRL while clicking the grip. In the following illustration, the pipe elbow fitting has a Rotate grip with 2 modes for rotating 180 or 90 degrees.

![Rotate 180 degrees]

Press Ctrl while selecting to rotate 90 degrees

Drag grips that require you to specify points or dimensions can have one or multiple editing modes. For these grips, you select a mode and then use the grip. In the following illustration, the variable air volume (VAV) box has a Location grip with 3 editing modes.
To specify a grip editing mode

1. Click the grip to select it.
2. Select a mode:

<table>
<thead>
<tr>
<th>If you want to use…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>the first mode</td>
<td>modify the object using the grip. The first mode listed in the tooltip is the default mode.</td>
</tr>
<tr>
<td>the second mode</td>
<td>press and release CTRL.</td>
</tr>
<tr>
<td>a subsequent mode</td>
<td>press and release CTRL as many times as needed.</td>
</tr>
</tbody>
</table>

You can now modify the object using the grip.

**Drafting with Flow Direction**

Flow direction is the forward movement of a material or fluid (such as air or water) through the components of a system. You can set or reverse the flow direction of a duct run or a pipe run between 2 branches. Once you set the flow direction, you can show it using flow markers, toggling the markers on and off as needed. The flow markers are solid 2D arrows displayed at the midpoint of segments.
Flow markers indicating the flow direction of a pipe run

**NOTE** In addition to flow markers, you can also add flow labels (sometimes referred to as flow arrows in the software) to duct runs and pipe runs. Like flow markers, flow labels show the current flow direction of the run if the flow direction has been set, and they are scaled according to the annotation scale. Unlike flow markers, flow labels are fully annotative objects, which means you can modify and delete them. For information on adding flow labels as you draw, see *Applying Label or Flow Arrow Styles to Ducts* on page 286 or *Adding Labels or Flow Arrows to Pipe* on page 465.

**To set or reverse the flow direction of a duct or pipe run**

1. Select a segment in the run.
2. Click Duct tab ➤ Calculations panel ➤ Set Flow Direction.

You can perform the same operation on a pipe run using Set Flow Direction on the Pipe tab.

3. The current flow direction of the run is shown by an arrow in the center of the selected segment. If the run does not have an
assigned flow direction, the start point of the segment is considered upstream, and a default flow direction is shown.

![Diagram](image)

4 Do one of the following:
- Enter `y` (yes) to reverse the flow direction.
- Enter `n` (no) to accept the indicated flow direction.

![Diagram](image)

The selected run between branches is assigned the indicated flow direction. Flow direction for a run stops at branch fittings (fittings with 3 or more connectors, such as tees and crosses) and MvParts.

**NOTE** To reverse the flow direction of a single segment, select it, right-click, and click ReverseSegment (or enter `reversesegment`).

To turn flow markers on or off for all runs that have a flow direction

1 Select a segment in a run.

2 Click Pipe tab or Duct tab ➤ Calculations panel ➤ Show Flow.

**NOTE** If you do not want flow markers to appear on construction documents, turn them off before plotting or publishing.
Regenerating an AutoCAD MEP Model

Use this procedure to regenerate an AutoCAD MEP model. You should regenerate a drawing model after making a large number of changes to the model, after applying new display representations to objects in the model, or if you are working with external reference (xref) files. Regenerating an AutoCAD MEP model steps through its objects and displays them based on current settings and preferences. You should also regenerate the model when objects do not display correctly, specifically after an AutoCAD® Regen. However, to avoid performance problems during regeneration of large drawings, select only those objects that are displaying incorrectly.

To regenerate an AutoCAD MEP model

1. Click View tab ➤ Appearance panel ➤ Regenerate drop-down ➤ Regenerate Model.
2. Select one or more objects to regenerate, or press ENTER to regenerate the entire drawing.

Viewing Part Properties

Every part in AutoCAD MEP has unique characteristics or properties that define the part’s state, appearance, or value. Properties can be predefined or user-defined. During layout you define, select, and specify part properties using the Properties palette or properties dialog, depending on the part that is selected.

**NOTE** The Add dialog currently appears when you add some MEP objects in AutoCAD MEP, such as duct or MvParts. Likewise, the modify or properties dialogs appear when you change properties for those objects.

Basic Part Information

You can access properties on the Properties palette under Basic.
You can also assign property set information to objects that typically have associated schedules, such as MvParts. Click the Extended Data tab on the Properties palette for Property Sets.
Property sets for Duct

System Assignments for Parts and Connectors

You can access the systems assigned to parts. System information is available on the properties dialog for duct or MvParts, and on the Properties palette for pipe, conduit, or plumbing (as shown next).

NOTE Changing a system assignment on a connection may change the system assignment of connecting parts, depending on the connector style rules in your drawing.

Part Styles

You can access object styles from the Properties palette under Basic. Only the styles defined in your drawing are listed.
NOTE If you want to add new styles, modify existing styles, or delete unused styles, use Style Manager. For more information, see Configuring Styles on page 896.

On the Properties palette, you can also assign a style for the label and flow arrow associated with a piping or plumbing object.
Assigning a piping label style

Part Property Details

You can view and modify part property details on the Properties palette or properties dialog, depending on the part that is selected. For schematic lines, you can define the designation ID for labeling. For parts, such as ducts or MvParts, in the corresponding properties dialog you can view a list of part properties that dynamically change when you swap parts from the part catalog. Part properties include general part data, such as type and sub-type, connector type, dimension, system, and location properties.
For other parts, such as plumbing lines, you can view and modify part properties including elevation, nominal size, and slope. You can view the read-only value for the calculated size of the pipe. When you change the part properties, the part is dynamically updated in your layout.

Part Location

You can view part location information and modify the X, Y, and Z insertion points relative to the current coordinate system and rotation angle of the part. You can also specify elevation, start, mid, and end point values. Location details are available on the properties dialog for duct or MvParts. For other parts, such as cable tray as shown next, click (Additional information) on the Properties palette to open the Location dialog.

Location properties for Cable Tray
Working with Projects

This section describes how to create a project environment and establish standards for your projects. By using project standards, you can enhance efficiency, automate repetition, and maintain consistency across your project drawings and construction documents.

Working with Drawing Management Projects

The Drawing Management feature formalizes the processes related to building system design and documentation. This feature automates the management, viewing, and construction of building systems, ensuring consistency in all aspects of the project. Consequently, your entire design team has a centralized project environment for accessing the most current documents.

The basis of the Drawing Management feature is a sophisticated referenced drawing (xref) feature enhanced from standard AutoCAD xref functionality. Project elements are referenced into constructs; constructs are referenced into views, and views are referenced into plotting sheets. Powerful linking features ensure that source files can be distributed over many different locations on a single computer or network, enabling simultaneous access by others working on the same project.
The Drawing Management feature has two main components:

**Project Browser**
Project Browser creates projects and specify high-level project information and settings, such as the project number, project name, contact information, and the file locations of the drawing templates, tool palettes, and the project-specific Content Browser library to use.

**Project Navigator**
Project Navigator centralizes project-specific tasks, such as defining building levels and divisions (wings), creating project drawings, and creating plotting sheets.
A drawing must be part of a project to synchronize with project standards. The Drawing Management feature ensures that project standards are properly enforced. You cannot apply project standards to standalone drawings. You can copy standard styles and display settings into standalone drawings, but they are not synchronized when the standards change.

**RELATED** See Concepts of Drawing Management in the AutoCAD Architecture Help.

### Establishing Project Standards

Typically, at the beginning of a project, you establish the standards that guide the project design. Project standards, called CAD standards, enhance efficiency, automate repetition, and maintain consistency across your project drawings and construction documents.

Templates store the following standards required to begin a drawing:

- Unit type and precision
■ Drawing and plotting scales
■ Dimension and text styles
■ Layer structures
■ Linetypes and lineweights

You can also establish the following design-specific standards on a
drawing-by-drawing basis or add them to a template:
■ Design and drawing preferences
■ Coordinate systems
■ Design and plotting display layouts
■ Title blocks and borders

AutoCAD MEP, together with AutoCAD Architecture, provide several tools
for establishing and managing standards. You can learn how to create standards
for the following:

<table>
<thead>
<tr>
<th>To create</th>
<th>then learn about</th>
</tr>
</thead>
<tbody>
<tr>
<td>custom layer structures</td>
<td>layers, layer standards, layer key styles, layer keys, and the Layer Manager in AutoCAD MEP Layer Standards on page 203</td>
</tr>
<tr>
<td>standard fonts</td>
<td>text styles and the Style Manager in Creating Construction Documents on page 813 and Style Manager</td>
</tr>
<tr>
<td>standard dimensions</td>
<td>dimension styles and the Style Manager in Creating Construction Documents on page 813 and Style Manager</td>
</tr>
<tr>
<td>annotation, such as labels</td>
<td>label styles and the Style Manager in Creating Construction Documents on page 813 and Style Manager</td>
</tr>
<tr>
<td>custom display representations</td>
<td>object types, standard display representations, and the Display Manager in Essentials of Objects on page 152 and AutoCAD MEP Displays on page 208 in this Help</td>
</tr>
</tbody>
</table>

NOTE AutoCAD MEP objects do not support AEC Dimensions. Be sure to use AutoCAD MEP annotation tools or AutoCAD® dimensions.
The Project Standards feature lets you establish, maintain, and synchronize standards across all drawings in a Drawing Management project. Project standards include standard styles, display settings, and AutoCAD standards that are used across all project drawings. Standard styles and display settings are specified in one or more standards drawings associated with the project. Project drawings can then be synchronized with these standards throughout the project life cycle, either automatically, or on demand.

**RELATED**  See Project Standards Overview.

### AutoCAD MEP Layer Standards

The Layer Management feature in AutoCAD MEP lets you organize, sort, and group layers using layer standards, layer key styles, and layer overrides. Layer standards define the naming of new layers according to the structure defined in the standard. AutoCAD MEP includes a number of predefined layer standards and matching layer key styles based on common building system industry norms.

You can change any part of the layer name structure using layer key overrides within the layer key style. You can also override layer names for all of the layer keys in a layer key style or for individual layer key styles.

### Layer Standards Overview

Layers organize the objects in a drawing and enforce linetype, color, and other standards. They are the equivalent of the overlays used in paper-based drafting.
For example, in paper-based drafting, a building plan might contain overlays for the foundation, floor plans, and mechanical, plumbing, or electrical layouts. In AutoCAD MEP, you can organize the same information on layers in your drawings.

This section provides a summary of AutoCAD MEP layer standards and other related concepts.

Layer Standards

Layer standards establish naming conventions for the layers in your drawings. A layer standard contains rules that determine the structure of the layer names in a drawing. You can use layer standards to enforce and manage project standards for layers.

The software provides several default layer standards based on industry-standard layering conventions (for example, MEP Object - Based on AIA, and BS1192 - AUG Version 2). When you create a layer based on a layer standard, the name of the layer has several parts separated by delimiters, such as hyphens. Each part of the name is determined by the rules that are set in the layer standard definition. The default layer standard definitions for AutoCAD MEP are based on common industry layer standards. For example,
according to the MEP Object layer standard, the layer name for duct is M-Duct-Std.

You can incorporate the default layer standards into your project standards, customize them, or create your own.

**Layer Key Styles and Layer Keys**

Each layer standard has a corresponding layer key style. A layer key style contains a set of layer keys. The layer keys assign objects to defined layers with names that conform to the layer standard. When you add an object to your drawing, the software automatically draws the object on the layer assigned to it in the current layer key style. This process is called layer keying.

**Layer keys for duct and duct fitting objects**

<table>
<thead>
<tr>
<th>Layer Key</th>
<th>Description</th>
<th>Layer Settings</th>
<th>Line Type</th>
<th>Line Weight</th>
<th>Plot Style</th>
<th>Allow Dyn.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duct</td>
<td>HVAC Duct</td>
<td>H-Ductwork</td>
<td>[ ] 22</td>
<td>Continuous</td>
<td>0.25 mm</td>
<td>Color_72</td>
</tr>
<tr>
<td>DuctCustomFitting</td>
<td>HVAC Duct Custom</td>
<td>H-Ductwork</td>
<td>[ ] 22</td>
<td>Continuous</td>
<td>0.25 mm</td>
<td>Color_72</td>
</tr>
<tr>
<td>DUCTDIM</td>
<td>HVAC Dimensions</td>
<td>H-Ductwork</td>
<td>[ ] 221</td>
<td>Continuous</td>
<td>0.25 mm</td>
<td>Color_211</td>
</tr>
<tr>
<td>DuctFitting</td>
<td>HVAC Duct Fitting</td>
<td>H-Ductwork</td>
<td>[ ] 22</td>
<td>Continuous</td>
<td>0.25 mm</td>
<td>Color_72</td>
</tr>
</tbody>
</table>

**Layer Standards Drawing**

AutoCAD MEP lets you specify the layer standard and layer key style to use in the current drawing. You can also specify that the selected layer standard and layer key style be imported automatically into new drawings.

The software includes several layer standards and several layer key styles in a layer standards drawing named AecbLayerStd.dwg. This drawing is located in \ProgramData\Autodesk\MEP 2011\enu\Layers or in one of its subfolders, depending on the content you installed. The templates provided with the software are configured to load an appropriate AecbLayerStd drawing into new drawings that you create.

**NOTE** The Layers folder contains other layer standards drawings with similar names that have appended version numbers (for example, AecbLayerStd5.dwg). These layer standards drawings originate from earlier versions of the software and are included to support legacy drawings.
Layer Properties Manager

The Layer Properties Manager lets you view and manage the layers in the current drawing. You also use the Layer Manager to access and manage the components that support layering, such as layer standards, layer key styles, layer keys, and layer key overrides.

In the Layer Properties Manager, all the layers in the current drawing are displayed in the All layer group. If you link any referenced drawings (xrefs) to the drawing, the layers are listed in an Xref layer group.

![Layer Properties Manager](image)

RELATED See Layer Management in the AutoCAD Architecture Help.

Specifying a Layer Standard and a Layer Key Style

1. Click Home tab ➤ Layers panel ➤ ➤ Select Layer Standard.
2. In the Drawing Setup dialog, click the Layering tab.
3. Under Layer Standards/Key File to Auto-Import, click to browse to the desired layer standards drawing (DWG or DWT file). Make your selection on the Open Layering File dialog.
If you saved the layer standards drawing on page 205 in the same folder as the default layer standard drawing, you can access the folder by clicking the Content folder in the left pane and then clicking the Layers folder.

4 Under Default Layer Standard in the Drawing Setup dialog, select the layer key style to use in your drawing, and click Apply.

5 Specify how to apply the layer settings:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>save the layer settings for the current drawing and apply them globally</td>
<td>select Save as Default.</td>
</tr>
<tr>
<td><strong>TIP</strong> This option applies the saved layer setting to all new drawings started either without a template or from templates without existing drawing setup information.</td>
<td></td>
</tr>
<tr>
<td>save the layer settings only for the current drawing</td>
<td>clear Save as Default, and then click Apply.</td>
</tr>
</tbody>
</table>

If you also changed the drawing units, the software prompts you to specify whether existing objects in the current drawing should be scaled for the new units.

**RELATED** See Layer Management in the AutoCAD Architecture Help.

**Accessing Layer Key Styles and Layer Keys**

1 Click Home tab ➤ Layers panel ➤ ➤ Layer Key Styles .

2 In the Style Manager, select a layer key style, and then click the Keys tab in the right pane.

The Keys tab displays the layer keys and related settings, including layer, color, linetype, and lineweight.

**RELATED** See Working with Layer Keys in the AutoCAD Architecture Help.
AutoCAD MEP Displays

Traditional, manual CAD designs require that you draw a single object (such as a duct or a pipe) multiple times in different drawings to produce different views of the same object. For example, you might have a 1-line drawing of a duct and piping layout and a separate 2-line drawing of the same layout to clarify the construction documents. For each drawing, you use a separate collection of drafting entities to represent the objects.

AutoCAD MEP provides tools to view an object in the layout in different ways. This saves time and maintains consistency across all your project drawings.

Display System Structure

The AutoCAD MEP display system controls how objects appear in a viewport. By specifying the objects for display and the direction from which to view them, you can produce different displays, such as plan layouts, 3D models, isometric riser diagrams, and schematic diagrams. Establishing standard displays helps maintain consistency across multiple drawings.

Three main components comprise the AutoCAD MEP display system:

- Display representations on page 211 for controlling how individual objects are displayed
- Display sets on page 214 for grouping display representations of objects
- Display configurations on page 214 for assigning display sets to view directions

These components are hierarchical in nature. Each display configuration contains some display sets, and each display set contains some display representations. The components work together to create the display system as follows:
Most AutoCAD MEP objects have 1 Line, 2 Line, Model, and Plan display representations on page 211. This is because these are the most common design scenarios that require different views of a building system.
Some building systems objects, such as label curve objects and schematic objects, have only a general display representation because the display of these objects does not change in different views.

The sample templates have default display settings for new and tiled viewports. Default drawing settings guide new users. They also help more experienced CAD managers maintain consistency across project drawings by customizing the sample templates or creating new templates with different display settings.
1. To specify the default display settings for an individual drawing, click
   Utilities ➤ Drawing Setup.

2. Click the Display tab on the Drawing Setup dialog.

Display Manager

The Display Manager is the central location for the display system components in your AutoCAD MEP drawings. You set up display configurations, display sets, and display representations in the left pane of the Display Manager. The right pane details information about a selected display system component.

RELATED  See The Display Manager in the AutoCAD Architecture Help.

Display Representations

Display representations represent the first level of display control. Display representations define how an object appears in a drawing.

You can also preview display representations by clicking (Floating Viewer) in the Display Manager. The Floating Viewer displays how a specific object appears in different display representations and view directions.

RELATED  See Viewing Display Representations and Viewing an Object in a Display Representation in the AutoCAD Architecture Help.

Display Representations in AutoCAD MEP

AutoCAD MEP includes, among others, the following display representations:

1 Line
- Used for centerline depiction of an object in 2D or 3D
- In some cases, also used for isometric drawings

1 Line Screened
- Same as 1 Line display representation
- Exception: Objects screened for use as background
2 Line
- Used for 2D or 3D contour depiction of an object in plan and model drawings
- Fast, underlying graphical display engine
- For speed, hidden lines and rise/drop symbology not shown

2 Line Screened
- Same as 2 Line display representation
- Exception: Objects screened for use as background

Model
Used for full 3D wireframe depiction of an object

Model Screened
- Same as Model display representation
- Exception: Objects screened for use as background

Plan
- Used for 2D or 3D contour depiction of an object
- Has a graphical display engine that is slower than that for 2 Line but with higher quality (and thus, better for plotting)
- Hidden lines and rise/drop symbology shown

Plan Presentation
- All objects screened so that the user can create display themes or apply interference detection highlighting and display only the affected objects
- Hatching shown

Plan Screened
- Same as Plan Presentation
- Exception: Haching not shown
Plan High Detail
- Unused
- AutoCAD Architecture display representation provided for use in AutoCAD MEP
- Turns on all architectural subcomponents (for example, all wall components)

Plan Low Detail
- Unused
- AutoCAD Architecture display representation provided for use in AutoCAD MEP
- Turns on some architectural subcomponents

Schematic
Used for 2D symbolic depiction of 3D MvParts for schematic diagrams

Schematic Screened
- Same as Schematic display representation
- Exception: Objects screened
- For use in the MEP Presentation display configuration

Reflected
- Unused
- AutoCAD Architecture display representation provided for use in AutoCAD MEP

General
Used for objects that do not require different graphics for different representations or types of drawings (for example, annotation, plumbing lines, and plumbing fittings)

General Screened
- Same as General display representation
Exception: Objects screened

The color of the grayed out (screened) objects in the background of building systems design drawings is controlled by layer G-Bgrd-Std-Scrn. The colors of the hidden lines applied to objects in building systems design drawings are controlled by the following layers:

- E-Hidn-Std-High and E-Hidn-Std-Subd for electrical objects
- M-Hidn-Std-High and M-Hidn-Std-Subd for mechanical objects
- G-Hidn-Std-High for plumbing objects

**Display Sets**

Display sets represent the second level of display control. Display sets are collections of display representations on page 211 of objects that control how a group of objects appears.

Typically, you create display sets for a specific task or type of drawing, such as a reflected ceiling plan. You can also use them to show or hide objects according to classification, such as construction status (new, existing, or demo). See Display of Objects by Classification on page 239 for more information.

**RELATED** See Viewing Display Sets in the AutoCAD Architecture Help.

**Display Configurations**

Display configurations represent the final level of display control. A display configuration contains one or more display sets that control the representation of objects in your drawing when viewed from different directions (Top, Bottom, Left, Right, Front, Back, and Default). The different views help with design layout and for plotting presentation drawings or construction documents.

**RELATED** See also Viewing Display Configurations in the AutoCAD Architecture Help.
AutoCAD MEP Display Configurations
The default Aecb Model drawing templates include the following display configurations, based on the display representations on page 211 in AutoCAD MEP.

<table>
<thead>
<tr>
<th>Display Configuration</th>
<th>Display Representations by view direction</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Plan (Top), Model (all other view directions)</td>
<td>Not recommended for building systems objects because non-building systems objects are displayed with full color. For medium detail drawings</td>
</tr>
<tr>
<td>Mechanical</td>
<td>Mechanical - Plan (Top), Mechanical - Model (all other view directions)</td>
<td>Combined mechanical duct and pipe drawings; shows all piping and equipment as 2-line, but can use the system definition configuration to show 2-line, 1-line, or graphical 1-line, depending on size; hidden lines and rise/drop symbology used; uses Plan display representation for Mechanical and Plan Screened for non-Mechanical (electrical and plumbing objects)</td>
</tr>
<tr>
<td>Mechanical - Duct/Pipe - 1-Line</td>
<td>Mechanical - Duct/Pipe 1-Line Plan (Top), Mechanical - Duct/Pipe 1-Line Model (all other view directions)</td>
<td>For 1-line mechanical duct drawings; pipe is 1-line and screened; rise/drop symbology used, hidden lines not used; all non-duct objects screened</td>
</tr>
<tr>
<td>Mechanical - Duct/Pipe - 2-Line</td>
<td>Mechanical - Duct/Pipe 2-Line Plan (Top), Mechanical - Duct/Pipe 2-Line Model (all other view directions)</td>
<td>Duct, piping and equipment shown as 2-line; uses the system definition configuration to show 2-line, 1-line, or graphical 1-line, depending on size; pipe is by size and screened; hidden lines and rise/drop symbology used; all non-duct objects screened; for Piping, uses Plan display representation for Mechanical and Plan Screened for non-Mechanical</td>
</tr>
<tr>
<td>Mechanical - Pipe by Size</td>
<td>Mechanical - Pipe By Size Plan (Top), Mechanical - Pipe By Size Model (all other view directions)</td>
<td>For 2-line and 1-line mechanical pipe drawings; uses system definitions to display pipe as 2-line, 1-line, or graphical 1-line by size; hidden lines and rise/drop symbology used; all non-pipe objects are screened; uses Plan display representation for pipe objects and Plan Screened for other disciplines, allowing all non-pipe-related objects to be screened as background</td>
</tr>
<tr>
<td>Display Configuration</td>
<td>Display Representations by view direction</td>
<td>Comments</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Electrical</td>
<td>Electrical - Plan (Top), Electrical - Model (all other view directions)</td>
<td>Combined electrical lighting, power, and system drawings; hidden lines and rise/drop symbology used; all non-electrical objects are screened</td>
</tr>
<tr>
<td>Electrical - Lighting</td>
<td>Electrical - Lighting Plan (Top), Electrical - Lighting Model (all other view directions)</td>
<td>Shows lights, diffusers, ceiling grid, and common objects like junction boxes in electrical lighting drawings; hidden lines and rise/drop symbology used; all non-lighting objects are screened</td>
</tr>
<tr>
<td>Electrical - Power</td>
<td>Electrical - Power Plan (Top), Electrical - Power Model (all other view directions)</td>
<td>Shows common objects like junction boxes in electrical power drawings; hides lights, diffusers, and ceiling objects; hidden lines and rise/drop symbology used; all non-power objects are screened</td>
</tr>
<tr>
<td>Plumbing</td>
<td>Plumbing - Plan (Top), Plumbing - Model (all other view directions)</td>
<td>For plumbing drawings; hidden lines and rise/drop symbology used; all non-plumbing objects are screened; pipes are 1-line; ducts are 2-line</td>
</tr>
<tr>
<td>MEP Basic 2-Line</td>
<td>MEP Basic 2-Line - Plan (Top), MEP Basic 2-Line - Model (all other view directions)</td>
<td>2-line engineering drawings of duct, pipe, or cable tray, regardless of system definition configurations for 1-line and graphical 1-line; hidden lines and rise/drop symbology not used; best suited in layouts where hidden lines are not needed, as well as in Model views, to accurately depict the 2 line representation of the objects; the graphical detail is lower, but the underlying graphical display engine is quicker</td>
</tr>
<tr>
<td>MEP Design</td>
<td>MEP Design - Plan (Top), MEP Design - Model (all other view directions)</td>
<td>For engineering design and modeling to show all architectural objects, building systems objects, and ceiling grid; for coordination and placement of objects. For Piping, shows large diameter piping and equipment as 2-line and smaller diameter system as 1-line based on the Pipe By Size setting in the system definitions; all parts and fittings scaled for</td>
</tr>
</tbody>
</table>
### Hierarchy of Display Control

The display control operates according to the following hierarchy:

- **Object**
- **Style**
- **System Definition**
- **Domain Drawing Default**

If no object-level display control overrides are in effect, control then passes to that object’s style-level definition. If no style-level overrides are in effect, control then passes to that object’s system definition. If no system definition settings are in effect, control then passes to the drawing default level.

You can apply multiple overrides to an object, essentially layering them on the object. As you remove the layers of overrides, the highest override in the hierarchy takes control.
Synchronization of Display Settings

Display properties are synchronized across other AutoCAD MEP objects within a domain. For example, if you change the display properties for duct segments whose display is controlled by Drawing Default, the display properties are also changed for duct, duct fittings, duct custom fittings, and duct flex.

Ideally you should use the Display tab on the Properties palette to make direct changes to the display properties for an object in a drawing. However, you can also use the Style Manager or Display Manager to manage all (unfiltered) display properties for an object whose display is controlled by Drawing Default or System Definition.

When a display override is added to or removed from a system, display properties are also synchronized within a domain. Display properties are synchronized for the following domains/objects:

- Pipe: Pipe, pipe fitting, pipe custom fitting, pipe flex
- Duct: Duct, duct fitting, duct custom fitting, duct flex
- Cable tray and cable tray fitting
- Conduit and conduit fitting
- Plumbing line and plumbing fitting

Managing Display Settings During Project Setup

The default display settings in a drawing determine the display of objects when no display overrides are in effect. As the CAD manager, you set up a template or project and specify the display settings that will remain in effect in the drawing. During project setup, the way that you set the default settings for display representations depends on the type of object. For example, you can use:

- Style Manager on objects in the duct, pipe, cable tray, and conduit domains to make the same changes that affect all objects in that domain
- Display Manager to set default display settings for all other types of objects

Levels for Specifying Display Settings Setup

- Drawing default display settings determine the display of objects when no overrides are in effect.
System-level overrides are specified for systems, such as an exhaust duct system, and determine the display of all the objects assigned to the system.

Style-level overrides are specified for a style, such as a device style, and determine the display of all the objects using that style.

Specifying Default Display Settings

You can specify default display settings using the Style Manager or the Display Manager.

**TIP** In the Style Manager and the Display Manager, the entire collection of unfiltered display components are visible and available for editing. In contrast, on the Display tab on page 221 of the Properties palette, the display properties are filtered based on the object that is selected in the drawing area.

**Using the Style Manager**

1. Click Manage tab ➤ Style & Display panel ➤ Style Manager ➤ Style Manager.
2. Expand the desired objects folder, such as HVAC Objects.
3. Expand the system definitions for that object.
4. Select a system, and then click the Display Properties tab in the right pane.
5. Under Display Representations, double-click the display representation where you want to specify defaults (for example, Plan).

**TIP** You can also click the display representation and then click for the same result.

6. In the Display Properties dialog, click a display properties for one of the display components, and make the desired changes.

**Using the Display Manager**

1. Click Manage tab ➤ Style & Display panel ➤ Display Manager ➤ Display Manager.
2. Expand the Representations by Object folder.
3. Double-click an object in the list.
4 Click a display representation listed under the object where you want to specify defaults.

**TIP** The selected object and display representation will control the display properties available for editing. For example, a device in a model representation only displays the Layer/Color/Linetype tab. However, a device in a plan representation displays the additional Hatching tab.

5 In the right pane on the Layer/Color/Linetype tab, click a display property for one of the display components (such as Linetype), and make the desired changes.

**RELATED** See Editing a Display Representation in the AutoCAD Architecture Help.

### Applying System-Level Overrides

Use the Style Manager to apply system-level display overrides that control the display representation for objects in a particular system (such as Duct - Low-Pressure Supply).

**NOTE** Although MvParts can be assigned a system, their display properties are not controlled by systems.

1 Click Manage tab ➤ Style & Display panel ➤ Style Manager ➤ Style Manager.
2 Expand the desired objects folder, such as HVAC Objects.
3 Expand the system definitions for that object.
4 Select a system, and then click the Display Properties tab in the right pane.
5 Under Style Override, select the box for the display representation where you want to apply an override.
6 In the Display Properties dialog, modify the display properties of the display components as needed.
Applying Style-Level Overrides

Use the Style Manager to apply style-level overrides that control a display representation for all objects of a particular style (for example, a device style for a junction box).

1. Open the drawing that contains the style to override.
2. Click Manage tab ➤ Style & Display panel ➤ Style Manager .
3. Expand the category and the style type that you want to override.
4. Select the style, and then click the Display Properties tab in the right pane.
5. Under Display Representations, select the display representation where you want to apply an override, and select the corresponding box in the Style Override column.
6. In the Display Properties dialog, modify the display properties.

Configuring Display Settings During Design

The Display tab of the Properties palette directly controls the graphical properties of objects in an AutoCAD MEP drawing.

Display tab showing Duct display properties

On the Display tab of the Properties palette, click (Select Components), and then click an object in the drawing area to make changes to the display properties.
General Display Properties

- Display components: Allows you to adjust settings for the object's individual display components, such as contours and centerlines

  **NOTE** Only the active component display properties for the selected object are listed.

- Display controlled by: Choose from the list of 3 options:
  - Object: Applies changes to all objects with the specified system (for example, Duct System Definition: Supply - Low Pressure) for which no object overrides are in effect (called system override). This selection takes precedence over the drawing default setting and style setting.
  - Style: Applies changes to all objects with the specified style (for example, Duct Style: 300 mm Diameter Round Duct) for which no object overrides are in effect (called style override). This selection takes precedence over the drawing default setting.
  - System definition: Adds a system definition override to the selected object
  - Domain drawing default: Applies changes to all objects within a domain.

  **RELATED** See Hierarchy of Display Control on page 217.

- Display representation: Displays the current display representation (such as Plan)

Component Display Properties

- Basic defines the color, layer, linetype, linetype scale, and linewidth properties of the selected object.

Click (along the General title bar) for the Apply Display Component Properties to Other Display Representations worksheet to change other display representations at the same level indicated by the Display controlled by value.

**TIP** A display component must be selected for this button to appear. The corresponding worksheet will only reflect display representations that can be applied to the selected component.
Changes made on the Display tab become immediately visible in the display representation of the current drawing. You can also apply changes to other display representations. For example, you can specify whether a change you make to a display property will apply to the selected component for all objects of that type, all objects of that style, or only the selected object.

Display of Objects Based on Elevation

In some regions, construction documents must show building system objects differently based on their elevation. For example, you might be required to display an object below the floor slab in the plan view with one linetype, and another object above the floor slab but below the cut plane with another linetype.

You can meet such requirements using the Display by Elevation feature. The Display by Elevation feature includes the following elevation-based display components:

- Contour
- Connector
- Center Line
- Hatch
- Insulation
- Lining
- Rise Drop
- Annotation
You can configure these display components to show or hide the following AutoCAD MEP objects relative to the floor plan and the cut plane on page 228:

- Cable tray, cable tray fitting
- Conduit, conduit fitting
- Duct, flexible duct, duct fittings, and custom duct fitting
- MvParts
- Pipe, flexible pipe, pipe fitting, custom pipe fitting

Any rise/drop symbols associated with these objects will inherit the elevation-based display characteristics of the parent object.

If you create a 2D section or 2D elevation with a display set that uses 1-Line or Plan display representations, the section or elevation also shows the objects with the elevation-based display properties.

**NOTE** Only objects in the Duct domain can be configured with 1 Line elevation-based components.

The elevation-based display components control the display of objects when the following conditions are met:

- The Display by Elevation feature is enabled on page 227.
- The current view is Top (plan).
- The current display configuration uses 1-Line or Plan display representations on page 211.

You can configure elevation-based display components using the Style Manager or the Display Manager (see Specifying Default Display Settings on page 219). The following example shows contour display components in the Display Manager when the Display by Elevation feature is enabled on page 227:
Display settings differentiate objects above or below the display range. For example, you can set linetypes and line colors on page 221 to display differently depending on elevation. You can also use the display settings to hide an object based on its elevation. Hiding objects is useful when you create construction documents for a specific floor plan from a model that spans multiple stories.

You can also configure elevation-based display components that apply to a particular object in the drawing using the Display tab of the Properties palette (see Configuring Display Settings During Design on page 221).

The next example shows the Display tab with the relevant display component based on the elevation of the selected object. The cut height is 2500 mm, the display above range is 3500 mm, and the display below range is 0. At an elevation of -1000 mm, the duct object, located below the display range, is hidden.
NOTE Display settings are stored in the drawing. When you enable the Display by Elevation feature in the drawing template for your project, all drawings created from the template will have the feature enabled by default and will include the correct display settings. If you are working in a project environment, make sure you copy the display settings to all of the templates you are using for constructs, views, and sheets.

**Workflow for Displaying Objects Based on Elevation**

**Review the steps**

Enable the Display by Elevation feature.

**View more information**

Select Enable Display by Elevation to differentiate objects that are placed above or below the cut plane in the layout. See Enabling the Elevation-Based Display Components.
Enabling the Elevation-Based Display Components

1. Click ➤ Options.

2. On the MEP Display Control tab, select Enable Display by Elevation.

**NOTE** From the command line, you can also enter `displaybyelevation` and then follow the prompts to enable this feature.

**RELATED** See *Display of Objects Based on Elevation* on page 223.
Specifying the Cut Plane and Display Range for a Display Configuration

When you configure a display configuration, you can specify the cut plane and display ranges. In the plan view, AutoCAD MEP uses the cut plane settings for the current display configuration. It also uses the elevation of an object to determine which display component (Below, Low, High, or Above) is used to display the object.

TIP For a pipe object with a slope on page 373, the object’s starting point determines its elevation.

RELATED Global cut plane and display range settings for a display configuration in AutoCAD MEP objects are used differently from AutoCAD Architecture objects. See Working with Cut Planes in a Project in the AutoCAD Architecture Help.

To set cut plane and display ranges

1 Select Enable Display by Elevation in the Options dialog.
2 Specify the cut plane settings using one of the following methods:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>define the cut plane height for the current display configuration</td>
<td>click the Cut Plane value on the drawing window status bar.</td>
</tr>
<tr>
<td>define the cut plane height for any display configuration</td>
<td>Click Manage tab ➤ Style &amp; Display panel ➤ Display Manager ➤ Display Manager. Select a display configuration that uses a Plan display representation in Top (plan) view or a 1 Line (for Duct domain only). Click the Cut Plane tab in the right pane.</td>
</tr>
</tbody>
</table>

3 For Cut Height, enter a value for the cut plane.
The cut plane is the height at which an object is cut to produce the plan representation.

**Example of Cut plane tab in the Display Manager**

4 For Display Above Range, enter a value for the top range of the floor plan.

Objects above this range are displayed using the Above display components. For example, in 1-line display representations, this is the Single Line - Above component. In plan display representations, these are the Contour - Above, Insulation - Above, and Rise Drop - Above components.

Objects at or below this range, but above the cut height, are displayed using the High display components.

5 For Display Below Range, enter a value for the bottom range of the floor plan.

Objects at or below the cut plane, but above this height, are displayed using the Low display components. Objects at or below this height are displayed using the Below display components.

For more information, see Specifying the Display Properties of a Space Style.
Configuring Elevation-Based Display Components

In the Style Manager, you can change a display representation for all elevation-based display components for objects in a particular domain. However, in the Display Manager, you configure the display representation for domain objects individually.

Make sure that you coordinate the configurations of the elevation-based display components with each other (such as, contour components with insulation components), and with the display components that are not elevation-based (for example, connector display components).

To configure elevation-based display components

1 Select Enable Display by Elevation in the Options dialog.
2 Click Manage tab ➤ Style & Display panel ➤ Style Manager .
3 Expand the desired objects folder.
4 Expand the system definitions.
5 Select the desired system definition, and then click the Display Properties tab in the right pane.
6 To configure the Plan display representation, select Plan (default), and then click .
7 On the Layer/Color/Linetype tab of the Display Properties dialog, specify values for the elevation-based display components, such as Contour, Single Line, and Hatch. Click OK when done.
8 To configure 1-line, on the Display Properties tab, select a 1-line display representation, and click . Repeat the previous step in the Display Properties dialog.

To activate the display range in model view

1 Click Manage tab ➤ Style & Display panel ➤ Display Manager .
2 On the left pane, expand Sets, and select MEP Design - Model.
3 On the right pane, click the Display Options tab.
4 Under Live Sections and Materials, select Section AEC Objects by Display Range defined in Display Configuration.

As a result, the elevation-based display range you specified for the cut plane on page 228 is visible in model view.

**Modifying Elevation-Based Display Components on the Properties Palette**

You can modify the current display components for an object in a drawing using the Display tab on the Properties palette.

1. **Switch to the desired workspace.**
2. Select **Enable Display by Elevation** in the Options dialog.
3. Select an object.
4. Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Properties .
5. On the Properties palette, click the Display tab.
6. Select an object in the drawing. The current display representation appears under General.

**NOTE** Instead of selecting an object, you can click at the bottom of the Display tab, and then click the display component in the drawing for the same result.

7. Under General, for Display controlled by, select the level at which you want your changes applied.
8. Under General, for Display component, select a display component from the list.
   Only the elevation-based display components that pertain to the selected object are listed.

9. Click (on the General title bar) to apply changes to other display representations at the same level indicated by the Display controlled by property. Make changes to the Apply Display Component Properties to Other Display Representations worksheet.
TIP  A display component must be selected for this button to appear. The corresponding worksheet will only reflect display representations for the selected component.

The following example shows the current display component details on the Display tab for the selected pipe object.

Overriding the Cut Plane

To display all the architectural and business system objects correctly, some designs require different cut planes and display ranges for AutoCAD MEP objects as opposed to AutoCAD Architecture objects.

RELATED  See Object-Specific Cut Planes in the AutoCAD Architecture Help for more information.
To apply cut plane overrides on the Display tab

1. Switch to the desired workspace.
2. Select Enable Display by Elevation in the Options dialog.
3. Select an object.
4. Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Properties.
5. Under Object Display Properties, configure settings for the current configuration as follows:
   a. Select Yes for Above level override, and then specify a value for Above range.
   b. Select Yes for Cut height override, and then specify a value for Cut height.
   c. Select Yes for Below level override, and then specify a value for Below range.

**BEST PRACTICE** Some objects spanning multiple cut planes might include a Rise/Drop symbol on an elevation-based display component that is turned off, causing the object to be hidden. In those cases, you can override the cut plane for that particular object so that it appears in the drawing area.

To apply cut plane overrides in the Display Manager

1. Select Enable Display by Elevation in the Options dialog.
2. Click Manage tab ➤ Style & Display panel ➤ Display Manager.
3. Expand the Configurations folder.
4. Select a display configuration from the list.
5. Click the Cut Plane tab in the right pane.
6. Apply the desired override for the display configurations that use this display representation.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>define the visible range above the cut plane</td>
<td>enter a value for Display Above Range.</td>
</tr>
<tr>
<td>define the cut plane height</td>
<td>enter a value for Cut Height.</td>
</tr>
</tbody>
</table>

Display of Objects Based on Elevation | 233
If you want to... then...
define the visible range below the cut plane enter a value for Display Below Range.

The values you enter for the Above and Below ranges are not relative to the cut height. They are absolute height values calculated from the WCS origin. Therefore, the value that you enter for Display Above Range must be greater than the value that you enter for Cut Height. Invalid values will produce incorrect results.

NOTE The Calculate button on the Cut Plane tab is only available if you selected a project using Project Navigator and the current drawing is multi-story. It opens a Cut Plane dialog that you use to set the cut plane height for objects at a specific level. For more information, see Levels in the AutoCAD Architecture Help.

Display of Crossing Objects in 2-Line Plan Views

You can change the appearance of hidden lines, layers, line types, or color for crossing or overlapping objects at different elevations in 2-line plan views.

Configuring the Display of a Gap Between Crossing Objects

You can configure a gap to display between crossing objects or disable hidden lines for MvParts. These settings are applied to all objects in the drawing.

1 Click ➤ Options.
2 In the Options dialog, click the MEP Display Control tab.
3 Under Crossing Objects Display, specify one of the following:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify a gap to the outside of the crossing objects</td>
<td>select Apply Gap to Outside, and then enter a value for Gap Width.</td>
</tr>
<tr>
<td>specify a gap to the inside of the crossing objects</td>
<td>select Apply Gap to Inside, and then enter a value for Gap Width.</td>
</tr>
<tr>
<td>If you want to…</td>
<td>then…</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>specify no gap to the outside of the</td>
<td>clear Apply Gap to Outside (the default).</td>
</tr>
<tr>
<td>crossing objects</td>
<td></td>
</tr>
<tr>
<td>specify no gap to the inside of the</td>
<td>clear Apply Gap to Inside (the default).</td>
</tr>
<tr>
<td>crossing objects</td>
<td></td>
</tr>
<tr>
<td>change the size of the gap as the</td>
<td>select Apply Annotation Scale to Gap</td>
</tr>
<tr>
<td>annotation scales change</td>
<td></td>
</tr>
<tr>
<td>specify the gap size</td>
<td>enter a value for the gap</td>
</tr>
<tr>
<td>increase drawing performance when using</td>
<td>select Save Hidden Lines in Drawing.</td>
</tr>
<tr>
<td>hidden lines</td>
<td></td>
</tr>
<tr>
<td>have hidden lines ignore MvParts</td>
<td>select Disable Hidden Lines for MvParts.</td>
</tr>
</tbody>
</table>

### Modifying Hidden Lines for Objects

You can modify hidden line properties such as color, linetype, and visibility use the display properties dialog for selected objects.

1. Select the object, and on the Display tab of the Properties palette, click (Edit Object Display).
2. In the Object Display dialog, click the Display Properties tab.
3. Select the Plan display representation.
4. Open the Display Properties dialog:
   - If you want to change the object display representation so that all objects in the drawing display the same way, click (Edit Display Properties).
   - If you want to change the display for the selected object only, select Object Override for the Plan display representation.
5. In the Display Properties dialog, specify the settings for the display components with Hidden in their name.
Display of Center Lines on Ducts

In display configurations that use 2-line display representations for ducts and fittings, you display center lines on the ducts and fittings by turning on the visibility of the Center Line display components (in the display representations).

However, in display configurations that use Plan display representations, you have more flexibility. You can:

- Display or hide the center lines on all ducts and fittings
- Display or hide the center lines on ducts and fittings of specific shapes
- Display or hide the center lines on flexible ducts
- Extend the center lines of round takeoffs and oval takeoffs to the center lines of mains

In the following image, center lines are displayed on the round ducts and fittings to the left of the multi-shape transition fitting, but they are not displayed on the transition fitting or the rectangular duct on the right.

If you create a 2D section or 2D elevation using a display set that uses the Plan display representations, the section or elevation also shows the center lines as specified.

**NOTE** You can also display center lines on rise symbols and on drop symbols by specifying center line blocks in rise/drop styles. For more information, see Defining Rise/Drop Styles on page 914.

**To display center lines on ducts and fittings in Plan display representations**

1. Click Options.
2. Click the MEP Display Control tab.
3. Under Center Line Display, specify the ducts and fittings on which you want to display center lines.
NOTE The Display on Multi-shape Fittings setting works in conjunction with the shape-dependent settings. The center line on the fitting is displayed if center lines are enabled for the shape corresponding to at least one of its connectors.

IMPORTANT To display center lines on all ducts and fittings regardless of shape, select all of the options. For center lines to be visible in display configurations using Plan display representations, these settings must be configured as required, and the Center Line display components must be set to Visible (which you do later in this procedure). You cannot complete the latter task alone.

4 If you want to display center lines on flexible ducts, select Display Center Line on Flex Ducts.

NOTE If you are using duct system definition overrides, and you do not want to display center lines on the flexible ducts assigned to those systems, deselect this option. A system definition override that turns on the Center Line display component does so for all duct objects, including flexible ducts. However, center lines are not displayed on any flexible ducts unless this option is selected.

5 If you want to extend the center lines on takeoffs to the center lines of the mains, select Extend Center Line for Takeoffs.

NOTE The center line on a takeoff is displayed if center lines are enabled for the shape corresponding to the branch connector. It is extended to the main if you select Extend Center Line for Takeoffs, and the takeoff is round or oval (not rectangular or multi-shape).

In the following steps, you turn on the visibility of the Center Line display components in the Plan display representations for all duct objects.

6 Click Manage tab ➤ Style & Display panel ➤ Style Manager ➤ .
7 In the left pane of Style Manager, select any system definition, and in the right pane, click the Display Properties tab.

8 Select the Plan display representation, and click .

**NOTE** Accessing and configuring a display representation in this way automatically applies the changes to the same display representation for all duct objects (ducts, duct fittings, custom duct fittings, and flexible ducts). You can achieve the same results by configuring the display representations using Display Manager, but this requires you to configure the display representation for ducts, repeat the changes in the same display representation for duct fittings, repeat them again for custom duct fittings, and so on.

9 In the Display Properties dialog, click the Layer/Color/Linetype tab.

10 Click the icons under Visible to turn on the Center Line display components.

11 Configure the remaining display properties of the Center Line display components as required.

If needed, you can also apply **system-level overrides** or **style-level overrides**.

**NOTE** You can also enable the display of center lines on ducts or fittings by entering the command corresponding to the shape or type:
ROUNDDUCTCENTERLINE, RECTANGULARDUCTCENTERLINE, OVALDUCTCENTERLINE, MULTISHAPEFITTINGCENTERLINE, FLEXDUCTCENTERLINE, or TAKEOFFCENTERLINE.

---

**Display of a Hatching Pattern to Identify a Duct System**

You can add hatching patterns to a duct system to identify separate systems in complex drawings. For example, you can specify different hatch patterns for supply and return duct systems.

1 In the drawing that contains the duct systems, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ HVAC System Definitions .

2 Select a duct system.

3 In the right pane, select the Display Properties tab.

4 Double-click Plan under Display Representations.
5 In the Display Properties dialog, select the Layer/Color/Linetype tab.
6 Select Hatch under Display Component, and specify it as visible.
7 Click the Hatching tab, and specify a hatch pattern.
8 Click OK 3 times.

Display of Objects by Classification

You can hide or show objects in a display set based on object classification. For example, if you classify objects by construction status, such as New, Existing, and Demo, you can exclude objects with the Demo classification from the display. When the display is used in the drawing, those objects do not appear.

Objects filtered from the display are not removed from the drawing. Their display is turned off only in viewports using the display set in which objects of that classification are filtered. You can change the filter to display them again. Because the objects still exist in the drawing, the display of other objects in the drawing does not change. For example, if you filter dampers from a floor plan, the ducts that connect to the dampers still end at the points where the dampers are located.

RELATED See Displaying Objects by Classification and Classification Definitions in the AutoCAD Architecture Help.

Adding Custom Graphics as a Display Component

You can add custom blocks to the display representations of some building systems objects. For example, you can add custom blocks to mechanical pipe runs to add symbology to designate hangers.

To create a custom component for a building systems object
1 Draw the custom component, and save it as a block.
2 Select a building systems object, and on the Display tab of the Properties palette, click \(\text{Edit Object Display}\).
3 In the Object Display dialog, click the Display Properties tab.
4 Select any display representation except one of the Plan display representations, and click \(\text{Edit Display Properties}\).
5 In the Display Properties dialog, click the Other tab.

**NOTE** If the Other tab is not available, the selected building systems object does not support custom graphics as a display component.

6 Under Custom Block Display, click Add.

7 In the Custom Block dialog, click Select Block.
   In the Select a Block dialog, select the block that you created.

8 To specify a scale, in the Custom Block dialog, under Scale to Fit, specify a scale to maintain for the block based on the size of the block entities.
   You can select Width, Height, Depth, Lock XY Ratio, or a combination of these options.

9 To mirror the block upon insertion, under Mirror In, specify the direction to mirror the block:
   - Mirror X creates a mirror of the block in the X direction, along the segment curve.
   - Mirror Y creates a mirror of the block in the Y direction.
   - Mirror Z creates a mirror of the block in the Z direction.

10 To insert an instance of the block, under Insertion Point, specify a position for the block on the object by selecting an X, Y, and Z position on the segment curve.

**IMPORTANT** When Repeat Block Display under Repeat Mode is selected, Insertion Point is unavailable (shaded).

11 To specify an offset for the block, under Insertion Offset, enter distances for the X, Y, or Z directions from the segment curve.

12 To repeat the block along a segment, under Repeat Mode, select Repeat Block Display, and enter a distance for Start Offset and/or End Offset and Spacing.
   The insertion point of the first block is located at the start offset location. The block is then repeated, placed according to the specified distance for spacing between blocks. The last block is placed at or near the end offset location to allow for equal spacing between blocks based on the specified distance.

13 Click OK 3 times.
Troubleshooting Object Display

If objects are displayed incorrectly or not at all, follow these suggestions for troubleshooting the problem:

1. Verify that the object’s layer is on.
2. Verify that the viewport in which the object will display is on.
3. If you are using referenced drawings (xrefs), confirm the method of attachment and the xref configuration.

Under certain circumstances, the Display Manager can assist you in troubleshooting object display problems. Check the display configurations to:

- Identify the display set applied to the viewport
- Verify that a display representation is selected in that display set
- View the display properties to confirm that the components are turned on

AutoCAD MEP Templates

Once you establish project standards, you can create custom templates that are unique to your project. You can create a custom template in several ways:

- (Recommended) Modify an existing template.
- Save a drawing as a template.
- Create the template from scratch.

RELATED  See Use a Drawing Template File.

Default Drawing Templates

Drawing templates store default preferences, controls, and content common to all drawings in a project. You can start on a project immediately by using a template. This saves time and provides consistency when creating multiple drawings.
AutoCAD MEP includes several default templates in metric or imperial units. Most notably:

- Aecb Model, a template for designing building systems
- Aecb Sheet, a template for plotting building systems

The templates have specified drawing units, drawing scales, and annotation size. They also have defined layout tabs, display representations, and plotting setups, which serve as a guide to the recommended use of model space and paper space.

Using default templates helps you become more familiar with the software to create new drawings and incorporate them into your project standards. Later, you can modify the default templates or create your own to meet specific company or project requirements.

Perform the action associated with one of the following components:

**Layer structures**

1. Click Home tab ➤ Layers panel ➤ Layer Properties.
2. Click Layer Standards.
3. Click Import/Export. For more information, see Importing Layer Standards in the AutoCAD Architecture Help.

**Styles, such as system definitions and object styles**

1. Click Manage tab ➤ Style & Display panel ➤ Style Manager.
2. Select the style from the tree view of the first drawing, and drag it to the tree view of the second drawing.

**Design content such as text styles, dimension styles, and linetypes**

1. Click Insert tab ➤ Content panel ➤ Content drop-down ➤ Design Center.
2. Select the content type from the tree view.
3 Double-click the specific design content to add it to the drawing.

NOTE For more information, see DesignCenter.

Layout tabs
1 If the Model tab and layout tabs are visible, right-click any tab, and select From template.
2 In the Select Template From File dialog, select the file that contains the layout tabs that you want to add to your drawing, and click Open.
3 In the Insert Layouts dialog, select the layout tabs. If the Model tab and layout tabs are not visible, you can display them by right-clicking either corresponding status bar button, and clicking Display Layout and Model tabs.

NOTE For more information, see Creating and Saving Drawings.

NOTE If you do not use a template to create new drawings, you must save the drawing settings and standards that you need in each individual drawing.

Creating a Custom Template from a Template or Drawing

An efficient method for creating custom templates is to start with an existing template or drawing, modify it, and save it as a new template. This method works best when minor modifications to the existing template or drawing can provide the custom template that you need.

To create a custom template from a template or drawing

1 Click ➤ Open ➤ Drawing.
2 If you are using an existing template (DWT file) as a base for your new template, in the Select template dialog, verify that Drawing Template File (*.dwt) is selected for Files of type.
3 Browse to the template or drawing file from which to create the new template and open it.
4 Modify the template or drawing.
You can change preferences or controls in the drawing, add or replace the border or title block, import or configure standards, and erase or add drawing elements.

5 Click ➤ Save As ➤ AutoCAD Drawing Template.

**TIP** By default, the software saves the new template in the \ProgramData\Autodesk\MEP 2011\enu\Template folder.

6 For File name, enter a name for the new template, and click Save.

7 In the Template Options dialog, enter a brief description of the template, and specify the measurements, and click Help to learn about New layer Notification options.

**Creating a Custom Template**

If you use different standards for each project, creating custom templates is recommended instead of creating them based on existing templates. You can save time and maintain accuracy by starting with a clean project environment and customizing only those standards required for the project. In addition, creating the clean template means you do not need to clean out irrelevant information from an existing template or drawing.

**To create a custom template**

1 Click ➤ New ➤ Drawing.

2 In the Select template dialog, select acad.dwt from the list of templates, and then modify the template.

You can change preferences or controls in the drawing, add or replace the border or title block, import or configure standards, and erase or add drawing elements.

3 Click ➤ Save As ➤ AutoCAD Drawing Template.

**TIP** By default, the software saves the new template in the \ProgramData\Autodesk\MEP 2011\enu\Template folder.
4 For File name, enter a name for the new template, and click Save.
5 In the Template Options dialog, enter a brief description of the template, and specify the measurements, and click Help to learn about New Layer Modifications.

**NOTE** AutoCAD MEP template settings are not necessarily the same as AutoCAD default template settings. When creating a new template, it is recommended that you click ➤ Utilities ➤ Drawing Setup, and specify the drawing units and scale in the Drawing Setup dialog.

---

**Working with Referenced Drawings**

When you create an AutoCAD MEP drawing, you often need to relate your layout to an architectural drawing, such as a floor plan, a reflected ceiling plan, or an AutoCAD Architecture building model.

You can begin with a drawing that contains the walls and other spatial elements that you need by attaching another drawing called a referenced drawing or xref. Xrefs are drawings that are linked to, and displayed in, the current drawing.

Whenever you open a drawing, the software reloads the xref drawings attached to it so that changes made to the xref drawings are reflected in your building system drawing. For example, if you attach an architectural floor plan as an xref, and the architect subsequently changes the location of the building’s mechanical room, the changes to the architectural floor plan are automatically reflected in your building systems drawing the next time that you open it. You can also reload xrefs on demand and check for interferences between building system objects and structural members by applying interference detection highlighting to your drawing.

There are 2 types of xrefs: attachment and overlay. Unlike an attached xref, an overlaid xref is not displayed when the drawing is itself attached or overlaid.
as an xref to another drawing—a process referred to as nesting xrefs. Overlaid xrefs are designed for data sharing in a network environment. By overlaying an xref, you can see how your drawing relates to the drawings of other groups without changing your drawing by attaching an xref. Changes made to an xref drawing, whether attached or overlaid, are displayed in your drawing when you open the drawing or reload the xref.

Linking xrefs to your drawings is effective when creating design drawings and construction documents. Design projects typically involve the coordination of many drawings, and sharing the content of those drawings is fundamental to efficient project management. Establishing standards for using xrefs helps you to use drawings optimally and minimize the need to re-create drawing content.

The following cite several advantages to using xrefs in AutoCAD MEP drawings:

■ You can reference an architectural drawing as a base for your mechanical, electrical, or plumbing drawings. In addition, you are aware immediately of any changes to the architectural drawing because the changes are reflected when you open your drawing or reload the xref.

■ You can assemble master drawings from individual design drawings. For example, several people can work with different sections of a design for a large building (such as by floor or by wing), and the individual designs can be referenced into a master drawing.

■ You can attach drawings containing borders, title blocks, and other office standards for plotting as xrefs for easy maintenance.

■ You can choose not to load an xref if you do not need it as a reference. The xref does not use system resources when it is not loaded.

NOTE See Concepts of Drawing Management and Reference Other Drawing Files.

## Attaching or Overlaying Xrefs

Xrefs enable you to begin with a drawing that contains walls and other spatial elements that you need, such as a floor plan, reflected ceiling plan, or AutoCAD Architecture building model.

NOTE In a Drawing Management project, attach xrefs using the Project Navigator only. For more information, see Concepts of Drawing Management in the AutoCAD Architecture Help.
If you attach or overlay an xref created in a previous version of the software, the file format of the xref is not updated to the current version (which would make the xref incompatible with the version in which it was created). The exception to this is when the xref contains annotative objects, and the host drawing is configured to automatically add scale representations to annotative objects as the annotation scale changes.

**RELATED**  See Adding and Modifying Scale Representations on page 823.

To attach or overlay an xref

1. Click Insert tab ➤ Reference panel ➤ Attach.
2. In the Select Reference File dialog, open the file you want to attach or overlay.
3. In the Attach External Reference dialog, select one of the following for Reference Type:
   - Attachment: Saves a copy of the xref drawing in your drawing.
   - Overlay: Creates a link to the xref drawing in your drawing.
4. Specify the insertion point, scale, and rotation angle; or click Specify On-screen to use the cursor.
5. Click OK, and, if necessary, specify the insertion point, scale, or rotation angle in the drawing.

**Reloading Xrefs**

When you open a drawing, the software automatically reloads all xrefs. However, you can reload xrefs at any time when you want to ensure the most current versions are displayed in your drawing.

To reload an xref

1. Click Insert ➤ Reference panel ➤ External References tool palette.
2. On the External References palette, select the name of an xref, right-click, and click Reload All References.
Clipping Xrefs

After attaching or overlaying an xref, you can define a clipping boundary to display only a portion of the xref.

Clipping an xref is often useful when you want to:

■ Work with a specific part of a large architectural floor plan
■ Enlarge a specific part of a building systems drawing (for example, to show a detailed layout in a mechanical or electrical room)
■ Lay out construction documents
■ Improve drawing performance because you load only a part of the xref drawing

To clip an xref

1 Click Insert tab ➤ Reference panel ➤ Clip.
2 Select a reference.
3 At the prompt, select New Boundary by pressing ENTER.
4 Select a rectangular or polygonal clipping boundary, and then specify the corners or vertices of the boundary.

The software clips the image based on the area that you specified, and hides the portion of the xref outside the clipping boundary.
Changing the Display Configurations of Xrefs

1. Open the host drawing that contains the xref drawing for which you want to specify a different display configuration.
2. Select the xref drawing that you want to change, and on the Display tab of the Properties palette, click (Edit Object Display).
3. In the Object Display dialog, click the Xref Display tab. If the settings on the tab are unavailable, you cannot change the display configuration used for the xref overlay.
4. Select Override the display configuration set in the host drawing.
5. Select the display configuration to use.

RELATED  See Clip External References and Blocks.
The listed display configurations are those available in the xref drawing. Select Domain Drawing Default if you want to use the default display configuration specified in the host drawing.

6 Click View tab ➤ Appearance panel ➤ Regenerate drop-down ➤ Regenerate Drawing And Viewports.

NOTE If you specified that the drawing should always use its own display configurations when it is inserted as an xref overlay, you cannot change the display configuration used to display the xref objects in the host drawing. For more information, see Specifying the Display Configurations Used in Xref Overlays in the AutoCAD Architecture Help.
This section offers instructions on how to use AutoCAD MEP to design and draft heating, ventilation, and air conditioning (HVAC) systems for a building plan.

**HVAC System Overview**

Best practices for mechanical system design start with the establishment of project parameters. HVAC designers can design duct and necessary piping systems to create, size, and connect heating and cooling components.
Before you begin drafting, you can establish design preferences and HVAC system definitions that fit your project. Once you define the systems for your drawing, you can assign systems to equipment and ductwork as you draw and modify your duct networks.

**Workflows**

This section contains workflows for designing and optimizing an HVAC system. Click in the left column to see the step. The right column provides links to more detailed information.
Mechanical System Workflow

Step | View more information
--- | ---
Define HVAC design parameters | Specify routing and auto-layout behavior, duct size calculation parameters, and duct rise and drop display style by Configuring Duct System Settings on page 279
Define a project | Specify the tool catalogs to use and other project information by Working with Projects on page 199
Link to floor plans | Use Project Navigator to create drawing sheets and views and attach an architectural floor plan as an external reference by Working with Referenced Drawings on page 245
Specify or leverage spaces, and use them to create room take-off schedules | Spaces make it easy to export building information via gbXML for the calculation of heating and cooling loads. See Using Spaces for Load Analysis on page 320
Calculate heating and cooling loads | Use one of a variety of 3rd-party tools to determine heating and cooling loads by Calculating Duct Sizes to Optimize Duct System Designs on page 336
## Duct System Workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>View more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create preliminary 1-line designs</td>
<td>Prepare a conceptual design for evaluation by building engineers and code officers. See About Schematic Diagrams on page 772.</td>
</tr>
<tr>
<td>Lay Out a System</td>
<td>Place diffusers, VAV boxes, coils, dampers, and other equipment by adding HVAC parts on page 290.</td>
</tr>
<tr>
<td>Draw Duct</td>
<td>Connect the equipment using duct runs by adding duct on page 292.</td>
</tr>
<tr>
<td>Size Duct</td>
<td>Verify flow values and calculate duct to properly size components by calculating duct sizes for a duct system on page 302.</td>
</tr>
<tr>
<td>Make changes to a duct system</td>
<td>Modify system layouts based on design changes, and recalculate sizes as necessary by modifying a duct system on page 341.</td>
</tr>
<tr>
<td>Label system components and generate schedules</td>
<td>As you design, annotate systems for preliminary design specifications and subsequent construction documents. See Adding a Label or Flow Arrow to Duct on page 318.</td>
</tr>
</tbody>
</table>
Refine a duct system

You can modify and move duct and equipment using grips to accommodate design changes without breaking connections. See Grips for Modifying a Duct Run on page 265.

Workflow for Using Spaces for Load Analysis

Configure space styles.

Create a space style, specify lighting and equipment load per area, and specify a classification. See Specifying Space Styles on page 321.

Create zone styles to specify the display and design rules for zones.

See Configuring Zone Styles on page 323.

Adding spaces to a floor plan.

Add spaces to a drawing using objects in a referenced floor plan drawing (xref) as the bounding objects. See Adding Spaces to a Floor Plan on page 324.

Assign property set data to spaces and edit engineering data.

See Adding Engineering Data to Spaces on page 326.

Attach property sets to zones.

Create zones and assign property sets before exporting space data. See Attaching Property Sets to Zones on page 329.
Step

Associate spaces with zones.

Assign spaces to zones and attach zones to other zones. See Attaching Spaces to Zones on page 330.

Exporting zones for load analysis.

Export the engineering and building information in gbXML format. See Exporting Zones for Load Analysis on page 331.

Review spaces and zones.

Use the Space/Zone Manager to review the zone hierarchy and review space information. See Reviewing Spaces and Zones on page 332.

Import load analysis results.

Import the completed load analysis data into your drawing. See Importing Load Analysis Results on page 334.

Use space and zone calculated data.

Display load calculation results in tags and schedules to improve the design of the HVAC system. See Using Space and Zone Calculated Data on page 335.
Workflow for Calculating Duct Sizes to Optimize Duct System Designs

<table>
<thead>
<tr>
<th>Step</th>
<th>View more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review your duct system to ensure compliance with generally acceptable design practices.</td>
<td>Verifying your system ensures that external analysis tools can analyze unorthodox systems or components. See Calculating Duct Sizes to Optimize Duct System Designs on page 336.</td>
</tr>
<tr>
<td>Assign ASHRAE identification numbers to all fittings if your external analysis tool requires it.</td>
<td>See Specifying ASHRAE Fitting Types on page 336.</td>
</tr>
<tr>
<td>For duct system data to be eligible for export, ensure that the duct system adheres to various criteria.</td>
<td>Review the list of criteria in Considerations Prior to Exporting Duct System Data on page 338.</td>
</tr>
<tr>
<td>Export system information directly from the drawing in DDXML format.</td>
<td>See Exporting Duct System Data on page 339.</td>
</tr>
<tr>
<td>Analyze the DDXML file using an external tool. Component sizes are calculated and written to the DDXML file. Then import the DDXML file into your drawing.</td>
<td>See Importing Optimized System Data on page 339.</td>
</tr>
<tr>
<td>Resize your system based on the calculated results.</td>
<td>See Resizing a System on page 340.</td>
</tr>
</tbody>
</table>
HVAC System Settings

You can configure duct layout preferences and system definitions to control the construction, display, and annotation of duct systems. Duct layout preferences are applied to all new duct runs. When adding a duct run, you specify a system definition. The duct layout preferences specify the parts and connections used in a duct run, and the system definition controls how the duct run is displayed.

**RELATED** For more information, see Configuring Duct Layout Preferences on page 279 and Configuring Duct System Settings on page 279.

Duct System Definitions

You typically name duct system definition for the duct system for which it will be used, such as supply or return air. Systems help maintain consistency throughout a run and across multiple drawings in a project. When you change a segment’s system, all components having valid connections to that segment are updated to the new system. Duct system definitions specify duct size calculation parameters and duct display information, such as layer key settings, rise and drop display style, and display properties. The settings for a system definition control many of the display properties of a duct system. You can assign a layer key style to a system definition to dictate its layer, color, and linetype. You can also configure a system definition for duct size calculations.

You can assign a system definition to a system group on page 140. Duct runs with different system definitions cannot connect to each other without changing the system for the connecting duct run. You can, however, assign a system group to different system definitions. This allows duct runs from different system definitions to connect while maintaining the same system for each run. For example, you can assign the same system group to Supply - High Pressure and Supply - Medium Pressure. You can then connect duct runs between these 2 systems while maintaining their original system definitions. The default templates include many duct system definitions, such as chilled water, heating hot water, and steam. Duct system definitions are stored with a drawing. You can use different system definitions for different drawings, and you can share system definitions among drawings.

**RELATED** For more information, see Configuring Duct System Definitions on page 288.
Drawing Ductwork

You can draw ductwork in various sizes and shapes. You can automatically place fittings, such as elbows and tees, as you draft. You can also manually add fittings to your runs, which is beneficial when using fittings not specified in the duct layout preferences.

NOTE When you add duct runs, AutoCAD MEP inserts rise symbols and drop symbols as needed based on the rise/drop style assigned to the system of the run.

After you initially lay out your mechanical equipment, you can draw ductwork to connect equipment and create networks. AutoCAD MEP includes many features that streamline the design and drawing of duct runs.

The process for adding duct runs is the same. You can add duct as 1-line objects as you design preliminary routes, and then modify them to 2-line objects as you specify properties, such as size and connection type. 1-line duct runs appear as single-line representations while 2-line runs display the actual geometry of the duct, even in isometric views. You do not necessarily need to draw runs as 1-line elements at first. You can draw defined 2-line duct any time.

NOTE 1-line duct objects differ from schematic lines in that they act as placeholders for sized 2-line duct objects. You can convert 1-line duct objects directly to 2-line duct objects of specific size and shape. For more information, see Display Representations on page 211

On the left, a top view of a 1-line duct run and on the right, a defined 2-line duct run.
You can draw duct runs in all 3 dimensions. You can also add sloped runs by specifying rise/run values. As you draw duct runs, fittings are automatically inserted to accommodate your routing geometry. The layout preferences specify which fittings are used. For more information, see Configuring Duct Part Preferences on page 284.

1-line and 2-line duct runs can be routed 3 dimensions.

You can size duct systems using AutoCAD MEP engineering analysis tools. You can use a duct system size calculator to size duct systems, and you can use instant duct size calculators in the Add dialog and Modify dialog to size individual segments.

Flexible Duct Runs

You can draw flexible duct runs. Flexible runs can be connected to rigid runs to create complete and accurate networks. Because flexible ducts are typically round in shape, the correct transition fitting is inserted when you connect to a duct segment of a different shape. You can specify a system for flexible duct components just as you can with rigid duct. You can also assign flexible and rigid components to the same system.
Flexible duct runs can be connected to equipment and MvParts.

You can draft a flexible duct run using different segment modes. Individual segments can be drafted as lines, arcs, or splines to create different configurations of flexible runs. For more information, see Configuring Flexible Duct Preferences on page 283.

You configure the display properties of flexible duct using several display components:

- **Contour.** Use this component to configure the contour lines.
- **Contour - Details.** Use this component to configure the interior contour lines.
- **Connector.** Use this component to configure the connector lines at start points and endpoints.
- **Annotation.** Use this component to configure the graphics pattern.

For more information on the display system, see AutoCAD MEP Displays on page 208.

**Auto Layout**

As you draw duct runs, you lay out the duct run geometry by specifying points in the drawing. The software automatically inserts duct segments and fittings along the layout. You can control which ducts and fittings are inserted by configuring duct layout preferences before you begin drawing duct runs.

The software includes many tools to streamline the layout of a duct run. You can use the compass to specify an angle, and you can use tracking lines to
align a component with another object or line. You can use AutoCAD MEP snaps to connect to duct objects, or to a geometric point on an object or line.

**Multi-Floor Duct Systems in Referenced Drawings**

You can connect duct systems in a current drawing with duct systems in referenced drawings. For example, a design for a multi-floor building includes a rooftop air conditioning unit. A medium velocity supply air duct runs vertically from the bottom of the AC unit to the ground floor. You can connect a system for each floor with the vertical supply air trunk even if the trunk exists in a reference drawing. The fittings needed to connect the floor system with the trunk are automatically saved in the reference drawing.

**RELATED** For more information, see Connecting Ducts Through Referenced Drawings on page 310.

**IMPORTANT** You can connect to objects in an xref, but any modifications to connected objects in the current drawing will not be propagated through to the xref drawing. For example, a duct run in the current drawing is connected to duct in an xref drawing. If you modify the duct size in the current drawing, only the duct in the current drawing is modified.

The following example shows a simple duct systems on separate floors connected to a vertical trunk in a reference drawing.
This example shows takeoffs that are added to connect with the duct systems on each floor in the referenced drawing.

Takeoffs enable you to position a fitting at any location on a duct segment. You attach the takeoff to the center line or curve of the segment, and then rotate the takeoff to a specified angle around the segment.

You can also position the takeoff off center from the center line or curve of the segment, referred to as an off-center takeoff. For example, you can attach the takeoff to the side of a duct segment above the center line. The offset distance is defined as the distance from the center line of the duct segment to the center line of the takeoff fitting.

**TIP** When attaching takeoffs, it is helpful to work in an isometric view of your model.
Duct Snaps

Duct AutoCAD MEP snaps quickly and accurately connect duct objects. As you draw duct runs, you can use duct snaps to connect a duct, fitting, or MvPart directly to a duct connector on another object. You can connect to duct end connectors located on the ends of objects. You can also connect to duct curve connectors located at any point along a duct segment.

Duct Grips

Grips offer an efficient alternative for drawing a new duct run or modifying an existing run. Grips let you quickly add or modify duct objects or MvParts. All available grips are displayed when you select an object in a drawing.

Add Grips

Add grips on a duct object are used to draw a duct run, ensuring connectivity between the object and the duct run. Some fittings also contain add grips for creating a new branch from the fitting. For example, an elbow has add grips that let you automatically convert the elbow to a tee and then draw a duct run directly from the new tee connection. The existing duct branches remain connected to the other tee connections. The following illustrates add grips on duct objects.

From top to bottom: Add grips for a duct segment, an elbow fitting, and a VAV outlet plenum
Add grip used at the midpoint of a run to create a new branch run.

Add grip used on a connected 90 degree fitting to create a new branch.

**RELATED** For more information, see Adding Duct Using Grips on page 298.

**Grips for Modifying a Duct Run**

AutoCAD MEP includes various grips for modifying duct segments or HVAC MvParts on page 110 in a duct run. Selecting the object exposes one or more grips for that object in the drawing.

**RELATED** To use add grips, see Adding Duct Using Grips on page 298. To use grips to modify duct objects, see Modifying Components Using Grips on page 342.

**Location Grips**

You can move duct segments, duct fittings, and HVAC MvParts on page 110 using Location grips, as shown next.
Example of a Location grip for a duct segment.

If the object is connected to a system, you can move connected objects in the current XY plane to maintain connectivity. The following illustrations show how location grips are used to move duct objects.

**Top view of a duct run**
Location grip used to move the duct branch to the adjacent room.

Duct branch moved to the new location

If a duct segment is not connected to another object, you can change its angle and length using the Start or End grip.

The Start and End grips change the XYZ location of the start point or endpoint of the segment. This makes them particularly useful when initially designing duct runs because you can use them to easily connect a segment to an existing run.
Elevation Grips

You can use elevation grips (▲) to modify the elevation of HVAC MvParts and duct segments as you connect them to existing duct runs in side and isometric views. Elevation grips on HVAC MvParts are displayed at their insertion points and connector points. Elevation grips on a duct segment let you modify the elevation relative to the top, centerline, or bottom of the segment.

If the part or duct segment is connected to other objects, you must specify whether you want AutoCAD MEP to maintain their connectivity when you modify the elevation.

The following illustrates changing the elevation of a duct segment.
Elevation grip on duct segment selected

select duct segment

select Elevation grip

input fields for relative dimension

input fields for absolute dimensions

activate input field
**Activated input field**

You can use the arrow-shaped (стрелка) Rotate grip to rotate HVAC in-line parts, duct fittings, and takeoffs 180 or 90 degrees in the direction indicated by the grip.

**RELATED** For more information, see Rotating Duct Components on page 345.
Rotating a damper 180 degrees in plan view

In isometric views, if the part, fitting, or takeoff has round connectors on opposite ends, you can also use the diamond-shaped ( ) Rotate grip to rotate the object around its centerline to any angle you specify.

Rotating a damper in an isometric view

AutoCAD MEP displays Rotate grips on all HVAC in-line parts, fittings, and takeoffs with connectors on opposite ends. However, when necessary to preserve the connectivity of duct runs, the software limits the available rotation options or hides the grips. For example, in the following illustration, you can rotate the wye fitting on the left in several ways, but you cannot rotate the wye fitting on the right due to the connected branch.
When you rotate a part, fitting, or takeoff that is connected to other objects, the software adjusts the connected objects to maintain connectivity. For example, the software might make minor adjustments to the lengths of connected duct segments after you have flipped a fitting. If it cannot adjust the objects, it disconnects them.

**Lengthen Grips**

You can modify the length of duct segments using Lengthen grips ( ). Because the grips constrain a segment to its current angle, they are particularly useful for modifying the lengths of ducts you have already placed.

When you use the Lengthen grip on an end connected to another object, you must specify whether you want AutoCAD MEP to maintain connectivity between the objects when you modify the length.

**Lengthen grips on duct segments**
The following example illustrates how to modify the length of a duct segment. The horizontal duct segment is stretched to the right and doubled in length. Because the modification occurs in the moveable MvParts editing mode, connected objects including parts are adjusted to maintain their connectivity. More specifically, the vertical duct segment and the ceiling diffuser attached to its right branch are moved.

**Lengthening a duct**

![Diagram](image)

- Select segment
- Select Lengthen grip, then select editing mode

---

**Lengthening a duct**

Duct Grips | 273
If the duct segment is not connected to another object, you can change both its length and angle using the Start or End grip.

The Start and End grips enable you to change the XYZ location of the start point or endpoint of the segment. This makes them particularly useful when initially designing runs because you can use them to easily connect a segment to an existing run.
Duct Elevation Lock

Locking elevation while drawing a duct run on page 292 avoids undesirable results in the design by restricting a duct run to a specific elevation. For example, you can avoid snapping to an object at a different elevation or trying to connect a horizontal run to a vertical segment.

You can turn on the elevation lock for a portion of a duct run, and turn it off for other portions where you want to use different elevations. If the lock is turned on, you cannot connect to an object on a different elevation. You must turn the elevation lock off before connecting the objects. By default, the lock is turned off each time you add duct.

RELATED For more information, see Using the Elevation Lock on page 309.

Duct Sizing Methods and Tools

Because AutoCAD MEP duct systems connect intelligently, the software can size duct systems automatically. A duct run is any ductwork connected to one or more outlet devices that have a defined outlet flow. Outlet devices, such as air diffusers, are considered the ends of the duct system. Each duct segment in the run can pass on the flow values for all outlet devices that are downstream from it. These flow values are used to calculate sizes for each duct segment in the run. This section describes the various duct sizing methods and tools in AutoCAD MEP.

NOTE Contact your local Autodesk reseller to use external analysis tools to size duct networks in AutoCAD MEP drawings.

Duct Sizing Methods

Duct sizes are calculated using either the equal friction method or constant velocity method. For more information, see Specifying a Calculation Method for Duct Sizing on page 289.

The calculations for duct friction losses are based on the Darcy and Altshul-Tsal equations described in the 2001 ASHRAE Fundamentals Handbook, Chapter 34, as follows:

- Duct friction loss for round, rectangular, and oval ducts is calculated using equation 19.
Duct friction factor for round, rectangular, and oval ducts is calculated using equation 21.

Reynolds Number is calculated using equation 23.

Equivalent round duct diameter for a rectangular duct is calculated using equation 25.

Equivalent round duct diameter for a flat oval duct is calculated using equations 26, 27, and 28.

To size friction for the rectangular or oval duct, the calculations use the equivalent round duct diameter and its velocity.

The dialogs for Add Ducts and Modify Duct list the actual velocity for the selected CFM and duct size, not the velocity used in the duct friction calculations. The actual velocity is displayed for duct fitting and acoustical analysis.

When a CFM is not displayed in the dialogs for Add Ducts or Modify Duct, the friction or velocity values shown are the values specified in the Design Parameters for the Duct System Definition. To specify design parameters for the Duct System Definition, see Specifying a Calculation Method for Duct Sizing on page 289.

The Add Ducts dialog shows an asterisk next to the Velocity field to indicate that the constant velocity method was used to calculate duct size.
The Modify Duct dialog shows the fixed parameter value for velocity that was used to calculate duct size.

Duct sizes are calculated based on the flow values assigned to all outlet devices detected in the system. For more information on assigning flow values, see Configuring Mechanical Parts for Analysis on page 291.

**Duct Sizing Tools**

The software includes 3 options for calculating duct sizes:

- The Duct System Size Calculator calculates sizes to convert 1-line duct systems to sized 2-line duct systems. It can also calculate sizes for duct systems with defined shapes.
- The Instant Sizing Calculator calculates sizes for individual duct segments.
- Third-party, external analysis tools work in conjunction with AutoCAD MEP to analyze duct systems.

You can use any of these sizing tools at any time. The duct system size calculator can be used for both preliminary designs and modifications. The instant sizing calculator is best suited for modifying discrete parts of the system.

**Duct Size Calculator**

You can use the duct size calculator to calculate duct sizes for both undefined 1-line or defined 2-line duct systems, for either entire or selected portions of the system. For 1-line, you can draw duct systems using 1-line duct objects that act as placeholders for sized duct objects.
NOTE Before calculating duct sizes, you must assign flow values to all outlet parts in the duct system. For more information, see Configuring Mechanical Parts for Analysis on page 291.

RELATED For more information, see Calculating Duct Sizes for a Duct System on page 302.

Instant Duct Sizing

If you have assigned flow values to outlet equipment, you can use the instant sizing tool to calculate sizes for ductwork as you draw duct runs. You can also use the instant sizing tool when modifying existing duct runs.

You can calculate duct sizes using either the equal friction method or the constant velocity method. To specify which duct sizing method to use, see Specifying a Calculation Method for Duct Sizing on page 289. The instant sizing tool calculates capacity by adding the flow values for all outlets detected in the duct run. If no flow values have been assigned to outlet devices, the capacity displayed is zero.

If you are drawing a duct segment connected to an outlet device with a specified flow capacity, the flow value is detected. If you are drawing a branch that is not yet connected to outlet devices, you can select outlet devices to be considered when calculating size. You can also manually enter a flow capacity to be used for size calculations.

The instant sizing tool detects flow capacity of outlet devices connected to the run.
When you execute the calculate size command, the instant sizing tool performs 2 calculations. First, it calculates the exact duct size based on the flow capacity value and a fixed parameter (either friction or velocity, depending on which calculation method is specified). The exact duct size is compared to available duct sizes in the catalog, and the next larger size from the catalog is selected. The velocity and friction values are then recalculated using the duct size selected from the catalog.

Configuring Duct System Settings

The topics in this section explain how to configure various duct settings. Because duct settings are stored with a drawing and can be shared among other drawings, configuring settings, such as duct layout preferences and system definitions, ahead of time helps you to build more accurate duct systems.

RELATED See HVAC System Settings on page 258.

Configuring Duct Layout Preferences

You can configure duct layout preferences to automate features, such as routing behavior settings, annotation settings, flexible duct settings, and connection settings, prior to drawing duct runs.

Configuring Justification for Duct Insertion

1. From the HVAC workspace, click Manage tab ➤ Preferences panel ➤ Duct .
2. In the Duct Layout Preferences dialog, click the Routing tab.
3. Specify the justification on page 160 settings for duct insertion:

<table>
<thead>
<tr>
<th>To…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>align the duct centerline</td>
<td>under Justification, specify Center for Horizontal and Vertical. Specify 0 for Offset.</td>
</tr>
<tr>
<td>along the points you specify for the duct run</td>
<td></td>
</tr>
<tr>
<td>align one side of the duct</td>
<td>under Justification, specify Left or Right for Horizontal, or Top or Bottom for Vertical. Use</td>
</tr>
<tr>
<td>along the points you specify for the duct run</td>
<td></td>
</tr>
</tbody>
</table>
To… then…

a combination of the 2 to align 2 sides along the insertion points.

offset the duct by a uniform distance from the points you specify for the duct run

enter a distance for Offset.

---

RELATED For more information, see Justification of Objects on page 160.

### Configuring Sloped Duct

1. In the HVAC workspace, click Manage tab ➤ Preferences panel ➤ Duct.
2. In the Duct Layout Preferences dialog, click the Routing tab.
3. Specify the vertical slope:

<table>
<thead>
<tr>
<th>To…</th>
<th>then…</th>
</tr>
</thead>
</table>
| specify an angle | ■ Under Duct Layout Rise/Run, select Angle.  
                   ■ Enter an angle value for Rise/Run, and for Increment.  
                   The rise/run value is displayed in the Add Ducts dialog on page 292. You can increase or decrease the angle by the increment value. |
| specify a fraction | ■ Under Duct Layout Rise/Run, select Fraction.  
                   ■ Enter a fractional value for Rise/Run.  
                   The Increment field is inactive. The fractional rise/run value is displayed in the Add Ducts dialog on page 292. You can enter a new value. |

RELATED For more information, see Drawing Sloped Duct on page 308.
Breaking Duct at Even Intervals During Layout

You can automatically break duct segments during layout. For example, if a duct system is going to be fabricated from straight ducts that are 10 feet long, you can configure duct layout preferences so that straight runs are automatically broken into 10-foot intervals as you draw them. Joints are automatically added at the break interval. When turned on, the automatic break length setting is applied to all duct system definitions. The automatic break length is applied to supply air, return air, or any other defined duct system in the drawing. If you want to use different break lengths when drawing different systems, you can also change the break length prior to working with each system.

1 In the HVAC workspace, click Manage tab ➤ Preferences panel ➤ Duct.

2 In the Duct Layout Preferences dialog, click the Routing tab.

3 Under During Layout, select Duct Length.

4 Specify the duct segment length.
Configuring the Display of Turning Vanes and Flanges

1. In the HVAC workspace, click Manage tab ➤ Preferences panel ➤ Duct.
2. In the Duct Layout Preferences dialog, click the Vanes and Flanges tab.
3. Select Enable Vanes to display turning vanes on fittings in 2-Line and Plan display representations.
   If you apply vanes to a single fitting, they are automatically applied to all fittings of the same subtype and size.

   **TIP** If you clear Enable Vanes to disable vanes for selected fittings, you can still apply vanes to fittings. However, you must repeat for one fitting at a time, not for all fittings of the same subtype and size. For more information, see Adding Turning Vanes to Fittings on page 314.

   **NOTE** The visibility and display properties of turning vanes are determined by the Annotation display component.

4. To show flanges on ducts and fittings in Plan or Model display representations
   Select Enable Flange Connector Graphics.
5. For each duct shape (round, rectangular, and oval), enter values for the flange size and flange thickness.
   These entries are displayed on the Extended tab of the Properties palette as property set data. To hide this information, clear Enable Flange Connector Graphics.

6. To modify values for one or more selected ducts or fittings
   Select on ore more ducts or fittings, and click Home tab ➤ Build panel ➤ Tools drop-down ➤ Properties.
8. For Flange dimensions, enter values for Connector 1 and Connector 2.
   Changing the values to 0 for a connector causes the flange not to display once you regenerate the model.
### Configuring Flexible Duct Preferences

1. In the **HVAC workspace**, click Manage tab ➤ Preferences panel ➤ Duct ➤ Duct.

2. In the Duct Layout Preferences dialog, click the Flex Ducts tab.

3. For Segment Mode, specify the default layout method for flex duct:

<table>
<thead>
<tr>
<th>To…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>lay out the flex duct as a series of straight line segments</td>
<td>select (Line) for Segment Mode. Specify a value for Radius of Curvature. Any angled transitions in the flex duct segment use this radius value.</td>
</tr>
<tr>
<td>lay out the flex duct as a series of arcs</td>
<td>select (Arc) for Segment Mode.</td>
</tr>
<tr>
<td>lay out the flex duct as a complex curve by specifying points for a spline</td>
<td>select (Spline) for Segment Mode.</td>
</tr>
</tbody>
</table>

4. Under 1 Line Annotation, for Graphics, select an annotation pattern.
   This pattern is applied to flexible duct runs after you draw them, and it is visible for flexible duct systems displayed as 1-line.

5. Under 1 Line Annotation, for Pitch, specify a value.
   This specifies the interval between the pattern, and it is based on the drawing scale.

6. Repeat the previous steps for 2 Line Annotation.
   This pattern is visible for flexible duct systems displayed as 2-line.
Configuring Duct Part Preferences

You can specify preferences for parts and fittings that are automatically inserted into a duct run.

1. In the HVAC workspace, click Manage tab ➤ Preferences panel ➤ Duct.
2. In the Duct Layout Preferences dialog, click the Parts tab.
3. For Part Group Definition, select the definition to modify.
4. For Connection Type, select a connection type.
The tree structure updates to display only those parts available for the selected connection type.

5 For each part type, select a default part.

Configuring Duct Connections

You can specify whether to use a tee or takeoff when connecting a new run along an existing duct segment. You can also specify how to connect duct branches to air terminals.

1 In the HVAC workspace, click Manage tab ➤ Preferences panel ➤ Duct ➤ .

2 In the Duct Layout Preferences dialog, click the Connections tab.

3 For Connection Style, verify that HVAC Connector Style is specified.

4 Under Connect with Duct, select Use Takeoff or Use Tee.

5 For Terminal-Duct Connection, specify how to connect duct to air terminals.

When selecting a connection option, a preview displays.
Applying Insulation or Lining on Duct

You can apply insulation or lining to duct segments. Insulation and lining are annotation elements that display as hidden lines and are only visible when the duct is viewed as 2-line.

**RELATED** To manually add, remove, or modify insulation or lining on duct components, see Changing Insulation or Lining on a Duct or Fitting on page 360.

1. In **the HVAC workspace**, click **Manage tab ➤ Preferences** panel ➤ Duct ➤.
2. In the Duct Layout Preferences dialog, click the Ducts tab.
3. Under Lining and Insulation, select Apply Insulation or Apply Lining, or both, to turn this feature on.
4. Enter a value for Thickness.

Applying Label or Flow Arrow Styles to Ducts

Use this procedure to apply label or flow arrow styles to new duct runs, as shown next.

**Size labels and flow arrows in a duct run**

1. In **the HVAC workspace**, click **Manage tab ➤ Preferences** panel ➤ Duct ➤.
2. In the Duct Layout Preferences dialog, click the Ducts tab.
3 To specify 1 label or flow arrow style for a duct run, under Labels and Flow Arrows, select the first Apply Labels/Flow Arrows.

4 For Style, select a label or flow arrow style from the adjacent drop-down list.

**RELATED** For more information, see Label Style Properties on page 826.

5 Under Layout Method, specify how many labels or flow arrows to add to each straight segment of the duct run:

<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the total number of labels or flow arrows to display on each straight segment of the duct run</td>
<td>select Space Evenly, and enter a value for Number of Labels. Note that the number of labels or flow arrows is automatically added to each straight segment.</td>
</tr>
</tbody>
</table>

| Insert a label or flow arrow at a uniform interval on each straight segment of the duct run | select Repeat Every, and enter a value for Distance. Note that if a segment length is less than the interval distance, a label or flow arrow is not automatically added to that segment. |

**Flow Arrows Spaced Evenly, 1 per segment**

**Flow Arrows Repeated at a Uniform Interval**

6 To specify a second set of styles, select the second Apply Labels/Flow Arrows, and follow the previous steps to define the type and placement.
NOTE To turn off the automatic insertion of labels or flow arrows, in the Duct Preferences dialog, click the Ducts tab, and under Labels and Flow Arrows, deselect one or both Apply Labels/Flow Arrows.

Configuring Duct System Definitions

You can configure duct system definitions to specify duct display information and duct size calculation parameters.

RELATED See Duct System Definitions on page 258.

Creating a Duct System Definition

1 In the HVAC workspace, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ HVAC System Definitions .

2 Create the duct system definition:

<table>
<thead>
<tr>
<th>To…</th>
<th>then in the left pane of Style Manager…</th>
</tr>
</thead>
<tbody>
<tr>
<td>create a new, blank system definition</td>
<td>right-click Duct System Definitions, and click New. Enter a name.</td>
</tr>
<tr>
<td>copy an existing definition, so you can modify the copy</td>
<td>do the following:</td>
</tr>
<tr>
<td></td>
<td>■ Right-click the system definition you want to copy, and click Copy.</td>
</tr>
<tr>
<td></td>
<td>■ Right-click Duct System Definitions, and click Paste.</td>
</tr>
<tr>
<td></td>
<td>■ Right-click the copy, click Rename, enter a new name.</td>
</tr>
</tbody>
</table>

3 On the General tab, enter a description.

4 Specify values for other general properties common to systems in all engineering disciplines. For more information, see Creating Systems on page 141.

5 Specify a calculation method for duct sizing on page 289.
Specifying a Calculation Method for Duct Sizing

1. In the HVAC workspace, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ HVAC System Definitions.

2. On the Style Manager, select a duct system under Duct System Definitions.

3. In the right pane of Style Manager, select the Design Parameters tab.

4. Specify which method to use to calculate duct sizes:
   
<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>use the constant velocity method</td>
<td>select Velocity, and enter a value.</td>
</tr>
<tr>
<td>use the equal friction method</td>
<td>select Friction, and enter a value.</td>
</tr>
</tbody>
</table>

   **NOTE** The Add Duct dialog displays the fixed parameter value with an asterisk (*). The fixed parameter value initially calculates the exact duct size, and is then used to specify an available size in the catalog. Once you calculate duct size, the fixed parameter value in the Add or Modify dialogs might differ from what is specified in Design Parameters. See Duct Sizing Methods and Tools on page 275 for more information.

5. Specify a value for Roughness (roughness value of the ductwork material).

6. Specify a value for Density (medium used in the system, for example — air).
The initial, default value is the density of air at sea level at 68 degrees F (20 degrees C).

Continue specifying the design parameters for other duct systems, and click OK.

Creating a Duct System

After you configure duct settings, you can add HVAC equipment and duct segments to a duct systems in a drawing. One way to add parts and duct runs is with the HVAC tool palettes set. A quicker approach is to use duct grips on page 264 to add to duct runs directly from an object. You can also insert an architectural floor plan as a reference, and design duct systems around that floor plan.

The topics in this section offer specific instructions to create duct systems.

Adding HVAC Equipment

You can place MvParts on page 110 as standalone objects or connect them to duct runs in a drawing. You can also add an in-line or anchored MvPart to a duct.

Placing a Duct MvPart in a Drawing

1 In the HVAC workspace, click Home tab ➤ Build panel ➤ Equipment drop-down, and select an equipment on page 110 from the list.

   The Add MvParts dialog displays the current part catalog at the folder location associated with the tool you selected.

2 On the Part tab, select a part subtype in the folder.

3 Click Details to view available sizes.

4 Select Display/Hide additional parameters to expand the contents of the parameters table.

5 Click the Part Filter tab, and enter the desired criteria under Filter by Dimensions.

   TIP The part catalogs and content locations on page 100 determine the parts that you can add. If the part is unavailable, you can create a custom part using Content Builder on page 964.
6 Select a part for Part Size Name.
7 Specify a value for Elevation.
8 If you can assign airflow values to the part, click the Flow tab. For outlet devices, enter the airflow value for Flow. For supply devices, enter an airflow value for each connector.
9 Specify an insertion point in the drawing, and use the compass to specify a rotation angle.
10 Press ENTER to end the command.

Adding Parts In-Line to Ducts

1 Select an MvPart on page 110 to add as explained in Placing a Duct MvPart in a Drawing on page 290.
2 To place the part on a duct, move the cursor to a duct segment to display a duct end or duct curve connector.
3 Click the duct connector to place the part in-line to the duct or anchored to a duct end, and use the compass to specify a rotation angle.
4 Press ENTER to end the command.

Once the part is inserted, you can use grips to rotate the part around the centerline of the duct segment. You can also flip an in-line part such as a fan to orient the part in the proper flow direction. For more information, see Rotating Duct Components on page 345.

Configuring Mechanical Parts for Analysis

You can assign air flow values to duct system equipment, such as air terminals. The duct system can be analyzed, and sizes can be calculated using these values.

1 Select on page 157 the part.
2 Click Equipment tab ➤ Modify panel ➤ Equipment Properties.
3 In the Multi-view Part Properties dialog, click the Flow tab and specify the airflow values:

<table>
<thead>
<tr>
<th>To…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify an air flow value for an outlet device, such as a ceiling diffuser</td>
<td>enter the value for Flow.</td>
</tr>
<tr>
<td>specify an air flow value for a supply device, such as a VAV box</td>
<td>specify an air flow value for each connector.</td>
</tr>
</tbody>
</table>

Adding Duct

You can draw duct runs anywhere on a floor plan. All ducts and fittings include connectors for connecting directly to other duct objects and MvParts. You can also use analysis tools that work with drawings to analyze and calculate sizes for systems or individual segments.

Prior to drawing duct systems, if necessary, review duct preferences and system definitions. See Configuring Duct System Settings on page 279.

Drawing a Duct Run

1 In the HVAC workspace, open the Add Ducts dialog in one of the following ways:

- Click Home tab ➤ Build panel ➤ Duct drop-down ➤ Duct.
- Open the Duct tool palette, and select a duct tool.

**NOTE** When beginning a design by defining the duct runs according to system on page 138, select a duct tool with a specific, predefined system, such as the Supply - Low Pressure tool. The duct that you draw inherits the system’s properties, such as its design parameters, display properties, and rise and drop style.

- Click the Add grip on a part, duct fitting, or duct segment.

2 In the Add Ducts dialog, specify a system.
3 Specify a coordinate system and value for Elevation:

<table>
<thead>
<tr>
<th>To…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>draw a run at a defined elevation</td>
<td>select an elevation name for Elevation.</td>
</tr>
<tr>
<td>draw a run at a specified elevation relative to a wall or other duct or duct</td>
<td>enter the desired elevation, specify justification and offset, and use AutoCAD snaps or AutoCAD MEP snaps to specify points on the wall, duct, or other objects.</td>
</tr>
<tr>
<td>start a branch at a specified elevation on a riser</td>
<td>enter the desired elevation and use AutoCAD MEP snaps to specify a point on the riser.</td>
</tr>
<tr>
<td>start a branch from a vertical run with a riser at a specified elevation</td>
<td>enter the desired elevation and use AutoCAD MEP snaps to specify a point on the vertical run.</td>
</tr>
<tr>
<td>extend a sloped duct or duct segment to a specified elevation</td>
<td>enter the desired elevation, click Use Rise/Run, and use AutoCAD MEP snaps to specify the endpoint of a sloped duct or duct.</td>
</tr>
</tbody>
</table>

**RELATED** For more information on displaying objects at different elevations, see Display of Objects Based on Elevation on page 223.

If you lock the elevation, the elevation from the objects that you connect to is not inherited.

4 You can specify the offset in 2 directions:

<table>
<thead>
<tr>
<th>To specify…</th>
<th>select…</th>
</tr>
</thead>
<tbody>
<tr>
<td>the horizontal offset</td>
<td>Left, Right, or Center. Enter the horizontal distance of the run from the wall or other objects.</td>
</tr>
<tr>
<td>the vertical offset</td>
<td>Top, Center, or Bottom. Enter the vertical distance of the run from the ceiling or other objects.</td>
</tr>
</tbody>
</table>
5 Specify connection type, duct shape, and duct size. To calculate duct size using the **instant sizing tool**:

<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>calculate size for round duct</td>
<td>accept the detected value for Capacity, or enter a value for Capacity. Click</td>
</tr>
<tr>
<td>calculate size for oval or rectangular duct based on a fixed height</td>
<td>accept the detected value for Capacity, or enter a value for Capacity. Specify a size for Height, and click for Width. You can change the height and recalculate the width repeatedly until you achieve a desirable duct size.</td>
</tr>
<tr>
<td>calculate size for oval or rectangular duct based on a fixed width</td>
<td>accept the detected value for Capacity, or enter a value for Capacity. Specify a size for Width, and click for Height. You can change the width and recalculate the height repeatedly until you achieve a desirable duct size.</td>
</tr>
<tr>
<td>calculate duct size using a single outlet flow device that is not yet connected to the duct</td>
<td>click and select a single outlet device. The flow value of the outlet device is specified for Capacity. Click</td>
</tr>
<tr>
<td>calculate duct size by using multiple outlet flow devices that are not yet connected to the duct</td>
<td>click and select multiple outlet devices. The Capacity value is increased by the combined flow values of the selected devices. Click</td>
</tr>
</tbody>
</table>

For more information, see [Specifying a Calculation Method for Duct Sizing](#) on page 289.

6 You can select Use Rise/Run and enter a value in degrees to continue drawing the duct at an upward or downward angle.
7 Click Use Routing, and select a routing method:

<table>
<thead>
<tr>
<th>To…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>draw with a predefined elbow angle</td>
<td>select an elbow angle.</td>
</tr>
<tr>
<td>define your own elbow angle in the drawing area</td>
<td>select User Defined, and specify a point for the elbow angle. You can draw either with or without the Compass.</td>
</tr>
<tr>
<td>define your own elbow angle in the dialog</td>
<td>enter a value for the elbow angle.</td>
</tr>
<tr>
<td>update the Elbow Angle options to select elbow angles from the catalog</td>
<td>select Show Catalog for Elbow Angle. To optimize drawing performance, elbow angles from the catalog are hidden by default.</td>
</tr>
<tr>
<td>hide the Elbow Angle options from the catalog in order to increase drawing performance</td>
<td>select Hide Catalog.</td>
</tr>
<tr>
<td>draw with only the selected elbow angle</td>
<td>click the Lock icon next to Elbow Angle. The next segments you draw will have the same elbow angle.</td>
</tr>
<tr>
<td>draw with both an elbow angle and a rise or drop to a specific elevation</td>
<td>click the Preferences icon, and then click the Routing tab. Deselect Automatically create riser at new Elevation, and then click OK. Enter an elevation and draw the segment with an elbow angle.</td>
</tr>
<tr>
<td>save drawing performance and not display the elbow as you draw with a specified elbow angle</td>
<td>click the Preferences icon, and then click the Routing tab. Deselect Preview Elbow when Compass is Enabled or Preview Elbow when Compass is Disabled.</td>
</tr>
<tr>
<td>specify the predefined elbow angles displayed in the Elbow Angle list</td>
<td>click the Preferences icon, and then click the Routing tab. Enter or delete</td>
</tr>
</tbody>
</table>
To... then...

elbow angles in the Predefined Elbows Angles list.

NOTE The selection of elbow angles does not apply to the first segment that you draw.

8 Specify a start point, and then continue to specify points to add more segments to your run.
   Connection fittings are inserted to connect each segment as you draw.

9 Change the elevation as needed, and continue to specify points to add more segments to your run.
   Vertical segments are added by default.

Starting a Run From Existing Duct

Using AutoCAD MEP snaps, you can automatically connect a new run anywhere along an existing duct segment or fitting. The fittings that are automatically inserted between the existing duct and the new duct are configured in the routing preference and duct layout preference.

1 Open and configure the Add Ducts dialog, as explained in Drawing a Duct Run on page 292.

Starting a run from a duct end

2 Move the cursor over the end of the existing duct segment to display the duct end connector snap.

3 Click the duct end connector to specify the start point of the new run.
   The size and system for the new run match the existing duct.

4 In the Add Ducts dialog, specify a routing preference for Routing Preference.

5 To use a different size for the new run, specify a new size.
   If you use a different size for the new run, a transition fitting is inserted to connect the new duct to the existing duct. If the duct layout preference is not configured with an appropriate transition fitting, you are prompted to choose a part.
6 To use a different shape for the new run, specify a new shape for Shape.
   If the duct layout preference is not configured with an appropriate transition fitting, you are prompted to choose a part.

7 Continue specifying points to lay out the run.

Starting a run at a point along a duct segment

8 Move the cursor over the existing duct segment to display the duct curve connector snap.

9 Click the duct curve connector to specify the start point for the new run.
   Based on the connection type configured in the duct layout preference, a takeoff or tee is inserted.

10 Continue specifying points to lay out the run.

Ending a Run on an Existing Duct

11 To connect a run to an existing segment, move the cursor over the existing duct segment to display the duct curve connector or duct end connector.

12 Click the duct curve or duct end connector to specify the endpoint of the run and connect to the existing segment.

Connecting a Duct Run to Equipment

When you start or end a run at a piece of equipment (MvPart), the start point or endpoint snaps to the nearest connection point on the MvPart on page 110. Simple MvParts, such as terminals, fans, and humidifiers, contain only one connection point. However, many of the more complex types of MvParts, such as tanks and pumps, contain multiple connection points. Some MvParts even have connection points that belong to different domains, such as a furnace that has both duct and pipe connection points.

NOTE This procedure assumes that you have placed equipment in your drawing. For more information, see Placing a Duct MvPart in a Drawing on page 290.

To connect a duct run to equipment

1 In the HVAC workspace, choose an action below:
   ■ Click Home tab ➤ Build panel ➤ Duct drop-down ➤ Duct.
Open the Duct tool palette, and select a duct tool.

If you select a duct tool with a specific, predefined system (for example, the Supply - Low Pressure tool), the duct that you draw inherits the system’s properties, such as its design parameters, display properties, and rise and drop style.

2 With AutoCAD MEP snaps enabled, select a starting point for the segment at the connector of an MvPart, and continue selecting points to draft the run as necessary.

   The default run direction of the duct is dependent on the connector assigned to the MvPart. Typically, the run direction is perpendicular to the connector face of the MvPart.

   The type of connector assigned to the MvPart and the connector rules specified in the drawing determine the type of segment that can be connected to the MvPart.

3 Press ENTER to end the command.

## Adding Duct Using Grips

1 Select an object in the drawing, and choose an action below:

<table>
<thead>
<tr>
<th>To…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>start a run from one of the ends of a duct segment</td>
<td>click the add grips on page 264 at one end of the segment.</td>
</tr>
<tr>
<td>start a run from the midpoint of a duct segment</td>
<td>click the add grip at the midpoint of the segment. A tee or takeoff is automatically inserted, depending on the connection specified for duct layout preferences.</td>
</tr>
<tr>
<td>start a run from an MvPart</td>
<td>click the add grip on the MvPart connection.</td>
</tr>
<tr>
<td>start a run from a fitting, such as an elbow or tee</td>
<td>click the add grip pointing in the direction of where you want to start the new run.</td>
</tr>
</tbody>
</table>

2 In the Add Ducts dialog:

   If you start from an MvPart, specify a system type for System.
If you start from a duct segment or fitting, the new run inherits the system.

If you change the size before specifying the first segment of the new run, a transition is automatically inserted between the object and new duct segment after you specify the first point of the new run.

If the appropriate transition is not configured in the routing preference, you are prompted to choose a part.

3 Continue specifying points for the duct run layout geometry.

**Drawing a Vertical Duct Run**

1 Add duct, and begin laying out the duct run, as explained in [Drawing a Duct Run](#) on page 292.

2 Specify the point in the layout where you want to start the vertical segment.

3 In the Add Ducts dialog, specify the elevation of the endpoint of the vertical segment.

4 Continuing specifying points for the duct run geometry.

**Drawing 1-Line Duct**

You can draw 1-line duct systems to configure preliminary routes and connect mechanical equipment placed in the drawing. 1-line ducts are added as undefined duct components and displayed as a single line. They act as placeholders for the eventual defined duct components.

1 Choose an action below:

<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>draw duct directly from</td>
<td>select the MvPart and click the Add grip on an MvPart</td>
</tr>
<tr>
<td>an MvPart</td>
<td>page 264 for the connection where you want to draw.</td>
</tr>
</tbody>
</table>
To... then...

draw duct from any point select the 1-Line tool on the Duct tool palette in the HVAC tool palette group.

RELATED For more information, see Drawing a Duct Run on page 292.

2 In the Add Ducts dialog, verify that Connection Type and Shape are set to Undefined.

3 Specify a type for System.

4 Specify a defined elevation for Elevation, or enter a height value for Elevation. If you are drawing from an Add grip on page 264 on an MvPart, the duct automatically assumes the elevation from the MvPart.

5 Specify points to place the duct run.

NOTE You can use AutoCAD MEP snaps and tracking lines to align duct geometry with other objects and to maintain connectivity between objects in the system.

When connecting to a part, especially at a different elevation than the duct run, more than one routing option may be offered. Use 2 viewports to get an accurate preview of each routing option.
For example, the Aecb Model drawing template includes a Work layout tab where the workspace is configured for 2 viewports.

**Using 2 viewports to preview routing options**

6 Click New Run in the Add Duct dialog. You can use AutoCAD MEP snaps to draw new branches on duct segments. You can also use Add grip on page 264 on MvParts, ducts, and duct fittings to create new runs.

7 To insert 1-line duct fittings, use the 1-Line tool on the Fitting tool palette, and complete the 1-line layout for the system.

Top view of a simple 1-line system: A VAV box is connected to 4 air diffusers.

8 To check connectivity in the system, select any part of the system, right-click, and click Connected Objects ➤ Show Connected Run. If any part of the system is not connected, duct size tools will either not work or will provide inaccurate results.

To move parts of a system, use location grips on page 342 on ducts, duct fittings, and MvParts to move parts of a system.
You can also use the duct system size calculator on page 302 to convert 1-line systems to sized 2-line systems.

### Calculating Duct Sizes for a Duct System

1. Select any object in a connected system.
   - An example of a 1-line system.

2. Click Duct Flex tab or Duct tab ➤ Calculations panel ➤ Calculate Duct Sizes  
3. In the **Duct Size Calculator** on page 277, specify which ducts to size:

<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>size all objects in a system</td>
<td>select Calculate complete system.</td>
</tr>
<tr>
<td>size selected objects</td>
<td>select Calculate selected objects, click , and select the objects you want to size. Press enter.</td>
</tr>
</tbody>
</table>

4. Specify the shape for the sized ducts:

<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify the same shape for all parts</td>
<td>select All and specify a shape.</td>
</tr>
</tbody>
</table>

---

302 | Chapter 6  Drawing HVAC Systems
To... then...

specify different shapes for the trunk and runouts
select Individual. Specify a shape for Trunk and for Runouts. Note that there must be a fan at the start of the system to use the Inherit from Fan shape for Trunk.

specify the runouts to use the same shape and size as the air terminal connection
select Use shape and size from air terminals on runouts. Note that this deactivates Runout shape if you are specifying individual shapes for the trunk and runouts.

NOTE If you are sizing ducts with defined shapes, you cannot change their shape. You can calculate sizes, but you cannot override the shapes already assigned to the ducts.

5 Specify design parameters to apply to this calculation:

To... then...

use different parameters than those specified in the HVAC System Definitions style
select Override design parameters from system definition(s). Select the parameter (Velocity or Friction) to change, and enter a new value. These values are only used for this specific calculation. The system definition values remain the same, and are used on all subsequent calculations.

specify a maximum diameter for round ducts
select Round max. size and enter a value. If a duct must be larger than this diameter to meet flow requirements, specify Rectangular or Oval for For larger size. The height of the rectangular or oval duct will not exceed the maximum round size.

specify a maximum height for rectangular or oval ducts
select Rectangular/Oval Max. Height and enter a value.

specify which duct sizes to use from the duct catalog
select All, 1 inch increment, or Even sizes only.
To... then...

apply duct size calculations to any objects in the system that already have a defined shape

select Apply sizing to parts with defined shape.

6 Click Start.
7 When the calculations are complete, the system is resized in the drawing.

Example drawing converted to a sized 2-line duct system

If any errors occurred during calculations, click View Event Log for a description of the error.

**NOTE** Duct segments are not broken into multiple segments. The calculated duct size is applied to the entire duct segment. For example, you may want to reduce the duct size at all points where the system services 2 air diffusers. To refine your system, you can break a duct into segments and recalculate sizes. For more information, see [Breaking or Merging Duct Segments](#) on page 352.

**Adding a Duct Fitting Manually**

AutoCAD MEP adds fittings as you draw a duct run based on default fittings in the duct layout preferences, or you can manually add a fitting to an existing
segment or duct run. You can also add a fitting where you want to start a segment or run or customize the connection to a part.

1 In the HVAC workspace, choose an action below:
   ■ Click Home tab ➤ Build panel ➤ Duct Fitting drop-down ➤ Duct Fitting .
   ■ Open the Fitting tool palette, and select a fitting tool.

   The Add Duct Fittings dialog displays the current part catalog at the folder location associated with the tool you selected.

2 On the Part tab, select a part subtype in the folder.
3 Click Details to view available sizes.
4 Select Display/Hide additional parameters to expand the contents of the parameters table.
5 Click the Part Filter tab, and enter the desired criteria under Filter by Dimensions.

   TIP The part catalogs and content locations on page 100 determine the parts that you can add. If the part is unavailable, you can create a custom part using Content Builder on page 964.

6 Select a part for Part Size Name.
7 Select a defined elevation or enter a value for Elevation.

   NOTE The elevation is applicable when you are connecting the fitting to a vertical or riser segment. If you are connecting the fitting to a horizontal segment, you do not enter an elevation. The software places the fitting at the same elevation as the segment to which it is connected.

8 Specify an insertion point in the drawing. You can connect the fitting to a segment or insert it as a stand-alone object.
9 Use the compass to specify a rotation angle.
10 Press ENTER to end the command.

   NOTE You can apply turning vanes to duct fittings to reduce pressure loss. In plan view, turning vanes are displayed on fittings as annotation. For more information, see Adding Turning Vanes to Fittings on page 314.
Drawing Flexible Duct

1 In the HVAC workspace, choose an action below:
   ■ Click Home tab ➤ Build panel ➤ Duct drop-down ➤ Flex Duct.
   ■ Open the Duct tool palette, and select the Flex Duct tool.
   ■ Press Ctrl and click the Add grip on a MvPart, or duct segment.

2 In the Add Flex Duct dialog, for Segment Mode, click Line, Arc, or Spline.

   RELATED See Draw Splines.

3 Specify a system and an elevation.

4 If you are using the line segment mode, specify the offset as follows:

<table>
<thead>
<tr>
<th>To specify...</th>
<th>then select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the horizontal offset</td>
<td>Left, Right, or Center. Enter the distance of the run from the wall or other horizontal object.</td>
</tr>
<tr>
<td>the vertical offset</td>
<td>Top, Center, or Bottom. Enter the distance of the run from the ceiling or other vertical object.</td>
</tr>
</tbody>
</table>

5 Specify the connection type and diameter.

6 Specify a start point.
   If using the Spline segment mode, specify a start tangent point or press ENTER for none.

7 Continue to specify points to add more segments to the run.
   To switch between segment modes during layout, enter l (line), a (arc), or sp (spline).
   Line and arc segments are joined together to create a single segment in the run. Spline segments remain separate segments in the run.
   To switch between planes during layout, enter p (plane) to toggle between the X, Y, and Z axes.
8 Press ENTER to end the command.
If drafting a spline segment, specify an end tangent point or press ENTER for none. The flexible run is displayed.
If drafting a line or arc segment, press ENTER or click Close. The flexible run is displayed.

**NOTE** To draft multiple flexible runs, click New Run to end the current run and start drafting a new run without ending the command.

**RELATED** To configure the display properties of flexible duct, see Flexible Duct Runs on page 260.

---

**Adding a Parallel Duct Run**

1 Add duct, and begin laying out the duct run, as explained in Drawing a Duct Run on page 292.

2 In the Add Ducts dialog, specify the offset:

<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>offset the new run at a horizontal distance (X or Y direction) from the existing run; both runs are at the same elevation</td>
<td>for Horizontal, specify a value for Offset. To offset the new run in a positive X or Y direction from the existing run, enter a positive value. To offset in a negative X or Y direction, enter a negative value.</td>
</tr>
<tr>
<td>offset the new run at a vertical distance from the existing run; both runs have the same X-Y dimensions, but are at different elevations</td>
<td>for Vertical, specify a value for Offset. To offset the new run in a positive Z direction from the existing run, enter a positive value. To offset in a negative Z direction, enter a negative value.</td>
</tr>
</tbody>
</table>

3 In the drawing, select a point on the existing duct run.
You can use AutoCAD MEP snaps to select duct connectors, or object snaps to select points on duct geometry.

4 Continue selecting points along the duct run.
**NOTE** Drawing a parallel duct run may be easier if you use a 1-line display for the existing duct run. This reduces the potential number of points to pick, and allows you to accurately select transition points. To view a duct system as 1-line, change the current display configuration. The Mechanical - Duct 1-line display configuration included with the default Aecb Model drawing template is configured to show duct segments and fittings as 1-line.

**Offsetting Duct from Existing Geometry**

You can draw a duct run that is offset at a specified distance from existing geometry, such as from a wall in a referenced drawing. The geometry can be AutoCAD lines or blocks, AutoCAD Architecture building objects, or AutoCAD MEP objects, and the geometry can exist in a reference drawing. You can select points on the geometry using AutoCAD MEP snaps.

1. Add duct, and begin layout a duct run as explained in Drawing a Duct Run on page 292.

2. In the Add Ducts dialog, specify the offset:

<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>offset the new run at a horizontal distance (X or Y direction) from the geometry; the geometry and duct run are at the same elevation</td>
<td>for Horizontal, specify a value for Offset. To offset the new run in a positive X or Y direction from the existing geometry, enter a positive value. To offset in a negative X or Y direction, enter a negative value.</td>
</tr>
</tbody>
</table>

   | offset the new run at a vertical distance from the geometry; both have the same X-Y dimensions, but are at different elevations | for Vertical, specify a value for Offset. To offset the new run in a positive Z direction from the geometry, enter a positive value. To offset in a negative Z direction, enter a negative value. |

3. In the drawing, select a point on the geometry, using object or AutoCAD MEP snaps.

4. Continue selecting points along the geometry.

**Drawing Sloped Duct**

1. Add duct, and lay out the duct run, as explained in Drawing a Duct Run on page 292.
2 Specify the point in the layout where you want to draw a duct run with a vertical slope.

**RELATED** For information on specifying the slope, see Configuring Sloped Duct on page 280.

3 In the Add Ducts dialog, under Layout Method, select Use Rise/Run.

4 Specify the end point for the sloped segment.

5 To turn off sloped layout and return to horizontal runs, under Layout Method, select Use Routing.

6 Continuing specifying points for the duct run geometry.
   If you add a vertical segment at the end of a sloped segment, you may be prompted to choose a part on page 447. If a fitting with the proper angle does not exist, you can accept the creation of a custom transition.

### Using the Elevation Lock

By default, the elevation lock is turned off each time you add duct.

1 Add duct, and lay out the duct run, as explained in Drawing a Duct Run on page 292.

2 In the Add Ducts dialog, next to the elevation value, click the unlock button.

3 Specify points for the duct run.

**TIP** To connect a horizontal duct to a vertical duct, move the cursor over the vertical segment to get a duct curve connector, and click on it. If you have difficulty achieving the desired connection, try using a different view, such as a side or isometric view, when connecting the horizontal duct run to the vertical segment.

4 To turn off the elevation lock, click the lock button.

**RELATED** For more information, see Duct Elevation Lock on page 275.
Connecting Ducts Through Referenced Drawings

Use this procedure to connect duct systems in one drawing with duct systems in referenced drawings.

**NOTE** For more information, see Multi-Floor Duct Systems in Referenced Drawings on page 262.

1. Verify that the xref containing the duct system is loaded in the drawing and that the referenced drawing itself is not open.
2. Draw a duct run to connect your duct system with the duct system in the reference drawing.
3. Use the lock elevation icon on page 309 in the Add Duct dialog to connect the duct run to the reference object at the same elevation as the duct run.
   If you do not lock the elevation, the duct run is likely to connect to a duct end connector on the reference object.

**TIP** Use 2 viewports to get an accurate preview of the routing and connection point with the reference duct.

4. Click Yes when prompted by the Save to Xref dialog.

**NOTE** The changes are permanently saved to the duct in the referenced drawing.

Adding a Takeoff to a Duct

1. In the HVAC workspace, open the Fitting tool palette, and select the Takeoff tool.
   The Add Duct Fittings dialog displays the current part catalog at the folder location associated with the tool you selected.
2. Select the takeoff fitting to add.
3. Select a size for Part Size Name.
4. In the drawing, specify a location along the length of the duct segment to place the takeoff.
5. To add an off-center takeoff, skip to Step 10.
6 Specify the placement preferences:

<table>
<thead>
<tr>
<th>To…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>toggle the compass on or off as you position the takeoff</td>
<td>right-click in the drawing area, and click Compass.</td>
</tr>
<tr>
<td>change the location of the takeoff along the length of the duct segment</td>
<td>right-click in the drawing area, and click Slide. Drag the fitting along the duct segment, and select a new location.</td>
</tr>
</tbody>
</table>

7 Specify the rotation angle:

<table>
<thead>
<tr>
<th>To specify the…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>rotation angle on the Y axis</td>
<td>right-click, and click rotate Y. Drag the takeoff around the Y axis, and select a position. You can also enter a number for the angle.</td>
</tr>
<tr>
<td>rotation angle on the Z axis</td>
<td>right-click, and click rotate Z. Drag the takeoff around the Z axis and select a position. You can also enter a number for the angle.</td>
</tr>
<tr>
<td>rotation axis on the command line</td>
<td>enter Y for rotate Y, or enter Z for rotate Z.</td>
</tr>
</tbody>
</table>

8 Press ENTER to end the command.

9 To add an off-center takeoff after you specify the location on the duct, right-click in the drawing area, and click Offcenter.

The Off Center tab is displayed in the Add Duct Fittings dialog, and Enable off center placing is selected.

10 Specify the position of the takeoff:

<table>
<thead>
<tr>
<th>To specify the…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>side of the duct segment to which to attach the takeoff</td>
<td>in the dialog, click the Side cell, and select a location around the duct segment: center, top, bottom, left, or right.</td>
</tr>
<tr>
<td>To specify the...</td>
<td>then...</td>
</tr>
<tr>
<td>------------------</td>
<td>---------</td>
</tr>
<tr>
<td>NOTE</td>
<td>The left and right sides of the duct segment are determined by the direction the segment was drafted.</td>
</tr>
</tbody>
</table>

| justification on page 160 of the takeoff | in the dialog, click the Justification cell, and select left, center, right, top, or bottom depending on the specified side. |

| off-center distance | in the dialog, click the Offset cell, and enter a number for the offset distance. |
|---------------------| NOTE The offset is measured from the justification (left, right, center, top, or bottom) of the duct segment. |

| position of the takeoff by sliding around the duct segment | in the drawing, specify a side and justification, drag the takeoff around the segment, and select a position. |

| rotation angle | in the drawing, drag the fitting around the X axis, and select a location. Right-click in the drawing area, and click Rotate Y or Rotate Z to change the rotation axis. You can also enter a specific angle. |

| 11 Specify the rotation angle around the duct segment: |
|------------------|---------|
| To specify the... | then... |
| rotation angle on the X axis | click the X cell under Rotate Around, drag the takeoff around the X axis, and then select a position. You can also enter a number for the angle. |

| rotation angle on the Y axis | right-click in the drawing area, and click rotate Y. Drag the takeoff around the Y axis, and then select a position. |
To specify the…  then…

<table>
<thead>
<tr>
<th>rotation angle on the Z axis</th>
<th>You can also enter a number for the angle in Y under Rotate Around in the Add Duct Fittings dialog on the Off Center tab.</th>
</tr>
</thead>
<tbody>
<tr>
<td>right-click in the drawing area, and click rotate Z. Drag the takeoff around the Z axis, and then select a position. You can also enter a number for the angle in Z under Rotate Around in the Add Duct Fittings dialog on the Off Center tab.</td>
<td></td>
</tr>
</tbody>
</table>

12 Press ENTER to end the command.

TIP You can rotate the newly added takeoff using Rotate grips.

Converting a Line to Duct

1 Define the path of a segment with the AutoCAD Line command. For more information, see LINE.
2 On the command line, enter ductconvert.
3 Select the line to convert, and press ENTER.
4 Do one of the following:
   ■ Press ENTER or enter n (no) to leave the layout geometry in the drawing.
   ■ Enter y (yes) to erase the layout geometry from the drawing.
5 To modify various duct properties, see Modifying Duct on page 350.

Converting a Polyline, Line, Arc, or Spline to Flexible Duct

1 Define the curve of the layout path with either the AutoCAD Fillet or Spline command.
2 Select the polyline, line, arc, or spline you want to convert, right-click, and click Convert to ➤ Flex Duct.
3 Do one of the following:
   ■ Press ENTER or enter n (no) to leave the layout geometry in the drawing.
   ■ Enter y (yes) to erase the layout geometry from the drawing.

4 To modify flexible duct properties, see Modifying the Layout of a Spline Flexible Duct on page 356.

Adding Turning Vanes to Fittings

Vanes are considered annotation, but are not considered objects. You can add turning vanes to all fittings or to specific fittings.

Top view of a mitered elbow with turning vanes

1 Enable vanes in the duct layout preferences, as explained in Configuring the Display of Turning Vanes and Flanges.
2 Select a fitting to add vanes.
3 Click Duct Fitting tab ➤ Duct Vanes panel ➤ Add Vanes .
4 The vane settings are displayed on the command line.
To change the settings, enter `s` (settings), and specify the vane settings in the following table:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>radius</td>
<td>radius of curvature for the vanes</td>
</tr>
<tr>
<td>arc angle</td>
<td>determines the size of the vane arc relative to the circular path that defines the vane; for example, 45 degrees is 1/8 of the circular path</td>
</tr>
<tr>
<td>number of vanes</td>
<td>total number of vanes to add to each fitting; the vanes are spaced equally along the vane path</td>
</tr>
<tr>
<td>mirror current vanes</td>
<td>for tees; mirror the first set of vanes around a specified line</td>
</tr>
<tr>
<td>keep vane path</td>
<td>displays vane path on the fitting; specify no to not show the vane path</td>
</tr>
</tbody>
</table>
5 When prompted to select a start point, specify the inside corner of the fitting.

6 Specify the outside corner of the fitting as the vane path endpoint. Vanes are added to each fitting of the same size and subtype.

7 If you are mirroring vanes, specify the start and endpoints of the mirror line. A second set of vanes is added to the tee.

TIP To apply or remove turning vanes on selected fittings, select a fitting, and click Duct Fitting tab ➤ Modify panel ➤ Duct Fitting Properties. In the Duct Fitting Properties dialog, click the Vanes tab, and select or clear Enable Vanes.

Creating a Custom Duct Fitting

You can create a custom duct fitting when the required fitting is not available from the part catalog or you have a unique design. You create custom fittings by converting AutoCAD lines, arcs, and polylines into AutoCAD MEP objects with connectors. Part properties, such as size, shape, and system definition are inherited from the connecting parts to maintain system integrity. Custom fittings are style-based objects accessible through the Style Manager Overview. Each custom fitting you create represents a single style.

NOTE Custom fittings cannot be added to a part catalog. If you create a custom fitting to be used multiple times, you can share custom fittings between drawings using the copy and paste functionality.

To create a custom duct fitting

1 Draw the centerlines with lines, polylines, or arcs.
Typically, the centerline is drawn connecting ductwork and can be any combination of AutoCAD lines, arcs, or polylines. See the next illustration.

**Defining a custom fitting polyline centerline**

**NOTE** If you draw linework from endpoints of an existing duct, the shape and size of the duct is inherited by the end segment of the fitting that you create.

2 Click Home tab ➤ Build panel ➤ Duct Fitting drop-down ➤ Duct Custom Fitting .

3 Select the polylines, lines, or arcs that represent the centerline of the custom fitting, and press **ENTER**.

4 In the Create Custom Fitting dialog, enter a name, and select a system.

5 Specify the shape and size for the start and end of each segment, and then select Mitered End if an end is mitered.

Use the Object Viewerto view the segment you are specifying properties for. As you step through the Create Custom Fitting dialog, the Object Viewer highlights the current segment.

6 If the properties assigned to the current segment are the same for all segments, select Apply to All Segments.
7 If the properties of the next segment are different from those of the current segment, click Next. The Next button is not available if you select Apply to All Segments.

8 Click Finish, and enter y (yes) to erase the original centerline geometry or n (no) to keep the original geometry in the drawing.

9 Press ENTER.

**NOTE** If any size or shape properties of the segments are incomplete, the custom fitting cannot be created and the Missing Size or Shape Information error message is displayed.

---

### Using the Part Size Not Found Dialog

Sometimes, when adding or modifying a part (such as duct or conduit), the size that you define does not fit the criteria defined in the part catalogs. In such cases, you are prompted with the Part Size Not Found dialog. Use this dialog to select an alternate size definition for the part.

The top portion of the dialog indicates the size criteria that is incompatible with the part you defined. For example, you specify a height for a takeoff. If the values that you define in the part filter are not matched within the catalog, you can create a custom size.

<table>
<thead>
<tr>
<th>To…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>use a part from the catalog</td>
<td>select a part size from the list, and click Use selected part size from catalog.</td>
</tr>
<tr>
<td>create a new part to maintain the values that you defined</td>
<td>click Create custom sized part.</td>
</tr>
<tr>
<td>revert to the original dimension for the part</td>
<td>click Undo change.</td>
</tr>
</tbody>
</table>

---

### Adding a Label or Flow Arrow to Duct

1 In the HVAC workspace, choose an action below:

- Click Annotate tab ➤ Label panel ➤ MEP Label ➤.
Open the Annotation tool palette, and select a label tool.

2 On the Properties palette, under General, for Style, specify a selection.

3 Under Layout Method, specify how many labels or flow arrows to add to each duct segment you select, as follows:

<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the total number of labels or flow</td>
<td>select By quantity, and enter a value for Number of labels.</td>
</tr>
<tr>
<td>arrows to display on each duct segment</td>
<td>Note that the number of labels or flow arrows is automatically added to each straight segment.</td>
</tr>
<tr>
<td>Insert a label or flow arrow at a uniform</td>
<td>select By distance, and enter a value for Distance between.</td>
</tr>
<tr>
<td>interval on each duct segment</td>
<td>Note that if a duct segment length is less than the interval distance, a label or flow arrow is not added to that segment.</td>
</tr>
</tbody>
</table>

Flow Arrows Spaced Evenly, 1 per segment

Flow Arrows Repeated at a Uniform Interval

4 In the drawing, select the objects you want to label, and press ENTER.

5 If you specified One by one for the layout method, specify the location on the duct to add the label.

By default, the label is placed along the duct segment. Press Ctrl before specifying the label location to move the label off the duct.
RELATED  Label styles can be configured to display properties such as duct diameter or system type. For more information, see Label Style Properties on page 826. For more advanced annotation, such as tags, schedules, cross-sectional views, and details, see Creating Construction Documents on page 813.

Adding a Hatching Pattern to Identify a Duct System

Use this procedure to add hatching patterns to duct systems so that you can easily identify separate systems on complex drawings. For example, you can specify different hatch patterns for supply and return duct systems.

1  In the drawing that contains the duct systems, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ HVAC System Definitions.
2  Select a duct system.
3  In the right pane, select the Display Properties tab.
4  Double-click Plan under Display Representations.
5  In the Display Properties dialog, select the Layer/Color/Linetype tab.
6  Select Hatch under Display Component, and specify it as visible.
7  Click the Hatching tab, and specify a hatch pattern.
8  Click OK 3 times.

Using Spaces for Load Analysis

Spaces are entities that model the interior spaces of rooms and are grouped into zones. A zone represents an actual building zone that has its own heating and cooling requirements. Spaces and zones aid in calculating the heating and cooling loads for a building plan.

After you create spaces and zones, you can assign them the engineering data needed for calculating loads and airflows. You export the engineering and building information in Green Building XML (gbXML) format, that are used in external analysis tools. After you analyze the file, you can import the results into your drawing. You can view the calculated loads and airflows for the spaces and zones, and design your duct systems accordingly.
Specifying Space Styles

You can specify space styles for the different room types in the building plan. For example, when designing an HVAC system for a manufacturing facility, you can create space styles for offices, manufacturing areas, and warehouse areas.

Regarding load calculations, defining a classification for space style is essential. This action sets the occupant density and outside air flow requirements automatically. These values are included in the software, and are based on the appropriate mechanical standard or code. For more information, see Viewing Classification Definitions for Occupant Densities and Air Flows on page 323.

If multiple rooms use the same density of lighting and equipment, you can add property sets to the style that enable you to specify lighting and equipment loads per area. This action alleviates the need to manually enter lighting and equipment loads for each individual space. If you need to change the lighting and equipment load for a space, you can override these values using the Properties palette.

You can also specify the display properties for the space—such as visibility, layer, color, and linetype—and you can specify a hatching pattern to enhance the visibility of spaces in the floor plan.

Configuring Space Styles

Configuring spaces styles involves the following steps.

To create a space style

1. Open the drawing to which you want to add spaces.
2. Click Manage tab ➤ Style & Display panel ➤ Style Manager .
3. In Style Manager, expand the current drawing.
4. Expand Architectural Objects ➤ Space Styles.
5. Right-click Space Styles, and click New.
6. Rename the new style, and verify that it is selected.

To specify a lighting and equipment load per area

7. In the right pane, click the General tab.
8. At the bottom of the pane, click Property Sets.
9. In the Edit Property Sets Data dialog, click (Add Property Sets).
10 In the Add Property Sets dialog, select SpaceEngineeringStyles.

**NOTE** This property set is only available in drawings created from templates provided with Autodesk Building Systems 2007 or AutoCAD MEP 2011. If this property set is not available, you can copy and paste it from the Aecb Model drawing template using Style Manager. In Style Manager, it is located in Documentation Objects ➤ Property Set Definitions.

11 In the Edit Property Sets Data dialog, enter the area lighting and equipment loads.
You can also specify a gbXML space type override if you want to restrict this style to a specific space type. If you use this setting, it overrides any classification you specify for the space style as shown in the following steps.

**To specify a classification**

12 Click the Classifications tab.

13 For Space Occupancy, click ⬤.

14 In the Select Classification dialog, expand the directories under the desired standard, and select a space type.

15 Use the previous steps to create additional space styles.

16 To modify the display of spaces with the selected style, click the Display Properties tab, and modify the display settings as desired.

**NOTE** You must assign a classification to use the gbXML export feature. You can assign a classification to the space style, or you can specify a classification override in the space style property set. You can also manually specify a classification on the Extended Data tab of the Properties palette.

**NOTE** For complete information on working with space styles, see Space Styles in the AutoCAD Architecture Help.
Viewing Classification Definitions for Occupant Densities and Air Flows

1. Click Manage tab ➤ Style & Display panel ➤ Style Manager.
2. In the Style Manager, expand Multi-Purpose Objects ➤ Classification Definitions.
3. Click Space Occupancy.
4. In the right pane, click the Classifications tab.
5. Expand the classifications under Space Occupancy, and select the space type you want to view.
6. On the right side of Style Manager, click Property Sets.

The Edit Property Set Data dialog displays the values for the classification.

Configuring Zone Styles

You can create zone styles to specify the display and design rules for zones. Zone styles are located in Style Manager under the Documentation Objects.
For more information, see Zone Styles in the AutoCAD Architecture online help.

**Adding Spaces to a Floor Plan**

You can add spaces to a drawing using objects in a referenced floor plan drawing (xref) as bounding objects. Using the Space tool, you can generate a space for a room bounded by AEC objects, such as walls and floors, or AutoCAD objects, such as lines and blocks. The Space tool is located on the Analysis palette in the HVAC tool palette group.

When adding spaces, be sure to specify the appropriate space styles. After you create the spaces for a floor plan, you assign engineering data using property sets. You also specify surface types, such as exterior walls, using the Space/Zone Manager.

---

**NOTE** For complete information on creating, editing, and updating spaces, see Spaces in the AutoCAD Architecture online help.

---

**Recommendations for Floor Plans**

The Space tool should work with most kinds of floor plan drawings. When generating spaces, you can use the extruded 3D space type for most applications. The space perimeter is determined by the floor geometry, and the space is extruded vertically to a specified height. Whether the floor plan consists of 3D AEC objects, 3D AutoCAD lines, or 2D AutoCAD lines, you can generate extruded 3D spaces based on the floor outline. Note, however, that spaces generated from linework floor plans may require editing. For example, if a linework floor plan shows door swings into a room, the space generated from the floor outline might exclude the area in the door swing linework.

If a room does not have a constant perimeter throughout its height, such as it has sloped walls or ceilings, you can generate 3D free form spaces to automatically conform to the irregular volume. You can only create 3D free form spaces, however, if the floor plan is developed in 3D from AEC or AutoCAD objects.

When you generate spaces, they are specified as associative by default. Associative spaces are automatically linked to their bounding objects. If you modify the bounding objects, you can manually update the space in one step to match the new room shape. However, spaces set as associative cannot be
edited. When working with referenced floor plans, it is recommended that you configure the spaces based on the type of floor plan you are using:

- **AutoCAD Architecture floor plan:** If the floor plan consists of AEC objects, you can generate a space that not only matches the floor plan geometry, but also detects openings such as windows and doors. It is recommended that you leave the space as associative if you have immediate access to updated floor plans. That way you can manually update the space to match the latest floor plan. However, if you want to edit the space openings or space surfaces, you need to set the space to be non-associative. When you do this, the openings are maintained, but the space no longer interacts with its bounding objects.

- **AutoCAD linework and blocks, 2D or 3D:** You can generate spaces for both 2D and 3D linework drawings. For 2D linework, you can generate extruded 3D spaces. For 3D linework, you can generate extruded 3D spaces or free form 3D spaces. For both types, it is recommended that you generate the spaces, set them to be non-associative, and then manually add openings and specify surface types. You can manually edit the space geometry to match any changes to the floor plan.

For load analysis purposes, you must use extruded 3D spaces or free form 3D spaces. Do not use 2D spaces. This ensures that the room volumes are accurately modeled.

**TIP** If the spaces and their bounding objects are in the same drawing, you can configure the software to update the spaces automatically when you make changes to the bounding objects. For more information, see Activating and Deactivating Automatic Updates.

**Modeling Openings on Spaces**

Spaces can be configured to include openings such as doors and windows. If you create spaces based on AEC objects in an AutoCAD Architecture drawing, the spaces can automatically detect the openings.

Generated spaces are associative by default. They detect openings automatically, and cannot be manually edited unless you set them to be non-associative on the Properties palette. If you generate extruded 3D spaces using linework in a 2D floor plan, you have to set the spaces to be non-associative before you can add openings to the spaces.

Manually created spaces are not associative by default, and you can edit their surfaces and openings. For information on doing so, see How Changing the
Space Geometry Affects Surface Openings in the AutoCAD Architecture online help.

If you change a space from associative to non-associative or vice versa, existing openings are maintained in most cases. When you change a 3D free form space to a 3D extruded space, openings that do not intersect with the base profile of the extruded space are lost.

**Modeling Surface Types on Spaces**

Space surfaces can be configured for surface type. For example, a wall can be interior or exterior, and a floor can be interior, slab, or underground. However, you do not need to specify surface types in order to use the gbXML export tool. The tool automatically figures out the correct surface type when the gbXML file is created. For example, surfaces that have no adjacent spaces are considered exterior, and wall surfaces below grade level \( z = 0 \) are considered underground. You can specify surface types in the **Space/Zone Manager**.

**Adding Engineering Data to Spaces**

For load calculation purposes, you must add SpaceEngineeringObjects, ThermalProperties, and ZoneEngineeringObjects styles property sets to all spaces that you want to analyze. Use this procedure to add engineering data to spaces.

1. Click Manage tab ➤ Style & Display panel ➤ Style Manager ➔.
2. Click File ➤ Open Drawing.
3. In the Open Drawing dialog, navigate to \ProgramData\Autodesk\MEP 2011\enu\Styles\Imperial.
4. Select the gbXML Property Set Definitions drawing and click Open.
5. Expand the gbXML Property Set Definitions Documentation Objects folder.
   - The SpaceEngineeringObjects, ThermalProperties, and ZoneEngineeringObjects styles comprise this property set.
7. Copy the Property Set Definitions to your current drawing, and then click OK.
   - The engineering data styles are ready to be applied the spaces and zones in your drawing.
8 Select the spaces to which you want to add the property set data, and click Home tab ➤ Build panel ➤ Tools drop-down ➤ Properties.

9 On the Properties palette, click the Extended Data tab, and then click Add Property Sets.

10 In the Add Property Sets dialog, select SpaceEngineeringCalculatedData, SpaceEngineeringObjects, and SpaceObjects, and then click OK.
The property set is added to the selected spaces, and it can be viewed on the Extended Data tab.

11 Under Classification, verify that a room type (a classification) is specified for Space Occupancy.
   Any classification configured for the specified space style displays here. You can override it by clicking the room type, and specifying another room type in the Select Classification dialog. If the current value is "Unspecified", specify a room type.

12 Under Property Sets, you can specify values for the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Occupancy</td>
<td>Enter the number of occupants for the room. This value may be used for calculating the</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RequiredOutdoorAirFlow</td>
<td>required outdoor air flow depending on the code and classification. If Occupancy is 0, the occupant density for the classification is used to calculate outside air.</td>
</tr>
<tr>
<td>ConditionType</td>
<td>Specify how to condition the room.</td>
</tr>
<tr>
<td>LightingLoad</td>
<td>Enter the lighting load for the room. If you specified lighting load per area in the style, the DefaultLightingLoad property set calculates the lighting load based on the room area. You can override that value by entering a value for LightingLoad here.</td>
</tr>
<tr>
<td>EquipmentLoad</td>
<td>Enter the equipment load for the room. If you specified equipment load per area in the style, the DefaultEquipmentLoad property set calculates the equipment load based on the room area. You can override that value by entering a value for EquipmentLoad here.</td>
</tr>
<tr>
<td>OutsideAirFlow</td>
<td>If you enter a value, it overrides the required airflow calculated from the classification.</td>
</tr>
<tr>
<td>SupplyAirFlow and ReturnAirFlow</td>
<td>If you are exporting gbXML data for analysis, you do not need to enter values for these fields. Airflow will be calculated for this space, and you can enter your desired values after you import the load calculations. These values are for the flow rate for the room, not for the flow per unit area or per person.</td>
</tr>
</tbody>
</table>

Note that the RequiredOAFlow (occupant air flow) property is not editable. Its value is calculated automatically when you specify a room type for Space Occupancy and a number of occupants for Occupancy.

**Attaching Property Sets to Zones**

1 Create zones, as described in Configuring Zone Styles on page 323.
2 Select all zones, and click Home tab ➤ Build panel ➤ Tools drop-down ➤ Properties.

3 On the Extended Data tab of the Properties palette, click (Add Property Sets).

4 In the Add Property Sets dialog, select ZoneEngineeringObjects, and click OK.

The property set is added to the selected zone, and it can be viewed on the Extended Data tab.

5 Under Property Sets, specify the appropriate values for design heating and cooling temperatures.

**Attaching Spaces to Zones**

For load calculation purposes, you must assign all spaces to one or more zones. You can also attach zones to other zones, which is useful for exporting zone data through reference drawings. However, the Export gbXML command exports only those zones that have spaces assigned. Zones without spaces assigned to them will not be exported.
1 Select a zone and click the Add grip on page 264.

**NOTE** Alternatively, click Zone tab ➤ Modify panel ➤ Attach .

2 Select the spaces or zones to attach to the zone. Continue attaching spaces to zones as needed.
You can attach spaces or zones in reference drawings to a zone in the current drawing.

**IMPORTANT** Zones in reference drawings cannot be exported to gbXML unless they are attached to a zone in the current drawing. However, even when a zone in a reference drawing is attached to a zone in the current drawing, any zone will not be exported if the spaces attached to it are attached to other zones that have already been added to the export map.

3 (Optional) Use the Space/Zone Manager to review the zone hierarchy, and to review space information such as surface and opening type. See Reviewing Spaces and Zones on page 332.

**RELATED** For more information, see Opening the Space/Zone Manager and Editing Space Surface Properties.

### Exporting Zones for Load Analysis

1 Open the drawing that contains the zone data you want to analyze.

**NOTE** You can analyze a complete building by attaching zones and spaces in xref drawings to zones in a current drawing. The adjacent spaces and space surface types are automatically detected for all spaces at export.

2 Click ➤ Export ➤ gbXML.
If necessary, scroll down to display additional export options.

3 In the Export to gbXML dialog, specify the export settings:
   - File name: Specify a file name and location.
Select Objects: The dialog automatically detects all zones in the current drawing. Zones in reference drawings cannot be exported unless they are attached to a zone in the current drawing. If the dialog does not detect all zones, click Select Objects and select the desired zones.

Building Type: Specify a building type and postal ZIP code that may be used by the external analysis program.

Progress: Click Start to run the export.

Success: If any errors occur during export, the event log opens to allow you to view error messages. You can view the event log at any time by clicking View Event Log.

The gbXML file can now be used in various analysis software programs.

**Reviewing Spaces and Zones**

You can use the Space/Zone Manager to review the zone hierarchy and space information, such as surface and opening type.

1. Select a space or a zone.
2 Open Space/Zone Manager using one of the following methods:

- Click Space tab ➤ Helpers panel ➤ Space/Zone Manager.
- Click Zone tab ➤ Helpers panel ➤ Space/Zone Manager.
- On the Design tab in the Properties palette, under Basic ➤ General, click next to Space/Zone Manager.

3 In Space/Zone Manager, select both Show All Zones and Spaces and Show Space Surfaces.

4 To modify a surface type, such as specify a wall as interior or exterior, verify that Show Space Surfaces is selected.

5 Expand the space, and select the surface to specify. Move the Space/Zone Manager, if necessary, and note that the selected surface is highlighted on the drawing.
For Type, specify a surface type from the drop-down list.
Use the previous steps to specify surface types for all spaces.

**Importing Load Analysis Results**

1. Open the drawing that contains the zones and spaces used when you exported the original gbXML file.

   *NOTE* If you calculated loads for spaces in xref drawings, repeat the import procedure on every drawing that contains spaces.

2. Click Analyze tab ➤ HVAC panel ➤ Import gbXML.

3. In the Import gbXML dialog, specify the analyzed XML file, and click Open.
   The gbXML results are applied to the spaces and the zones in the drawing.

4. To view calculations, click a space or zone, and click the Extended Data tab on the Properties palette.
   The calculation results are displayed under SpaceEngineeringCalculatedData for spaces, and ZoneEngineeringCalculatedData for zones.

![Diagram showing gbXML results](image)

The SupplyAirFlow calculated value is used in the space tag and space schedules. You can manually enter values for return air flow.
NOTE The Import gbXML command provides no direct information about the success or failure of the import operation. Examine the calculated results to determine the success of the import operation.

Using Space and Zone Calculated Data

After you import load calculations into your drawing and apply them to spaces, you can display the calculation results in tags and schedules to help you design your HVAC system.

A space tag example

![Image of a space tag example]

Simple space schedule example

<table>
<thead>
<tr>
<th>Room</th>
<th>Area</th>
<th>Supply</th>
<th>Return</th>
<th>Ventilation</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAB 344</td>
<td>1,200</td>
<td>1,000</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>LAB 344</td>
<td>1,250</td>
<td>1,050</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>LAB 344</td>
<td>1,300</td>
<td>1,100</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

The space tags and schedules are located in the Content Browser. You can drag and drop them onto a tool palette.

To load the space tag onto a tool palette

1. Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Content Browser ➤ MEP Documentation Tool Catalog - Imperial.
2. In the Content Browser, click the MEP Documentation Tool Catalog - Imperial.
3. In the left pane, click HVAC ➤ HVAC Tags.
4. Click Text Tags.
5. In the upper-right corner, click Next until you get to the page with the Space tag.
6 Move the cursor over the i-drop symbol.

7 Drag the i-dropper from the Content Browser, and drop the space tag tool onto a tool palette.

8 To add the space schedule, repeat the previous steps. The Space Engineering Schedule is located in HVAC ➤ HVAC Schedules of the Documentation Tool Catalog.

9 Close Content Browser.

For information on placing space tags on your drawing, see Tags on page 835. For information on scheduling spaces, see Schedules on page 842. You are more likely to use space tags and schedules in construct drawings as design aids. You may not necessarily include them on view and sheet drawings for construction documents.

**Calculating Duct Sizes to Optimize Duct System Designs**

Once you have created a duct system, you can analyze the system design to determine the optimal sizes for system components. You export system data from the drawing and analyze it using an external software tool. Once the data has been analyzed, and optimal sizes have been calculated for system components, you then import the calculated data into your drawing and resize the system. Trane® VarTrane™ Duct Designer and Elite Ductsize are 2 applications that can analyze and size duct systems in AutoCAD MEP drawings.

Duct system data is exported and imported in Duct Design Extensible Markup Language (DDXML). DDXML is a schema used to store and transfer data for duct networks. It can be used directly in duct analysis packages.

**Specifying ASHRAE Fitting Types**

The American Society of Heating, Refrigerating, and Air-Conditioning Engineers (ASHRAE) publishes a database that includes loss coefficient tables for many duct fittings. Each duct fitting in the database is identified by a unique number.
The external tool you use to analyze your system may require that all fittings in the system are assigned an ASHRAE fitting number.

You can assign ASHRAE identification numbers to duct fittings in a system either using the Properties palette or the Modify Fitting ID dialog in the event log of the Duct System XML Export dialog.

**To specify an ID in the Properties palette**

1. In the drawing, select the fitting that you want to specify and click Home tab ➤ Build panel ➤ Tools drop-down ➤ Properties.

   **TIP** To specify all fittings of the same type in the drawing at once, select one fitting, and click Duct Fitting tab ➤ General panel ➤ Select System drop-down ➤ Select Similar .

2. On the Properties palette, expand Advanced, and expand Engineering Data.

3. In the Assigned Engineering ID drop-down list, view the available choices, if any, for ASHRAE fitting numbers.

   If the ASHRAE number you want to use is in the list, select it for Assigned Engineering ID.

   **NOTE** If there is more than one ASHRAE number to choose from, consult the ASHRAE Duct Fitting Database to make sure you choose the most appropriate fitting for your system. Some fittings are dependent on flow direction or duct system type, such as supply or exhaust.

   If the ASHRAE number you want is not in the list, or there are no numbers listed, enter the ASHRAE fitting number for Assigned Engineering ID.

4. Press ESC to deselect.

5. Continue specifying fittings, if necessary.

**To specify an ID when exporting to duct system XML**

6. After exporting a duct system for analysis, click View Event Log in the Duct System XML Export dialog.

7. If there are any error warnings for multiple fitting IDs in the Event Log, select the warning, and click (Modify Fitting ID).
In the Modify Fitting ID dialog, specify an ID in the Fitting drop-down list, or enter a fitting ID, and click OK. This ID is assigned to the fitting in the drawing. Repeat as necessary to resolve all fitting ID warnings. If desired, you can run the duct system export again to include the revised fitting IDs.

Considerations Prior to Exporting Duct System Data

Prior to exporting duct system data, each system must have at least one start point and one endpoint. A system is defined as any ductwork between a start point and one or more endpoints. A start point must consist of a fan or other air handling device. Endpoints must consist of outlet devices such as air terminals. Flow values must be assigned to outlet devices in order to properly size system components.

For example, a supply system uses an air handling unit to supply air to several rooms. Each room includes an air terminal as the outlet for the air. In this example, the system includes all ductwork from the air handling unit to each air terminal. If there was no air handling unit in the drawing, you would not be able to export the system data.

You should also consider these factors prior to exporting data:

- Start points can be fans, air handling units, or similar MvParts such as a VAV boxes, mixers, or economizers.
- To ensure proper sizing, assign flow values to all outlet devices, such as air terminals. For more information on modifying MvPart properties to assign flow values, see Configuring Mechanical Parts for Analysis on page 291.
- If the outlet device is an end cap, it is assigned a flow value of zero.
- Variable air volume controllers (VAV boxes) with 2 connectors, such as single duct or shut off VAV boxes, are considered part of the duct run unless they are ending a branch. If they end a branch, they must have a flow value assigned. If they do not end a branch, the flow value assigned to them is not used.
- VAV boxes with more than 2 connectors, such as dual duct boxes, are considered end points. Any ductwork beyond the VAV box is not considered. The flow value assigned to the VAV box connector is used for analysis.
Duct segments that contain takeoffs are considered as one plenum duct when exported. If you want the analysis tool to assign different sizes to different parts of the duct, use the break command to divide the duct into multiple segments, and insert transition fittings where appropriate.

Prior to exporting, you should also consult your external analysis package for any additional requirements you must include in your system. For example, you may need to specify the ASHRAE fitting type for all duct fittings as shown in Specifying ASHRAE Fitting Types on page 336. There may also be system design constraints that you need to consider.

**TIP** To preview the connectivity of a system, select an object within the system, and click [Duct, Duct Flex, or Duct Fitting] tab ➤ Modify panel ➤ Show Connected Objects drop-down ➤ Show Connected Run.

---

### Exporting Duct System Data

1. Click ➤ Export ➤ Duct XML.
2. In the Duct System XML Export dialog, specify a path and file name for the output file. Note that the file extension for a DDXML file is *.ddx.
3. Click Select Object.
4. In the drawing, select any duct segment or fitting within the system that you want to export.
5. In the Duct System XML Export dialog, specify a system for Select System Type.
6. Click Start.
7. When the export is complete, the DDXML file is created in the specified directory.
8. If any errors were encountered during export, click View Event Log for a list of errors.

### Importing Optimized System Data

Prior to importing system data, you can analyze the DDXML file using an external tool. Component sizes are calculated and written to the DDXML file. Once analyzed, you can import the DDXML file into your drawing.
1 Open the drawing that contains the system for which you exported the system data.

2 Click Analyze tab ➤ HVAC panel ➤ Import Duct XML. 

3 In the Duct System XML Import dialog, specify the DDXML file you want to import, and click Open. 

4 The optimized data is assigned to the system in the drawing.

**Resizing a System**

1 In the HVAC workspace, open the Analysis tool palette, and select the External Data Resize tool. 

2 In the System Resize dialog, click Select Object. 

3 In the drawing, select a duct segment or fitting in the system you want to resize. 

4 In the System Resize dialog, specify a preference for custom parts: 

<table>
<thead>
<tr>
<th>If you...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>want to use custom parts when resizing the system</td>
<td>select Allow parts with custom size.</td>
</tr>
<tr>
<td>want to only use parts available in the catalog</td>
<td>deselect Allow parts with custom size, and specify how to select parts whose calculated size does not exactly match an available size in the catalog.</td>
</tr>
</tbody>
</table>

5 Click Start. 

6 After the command has been fully executed, the system is automatically resized. Review the drawing to make sure all fittings and ductwork have been resized properly. 

   Click View Event Log to view any errors encountered during resizing. 

The following illustrations show a system design before and after sizing.
Modifying a Duct System

The topics in this section offer specific instructions on how to modify all aspects of a duct system. You can modify duct systems in your drawings at any point during the design process.
Modifying Components Using Grips

You can use grips on certain duct objects in a drawing to quickly modify the duct system, as described in the following table:

<table>
<thead>
<tr>
<th>Grip</th>
<th>Description</th>
<th>Available on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>move a part</td>
<td>ducts, fittings, and MvParts on page 110</td>
</tr>
<tr>
<td>Elevation</td>
<td>change the elevation for a part</td>
<td>ducts, fittings, and MvParts</td>
</tr>
<tr>
<td>Rotate</td>
<td>rotate a part around a duct centerline; flip parts in place, usually to orient a part for flow direction</td>
<td>in-line or anchored MvParts, fittings, and takeoffs</td>
</tr>
<tr>
<td>Lengthen</td>
<td>change the length of a duct</td>
<td>duct</td>
</tr>
</tbody>
</table>

RELATED See Grips for Modifying a Duct Run on page 265.

Moving Duct Components Using Location Grips

1 Select the object to move.
2 Click the Location grip on page 265 (blue square) on the selected object.
3 Specify the new location for the part:

<table>
<thead>
<tr>
<th>To…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>move the object while maintaining connectivity, and keep the location of MvParts on page 110 fixed</td>
<td>click the Location grip and specify the new location for the object. Any MvPart remains fixed. If an MvPart is oriented along the same vector as the object, the object also remains fixed.</td>
</tr>
<tr>
<td>move the object while maintaining connectivity, and move any MvParts oriented along the same vector as the object</td>
<td>click the Location grip and press Ctrl once. Specify the new location for the object. The MvPart moves with the object to the new location.</td>
</tr>
</tbody>
</table>
To… then…

move the object by itself, breaking connectivity with the system

click the Location grip and press ctrl twice. Specify the new location for the object.

If you maintained connectivity, the connected objects in the same plane stretched in the direction of the move.

Modifying the Elevation of HVAC Parts and Ducts

1 Change to a side or isometric view.
2 Select the part or duct segment, and click the elevation grip to use.
3 If the object is connected to another object, choose an action:

<table>
<thead>
<tr>
<th>To…</th>
<th>Maintain connectivity</th>
<th>Then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>adjust only duct fittings and segments and retain the current locations of parts</td>
<td>yes</td>
<td>proceed to the next step.</td>
</tr>
<tr>
<td>adjust all objects, including parts</td>
<td>yes</td>
<td>press CTRL.</td>
</tr>
<tr>
<td>break connectivity</td>
<td>no</td>
<td>press CTRL twice.</td>
</tr>
</tbody>
</table>

4 Specify the new elevation:

<table>
<thead>
<tr>
<th>To…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify the new overall elevation relative to a point on the part or segment (for example, the centerline)</td>
<td>press TAB as many times as needed to activate the appropriate input field, and enter the resulting dimension. Press ENTER.</td>
</tr>
</tbody>
</table>
To... then...

raise or lower the elevation by a specified dimension Drag the cursor to begin raising or lowering the elevation. Press \textit{TAB} as many times as needed to activate the appropriate input field, and enter the relative dimension. Press \textit{ENTER}.

\textbf{NOTE} Elevation grips are not available on flex or sloping duct segments.

\textbf{TIP} To specify elevation on the Duct Modify dialog, select the duct object, and click \textit{[Duct/Duct Flex/Duct Fitting]} tab \textgreater Modify panel \textgreater Duct Modify. The software adjusts connected fittings and segments to maintain connectivity, but retains the locations of parts.

\section*{Lengthening a Duct Segment}

1 Select the duct segment and click the \textit{Lengthen grip} on page 272.

2 If the segment is connected to an object on the end you selected, specify whether and how to maintain connectivity:

\begin{tabular}{lll}
\textbf{To...} & \textbf{Maintain connectivity} & \textbf{Then...} \\
adjust only duct fittings and segments and retain the current locations of parts & yes & proceed to the next step. \\
adjust all objects, including parts & yes & press \textit{CTRL}. \\
break connectivity & no & press \textit{CTRL} twice. \\
\end{tabular}

3 Specify the segment length:

\begin{tabular}{ll}
\textbf{To...} & \textbf{then...} \\
specify the new total length & press \textit{TAB} to activate the input field for specifying the resulting dimen- \\
\end{tabular}
To... then...

- sion, and enter the new length. Press 

  ENTER.

- specify the difference between the current length and new length drag the cursor to begin lengthening or shortening the segment, and enter the change in length in the input field that is active by default. Press ENTER.

- specify a new endpoint drag the grip to the endpoint, and click to specify the point.

**TIP** To use the dimension input fields, enable dynamic input (on the application status bar) and the Dimension Input drafting setting.

**NOTE** Flexible ducts do not have lengthen grips. To modify the length of flex ducts, see Modifying the Layout of a Spline Flexible Duct on page 356.

### Rotating Duct Components

1. Select an in-line part, fitting, or takeoff.
2. Rotate the object as follows:

<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>180 degrees</td>
<td>click the Rotate grip ( ).</td>
</tr>
<tr>
<td>90 degrees</td>
<td>while pressing CTRL, click the Rotate grip ( ).</td>
</tr>
</tbody>
</table>

**NOTE** If the part is rectangular or oval, the software automatically switches its height and width values.
Then...To...

<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>an angle you specify</td>
<td>click the Rotate grip ( ), and:</td>
</tr>
<tr>
<td></td>
<td>■ enter the new absolute angle in the active dimension input field.</td>
</tr>
<tr>
<td></td>
<td>■ drag the cursor to reduce or increase the angle, click TAB to</td>
</tr>
<tr>
<td></td>
<td>activate the dimension input field for specifying the angle change, and</td>
</tr>
<tr>
<td></td>
<td>enter the value.</td>
</tr>
<tr>
<td></td>
<td>■ drag the grip to a new location.</td>
</tr>
<tr>
<td></td>
<td>■ enter the value in the command window.</td>
</tr>
</tbody>
</table>

**Modifying HVAC Equipment**

You can modify the size, location, or system associated with an MvPart.

**RELATED** See *Mechanical, Electrical, and Plumbing Equipment in Building Systems* on page 110.

**Modifying HVAC MvPart Location**

You can specify exact location coordinates for mechanical parts in a drawing. However, this approach does not maintain connectivity.

1. Select the part, and click Equipment tab ➤ Modify panel ➤ Equipment Properties
2. In the Multi-view Part Properties dialog, click the Location tab.
3. Select the coordinates (world or current) on which to base the location.
4. Specify the new location:

<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify exact coordinates for</td>
<td>specify the X, Y, and Z coordinates under Insertion.</td>
</tr>
<tr>
<td>the location.</td>
<td></td>
</tr>
<tr>
<td>To...</td>
<td>then...</td>
</tr>
<tr>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>rotate the part around the X, Y, or Z axis</td>
<td>specify the X, Y, and Z values under Normal.</td>
</tr>
<tr>
<td>rotate the part in the current plane</td>
<td>specify an angle for Rotation.</td>
</tr>
</tbody>
</table>

**Modifying HVAC Equipment**

1. Select the mechanical equipment on page 110 to modify.
2. Click Equipment tab ➤ Modify panel ➤ Modify Equipment.
3. In the Multi-view Part Modify dialog, on the Part tab, under All Installed MvParts, specify a part. Expand subfolders as needed.
4. Specify a part size for Part Size Name.

**NOTE** The part size name list displays the available part sizes in the range of the current part. If the part size is not available, proceed to the next step to specify filters and ranges.

5. On the Part Filter tab, under Connections, for Nominal Connection, select a size range (such as in this format: 4-72). To filter the number of sizes available for viewing, for Display, enter a number within the allowable range.

**Shows Display filter**

| Display: $9$ of $15$ parts |

6. Under the part graphic, click or to step through the available part size names in the selected range. Select a size for Part Size Name.
7 Specify an elevation.

**NOTE** When changing the elevation for an MvPart that is connected to other objects, the objects remain connected and are placed at the new elevation.

8 Click the Flow tab. For outlet devices, modify the airflow value for Flow. For supply devices, modify the airflow value for each connector.

**Changing a Part to Match Another Part**

You can change an MvPart of one type to match an MvPart of another type, for example, a valve to a pump.

1 Select the MvPart on page 110 to change.
2 Click Equipment tab ➤ Modify panel ➤ Modify Equipment ➔.
3 In the Multi-view Part Modify dialog, click (Match) in the lower-left corner.
4 In the drawing, select the MvPart to match.
5 Press ENTER to match the part and the elevation.

**Modifying Flow Annotation Information for Air Terminals**

1 In the HVAC workspace on page 53, select an air terminal on page 110 in the drawing.
2 Click Equipment tab ➤ Modify panel ➤ Equipment Properties.

3 In the Multi-view Part Properties dialog, click the Flow tab.

**NOTE** The Flow Annotation tab is only available after you have added an air terminal to the drawing.

4 To change or assign a flow value for devices such as fans, VAV boxes, and ceiling diffusers, specify a new value for Flow.

You can specify up to 8 locations to place flow arrows around the air terminal. You can select the block for the flow arrow, and optionally use the same block for all flow arrows or selecting different blocks based on location. You can specify the rotation angle and the offset from the air terminal for each flow arrow, and specify a flow value.

**Modifying the Flow Value Assigned to a Part**

1 Select the fan, VAV box, or ceiling diffuser.

2 Click Equipment tab ➤ Modify panel ➤ Modify Equipment ➤ .

3 In the Multi-view Part Modify dialog, click the Flow tab.

4 For Flow (Each Terminal), specify a flow value.
Modifying the System Assigned to a Part Connection

If you change the system for an MvPart connector that is connected to a duct run, the system for the duct run inherits the system properties of the MvPart connector.

1. In the drawing, select the MvPart you want to modify.
2. Click Equipment tab ➤ Modify panel ➤ Equipment Properties.
3. In the Multi-view Part Properties dialog, click the Systems tab.
4. In the System column, click in the field for the connector you want to specify.
5. Select a system.

**NOTE** When adding an MvPart to a drawing, no systems are assigned to its connectors. If you connect a duct run to an MvPart connector, the connector inherits the system setting from the connecting duct object. If you use Add grips on page 264 to draw duct runs directly from the MvPart, the system is already specified for the run.

### Modifying Duct

The topics in this section explain how to modify the segments and runs based on design changes or layout requirements. You can move single objects or groups of connected objects. You can change the system, elevation, shape, size, and part type of a duct segment. You can also use the duct system size calculator and instant sizing tool to recalculate duct sizes as you refine your systems. You can also change a duct fitting in a run, the position of an off-center fitting, or a custom fitting.

To enhance visual clarity in a drawing, you can also assign hatching patterns on page 238 to ductwork to identify different duct systems. For example, you can assign hatching patterns to ductwork that will be demolished as part of a building modification.

### Modifying the Size or Shape of a Duct

1. Select the duct segment.
2. Click Duct Flex tab or Duct tab ➤ Modify panel ➤ Duct Modify.
3 In the Modify Duct dialog, specify the duct shape for Shape.

4 Specify new sizes. You can manually select sizes or calculate them using the instant sizing tool:

<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>calculate size for round duct</td>
<td>accept the detected flow value for Capacity, or enter a flow value for Capacity. Click . The calculated duct size is displayed for Diameter.</td>
</tr>
<tr>
<td>calculate size for oval or rectangular duct based on a fixed height</td>
<td>accept the detected flow value for Capacity, or enter a flow value for Capacity. Specify a size for Height, and click for Width. You can change the height and recalculate the width repeatedly until you achieve a desirable duct size.</td>
</tr>
<tr>
<td>calculate size for oval or rectangular duct based on a fixed width</td>
<td>accept the detected flow value for Capacity, or enter a flow value for Capacity. Specify a size for Width, then click for Height. You can change the width and recalculate the height repeatedly until you achieve a desirable duct size.</td>
</tr>
</tbody>
</table>

**RELATED** For more information, see *Specifying a Calculation Method for Duct Sizing* on page 289.

5 In the Maintain Connection dialog, ensure a valid connection between the modified segment and the run:

**Choose the appropriate action:**

- Modify to maintain connection to next part. Prompts you to add a transition fitting to connect the duct or fitting without changing the entire run.
- Modify to next junction/transition.
Resizes the branch to the next junction or transition. With this choice, the junction fitting that connects the 2 runs is replaced. The correct transition fitting is inserted in its place to maintain a valid connection at that junction.

**Locking the Duct or Fitting Size**

When a component is locked, its size cannot be changed even if the entire branch is being resized. Transition fittings are added to each end of the locked object. For example, if a duct segment passes through an area with limited clearance, you can lock the size for that segment.

1. Select the segment or fitting.
2. Lock the size by doing one of the following:
   - On the Properties palette, expand Advanced, and under Calculation Settings, specify Yes for Lock Size.

**Modifying the System Assigned to a Duct**

1. Select the duct segment.
2. Click Duct tab ➤ Modify panel ➤ Duct Modify .
3. In the Modify Duct dialog, select a new system from the System drop-down list.

**Breaking or Merging Duct Segments**

You can break or merge duct segments. You can also choose to have duct segments broken automatically as you draw them.

To apply a single break at a specific location in an existing duct segment

1. On the command line, enter break.
2 Select the duct segment you want to break.
3 Enter f (first point), and specify the location of the first break on the segment.
4 Enter @ to specify the location of the second break as the same as the first.
   This applies only one break to the segment, and it maintains connectivity between the new segments.

To break or merge multiple duct segments

5 Select the ducts to break or merge, and click Duct tab ➤ Modify panel ➤ Duct Length.

6 In the Duct Length dialog, specify the operation:

<table>
<thead>
<tr>
<th>To…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>apply the length to the entire run</td>
<td>select Apply to Duct Run.</td>
</tr>
<tr>
<td>manually select duct segments to modify</td>
<td>click (Select Objects), and select specific segments to break or merge.</td>
</tr>
<tr>
<td>break a segment</td>
<td>select Break, and enter a value for Duct Length. You can also click (Pick Length), and specify a start and endpoint for the new length.</td>
</tr>
</tbody>
</table>
To... then...
merge multiple segments select Merge, click the Select Object icon, and select the segments to merge.

NOTE When merging segments, you cannot cross fittings to join segments.

### Modifying the Size or Subtype of a Duct Fitting

1. Select the duct fitting, and click Duct Fitting tab ➤ Modify panel ➤ Duct Fitting Modify.
2. In the Modify Duct Fitting dialog, modify the fitting:

<table>
<thead>
<tr>
<th>To modify...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the part subtype (for example, change a mitered elbow to a smooth radius elbow)</td>
<td>click the Part tab. In the part type folder, select a different part subtype.</td>
</tr>
<tr>
<td>the part size</td>
<td>click the Part tab, and select a different part for Part Size Name.</td>
</tr>
<tr>
<td>the type or size of the connection points</td>
<td>click the Part Filter tab, and then modify the values for each connector.</td>
</tr>
</tbody>
</table>

NOTE You cannot change the type of part, for example, change an elbow to a tee. To replace the part with one of a different type, erase the part and add a new one.
Modifying the Takeoff Position of a Duct Fitting

1. Click Duct Fitting tab ➤ Modify panel ➤ Duct Fitting Properties.

2. In the Duct Fitting Properties dialog, click the Takeoff Position tab.

**NOTE** The Takeoff Position tab is only available for takeoff duct fittings added to the drawing.

**Takeoff Position tab in the Duct Fitting Properties dialog**

On this tab, you can:

- Move the takeoff along or across a duct segment
- Specify a location by selecting an offset distance and position based on the start point and endpoint of the duct segment
- Relocate the takeoff to a different side of, or angle around, the duct segment
- Specify a new rotation angle, or flip the fitting based on the X, Y, or Z axis
Modifying the Layout of a Spline Flexible Duct

You can modify the layout of a flexible duct run drawn using the spline vertex editing mode on the command line. A vertex is the location where spline segments meet.

**NOTE** If you drew a flexible duct run using the line or arc segment mode, you can modify the layout with the AutoCAD® Modify commands or grips.

1 Select the spline flex duct.

2 Click Duct Flex tab ➤ Modify panel ➤ Flex Duct Modify .

3 On the command line, enter v (edit Vertex) to invoke the vertex editing option.

4 Enter n (Next) or p (Previous).

   The active vertex switches between the next or previous vertex in the direction that the flex duct was drawn. Depending on the location of the active vertex, one or both of the options are available.

5 Edit the vertex layout on the command line as follows:

<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>change the tangent of the start or end segment</td>
<td>Enter t (Tangent) and then specify a start tangent. Start or end vertex must be active for this option to be visible.</td>
</tr>
<tr>
<td>connect a flex part to another part</td>
<td>Enter c (Connect) and select a part to which to connect. Start or end vertex must be active for this option to be visible.</td>
</tr>
<tr>
<td>move a vertex</td>
<td>Enter m (Move), and then drag the vertex to the new position.</td>
</tr>
<tr>
<td>remove a vertex</td>
<td>Enter r (Remove).</td>
</tr>
<tr>
<td>insert a new vertex</td>
<td>Enter i (Insert). Click to specify the insertion point of the new vertex.</td>
</tr>
<tr>
<td>update the view based on your changes</td>
<td>Enter g (Regen).</td>
</tr>
</tbody>
</table>
then…
exit the vertex mode Enter x (Exit).

6 (Optional) In the Modify Flex Duct dialog, modify other flex duct properties.

Moving an Off-Center Takeoff

You can move an off-center takeoff along or across a segment. You can also relocate the takeoff to a different side of, or angle around, the segment.

1 (Recommended) Change to a 3D view of your model.
2 Select the takeoff, and click Duct Fitting tab ➤ Modify panel ➤ Duct Fitting Properties.
3 In the Duct Fitting Properties dialog, click the Takeoff Position tab.
4 Modify the position:

<table>
<thead>
<tr>
<th>To change the…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>side of the duct to which the takeoff is attached</td>
<td>click the Side cell, and select a new side: center, top, bottom, left, or right.</td>
</tr>
<tr>
<td>justification on page 160 of the takeoff’s position</td>
<td>click the Justification cell, and select a new justification (center, top, bottom, left, or right), depending on the specified side.</td>
</tr>
<tr>
<td>off-center distance</td>
<td>click the Offset cell, and enter a number for the distance.</td>
</tr>
<tr>
<td>position along the length of the segment</td>
<td>click the From cell, select Start, Mid Point, or End, and then click the To cell, and select Starting Edge, Center, or Ending Edge to specify a direction from which to calculate the new position. Click Distance, and enter a number for the distance.</td>
</tr>
</tbody>
</table>
To change the rotation axis of the takeoff, select Flip X, Flip Y and/or Flip Z to change the rotation of the takeoff along the duct segment. Depending on the selected axis and the current position of the takeoff, the display of the takeoff may not change.

Modifying a Custom Fitting

A custom fitting tends to be highly specific and is generally a 1-time-use part. You modify a custom fitting using various AutoCAD commands, as noted below:

- **EXPLODE command:** When you initially explode a custom fitting, it is converted to the active view block. Exploding the custom fitting a second time converts the block to its associated linework.

- **ERASE, MOVE, ROTATE and ROTATE3D, and SCALE commands** break system connections.

- **COPY, MIRROR, OFFSET, and ARRAY commands** maintain custom fitting part properties and property sets.

Modifying Turning Vanes

You can access turning vane information for duct fittings. You can also remove vanes either from all fittings or from selected fittings.

To access turning vane information and enable vanes for duct fittings

1. Select a fitting where you want to add vanes.
2. Click Duct Fitting tab ➤ Duct Vanes panel ➤ Add Vanes.
   
   The vane graphic is added to the fitting style.

**NOTE** You cannot change the number or layout of turning vanes once they are added to a fitting. For more information, see Adding Turning Vanes to Fittings on page 314.
3 Select one or more fittings.
4 Click Duct Fitting tab ➤ Modify panel ➤ Duct Fitting Properties.

5 In the Duct Fitting Properties dialog, click the Vanes tab.

To enable vanes, select Enable Vanes.

To remove vanes from all fittings of the same size and subtype
1 Select a fitting.
2 Click Duct Fitting tab ➤ Duct Vanes panel ➤ Remove Vanes.

To remove vanes from selected fittings only
3 Select one or more fittings.
4 Click Duct Fitting tab ➤ Modify panel ➤ Duct Fitting Properties.
5 In the Duct Fitting Properties dialog, click the Vanes tab.
6 Deselect Enable Vanes.
Changing Insulation or Lining on a Duct or Fitting

You can add or modify insulation or lining (or both) to duct segments and duct fittings in a duct run.

**NOTE** Insulation and lining are treated as annotation only. You can only view insulation and lining on duct displayed as 2-line.

1. Select one or more duct segments or duct fittings, and if the object selected is a...
   - Duct: click Duct tab ➤ Modify panel ➤ Duct Properties.
   - Duct Fitting: click Duct Fitting tab ➤ Modify panel ➤ Duct Fitting Properties.
   - Duct Flex: click Duct Flex tab ➤ Modify panel ➤ Flex Duct Properties.

2. Click the Lining and Insulation tab.

3. Specify the change:

<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>add insulation</td>
<td>select Apply Insulation, and specify a value for Thickness.</td>
</tr>
<tr>
<td>modify the insulation thickness</td>
<td>specify a new value for Thickness.</td>
</tr>
<tr>
<td>add lining</td>
<td>select Apply Lining, and specify a value for Thickness.</td>
</tr>
<tr>
<td>modify the lining thickness</td>
<td>specify a new value for Thickness.</td>
</tr>
<tr>
<td>remove insulation or lining</td>
<td>deselect Apply Insulation or Apply Lining.</td>
</tr>
</tbody>
</table>
You can also add insulation or lining automatically as you draw duct runs. For more information, see Applying Insulation or Lining on Duct on page 286.

### Checking Connectivity in a Duct System

Several methods are available to check connectivity of the duct systems in your drawings. Checking connectivity is useful if you encounter conflicts when modifying a duct system.

Choose an action below to check connectivity for a duct system:

<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>show solution tips on all systems</td>
<td>Click View tab ➤ MEP View panel ➤ Show Solution Tips. All disconnects are highlighted in red. For more information, see Showing Solution Tips on page 862.</td>
</tr>
<tr>
<td>check connectivity between adjacent parts</td>
<td>select a part, and click [Duct/Duct Flex/Duct Fitting] tab ➤ Modify panel ➤ Show Connected Objects drop-down ➤ Show Connected Objects.</td>
</tr>
<tr>
<td>check connectivity on a duct run</td>
<td>select a part in the run, and click [Duct/Duct Flex/Duct Fitting] tab ➤ Modify panel ➤ Show Connected Objects drop-down ➤ Show Connected Run.</td>
</tr>
<tr>
<td>check connectivity among duct branches</td>
<td>select a part, and click [Duct/Duct Flex/Duct Fitting] tab ➤ General panel ➤ Select System drop-down ➤ Select Connected Branches. Press Tab to cycle through the connected upstream and downstream branches.</td>
</tr>
</tbody>
</table>

### Modifying a Label

After you place a label in the drawing, you can apply a new style, change the spacing along the object, or change how it is displayed. You can use grips to add or remove individual labels from an object, or offset a label from the object.
A label updates dynamically if the object to which it is attached is modified. For example, if the size of the duct is modified, the associated label reflects the change in size.

**To modify a label using grips**

1. Select a label to view the available grips.

<table>
<thead>
<tr>
<th>To...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>add a label</td>
<td>click the <em>Add</em> on page 264 Label grip. Hold down <em>CTRL</em> while clicking to add labels at even spacing.</td>
</tr>
<tr>
<td>remove a label</td>
<td>click the Remove Label grip. You can remove individual labels regardless of the method used to add the labels.</td>
</tr>
<tr>
<td>move a label</td>
<td>click the <em>Location grip</em> on page 265 and move the label to a new location along the curve. Press <em>CTRL</em> after clicking the Location grip to offset the label from the curve.</td>
</tr>
<tr>
<td>add labels spaced at a specific distance along a curve</td>
<td>click the Repeat Distance grip, and click along the curve to specify a distance from the beginning of the curve to the selected point. Labels are added along the curve, and are spaced at this distance.</td>
</tr>
</tbody>
</table>
To modify a label using the ribbon:

1 Select a label and do one of the following:

<table>
<thead>
<tr>
<th>To...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>space multiple labels evenly along a curve</td>
<td>Hold down \textit{CTRL} and click the Repeat Distance grip.</td>
</tr>
</tbody>
</table>

2 To modify the layout method or label style, double-click a label.

3 On the Properties palette, expand General, and for Style, select a new label style.
NOTE  The configuration of the label curve style determines whether labels that use the style are considered annotative (scaled accordingly when the annotation scale changes). For more information, see Annotative Objects on page 815.

4 Expand Dimensions, and select a new layout method:

To display the labels... select...

| one at a time    | One by one. |
| evenly spaced along the curve | By quantity, and enter a value for Number of labels. |
| with a repeated spacing value | By distance, and enter a value for Distance between. |

RELATED To modify tags and schedules, see Creating Construction Documents on page 813.
Drawing Piping Systems

This section offers instructions on how to use AutoCAD MEP to design and draft mechanical piping systems for a building plan.

Pipe Systems Overview

Pipe system engineers design parallel and gravity-based pipe systems that range in size and complexity. With AutoCAD MEP, you can define piping specifications, routing preferences, and system definitions that the software can use when laying out the pipe run. You can adjust the layout based on routing solutions that the software generates. You can also annotate the system as you place pipe objects and other equipment and then generate accurate construction documents from those drawings.

Workflow for Designing a Pipe System

Review the steps

1. Set up a project and open a drawing.
2. Create a preliminary 1-line conceptual design.

View more information

Specify standards for pipe systems. Attach the drawing to an architectural floor plan as an external reference. See Working with Projects on page 199.

Prepare a conceptual design for evaluation by code officers and senior engineers. See About Schematic Diagrams on page 772.
Review the steps

Specify the pipes and fittings to be used as you draw a pipe run.

Define piping design specifications for AutoCAD MEP to use when laying out the pipe run. See Configuring Routing Preferences on page 411 for an overview and Configuring Routing Preferences on page 411 for more information.

Specify system definitions for chilled water or steam systems, size ranges, and display properties.

Define the look of your piping layouts. See Configuring System Definitions on page 414 for an overview and Configuring System Definitions on page 414 for more information.

Add boilers, chillers, pumps, heat exchangers and other equipment.

Place equipment in a drawing. See Adding Pipe Equipment on page 427 for more information.

Connect equipment along pipe runs and layout the pipe system (sloped or non-sloped).

Configure pipe settings and pipe layout preferences, and apply routing solutions. See topics under Adding Pipe on page 429 and Using Routing Solutions to Connect Objects on page 450. See Drawing Sloped Piping on page 455 to layout gravity-based pipe systems.

Modify the pipe layout.

Refine portions of the existing layout. See topics under Modifying a Piping System on page 466.

Generate construction documents.

Annotate the system as you place objects. Then, create construction documents. See Creating Construction Documents on page 814.
Pipe Routing Preferences

You use routing preferences to draw accurate pipe systems in auto layout on page 370. Pipe routing preferences specify which pipe part to insert as you lay out the pipe run. Couplings are inserted at the proper pipe length and at break points on page 438 in the pipe run. Routing preferences meet design standards and specifications and contain the pipe parts (pipes and fittings) used to lay out your pipe run.

A pipe part routing preference includes one or more size ranges on page 412 for pipe parts and fittings, such as elbows, tees, laterals, and transitions. The software organizes the size ranges based on nominal pipe diameters. You can use pipe parts and fittings in a specified size range as you lay out the pipe run. The following example shows the routing preferences for Glued. Notice that the available Pipe parts are organized based on material type for US Imperial and US Metric profiles.

Routing preferences, showing parts organized based on material type

Multiple size ranges provide more flexibility in your piping designs. For example, assume a design specification for a chilled water system requires
commercial steel pipe with threaded connections for all pipe sizes 3" and lower. The system also specifies commercial steel pipe with 150 class, weld neck, flange connections for pipe sizes 3 1/2" and higher.

When you configure a routing preference for a particular specification, the appropriate fittings are automatically inserted into the piping layout. Auto layout on page 370 can generate different routing solutions, and prompts you to select the best alternative.

Pipe run drawn using a particular routing preference (Top view, Mechanical - Pipe by Size display configuration)

Pressure Pipes and Gravity Pipes

AutoCAD MEP includes routing preferences for pressure pipes (horizontal or vertical piping designs) and gravity pipes (sloped piping on page 373). For example, the software inserts laterals or angled tees, when appropriate, in auto layout on page 370. The following lists a sampling of each:

Pressure pipe (US Imperial profile):
- Butt welded
- Grooved and threaded
- Slip on flanged - 150 lb. and threaded
- Threaded 2000 lb.

Gravity pipe (US Imperial):
- Cast Iron soil pipe (bell and spigot)
- Cast Iron soil pipe (no hub)
- Duct iron mechanical joint
High-density polyethylene (HDPE)
Sanitary drain, waste, vent

RELATED For more information, see Configuring Routing Preferences on page 411 and Adding Pipe from the Tool Palette on page 429.

Size Ranges in Routing Preferences
Pipes and fittings in a size range must have common nominal sizes in a routing preference that you can use in a pipe run. The following conditions apply to size ranges:

■ The lower limit of a size range (shown in Size Upper Limit) is set to the smallest size in common with all the selected parts. However, if you create a size value for a mid-size range that is less than the higher limit of the previous size range, the mid-size range value automatically moves to the previous size range. For example, if you set a value of 3 in size range 2, but that value is less than what is in size range 1, size range 2 becomes size range 1 and size range 1 becomes size range 2.
■ The list of available sizes for the upper limit of the size range (Size Upper Limit) is filtered to include only the sizes that are common to all of the selected parts.
■ The available range of sizes for the selected part is displayed for the part.

For example, when creating a routing preference, you select a pipe with sizes that range from 1/8” to 60” and an elbow with sizes that range from 1” to 24”. Because the lower limit of the size range is set to 1”, you can select an upper limit as high as 24”.

NOTE The size ranges in the routing preference definitions in drawings created with Autodesk Building Systems 2007 were not validated by the software to ensure the selected parts had nominal sizes in common within the specified range. When you open these drawings in AutoCAD MEP, they are validated. However, the validation might reset some of the upper limits to different sizes, and reset some of the parts to *NONE*.

Size range details appear on the Properties palette on page 420 when you add a pipe segment to a pipe run. The nominal sizes are grouped based on the size ranges for the selected routing preference.
Auto Layout

In new pipe runs, you lay out the pipe geometry by specifying points in the drawing. You control how the pipes, fittings, and transitions are automatically inserted based on what is specified in the current routing preference. The following examples illustrate how auto layout works.

The user moves the cursor at a 90 degree angle to the pipe segment.

A 90 degree elbow is automatically inserted after the point is specified.

Various AutoCAD MEP tools work with auto layout in pipe runs. For example, you can specify an angle using the compass. The angles configured in the elbow content determine the available auto-layout angles. Tracking lines align a component with another object or line. Object snaps connect to pipe objects or to a geometric point on an object or line.

Auto layout can generate sloped piping on page 373 layout solutions for gravity-based pipe systems based on points in the drawing. For example, auto layout determines whether to insert a transition. If so, the angle of deflection is equally distributed between female connectors on a fitting that supports sloped piping. If you set the slope value on the Properties palette on page 420 to 10 (degrees), and the pipe object has 2 female connectors, then each connector can have an angle of deflection of 5 degrees each. The value cannot exceed the stored angle of deflection (AoD) value on the part.
Routing Solutions

When you connect one object to another at different elevations or slopes, or connect objects whose centerlines are not aligned, the software can generate routing solutions with different combinations of fittings or joints. You can step through a preview of the generated routing solutions and accept the layout that satisfies your design requirements on the command line.

**Command line**

```
Next point or [Routing preferences/Systems/Size/look size/Tolerance
c Moffat/justification/compass/Plan/rot/face/Slope/Match/Extr
run/preferences]:
Connect or preview Next solution 1<10>. [Accept/Next/Previous/number/Undo] <Accept>:
```

**RELATED** For more information, see Using Routing Solutions to Connect Objects on page 450.

**TIP** To accurately preview routing solutions, especially those at different elevations or slopes, use a workspace configured for 2 viewports. For example, you can work in plan view in one viewport and isometric in the other. You can also use the 3D Orbit view while you preview routing solutions.

If none of the routing solutions presented on the command line are satisfactory, select one that most closely matches your requirements and then use grips to modify the layout.

The following example describes how routing solutions work when connecting a pipeline to a chiller. The pipeline is on a different elevation, and the end of the pipeline is not in line with the chiller connection. You select the last pipe segment, and click (Add grip on page 385) on the open end. You move the cursor to the chiller connection, and then click the pipe end connector.

The second viewport is set to an isometric view to preview routing solutions.
In this example, 2 routing solutions are generated. Each routing solution is based on the fittings in the current routing preference. The angles are determined by the allowable angles in the selected elbow. You preview the routing solutions and select the most suitable layout.

First routing solution

Second routing solution

Guidelines for Constrained Layout Solutions

Constrained layout solutions intelligently connect one pipe object to another in sloped on page 373 (gravity-based) or non-sloped (pressure-based) pipe
systems, even if the 2 pipe segments are at different elevations. AutoCAD MEP achieves constrained layouts based on the following guidelines:

- Horizontal routing solutions are supported when you connect 2 objects at different elevations.
- New vertical segments added to a pipe run remain vertical to the current user coordinate system (UCS).
- If you select Yes for Use fitting tolerance on the Pipe Properties palette on page 420 and the joint supports angle of deflection (AoD) on page 405, that angle of deflection is distributed equally between the female connectors on the pipe object. However, the value cannot exceed the stored angle of deflection value on the part.

**NOTE** As you lay out your pipe design, the software displays the actual slope value for the current pipe segment in constrained and unconstrained layouts. For more information, see Slope Value Displayed in Piping Layouts on page 375.

**Sloped Piping**

The sloped piping feature in AutoCAD MEP expands catalog content and pipe fitting routing preferences. Sloped piping supports gravity-based piping designs for sanitary drain, waste, vent, and sewer/storm drainage systems. For example, you can lay out the main of a drainage system with a 1/4" per foot slope and connect several branches with different slope angles based on the distance and height from the main. The system can generate possible layout solutions for sloped systems based on points you specify in the drawing, the slope value, and the allowable angle of deflection on page 405 for the pipe fitting used.

Sloped piping layouts model real-world piping requirements. Fittings are inserted based on the orientation of the pipe segment. As a result, pipes fit flexibly into couplings. AutoCAD MEP rotates the orientation of an elbow (or other fitting) around the attached point based on the centerline of the sloped pipe. The software lays out pipe and fittings with a horizontal slope and transitions between sloped and vertical pipes eliminating the need to manually calculate angles.

AutoCAD MEP applies slope in the Z direction of the current user coordinate system (UCS) in a drawing. You create sloped piping systems using elbows, tees, wyes, or other fittings that connect an angled segment to a horizontal
segment. The next example shows a rise/run ratio of 3/10 for the sloped segment where the elbows are rotated to accommodate the slope value.

*Sloped segment perpendicular to horizontal segments (front view)*

You can create slopes in straight runs if you have the appropriately angled fittings. The next example shows a 45-degree elbow connecting a 45-degree sloped segment to horizontal segments.

*Sloped pipe segment (side view)*

AutoCAD MEP supports the design of sloped connections by using wyes (laterals) or angled tees to connect a branch to a main. It inserts angled tees/wyes at the correct orientation to connect a sloped branch to a sloped main. You can also choose an eccentric reducer (with different diameter openings at each end with different centerlines) or a concentric reducer (with different diameter openings at each end with the same centerline).

*Auto Layout* on page 370 can generate routing solutions on page 371 for sloped piping systems based on points in the drawing. You can draw sloped piping layouts if the current routing preference supports angle of deflection on page 405 (allowable fitting tolerance). As you draw pipe, you can use sloped pipe-related properties on the Properties palette on page 420. For example, the Use fitting tolerance property turns on angle of deflection on a joint if the current routing preference supports angle of deflection. As you lay out the pipe run, you can set a slope value on the Properties palette and the slope format on the General tab in the Pipe Layout Preferences on page 433 dialog.

You can also set Joint direction. Joint direction determines how male and female connectors are oriented in *auto layout* on page 370. For example, if you select male into female, the male connector is placed first, then the female connector after the joint.
If you are routing pressure piping on page 368, you can increase the software response time by doing the following: specify No for Use fitting tolerance, specify the desired angle for Bend angle, and specify the preferred Branch fitting. This helps the software generate more directed auto-layout routing solutions on page 371 based on specific settings.

**Slopes Supported by Gravity-Based Piping Systems**

The gravity-based pipe tools on the Gravity Pipe tab on page 429 support sloped piping designs for drain, process drain, sanitary, sanitary vent, and storm systems in the following slopes:

- 1/8” per foot
- 1/4” per foot
- 1/2” per foot

**Slope Value Displayed in Piping Layouts**

The software displays the current slope value of a pipe segment as you draw the run. Slope value appears in both constrained layouts (pipe drawn between 2 existing pipe objects) and unconstrained layouts (pipe drawn from a pipe object to a point in space). This information is especially useful when routing solutions on page 371 are generated, as illustrated next.
A pipe segment can have a slope value specified on the **Pipe Properties palette** on page 420, or it can have a different slope depending on a particular routing solution that is used. The immediate visual indicator tells you exactly what solution is used and the associated slope value. To turn off this feature, enter `PipeSlopeDisplay` on the command line. Then enter `n` at the next prompt.

**RELATED** To lay out sloped piped designs, see **Drawing Sloped Piping** on page 455.

### Pipe System Definitions

Pipe system definitions specify display information, such as pipe display by size, layer key settings, rise/drop display style, and other display properties. You typically associate a system definition to a type of pipe system, such as chilled water or steam. The settings for a system definition control many of the display properties of a pipe system. You assign a layer key style to a system definition. This designation dictates the layer, color, and linetype for the system. You can also configure a system definition to display pipes as 1-line or 2-line by size.
You can assign a system definition to a system group. In the software, pipe runs that have different system definitions cannot connect to each other without changing the system for the connecting pipe run. You can, however, assign a system group to different system definitions. This allows pipe runs from different system definitions to connect while maintaining the same system for each run. For example, you can assign the same system group to Heating Hot Water - Supply and Heating Hot Water - Recirculation. You then can connect pipe runs between these 2 systems while maintaining their original system settings.

The default templates include many pipe system definitions, such as chilled water, heating hot water, and steam. Pipe system definitions are stored with a drawing. You can use different system definitions for different drawings, and you can share system definitions between drawings.

Pipe System Displays

Pipe systems can be displayed as 1-line on page 378, graphical 1-line display on page 379, 2-line on page 380, or single line graphic on page 415. Each variation refers back to the actual location in the 3D model.

You do not need to specify a pipe system as 1-line or 2-line. You only need to create a system on page 141 once using parts, such as pipe segments and fittings. The parts in the pipe system maintain their properties (such as part type, size, and connection type) whether they are displayed as 1-line or 2-line. You can use display configurations and system definitions to control the 1-line or 2-line displays of the pipe system. You can switch a display configuration in a drawing to 1-line or 2-line. To use a combination of 1-line and 2-line displays based on nominal pipe size, use a system definition for the pipe system along with the appropriate display configuration for the drawing.

You can combine graphical 1-line, 1-line, or 2-line displays in the same drawing. You can use 1-line displays to create preliminary layouts, allocate space, or show a simpler view of a system in a complex drawing. For plotting purposes, you can also combine 2-line, 1-line, and graphical 1-line displays in the same drawing. You can display large diameter pipe systems as scaled 2-line, medium diameter systems as scaled 1-line, and small diameter systems...
as graphical 1-line. In the following illustration, the larger diameter systems appear as 2-line and smaller systems as 1-line.

**TIP** The 1-line display is not the same as a schematic display. In a 1-line display, the layout does represent the actual geometry and location of all pipeline components. Whether a pipeline is displayed as 1-line or 2-line, it still contains all the defined pipe properties, such as size and system. You can also view 1-line or 2-line displays in isometric views.

**RELATED** For more information, see Configuring System Definitions for 1-Line, 2-Line, or Single Line Graphics on page 415 and Configuring Graphics for Single Line Pipe Display on page 417.

**1-Line Display**

You use 1-line displays for annotation of construction documents. The fittings and connections in a 1-line pipe system display at their actual envelope dimensions. In-line and anchored components, such as valves, appear as scaled 1-line and MvParts on page 110 as scaled 2-line.

The following example shows fittings, such as tees, elbows, and reducers, representing their actual envelope dimensions. A gate valve and a check valve appear as scaled 1-line components and the pump as scaled 2-line.
Graphical 1-Line Display

The graphical 1-line display shows a generalized routing of a pipe system, using non-scaled components. It displays equipment as schematic symbols but does not show a fitting or joint type. The sizes of components and equipment symbols are related to the physical model location but not to their actual dimensions.

The following example shows a natural gas line and hot water line connected to a boiler. The pipe lines and their in-line components, including valves, reducers, a pressure regulator, and a pressure gauge, display as 1-line symbols. The boiler displays as a scaled 2-line component. The gas line uses threaded connections, while the hot water line uses soldered connections. The connection types are indicated on the fittings.

Using a 1-line or 2-line display to plot a large pipe system, the fittings and equipment on smaller pipe runs might not render well because they are so small compared to the size of the entire system. If you use the graphical 1-line display for smaller diameter pipe systems, the fittings and equipment symbols plot at a specified size.

Graphical 1-line does not alter the components in the system. Pipe components still contain the defined properties, such as size, type, and system, and can be changed to display as scaled 1-line or 2-line.

2-Line Display

A 2-line display shows pipe components as scaled 2-dimensional objects. In isometric views, the objects display as 3-dimensional objects. Fittings and equipment are displayed based on the contours of their physical geometry. Typically, larger diameter pipelines are displayed as 2-line to allocate space or check interference with surrounding objects.

Straight Centerline Display of Elbows

Pipe standards and companies use straight centerlines in 1-line, 2-line, model, and plan displays to accurately represent the location of the intersection of an elbow. Pipe designs typically determine the centerline path. Wastewater piping contractors and fabricators use straight centerlines to guarantee accuracy in process piping installations and fabrication drawings.

The centerline display of elbows in AutoCAD MEP is based on the path and orientation of connectors 1 and 2 on the elbow on page 994. The centerline display typically follows the path of the curve and is generated in all orthographic and model views.

The following example shows a straight centerline of elbows on a pipe in 2-line display. One elbow is 45 degrees and the other is 90 degrees.
NOTE You can control the centerline of display of elbows on page 419 and store your display results in a drawing in the Piping, Electrical, or HVAC domains.

Placeholder Parts

Placeholder parts are 1-line dimensionless parts used for preliminary designs. When you draw systems with placeholder parts, the software inserts segments and fittings at appropriate points like other pipe types. You can convert placeholder parts to any other part type, such as commercial steel or copper tubing.

To draw a system with placeholder parts, configure a routing preference on page 411 using placeholder parts in the default part catalog. The default Aecb Model drawing template includes a placeholder routing preference. Draw systems just as you would for any other pipe type. To convert the placeholder parts to other parts, modify the part subtype as explained in Modifying the Routing Preference and Nominal Size on page 478 and Modifying a Pipe Fitting on page 483.

Pipe Parts Catalog

The pipe parts catalog contains pipe parts in thousands of sizes. The Piping domain includes the following part types:

- Connector
- Coupling
- Cross
Elbow
Endcap
Offset wye (lateral)
P-Trap
Takeoff
Tee
Transition
Wye
Undefined

Pipe parts catalogs are organized differently, depending on the profile in which you run AutoCAD MEP. Catalogs in the US Imperial and US Metric profiles are organized based on material type:

- Cast iron
- Copper
- Ductile iron
- Plastic
- Steel

Fittings in these categories are grouped by connection type (such as threaded). The following example shows the cast iron parts catalog.
Pipe parts catalog for cast iron pipe parts

Catalogs in the Global profile are organized by type and outside diameter, as follows:

- Commercial pipe: Pipe and fitting dimensions based on commercial steel pipe; also includes plastic pipes, such as PVC.
- Ductile iron: Pipe and fitting dimensions based on commercial iron pipe
- Tube and fitting dimensions based on copper tubing
- **Placeholder** on page 381: Dimensionless 1-line parts used for preliminary pipe runs; can be converted to other pipe types

The following example shows the pipe MvParts catalog under the Mechanical chapter.
Each pipe directory in the Global profile consists of fittings common to that pipe type. Pipe fittings are typically classified by part type, connection type, and pressure rating. The next example shows a directory structure for a class 3000 socket weld coupling.

**Couplings under Pipe catalog**
Pipe fittings and connectors, unlike pipe segments, have specific connection types. Pipe connectors, such as flanges, are treated as separate objects in the actual construction. For example, when a flanged elbow is connected to a pipe segment, a separate flanged connector is added to the pipe segment. You can account for all the connectors in the system and create schedules for them. The connector engagement length on page 404 (CEL) is also used to accurately represent pipe lengths and joint locations in the system.

**RELATED** See Pipe Length and Cut Length on page 406 and Connectors of a Parametric Part on page 994.

**Pipe Grips**

Grips are used to directly add or modify pipe objects or MvParts. All available grips are displayed when you select an object.

**Grips activated for a flanged tee (isometric view)**

**Add Grips**

Add grips ( ) on pipe segments, pipe fittings, and MvParts (as shown next) let you quickly add pipe objects, ensuring connectivity along the pipe run.
On a pipe segment

On a pipe fitting

On an MvPart (pump)

Used to draw pipe directly from a pump (isometric view)

Add grips on some fittings let you create a new branch directly from the fitting. For example, you can use an add grip on an elbow to convert it to a tee when drawing a pipe run. The existing pipe branches remain connected.
Grips for Modifying a Pipe Run

Various grips are available in AutoCAD MEP for modifying pipe objects in a pipe run.

Location Grips

Location grips let you move MvParts on page 110, fittings, or pipe segments in the current XY plane in a pipe run while maintaining connectivity (called associative movement). Location grips appear on the insertion and connector points on the part. When you move an MvPart to a new location, the pipe segments attached to that part can move, shrink, or stretch to maintain connectivity with the system. You can also move a pipe segment without affecting the location of MvParts or other portions of the pipe run.

RELATED  See Adding Pipe Using Add Grips on page 445.
Movement of a Pipe Segment

The following illustrations show how location grips are used to move a pipe away from a pump.
Location grip selected on pipe segment

New location specified

Resulting layout

The fittings connected to the pipe move with the pipe, but all other components in the run remain fixed in their original position. The elbows connected to the pipe move with it, and the length of the pipes connected to the elbows changes. The system remains connected.
Movement of a Pipe MvPart

The following illustrations show how location grips are used to move a pump MvPart. The pipes and fittings move with it, but all other components in the run remain fixed in their original position.
Location grip selected on MvPart

New location specified

Resulting layout

**RELATED** See [Moving Pipe Components Using Location Grips](#) on page 470.
Elevation Grips

Elevation grips ( ▲ ) let you modify the elevation of parts and pipe segments in the model view, relative to the top, centerline, or bottom of the segment.

If the pipe segment or part is connected to other objects, you can specify whether to maintain their connectivity when you modify the elevation of the pipe object on page 471.

**NOTE** Elevation grips are not available on flexible or sloped pipe segments. You modify the elevation of the starting point of a flexible pipe segment using the Properties palette on page 466. You modify sloped pipe segments by adjusting the elevations of connected fittings.

The following example modifies the elevation of a pipe segment. To provide more room for accessing the valve hand wheels, a horizontal pipe segment is raised by a dimension relative to its current elevation. As a result, the software adjusts connected objects and maintains connectivity.
Modifying the elevation of a pipe

select pipe segment

select Elevation grip
Flip and Rotate Grips

Arrow-shaped (🪝) flip grips let you rotate piping in-line parts, fittings, and takeoffs 180 or 90 degrees in the direction indicated by the grip.

RELATED See Modifying the Elevation of Pipe Components on page 471.
Rotating a 3-way valve 90 degrees in plan view

In isometric views, diamond-shaped ( ) rotate grips let you rotate the object around its centerline to any angle you specify.

AutoCAD MEP displays flip grips on piping in-line parts, fittings and takeoffs with connectors on opposite ends. However, when necessary to preserve the connectivity of pipe runs, the software limits the available rotation options or hides the grips. For example, you can rotate a wye fitting on the left in several ways, but you cannot rotate the wye fitting on the right due to the connected branch.
When you rotate a part, fitting, or takeoff that is connected to other objects, the software adjusts the connected objects to maintain connectivity. For example, the software might slightly adjust the lengths of connected pipe segments after you have flipped a fitting. If it cannot adjust the objects, it disconnects them.

**RELATED** See Rotating Pipe Components on page 473.

## Lengthen Grips

Lengthen grips let you modify the length of pipe segments (▶). Lengthen grips constrain a segment to its current angle — particularly useful for lengthening pipe segments already placed.

When you use the lengthen grip on an end that is connected to another object, you can specify whether to maintain connectivity between the objects.

**Lengthen grips on pipe segments**

![Uncropped image showing lengthen grips on pipe segments](image)

The next illustrations show a pipe segment in a sprinkler system that is lengthened with grips. To avoid interference with a duct system, the software adjusts the connected objects to maintain their connectivity.
Selected pipe

Selected lengthen grip in edit mode

New length entered

Pipe Grips | 397
If the pipe segment is not connected to another object, you can change both its length and angle using the Start grip or End grip. These grips let you change the XYZ location of the start point or endpoint of the segment. This is useful when you initially design runs because it lets you connect a segment to an existing run.
NOTE When using lengthen grips, the lengthen value displayed in the dynamic dimension equals the pipe length but may not be the same as the cut length. For more information, see Pipe Length and Cut Length on page 406.

NOTE See Modifying the Length of a Pipe Segment on page 473.

Pipe Connections

Pipe connections model the components and construction of an actual piping system. Connectors attach pipe segments to joints, fittings, and MvParts on page 110. Separate joints, such as flanges and couplings, reflect actual construction components in schedules. Connector engagement length (CEL) is configured for parts to ensure accurate pipe lengths and joint locations.

Pipe Connectors

Connectors on pipe segments and fittings allow pipe objects (such as pipe segments, fittings, and pipe MvParts) to form an intelligent system. They are located at each end of the part, as shown next.

Pipe connectors

Connectors on grooved couplings, as shown next, are located inside the coupling at the CEL depth, due to the design geometry of the grooved coupling. Unlike other connection types, pipe ends insert into grooved couplings. As a result, cut length on page 406 with grooved connections are reported differently.
Grooved coupling connector locations

MvPart and fitting connectors are assigned a connection type. For example, a base-mounted pump has flange connection types assigned to its connectors, and a threaded coupling has a threaded connection type assigned to it. A connector on an MvPart behaves similarly to a pipe connector on a fitting or pipe segment.

RELATED For more information, see Male-Female Fittings and Joint Direction on page 403 and Recommendations for Creating Parametric Fittings Content on page 972.

Pipe segments do not have connection types assigned to their connectors. They do, however, inherit the connection type of the connected pipe fitting. For example, if a socket weld coupling is connected to one end of a pipe segment, the pipe connector on that end inherits the socket weld connection type. For more information, see Viewing Connection Details on page 172.

Connector Assignments

AutoCAD MEP determines the connectors on a pipe fitting or segment and adds the appropriate joints as specified in the pipe part routing preferences on page 367. The number of joints that the software adds depends on the
Connection type. The next illustration shows a pipe segment and fittings. The software determines the number of joints, as follows:

- #1 refers to a pipe segment with an undefined connection type.
- #2 refers to a grooved coupling with female connectors.
- #3 refers to an elbow fitting with male connectors and undefined connection types.

The pipe segment (#1) inherits the connection type from the female grooved coupling (#2). The connector on the elbow fitting (#3) inherits the connection type from the female grooved coupling (#2), as specified in the routing preferences.

**RELATED** For more information, see Rules for Connector Behavior on page 974.

### Connection Types for Pipe and Pipe Fittings

You assign connection types in the Connector Properties dialog as you build fittings content using the Content Builder (see Adding Connectors to a Parametric Fitting on page 1019). Assigned connection types are then displayed on the Connection Assignments tab on page 436 of the Pipe Layout Preferences dialog. The following table shows the different orientations of pipe connection types:

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Connection orientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flanged, all types</td>
<td>![Diagram of connection types]</td>
</tr>
</tbody>
</table>

Pipe Connections | 401
<table>
<thead>
<tr>
<th>Connection type</th>
<th>Connection orientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fitting to pipe</td>
<td>Flanges are typically included on fittings. A separate flange is added to the pipe segment. Pipe to pipe: A separate flange is added to each pipe end to create the connection. Fitting to fitting: Fittings with inherent flanges connect directly to each other. No separate flanges are added to the connection.</td>
</tr>
<tr>
<td>Threaded,</td>
<td></td>
</tr>
<tr>
<td>Socket weld,</td>
<td></td>
</tr>
<tr>
<td>Glued, Brazed</td>
<td></td>
</tr>
<tr>
<td>Fitting to pipe</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pipe segments typically have inherent male ends, and fittings are typically female. The pipe inserts directly into the fitting.</td>
</tr>
<tr>
<td></td>
<td>Pipe to pipe: A female coupling is inserted between the pipe segments.</td>
</tr>
<tr>
<td></td>
<td>Fitting to fitting: Fittings connect directly to each other.</td>
</tr>
<tr>
<td>Grooved</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fittings and pipe segments are considered to have grooved ends that are ready to accept a coupling. A coupling is added to connect the fitting and pipe.</td>
</tr>
<tr>
<td></td>
<td>Pipe to pipe: A coupling is added to connect the pipe segments.</td>
</tr>
<tr>
<td></td>
<td>Fitting to fitting: A coupling is added to connect fittings.</td>
</tr>
<tr>
<td>Butt weld</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No extra objects are added. Fittings and pipe segments connect directly to each other.</td>
</tr>
</tbody>
</table>

**NOTE** The Piping domain includes a connection type called Same Connection. When Same Connection is configured for a pipe object that is attached to a hub, connector 1 inherits the connection type of the connection type on connector 2 of the attached hub. For more information, see Rules for Connector Behavior on page 974.
Male-Female Fittings and Joint Direction

The Pipe parts routing preferences on page 367 include parts with male-female connections. These preferences specify which pipe part to insert as you lay out the pipe run. You specify the orientation of male and female joints using the Joint direction property on the Pipe Properties palette on page 420. For example, if you select Male into female, the male connector is drawn first and then the female counterpart is drawn after the joint. Auto layout on page 370 inserts parts in the pipe layout based on adherence to connector behavior rules on page 974. The proper male-female orientation of a fitting connection on page 994 is inherited based on its gender. Couplings are inserted at the proper pipe length and at break points on page 480 in the pipe run. The software can reverse the male to female orientation on a pipe run if necessary, allowing interconnections that reflect real-world scenarios.

The following examples illustrate male-female connections as you draw pipe and specify Joint direction in Plan view.

Non-sloped mechanical joint pipe
You can use Content Builder on page 964 to create custom parametric parts with male, female, or a combination of both types of connectors based on real-world piping requirements. For example, you can set the CEL (connector engagement length on page 404) values to match the actual depth of the connector. You also can set the AoD value (angle of deflection on page 405) to match the allowable fitting tolerance for the connector based on manufacturer specifications.

**RELATED** For more information, see Recommendations for Creating Parametric Fittings Content on page 972, Connectors of a Parametric Part on page 994, and Creating a Parametric Fitting with Content Builder on page 1009.

### Connector Engagement Length

Each fitting in the pipe parts catalog on page 381 includes one or more connector engagement length (CELn) values. CEL is the length of pipe on page 406 that is inserted into a fitting connection. CEL values are based on industry standards and are configured for all pipe fittings.

Except for couplings, pipe connectors on page 399 are located on the ends of pipe segments and fittings. In a drawing, the software depicts a pipe that is connected to a fitting as attached to the end of the fitting. However, in an actual pipeline, the pipe is inserted into the fitting.
Angle of Deflection (Fitting Tolerance)

Angle of deflection specifies whether to allow deflection at joints that have a tolerance angle. Angle of deflection includes female connection types with non-standard angles based on manufacturer and user requirements. Angle of deflection is stored in the catalog content and is only available for those female fittings that are supported in the manufacturer specification. To turn on angle of deflection for supported female fittings in sloped pipe on page 373 designs, select Yes for Use fitting tolerance on the Pipe Properties palette on page 420.

RELATED See Drawing Sloped Piping on page 455.

Pipe Joints

AutoCAD MEP treats pipe joints as objects that are separate from the pipe segment. For example, a pipe segment with flanged connections actually comprises 3 objects: 1 pipe segment and 2 flanges.

The software adds joints as you draw pipe, based on selections made under Routing Options on the Pipe Properties palette on page 420. Having joints presented as separate objects renders more accurate systems that reflect the physical construction of the pipe system. You can create schedules for joint components, such as flanges or couplings. You can also manipulate the joints by changing their connection type or by refining their location on a pipe run.
The software categorizes pipe joints as fittings in the *pipe parts catalog* on page 381. Fittings are listed in the couplings directory and the asymmetric connectors directory. An example of an asymmetric connector is a socket weld flange. One side of the flange is configured with a socket to connect with a pipe, and the other side is a flange face that will connect with an adjacent flange.

**Pipe Length and Cut Length**

The length of a pipe segment is accurately modeled using separate joints. Cut length on the *Properties palette* on page 466 is the actual length of the pipe and includes the depths needed to engage the flanges.

Cut length refers to the distance between connectors inside a pipe segment. The following diagram differentiates pipe length from cut length, based on CEL (connector engagement length) on page 404.
The reported cut length value varies depending on the connection type of the attached fitting. For example, with hub flange couplings, the software considers the overall length of the connected object including the coupling length. The following example shows how the software reports the cut length based on this scenario. The overall calculated length includes the pipe length plus the coupling length, as shown next.
Pipe length varies, depending on what is connected to the pipe. The following illustrations show various pipe examples.

The first illustration shows a pipe segment. The second illustration shows a flange joint added to the pipe segment. The overall length of the pipe and joint is the same as the original pipe. However, the pipe end is moved so that it is in the same location as the flange connector. The pipe length is reduced by the width of the flange, and the CEL (connector engagement length on page 404) for the flange is added to the length to calculate the cut length.

The third and fourth illustrations show other fittings connected to the pipe end. If a coupling is added, the midpoint of the coupling is located at the original pipe end location. The pipe end is moved to the adjacent coupling face. An elbow is added at the end of the pipe, and the pipe end stays in the same location. The pipe length stays the same, but the cut length increases because the elbow CEL is added to the length. For each of the connections shown above, the resulting pipe cut lengths vary from the original pipe length.

Joints and fittings have the following effect on pipe segments and cut length:

- When modifying pipe segments using *lengthen grips* on page 396 and dynamic dimensions, the dynamic length dimensions do not include CEL values.
- When working with a specific pipe length in a system, such as a stock length, adding or changing a fitting might affect the cut length of a pipe segment.
Pipe Snaps

Pipe snaps quickly and accurately connect pipe objects. As you draw a pipe, you can use pipe snaps to connect a pipe, fitting, or MvPart directly to a pipe end connector at the end of a pipe segment. You can also connect to pipe curve connectors at any point along a pipe segment.

Pipe end connector

Pipe curve connector

RELATED  For more information see Using AutoCAD MEP Snaps.

Pipe Elevation Lock

You can lock pipe elevation as you draw a horizontal pipe run.

By restricting the pipe run to a specific elevation, you can avoid unintentional snapping to another object at a different elevation. When you want to connect a horizontal run to a vertical segment, locking the elevation prevents the horizontal segment from snapping to one end of the vertical segment. It allows you to connect along the segment at the desired elevation. You can turn on the elevation lock for a portion of a pipe run, and turn it off for other portions
where you want to use different elevations. If the lock is turned on, you cannot connect to an object on a different elevation.

**NOTE** The locked setting automatically resets to the unlocked state after a current pipe add session is ended.

Consider a scenario where you are working in the top view. You attempt to connect a horizontal run to a riser. You configure 2 viewports in the drawing window. The top view is used in the left pane and an isometric view to the right to preview routing solutions. In the top view, only the pipe end connector is available on the riser.

If you select the pipe end connector, routing solutions are offered that do not connect the horizontal run to the riser at the correct elevation.

If you lock the elevation before selecting the pipe snap on the riser, you connect to the riser at the elevation of the horizontal run.
You can lock the elevation for a portion of a pipe run and unlock it for other portions where you want to use different elevations. If locked, you cannot connect to an object on a different elevation. Additionally, you cannot lock elevation on a sloped pipe on page 373 segment.

Configuring Pipe System Settings

Pipe tools include properties for configuring pipe runs and ensuring more accurate piping designs. Pipe system settings are stored with a drawing. You can have different pipe system settings for different drawings and can share them between drawings.

Configuring Routing Preferences

You configure pipe part routing preferences by specifying a size range, parts, and connections to use in a pipe run.

RELATED To create a new tool from a routing preference, see Creating Tools from Routing Preferences on page 1181.

Creating or Copying a Routing Preference

1 In the Piping workspace, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Routing Preference Definitions.

2 Create or copy a routing preference, as follows:

| If you want to ... | then in the left pane of Style Manager ...
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>create a new, blank routing preference</td>
<td>Right-click Pipe Part Routing Preferences in the left pane, click New, enter a name.</td>
</tr>
<tr>
<td>copy an existing routing preference</td>
<td>Right-click the routing preference in the left pane, and click Copy. Next, right-click Pipe Part Routing Preferences, and click Paste. Then, right-click the copied item, click Rename, and enter a name.</td>
</tr>
</tbody>
</table>
**Configuring Properties for a Routing Preference**

1. In the Piping workspace, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Routing Preference Definitions.

2. In the left pane of Style Manager, select a routing preference.

3. In the right pane, click the General tab, and configure the general properties:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>change the name of the routing preference</td>
<td>enter a new name.</td>
</tr>
<tr>
<td>add or change the description of the routing preference</td>
<td>enter a description.</td>
</tr>
<tr>
<td>add notes, such as a revision history</td>
<td>Click Notes. Click the Notes tab, and enter the information.</td>
</tr>
<tr>
<td>add a link to a reference document, such as a piping specification</td>
<td>Click Notes. Click the Reference Docs tab, and click Add. In the Select Reference Document dialog, browse to the document, and click Open. In the Reference Document dialog, enter a description of the document, and then click OK twice.</td>
</tr>
</tbody>
</table>

**Configuring Size Ranges**

1. In the Piping workspace, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Routing Preference Definitions.

2. Select a routing preference.

3. In the right pane, click the Preferences tab.

4. For Part, select a part type.
The part list contains all the unfiltered parts in the pipe catalog for the part type.

- If you select *NONE* for a part type during pipe layout, the software prompts you to choose a part during pipe layout if a part type is needed to satisfy the layout geometry.

- If you select a part without any sizes in common with one or more other parts, the other parts are reset to *NONE*, and you must make a new selection. In this situation, you are notified of the affected parts, so you can confirm or cancel the part selection.

5 To specify the upper and lower limits for a size range, do the following:

<table>
<thead>
<tr>
<th>If you want to specify</th>
<th>then ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the upper limit</td>
<td>select a size for Size Upper Limit. You can select from the list of</td>
</tr>
<tr>
<td></td>
<td>nominal sizes that are common to all of the selected parts in the size</td>
</tr>
<tr>
<td></td>
<td>range. If a subsequent size range exists, its lower limit is changed</td>
</tr>
<tr>
<td></td>
<td>based on the upper limit you selected for the current size range. If</td>
</tr>
<tr>
<td></td>
<td>you need to select a larger size than is allowed in the list of choices,</td>
</tr>
<tr>
<td></td>
<td>select different parts for the size range.</td>
</tr>
<tr>
<td>the lower limit</td>
<td>change the value for Size Upper Limit for the preceding size range.</td>
</tr>
<tr>
<td></td>
<td>The lower limit of Size Range 1 is always defined by the selected parts</td>
</tr>
<tr>
<td></td>
<td>in the range.</td>
</tr>
</tbody>
</table>

**TIP** You can switch the order of 2 size ranges by changing the upper limit of one range so that it is larger or smaller than the other.

6 Enter a description for the size range, if desired.

7 Add a range to designate a new size range.
The new size range is appended to the list of ranges. Its lower limit is the next catalog size up from the upper limit for the preceding size range, and its upper size limit is the largest catalog size.

8 To delete a range, select the name of the size range, and click Remove Size Range.

NOTE It is possible to create and save an invalid size range. For example, specifying an upper limit that is already in use by another size range could invalidate the size range. If a size range is invalid, *Invalid Size Range* is specified for Size Upper Limit in the routing preference definition, and the sizes in that range are unavailable nominal sizes on the Properties palette.

### Deleting a Routing Preference

1 In the Piping workspace, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Routing Preference Definitions.

2 In the left pane of Style Manager, right-click the routing preference you want to delete, click Purge, and then OK.

### Configuring System Definitions

Pipe system definitions specify display properties, such as pipe display by size, layer key settings, and rise/drop symbols and display style.

TIP The default templates contain several system definitions that you can copy or modify.

### Creating a System Definition

1 In the Piping workspace, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Piping System Definitions.
Choose an action below:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then in the left pane of Style Manager…</th>
</tr>
</thead>
<tbody>
<tr>
<td>create a new system definition</td>
<td>Right-click Pipe System Definitions in the left pane, and click New. Enter a name, and press Enter.</td>
</tr>
<tr>
<td>copy an existing definition</td>
<td>Right-click the system definition in the left pane, and click Copy. Next, right-click Pipe System Definitions, and click Paste. Then, right-click the copy, click Rename, enter a new name, and press Enter.</td>
</tr>
</tbody>
</table>

3 On the General tab, enter a description for the pipe system definition.

4 Specify values for other general properties that are common to other disciplines: mechanical, electrical, and plumbing. For more information, see Creating Systems on page 141.

5 Specify how to display pipes in the system. For more information, see Configuring System Definitions for 1-Line, 2-Line, or Single Line Graphics on page 415.

**Configuring System Definitions for 1-Line, 2-Line, or Single Line Graphics**

1 In the Piping workspace, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Piping System Definitions.

2 In the left pane of Style Manager, expand Piping Objects.

3 Expand Pipe System Definitions.

4 Select a system.
5 In the right pane, click the Single Line Graphics tab.

To specify 1-line

6 Choose an action below:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>display pipe and equipment as scaled 1-line</td>
<td>select Show pipe and inline/anchored components as Single Line displays. Then for pipe sizes less than or equal to, enter an upper limit diameter.</td>
</tr>
<tr>
<td>display pipe and equipment as graphical 1-line, not to scale, with equipment represented by schematic symbols</td>
<td>select Display pipe and inline/anchored components as graphical 1-line. For pipe sizes less than or equal to, enter an upper limit diameter. Then for inline/anchored MvPart plot length, enter a plot length.</td>
</tr>
</tbody>
</table>

To specify 2-line

7 On the Single Line Graphics tab, clear Display pipe and inline/anchored components as single line displays and Display pipe and inline/anchored components as graphical 1-line.

To specify single-line graphics

8 On the Single Line Graphics tab, select Display pipe and inline/anchored components as single line displays.
9 For pipe sizes less than or equal to, enter an upper limit diameter.
10 Select Display pipe and inline/anchored components as graphical 1-line.
11 For pipe sizes less than or equal to, enter an upper limit diameter.
12 Enter a plot length for inline/anchored MvParts.
13 For Single Line Graphics Style (connector graphics), select a style.

**TIP** The blocks specified in the selected style will appear in the 1-line displays for the current system.

---

**Configuring Graphics for Single Line Pipe Display**

When configuring graphics for a single line pipe display, you match a connector type with a graphics block that most closely represents it in the current drawing.

1 In the **Piping workspace**, click Manage tab ➤ Style & Display panel ➤ Style Manager button .
2 In the left pane of Style Manager, expand Piping Objects.
4 Select a style.
5 In the right pane, click the Single Line Graphics tab.

<table>
<thead>
<tr>
<th>Pipe Connection Type</th>
<th>Connector Graphics Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blind</td>
<td>Aecb_Flange</td>
</tr>
<tr>
<td>Electro-Fused</td>
<td>Aecb_Flange</td>
</tr>
<tr>
<td>Equally Tapered</td>
<td>Aecb_Flange</td>
</tr>
<tr>
<td>Flared</td>
<td>Aecb_Flange</td>
</tr>
<tr>
<td>Plain</td>
<td>Aecb_Flange</td>
</tr>
<tr>
<td>Reducing</td>
<td>Aecb_Flange</td>
</tr>
<tr>
<td>Shrink Fit</td>
<td>Aecb_Flange</td>
</tr>
<tr>
<td>Sprayed</td>
<td>Aecb_Flange</td>
</tr>
<tr>
<td>Swaged</td>
<td>Aecb_Flange</td>
</tr>
<tr>
<td>Swaged Reducing</td>
<td>Aecb_Flange</td>
</tr>
<tr>
<td>Unthreaded</td>
<td>Aecb_Flange</td>
</tr>
<tr>
<td>Welded</td>
<td>Aecb_Flange</td>
</tr>
<tr>
<td>Welded Reducing</td>
<td>Aecb_Flange</td>
</tr>
</tbody>
</table>

6 For Connector Graphics Block, select a block that matches the pipe connection type in the left column.

**NOTE** Block naming for unique connection graphics use Aecb_ConnectionType. However, many connection types use the same Aecb_StandardPipeLineGraphic graphics block.

7 Under Scaling for selected block, select Use Annotation Scale to scale the block to the annotation plot size.

8 Select Override Scale, and enter values for coordinates X, Y, and Z.

**NOTE** The annotation selections work together. The annotation scale determines whether the block should be annotative. The override scale determines whether the block should be scaled beyond the initial size of the annotation block. By default, blocks are scaled to the size of the nominal diameter. For more information, see *Scaling Annotation* on page 815.
Configuring the Straight Centerline Display of Elbows

You can control the centerline display of elbows and store results in the drawing.

To display the straight centerline

1. Enter `DisplayStraightCenterlines`.
2. Enter the domain: `c` (Conduit), `d` (Duct), `p` (Pipe), or `a` (All).
3. Enter `y` (Yes) to display straight centerlines on all applicable objects.

**NOTE** For more information, see Straight Centerline Display of Elbows on page 380.

Creating a Piping System

You insert an architectural floor plan as a reference and design piping systems within that floor plan. You then create a piping system by adding equipment and pipe runs to a drawing. You can add pipe components in the following ways:

- Click Home tab ➤ Build panel ➤ Pipe drop-down ➤ Pipe.
- Click Home tab ➤ Build panel ➤ Pipe Fitting.
- Click Home tab ➤ Build panel ➤ Equipment drop-down ➤ Filter or other equipment.
- Click Add grips on page 385 on pipe objects to add additional parts to the layout.
- Add a pipe tool on the tool palette on page 429 to the drawing.
- Enter `PipeAdd` from the command line.
- Select a pipe object, and click Pipe tab, Pipe Flex tab, or Pipe Fitting tab ➤ General panel ➤ Add Selected.
- Select an MvPart, and clicking Equipment tab ➤ General panel ➤ Add Selected.
Pipe Properties Palette (Add Mode)

This section defines the properties on the Design tab of the Properties palette that you use to add pipe objects. The Design tab is divided into two categories: Basic and Advanced.

Basic Properties

By default, Basic properties are displayed on the Pipe Properties palette.

![Pipe Properties Palette](image)

**NOTE** In the following tables, properties related to sloped piped layouts on page 373 are preceded by an asterisk (*). Properties related to flexible pipe are preceded by double asterisks (**) and are only available when you add flexible pipe.

<table>
<thead>
<tr>
<th>General</th>
<th>Action</th>
<th>Selections</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Describes the pipe part (optional)</td>
<td></td>
</tr>
<tr>
<td>System</td>
<td>Selects a system definition for the pipe object in the current drawing</td>
<td>Standard (default); selections</td>
</tr>
</tbody>
</table>
### General

<table>
<thead>
<tr>
<th>Action</th>
<th>Selections</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>derived from the catalog</td>
</tr>
</tbody>
</table>

### Dimensions

<table>
<thead>
<tr>
<th>Action</th>
<th>Selections</th>
</tr>
</thead>
<tbody>
<tr>
<td>Routing preference</td>
<td>Standard (default); selections derived from the catalog</td>
</tr>
<tr>
<td>Nominal size</td>
<td>2” (first time); thereafter, last used value selected</td>
</tr>
<tr>
<td>Size lock</td>
<td>Unlocked (default)</td>
</tr>
</tbody>
</table>

### Selections

<table>
<thead>
<tr>
<th>Action</th>
<th>Selections</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Placement

<table>
<thead>
<tr>
<th>Action</th>
<th>Selections</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elevation</td>
<td>0 (default)</td>
</tr>
<tr>
<td>Elevation lock</td>
<td>Unlocked (default)</td>
</tr>
</tbody>
</table>

Pipe Properties Palette (Add Mode) | 421
<table>
<thead>
<tr>
<th>Placement</th>
<th>Action</th>
<th>Selections</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start elevation</td>
<td>Specifies an elevation for connector 1 on the pipe object. Start elevation is the same value as Elevation.</td>
<td>0 (default)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Justification</th>
<th>Action</th>
<th>Selections</th>
</tr>
</thead>
<tbody>
<tr>
<td>Justify</td>
<td>Orientates the justification on page 160 of the pipe object</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Top Left</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Top Center</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Top Right</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Center (default)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Center Left</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Center Right</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Bottom Left</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Bottom Center</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Bottom Right</td>
<td></td>
</tr>
</tbody>
</table>

| Horizontal offset | Specifies a placement offset in the horizontal direction from the insertion point | 0 (default) |

| Vertical offset | Specifies a placement offset in the vertical direction from the insertion point | 0 (default) |

<table>
<thead>
<tr>
<th>Routing</th>
<th>Action</th>
<th>Selections</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Slope format</td>
<td>Specifies the current slope format. The slope format affects the slope property (for example, as a fraction, decimal, or percentage).</td>
<td>Available slope formats:</td>
</tr>
<tr>
<td></td>
<td>▪ Angle</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Percentage (100%=45)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Percentage (100%=90)</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** Click (Preferences) to edit the slope format in the Pipe Layout Preferences worksheet on page 432.
<table>
<thead>
<tr>
<th>Routing</th>
<th>Action</th>
<th>Selections</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>■ Rise value/Run value</td>
<td>■ Run value, Rise= constant value</td>
</tr>
<tr>
<td></td>
<td>■ Run value, Run=constant value</td>
<td>■ Rise value, Run=constant value</td>
</tr>
<tr>
<td></td>
<td>■ Fractional Rise value, Run=constant value</td>
<td>■ Fractional Rise value, Run= constant value</td>
</tr>
</tbody>
</table>

*Slope

Specifies a slope value on page 375 (rise/run in previous releases) that reflects the slope format.

**NOTE** If you change the slope value while you are adding more pipe parts to a run, a fitting will be added to adjust the slope.

*Bend angle

Specifies the angle to constrain the routing in the pipe run.

The bend angle varies, depending on the values that are defined in the catalog content.

*Bend angle lock

Prevents the bend angle from being changed.

■ Unlocked (default)
■ Locked

**Segment

Specifies the layout method for the flexible pipe on page 457.

■ Line
■ Arc
■ Spline
Selections: Action Routing

**Radius factor**
If Line is selected for Segment, lets you specify a radius value.

*Branch angle*
Specifies the angle (for example, 45 or 90 degrees) to which tees and laterals are constrained in the branch.

The selections vary, depending on the angles that are defined in the catalog content. For example, if lateral is selected, then only angles from the routing preferences pertaining to the selected lateral appear.

*Branch angle lock*
Prevents the branch angle value from being edited.

- Unlocked (default)
- Locked

---

**Advanced Properties**

Advanced properties are collapsed by default. To view advanced properties, click (Down arrow).
NOTE In the following tables, properties related to sloped piped layouts on page 373 are preceded by an asterisk (*). Properties related to flexible pipe are preceded by double asterisks (**) and are only available when you add flexible pipe.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Action</th>
<th>Selections</th>
</tr>
</thead>
</table>
| Connection details                   | Click \[
|                                      | to open the Connection Details on page 172 worksheet.                  |                                                                           |
| Insulation thickness                 | Enter the insulation thickness on page 464 for the pipe segment.       | 0 (default)                                                               |
| **Graphics (1-Line, 2-Line)**        | Select the desired pattern for flexible pipe. For more information, see Drawing a Flexible Pipe Run on page 457. | Circle, Curve, Oval, Single line, single line 2, Vertical, vertical 2  |

Pipe Properties Palette (Add Mode) | 425
<table>
<thead>
<tr>
<th>Properties</th>
<th>Action</th>
<th>Selections</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pitch</strong></td>
<td>Enter a pitch value. For more information, see Drawing a Flexible Pipe Run on page 457.</td>
<td></td>
</tr>
<tr>
<td><strong>Routing options</strong></td>
<td><em>Use fitting tolerance</em> Select Yes to turn deflection on at joints that have a tolerance angle specified in the content. This property controls the tolerance for the female fitting connection.</td>
<td>■ Yes (default)  ■ No</td>
</tr>
<tr>
<td></td>
<td><strong>TIP</strong> Angle of deflection (AoD) is equally distributed between female connectors on a fitting that supports sloped piping. However, the value cannot exceed the stored angle of deflection value on the part. See Angle of Deflection (Fitting Tolerance) on page 405.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> If angle of deflection is unsupported, the software will disregard a Yes selection.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Joint direction</em> Select the orientation of fittings during layout. This property specifies how male and female joints are orientated as you draw pipe. For example, if you select Male into female, the male connector is drawn first and then the female connector is drawn after the joint. See Male-Female Fittings and Joint Direction on page 403.</td>
<td>■ Male into female (default) ■ Female out to male</td>
</tr>
<tr>
<td></td>
<td><strong>TIP</strong> If you are drawing pipe in the direction of the flow, choose Male into Female. If you are drawing against the flow, choose Female out to Male.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Branch fitting</em> Select the fitting combination you want to use when adding a branch. If you select a double fitting combination (such as Tee or Wye), the software will use the first fitting, and if unsuccessful, will use the second.</td>
<td>■ Tee or Wye (Lateral) (default)  ■ Tee only  ■ Takeoff only  ■ Wye (Lateral) only</td>
</tr>
</tbody>
</table>
### Adding Pipe Equipment

You can place an MvPart in a drawing. You can also add an in-line or anchored MvPart to a pipe.

**RELATED** See *Mechanical, Electrical, and Plumbing Equipment in Building Systems* on page 110.
Placing a Pipe MvPart in a Drawing

1 In the Piping workspace, click Home tab ➤ Build panel ➤ Equipment drop-down and select a pipe MvPart on page 110.

The Add MvParts dialog displays the current part catalog for the tool you selected.

2 On the Part tab, select a part subtype in the folder.

3 Click Details to view available sizes.

4 Select Display/Hide additional parameters to expand the contents of the parameters table.

5 Click the Part Filter tab, and enter the desired criteria under Filter by Dimensions.

**NOTE** The part catalogs and content locations determine the parts you can add. If the part is unavailable, you can create a custom part using Content Builder.

6 Select a part size name.

7 Specify an elevation value.

8 (Optional) Click the K-Factor tab to assign a K-factor value to sprinklers (listed under Fire Protection).

9 Specify an insertion point in the drawing, and use the compass to specify a rotation angle.

10 To add another existing MvPart, select the MvPart, click Equipment tab ➤ General panel ➤ Add Selected .

**TIP** You can also use the AutoCAD COPY or ARRAY commands in AutoCAD to add more MvParts.

Adding Parts In-Line to Pipe

1 Add a Pipe MvPart, as explained in Placing a Pipe MvPart in a Drawing on page 428.
2 To place the part on a pipe, move the cursor to a pipe segment to display a pipe end or pipe curve connector.

3 Click the pipe connector to place the part in-line to the pipe or anchored to a pipe end, and use the compass to specify a rotation angle.

After the part is inserted, you can use grips to rotate the part around the centerline of the pipe segment. You can also flip an in-line part, such as a check valve, to orient the part in the proper flow direction.

Adding Pipe

You can draw pipe runs anywhere on a floor plan. All pipes and fittings include connectors to connect directly to other pipe objects and MvParts on page 110.

BEST PRACTICE Review and configure pipe routing preferences and system definitions on page 411 prior to drawing pipe systems.

Adding Pipe from the Tool Palette

1 In the Piping workspace, click Home tab ➤ Build panel ➤ Tools drop-down ➤ Tools to display the Piping tool palette.
2 Click the Pressure Pipe or the Gravity Pipe tab, depending on the piping design.
   ■ Use pressure pipe tools in non-sloped piping designs.
Use gravity pipe tools in sloped piping on page 373 designs.
Gravity Pipe tab

RELATED To create sloped piping designs, see Drawing Sloped Piping on page 455.

Configuring Basic Pipe Properties

1 On the Properties palette on page 420, under General, enter a description for the pipe object (optional).
2 Select the system definition on page 376 for the pipe run.
3 Under Dimensions, select a routing preference.
   Routing preferences reflect the size ranges, pipe parts, and fitting connections that the software uses as you lay out the pipe run.
4 Select a nominal size.
The list includes available sizes on page 369 common to the pipes and fittings specified in the current routing preference.

**TIP** You can optionally lock this property. Locking the nominal size prevents an accidental change to sizing values when you are modifying the pipe routing.

**NOTE** The available sizes apply to the pipes and fittings specified in the current routing preference. Sizes are grouped based on the size ranges in that routing preference. If a size is unavailable, you can select a different routing preference or modify the parts in the size range for the selected routing preference. For more information, see Configuring Size Ranges on page 412.

5 Under Placement, enter the elevation for the pipe object. The elevation is the Z value above or below the XY plane of the current user coordinate system (UCS).

6 If you are routing pressure piping on page 368, you can increase the software response time and generate more specific auto-layout routing solutions on page 371 by doing the following:
   - Specify No for Use fitting tolerance.
   - Specify the desired angle for Bend angle.
   - Specify the preferred Branch fitting.

**RELATED** For more information on these properties, see Pipe Properties Palette (Add Mode) on page 420.

### Configuring Pipe Layout Preferences

The Pipe Layout Preferences dialog lets you define layout preferences for a pipe run. You can also assign male to female connection types when an undefined, male connection type is attached to a female connection type.

Pipe layout preferences are stored with the drawing. You can use different layout preferences for different drawings, and you can share layout preferences between drawings.
➤ In the **Piping workspace**, use any of these methods to access pipe layout preferences:

- Click **Manage tab ➤ Preferences panel ➤ Piping**.
- On the **Properties palette** on page 420, under Routing, click (Preferences).

## General Preferences

The General tab in the Pipe Layout Preferences dialog controls pipe layout preferences for slope, elevation, labels, and flow arrows.

### General tab

![Pipe Layout Preferences dialog](image)

### Slope preferences

1. On the General tab of the **Pipe Layout Preferences dialog** on page 432, select a slope format.

Slope format affects the Slope property on the **Properties palette** on page 420. Slope format is stored with the drawing. The list includes the following formats:

<table>
<thead>
<tr>
<th>Slope format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle</td>
<td>Expressed in degrees (for example, 2 degrees)</td>
</tr>
<tr>
<td>Slope format</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Percentage</td>
<td>Expressed as a percent, where 100%=45 degrees</td>
</tr>
<tr>
<td>Percentage</td>
<td>Expressed as a percent, where 100%=90 degrees</td>
</tr>
<tr>
<td>Rise/Run</td>
<td>Expressed as a fraction (for example, 1/48 or 1/100)</td>
</tr>
<tr>
<td>NOTE</td>
<td>The Slope property on the Properties palette is displayed as a fraction.</td>
</tr>
<tr>
<td>Rise/Run with Constant Rise</td>
<td>Expressed as a decimal</td>
</tr>
<tr>
<td>NOTE</td>
<td>The Slope property on the Properties palette displays the Run portion of</td>
</tr>
<tr>
<td></td>
<td>Rise/Run (for example, 20, where run is 1).</td>
</tr>
<tr>
<td>Rise/Run with Constant Run</td>
<td>Expressed as a decimal</td>
</tr>
<tr>
<td>NOTE</td>
<td>The Slope property on the Properties palette displays the Rise portion of</td>
</tr>
<tr>
<td></td>
<td>Rise/Run.</td>
</tr>
<tr>
<td>Rise/Run with Fractional Rise,</td>
<td>Expressed as a fraction, such as 1/4 for a 1/4&quot; rise with a 12&quot; run</td>
</tr>
<tr>
<td>Constant Run</td>
<td></td>
</tr>
</tbody>
</table>

2 Select drawing units for Rise and for Run.
   The Units list is only turned on if you first selected a slope format.
   The units in the list are derived from the current profile and from selections made in the Drawing Setup dialog. For example, for Metric, you can choose meters, millimeters, etc. For Imperial, you can choose feet or inches.

3 Enter a Constant value.
   You can only edit constant value for Rise if you previously selected Rise/Run with Constant Rise for Slope format. You can only edit constant value for Run if you previously selected Rise/Run with Constant Run for Slope format.

4 Select slash (/) or colon (:) for the preferred ratio divider.
Elevation preferences

5 Do one of the following:
   a Select Automatically create riser at new elevation to turn on this layout behavior.
   b Select Override slope based on elevation and placement point to automatically calculate the slope value based on the current elevation and the location of the cursor in the drawing.

6 NOTE Override slope is not available (grayed out) when you select Automatically create a riser at the new elevation.

Label preferences

7 Select a label style.
   Label preferences are stored in the registry.
   NOTE If you select None, skip the next step.

8 Select By quantity or By distance:
   ■ For By quantity, enter the number of labels to add to each straight segment.
   ■ For By distance, enter a segment length. If the segment length is less than the interval distance, a label is not automatically added to that segment.

Flow arrow preferences

9 Select a flow arrow style from the list.
   NOTE If you select None, skip the next step.

10 Select By quantity or By Distance:
   ■ For By quantity, enter the number of flow arrows to add to each straight segment.
   ■ For By distance, enter a segment length. If the segment length is less than the interval distance, a flow arrow is not automatically added to that segment.

The following examples show label and flow arrows in a pipe run:
Connection Assignments

The Connection Assignments tab lets you assign the proper name of a male connection type to its female counterpart.
1 In the **Pipe Layout Preferences** dialog on page 432, click the Connection Assignments tab.

2 For Male Connection, click a male connection type, and then click (Down arrow).

3 Select a male connection type to assign to the corresponding female connection type in the left column.

Any connection type designated as Undefined that attaches to a female connector type in a drawing will display as male and will reflect the selection made in this dialog.

**NOTE** Male or female connection types must adhere to rules for connection behavior on page 974 based on the CEL (connector engagement length) on page 404 value. Connector assignments originate from the catalog content.
Configuring Justification for Pipe Insertion

➤ On the Properties palette on page 420, under Placement ➤ Justification on page 160, specify the justification settings for pipe insertion:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>align the pipeline center-line along the points you specify for the pipe run</td>
<td>under Justification, specify Center for Horizontal and Vertical. Specify offset values for each.</td>
</tr>
<tr>
<td>align one side of the pipeline along the points you specify for the pipe run</td>
<td>under Justification, specify from one of nine combinations of Left, Right, Top, or Bottom settings for Justify to align 2 sides along the insertion points.</td>
</tr>
<tr>
<td>offset the pipeline by a uniform distance from the points you specify for the pipe run</td>
<td>enter vertical and horizontal distance offsets.</td>
</tr>
</tbody>
</table>

You can optionally lock the pipe elevation property. See Pipe Elevation Lock on page 409 and Locking Pipe Elevation During Drawing on page 462.

**RELATED** For more information, see Justification of Objects on page 160.

Specifying Cut Length

1. Add pipe, as explained in Creating a Piping System on page 419.
2. On the Properties palette on page 420, under Dimensions, choose Yes to specify a cut length for the pipe run.
3. For Cut length, enter a length.

Consider this scenario. If a pipe system is going to be fabricated from 10-foot long pipes, you can configure pipe layout preferences so that straight pipe runs are automatically broken into 10-foot intervals as you draw them. Joints are automatically added at the break interval. The resulting pipes and couplings are still connected as a pipe system. After the pipe run is drawn, the pipe runs are automatically cut into lengths.

When activated, the automatic cut length is applied to all pipe system definitions. For example, the cut length is applied to chilled water systems,
steam systems, natural gas systems, or any other defined pipe system in the drawing. If you want to use different cut lengths when drawing different pipe systems, change the cut length as described in this procedure prior to working with each system. You can also break or join pipe segments after you have drawn them. For more information, see Pipe Length and Cut Length on page 406 and Breaking or Merging Pipe Segments on page 480.

**Drawing a Pipe Run**

1. Add pipe, as explained in Creating a Piping System on page 419.
2. In the drawing, specify a starting point for the pipe run.
3. Continue specifying points to lay out the geometry of the pipe run.

As you lay out a pipe run, fittings are inserted based on the routing preference and pipe layout preference settings. If you lay out geometry for which a part is not specified in the preference or if the part is available but the specified size or angle is not, the software prompts you to make a substitution.

**TIP** The compass, object snaps, AutoCAD MEP snaps, Ortho mode, and tracking lines are tools you can use to lay out a pipe run.

4. To start a new run, enter `n` (New run) on the command line, and specify the settings on the Properties palette on page 420.

**NOTE** When you add pipe runs, AutoCAD MEP inserts rise symbols and drop symbols based on the *rise/drop style* assigned to the system of the run.

**Connecting to Existing Pipe**

You can use pipe snaps to connect a new run anywhere along an existing pipe segment or fitting. The fittings that are automatically inserted between the existing pipe and the new pipe are configured in the routing preference and pipe layout preference.
To connect a new pipe segment to an existing segment

1 Turn on the AutoCAD MEP pipe snaps (optionally).
2 Add pipe, as explained in Creating a Piping System on page 419.
3 To start a new run from the end of a segment, move the cursor over the end of the existing pipe segment to display the pipe end connector snap.

4 Click the pipe end connector to specify the start point of the new run.
   The routing preference, size, and system for the new run match the existing pipe.
5 On the Properties palette on page 420, under Routing Options, specify a layout method.
6 To use a different size for the new run, specify a new nominal size under Dimensions.

_IMPORTANT_ The available sizes include those common to all of the pipes and fittings specified in selected routing preference. This ensures that you select a pipe size that matches fittings of the same size. (The sizes are also grouped according to the size ranges defined in the routing preference.) If a size is not available, select a different routing preference, or modify the parts in the size range of the current routing preference.

If you use a different size for the new run, a transition fitting is inserted to connect the new pipe to the existing pipe.

7 Continue specifying points to lay out the run.

_TIP_ You can also use the _add grips_ to start a pipe run from a pipe end.
To start along a pipe

8 To start a run at a point along a pipe segment, move the cursor over the existing pipe segment to display the pipe curve connector snap.

9 Click the pipe curve connector to specify the start point for the new run.
Based on the connection type configured in the pipe layout preference, a takeoff or tee is inserted.

10 Continue specifying points to lay out the run.

To end a run on an existing pipe

11 Move the cursor over the existing pipe segment to display the pipe curve connector or pipe end connector.

12 Click the pipe curve or pipe end connector to specify the endpoint of the run and connect to the existing segment.
Based on the connection type configured in the pipe layout preference, a takeoff or tee is inserted.
If you try to connect pipes on different elevations, AutoCAD MEP creates one or more routing solutions you can preview and use to automatically connect the pipes.
Connecting a Pipe Run to an MvPart

You can connect a pipe run to an MvPart. If so, check the connection type and size on the MvPart so that you can specify your routing preference and pipe size accordingly. You can also manually specify a part to connect a run to an MvPart.

To connect a pipe run to an MvPart

1. Add pipe, as explained in Creating a Piping System on page 419.
2. Begin laying out the pipe run.
3. As your pipe run approaches the MvPart that you want to connect to, click (Object Snap Tracking) on the application status bar to line up your pipe run with the desired connection on the MvPart.

Using tracking to align a pipe run with a pipe connection on a chiller
4 Move the cursor over the MvPart connection to display the pipe end connector.

5 Click the pipe end connector to connect the pipe run to the MvPart.

**TIP** You might be prompted to accept or undo the connection.

If the pipe segment centerline is not aligned with the MvPart connector centerline, the software automatically presents routing solutions you can preview and use.

6 If the size or connection type of the pipe segment does not match the size or connection type of the MvPart, specify the fittings to use to make the connection:

<table>
<thead>
<tr>
<th>If...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the pipe size differs from the MvPart connection size</td>
<td>a transition fitting is automatically inserted. Accept the connection. If a transition is not specified in the routing preference, the Choose a Part dialog prompts you to specify the transition.</td>
</tr>
<tr>
<td>the pipe connection type differs from the MvPart connection type</td>
<td>the Choose a Part dialog prompts you to specify the fittings for this connection.</td>
</tr>
</tbody>
</table>
| you want to use a fitting in the part catalog that is not configured in the routing preference | specify the fitting on the Properties palette on page 420, and insert it at the end of the pipe run. For more information, see Overriding a Fitting on page 448. Once the fitting is
Adding a Vertical Segment to a Pipe Run

1. Add pipe, as explained in Creating a Piping System on page 419.
2. Begin laying out the pipe run.
3. Specify the point in the layout where you want to start the vertical segment. The elevation at this point is the start point of the vertical segment. You can specify start and end elevation values later when you modify the pipe run on page 466.
4. On the Properties palette on page 420, under Placement, specify the elevation of the endpoint of the vertical segment.
5. Continue specifying points for the pipe run geometry.

If... then...

inserted, you might need to move the fitting to connect the pipe run with the MvPart.
When drawing pipe systems, you can check connectivity among components, and you can set and view flow direction. Maintaining connectivity in a system ensures that all modifications are applied to the appropriate parts. For more information, see Checking Connectivity in a Pipe System on page 484 and Drafting with Flow Direction on page 190.

Adding Pipe Using Add Grips

1 Select the object in the drawing, and click 🌤️ (add grip) to begin drawing a pipe run:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>start a run from one of the ends of a pipe segment</td>
<td>click the add grip at one end of the segment.</td>
</tr>
<tr>
<td>start a run from the midpoint of a pipe segment</td>
<td>click the add grip at the midpoint of the segment. A tee or takeoff is automatically inserted, depending on the connection specified for pipe layout preferences.</td>
</tr>
<tr>
<td>start a run from an MvPart</td>
<td>click the add grip on the MvPart connection.</td>
</tr>
<tr>
<td>start a run from a fitting, such as an elbow or tee</td>
<td>click the add grip pointing in the direction of where you want to start the new run.</td>
</tr>
</tbody>
</table>

**TIP** The software will use the part and the male-to-female orientation specified in the Routing Preferences if possible. If not, the Choose a Part dialog on page 447 will prompt you to pick a part to insert into the layout at the appropriate angle.
If you want to… then…

add a joint to an existing pipe run

hold down the Ctrl key while clicking the add grip and then click to add pipe.

TIP If the Use fitting tolerance property on the Properties palette on page 420 is set to Yes, a coupling will be added to the pipe. This is true only if it is within the allowable fitting tolerance (angle). On the other hand, if Use fitting tolerance is set to No, an elbow will be added.

2 On the Properties palette on page 420, under Routing Options, specify the layout method that you want to apply to the new pipe run.

3 If you start from an MvPart, under Dimensions, specify a system and a routing preference.

The software remembers the routing preference and system setting. The routing preference and slope (if applicable) are automatically set based on the connected object. If you start from a pipe segment or fitting, the new run inherits those preferences.

4 If you change the nominal size before specifying the first segment of the new run, a transition is automatically inserted between the object and the new pipe segment after you specify the first point of the new run.

IMPORTANT The available sizes include those common to all of the pipes and fittings specified in selected routing preference. This ensures that you select a pipe size that matches fittings of the same size. (The sizes are also grouped according to the size ranges defined in the routing preference.) If a size is not available, select a different routing preference, or modify the parts in the size ranges in the current routing preference.

5 Continue specifying points for the pipe run layout geometry.
Manually Specifying Parts During Layout

As you draw a pipe run, fittings are automatically inserted into the layout based on the current preferences. Sometimes, however, you might be prompted to specify parts that are not included in the current routing or part preference.

Choosing a Part

The Choose a Part dialog displays if you try to add or modify a part in a run that is not stored in your preferences. You will be prompted to make a substitution from the catalog. The following example shows the dialog in the Piping domain in the US Imperial or US Metric profile:

Choose a Part dialog showing pipe parts organized by material type

The following table summarizes scenarios where the Choose a Part dialog is displayed, prompting you for a part substitution:

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Displays a dialog as you add to the layout</th>
<th>Displays a dialog as you modify the layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>The part is not stored in the current routing preference (for pipe or conduit) or part preference (for duct or cable tray).</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>The current routing or part preference includes the correct part but not the specified angle.</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>
### Scenario | Displays a dialog as you add to the layout | Displays a dialog as you modify the layout
---|---|---
The part size is not specified in the current routing or part preference. | yes The dialog prompts you to select a reducer. | yes
An additional part is required in the layout, and the reducer that you specified does not meet the size requirement. | no | yes A reducer is automatically added.
You tried to connect objects with different joint types (for example, butt welded and fusion) that are not included in the current routing or part preference. | yes | no

If you modify a layout, the Choose a Part dialog zooms to the part in the layout that requires action. After you make a selection, the original view is resumed. Your last preference for the specific domain is automatically retained until you change it. You also have the option to make the part selection the default.

The substitution you make only applies to the specific location in the layout. If you repeat this action while the Add command is still active, the dialog prompts you to select a part again.

If the preferred part or connection type is unavailable, click Cancel and then add the desired fitting manually.

**RELATED**  See Adding a Pipe Fitting Manually on page 452 or Adding Cable Tray or Conduit Fittings Manually on page 638.

You might also be prompted to choose a part multiple times if you try to connect objects either with different connection types on page 401 or whose centerlines are not aligned. In such cases, the parts you choose are automatically used to create one or more routing solutions.

### Overriding a Fitting

You can override a routing preference and specify a different part to use while drawing a pipe run. For example, if you want to use a threaded takeoff for a
specific run instead of the default butt-welded takeoff, you can override the default takeoff.

When you override a default part, it remains in effect until you end the Pipe Add command. The next time you add pipes, the default part in the routing preference is resumed.

**NOTE** As long as the Pipe Add command is active, the override part is used in place of the default part.

**To override a default fitting**

1. Add pipe, as explained in Creating a Piping System on page 419.
2. On the Properties palette on page 420, expand Advanced, and under Routing Options, click to open the Fittings Settings dialog.

### Fitting Settings dialog

The Fitting Settings worksheet shows the current description and size range from the catalog, and lists the available types and parts. If no value is available, the worksheet shows “- -”.

3. In the Fitting Settings dialog, select the fitting type to override.
4. Choose a part from the list.
5. Specify points to lay out the pipe run.
   The overridden part is automatically inserted into the layout.
The override is removed after you end the *PipeAdd* command. The next time you run *PipeAdd*, the default part from the routing preference is used once again.

**Choosing from Multiple Parts Found**

If you try to create a fitting with more than one size available for the object you are adding, the Multiple Parts Found dialog prompts you to choose the desired size. If you modify a layout with pipe objects, the software zooms to the location where you need to select a substitute part. After you select from the list of available part size names, the original layout is resumed. To turn off this feature, clear Zoom to the object. The software remembers your last preference.

**Using Routing Solutions to Connect Objects**

1. Start a pipe segment from the first object.

For information on starting a pipe run from an existing pipe object, see *Adding Pipe Using Add Grips* on page 445 or *Connecting to Existing Pipe* on page 439.
2 Move the cursor directly to the second object to display a pipe end or pipe curve connector.

3 Click the pipe connector.

**TIP** If you are connecting to an object with a different pipe size or a different routing preference, you may be prompted to choose a part to connect to the second object.
4 To step through the generated solutions, enter n (Next) or p (Previous) and press Enter.

As you preview a preferred routing solution, enter a and press Enter to accept it.

To accept a specific solution, enter the assigned number, and then enter Accept.

The pipe run is automatically updated.

Adding a Pipe Fitting Manually

AutoCAD MEP adds pipe fittings as you draw a pipe run based on the default fittings specified in the pipe routing preferences. However, you can also add a pipe fitting manually to an existing segment or to a run.

Routing preferences specify the common fittings used for most pipe layouts. However, the default pipe parts catalog includes many other fittings you can use.

To add a pipe fitting manually

1 In the Piping workspace, to select a fitting, click Home tab ➤ Build panel ➤ Pipe Fitting drop-down ➤ Pipe Fitting.
TIP You can also use the Fitting tool palette.

2 On the Properties palette, under General, click the part image next to Part.

3 In the Select a Part dialog, choose a part from the catalog.

Select a Part dialog

Under Select Part from Catalog, the dialog organizes pipe fittings based on material type in the US Imperial and US Metric profiles. For more information, see Pipe Parts Catalog on page 381.

4 (Optional) Select Display/Hide additional part parameters to expand the contents of the parameters table.

5 Under Filter by Dimensions, filter the list of parts.

NOTE The part catalogs and content locations determine the parts that you can select.

6 Select a part size.
On the Properties palette on page 420, under Placement, enter an elevation.

**NOTE** If you insert a fitting in an existing pipe run, you do not need to specify the elevation. The fitting inherits the elevation and system settings from that pipe run.

Specify an insertion point in the drawing, and use the compass to specify a rotation angle.

You can use pipe curve or pipe end connectors to insert the fitting on an existing pipe object.

**Creating a Custom Pipe Fitting**

You can create a custom pipe fitting when the required fitting is not available from the part catalog or you need to match a unique design. You create custom fittings by converting AutoCAD lines, arcs, and polylines into AutoCAD MEP objects with connectors. Part properties, such as size, shape, and system definition are inherited from the connecting parts to maintain system integrity. Part properties, such as CEL (connector engagement length on page 404) and AoD (angle of deflection on page 405), are stored with the drawing. Custom fittings are style-based objects that you can access from Style Manager. Each custom fitting you create represents a single style.

**NOTE** You cannot add custom fittings to a part catalog. If you create a custom fitting to be used multiple times, you can share custom fittings between drawings using the copy and paste functionality.

1. In the Piping workspace, draw the centerlines of the new custom fitting using lines, polylines, or arcs.
2. Click Home tab ➤ Build panel ➤ Pipe Fitting drop-down ➤ Pipe Custom Fitting.
3. Click the lines just drawn, and then press Enter.
4. In the Create Custom Fitting dialog, enter a name, and select a system.
5. Select the diameter for the start and end of each segment, and then select Mitered End if an end is mitered.
6 Determine if the properties are applied to some or all of the segments:

- If the properties assigned to the current segment are the same for all segments, select Apply to All Segments.
- If the properties of the next segment are different from those of the current segment, click Next twice.

**NOTE** The Next button is not available if you select Apply to All Segments.

7 Click Finish.

8 On the command line, enter y (yes) to erase the original centerline geometry or n (no) to keep the original geometry in the drawing.

**NOTE** If any size or shape properties of the segments are incomplete, the software will prompt you that it cannot create the custom fitting.

---

**Drawing Sloped Piping**

1 Begin laying out a pipe run as explained in Drawing a Pipe Run.

2 On the Properties palette on page 420, under General, specify a gravity-based routing preference on page 368.

**NOTE** For more information, see Pipe Routing Preferences on page 367 and Sloped Piping on page 373.

3 Specify a nominal size for the pipe segment.

4 Under Routing, for Slope format, select a format from the list.

For example, selecting Rise/Run with Fractional Rise sets a fractional slope per foot (for example, 1/4” per foot).

**TIP** Slope format is also available on the General tab of the Pipe Layout Preferences on page 432 dialog. For more information on slope formats, see General Preferences on page 433.

5 For Slope, enter a value based on the current slope format.

**TIP** A negative slope value pitches the pipe downward from the main or branch in the isometric view. For example, -1/4” reflects a downward 1/4” per foot slope.
6 Expand Advanced, and under Routing Options, for Use Fitting tolerance, select Yes.
Fitting tolerance refers to the angle of deflection on page 405 that is allowed on a fitting connection. Yes (default) turns on angle of deflection on page 405 for fittings that support sloped pipe on page 373 runs.

**TIP** If a female fitting, such as a flange, does not support angle of deflection, the software disregards a Yes selection.

7 For Joint direction, specify an orientation.
Joint direction controls the orientation of male-female connections on page 403 for routing preferences that support male-female fittings.

**TIP** If you are drawing pipe in the direction of the flow, choose Male into Female (default). If you are drawing against the flow, choose Female out to Male.

8 For Branch fitting, specify a combination. For example, Tee or Wye (Lateral) specifies that the software will first attempt to add a tee to the branch. Otherwise, the software will add a wye (lateral).

9 Under General, for Routing, select a branch angle.
Selections for branch angle vary depending on the values that are defined in the catalog content. The selected angle determines how the branch will be drawn. Select Values from catalog selection to use all angles in the current routing preference in the layout.

If the desired angle in the layout is outside the range of the standard angle and tolerance, the Choose a Part on page 447 dialog prompts you to make a part substitution.

10 Specify additional points in the pipe run.

**NOTE** The software displays the slope value for the pipe segment in the pipe run. For more information, see Slope Value Displayed in Piping Layouts on page 375.

11 (Optional) Click (Preferences) to make connection assignments on fittings in your drawing in the Pipe Layout
Preferences dialog. For more information, see Connection Assignments on page 436.

The following example shows sloped piping in plan versus SW Isometric views.

As you continue to lay out parts and connect pipe objects in the run, auto layout on page 370 can generate routing solutions on page 371. The command line prompts you to accept the preferred solution. For more information, see Using Routing Solutions to Connect Objects on page 450.

The software inserts a coupling or an elbow into the piping layout, depending on the allowable fitting tolerance. For example, you might draw pipe at an angle of 5 degrees. Then, if the layout angle is less than the allowable fitting tolerance of 10 degrees, a coupling is inserted into the layout. However, if the layout angle is greater than the allowable fitting tolerance, the software inserts an elbow.

RELATED For a summary of pipe properties related to gravity (sloped) piping, see Pipe Properties Palette (Add Mode) on page 420. For more information, see Sloped Piping on page 373.

Drawing a Flexible Pipe Run

1 In the Piping workspace, click Home tab ➤ Build panel ➤ Tools drop-down ➤ Tools.
2 Select a flexible pipe tool from the Piping tool palette.

TIP You can also use the PipeFlexAdd command or hold down the Alt key for the same result.
3 On the Properties palette on page 420, under General, specify a system.
4 Under Dimensions, specify a routing preference.
5 Select a nominal size for each pipe connector.
6 Under Placement, specify an elevation.
7 Under Routing Options, for Segment, specify the layout method for the flex pipe as follows:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>lay out the flex pipe as a series of straight line segments</td>
<td>select ✂️ Line for Segment. Specify a value for Radius factor. Any angled transitions in the flex pipe segment use this radius value.</td>
</tr>
<tr>
<td>lay out the flex pipe as a series of arcs</td>
<td>select 🌋 Arc for Segment.</td>
</tr>
<tr>
<td>lay out the flex pipe as a complex curve by specifying points for a spline</td>
<td>select 🌋 Spline for Segment.</td>
</tr>
</tbody>
</table>

   This pattern is applied to flexible pipe runs after you draw them, and it is visible for flexible pipe systems displayed as 1-line.
9 Specify a value for Pitch.
   The pitch specifies the interval between the pattern, based on the drawing scale.
10 Repeat the previous steps for 2 Line and click OK when done.
   This pattern is visible for flexible pipe systems displayed as 2-line.

**TIP** You can use pipe curve or pipe end connectors to connect a flexible pipe run with a rigid pipe object. You can use flexible and rigid pipes in the same system while maintaining connectivity throughout the system.

**NOTE** You cannot draw a sloped flexible pipe run in AutoCAD MEP. As a result, properties related to Sloped Piping on page 373 will not appear on the Properties palette on page 420.
Adding a Parallel Pipe Run Using Offsets

You can use justification on page 160 on the Properties palette to offset a new pipe run from an existing run. When you draw the parallel run, you select points on the existing run, and the new parallel run is created at the offset distance. You can select points on the existing run using AutoCAD MEP snaps.

**TIP** Drawing a parallel pipe run might be easier if you use a 1-line display for the existing pipe run. This reduces the potential number of points to specify, and it allows you to accurately select transition points. For more information, see Pipe System Displays on page 377.

To draw a parallel pipe run using offsets

1. Verify that the AutoCAD MEP pipe snaps are turned on, and turn off (Object Snap) and (Object Snap Tracking) on the application status bar.
2. Add pipe, as explained in Creating a Piping System on page 419.
3. On the Properties palette on page 420, under Justification on page 160, specify the horizontal and vertical offsets:

<table>
<thead>
<tr>
<th>If you want to</th>
<th>then</th>
</tr>
</thead>
<tbody>
<tr>
<td>offset the new run at a horizontal distance (X or Y direction) from the existing run, with both runs at the same elevation</td>
<td>under Justification, set a value for Horizontal offset. To offset the new run in a positive X or Y direction from the existing run, enter a positive value. To offset in a negative X or Y direction, enter a negative value.</td>
</tr>
<tr>
<td>offset the new run at a vertical distance from the existing run, with both runs having the same X-Y dimensions at different elevations</td>
<td>under Justification, set a value for Vertical offset. To offset the new run in a positive Z direction from the existing run, enter a positive value. To offset in a negative Z direction, enter a negative value.</td>
</tr>
</tbody>
</table>
4 In the drawing, select the pipe end connector at the start of the existing pipe run.

5 Continue selecting points along the run.

**IMPORTANT** To achieve the most accurate layout, select points at each end of the pipe segments. For angled transitions, such as elbows, select only the pipe curve connector at the logical intersection of the fitting centerlines as shown in the following example.

Note that for elbows and other curved fittings, a pipe curve connector is displayed at the logical intersection of the fitting centerlines. This ensures that the pipe is offset the specific distance along the entire parallel run.

**IMPORTANT** If you draw parallel pipe runs close to each other and plot them at a small scale, they may blend together on the plotted sheet. In the drawing, you may need to space the pipe runs far enough apart so that they render accurately and individually on the plot.

**RELATED** To draw parallel runs in piping or radiant heating systems (without using offsets), see *Adding Parallel Pipes to a Radiant Heating System* on page 506.

### Offsetting Pipe from Existing Geometry

You can draw a pipe run that is offset a specific distance from existing geometry, such as a wall, in a referenced drawing. The geometry can be AutoCAD® lines or blocks, AutoCAD Architecture building objects, or AutoCAD MEP objects, and the geometry can exist in a reference drawing. You can select points on the geometry using snaps.
To draw an offset pipe run

1 Add pipe, as explained in Creating a Piping System on page 419.
2 On the Properties palette on page 420, under Placement ➤ Justification on page 160, specify the horizontal and vertical offsets as follows:

<table>
<thead>
<tr>
<th>If you want to</th>
<th>then</th>
</tr>
</thead>
<tbody>
<tr>
<td>offset the new run at a horizontal distance (X or Y direction) from the geometry, with the geometry and pipe run at the same elevation</td>
<td>set a value for Horizontal offset. To offset the new run in a positive X or Y direction from the existing geometry, enter a positive value. To offset in a negative X or Y direction, enter a negative value.</td>
</tr>
<tr>
<td>offset the new run at a vertical distance from the geometry, with both having the same X-Y dimensions at different elevations</td>
<td>set a value for Vertical offset. To offset the new run in a positive Z direction from the geometry, enter a positive value. To offset in a negative Z direction, enter a negative value.</td>
</tr>
</tbody>
</table>

3 In the drawing, select a point on the geometry.
   You can use object or AutoCAD MEP snaps to select points on the geometry.
Continue selecting points along the geometry.
To turn off the offset at any point, specify 0 for Horizontal Offset or Vertical Offset, and continue laying out the run.

Locking Pipe Elevation During Drawing
1 Add pipe, as explained in Creating a Piping System on page 419.
2 On the Properties palette on page 420, under Placement, specify an elevation and begin the pipe run.
3 Lock the elevation property to prevent a pipe segment along a run to snap to a segment at a different elevation.

TIP By default, the lock is turned off whenever you start the PipeAdd command. The setting also resets to Unlocked when the command ends. See Pipe Elevation Lock on page 409 for more information.

TIP To connect a horizontal pipe to a vertical pipe, move the cursor over the vertical segment to get a pipe curve connector, and click on it. If necessary, try using a different view, such as a side or isometric view, to achieve the desired connection.

Adding a Takeoff to a Pipe
You can add a takeoff perpendicular to the pipe centerline and rotate it at any angle around the pipe. The simplest way to add a takeoff is to connect a pipe segment to a pipe curve connector on an existing segment. If a takeoff is the specified connection type in the pipe layout preferences, a takeoff is automatically inserted to connect the new segment to the existing segment.

To add a takeoff to a pipe segment
1 In the Piping workspace, click Home tab ➤ Build panel ➤ Tools drop-down ➤ Tools .
2 Select a fitting, tap, or takeoff from the Piping tool palette.
3 On the Properties palette on page 420, under General, click the part image.
4 In the Select a Part dialog, choose a part from the catalog.
Select a Part dialog

Under Select Part from Catalog, the dialog organizes pipe parts based on material type in the US Imperial and US Metric profiles. For more information, see Pipe Parts Catalog on page 381.

5 Select Display/Hide additional parameters to expand the contents of the parameters table.

6 Under Filter by Dimensions, filter the list of parts.

NOTE The part catalogs and content locations determine the parts that you can add.

7 Select a part size and click OK.

8 In the drawing, move the cursor to the location on the pipe segment to add the takeoff.

9 Click the pipe curve connector.
TIP For 1-line pipe, a pipe curve connector appears when you move the cursor over the pipe centerline. For 2-line pipe, a pipe curve connector appears when you move the cursor over the contour lines of the pipe.

10 (Optional) To change the insertion point after you place the takeoff, enter `sl` (slide), and specify a new insertion point.

11 Enter an angle to rotate the takeoff around the pipe, or use the compass to specify an angle.

TIP You can use **rotate grips** to rotate the newly added takeoff.

### Adding Insulation to Pipe

Insulation is only visible when piping is displayed as **2-line**. When you activate this feature, insulation is added to all pipe system definitions as you draw pipe. A new pipe or pipe fitting inherits the insulation values from the existing pipe or pipe fitting where it was added.

![Diagram of insulated pipe](image)

**NOTE** Insulation is an annotation element that shows where insulation is used on a pipe system. Because it is not an object, you can only **modify** how and where it displays in the drawing. However, you cannot create schedules for insulation.

To **add insulation to pipes**

1. Add pipe, as explained in *Creating a Piping System* on page 419.
2. On the Properties palette on page 420, expand Advanced, and enter an insulation thickness.
Adding Labels or Flow Arrows to Pipe

You can add annotation, such as labels and flow arrows, as you lay out the pipe run. You can configure label styles to display pipe diameter or system type properties.

To add a label or flow arrow

1. Add pipe, as explained in Creating a Piping System on page 419.
3. Under Label, specify a style from the list.
4. For Layout Method, specify the label and flow arrow configurations to add to each pipe segment you select:

<table>
<thead>
<tr>
<th>If you chose</th>
<th>then</th>
</tr>
</thead>
<tbody>
<tr>
<td>By quantity</td>
<td>specify the total number of labels or flow arrows to display on each pipe segment. Note that the number of labels or flow arrows is automatically added to each straight segment.</td>
</tr>
</tbody>
</table>

By distance | specify the distance to insert a label or flow arrow at uniform intervals on each pipe segment. Note that if a pipe segment length is less than the interval distance, a label or flow arrow is not added to that segment.

Flow arrows by distance
Flow arrows repeated at a uniform interval

RELATED For more on annotation, such as tags, schedules, cross-sectional views, and details, see Annotation on page 814.

Converting a Polyline to Flexible Pipe

1 Select the polyline, line, arc, or spline to convert.
2 Right-click, and click Convert to ➤ Flex Pipe.
3 On the command line, enter n (No) to leave the layout geometry or y (Yes) to erase it from the drawing.
   If prompted, choose a part substitution.
4 On the Properties palette on page 420, configure basic piping properties.

Modifying a Piping System

You can make changes to a pipe system at any point during the design process. The topics in this section offer instructions on how to modify various aspects of the pipe system.

Pipe Properties Palette (Modify Mode)

This section defines the properties on the Design tab of the Properties palette to use to modify the piping system. The Design tab is divided into two sections: Basic and Advanced.
Basic Properties

Basic properties are expanded by default. The properties display the last stored value.

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Describes the object (optional)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Layer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifies the layer style on page 203 for the selected object</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifies the system definition for the selected object</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Routing preference</td>
</tr>
<tr>
<td>Specifies the routing preference for the selected pipe object</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Nominal size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifies the size on page 369 in the routing preference for the selected object</td>
</tr>
</tbody>
</table>

**NOTE** In the following tables, properties related to sloped piped layouts on page 373 are preceded by an asterisk (*). Properties related to flexible pipe are preceded by double asterisks (**) and are only available when you add flexible pipe.
<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size lock</td>
<td>Prevents the editing of the nominal size value while you are modifying the pipe routing</td>
</tr>
<tr>
<td>Cut length</td>
<td>Specifies the reported value of the length on page 406 of the pipe</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Placement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elevation</td>
<td>Specifies the elevation of the pipe object</td>
</tr>
<tr>
<td>Start elevation</td>
<td>Specifies the elevation at the starting and ending points of the pipe segment</td>
</tr>
<tr>
<td>End elevation</td>
<td></td>
</tr>
</tbody>
</table>

**Start/end elevation on Properties palette**

![Image of elevation values](image)

<table>
<thead>
<tr>
<th>Placement</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elevation</td>
<td>UCS: 0</td>
</tr>
<tr>
<td>Start</td>
<td>UCS: 0</td>
</tr>
<tr>
<td>End</td>
<td>10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Move attached segments</th>
<th>Lets you specify whether to move the attached pipe segments if the location of the selected part has changed (default — Yes)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Additional information</th>
<th>Click [ ] to open the Location worksheet.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NOTE</strong></td>
<td>For more information, see Modifying the Pipe or Fitting Location on page 479.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Routing</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Slope format</td>
<td>Displays the current slope format (not editable)</td>
</tr>
<tr>
<td>*Slope</td>
<td>Specifies the slope value on page 375 of the current pipe segment (not editable)</td>
</tr>
</tbody>
</table>
Advanced Properties

Advanced properties are collapsed by default. To view advanced properties, click \( \text{△} \) (Down arrow).

**Advanced properties (includes pipe flex properties)**

In the following table, properties related to sloped piped layouts on page 373 are preceded by an asterisk (*). Properties related to flexible pipe are preceded by double asterisks (**) and are only available when you add flexible pipe.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection details</td>
<td>Click ( \square ) to open the Connection Details worksheet.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> For more information, see <a href="#">Connection Details on page 399</a>.</td>
</tr>
<tr>
<td>Anchors (for fittings)</td>
<td>Click ( \triangle ) to open the Anchor worksheet.</td>
</tr>
</tbody>
</table>

Pipe Properties Palette (Modify Mode) | 469


### Modifying Pipe Components Using Grips

You can use grips to modify pipe components in a pipe run including:

- Location grips
- Elevation grips
- Flip grips (rotate 180 degrees)
- Lengthen grips

### Moving Pipe Components Using Location Grips

1. Select the part or pipe segment.
2. Select a location grip.

---

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| NOTE         | The Anchor icon and Anchor worksheet only display for pipe fittings and symbols that use anchors (such as takeoffs). For more information, see Part Anchors on page 181.
| Insulation thickness | Specifies the insulation thickness of the current pipe segment             |
| **Graphics** | Specifies the pattern for flexible pipe                                     |
| NOTE         | For more information, see Drawing a Flexible Pipe Run on page 457.          |
| **Pitch**    | Specifies the pitch value for flexible pipe                                |
| NOTE         | For more information, see Drawing a Flexible Pipe Run on page 457.          |
| **Geometry** | Used when you modify the layout of flexible pipe                            |
| NOTE         | For more information, see Modifying the Layout of a Flexible Pipe on page 483. |
3 If the part or pipe segment is connected to another object, specify whether and how to maintain connectivity:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>maintain connectivity by adjusting all objects, including MvParts</td>
<td>click the location grip and then click the Ctrl key once.</td>
</tr>
<tr>
<td>break connectivity</td>
<td>click the location grip and then click the Ctrl twice.</td>
</tr>
</tbody>
</table>

**NOTE** If you want to maintain connectivity by adjusting only pipe fittings and segments and retain the current locations of MvParts on page 110, skip to the next step.

4 Specify the new location:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify the new location relative to the current location</td>
<td>for an offset in the X direction, move the part in the direction of its new location, enter a value, and press Enter. For an offset in the Y direction, press Tab to toggle to the Y offset, enter a value, and press Enter.</td>
</tr>
<tr>
<td>manually specify the new location</td>
<td>drag the cursor to move the location, and click to specify the new location. You can use object snaps, AutoCAD MEP snaps, and tracking lines to help specify the new location point.</td>
</tr>
</tbody>
</table>

**NOTE** To use the dimension input fields, both dynamic input (on the status bar) and the Dimension Input drafting setting must be turned on (default). If you have turned them off, you can specify the new location by dragging the cursor and specifying a point in the drawing or by entering the coordinates in the command window.

**Modifying the Elevation of Pipe Components**

1 Change to a side or isometric view.
2 Select a part or pipe segment.
3 Select the elevation grip on page 392 to use.
4 If the part or pipe segment is connected to another object, specify whether and how to maintain connectivity:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>maintain connec-</td>
<td>proceed to the next step.</td>
</tr>
<tr>
<td>tivity by adjust-</td>
<td></td>
</tr>
<tr>
<td>ing only pipe</td>
<td></td>
</tr>
<tr>
<td>fittings and segments, and</td>
<td></td>
</tr>
<tr>
<td>retain the current locations of parts</td>
<td></td>
</tr>
</tbody>
</table>

| maintain connectivity by adjusting all objects, including parts | press Ctrl. |
| break connectivity | press Ctrl twice. |

5 Specify the new elevation:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify the new overall elevation relative to a point on the part or segment (for example, the centerline)</td>
<td>press Tab as many times as needed to activate the appropriate input field, and then enter the resulting dimension. Press Enter.</td>
</tr>
</tbody>
</table>

| raise or lower the elevation by a specified dimension | drag the cursor to begin raising or lowering the elevation. Press Tab as many times as needed to activate the appropriate input field, and then enter the relative dimension. Press Enter. |

**TIP** To use the dimension input fields, both dynamic input (on the status bar) and the Dimension Input drafting setting must be turned on (default). If you have turned them off, you can specify the new elevation by dragging the cursor and specifying a point in the drawing, or by entering the coordinates in the command window.
Rotating Pipe Components

1 Select the in-line part, pipe fitting, or takeoff.

2 Rotate the object as follows:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>rotate the object 180 degrees (flip the object)</td>
<td>click the flip grip on page 394 ( ).</td>
</tr>
<tr>
<td>rotate the object 90 degrees</td>
<td>while pressing CTRL, click the flip grip ( ).</td>
</tr>
<tr>
<td>rotate the object to an angle you specify</td>
<td>click the rotate grip ( ), and do one of the following:</td>
</tr>
<tr>
<td></td>
<td>■ enter the new absolute angle in the active dimension input field.</td>
</tr>
<tr>
<td></td>
<td>■ drag the cursor to reduce or increase the angle, click Tab to activate the dimension input field for specifying the angle change, and enter the value.</td>
</tr>
<tr>
<td></td>
<td>■ drag the grip to a new location.</td>
</tr>
<tr>
<td></td>
<td>■ enter the value in the command window.</td>
</tr>
</tbody>
</table>

Modifying the Length of a Pipe Segment

1 Select the pipe segment.

2 Select the lengthen grip on the end you want to modify.

3 If the segment is connected to an object on the end you selected, specify whether and how to maintain connectivity:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>maintain connectivity by adjusting only pipe fittings and segments, and retain the current locations of parts</td>
<td>proceed to the next step.</td>
</tr>
<tr>
<td>If you want to...</td>
<td>then...</td>
</tr>
<tr>
<td>------------------</td>
<td>---------</td>
</tr>
<tr>
<td>maintain connectivity by adjusting all objects including parts</td>
<td>press Ctrl.</td>
</tr>
<tr>
<td>break connectivity</td>
<td>press Ctrl twice.</td>
</tr>
</tbody>
</table>

### 4 Specify the segment length:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify the new total length</td>
<td>press Tab to activate the input field for specifying the resulting dimension, and then enter the new length. Press Enter.</td>
</tr>
<tr>
<td>specify the difference between the current length and new length</td>
<td>drag the cursor to begin lengthening or shortening the segment, and then enter the change in length in the input field that is active by default. Press Enter.</td>
</tr>
<tr>
<td>specify a new endpoint</td>
<td>drag the grip to the endpoint, and click to specify the point.</td>
</tr>
</tbody>
</table>

**NOTE** To use the dimension input fields, both dynamic input (on the status bar) and the Dimension Input drafting setting must be turned on. They are turned on by default. If you have turned them off, you can specify the new length by selecting a stretch point in the drawing or entering one in the command window.

---

**Modifying Pipe Equipment**

You can modify MvPart properties, including location, elevation, size, or system assigned to its connectors.

**RELATED** See *Mechanical, Electrical, and Plumbing Equipment in Building Systems* on page 110.
Modifying the Location or Elevation of an MvPart

You can change the location or elevation of an MvPart using the Properties palette or the Multi-view Part Properties dialog. Either method causes the MvPart to break from any pipe runs to which it is currently connected.

Using the Properties palette

1. Select the MvPart on page 110 to modify in the drawing.
2. On the Properties palette on page 466, under Placement, specify a location or orientation change:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>change the elevation</td>
<td>specify an elevation.</td>
</tr>
<tr>
<td>rotate the MvPart around its normal axis</td>
<td>specify a value for Rotation.</td>
</tr>
</tbody>
</table>
| enter coordinates to specify a new location | 1 Click (Additional information).  
2 In the Location worksheet, under Insertion Point, specify the new X, Y, and Z coordinates and click OK. |
| change the normal axis, and reorient the part along the new normal | 1 Click (Additional information).  
2 In the Location worksheet, under Normal, specify 1 for the normal axis and 0 for the other 2 axes and click OK. |

Using the Multi-view Part Properties dialog

1. In the drawing, select the MvPart on page 110 to modify.
2. Click Equipment tab ➤ Modify panel ➤ Equipment Properties .
3. In the Multi-view Part Properties dialog, click the Location tab.
4 Specify the location or orientation change, and then click OK, as follows:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>rotate the part around its normal axis</td>
<td>Under Rotation, specify a value for Angle.</td>
</tr>
<tr>
<td>enter coordinates to specify a new location</td>
<td>Under Insertion Point, specify the new X, Y, and Z coordinates.</td>
</tr>
<tr>
<td>change the normal axis and reorient the part along the new normal</td>
<td>Under Normal, specify 1 for the normal axis and 0 for the other 2 axes.</td>
</tr>
</tbody>
</table>

**Modifying Piping Equipment**

1 Select the MvPart on page 110, and click Equipment tab ➤ Modify panel ➤ Modify Equipment ➤ Modify Equipment.

2 In the Multi-view Part Modify dialog, on the Part tab, under All Installed MvParts, specify a part. Expand subfolders as needed.

3 Specify a part size for Part Size Name.

**NOTE** The part size name list displays the available part sizes in the range of the current part. If the part size is not available, proceed to the next step to specify filters and ranges.

4 On the Part Filter tab, under Connections, for Nominal Connection, select a size range (such as in this format: 4-72). To filter the number of sizes available for viewing, for Display, enter a number within the allowable range.

**Shows Display filter**

| Display | 9 of 15 parts |

5 Under the part graphic, click ▼ or ▲ to step through the available part size names in the selected range. Select a size for Part Size Name.
Matching an MvPart of One Type to Another

1 Select the MvPart on page 110 to change.

2 Click Equipment tab ➤ Modify panel ➤ Modify Equipment.

3 In the Multi-view Part Modify dialog, click MATCH (Match).

4 In the drawing, select the MvPart you want to match.

5 Press Enter to match both the part and the elevation.

6 Click OK in the Multi-view Part Modify dialog to complete the match.

Modifying the K-Factor

1 Select the MvPart on page 110 (for example, sprinkler) you want to modify (see Mechanical folder ➤ Fire Protection).

2 Click Equipment tab ➤ Modify panel ➤ Modify Equipment.

3 In the Multi-view Part Modify dialog, click the K-Factor tab.

4 Specify a new value for K-Factor and click OK.
Modifying the System for an MvPart Connector

When you add an MvPart on page 110 to a drawing, no systems are assigned to its connectors. If you connect a pipe run to an MvPart connector, the connector inherits the system setting from the connecting pipe object.

You can specify the system for MvPart connectors. Then, if you use the add grip to begin drawing pipe runs directly from the MvPart, the system is already specified for the new run.

If you change the system for an MvPart connector that is connected to a pipe run, the system for the pipe run changes to match that of the MvPart connector.

To change the system assigned to an MvPart connector

1. In the drawing, select the MvPart to modify.
2. Click Equipment tab ➤ Modify panel ➤ Equipment Properties.
3. In the Multi-view Part Properties dialog, click the Systems tab.
4. In the System column, click the cell for the connector you want to specify.
5. Select a system from the list, and click OK.

Modifying Pipe

You can modify many aspects of pipes, flex pipes, and pipe fittings, including type, size, location, system, and connected pipe runs.

Modifying the Routing Preference and Nominal Size

You can apply a different routing preferences on page 367 to a pipe run to change connection types, such as change a run from flanged connections to grooved. You can also change pipe type, such as change commercial pipe to iron pipe.

1. Select a pipe segment in a run.
2. On the Properties palette on page 466, under Dimensions, specify a routing preference.
3. Under Dimensions, select a nominal size.
IMPORTANT  The available sizes include those common to all of the pipes and fittings specified in selected routing preference. This ensures that you select a pipe size that matches fittings of the same size. (The sizes are also grouped according to the size ranges defined in the routing preference.) If a size is not available, select a different routing preference, or modify the parts in the size ranges in the current routing preference.

4 Click Pipe tab ➤ Modify panel ➤ Modify Run ➤ .
5 In the Modify Pipe Run dialog on page 174, change the routing preferences and other settings for objects connected to the selected object.

Modifying the Pipe or Fitting Location

1 In the drawing, select the part to modify.
2 On the Properties palette on page 466, under Placement, specify the location or orientation to change:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>change the elevation</td>
<td>enter a different value for Elevation.</td>
</tr>
<tr>
<td>rotate the MvPart around its normal axis</td>
<td>specify a value for Rotation.</td>
</tr>
</tbody>
</table>
| enter coordinates to specify a new location | 1 Click (Additional Information).  
2 In the Location worksheet, under Insertion Point, specify the new X, Y, and Z coordinates and click OK. |
| change the normal axis, and reorient the part along the new normal | 1 Click (Additional Information).  
2 In the Location worksheet, under Normal, specify 1 for the normal axis, and specify 0 for the other 2 axes, and then click OK. |

3 Deselect that part, and then select the fitting in the drawing you want to modify.
4 On the Properties palette on page 466, click (Additional Information).

5 In the Location worksheet, specify the location or orientation to change and then click OK.

If you want to... then...

<table>
<thead>
<tr>
<th>rotate the part around its normal axis</th>
<th>Under Rotation, specify a value for Angle.</th>
</tr>
</thead>
<tbody>
<tr>
<td>enter coordinates to specify a new location</td>
<td>Under Insertion Point, specify the new X, Y, and Z coordinates.</td>
</tr>
<tr>
<td>change the normal axis, and reorient the part along the new normal</td>
<td>Under Normal, specify 1 for the normal axis, and specify 0 for the other 2 axes.</td>
</tr>
</tbody>
</table>

**Breaking or Merging Pipe Segments**

You can break or merge pipe segments in a pipe run. For example, you can break 1 pipe segment into 2 or more adjacent segments. You can also merge 2 or more adjacent pipe segments to form 1 pipe segment. You can apply the break or merge command to all or part of a pipe run.

**To break or merge pipe segments in a pipe run**

1 Select a pipe segment to break or merge.

2 Click Pipe tab ➤ Modify panel ➤ Pipe Length ➤ Pipe Length. For more information, see Pipe Length and Cut Length on page 406.

3 In the Pipe Length dialog, specify the segments to break or merge:

If you want to... then...

| apply the length command to the entire pipe run | select Apply to Pipe Run. |
If you want to... then...

| manually select segments to modify | click \(\text{Select Objects}\), and select specific segments to break or merge. |

4 Specify the operation:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>break a segment</td>
<td>select Break, and enter a value for Pipe Length. You can also click (\text{Pipe Length}), and specify a start point and endpoint for the new length. The cut length for the pipe segments is the same as the break length.</td>
</tr>
<tr>
<td>merge multiple segments that are adjacent, connected, and aligned along the same centerline</td>
<td>select Merge, click (\text{Select Objects}), and select the segments to merge.</td>
</tr>
</tbody>
</table>

**NOTE** The last used *routing preference* on page 367 is preserved.

5 For Joint direction, select the orientation of fittings during layout. This setting specifies how male and female joints are orientated as you draw pipe. For example, if you select Male into female, the male connector is drawn first and then the female connector is
drawn after the joint. For more information, see Male-Female Fittings and Joint Direction on page 403.

6 (Optional) Use the Properties palette to verify cut length for full-length segments. See Connector Engagement Length on page 404 and Pipe Length and Cut Length on page 406 for more information.

Locking the Size of a Pipe or Fitting

You can lock the nominal size of an existing pipe or fitting to ensure that it is not accidentally changed when you are modifying the pipe routing. For example, you might lock the diameter if a pipe run passes in close proximity to building elements or other systems, and the pipe diameter cannot be increased without interfering with other components.

To lock the nominal diameter

1. Select the pipe segment or fitting to lock.
2. On the Properties palette on page 466, under Dimensions, select Locked for Size lock (Unlocked by default).

When locked, the nominal size list is inactive and the pipe or fitting diameter cannot be modified. You can, however, still modify the length or elevation of a pipe segment. To turn off a size, unlock this setting on the Properties palette.

Modifying the System Assigned to a Pipe

1. Select a pipe segment in the pipe run.
2. On the Properties palette on page 466, select a system.

TIP Alternatively, you change the system by clicking Pipe tab ➤ Modify panel ➤ Modify Run ➤ .

3. (Optional) To modify the system for a connected run, click Pipe tab ➤ Modify panel ➤ Modify Run ➤ .
4. Specify a system and other properties, as desired, on the Modify Run dialog. For more information, see Modifying Connected Objects Along a Run.
Modifying a Pipe Fitting

You can modify a fitting. For example, you can change an elbow from a standard radius to a long radius. However, you cannot change it to another type — for example, an elbow to a cross.

1 Select the pipe fitting.
2 On the Properties palette on page 466, click the image next to Part.
3 In the Select a Part dialog, choose a part from the catalog.
4 Select Display/Hide additional parameters to expand the contents of the parameters table.
5 Under Filter by Dimensions, filter the list of parts.

**NOTE** The part catalogs and content locations determine the parts that you can add.

6 Select a part size.

**NOTE** If you specify a fitting size that is different from the objects connected to the fitting, you can modify the connected pipe segments in the pipe run on page 174.

7 On the Properties palette, under Placement, specify an elevation.

**NOTE** If you are inserting a fitting in an existing pipe run, you do not need to specify the elevation. The fitting inherits both the elevation and system from the pipe run when you insert it.

Modifying the Layout of a Flexible Pipe

1 Select the flexible pipe segment.
2 On the Properties palette on page 466, expand Advanced, and then expand Geometry.
3 Click the left or right arrows at Vertex directly under Geometry to toggle to the desired location along the spline.

**NOTE** This procedure uses the spline segment mode.

4 Specify values for the X, Y, and Z vertices.
For flexible pipe that was drawn using any of the segment modes (line, arc, or spline), you can use grips to move the location of control points.

1. Select the flexible pipe segment.
2. Select the location grip to move the segment to a new location.

**TIP** Click the location grip and then the Ctrl key once to maintain the connection with the MvPart. Click the location grip and then the Ctrl key twice to break the connection.

---

**Modifying Insulation on a Pipe or Fitting**

1. Select one or more pipe segments or pipe fittings.
2. On the Properties palette on page 466, expand Advanced.
3. Specify the properties for insulation thickness:

<table>
<thead>
<tr>
<th>If you want to</th>
<th>then</th>
</tr>
</thead>
<tbody>
<tr>
<td>modify insulation</td>
<td>specify a value for Thickness (default is 0).</td>
</tr>
<tr>
<td>remove insulation</td>
<td>enter 0.</td>
</tr>
</tbody>
</table>

**NOTE** Insulation is an annotation element, not an object. You can only view insulation on pipe displayed as 2-line.

---

**Checking Connectivity in a Pipe System**

Take the appropriate action to check connectivity in a pipe network:

<table>
<thead>
<tr>
<th>If you want to</th>
<th>then</th>
</tr>
</thead>
<tbody>
<tr>
<td>show solution tips on all systems</td>
<td>Click View tab ➤ MEP View panel ➤ Solution Tip ▲. All disconnects are highlighted in red.</td>
</tr>
<tr>
<td>check connectivity between adjacent parts</td>
<td>Select a pipe, and click Pipe tab ➤ Modify panel ➤ Show Connected Objects drop-down ➤ Show Connected Objects ▶.</td>
</tr>
</tbody>
</table>
If you want to… then…

check connectivity on a pipe run (a pipe run terminates at a junction such as a tee)
Select a pipe, and click Pipe tab ➤ Modify panel ➤ Show Connected Objects drop-down ➤ Show Connected Run ➤ .

check connectivity among pipe branches
Select a pipe, and click Pipe tab ➤ General panel ➤ Select System drop-down ➤ Select Connected Branch ➤ . Press Tab to cycle through the connected upstream and downstream branches.

Modifying a Label or Flow Arrow

After placing a label in your drawing, you can apply a new style, change the spacing along the object, or change its appearance. Note that the software automatically updates a label attached to a pipe if the parent object is modified.

To modify a label using grips

1 Select a label to turn on the pipe grips on page 385.

2 Specify the change:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>add a label</td>
<td>click the add grip on page 385. Hold down Ctrl while clicking to add labels at even spacing.</td>
</tr>
<tr>
<td>move a label</td>
<td>click the location grip on page 387, and move the label to a new location along the curve. Press Ctrl after clicking the location grip to offset the label from the curve.</td>
</tr>
</tbody>
</table>
If you want to... | then...
---|---
add labels spaced at a specific distance along a curve | click the Repeat Distance grip, and click along the curve to specify a distance from the beginning of the curve to the selected point. Labels are added along the curve, spaced at the specified distance.
space multiple labels evenly along a curve | hold down Ctrl and click the Repeat Distance grip.

To modify a label from the ribbon or context menu

1 Select a label and do one of the following:

| If you want to... | then... |
---|---|
add a label node | click Label tab ➤ General panel ➤ Add Selected drop-down ➤ New Label Node ➤ , and select a point on or near the object. |
remove a label node | click Label tab ➤ Modify panel ➤ Delete ➯. |
offset a label node | click Label tab ➤ Modify panel ➤ Offset ➯, enter an offset distance, and press Enter. You can offset an individual label, or you can offset all labels in your drawing. |
rotate a label node | click Label tab ➤ Modify panel ➤ Rotate ➯, select a rotation point, and enter a rotation value. You can rotate an individual
If you want to… then…

label, or you can rotate all labels in your drawing.

anchor the label to a different object

click Label tab ➤ Modify panel ➤ Move To Object <>, and select the new object to which to anchor the label.

2 To change the label properties, select the label in the drawing, and then on the Design tab of the Properties palette on page 466 under Dimensions, modify the layout method as follows:

<table>
<thead>
<tr>
<th>If you want to display the labels…</th>
<th>then select…</th>
</tr>
</thead>
<tbody>
<tr>
<td>one at a time</td>
<td>One by one</td>
</tr>
<tr>
<td>evenly spaced along the curve</td>
<td>By distance, and enter a value for distance.</td>
</tr>
<tr>
<td>with a repeated spacing value</td>
<td>By quantity, and enter a value for the number of labels.</td>
</tr>
</tbody>
</table>

3 Select a new label style.

**NOTE** The configuration of the label curve style determines whether labels that use the style are considered annotative (scaled accordingly when the annotation scale changes). For more information, see Annotative Objects on page 815.
This section describes how to use AutoCAD MEP to create and modify the radiators, valves, and the pipe work used in radiant heating systems.

**Radiant Heating Systems Overview**

Refer to the following workflow for creating and modifying radiator systems:

<table>
<thead>
<tr>
<th>Review the steps</th>
<th>View more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up a project</td>
<td>Specify tool catalogs to use and other project information. See <em>Working with Projects</em> on page 199</td>
</tr>
<tr>
<td>Import radiator data files</td>
<td>Use the BDH files that contain radiator data in your drawings. See <em>Creating Radiator Parts</em> on page 490</td>
</tr>
<tr>
<td>Place radiators in drawing</td>
<td>Use windows and walls to locate and orient radiators. See <em>Adding a Radiator MvPart</em> on page 497</td>
</tr>
</tbody>
</table>
Creating Radiator Parts

Radiator data in BDH files derive from radiator manufacturers, heating load calculation applications (such as SOLAR COMPUTER Desktop), and design software in the D A CH radiator market. Radiator data includes length, width, height, company name, and part name. You import a BDH file (.dat) and then create the radiator definitions in the MvParts (DEU).apc catalog in AutoCAD MEP. You use Multi-view parts (MvParts) to model the size and shape of the
real-world parts, such as radiators. AutoCAD MEP organizes MvParts, such as radiators, by type and stores that data in part catalogs. A default radiator template controls the graphic look of the radiator. This template is located at \ProgramData\Autodesk\MEP 2011\enu\MEPContent\Global\MvParts\Plumbing\Radiators\Radiator Template_gbm.xml. You can change the template to modify the radiator’s appearance. See How Catalog Parts are Stored and Referenced on page 117.

NOTE Ensure that you select the AutoCAD MEP D A CH profile on the Profiles tab of the Options dialog. See Creating Drawing Environment Configurations for Users on page 117.

To create custom radiator parts

1 Click ➤ Open ➤ BDH Radiator Content.

2 In the Import BDH File dialog, under Part Catalog, select the MvParts catalog where the parts will reside.

3 Under Select BDH File, browse to the BDH file (.dat) and select it. Chapter Name updates with the manufacturer name from the file and the targeted number of created or updated parts.

4 Click OK.

The software updates the parts in the Plumbing ➤ Radiator folder of the MvParts catalog under the specified folder name. AutoCAD MEP organizes parts according to the subchapter names specified in the BDH file and also updates existing radiators. For more
Using a Calculation Program to Add Radiators

You can use a heating calculation program, such as SOLAR COMPUTER Deskstop, to determine the:

- Number of radiators to insert
- Radiator part type to use
- Size of each radiator required to heat specified spaces in an AutoCAD MEP drawing

This procedure uses the data file (.dat) in BDH format to define the set of available radiator parts used in both the calculation program and in AutoCAD MEP. You can download BDH files from a radiator manufacturer.

To place radiators in an AutoCAD MEP drawing using a heating calculation program, you create data files that are exchanged between the heating calculation program and AutoCAD MEP.

Use the following workflow to place radiators in an AutoCAD MEP drawing using SOLAR COMPUTER Desktop.

1. In AutoCAD MEP, create a gbXML (Green Building XML) file for the spaces in the drawing to place radiators. See Exporting Drawing Information for Analysis on page 495.
2. In SOLAR COMPUTER Desktop, import the gbXML file.
3. In SOLAR COMPUTER Desktop, import the BDH file that describes available radiator types and sizes.
4. In SOLAR COMPUTER Desktop, calculate the type, size, and number of radiators required to heat each space in the AutoCAD MEP drawing.
5. In SOLAR COMPUTER Desktop, export an XML file that contains the calculated radiator data.
6. In AutoCAD MEP, import the BDH file to create the required radiator part types and sizes. See Creating Radiator Parts on page 490.

**NOTE** You only should import the BDH file if you intend to modify the radiators after they are placed in the drawing.
7 In AutoCAD MEP, import the XML file created by SOLAR COMPUTER Desktop to place the radiators in the drawing.

Adding Radiators Using Calculated Data

You can add radiators to a drawing using data from an XML file produced by a heating calculation program such as SOLAR COMPUTER Desktop. The XML file contains an identifier for one or more of the spaces in the model. Each space identifier in the file precedes a list of the radiators to be placed into the space.

**NOTE** If the current drawing includes multiple copies of the same xref, the software operates only on the first copy and ignores the other copies.

**IMPORTANT** For each space in the file that matches a space in the drawing, the software processes the associated radiator list depending on the selected layout method.

To add new radiators to a drawing using calculation data

1. In the Piping workspace on page 53, click Insert tab ➤ Import panel ➤ Radiator.
2. In the Import Radiators dialog, under Select file, browse to the XML file that contains the imported calculation data, and open it.

![Import Radiators dialog](image)
3 For Layout method, select one of the following.

- **Automatic: Spaces**
  The software places the radiator by applying the positioning options to a window and its wall. The software adds a radiator beneath each window in the space. It matches the length of the radiators in the list to the width of the windows in the space. If the list contains more radiators than the number of windows currently in the space, the software zooms to that space and prompts you to enter 2 points to place the additional radiators.

- **Manual: Two points**
  The positioning options apply to the line defined by the specified left and right points. The software zooms to the space being processed. For each radiator in the list, the software prompts you to enter 2 points to position the radiator within the space.

4 Specify the positioning options for the radiators.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>center each radiator</td>
<td>for Justification, select Center.</td>
</tr>
<tr>
<td>place each radiator off center</td>
<td>for Justification, select Left or Right, and for Offset, enter a distance.</td>
</tr>
<tr>
<td>place each radiator a specified distance from a wall</td>
<td>for Distance from wall, enter a value.</td>
</tr>
</tbody>
</table>

5 For Elevation, specify an elevation, or enter a value.

6 If the XML file specifies a radiator part size that does not already exist, in the Missing Radiator Parts dialog, select one of the following:

- **Create Custom Parts**: Adds the missing radiator parts to the current drawing. The software does not create the parts in the MvParts catalog or make them available for use in other drawings. You can reference the added radiators for tasks such as scheduling. However, the capability for changing them is limited.

**NOTE** Click Always create custom parts if you do not want the dialog to display again.
Cancel: Ends the processing so that you can create the required radiator parts in the MvParts catalog and then run the command again. The parts will then be available for use in this or other drawings. (See Creating Radiator Parts on page 490.)

7 If the file contains more radiators than windows for a space, the software zooms to the space. Follow the prompts and enter 2 points to place each radiator.

Rules About Updating Existing Radiators

The drawing information you export to a gbXML file in AutoCAD MEP includes information about the existing radiators. A calculation program, such as SOLAR COMPUTER Desktop, uses this information during its calculations. The program includes any required changes to existing radiators in the resulting XML file.

When you import SOLAR COMPUTER Desktop’s XML file into AutoCAD MEP, these rules apply to existing radiators:

■ When data for an existing radiator is encountered in the XML file, AutoCAD MEP updates the drawing with the part type and size of the radiator. The software maintains any valves connected to the radiator in the drawing. It also adjusts connections to pipes to accommodate the new part type and size if possible.

■ The positioning options specified in the Import Radiator dialog (such as Justification, Distance from Wall, and Elevation) are not applied when an existing radiator is updated.

■ The software deletes radiators with no corresponding information in the XML file from the drawing.

■ The software updates only the radiators in the current drawing but ignores radiators in other xrefs associated with the drawing. You must import radiators into each of these xrefs to update them.

Exporting Drawing Information for Analysis

In AutoCAD MEP, you use spaces to model the interior areas of rooms as explained in Adding Spaces to a Floor Plan on page 324. You group the spaces...
into zones that represent the real-world heating and cooling zones. See Attaching Spaces to Zones on page 330 for more information.

After you create spaces and group them into zones, you can export the information to a file in the Green Building XML (gbXML) format as follows.

1 Click ➤ Export ➤ gbXML.
   If necessary, you can scroll down to locate the command from the list.

2 In the gbXML Export dialog, for File Name, specify a file name and folder.
   ![gbXML Export dialog]

3 Click Select Objects to choose the zones to be exported.
4 Specify a building type and zip code.
5 Click Start.
6 If an error occurs during the export process, click View Event Log to learn more about the error.
Designing Radiant Heating Systems

You can quickly and easily add radiator MvParts to selected spaces, windows, or locations in a drawing. After a radiator is in place and connected to valves and piping, you can modify its type, size, elevation, and location while maintaining those connections.

For information about using calculation programs to add radiators to a drawing, see Using a Calculation Program to Add Radiators on page 492.

Adding a Radiator MvPart

1 In the Piping workspace, click Home tab ➤ Build panel ➤ Equipment drop-down ➤ Equipment.

2 Navigate to Plumbing - Radiators in the tree view of the Add Multi-view Parts dialog, and for Part Size Name, select a part size name from the list.

You can select a part size name for the radiator or let the software calculate the correct part size on the Layout tab (described later in this procedure).

3 For Elevation, select a value.
4 (Optional) Click the Display/Hide additional parameters check box to toggle between displaying or hiding additional parameters in this dialog.

**TIP** You can click Details to view the available sizes for the current radiator.

5 On the Layout tab, under Layout Method, select the method for adding the radiators to the drawing.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>place radiators relative to every window in selected spaces</td>
<td>select Spaces.</td>
</tr>
<tr>
<td>place radiators relative to selected windows</td>
<td>select Windows.</td>
</tr>
<tr>
<td>specify 2 points for each radiator to be placed</td>
<td>select Two points.</td>
</tr>
<tr>
<td>place radiators by specifying the insertion point</td>
<td>select Insert point. Command-line prompts will ask you to specify insertion points.</td>
</tr>
</tbody>
</table>
6 Specify the positioning options for the radiators.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>center each radiator</td>
<td>for Justification, select Center.</td>
</tr>
<tr>
<td>place each radiator off center</td>
<td>for Justification, select Left or Right, and for Offset, enter a distance.</td>
</tr>
<tr>
<td>place each radiator a specified distance from a wall</td>
<td>for Distance from wall, enter a value.</td>
</tr>
</tbody>
</table>

7 If you want the software to calculate the radiator size, select Use Width from Window. You can also specify a value for Subtract Window Width by to decrease the width by the distance specified. The height and depth are predefined by the selected part size.

8 Select the objects or points used to place the radiators.

<table>
<thead>
<tr>
<th>If you selected this layout method...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spaces</td>
<td>select one or more spaces in the drawing or xref. The software places the radiators relative to each window in the selected spaces, according to the specified positioning options. The software adds the radiators to the drawing based on the location and dimensions of the specified windows. For each radiator, the software uses the closest available part size. This value is less than the window width minus the value for Subtract Window Width by.</td>
</tr>
<tr>
<td>Windows</td>
<td>select one or more windows in the drawing or xref, and click a point inside the building. The software places a radiator relative to each selected window.</td>
</tr>
<tr>
<td>Two points</td>
<td>specify the left and right points for each radiator to be added. The software applies the positioning options to the line defined by the specified left and right points. It calculates the radi-</td>
</tr>
</tbody>
</table>
If you selected this layout method... Then...

| Ator size using the distance between the 2 points instead of a window width. |

| Insert point | Specify insertion point |

If desired, modify the settings in the Add Multi-view Parts dialog and add additional radiators.

### Modifying a Radiator MvPart

When you modify a radiator, its connections to valves and pipes are maintained if possible. Branch pipes that connect the radiator to parallel pipes are adjusted to maintain the connection to the parallel pipes. If the connections to the parallel pipes cannot be maintained, the branch pipes will disconnect from the main run and move along with the radiator.

To modify a radiator, you use the same procedures that apply to all MvParts, as follows:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the part type, size, or elevation of a radiator.</td>
<td>Select one or more radiator MvParts, and then click Equipment tab ➤ Modify panel ➤ Modify Equipment. Modify settings in the Multi-view Part Modify dialog. See Modifying Piping Equipment on page 476 for more information.</td>
</tr>
<tr>
<td>Tip You can also change elevation on the Properties palette.</td>
<td></td>
</tr>
<tr>
<td>Move a radiator.</td>
<td>Use the (Location) grip. See Moving Pipe Components Using Location Grips on page 470.</td>
</tr>
<tr>
<td>Move and connect an unconnected radiator.</td>
<td>Use the (Alignment) grip to connect and align the radiator to a connector. See Connecting MvParts Using Alignment Grips on page 503.</td>
</tr>
</tbody>
</table>
Radiator Valves

In AutoCAD MEP, radiator valves are MvParts. You can use grips to perform many of the operations involving radiator valves.

Adding a Radiator Valve

1 Select a radiator.

2 Click the (Add) grip on a radiator connector.

3 In the Add Multi-view Parts dialog, use the Part and Part Filter tabs to select a valve type and size. See Placing a Pipe MvPart in a Drawing on page 428.

4 Press Enter to add the valve to the connector.

5 Press Enter to end the command.

NOTE You can use a rotate grip to flip the valve 180 or 90 degrees. See Modifying a Radiator Valve on page 502.
## Modifying a Radiator Valve

To modify a radiator MvPart valve, use the same procedures that apply to all MvParts as follows:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>change the valve type</td>
<td>Select the MvPart, and then click Equipment tab ➤ Modify panel ➤ Modify Equipment. See Modifying Piping Equipment on page 476. The valve’s connections with the radiator and any pipes are maintained if possible.</td>
</tr>
<tr>
<td>rotate the valve 180 or 90 degrees</td>
<td>use the arrow-shaped Rotate grip. See Rotating Pipe Components on page 473.</td>
</tr>
<tr>
<td>rotate a valve around a centerline to any angle</td>
<td>use the diamond-shaped Rotate grip in an isometric view. See Rotating Pipe Components on page 473.</td>
</tr>
</tbody>
</table>

## Moving a Radiator Valve

When a radiator valve is connected to a radiator, you can use grips to move it to a connector on the same radiator or another radiator. If you move the valve to a connector on the same radiator, connections to pipes are maintained if possible. If you move the valve to a connector on another radiator, connections to pipes are not maintained.

The type of grip used to move a valve depends on how the valve is connected.

- **Location grip:** Visible when the valve is connected to the main run. Use the location grip to move the valve to the same or a new radiator, maintaining the connection to the main run.

- **Alignment grip:** Visible when the valve is not connected to the main run. Use the alignment grip to move the valve and align it to another connector.
To move a radiator valve, do the following:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>move a radiator valve that is connected to a radiator and maintain the connections with piping if possible.</td>
<td>use the (Location) grip displayed at the valve connector. See Moving Pipe Components Using Location Grips on page 470.</td>
</tr>
<tr>
<td>move a valve and change its alignment.</td>
<td>use the (Alignment) grip displayed at the valve connector. See Connecting MvParts Using Alignment Grips on page 503.</td>
</tr>
</tbody>
</table>

**Connecting MvParts Using Alignment Grips**

You use the alignment grip to connect an MvPart to another object by aligning their connectors and placing the MvPart in the correct orientation. The alignment grip lets you accurately move a radiator valve to another side of the radiator.

The alignment grip only appears on an MvPart connector when you can move or realign the MvPart without affecting other connections. Otherwise, use the location grip on the connector to move the MvPart.

**To move a valve to another connector and maintain alignment**

1. Select the radiator valve MvPart.
2. Click the alignment grip on the valve/part you want to move.

3. Select another radiator connector to align the selected valve.
Creating Pipe Runs for Radiators

After you have placed the radiators in your drawing, use this procedure to create the parallel pipework for a radiator system.
1 Add the parallel pipes for the radiator supply and return. See *Adding Parallel Pipes to a Radiant Heating System* on page 506.

2 Add valves to the connectors on a typical radiator. See *Adding a Radiator Valve* on page 501.

3 Add branch pipes to connect the valves to the supply and return pipes. See *Connecting to Existing Pipe* on page 439 and *Connecting a Pipe Run to an MvPart* on page 442.
Copy the valves and branch pipe layout to similar radiators to connect them to parallel pipes. See Connecting Multiple Radiators to Parallel Pipes on page 510.

Adding Parallel Pipes to a Radiant Heating System

Use this procedure to route parallel runs in piping systems.

NOTE You cannot create sloped parallel pipes in AutoCAD MEP. As a result, sloped piping on page 420-related properties on the Properties palette will be disabled (unavailable). See Sloped Piping on page 373 for more information.

1 If necessary, activate the Piping workspace.

2 Create 2 or more starting parallel pipe segments. For each segment, specify properties, such as the routing preference and the system.

3 Click Home tab ➤ Build panel ➤ Pipe drop-down ➤ Parallel Pipes

TIP You can also start the command by entering ParallelRouting on the command line.

4 Select a baseline pipe.
Routing begins at the open end of the baseline pipe. If the pipe is open at both ends, select the pipe by clicking near the end where you want the routing to begin.
**5** Select one or more pipes to be routed parallel to the baseline pipe, and press *Enter*.
The baseline pipe becomes active.

**6** Add pipe segments.

The software adds pipe segments to the baseline pipe and the parallel pipe(s). Each pipe segment is created according to the routing preferences and properties specified for the starting pipe.
segment. A constant distance is maintained between the pipe segments where possible.

NOTE If the routing preference for one or more of the pipes does not specify a required pipe type or fitting, the Choose a Part dialog prompts you to specify a different part. See Choosing a Part on page 447 for more information.

7 If you make changes on the Properties palette, the following guidelines apply:

- A change to a property that guides the placement of the baseline pipe, such as Justification or Compass, applies only to the baseline pipe.

- A change that affects the physical characteristics of a pipe segment being created, such as Size or Insulation Thickness, affects all pipe segments in the run.

- A new Elevation value modifies the elevation of all pipes being routed. The distance between the pipes is maintained over the elevation change unless it results in a conflict.

- You cannot change some properties, including System, Routing Preferences, Fitting Settings, and Layout Method, while the ParallelRouting command is active.

8 To designate a different pipe as the baseline pipe, enter *b*. The current routing options, such as Justification or Compass, apply to the new baseline pipe.
To connect the baseline pipe to a radiator valve

9 Click the Pipe End Connector on the valve.

10 Enter a to accept the displayed solution.

Another pipe becomes the baseline pipe. When only one pipe remains to be routed, the ParallelRouting tool behaves like PipeAdd.

11 End the command by doing one of the following:
   ■ Connect the final pipe to an object, such as a radiator valve or another pipe.
   ■ Press Enter.

Correcting a Parallel Pipe Routing Conflict

When using the ParallelRouting command to add parallel pipes, you might specify a point or a property value that causes a conflict between 2 of the pipes being routed. This situation generally occurs when you specify a small turn or a change in elevation while routing pipes with different diameters, as shown in the following illustration:
When a conflict occurs, a dialog prompts you for action. Choose either of the following:

- Click Undo to restart from the last created pipe segment, and proceed by specifying a point or property that does not cause a routing conflict.
- Accept the proposed new distance between the parallel runs of pipe. This distance is maintained between the pipes as you continue routing them.

**Connecting Multiple Radiators to Parallel Pipes**

1. Add valves to the connectors on a radiator (the source radiator) and create branch pipes that connect the radiator to a set of parallel supply and return pipes.

See Adding a Radiator Valve on page 501, Connecting to Existing Pipe on page 439, and Connecting a Pipe Run to an MvPart on page 442.
2 Select the source radiator.
3 Right-click, and click Connect Multiple Parts.
4 Select one or more target radiators, and press Enter.

If the routing preference for a branch pipe does not specify a fitting for the connection, the Choose a Part dialog prompts you to specify a different fitting. See Choosing a Part on page 447 for more information.

**TIP** If you change a valve location on one radiator, run Connect Multiple Parts again to update all other connected radiators.

The target radiators are connected to parallel pipes using valve types and branch pipe properties copied from the source radiator. The following rules apply:

- Any existing valves or branch pipes are removed from the target radiator before it is connected.
- The valves from the source radiator are copied to the target radiator.
- The routing preferences from the source radiator branch pipes are used to create the branch pipes on the target radiator.
- The target radiator is connected to the same parallel pipes as the source radiator. If the source radiator’s parallel pipes do not run parallel to the target radiator, the target radiator is connected to the nearest set of parallel pipes within a reasonable distance from the radiator.
- The connectors on the source radiator are mapped to the connectors on the target radiator. For example, the valve and branch pipes attached to the lower-left connector on the source radiator will be copied to the lower-left connector on the target radiator. If there is not a direct one-to-one correspondence between the connectors on the source and target radiators, the software looks for the best possible match. If a match cannot be found, a connector on a target radiator might remain unconnected.
As much as possible, the connections between the systems specified for the parallel pipes are maintained. For example, if the Hot Water Return pipe system is connected to the right side of the source radiator, the Hot Water Return pipe system will be connected to the right side of the target radiator.

The connection to a target radiator can be adjusted even if the distance between the target and the parallel pipes differs from that of the source radiator.

Sometimes a target radiator cannot be connected. For more information about the causes of connection failures, see Correcting a Radiator Connection Failure on page 512.

Correcting a Radiator Connection Failure

The valves and branch pipes from the source radiator are copied to the target radiator even if the software cannot connect a target radiator to parallel pipes. You can then manually connect the branch pipes.

You can use Solution Tips to view information about connection failures and instructions for correcting them. See Showing Solution Tips on page 862.

The following conditions report a failed connection:

- The radiator is not parallel to the main pipes.
- The radiator is too close to the main pipe, preventing enough space for the fittings in the branch.
- The target radiator is placed on the wrong side of the pipes. The radiator might also be rotated 180 degrees.
- The radiators differ in type or orientation. For example, the target might be a single-panel radiator, and the source a two-panel radiator.
- The software could not find a match between all the connectors on the source radiator and the target radiator. In this case, some of the connections might have succeeded.
Drawing Electrical Systems

This section provides instructions for using AutoCAD MEP to design and draft the electrical systems for a building plan.

Electrical Systems Overview

AutoCAD MEP includes many features that you can use to create, modify, and plot electrical system designs. The topics in this section provide general information about electrical features.

Design Workflows for Electrical Systems

Use the electrical features in AutoCAD MEP during the design development and construction document phases of a building project to design and document a building’s electrical systems.

Define System Requirements

Click in the left column to view a task. The right column provides links to help topics that provide detailed procedures.

<table>
<thead>
<tr>
<th>Task</th>
<th>View more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create electrical system definitions</td>
<td>Name electrical systems and supply definitions for key elements by Creating Electrical System Definitions on page 534</td>
</tr>
</tbody>
</table>
### Design the Electrical System Project

Click in the left column to view a task. The right column provides links to help topics that provide detailed procedures.

<table>
<thead>
<tr>
<th>Task</th>
<th>View more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create load category definitions</td>
<td>Specify a demand factor for the calculation of circuit loads by Creating Load Category Definitions on page 536</td>
</tr>
<tr>
<td>Configure Electrical Preferences</td>
<td>Select voltages for the project, circuiting features, such as naming conventions and wire sizing factors, by Configuring Electrical Preferences on page 538</td>
</tr>
<tr>
<td>Define Design Specifications for Wires</td>
<td>Choose the characteristics of hot, neutral, and ground/isolated ground wires by Defining Design Specifications for Wire Styles on page 550</td>
</tr>
<tr>
<td>Select Equipment, Device, and Lighting Fixture Styles</td>
<td>Choose a wire cleanup method and drawing layer for lighting fixtures, junction boxes, and other devices by Device Style Setup on page 541</td>
</tr>
<tr>
<td>Create preliminary 1-line designs</td>
<td>Prepare the conceptual design for evaluation by building engineers and code officers. See About Schematic Diagrams on page 772</td>
</tr>
</tbody>
</table>
Task | View more information
--- | ---
Create an electrical project database | Create a repository for panel and circuit data by [Creating an Electrical Project Database](#) on page 564. You can create this database before or after you add circuits and panels to a drawing.
Add electrical equipment | Support your electrical system by [Adding Electrical Equipment](#) on page 620, including generators, transformers, and switchboards.
Add electrical panels | Place panels in your electrical layout by [Adding Panels](#) on page 596. You could also create one or more circuits at the same time.
Specify or leverage spaces, and use them to create room take-off schedules | To help calculate power totals and wire sizes, use any architectural drawing-supplied spaces, or specify your own. See [Adding Spaces to a Floor Plan](#) on page 324.
Place fixtures and devices | Add a receptacle to a wall and align it using this [Example: Aligning a Device to Floor Plan Geometry](#) on page 588. View additional examples of other methods for adding devices. Save time as you draw by duplicating existing drawing elements by [Copying Devices and Panels](#) on page 605.
Create circuits | Add power and lighting circuits for receptacles, small appliances, and light fixtures by [Creating Circuits Using the Circuit Manager](#) on page 569. You can create circuits for switches and junctions...
<table>
<thead>
<tr>
<th>Task</th>
<th>View more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw cable trays and conduits</td>
<td>Create pathways for electrical wiring by Adding Cable Trays and Conduits on page 622. You can specify elevation, slope, and branching options.</td>
</tr>
<tr>
<td>Add wires</td>
<td>Draw line, arc, snake, polyline, chamfer, or spline wires manually or generate them with a single command by Adding Wires on page 611.</td>
</tr>
<tr>
<td>Check and modify electrical systems</td>
<td>Calculate power totals and wire sizes by Checking Electrical Systems on page 639 and make needed changes by Modifying Electrical Systems on page 645.</td>
</tr>
<tr>
<td>Insert a panel schedule</td>
<td>Use MEP-supplied panel schedule tables to display the panel, circuit, wire, and load data for panels by Generating Panel Schedules on page 688.</td>
</tr>
<tr>
<td>Annotate the electrical system as you create it</td>
<td>As you design a system, add labels, tags, and documentation symbols to wire, conduit, and other components by Annotating Electrical System Drawings on page 683.</td>
</tr>
</tbody>
</table>
Circuits

In AutoCAD MEP, a circuit is a non-graphical element that stores circuit information in a database. AutoCAD MEP includes several circuit features such as creating and managing circuit assignments across an entire project, configuring circuits with assigned electrical properties such as electrical system, rating, voltage, and panel assignment, and assigning devices, such as lights and receptacles, to a specific circuit in a panel.

**RELATED** To use circuit features, see *Working with Circuits* on page 562.

Electrical Project Database

In AutoCAD MEP, an electrical project database is a file that contains the panels and circuits to which you assign devices and wires. The electrical project database resides in a file with the file extension of .epd. The devices that make up electrical systems reside in separate drawings that are linked to the electrical project database file.

Using the electrical project database file, you can create and share the most current circuit information across all drawings in an electrical project. It is required for any drawing that contains circuits.

**RELATED** For information about working with the electrical project database, see *Using an Electrical Project Database* on page 562.

Circuit Manager

The Circuit Manager displays the circuits defined in the drawing and in the project database. Circuits are organized by panel and system type, as shown next.
Circuit Manager

The left pane lists the available panels, circuit types, or circuits in the current drawing, or in all drawings if you are using the electrical project database). The right pane displays information about the selection in the left pane. Overloaded circuits display in red.

The header section contains information from the panel object properties and circuit settings for the selected panel, including voltage, phases/wires, panel rating and type, main rating size, design capacity, AIC rating, mounting, and enclosure.

The footer section contains calculations for connected loads and demand factor, including a summary and totals for connected loads for each load category, totals for each load category multiplied by the demand factor, demand load total and available spare capacity, and load distribution among the phases.

The Circuit Manager supports the following tasks:

- **Viewing** on page 572 information about circuits or panels
- **Creating** on page 569 new circuits
- **Configuring** on page 571 circuit properties
- **Deleting** on page 647 circuits
- **Linking** on page 573 panels
- **Calculating** on page 640 wire sizes
- **Generating** on page 642 a circuit report

While you can modify some circuit properties using the Circuit Manager, other properties are displayed for reference and are view-only. For example,
you can modify the name and description of a circuit, but the number of poles and phases (for ANSI) are not editable.

For circuits whose system type is specified as Power and Lighting, you can use the Circuit Manager to calculate wire sizes based on the circuit rating. When checking wire sizes, you can automatically resize them if they are undersized or oversized when compared to the calculated sizes.

System Types of Circuits

When you create a circuit, you specify its system type, such as Power and Lighting. The system type determines which components you can connect to a circuit.

Circuits are available in 3 system types. Devices and connection details are described next:

- **Power and Lighting** devices can only connect to circuits of the same type. Devices include receptacles, small appliances, and light fixtures.

- **General** devices can connect with all system types for special use cases. For example, switches and junction boxes, configured for the General system type, can be assigned to General, Power and Lighting, or Other circuits.

- **Other** devices can only connect with circuits of the same type. They include communication and fire safety components.

Generally, when you select a device, the system type property of the connector is already assigned. You can change connector properties. For more information, see Configuring the Electrical Connectors of a Device on page 583.

**NOTE** If you are using the Power and Lighting or Other system type, the connectors of the devices must use the same system type to be placed on the same circuit. To connect a device of any system type to a circuit, use the General system type.

Components of an Electrical System

Electrical objects are the components used to design electrical systems. Electrical objects include devices, panels, and wires. Objects, such as receptacles, switches, and telecommunications outlets, typically display symbolically and
are not drawn to scale in plan view. Objects, such as lights, also display symbolically, but they are scaled to their actual envelope dimensions in plan view. This scaling lets you place lights to achieve the desired lighting density and also enables you to check for interferences between larger electrical components and surrounding systems.

You can then draw cable tray and conduit runs in order to form complete electrical networks.

**Devices**

Typically, the first step in drafting an electrical plan, such as a power or lighting plan, is to place the devices and panels in the appropriate locations on the floor plan. AutoCAD MEP provides a library of electrical devices that includes most of the elements that you need to complete your plans:

- Power receptacles
- General lighting fixtures
- Fluorescent lighting fixtures
- Switches
- Communication devices
- Fire safety devices
- Junction boxes

Usually, you add devices in plan view to produce construction documents, but you can also display parts differently in different views. For example, in a 3D view of an electrical system, you can display the real-world geometry of the devices, while in a 2D plan view you can represent them as one-line symbols.
Examples of electrical devices

Panels

When drafting an electrical plan, such as a power or lighting plan, you place devices and panels in the appropriate locations in the floor plan. AutoCAD MEP provides a library of panels, such as recessed panels and surface door panels, to complete your plans.

Usually, you add panels in plan view to produce construction documents, but you can also display parts differently in different views. For example, in a 3D view of an electrical system, you can display the real-world geometry of the panels, while in a 2D plan view you can represent them as one-line symbols.

Electrical panels

You can create circuits as you add panels. You can also specify a naming convention for the circuits in the electrical preferences for the drawing.
Wires

After adding electrical devices to a layout, you can simultaneously connect the devices with wires and, if desired, assign the devices to a circuit. You can add wires on page 611 manually. If the devices are already assigned to a circuit, you can have the software generate wires.

**Connecting devices with wiring and a home run**

To maintain the connectivity of a circuit, wires are anchored to devices. As a result, when you move a device, the connected wires stretch accordingly.

While you can connect devices with wires to graphically represent circuits, wires are not necessary for you to assign devices to circuits and view electrical loads. However, adding wires without assigning circuits can be useful during the preliminary design phase when the specifications are not defined.

You use wire styles to distinguish different types of wiring configurations, for example:

- 1-pole for general lighting and power distribution
- Multi-pole for equipment and power distribution
- Low voltage for security, fire alarm, or communication

The wire style determines several wire properties, such as the wire material, the number of wires, and the annotation preferences.

After you have created a wire run, you can add labels to indicate the wire style or to identify the circuit to which the run is assigned.

**A wire segment with a label indicating the wire style**
Wire Size Calculations

You can automatically calculate wire sizes for circuited wire runs. As you add wire, you can use the instant sizing tool to automatically calculate wire sizes based on the circuit rating. You can also use the Circuit Manager to calculate wire sizes for any wires assigned to a circuit. Wire sizes are calculated based on the National Electrical Code (NEC) 2002 Handbook: Table 250.122 for ground conductors, and Table 310.16 for current-carrying conductors.

For more information, see Adding Wires on page 611, Modifying Wire Properties on page 664, and Calculating Wire Sizes Using the Circuit Manager on page 640.

Electrical and Wire Ways Snaps

Like all building systems objects, electrical objects have connectors that enable them to connect intelligently with each other, and transfer information along connected runs. As you draw electrical systems, you make these intelligent connections using 2 types of AutoCAD MEP snaps:

- **Electrical Snaps.** Used to make connections when adding wires to devices and panels.
- **Wire Ways Snaps.** Used to make connections to cable tray, conduit, and electrical MvPart on page 110 equipment.

Like all AutoCAD MEP snaps, electrical snaps and wire ways snaps have 2 subtypes:

- **End Connector Snaps.** Used to connect an object to an endpoint on another object.
- **Curve Connector Snaps.** Use these snaps to connect an object anywhere along the centerline of another object.
Wiring a junction box to a light with electrical snaps

Connecting one cable tray to another with wire ways snaps

Cable Trays and Conduits

You can draw cable tray and conduit runs in order to form complete electrical networks.

In the software, a run is the cable tray or conduit parts that encase or support wires, bringing them from one point, such as a junction box or a panel, to another point, such as the junction with another run. A network is a group of interconnected cable tray or conduit runs.

Viewing conduit and junction boxes in 3D
To add cable trays and conduits to a drawing, you draw the main runs, locating the risers. As you draw cable tray or conduit runs on page 625, you lay out wireway geometry by specifying points in the drawing. The software automatically adds fittings to connect segments when forming a run and to connect runs to risers and branches when forming a network (auto layout). You can also add fittings manually on page 638.

You can control which parts are inserted by configuring layout preferences before you begin drawing your wireway runs.

A cable tray or conduit run is made up of individually drawn segments. You draw a segment on page 622 by specifying its properties, and then specifying points in the drawing.

**Drawing a cable tray segment**

Once you have drawn the cable tray or conduit runs, you can connect them to form a complete cable tray or conduit network. AutoCAD MEP snaps can help you locate valid connection points on objects in your drawing. You can start a run at the end of a segment or run, or at any point along the path of another run. In this case, the software inserts an appropriate fitting to connect the 2 runs, creating a branch on page 631.

**Drawing a branch**

Cable tray and conduit components store properties such as connection type, size, system, and part type. When you connect to existing cable tray or conduit runs to create branches, part properties are inherited, providing a consistent method of drafting a layout. This ensures that you are creating intelligent building system designs.

Components of an Electrical System | 525
NOTE Once you have completed your connections, you can apply solution tips to test whether your connections are valid.

You can also assign systems on page 138 to cable tray and conduit to enable layouts to act together by maintaining the same look and feel throughout the system. For example, a group of cable tray runs can represent a power and lighting system, while another group of cable tray runs can represent a general system.

Finally you can add a schedule on page 842 that contains the tagged parts for conduit and fittings in a drawing.

Enhancements for Laying out Conduit Runs

The Electrical workspace includes enhancements for laying out conduit runs, including conduit routing preferences and a dedicated conduit Properties palette.

Conduit Routing Preferences

Use conduit routing preferences to draw accurate runs in auto layout. When you configure a routing preference to meet a particular industry standard or specification, the appropriate fittings are automatically inserted into the layout. Auto layout can generate different routing solutions, from which you can choose the best alternative. Conversely, you can change a routing preference as you add conduit segments to a run from the Properties palette. Nominal size on the Properties palette reflects the current routing preference.

A conduit part routing preference includes one or more connection types (such as set screw) in the available part sizes for conduits and fittings. A preview
of the selected part displays to the right of the dialog. The image to the right provides a graphical representation of the selected part.

<table>
<thead>
<tr>
<th>Type</th>
<th>Part</th>
<th>Part size range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conduit</td>
<td>Conduit EMT Set Screw GARM</td>
<td>1/2&quot; to 2-1/2&quot;</td>
</tr>
<tr>
<td>Elbow</td>
<td>Best Conduit EMT Set Screw ARM</td>
<td>1/2&quot; to 2-1/2&quot;</td>
</tr>
<tr>
<td>Tee</td>
<td>Box Tee EMT Set Screw GERM</td>
<td>1/2&quot; to 2-1/2&quot;</td>
</tr>
<tr>
<td>Transition C</td>
<td>Conduit Body Transition Type C EMT Set Screw GARM</td>
<td>1/2&quot; to 2-1/2&quot;</td>
</tr>
</tbody>
</table>

The next illustration shows conduit drawn using the set screw routing preference, shown in the SW Isometric view.

**Threaded IMC conduit routing preference — connected to junction box**

**Configuring Routing Preferences**

Use the Style Manager to configure conduit routing preferences.

1. In the **Electrical workspace** on page 53, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Routing Preference Definitions
2 Choose the desired action below.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>create new</td>
<td>in the left pane, right-click Conduit Routing Preferences, and click New.</td>
</tr>
<tr>
<td>copy existing</td>
<td>in the left pane, right-click a routing preference, and click Copy. Then right-click Conduit Routing Preferences, and click Paste.</td>
</tr>
<tr>
<td>configure properties</td>
<td>in the left pane, select a routing preference. In the right pane, click the General tab, and configure the desired properties, including name, description, and notes.</td>
</tr>
<tr>
<td>delete</td>
<td>in the left pane, right-click the routing preference you want to delete, and click Purge.</td>
</tr>
</tbody>
</table>

**Conduit Properties Palette**

Use the Design tab on the Properties palette to add or modify conduit segments and fittings, as described in the following sections.

**Basic Properties**

Basic properties reflect the default or the last stored value. When multiple objects are selected in the drawing, not all properties appear in the Properties palette. Those that do appear are designated with asterisk(s) as follows:

- * Appears when multiple conduit segments are selected
- ** Appears when multiple fittings are selected
- *** Appears when either multiple conduit segments or multiple conduit segments with fittings are selected

<table>
<thead>
<tr>
<th>General</th>
<th>Description</th>
<th>Conduit</th>
<th>Fitting</th>
<th>Add</th>
<th>Modify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description*</td>
<td>Describes the part</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Layer*</td>
<td>Specifies a layer style on page 203</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>System*</td>
<td>Specifies the system definition on page 534</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Part</td>
<td>Designates the part. Click the image to display the Select a Part dialog on page 638.</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Current size</td>
<td>Specifies the fitting size</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

### Dimensions

<table>
<thead>
<tr>
<th>Description</th>
<th>Conduit</th>
<th>Fitting</th>
<th>Add</th>
<th>Modify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>Displays the nominal diameter for each conduit connector</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>
| Path angle                                       | Specifies an angle value that represents the arc's scanning path. Angle values are stored in the catalog content and vary depending on the type of conduit fitting:  
- For conduit bend, angle selections range from 1 to 180.  
- For conduit elbow, the list displays radius values derived from the catalog content, such as 30, 45, 60, and 90. | ✔️       | ✔️       | ✔️   | ✔️     |
<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Description</th>
<th>Conduit</th>
<th>Fitting</th>
<th>Add</th>
<th>Modify</th>
</tr>
</thead>
<tbody>
<tr>
<td>90° path angle</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Radius of curvature</td>
<td>Specifies a radius dimension for the part based on the industry standard. The values originate from the conduit catalog content and vary depending on the part’s nominal size.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Part</td>
<td>Specifies the fitting part</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Nominal size*</td>
<td>Specifies the dimension, based on the outside and inside diameters of the conduit (as shown). Nominal size (also referred to as trade size) complies with industry standards.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Size</td>
<td>Prevents changing the nominal size</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

530 | Chapter 9  Drawing Electrical Systems
## Dimensions

<table>
<thead>
<tr>
<th>Description</th>
<th>Conduit</th>
<th>Fitting</th>
<th>Add</th>
<th>Modify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Routing preferences*</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Used to draw accurate runs in auto layout (based on the connection type)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>NOTE</strong> For more information, see Conduit Routing Preferences on page 526.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Specify cut length</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allows breaking of conduit segments. If Yes is selected, see Cut length (below).</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cut length</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If Yes is selected (above), specifies the cut length for each segment.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Placement

<table>
<thead>
<tr>
<th>Description</th>
<th>Conduit</th>
<th>Fitting</th>
<th>Add</th>
<th>Modify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elevation*</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Specifies the elevation above or below the XY plane of the object</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Elevation</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prevents a segment at 1 elevation from snapping to a segment at another</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start elevation</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Specifies the elevation at the start of the segment (equal to elevation)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>End elevation</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Specifies the elevation at the end of the segment</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move attached segments*</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maintains connectivity if the selected part’s elevation changes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional information***</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Displays the Location worksheet (connector 1 details); changes made affect all connectors on the object</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Placement

<table>
<thead>
<tr>
<th>Description</th>
<th>Conduit</th>
<th>Fitting</th>
<th>Add</th>
<th>Modify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify rotation on screen</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allows a fitting to be rotated in drawing. If No is selected, see Rotation (below).</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Description</th>
<th>Conduit</th>
<th>Fitting</th>
<th>Add</th>
<th>Modify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotation**</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If No is selected (above), specifies the fitting routing angle.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Description</th>
<th>Conduit</th>
<th>Fitting</th>
<th>Add</th>
<th>Modify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Justify</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Specifies the justification setting for a conduit segment</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**RELATED** For more information, see [Justification of Objects](#) on page 160.

<table>
<thead>
<tr>
<th>Description</th>
<th>Conduit</th>
<th>Fitting</th>
<th>Add</th>
<th>Modify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal/Vertical offset</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Specifies the placement offsets in the applicable direction from the insertion point</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Routing Options

<table>
<thead>
<tr>
<th>Description</th>
<th>Conduit</th>
<th>Fitting</th>
<th>Add</th>
<th>Modify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parallel bends</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Specifies the type of bend radius to use for parallel conduit routing. This option is only available when drawing parallel conduit runs on page 632. Selections include Concentric or Fixed radius. See below.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Concentric**

![Concentric Bend Example](image)
<table>
<thead>
<tr>
<th>Routing Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed radius</td>
<td><img src="image" alt="Fixed radius diagram" /></td>
</tr>
</tbody>
</table>

**RELATED** See Specifying Parallel Bends in the Conduit Run on page 635.

- **Slope format**: Specifies how the slope is represented (such as angle, percentage, rise/run). This property is also available in the Conduit Layout Preferences on page 560 dialog.

- **Slope**: Specifies the pitch of the drawn segment.

- **Bend angle**: Specifies the angle by which the routing is constrained (derived from the catalog). This property was formerly called elbow angle.

- **Bend**: Prevents the editing of the bend angle in auto layout.

**NOTE** The following properties are not available for parallel conduit routing: system, routing preferences, slope, and slope format.
Advanced Properties

Click on the Properties palette to expand Advanced properties.

<table>
<thead>
<tr>
<th>Additional Information</th>
<th>Description</th>
<th>Conduit</th>
<th>Fitting</th>
<th>Add</th>
<th>Modify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection details*</td>
<td>Displays the Connection Details on page 172 worksheet</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

| Preferences            | Displays conduit layout preferences on page 560 | ✔️ | ✔️ |

<table>
<thead>
<tr>
<th>Labels and Flow Arrows</th>
<th>Description</th>
<th>Conduit</th>
<th>Fitting</th>
<th>Add</th>
<th>Modify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style</td>
<td>If a label or flow arrow style is selected, specifies the layout method:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ By quantity: Number to add to each segment</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ By distance: Segment length (must be greater than the interval distance)</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Control the Appearance and Behavior of Electrical System Designs

You can configure various settings that control the appearance and behavior of objects in your electrical system designs.

Creating Electrical System Definitions

A system definition specifies behaviors and display properties that apply to all of the objects in a system. Typically, you create and name electrical system
definitions according to the real-world electrical systems that they represent, such as

- Device - Power - 277V
- Device - Lighting - 120V
- Conduit - Emergency

**TIP** The default templates contain several system definitions that you can copy and modify.

**To create an electrical system definition**

1. Click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Electrical System Definitions.
2. Create the system definition:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then in the left pane of Style Manager…</th>
</tr>
</thead>
<tbody>
<tr>
<td>create a new, blank system definition</td>
<td>right-click Electrical System Definitions, and click New. Enter a name, and press Enter.</td>
</tr>
</tbody>
</table>
| copy an existing definition | do the following:
  - Right-click the system definition you want to copy, and click Copy.
  - Right-click Electrical System Definitions, and click Paste.
  - Right-click the copy, click Rename, enter a new name, and press Enter. |

3. Use the tabs in the right pane to configure the system definition. Electrical system definitions have properties that are common to systems in other disciplines. For information about configuring these properties, see Creating Systems on page 141.
Creating Load Category Definitions

You can specify a demand factor to calculate the estimated demand load from a circuit. The demand factor can:

- Be a constant value
- Be a constant value for all motors, except the largest motor
- Vary depending on the load total
- Vary depending on the quantity of the objects

Each demand factor is assigned a value that is multiplied by the load to determine the demand for a load category. It is important to define a demand load so that you do not overload the circuit. Defining a demand factor also provides you with a real calculation of the estimated demand load.

For example, for the load category Lighting, with a demand factor of 1.00, if you have 10 lights at 60 VA each, the load is 60 VA x 10 (lights) = 600 VA. Therefore, the lights for the load of this load category would be 600 VA. However, this value applies only if all the lights are turned on at the same time. If you plan to have just half the lights on at a time, you would specify the demand factor as a constant value set to 0.5 (or 50%). The estimated load is then 600 VA x 0.5 (demand factor unit) = 300 VA. Building codes provide guidance what values to use for demand loads. For example, if the total receptacle load on a panel is 20,000 VA, the demand factor could be 15,000 VA depending on the local code.

Using a different example, if the demand factor were set to vary depending on the quantity of the objects, for example for elevators, the minimum demand factor value would be 72% (or .72). The estimated load is then 600 VA x 0.72 (demand factor unit) = 432 VA.
Demand factors are assigned to load categories and load categories are assigned to device connectors. The estimated load for a device is calculated by using the load and the value for the demand factor. The estimated demand load is displayed in the Circuit Manager and in the Panel Schedule. The Panel Schedule also shows the load for each load category style.

**TIP** The default templates contain several load category styles that you can copy and modify.

To create a load category definition

1. Click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Load Category Definitions ➤ Load Category Definitions. Right-click, and click New.
2. Enter a name, and press Enter.
3. Select the new load category style.
4. On the General tab, enter a description for the load category.
5. On the Demand Factor tab, select the demand factor type.
6. Specify the value(s) for demand factor as necessary.
Configuring Electrical Preferences

Before you begin creating circuits, you can specify electrical preferences for the following features:

- Voltages that will be available for the project
- Circuiting features, such as naming conventions, overload checks, and wire sizing factors
- An electrical project database file that contains panels and circuits for the project

NOTE For information about the electrical project database file, see Using an Electrical Project Database on page 562.

Specifying Voltage Definitions

Use the Voltage Definitions tab of the Electrical Preferences dialog to enter valid voltages for different numbers of poles. The voltage values are the default values available when you are working with devices and circuits.

Each voltage definition has a minimum value and maximum value that define the valid range when a device is to be connected to a circuit.

NOTE Voltage settings for 2-pole and 3-pole should be the same, otherwise some values may not be available in the Circuit Settings worksheet.

To define voltage definitions

1. From the Electrical workspace, click Manage tab ➤ Preferences panel ➤ Electrical.
2. In the Electrical Preferences dialog, click the Voltage Definitions tab.
3. Select a pole type, click (Add Voltage Definition), and then specify the voltage amount, the minimum value, and the maximum value.

NOTE To delete a voltage, expand a pole, select a voltage, and click (Remove Voltage Definition).
Configuring Circuiting Options

Use the Circuiting tab of the Electrical Preferences dialog to specify circuiting options, such as a default circuit naming convention, the type of overload protection to use when creating circuits, and the ambient temperature to use when calculating wire sizes.

The circuit naming convention determines the naming of all circuits. You define a naming convention by specifying a prefix, such as power, and a numbering system that can be used to sort through the circuits in your drawing. It is possible to create circuits even if there are no panels; in this case, the circuit uses the existing naming convention, and the circuit is designated as “unassigned.”

Total load is used when checking for overloads as you create circuits. Overload protection provides warning messages when circuits are overloaded.

**NOTE** Overload checks can only be used with circuits specified as Power and Lighting. Overload checks do not work with circuits specified as General or Other. These circuit types do not have current ratings or voltages assigned to them.

The ambient temperature that you specify is used to determine the correction factor for ampacity when calculating wire sizes as you add or modify wire runs. For more information about calculating wire sizes, see **Wires** on page 522.

**To specify circuiting options**

1. From the Electrical workspace, click Manage tab ➤ Preferences panel ➤ Electrical.
2. In the Electrical Preferences dialog, click the Circuiting tab.
3. If you want each drawing to use different names for circuits, select Require Unique Circuit Names per Drawing.
4. Specify a prefix and numbering convention to use for naming circuits:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then click…</th>
</tr>
</thead>
<tbody>
<tr>
<td>use no prefix</td>
<td>None.</td>
</tr>
<tr>
<td>use the panel name as a prefix</td>
<td>Panel Name.</td>
</tr>
<tr>
<td>create your own prefix</td>
<td>User defined, and enter the name in the box.</td>
</tr>
<tr>
<td>If you want to…</td>
<td>then click…</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>number circuits sequentially regardless of the number of poles</td>
<td>Use Sequential Numbers. Poles are created sequentially at the start number that you specify. For example, if the start number is set to 1, then the next pole added is assigned the number 2.</td>
</tr>
<tr>
<td>group circuit names by even and odd poles</td>
<td>Group using Number of Poles. Select this option when creating branch circuits to group together even and odd circuits. For example, if you are working with a 3 pole circuit, and you have a start number of 1, then the next pole created is numbered 3.</td>
</tr>
<tr>
<td>increase the circuit serial number when you add poles</td>
<td>Increase by Number of Poles. Select this option when you want to increase the serial number of the circuit by the number of poles. Each 1 pole needs 1 number, each 2 pole needs 2 numbers, and each 3 pole needs 3 numbers.</td>
</tr>
</tbody>
</table>

5 Select a Start Number from the list. The default value is 1. The serial number is attached to the end of the circuit name.

6 Under Overload, specify the overload protection method to use:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then select…</th>
</tr>
</thead>
<tbody>
<tr>
<td>automatically check overloads when creating circuits</td>
<td>Check Overload when circuiting.</td>
</tr>
<tr>
<td>show the circuits that are overloaded in the Circuit Manager</td>
<td>Display Overload in the Circuit Manager.</td>
</tr>
<tr>
<td>specify the maximum circuit rating percentage to allow before prompting</td>
<td>a percentage that, when reached, causes a prompt to be displayed.</td>
</tr>
</tbody>
</table>

7 Under Wire Sizing, specify a value for Ambient Temperature.
Specifying an Electrical Project Database File

Use the Electrical Project Database tab of the Electrical Preferences dialog to specify a file that serves as the electrical project database. For more information, see Using an Electrical Project Database on page 562.

Device Style Setup

Devices are a type of style-based content, which is the collective term for building system objects that use styles to define their appearance and behavior. When you add a device to a drawing, you are adding an instance of a style, and the software establishes a link between the object and the style that defines it. When you modify the style, the software updates the object accordingly.

Specifying Design Rules for Device Styles

The design rules of a device style specify:

- The type of device represented by the style
- The drawing layer on which devices of the style are placed
- The method of wire cleanup used for devices of the style

To specify the design rules of a device style

1 Open the drawing that contains the device style.
2 In the Electrical workspace, open the device style by doing one of the following:
   - Click Manage tab ➤ Style & Display panel ➤ Style Manager. In the left pane of the Style Manager, expand Electrical Objects, then expand Device Styles, and select the style.
   - Select an device in the drawing that uses the style and click Device tab ➤ General panel ➤ Edit Style drop-down ➤ Edit Style.
3 Click the Design Rules tab.
4 For Type, select a device type.
   The list of device types corresponds to the types defined and used in the software, and it is not customizable.
When the software calculates loads in power totals or in the Circuit Manager, it totals the loads into 3 groups according to device type: lighting, receptacles, and, for all other device types, other.

A corresponding modify command is available for each device type. While pressing Ctrl, you can press A to quickly select all of the objects in the drawing, and then enter a modify command, such as LIGHTINGMODIFY, to filter the selection set to include only the devices of the specified type.

**NOTE** Keep the classification for the Device Type classification definition the same as the value for Type unless you have added a custom classification that is more appropriate. For more information, see Specifying Classifications for Device Styles on page 545.

5 For Layer Key, select the layer key that corresponds to the layer on which devices of this style are placed when they are added to drawings.

The list of available layer keys is determined by the layer standard and layer key style that is specified for the current drawing. For more information, see Specifying a Layer Standard and a Layer Key Style on page 206.

6 For Wire Cleanup, select a wire cleanup method.

This selection determines how wires are displayed when connected to devices or panels. The preview image on the right provides an example of the current selection.

## Configuring Connectors for Device Styles

Devices can have a single connection point or multiple connection points.

**To configure the connectors of a device style**

1 Open the drawing that contains the device style.

2 In the Electrical workspace, open the device style by doing one of the following:
   - Click Manage tab ➤ Style & Display panel ➤ Style Manager ➤ . In the left pane of the Style Manager, expand Electrical Objects, then expand Device Styles, and select the style.
In the drawing, select a device that uses the style, and click Device tab ➤ General panel ➤ Edit Style drop-down ➤ Edit Style.

3 Click the Connectors tab.

4 For Description, enter a descriptive name that identifies what the connector represents, such as Normal Power.

5 For System Type, select Power and Lighting, Other, or General.

6 Specify a value for Connection Point X, Y, and Z, or click Add Center Points from View Blocks in Top View to create a centered connector.

7 If you selected Power and Lighting for System Type, do the following:

Specify values for the following additional connector properties:

<table>
<thead>
<tr>
<th>Connector Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of poles</td>
<td>The number of poles on the connector: 1, 2, or 3. You can select a number, select By Circuit to retrieve the value from the circuit when it is assigned, or select Undefined.</td>
</tr>
<tr>
<td>Voltage</td>
<td>The voltage on the connector. You can enter a voltage, select from the voltages defined in the drawing that are valid for the currently specified number of poles, select By Circuit to retrieve the value from the circuit when it is assigned, or select Undefined.</td>
</tr>
</tbody>
</table>
| Load Phase 1 Load Phase 2 Load Phase 3    | The load (in VA) on the connector. For each device added, this load is added to the circuit. You can use this to automatically assign a load as you add the device. If the Number of Poles is <Undefined> or 1, only Load
<table>
<thead>
<tr>
<th>Connector Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase 1 is editable. If Number of Poles is 2, then Load Phase 1 and Load Phase 2 are editable. If Number of Poles is 3, then Load Phase 1, Load Phase 2, and Load Phase 3 are editable.</td>
<td></td>
</tr>
<tr>
<td>Load Category</td>
<td>The load category of the connector. You can select from the load category defined in the drawing, or you can select Undefined.</td>
</tr>
<tr>
<td>Load Sub-category</td>
<td>The load sub-category of the connector. You can select Motor.</td>
</tr>
<tr>
<td>Maximum Overcurrent Rating (amps)</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Power Factor</td>
<td>Reserved for future use.</td>
</tr>
</tbody>
</table>

**NOTE** If you select Undefined for Number of Poles or Voltage, and you do not specify a value when adding a device, a default value of By Circuit is used. This means the value from the circuit is retrieved and used when the device is assigned to a circuit. In addition, note that when you change the value for Number of Poles, Voltage, or Load in a device style, instances of the style in the drawing are not updated.

- For each of the properties, for Prevent Override, specify whether to allow the override of the value in the style when adding devices. Select Yes to prevent overrides, or select No to allow them.

8 To add a connector, click , and configure its properties.

9 To remove a connector, select the connector, and click .
WARNING Use caution when removing connectors. Doing so can break the connectivity of a circuit because the connector is removed from all instances of the style in the drawing.

Specifying Classifications for Device Styles

A classification definition contains a set of classifications (named properties or characteristics) that you apply to one or more object types. For example, a Construction Status classification definition might contain the following classifications: Existing, Demo, and New.

You can create display sets that show or hide objects based on their classifications, such as a display set that shows only devices classified as lighting. Many of the display sets provided in the software are configured in this manner.

You can also use classifications to control the content of schedules by including

- Only objects that meet specific classification criteria
- Classification definitions as columns
- Additional information from property sets that you create and attach to classifications

Because you frequently need to classify the devices in a drawing by type, AutoCAD MEP includes a Device Type classification definition that applies to devices, and it contains classifications for the device types defined in the software.

Classification definitions that apply to devices are displayed on the Classifications tab of each device style. When configuring a device style, this is where you specify a classification for the Device Type classification definition and for any custom classification definitions. Most of the device styles included with the software specify a classification for the Device Type classification definition.
Because a device in a drawing is an instance of a device style, the device has a property for each classification definition in the device style. On the Extended Data tab of the Properties palette, you can view or override the classification for one or more devices in the drawing.

**Properties palette for a selected 12 x 24 recessed light**

To specify the classifications of a device style

1. Open the drawing that contains the device style.
2 In the Electrical workspace, open the device style by doing one of the following:

- Click Manage tab ➤ Style & Display panel ➤ Style Manager. In the left pane of the Style Manager, expand Electrical Objects, then expand DeviceStyles, and select the style.
- In the drawing, select a device that uses the style and click Device tab ➤ General panel ➤ Edit Style drop-down ➤ Edit Style.

3 Click the Classifications tab.

4 Specify a classification for the Device Type classification definition:

- Click beside the Device Type classification.
- In the Select Classification dialog, under Device Type, select a classification.

**NOTE** Keep the classification for the Device Type classification definition the same as the value for Type unless you have added a custom classification that is more appropriate. For information about the Type property of a device style, see Specifying Design Rules for Device Styles on page 541.

- Click OK.

5 Specify a classification for any custom classification definitions in a similar manner.

**NOTE** For more information about classifications, see Using Classifications on page 877 in AutoCAD MEP Help, as well as Classification Definitions and Displaying Objects by Classification in AutoCAD Architecture Help.

### Configuring Styles for Panels

Panels are a type of style-based content, which is the collective term for building system objects that use styles to define their appearance and behavior. When you add a panel to a drawing, you are adding an instance of a style, and the software establishes a link between the object and the style that defines it. When you modify the style, the software updates the object accordingly.
Specifying Design Rules for Panel Styles

The design rules of a panel style specify the method of wire cleanup used for panels of the style.

NOTE You can change the layers on which panels are placed when they are added to drawings by remapping their layers using Layer Manager. For more information, see Remapping Objects to Different Layers in AutoCAD Architecture Help.

To specify the design rules of a panel style

1. Open the drawing that contains the panel style.
2. From the Electrical workspace, open the panel style by doing one of the following:
   - Click Manage tab ➤ Style & Display panel ➤ Style Manager. In the left pane of the Style Manager, expand Electrical Objects, then expand Panel Styles, and select the style.
   - In the drawing, select a panel that uses the style and click Panel tab ➤ General panel ➤ Edit Style drop-down ➤ Edit Style.
3. Click the Design Rules tab.
4. For Wire Cleanup, select a wire cleanup method.
   This selection determines how wires are displayed when connected to panels. The preview image on the right provides an example of the current selection.
Configuring Connectors for Panel Styles

1 From the Electrical workspace, open the panel style by doing one of the following:

   ■ Click Manage tab ➤ Style & Display panel ➤ Style Manager ➤. In the left pane of the Style Manager, expand Electrical Objects, then expand Panel Styles, and select the style.

   ■ In the drawing, select a panel that uses the style and click Panel tab ➤ General panel ➤ Edit Style drop-down ➤ Edit Style ➤.

2 Click the Connectors tab.

3 For Description, enter a name or phrase that identifies what the connector represents.

4 For Domain, select Electrical.

5 Specify a value for Connection Point X, Y, and Z, or click Add Center Points from View Blocks in Top View to create a centered connector.

6 To add a connector, click , and configure its properties.

7 To remove a connector, select the connector, and click.

   WARNING Use caution when removing connectors. Doing so can break the connectivity of a circuit because the connector is removed from all instances of the style in the drawing.

Configuring Styles for Wires

Wires are a type of style-based content, which is the collective term for building system objects that use styles to define their appearance and behavior. When you add a wire to a drawing, you are adding an instance of a style, and the software establishes a link between the object and the style that defines it. When you modify the style, the software updates the object accordingly.
Defining Design Specifications for Wire Styles

**IMPORTANT** The material and temperature rating of wires, which are specified in the wire style, are used by the instant sizing tool to calculate the wire sizes. To use the sizing tool, you must select a material from the available choices instead of entering one. For information about using the sizing tool, see Drawing or Generating Wires on page 611 or Modifying Wire Properties on page 664.

1 Open the style by doing one of the following:
   - From the Electrical workspace, click Manage tab ➤ Style & Display panel ➤ Style Manager. In the left pane of the Style Manager, expand Electrical Objects, then expand Wire Styles, and select the style.
   - Select a wire that uses the style in your drawing and click Wire tab ➤ General panel ➤ Edit Style drop-down ➤ Edit Style.

2 Click the Specifications tab.
3 Under Hot, specify property values for the conductors:

4 Under Neutral, specify property values for the neutral wires:

- Specify whether the properties of the neutral wires should match those of the conductors:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>use the property values specified for the conductors</td>
<td>click Match hot, and for Size of hot in %, enter the size of the neutral wires expressed as a percentage of the size of the conductors.</td>
</tr>
<tr>
<td>specify property values for the neutral wires</td>
<td>click Specify neutral, and then specify values for Material, for Insulation, and for Temp. Rating.</td>
</tr>
</tbody>
</table>

5 Under Ground and under Isolated Ground, specify property values for the ground wires:

### Specifying Annotation for Wire Styles

When you draw a wire, you can select a style for the wire on the Properties palette. The style determines the annotation properties for the wire, such as the tick marks to use for conductor, neutral, and ground wiring; the symbol to use for home run arrows; and how to display connections.

**NOTE** Wire tick marks are always displayed in plan views unless you turn them off through the (Edit Display Properties) on the Display Properties tab in the Style Manager or the Wire Style Properties dialog. For more information, see Configuring the Display Properties of a Style on page 908.

The style of a wire also determines how crossing wires are displayed. You can display crossing wires as is, with an overlap or a break of a specific width.

If you select the overlap style or break style, you must also specify a corresponding priority value. In a drawing, if 2 crossing wires have the same priority value in their corresponding styles, the order in which the wires were drawn determines which wire displays the overlap or break. If the priority
values are different, the priority values determine this. Refer to the following table for more information.

<table>
<thead>
<tr>
<th>If the crossing style of the 2 wires is...</th>
<th>And if the priority values of the 2 wires are...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>overlap</td>
<td>the same</td>
<td>the wire drawn second displays the overlap.</td>
</tr>
<tr>
<td>break</td>
<td>the same</td>
<td>the wire drawn first displays the break.</td>
</tr>
<tr>
<td>mixed (one is overlap, and the other is break)</td>
<td>the same</td>
<td>the wire drawn second determines the crossing style to use. If the style is overlap, the wire drawn second displays the overlap. If the style is break, the wire drawn first displays the break.</td>
</tr>
<tr>
<td>overlap</td>
<td>different</td>
<td>the wire with the lower priority value displays the overlap.</td>
</tr>
<tr>
<td>break</td>
<td>different</td>
<td>the wire with the higher priority value displays the break.</td>
</tr>
<tr>
<td>mixed (one is overlap, and the other is break)</td>
<td>different</td>
<td>the wire with the lower priority value determines the crossing style to use. If the style is overlap, the wire with the lower priority value displays the overlap. If the style is break, the wire with the higher priority value displays the break.</td>
</tr>
</tbody>
</table>

**TIP** To change the draw order of a selected wire, click Home tab ➤ Modify panel ➤ Bring to Front drop-down and then choose one of the options offered.

**To specify annotation for a wire style**

1. Open the style by doing one of the following:
   - From the Electrical workspace, click Manage tab ➤ Style & Display panel ➤ Style Manager. In the left pane of the Style Manager, expand Electrical Objects, then expand Wire Styles, and select the style.
In the drawing, select a wire that uses the style and click Wire tab ➤ General panel ➤ Edit Style drop-down ➤ Edit Style.

2 Click the Annotation tab.

3 Under Tick Marks, select a symbol type, and enter a tick mark size and angle for conductor, neutral, and ground.

4 For Distance, enter the spacing for tick marks between conductor and neutral wires, or neutral and ground wires.

5 Specify how to display tick marks:
   - To show tick marks on each segment, select Display on wire segment.
   - To show tick marks on home runs, select Display on home run.
   - For Paper distance between same kind of ticks, enter the distance between the tick marks on a segment.

6 Under Home Run Arrow, select an arrow style, and enter a size.
To show only one home run arrow for each circuit, select Display one arrow for each circuit.

7 Under Crossings, select a style for crossing wires.
   You can specify that the crossing wires are displayed as is, with an overlap, or with a break.

8 If you selected the overlap style or the break style, for Break/Overlap Paper Width, enter the width of the overlap or the break, and for Break/Overlap Priority, enter a number.

9 Under Connections, select a connection node symbol type for wire junctions, and enter a size.

**Configuring Layout Preferences for Cable Tray or Conduit**

You can configure layout preferences for cable tray and conduit to control the layout and appearance of wireway runs.

Layout preferences are stored in the drawing. The sample templates provided in AutoCAD MEP include default preferences so you can begin design layout immediately. You can create custom templates that include company-specific or project-specific preferences.

**Cable Tray**

As you draw cable tray, click in the Add Cable Trays dialog to open the Cable Tray Layout Preferences dialog. You can also click Manage tab ➤ Preferences panel ➤ Cable Tray .

**Conduit**

On the Properties palette on page 528, click (Preferences) to open the Conduit Layout Preferences worksheet. You can also click Manage tab ➤ Preferences panel ➤ Conduit .
Specifying Alignment for Cable Tray Insertion

By default, the cable tray that you draw is center-aligned horizontally and vertically. As a result, the centerlines of the segments and fittings are placed along the points you specify. You can change the alignment and also specify an offset distance. Changing alignments is useful if you want to run cable tray along drawing geometry.

1 In the **Electrical workspace** on page 53, click Manage tab ➤ Preferences panel ➤ Cable Tray.

2 In the Cable Tray Layout Preferences dialog on the Routing tab, under Offset, specify the alignment for cable tray insertion:

   ![Offset Preferences](image)

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>Then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>align the centerlines of the cable trays along the points you specify for the run</td>
<td>under <strong>Justification</strong> on page 160, select Center for Horizontal and for Vertical. Enter 0 for Offset A and for Offset B.</td>
</tr>
<tr>
<td>align one or 2 sides of the cable trays along the points you specify for the run</td>
<td>under Justification, select Left or Right for Horizontal, and/or select Top or Bottom for Vertical.</td>
</tr>
<tr>
<td>offset the cable trays from the points you specify for the run</td>
<td>enter a distance for Offset A and/or for Offset B.</td>
</tr>
</tbody>
</table>

To assist you, the preview image on the right provides an example of the current selections.
Specifying the Slope for Cable Tray

Slope is applied to cable tray in the Z direction of the current coordinate system in the drawing (typically the vertical direction for a building plan).

1. In the Electrical workspace, click Manage tab ➤ Preferences panel ➤ Cable Tray.
2. In the Cable Tray Layout Preferences dialog on the Routing tab, under Cable Tray Layout Rise/Run, click Angle or Fraction.

3. For Rise/Run, enter the desired value, depending on the format selected.

   NOTE The Rise/Run value is used as the default in the Add Cable Trays dialog.

   - **Angle**

   - **Fraction**

4. For Angle, also specify the increment in number of degrees.

Breaking Cable Tray at Even Intervals

Use this procedure to break cable tray segments into specific lengths as you draw wireway runs.
1 In the Electrical workspace, click Manage tab ➤ Preferences panel ➤ Cable Tray.
2 In the Cable Tray Layout Preferences dialog on the Routing tab, under During Layout, click Cable Tray Length.

3 Specify the segment length.

**Specifying Annotation for Cable Tray**

You can specify labels or flow arrows to be added to cable tray runs as you draw them. You can also specify the hatch pattern to apply. You can specify vertical or 45-degree lines and the line spacing to use.

1 In the Electrical workspace, click Manage tab ➤ Preferences panel ➤ Cable Tray.
2 In the Layout Preferences dialog, click the Annotations tab.
3 To specify a cable tray pattern, under Cable Tray Pattern, select a type of line pattern, and enter a value for Spacing. To assist you, the preview image on the right provides an example of the current selections.

4 Under Labels and Flow Arrows, select a style and specify a layout method. You can define labels only, flow arrows only, or both.

**Specifying Default Parts for Cable Tray**

Use this procedure to specify the parts and fittings that are inserted automatically as you draw a cable tray run.

1 In the Electrical workspace, click Manage tab ➤ Preferences panel ➤ Cable Tray .

2 In the Layout Preferences dialog, click the Parts tab.
3 For Part Group Definition, select the definition to be modified.
4 For Connection Type, select a connection type.
   The tree structure updates to display only those parts available for the selected connection type.
5 For each part type, select a default part.

**Configuring Connections for Cable Tray**

1 In the Electrical workspace, click Manage tab ➤ Preferences panel ➤ Cable Tray.
2 Click the Connections tab.
3 For Connection Style, verify that Cable Tray Connector Style is specified.
4 Specify how to make connections to existing segments and fittings:
   If you want… then…
   the software to automatically insert a fitting when you connect with Cable Tray, select Use Fitting.
If you want…

<table>
<thead>
<tr>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>to connect one cable tray segment to another</td>
</tr>
</tbody>
</table>

| to directly connect one cable tray segment to another |
| under Connect with Cable Tray, clear Use Fitting. |

| the software to automatically replace the elbow with a tee when you connect a cable tray segment to an elbow |
| under Connect with Elbow, select Use Tee. |

| to directly connect the cable tray segment to the elbow |
| under Connect with Elbow, clear Use Tee. |

| the software to automatically replace the tee with a cross when you connect a cable tray segment to a tee |
| under Connect with Tee, select Use Cross. |

| to directly connect the cable tray segment to the tee |
| under Connect with Tee, clear Use Cross. |

For each setting, you can preview the type of connection you have specified in the corresponding image.

Configuring Layout Preferences for Conduit

1 In the Electrical workspace on page 53, click Manage tab ➤ Preferences panel ➤ Conduit. Preferences ( ) are also available on the Properties palette on page 528.

2 In the Conduit Layout Preferences dialog, select a slope format.

<table>
<thead>
<tr>
<th>Slope format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle</td>
<td>Expressed in degrees</td>
</tr>
<tr>
<td>Percentage</td>
<td>Expressed as a percent, where 100%=45 degrees</td>
</tr>
</tbody>
</table>
### Slope format Description

<table>
<thead>
<tr>
<th>Slope format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percentage</td>
<td>Expressed as a percent, where 100%=90 degrees</td>
</tr>
<tr>
<td>Rise/Run</td>
<td>Expressed as a fraction (for example, 1/48)</td>
</tr>
</tbody>
</table>

3 Select drawing units for Rise and Run.

**NOTE** Units for slope format are derived from the current profile and in the **Drawing Setup dialog** on page 208.

4 For Ratio divider, specify slash (/) or colon (:).

5 Make a selection for Automatically create riser at new elevation to yield the desired layout behavior.

- **Automatically create riser at new Elevation selected** (default)

- **Automatically create riser at new Elevation not selected**

6 Specify the label and flow arrow styles.

**NOTE** If None is specified, skip the next step.

7 Specify a layout method for label and flow arrow styles.

- For By quantity, enter the number of labels or flow arrows to add to each straight segment.

- For By distance, enter a segment length. If the segment length is less than the interval distance, a label is not automatically added to that segment.
Working with Circuits

You can use AutoCAD MEP circuit features to create and manage circuits for your electrical plans. You use the electrical project database on page 517 to manage panel and circuit assignments for electrical devices, such as lights or receptacles, across all electrical system drawings. Then you can share current circuit information across all electrical drawings in a project. Using the Circuit Manager on page 517 lets you manage and view circuit information as you create and modify your systems.

Circuit features include automation tasks, such as calculating circuit loads, checking circuit overloads, or calculating wire sizes. For example, you can create panel schedules from the circuit data in the electrical project database file. You also can add home run tags to wire runs, to display the panel and circuit assignments in the home run tag.

Circuit features are flexible and can accommodate different workflows. For example, you can identify the location of panels before you create circuits, generally during the schematic design phase. Then you can create panels and circuits and assign devices to circuits when you add the devices to drawings. You also can add devices to drawings before creating any circuits. After you create circuits, you can go back and assign devices to them. As you refine your electrical system designs, you can change circuit assignments for devices, modify circuit properties, and move circuits around on a panel.

Using an Electrical Project Database

The electrical project database lets you manage your circuits and loads across all electrical drawings in a project. As you create and refine your circuited systems, the electrical project database keeps track of devices and loads in all linked drawings. Using an electrical project database ensures that circuit
assignments and loads are accurate even if devices in multiple drawings are assigned to the same circuit.

**How the Electrical Project Database Works**

An electrical project database is required for any drawing that contains circuits. It can be specified at any time before or after circuits are created. If an electrical project database has not been specified and circuits are added to a drawing, you will be prompted to specify the name of an electrical project database file.

The electrical project database manages the circuit assignments in all linked drawings. As you create and refine electrical system drawings, you can use the Circuit Manager to view and manage panel and circuit information. Access the Circuit Manager from either the panel drawing or any of the linked drawings. As you work on electrical systems, you can view current circuit information, such as total load and number of devices assigned to each circuit.
For construction documents, panel schedules are created using the electrical project database. Also, circuit data originates directly from the electrical project database.

Creating an Electrical Project Database

An electrical project database is a file that contains panel and circuit data for all drawings that are connected to it. The electrical project database file can be specified at any time before circuits are created. If an electrical project database file has not been specified, and circuits are created with the PANELADD command or in the Circuit Manager, you are prompted to specify an electrical project database file. After you create this file, you can link to it from other drawings. It is recommended that you use only one electrical project database per project.

You create circuits in the electrical project database, and assign them to panels. As you create electrical systems in other drawings, you can assign devices and wires to the circuits in the electrical project database.

To create a new electrical project database file before creating circuits:

1. Click Manage tab ➤ Preferences panel ➤ Electrical .
2 Click the Electrical Project Database tab and click New.
3 Optionally, in the new drawing, reference a floor plan drawing for the placement of your panels.
4 To add panels to the drawing, use a panel tool on the Panel tool palette, or use the PANELADD command.
   Create circuits as you add a panel, or add a panel and add circuits later using the Circuit Manager.

**To create a new electrical project database file when prompted while creating circuits:**

1 In the Electrical Project Database dialog, click Create a new EPD file.
2 Specify a filename and click OK.

**To open an existing electrical project database file when prompted while creating circuits:**

1 In the Electrical Project Database dialog, click Open an existing EPD file.
2 Browse to the location and name of the existing electrical project database file, and click OK.

---

**Linking to the Electrical Project Database**

Create a file to serve as the electrical project database. Then, link drawings to the electrical project database. You can link a drawing to only one electrical project database at a time.

1 Create a new drawing, or open an existing drawing that you want to link to the electrical project database.
2 Click Manage tab ➤ Preferences panel ➤ Electrical ➤ .
3 In the Electrical Preferences dialog, click the Electrical Project Database tab.
4 For Project Database, click .
5 In the Open dialog, browse to the file you want to use as the electrical project database.
6 Select the electrical project database file, and click Open.
   The file name is displayed for Project Database, and Used Database shows the directory path.
7 For path type, select either Use Fixed Path or Use Relative Path.
- Fixed path: If you use a fixed path reference, moving the electrical project database file to another directory, this also breaks the links with associated electrical drawings. If you move an entire project to another directory, this will also break the links between the electrical project database file and the linked drawings.
  To move the electrical project database file, you must open each linked drawing and configure the electrical project database to its new file path.
- Relative path: If you use a relative path reference, the link remains intact as long as the electrical project database file is in the same location relative to the linked drawing. You can move a project or rename directories in the project without breaking the links to associated electrical drawings.
  If Use Relative Path is inactive, you must save the current drawing in order to make it active.

8 The electrical project database status icon displays in the application status bar.

You can now assign devices to circuits in the electrical project database. You can assign devices to a circuit as you add or modify them. If more than one electrical drawing is open and being worked on, you can reload the electrical project database in your current drawing by reloading the electrical project database.

**IMPORTANT** When you are working in linked drawings, the electrical project database must be closed. If it is open, you are prompted to close it when you try to save a linked drawing. No data can be written from linked drawings to the electrical project database unless the electrical project database is closed.

**Reloading the Electrical Project Database**

If two or more people are working simultaneously on electrical drawings, you can reload the latest data from the electrical project database into your current drawing to ensure that you have current circuit information. Or, if you have two or more linked drawings open, and you save changes to one, you can
reload the electrical project database, thus adding the changes to the other drawing.

For example, if someone assigns devices to a circuit in another drawing while your drawing is open, you can reload the electrical project database in your current drawing, and view the current number of devices assigned to that circuit. This ensures that you have accurate circuit information across all drawings that use the electrical project database.

As soon as a linked drawing is saved, the Electrical Project Database Status icon indicates that the database needs to be reloaded in your current drawing. If a linked drawing is not open when changes are made, you do not need to reload the electrical project database. The latest version of the electrical project database is loaded automatically when you open the drawing.

The steps in the following procedure show how to manually reload the electrical project database. Also, the database is also always reloads when you open a drawing.

**NOTE** Note that the electrical project database reloads automatically every 5 minutes. This time interval is not configurable, and it is always on.

### To manually reload the electrical project database

1. In the application status bar, note that the electrical project database status displays an alert marker ▶️. This marker indicates that changes have been saved to the electrical project database from one or more linked drawings.

2. Click the Electrical Project Database Status icon once, or right-click the icon and click Reload Electrical Project Database. The electrical project database status displays as current.

3. If the electrical project database cannot find one or more of the drawings linked to the electrical project database, the Electrical Project Database Reload dialog prompts you, giving you the option to remove the missing drawing data from the electrical project database.

   If you do not want to use the drawing in the electrical project database, select the check box to remove its data from the electrical project database. For example, the missing drawing is one you deleted and that you did not want to use.

   If you want to keep the drawing data in the electrical project database, clear the check box. For example, you want to use the
missing drawing, but it resides on a server that is temporarily unavailable.

Unlinking From the Electrical Project Database

You can remove a linked drawing from the electrical project database as long as all of the circuits in the drawing have been removed. When you unlink a drawing from the electrical project database, the next time you save the drawing, the data from that drawing is automatically removed from the electrical project database.

To unlink a drawing from the electrical project database

1. In the drawing you want to unlink, click Manage tab ➤ Preferences panel ➤ Electrical.
2. In the Electrical Preferences dialog, click the Electrical Project Database tab.
3. For Project Database, select <None> from the drop-down list.
4. Save the drawing.

The drawing and its electrical data are removed from the electrical project database. You can reload the electrical project database in any linked drawings that are open.

Using Circuits

You can create and store circuits in the same drawing as the panel to which they are assigned. Using the electrical project database, you can assign devices—such as lights or receptacles—to circuits in the electrical project database. Then you can share current circuit information across all electrical drawings in a project.

**BEST PRACTICE** Before creating circuits, create electrical system and load category definitions, and configure electrical preferences. Then, you can take better advantage of the circuit feature, reducing the number of details you must specify when adding circuits. For more information, see Creating Electrical System Definitions on page 534 and Control the Appearance and Behavior of Electrical System Designs on page 534.
Creating Circuits Using the Circuit Manager

You can use the Circuit Manager to create one or more circuits. You typically create panels and circuits in a drawing and add them to an electrical project database. Other drawings can then reference these panels and circuits. You can link any drawing to an electrical project database and then use its panels and circuits in multiple drawings.

You can create circuits at any point in the design process. You can create circuits as you add panels, or at any point after you add panels. You can also create circuits before adding any panels, and assign those circuits after you add panels. You can add one circuit or multiple circuits at once.

**NOTE** The Circuit Manager can remain open while you work in your drawing.

To create circuits using the Circuit Manager

1. In the drawing that contains or will contain at least one electrical panel, select a device and click Device tab ➤ Circuits panel ➤ Circuit Manager drop-down ➤ Circuit Manager.
2. In the left pane of the Circuit Manager, select the panel to which you want to add one or more circuits.
   If you have not yet added any panels, select <Unassigned>. Any new panels are automatically added to <Unassigned>. After you create panels, you can drag and drop circuits from <Unassigned> into the desired panels.

To add a single circuit:

3. Add a single circuit using any of the following methods:
   - Click (Create New Circuit) or click the drop-down arrow next to Create New Circuit ( ) to specify a circuit type.
   - Right-click the panel name, and select New <circuit type>.
   - Right-click the system type (for example, Power and Lighting) under the panel name, and click New Circuit.

To add multiple circuits:

4. Add multiple circuits using any of the following methods:
   - Click (Create Multiple Circuits).
Right-click the panel name, and select New Multiple Circuits.

5 In the Create Multiple Circuits dialog, under Common properties, specify the following:

- Panel: If you selected a panel name before starting this command, this field will be inactive. If you selected <Unassigned>, select a panel from the drop-down list. Select <Unassigned> in this list if you do not want to assign the circuit to a panel yet.

- System Type: Specify a type of system for the circuits.

- System: Specify a system for the circuits.

6 Under <System Type> Properties, specify the number of 1-pole, 2-pole, and 3-pole circuits and their respective voltages.
Configuring a Circuit

After you create circuits, configure circuit properties, such as voltage, rating, load category, and system.

1. Open the drawing that contains the circuits and select a device.
2. Click Device tab ➤ Circuits panel ➤ Circuit Manager drop-down ➤ Circuit Manager.
3. In the left pane of the Circuit Manager, expand the panel, expand the branch (for example, Power and Lighting), and select the circuit to be configured.
   To edit properties for multiple circuits, select the branch in the left pane that contains the circuits. On the right pane, use Shift or Ctrl to select multiple rows in the circuit list view.
4. Double-click the circuit property field in the right pane.
5. Enter the new information, or select a new property from the list.

Depending on the system type, you can modify the following properties:

- Name: Specify a name, using naming conventions for new circuits using electrical preferences.
- Description: Typically a brief description of the type of devices and the area of the building this circuit will service.
- System: The electrical system definition for the circuit.
- Rating (Power and Lighting only)
- Voltage (Power and Lighting only)

The number of devices and circuit length are calculated for you as you assign devices to circuits. For power and lighting circuits, the total load is also calculated for you.

Circuit length is calculated only if the devices and circuits are contained in the same drawing. Typically, you assign devices in one drawing to circuits in the electrical project database file. In
that case, the circuit length always displays as "Used in multiple drawings".

After you assign one or more devices to a circuit, not all properties are editable. To reconfigure a property for a circuit with devices assigned to it, you can modify the devices, set their circuit assignments to "Unassigned", and then modify the circuit property in the Circuit Manager. You can also create a new circuit, configure it as desired, and modify the devices to assign them to the new circuit. Then, delete or reuse the old circuit.

If you are using an electrical project database file, and you configure a circuit that is being used by devices in other drawings, you are prompted to open and save the affected drawings to ensure that the circuit information is current. For more information, see Electrical Project Database on page 517.

**IMPORTANT** When you assign power and lighting devices to circuits, make sure the voltage and number of poles for the device are the same or less than the circuit settings. If the device voltage exceeds the circuit voltage, or the number of poles on the device exceeds the number of circuit poles, you will not be able to assign the device to that circuit.

### Viewing Details in the Circuit Manager

Use the Circuit Manager to view circuit data and information for electrical system drawings. If you use an electrical project database, you can view circuit data in any linked drawing. If you do not use an electrical project database, you can view circuit data in the current drawing.

**To view circuit information**

1. In the drawing, select a device and click Device tab ➤ Circuits panel ➤ Circuit Manager drop-down ➤ Circuit Manager.
2. In the Circuit Manager, expand the panel, and select the system type (for example, Power and Lighting) to view the circuit properties.
3. To search for a particular panel, type the panel name in the left pane. The properties of each circuit are displayed in the right pane.
Circuit Manager

- Expand a specific panel to list all circuits by system type assigned to that panel.
- Expand a circuit type under a panel (for example, Power and Lighting) to list all circuits of that type assigned to the panel.

If you use an electrical project database, you can edit circuit settings from the current drawing only. You cannot edit circuit settings for other drawings linked to the electrical project database.

For power and lighting circuits, the Circuit Manager displays overloaded circuits in red. For more information, see Viewing Circuit Information on page 641.

Linking Panels

After linking panels, use the Circuit Manager to transfer the panel demand and connected load totals for each load category from one panel to another.

To link panels in the same drawing:

1. Select a panel and click Panel tab ➤ Connections panel ➤ Connect To Other Panel .
2. In the first Panel to Panel connection dialog, select the panel that will be fed by another panel.
3 In the second Panel to Panel Connection dialog, select the method to use when connecting the panels, and click OK.

<table>
<thead>
<tr>
<th>If you select…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circuit breaker in panel</td>
<td>the panel is added as a sub-fed panel to an existing circuit in the linked panel.</td>
</tr>
<tr>
<td>Feed-thru lugs</td>
<td>the panel is added as a sub-fed panel to a feed-thru lug circuit in the linked panel.</td>
</tr>
<tr>
<td>Sub-feed lugs</td>
<td>the panel is added as a subfed panel to a subfeed lug circuit in the linked panel.</td>
</tr>
<tr>
<td>Subfeed breaker</td>
<td>the panel is added as a subfed panel to a subfeed breaker circuit in the linked panel.</td>
</tr>
<tr>
<td>Panels are connected through a transformer (panels are different voltages)</td>
<td>the panel is connected through a transformer when panels are of different voltages.</td>
</tr>
</tbody>
</table>
The sub-fed (linked) panel is shown indented in the tree view in the left pane.

![Tree view of panels]

**NOTE** A warning symbol appears if you try to create a circular reference by linking a panel back to the panel that feeds it.

**NOTE** You cannot link a panel to more than one panel at a time.

**NOTE** Anytime you add or delete circuits, you will need to update any existing panel schedules. See *Updating Panel Schedules* on page 693

To remove a link between panels:

➤ Select the panel and click Panel tab ➤ Connections panel ➤ Remove Connection To.

**NOTE** You can connect to a panel only once using either the feed-thru lugs, subfeed lugs, or subfeed breaker option. You can use the circuit breaker option only when there are available circuits.
Managing Circuits in a Project

As you create and refine your electrical system designs, you can manage your circuits using the following tips:

■ Use an electrical project database file to manage circuits across all drawings in a project.

■ Create circuits when you add a panel, or add circuits to panels later using the Circuit Manager.

■ Configure circuit settings only in the drawing that contains the circuits. After you assign at least one device to a circuit, many of the circuit settings are no longer editable.

■ Configure loads for device styles so that the load is automatically configured when you add the device to a drawing.

■ Assign devices to circuits as you add the devices, or add the devices first and then assign them to circuits later.

■ Keep circuit data current in multiple electrical drawings by reloading the electrical project database.

■ Configure electrical preferences so that you are automatically notified of circuit overloads for power and lighting circuits.

■ Use circuit-checking features to see circuit information for a selected device. You can also verify circuit connectivity to display the devices that are assigned to the same circuit.

■ As you refine your designs, you can move circuits around on a panel to balance loads. Also, you can drag and drop circuits from one panel to another.

■ Generate panel schedules automatically from the circuit data.

Creating Electrical Systems

Use AutoCAD MEP to create designs for typical electrical systems such as lighting plans, power plans, and telecommunications plans. You can also create plans for electrical equipment, such as switchboards or emergency power generators, and draw the conduit or cable tray networks to connect the equipment.
When creating lighting, power, and telecommunications plans, you add devices to the floor plan, and you connect the devices with wire runs. You can use panel and circuit features to assign the devices to circuits. You can also use circuit features to manage loads for power and lighting circuits.

When creating plans for electrical equipment, you add MvParts to floor plans, and you draw conduit or cable tray runs to connect equipment.

**Adding Devices**

After attaching a referenced drawing (xref) of the architectural plan to your drawing, typically you continue by placing devices and panels in the layout. You can place devices and then connect them with wires. You can also insert a device onto a wire, in which case the device breaks into the wire and creates 2 wires.

When you add a device to your drawing, you can assign the device to a circuit, or you can leave the circuit unassigned until you know the circuit to use. This ability means you can create circuits and connect them to devices at any time during the design process. For information about using circuits across multiple drawings, see Working with Circuits on page 562.

**To add devices**

1. In the Electrical workspace, start the add command by doing one of the following:
   - Click Home tab ➤ Build panel ➤ Device .
   - Open a device tool palette, and select a tool. If necessary, scroll to display the tool. Because tools contain preconfigured properties for the objects they create, you might not need or be able to specify some of the device properties referenced in this procedure.
   - Enter deviceadd.
Specify general properties

2 On the Properties palette, if necessary, double-click on the device display to open the style selector dialog.

3 For Description, click , enter a description of the device, and click OK.
Specify location properties

4 If you selected One by One for Layout Method, expand Location, and for Align to objects, specify how you want to align the devices:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>snap to an object using object snaps and have the software align the device perpendicular to the object</td>
<td>select Yes. The software can align the device perpendicular to a wall, ceiling grid, space boundary, line, polyline, spline, arc, or circle in the current drawing or in an xref.</td>
</tr>
<tr>
<td>manually align the device</td>
<td>select No.</td>
</tr>
</tbody>
</table>

NOTE If you have difficulty snapping and aligning to an object, zoom to the area or modify the size of the Auto-Snap aperture as needed. The aperture size determines how close to a snap point you can be before the magnet locks the aperture box to the snap point. You can modify the size on the Drafting tab of the Options dialog. For more information, see Drafting Tab (Options Dialog Box).

5 For Justification, select the point on the device to use as the insertion point.
You can select either the insertion point of the view block that represents the device, or one of 9 other points on the device, such as Top Left or Middle Center.

**6 Specify an elevation by doing one of the following:**
- For Preset Elevation, select a defined elevation.
- For Elevation, enter an elevation.

Because devices have 2D views and many have 3D views assigned to them, the insertion point of devices should be specified as 0. The elevation property of the device (not the insertion point) should be used to assign the 3D view to the correct elevation. Follow these simple rules:
- The Z-value of Connectors should always be defined as 0.
- The Insertion point Z-value of device shall be 0.
- To set the elevation of the device to anything other than 0, use the Elevation property of the device on the Properties palette. This setting defines the 3D offset of the device from the current UCS. The object will display at the set elevation when viewing it in a 3D or Iso view.

The difference in the elevation of the devices, the wires, and the panel for a circuit is used to calculate the circuit length. Note that the circuit length can only be calculated if the panel and all of the devices on the circuit are in the current drawing.

**Specify advanced properties**

**7** Expand Advanced, expand System, and for System, select the system to which the device belongs.

**NOTE** The system assigned to the device determines its display properties, and the system assigned to an electrical connector on a device determines the connections that can be made to the connector. For more information about connectors, see Configuring the Electrical Connectors of a Device on page 583. For more information about systems, see Creating Electrical System Definitions on page 534 and Working with Systems on page 138.

**8** Expand Design Data, and for ID, enter an ID for the device. The ID is an optional number that you can assign.
9 Expand Tag, and for Insert Tag, select the tag to anchor to the object.

The list of tags includes the tags in the current drawing and, if specified, the tag specified in the tool you selected.

A tag is a symbol that can display the data in a property set that is attached to the object. A property set is a user-defined group of related properties, such as a part number or a manufacturer’s name, which you can specify in the properties of a tag tool or manually attach to an object using the Extended Data tab of the Properties palette. You use property sets and tags to annotate drawings and create schedules for construction documents.

TIP Instead of manually adding tags and property sets to devices one-by-one using the Properties palette, you can create device tools that automatically add them to devices when the devices are inserted. For more information, see Creating Tools for Style-Based Content on page 1179.

Specify connector properties

10 Expand Advanced, expand Circuits, and click Electrical Properties.

NOTE You can edit Electrical Properties later by selecting a device in the drawing and clicking Device tab ➤ Circuits panel ➤ Circuit Properties.

11 On the Electrical Properties worksheet, configure the electrical connectors, as explained in Configuring the Electrical Connectors of a Device on page 583.

Insert the devices

12 If you selected Quantity around space or Distance around space for Layout method, insert the devices as follows:

- In the drawing, move the cursor to the location for the first device. This must be a point on a space boundary.

- Examine the preview of the device layout, and, if necessary, move the cursor to a different location.

- Click to insert the devices.
If you selected One by One for Layout method and Yes for Align to objects, insert the devices as follows:

- If you want to insert the device into a wire, enter `w` (wire), and select the wire. Otherwise, proceed to the next step.

- Use object snaps to snap to an object (such as a wall) at the desired insertion point, and click to insert the device.

- Repeat the previous steps to add additional devices with the same properties.

If you selected One by One for Layout method and No for Align to objects, insert the devices as follows:

- If you want to insert the device into a wire, enter `w` (wire), select the wire, and move the device along the wire to the desired location. Otherwise, proceed to the next step.

- Click to specify the insertion point.

- Rotate the device by moving the cursor or entering the number of degrees on the command line, and click to insert the device. Alternatively, you can press Enter to accept the default rotation, and then click.

- Repeat the previous steps to add additional devices with the same properties.

On the Properties palette, modify the device properties and then insert additional devices, or press Enter to end the add command.

**NOTE** If you are using the electrical project database file, and two or more electrical drawings are open, you can update each drawing to include the most current circuit information by reloading the electrical project database in each open drawing. For example, if you add lighting devices to a circuit in the electrical project database, and a power drawing is open and using circuits on the same panel, you can reload the electrical project database in the power drawing to have current circuit information.
Configuring the Electrical Connectors of a Device

When you add a device to a drawing, you need to configure its connectors using the Electrical Properties worksheet. Typically, devices have a single electrical connector.

You can configure an electrical connector using either of the following methods:

- Assign the connector to a circuit. If you know the circuit, you can select it. Otherwise, you can make panel and connector property selections to filter the list of available circuits, and then select one. Once you select a circuit, the System value is no longer editable. If the system type of the connector is Power and Lighting, then the values for Voltage and for Number of poles are not editable. This prevents changes...
that do not agree with the selected circuit. You can then configure the connector properties that remain editable.

As you add devices with connectors that are assigned to a circuit, the circuit is updated and evaluated for overloads based on the load and load category of the connectors. In the circuiting preferences, you can specify whether the software warns you of overloads, so you can decide whether to proceed and add the devices. If you overload a circuit, you are not notified of the overload again during the drawing session.

■ Configure the connector properties, but do not assign the connector to a circuit. Later, after you identify the circuit to use, you can assign the circuit.

NOTE If the style of the device does not allow the override of a connector property value, that property is not editable even when no circuit has been assigned. For information about allowing and preventing overrides, see Configuring Connectors for Device Styles on page 542.

To configure the electrical connectors of a device

1 Start the add command by doing one of the following:
   ■ Click Home tab ➤ Build panel ➤ Device ➤.
   ■ Open a device tool palette, and select a tool.
   ■ Enter deviceadd.

2 On the Properties palette, expand Advanced, expand Circuits, and click Electrical Properties.

   NOTE You can apply these settings later by selecting a device in the drawing and clicking Device tab ➤ Circuits panel ➤ Circuit Properties ➤.

The Electrical Properties worksheet lists the connectors on the device and shows the system type and description for each connector. These attributes of the device are determined by the device style, and, to change them, you must modify the connectors in the style.

3 Under Electrical Connectors, select a connector to configure.

   The properties of the selected connector are displayed under Connector Properties.
Optionally assign the connector to a circuit

4 If necessary, you can filter the list of available circuits:

<table>
<thead>
<tr>
<th>If you want to select from the circuits…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>on a specific panel</td>
<td>for Show circuits from panel, select the panel.</td>
</tr>
<tr>
<td>that are not assigned to a panel</td>
<td>for Show circuits from panel, select Unassigned.</td>
</tr>
<tr>
<td>with a specific system</td>
<td>for System, select the system.</td>
</tr>
<tr>
<td>with a specific number of poles</td>
<td>for Number of Poles, select the number.</td>
</tr>
<tr>
<td>with a specific voltage</td>
<td>for Voltage, select or enter the voltage.</td>
</tr>
</tbody>
</table>

Detailed descriptions of the connector properties are described later in this procedure.

NOTE The circuits available for Circuit are the circuits in the current drawing, or in the electrical project database file, if one is specified for the current drawing. The circuits available are those that match the values you have specified for the connector properties, and have either a system type of General or the same system type as the connector.

Beside each circuit name, the current load on the circuit is displayed. The load is the total load on the circuit across all applicable drawings, including the electrical project database file.

5 For Circuit, select the circuit.

Specify the connector properties

6 Under Value, specify values for the connector properties.

<table>
<thead>
<tr>
<th>Connector Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>The system of the connector. If the system type of the connector is General, you can select from all</td>
</tr>
</tbody>
</table>
### Connector Property

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>of the <em>electrical systems</em> defined in the drawing. Otherwise, you can select from systems with the same system type (Power and Lighting, or Other).</td>
</tr>
</tbody>
</table>

**NOTE** While the system assigned to the device determines its display properties, the system assigned to the connector on a device determines the connections that can be made to the connector. If the system type of the connector’s system is Power and Lighting or Other, you can only connect objects of the same system type to the connector. If the system type is General, you can connect objects of any system type to the connector.

<table>
<thead>
<tr>
<th>Load Phase 1</th>
<th>Load Phase 2</th>
<th>Load Phase 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>The load on the connector. Applies only to connectors whose system type is Power and Lighting. If the Number of Poles is <code>&lt;Undefined&gt;</code> or 1, only Load Phase 1 is editable. If Number of Poles is 2, then Load Phase 1 and Load Phase 2 are editable. If Number of Poles is 3 or <code>&lt;By Circuit&gt;</code>, then Load Phase 1, Load Phase 2, and Load Phase 3 are editable. You can enter a value. Otherwise, the value in the style is used and shown.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>The voltage on the connector. Applies only to connectors whose</td>
</tr>
<tr>
<td>Connector Property</td>
</tr>
<tr>
<td>--------------------</td>
</tr>
<tr>
<td>system type is Power and Lighting. You can do one of the following:</td>
</tr>
<tr>
<td>enter a voltage</td>
</tr>
<tr>
<td>select from the voltages defined in the drawing that are valid for the currently specified number of poles</td>
</tr>
<tr>
<td>select By Circuit to retrieve the value from the circuit when it is assigned</td>
</tr>
<tr>
<td>The number of poles</td>
</tr>
<tr>
<td>Load Category</td>
</tr>
<tr>
<td>Load Sub-category</td>
</tr>
<tr>
<td>Maximum Overcurrent Rating (amps)</td>
</tr>
<tr>
<td>Power Factor</td>
</tr>
</tbody>
</table>
As you specify values for the connector properties, the information in the Value Set By column changes accordingly:

<table>
<thead>
<tr>
<th>If...</th>
<th>then Value Set By is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the value of the property matches the value specified in the device style</td>
<td>Style Default</td>
</tr>
<tr>
<td>the value of the property does not match the value specified in the device style</td>
<td>Style Override</td>
</tr>
<tr>
<td>there is no value specified in the device style</td>
<td>empty</td>
</tr>
<tr>
<td>the value of the property is By Circuit in the device style or in the currently selected connector</td>
<td>Circuit</td>
</tr>
</tbody>
</table>

**Example: Aligning a Device to Floor Plan Geometry**

In this example, you add a single receptacle and align it to a wall.

1. In a new drawing, attach or overlay a drawing of an architectural floor plan.
2. In the Electrical workspace, open the Power-Lighting Device tool palette, and select a receptacle tool.
3. If necessary, on the Properties palette, change the style of the receptacle to be added:
   - Expand Basic, and on the General bar, click 📚.
   - In the left pane of the Select Device worksheet, navigate to the drawing that contains the style.
   - In the right pane, select the style, and click OK.
4. Expand Layout, and for Layout method, select One by One.
5. Expand Location, and for Align to objects, select Yes. This causes the receptacle to align to the object to which you snap. You can snap and align to a wall, ceiling grid, space boundary, line, polyline, spline, arc, or circle in the current drawing or in a referenced drawing (xref).
In the drawing, snap to a wall at the desired insertion point, and click to specify the point.

**TIP** When you are prompted for a point, you can temporarily enable an object snap by entering the first 3 characters of its name. This is useful when you require a snap that you do not want as a running object snap, such as Nearest, which snaps to the nearest point on an object.

**NOTE** If you have difficulty snapping and aligning to an object, zoom to the area, or modify the size of the AutoSnap aperture as needed. The aperture size determines how close to a snap point you can be before the magnet locks the aperture box to the snap point. You can modify the size on the Drafting tab of the Options dialog. For more information, see Drafting Tab (Options Dialog Box).

7 Press Enter.

**NOTE** For detailed information about adding devices and configuring their properties, see Adding Devices on page 577.

### Example: Adding Devices at a Specific Distance Interval

In this example, you add receptacles to a room at a specific distance interval. You specify the insertion point of the first device on a space boundary created for the room, and the software aligns all of the devices along the boundary.

1 In a new drawing, **attach or overlay a drawing** of an architectural floor plan.
2 **Activate an electrical display configuration.**
3 If the floor plan drawing does not contain spaces, generate a space for a room by doing the following:
   - Open the Power-Lighting Device tool palette, and select the Space tool.
In the drawing, specify a point within a room, and press Enter.

NOTE By default, the electrical display configurations use the Reflected Screened display representation for Space objects. This display representation makes the boundaries of spaces visible in drawings, but adds the spaces to a non-plotting layer. The display representation is not used by any other display configurations provided in the software. For more information about the display system, see AutoCAD MEP Displays on page 208.

4 On the Power-Lighting Device tool palette, select a receptacle tool.
5 If necessary, on the Properties palette, change the style of the receptacle to be added:
   ■ Expand Basic, and on the General bar, click .
   ■ In the left pane of the Select Device worksheet, navigate to the drawing that contains the style.
   ■ In the right pane, select the style, and click OK.
6 Expand Layout, and for Layout method, select Distance around space.
7 For Distance between, enter a value.
   You can also enter a value by clicking and specifying 2 points in the drawing.
8 In the drawing, move the cursor to the location for the first device. This must be a point on the space boundary.

NOTE If the software does not detect a space boundary, you can still insert the devices and have the software align them automatically, but you must manually specify the location for each device one at a time.

9 Examine the preview of the receptacle layout, and if necessary, move the cursor to a different location on the boundary.

NOTE On the Properties palette, you can view the value for Number of devices. This read-only property is updated when the preview is displayed.

10 Click to insert the receptacles, and press Enter to end the command.

11 Depending on the layout and your design requirements, you might need to make minor adjustments to the receptacles. For
example, you might need to move or remove the last receptacle added along the boundary.

NOTE For detailed information about adding devices and configuring their properties, see Adding Devices on page 577.

**Example: Adding a Specific Number of Devices**

In this example, you add a specific number of telephone outlets to a room. You specify the insertion point of the first outlet on a space boundary created for the room, and the software aligns all of the outlets along the boundary.

1. In a new drawing, attach or overlay a drawing of an architectural floor plan.
2. Activate an electrical display configuration.
3. If the floor plan drawing does not contain spaces, generate a space for a room by doing the following:
   - Open the Comm-Fire Device tool palette, and select the Space tool.
In the drawing, specify a point within a room, and press Enter.

NOTE By default, the electrical display configurations use the Reflected Screened display representation for Space objects. This display representation makes the boundaries of spaces visible in drawings, but adds the spaces to a non-plotting layer. The display representation is not used by any other display configurations provided in the software. For more information about the display system, see AutoCAD MEP Displays on page 208.

4 On the Comm-Fire Device tool palette, select a telephone tool.
5 If necessary, on the Properties palette, change the style of the telephone outlet to be added:
   - Expand Basic, and on the General bar, click .
   - In the left pane of the Select Device worksheet, navigate to the drawing that contains the style.
   - In the right pane, select the style, and click OK.
6 Expand Layout, and for Layout method, select Quantity around space.
7 For Number of devices, enter a number.
8 In the drawing, move the cursor to the location for the first device. This must be a point on the space boundary.

**NOTE** If the software does not detect a space boundary, you can still insert the devices and have the software align them automatically, but you must manually specify the location for each device one at a time.

9 Examine the preview of the telephone outlets, and if necessary, move the cursor to a different location on the boundary.

**NOTE** On the Properties palette, you can view the value for Distance between. This read-only property is updated when the preview is displayed.
10 Click to insert the outlets, and press Enter to end the command.

NOTE For detailed information about adding devices and configuring their properties, see Adding Devices on page 577.

Example: Inserting a Device into a Wire

In this example, you insert a service disconnect into a wire.

1 Open the Power-Lighting device tool palette, and select a disconnect tool.
2 On the Properties palette, expand Basic, and expand Layout.
3 For Layout method, select One by One.
4 Expand Location, and for Align to objects, select No.
   This enables you to manually rotate the device in the drawing.
5 For Justification on page 160, select Middle Center.
6 Enter w (wire), and in the drawing, select the wire into which to insert the device.
7 Move the device along the wire to the desired location, and click to specify the insertion point.

8 Rotate the symbol into position.

9 Click to insert the device, and press Esc.

**TIP** You can also insert a device into a wire and align the device perpendicular to the object to which you snap. This can be helpful when you want to break into a wire and, for example, add a receptacle aligned to a wall. For more information, see Adding Devices on page 577.

**Adding Panels**

After attaching a referenced drawing (xref) of the architectural plan to your drawing, typically you continue by placing panels or devices in the layout.

When you add a panel, you can create one or more circuits assigned to the panel at the same time. Alternatively, you can use Circuit Manager to create the circuits before or after you add panels or devices.

**IMPORTANT** To use a panel and its circuits in multiple drawings, create an electrical project database file and link the drawing to the electrical project database.

To add panels

1 Start the add command by doing one of the following:
   - Click Home tab ➤ Build panel ➤ Panel.
Open the Panel tool palette, and select a tool. If necessary, scroll to display the tool. Because tools contain preconfigured properties for the objects they create, you might not need to specify some of the panel properties referenced in this procedure.

Enter `paneladd`.

**NOTE** On the Properties palette, ❄️ indicates a property is available only when you are adding panels, not when you are modifying them.

### Specify general properties

2 On the Properties palette, if necessary, specify or change the panel to add by selecting a panel style:

<table>
<thead>
<tr>
<th>If you want to select a panel style...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>in the current drawing</td>
<td>expand Basic, expand General, and for Style, select the style.</td>
</tr>
<tr>
<td>in a drawing in the directory specified as the default content location for electrical panels, or in the style drawing referenced in the properties of the tool you selected</td>
<td>on the General bar, click ✉️. In the left pane of the Select Panel worksheet, navigate to the drawing that contains the style, and select the drawing. In the right pane, select the style, and click OK.</td>
</tr>
</tbody>
</table>

3 For Description, enter a description of the panel.

### Specify location properties

4 Expand Location, and for Align to objects, specify how you want to align the panel:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>snap to an object using object snaps and have the software align the panel perpendicular to the object</td>
<td>select Yes. The software can align the panel perpendicular to a wall, space boundary, line, polyline, spline, arc, or circle in the current drawing or in an xref.</td>
</tr>
</tbody>
</table>
If you want to…  Then…

manually align the panel  select No.

**NOTE** If you select Yes for Align to objects, the software inserts the panel using the insertion point of the underlying block and rotates it as needed to align it perpendicular to the object to which you snap. As a result, you cannot specify a value for Justification on page 160 on the Properties palette, or a value for Rotation on the command line.

5 For Justification, select the point on the panel to use as the insertion point.

You can select either the insertion point of the view block that represents the panel, or one of 9 other points on the panel, such as Top Left or Middle Center.

6 Specify an elevation by doing one of the following:

- For Preset Elevation, select a defined elevation.
- For Elevation, enter an elevation.

The difference in the elevation of the devices, the wires, and the panel for a circuit is used to calculate the circuit length. Note that the circuit length can only be calculated if the panel and all of the devices on the circuit are in the current drawing.

**Specify advanced properties**

7 Expand Advanced, expand System, and for System, select the system to which the panel belongs.

For more information about systems, see Creating Electrical System Definitions on page 534 and Working with Systems on page 138.

8 Expand Design Data, and for Name, enter a unique name for the panel.

9 For Rating, enter a panel rating.

10 For Voltage phase-to-neutral, select from the drop-down list. The voltage list comes from the Electrical Preferences - Voltage Definitions.

11 For Voltage phase-to-phase, select from the drop-down list. The voltage list comes from the Electrical Preferences - Voltage Definitions.

12 For Phases, select the number of phases: 1 or 3.
13 For Wires, select the number of wires: 3 or 4.
14 For Main type, select Main lugs only (MLO) or Main circuit breaker (MCB).
15 For Main size (amps), enter the main size.
16 For Design capacity, enter the design capacity.
17 For Panel type, select ANSI or ISO.
18 For Enclosure type, enter an enclosure type.
19 For Mounting, select Surface, Recessed, or Floor.
20 For AIC rating, enter a rating.
21 For Fed from, enter the fed from information.
22 For Notes, enter any notes.

**Optionally create one or more circuits for the panel**

23 If you do not want to create circuits, skip this section and proceed to the section on inserting the panel. Otherwise, expand Circuits, and for Create circuits, select Yes.
24 Beside Circuit Settings, click \[ \text{Power and Lighting} \].

![Create Multiple Circuits dialog box]

25 On the Circuit Settings worksheet, for System Type, select the system type of the circuits: Power and Lighting, General, or Other.

**NOTE** If you select Power and Lighting or Other for the system type, the connectors on the electrical objects in your drawing must have the same system type in order to be placed on the circuit. To allow devices of any system type to be connected to the circuit, select General for the system type. The General system type allows objects of different system types to connect. For more information, see Circuits on page 517.

26 For System, select an electrical system for the circuits.
Specify additional circuit properties, which vary according to the system type of the circuit:

**If the system type is… then…**

**Power and Lighting**
- Enter the total number of slots on the panel.
- Enter the number of 1-pole, 2-pole, and 3-pole circuits to create. You can only create 3-pole circuits if you selected 3 for Phases on the Properties palette.
- For each type of circuit to create (1-pole, 2-pole, and 3-pole), select a voltage. You can select from the voltages defined in the drawing that are valid for the number of poles.

**NOTE** If the number of 1-pole, 2-pole, and 3-pole circuits is less than the number of slots, the remaining circuits will be created with a rating of 0.

**General or Other**
For Number of circuits, enter the number of circuits to create.

For Circuit Description, specify the description for circuits with breakers and circuits without breakers that will display in the Circuit Manager when new circuits are created.

Insert the panels

In the drawing, insert the panels as follows:

**If, for Align to objects, you selected… then…**

**Yes**
- use object snaps to snap to an object (such as a wall) at the desired insertion point, and click to insert the panel.
If, for Align to objects, you selected... then...

**NOTE** If you have difficulty snapping and aligning to an object, zoom to the area or modify the size of the Auto-Snap aperture as needed. The aperture size determines how close to a snap point you can be before the magnet locks the aperture box to the snap point. You can modify the size on the Drafting tab of the Options dialog. For more information, see Drafting Tab (Options Dialog Box).

---

**No**

do the following:

- Click to specify the insertion point.
- Rotate the panel by moving the cursor or entering the number of degrees on the command line, and click to insert the panel. Alternatively, you can press Enter to accept the default rotation, and then click.

30 Repeat the previous step to add additional panels with same properties.

31 On the Properties palette, modify the panel properties and then insert additional panels, or press Enter to end the command.

**Optionally link the panel to an existing panel**

32 If you do not want to link this panel to an existing panel, skip this section. Otherwise, select the panel, right-click and click Connect To.
33 Select the panel you want to connect to and click OK.

![Panel To Panel Connection]

**NOTE** Valid connections are shown in bold.

34 Select the method to use when connecting the panels and click OK.

![Panel to Panel Connection Method]

**If you select...**  
**then...**

- Circuit breaker in panel  
  the panel is added as a subfed panel to an existing circuit in the linked panel.
If you select… then…

<table>
<thead>
<tr>
<th>Feed-thru lugs</th>
<th>the panel is added as a subfed panel to a feed-thru lug in the linked panel.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subfeed lugs</td>
<td>the panel will be added as a subfed panel to a subfeed lug circuit in the linked panel.</td>
</tr>
<tr>
<td>Subfeed breaker</td>
<td>the panel will be added as a subfeed panel to a subfeed breaker circuit in the linked panel.</td>
</tr>
<tr>
<td>Panels are connected through a transformer (panels are different voltages)</td>
<td>the panel will be connected through a transformer when panels are of different voltages.</td>
</tr>
</tbody>
</table>

**NOTE** To remove the link to a panel, select the panel, click Panel tab ➤ Connections panel ➤ Remove Connection To 📨.

---

**Example: Aligning a Panel to Floor Plan Geometry**

In this example, you add a panel and align it to a wall.

1. In a new drawing, attach or overlay a drawing of an architectural floor plan.
2. In the Electrical workspace, open the Panel tool palette, and select a panel tool.
3. If necessary, on the Properties palette, change the style of the panel to be added:
   - Expand Basic, and on the General bar, click 📚.
   - In the left pane of the Select Panel worksheet, navigate to the drawing that contains the style.
   - In the right pane, select the style, and click OK.
4. Expand Location, and for Align to objects, select Yes. This causes the panel to align to the object to which you snap. You can snap and align to a wall, space boundary, line, polyline,
spline, arc, or circle in the current drawing or in a referenced drawing (xref).

5 In the drawing, snap to a wall at the desired insertion point, and click to specify the point.

**TIP** When you are prompted for a point, you can temporarily enable an object snap by entering the first 3 characters of its name. This is useful when you require a snap that you do not want as a running object snap, such as Nearest, which snaps to the nearest point on an object.

![Object Snap Example](image)

**NOTE** If you have difficulty snapping and aligning to an object, zoom to the area, or modify the size of the AutoSnap aperture as needed. The aperture size determines how close to a snap point you can be before the magnet locks the aperture box to the snap point. You can modify the size on the Drafting tab of the Options dialog. For more information, see Drafting Tab (Options Dialog Box).

6 Press Enter.

**NOTE** For detailed information about adding panels and configuring their properties, see Adding Panels on page 596.

### Copying Devices and Panels

You can copy devices and panels using Alignment grips ( ). Unlike the AutoCAD COPY command, the grips can optionally align the copy perpendicular to the object to which you snap, such as a wall or a ceiling grid.
By default, Alignment grips are displayed at the electrical connector points on devices and panels. However, you can toggle on additional grips by clicking the Show all insertion points grip. The additional grips are located at the justification points available when adding devices and panels, for example, Top Left, Bottom Center, and Insertion Point. In the following image, one receptacle displays the default Alignment grip; the other also displays the additional grips.

**NOTE** When you copy multiple devices or panels at the same time using Alignment grips, you must select a base grip on one device or panel (the base device or base panel) for the copy action. If you align the copy of the base device or base panel to an object, the other copies inherit the same angle of rotation. The other copies also maintain their position relative to the base copy.

**To copy a device or panel**

1. Select the device or panel.
2. Select the Alignment grip to use to insert the copy:

<table>
<thead>
<tr>
<th>If you want to insert the copy relative to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>its electrical connector point</td>
<td>select the default grip.</td>
</tr>
<tr>
<td>another point on the device or panel</td>
<td>click the Show all insertion points grip, and select the grip.</td>
</tr>
</tbody>
</table>

**NOTE** To copy multiple devices or panels at the same time, while pressing Shift, select the same Alignment grip on each of the devices or panels to create the selection set. Then, on one device or panel, reselect the grip to use it as the base grip.
3 Specify how you want to align the copy:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>Then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>snap to an object using object snaps and have the software align the copy perpendicular to the object</td>
<td>proceed to the next step. When you select an Alignment grip, this behavior is active by default.</td>
</tr>
<tr>
<td>place the copy using the angle of rotation of the original device or panel</td>
<td>press Ctrl. This toggles off the alignment behavior, but you can still snap to an object to place the copy.</td>
</tr>
</tbody>
</table>

NOTE The software can align the copy perpendicular to a wall, ceiling grid, space boundary, line, polyline, spline, arc, or circle in the current drawing or in a referenced drawing (xref).

4 Enter `c` (copy).

5 Copy the device or panel:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>Then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>use the base grip point as the base point for the copy</td>
<td>specify the second point (the insertion point of the copy) by doing one of the following:</td>
</tr>
<tr>
<td></td>
<td>■ specify a point in the drawing. For example, you can snap to a point on a wall.</td>
</tr>
<tr>
<td></td>
<td>■ enter the coordinates, and press Enter.</td>
</tr>
<tr>
<td>specify a base point and then a second point</td>
<td>enter <code>b</code> (base point), specify the base point, and then specify the second point.</td>
</tr>
</tbody>
</table>
NOTE If you have difficulty snapping and aligning to an object, zoom to the area, or modify the size of the AutoSnap aperture as needed. The aperture size determines how close to a snap point you can be before the magnet locks the aperture box to the snap point. You can modify the size on the Drafting tab of the Options dialog. For more information, see Drafting Tab (Options Dialog Box).

6 Repeat the previous step to place additional copies.
7 Press Esc.

NOTE When copying a device, the loads will increase for the circuit. Use the REGEN command to update a panel schedule for that circuit. If the new load exceeds the limit for the load category, the panel schedule will need a new row. A diagonal line through the panel schedule will indicate that the schedule is out of date. See Updating Panel Schedules on page 693 for more information.

Example: Copying a Device

In this example, a receptacle is copied to 2 locations in a room.
Example: Copying a Panel

In this example, a recessed panel is copied and aligned elsewhere on the same wall.
select panel

click Show all insertion points grip

select Alignment grip

enter c, then place copy

result
Adding Wires

Although you can connect devices with wires to graphically represent circuits, wires are not necessary for you to assign devices to circuits and to view electrical loads.

You can also add wires without assigning circuits, which can be useful during the preliminary design phase when the specifications are not defined.

Drawing or Generating Wires

You can add wires by doing one of the following:

- Drawing the wires manually by using a wire tool, or by using the + grip on an electrical device
- Generating the wires using a command. In this case, you must specify a circuit in the wire's properties.

If you assign the devices to a circuit as you connect them with wires, the circuit is updated and evaluated for overloads based on the load and load category of the connectors on the devices. In circuiting preferences, you can specify whether the software warns you of the overloads, so you can decide whether to proceed and add the wire. If you overload a circuit, you are not notified of the overload again within the drawing session.

When you use the + grip to invoke a wire-add operation, the software uses the set of properties for the connector of the chosen device. For example, for system, it will use the system type of the connector of the chosen device. If the system type is undefined, the wire-add operation uses the last used system in that drawing or session for the system type. The Properties palette will filter the Systems list to display only those systems that match the connector.

The Properties palette will also show:

- Circuit, unless it is unassigned
- Panel, based on the circuit

The list of available circuits will show only those that can be used for the chosen connector. When a connector circuit is unassigned, the available list shows:

- For Power and Lighting circuits, the first available circuit with no load, or the one with the least amount of load
- For Other circuit connectors, the first available circuit of that type
- For General circuits, the first circuit available

The list of circuits also displays the total assigned load for each circuit. The list of panels will show the last used panel, or All if Circuit is undefined.

You can add wires using any of the following types of wire segments.

<table>
<thead>
<tr>
<th>Wire Segment Type</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line. Use this type to draw wires using straight lines.</td>
<td><img src="Image" alt="Example Wire Segment Type-Line" /></td>
</tr>
<tr>
<td>Arc. Use this type to draw wires with arcs.</td>
<td><img src="Image" alt="Example Wire Segment Type-Arc" /></td>
</tr>
<tr>
<td>Snake. Use this type to draw wires with arcs that alternate the offset direction.</td>
<td><img src="Image" alt="Example Wire Segment Type-Snake" /></td>
</tr>
<tr>
<td>Polyline. Use this type to draw wires with lines connected with filleted corners.</td>
<td><img src="Image" alt="Example Wire Segment Type-Polyline" /></td>
</tr>
<tr>
<td>Chamfer. Use this type to draw wires with plateaus.</td>
<td><img src="Image" alt="Example Wire Segment Type-Chamfer" /></td>
</tr>
<tr>
<td>Spline. Use this type to draw wires with curves that pass through or near a set of specified points.</td>
<td><img src="Image" alt="Example Wire Segment Type-Spline" /></td>
</tr>
</tbody>
</table>

To add wires

1. In the Electrical workspace, start the add command by doing **one** of the following:
   - Click Home tab ➤ Build panel ➤ Wire ➤ .
   - Select the + grip on a device
   - Open the Wire tool palette, and select a tool.
     If necessary, scroll to display the tool. Because tools contain preconfigured properties for the objects they create, you might
not need to specify some of the wire properties referenced in this procedure.

- Enter `wireadd`.

**NOTE** On the Properties palette, indicates a property is available only when you are adding wires, not when you are modifying them.

Specify general properties (optional when using the + grip)

1. On the Properties palette, if necessary, specify or change the wire to add by selecting a wire style:
   - Expand Basic, and expand General.
   - For Style, select a wire style.
      You can select from the wire styles in the current drawing.

If you want to calculate wire sizes using the instant sizing tool, do not select the Standard style provided in the software. By default, that style does not specify a wire material, which is required to calculate the sizes.
3 For Description, enter a description of the wire.

Specify location properties

4 Expand Location, and for Segment, select the type of wire segment to use:

<table>
<thead>
<tr>
<th>If you want to use...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>select Line.</td>
</tr>
</tbody>
</table>
| Arc                   | select Arc, and do the following:  
  - For Height, enter the height of the geometry.  
  - For Offset, select Left or Right, which indicates the side on which to display the geometry. |
| Snake                 | select Snake, and specify values for Height and Offset. |
| Polyline              | select Polyline, and for Radius, enter a radius to set the curvature for the fillets. |
| Chamfer               | select Chamfer, and specify values for Height and Offset. |
| Spline                | select Spline, and specify values for Height and Offset. |

TIP When drawing wires using arc, snake, or spline segments, you can override the values for Offset and for Height by specifying a point between 2 devices. This can be helpful when you want to route the wires around walls, equipment, or other floor plan geometry, or when you are unsure of the value to specify for Offset. For an example, see Example: Drawing Wires on page 617.

5 Specify an elevation by doing one of the following:
  - For Preset Elevation, select a defined elevation.
  - For Elevation, enter an elevation.

The difference in the elevation of the devices, the wires, and the panel for a circuit is used to calculate the circuit length. Note that the circuit length can only be calculated if the panel and all of the devices on the circuit are in the current drawing.
Specify advanced properties

6 Expand Advanced, expand System, and for System, select the system of the wire.

| NOTE | If the electrical connector on the device to which the wire will be connected does not have a specified system, you can connect a wire of any system to the connector. However, if the connector has a specified system, the system of the wire must be the same. If it is not the same, you cannot add the wire unless the system of the electrical connector is changed to match. Depending on how you have configured the connection rules, you are prompted to accept the change before adding the wire, the change is made without prompting you, or you cannot make the change and add the wire. The system of the device, which only determines how the device is displayed, is not affected. For more information about systems, see Creating Electrical System Definitions on page 534 and Working with Systems on page 138. |

7 Expand Design Data, and specify whether to assign the devices to a circuit as you connect them with wires:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>connect the devices with wires without assigning a circuit</td>
<td>for Circuit, select Unassigned.</td>
</tr>
<tr>
<td>assign the devices to a circuit</td>
<td>for Show circuits from panel, select the panel that contains the circuit. You can select from the panels in the current drawing, or in the electrical project database. Then, for Circuit, select the circuit.</td>
</tr>
</tbody>
</table>

| IMPORTANT | To use the instant sizing tool to calculate the wire sizes, you must select a circuit whose system type is Power and Lighting. You cannot select Unassigned or a circuit of different system type. |
NOTE As you connect the devices with wires, the software assigns the devices to the specified circuit unless they are already assigned to one. In this case, the Circuit property cannot be changed. You can manually create a multiple-branch circuit by changing the specified circuit as you add wires, or by drawing a wire between 2 devices that are already assigned to different circuits.

Specify wire sizes

8 Expand Dimensions, and specify the wire sizes by doing one of the following:

- On the Dimensions bar, click to have the instant sizing tool calculate the sizes.
  The tool calculates the sizes based on
  - The material and temperature rating of the wire, which are specified in the wire style
  - The rating of the specified Power and Lighting circuit
  - The ambient temperature specified in the drawing. For information about specifying the ambient temperature, see Configuring Circuiting Options on page 539.

- Select or enter wire sizes for the hot, neutral, ground, and isolated ground wires.

The wires for which you need to calculate or specify sizes depend on the design specifications of the selected wire style.

Insert the wires

9 Connect the devices with wires:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>insert the wires manually</td>
<td>in the drawing, use electrical snaps to manually specify the devices to connect with wires. For an example, see Example: Drawing Wires on page 617.</td>
</tr>
</tbody>
</table>
If you want to… then…

NOTE As you connect the devices with wires, on the Properties palette you can view the assigned circuit (Connected circuits) and its total load (Connected load). In the case of multiple-branch circuits, all circuits and their total loads are shown.

| generate the wires | enter g (generate) on the command line to generate wires between all the devices assigned to the specified circuit. |

Optionally insert a home run wire

10 Do one of the following:

■ To add a home run, press Enter, and click in the direction of the panel. The appearance of the home run depends on the annotation properties of the wire style.

■ To end the command without adding a home run, press Enter twice. You can add a home run later, as shown in Drawing a Home Run on page 619.

Example: Drawing Wires

In this example, you connect receptacles with wires using the spline wire segment. You override the default height and offset direction for one of the wires, so you can draw the wire along the wall.

1 In a new drawing, attach or overlay a drawing of an architectural floor plan.

2 Add several receptacles to a room as shown.
3 Select the left most receptacle and click on the + grip.
4 On the Properties palette, enter a distance for Height, and specify Left for Offset.
5 Using electrical end connector snaps, specify the first device to connect with wires.

6 Snap to the electrical connector on the second device.
7 Draw the third wire by manually overriding the height and the offset direction of the wire. To do this, specify a point between the devices, and then snap to the third device.
8 Press Enter twice to end the command without adding a home run.

NOTE For detailed information about adding wires and configuring wire properties, see Drawing or Generating Wires on page 611.

Drawing a Home Run

A home run is a wire that graphically represents the wiring of a circuit to a central location that acts as the distribution point for the power, typically, a panel. You do not need to connect the home run to the panel. You can draw the home run in the direction of the panel, as is common practice.

The appearance of the home run is determined by the annotation properties of the wire style.

While you can use a single home run to represent the connection of one or more circuits to a single panel, sometimes devices are assigned to multiple circuits on different panels. For example, you might have a lighting fixture with 2 electrical connectors, where the first connector is assigned to a circuit on a panel for normal lighting, and the second connector is assigned to a circuit on a panel for emergency lighting. When a device is assigned to multiple circuits on multiple panels, you must add a home run to each panel. This allows you to subsequently tag each home run with the correct panel information. Make sure the locations of the electrical connectors in the device
style are not the same, so you are able to draw a home run from each connector.

To draw a home run

1 Select an existing wire on the circuit, and click Wire tab ➤ General panel ➤ Add Selected.
2 Using electrical snaps, select a device in the circuit.
3 Press Enter, and specify a point in the direction of the circuit’s panel.

Creating a Wire from a Polyline

You can convert an AutoCAD® line, arc, or polyline to a wire.

1 Select the line, arc, or polyline that you want to convert, right-click, and select Convert to ➤ Wire.
2 Do one of the following:
   ■ Press Enter or enter n (no) to leave the layout geometry in the drawing.
   ■ Enter y (yes) to erase the layout geometry from the drawing.
3 In the Modify Wires dialog, specify values for the wire properties, such as system and voltage.
4 Click OK.

Adding Electrical Equipment

After you add devices and panels to your layout and update the circuitry to include voltage and load requirements, typically you continue by adding the electrical equipment needed to support the system. You can place the equipment in specific locations on the floor plan.

You add electrical equipment using the tools on the Equipment tool palette in the Electrical tool palette group. You select a tool, use the Add Multi-view Parts dialog to select a part and configure its properties, and then add the part to the drawing.

RELATED See Mechanical, Electrical, and Plumbing Equipment in Building Systems on page 110.
To add electrical equipment

1 In the Electrical workspace, click Home tab ➤ Build panel ➤ Equipment drop-down ➤ Generator (or other provided equipment).

**TIP** To add equipment to an existing conduit run, select a conduit segment, click Conduit tab ➤ General panel ➤ Insert Equipment drop-down ➤ Generator (or other provided equipment).

The software displays the Add Multi-view Parts dialog, which displays a tree view of the current catalog.

The software opens the catalog at the part type folder associated with the tool you selected.

2 On the Part tab, select a part subtype in the part type folder.

3 Click Details to view the sizes available for the selected part subtype.
4 Some part types have large numbers of available sizes. If necessary, filter the list by clicking the Part Filter tab and specifying the filtering criteria. For example, you can filter the list according to connection size or type.

**NOTE** The part catalogs and content locations specified in the Options dialog determine the parts available to you when adding a part. For more information, see *Specifying Part Catalogs and Style-Based Content Locations* on page 100.

If the part you want is not available, you or your CAD manager can create a custom part using *Content Builder*.

5 Select a part for Part Size Name.

6 Select a defined elevation from the list or enter a value for Elevation.

7 Specify an insertion point in the drawing, and use the compass to specify a rotation angle.

8 Repeat the preceding step to add additional parts with the same properties.

9 Press *Enter* to end the command.

---

**Adding Cable Trays and Conduits**

You can add to *cable tray and conduit* runs in the following ways:

- In the Electrical *workspace* on page 53 — from the *ribbon* on page 57
  - Click Home tab ➤ Build panel ➤ Cable Tray or Conduit .

- Click Home tab ➤ Build panel ➤ Cable Tray Fitting or Conduit Fitting .

- Select the object, and click Cable Tray or Conduit ➤ General panel ➤ Add Selected .

- Click the Add grip ( ) on conduit or cable tray on page 629.

- From the *Tool palette* on page 130
Conduit

Use the Conduit Properties palette for conduit and fitting settings.

**RELATED** For more information, see Conduit Properties Palette on page 528.

Properties palettes for conduit* and conduit fittings

*C shows expanded properties including parallel routing mode

Cable Tray

Use the Add Cable Trays dialog for cable tray settings and the Add Cable Tray Fittings dialog for fittings.
Dialogs for cable tray and cable tray fittings

You can also manually add fittings on page 638 to your drawing, which is beneficial when you want to create unique connections to other runs or equipment.

NOTE For information about specifying layout preferences, see Configuring Layout Preferences for Cable Tray or Conduit on page 554.
Drawing a Cable Tray or Conduit Run

1. In the Electrical workspace on page 53, click Home tab ➤ Build panel. Then click Cable Tray or Conduit.

2. For the remaining steps, use the Properties palette on page 528 for conduit settings or the Add Cable Trays dialog on page 622 for cable tray settings, as shown next.

Conduit (left), cable tray (right)

*Shows expanded properties including parallel routing mode

3. Select a system from the following locations:
   - For cable tray: In the Add Cable Trays dialog, at System
   - For conduit: On the Properties palette, under General, at System

The cable tray and conduit tools have specific, predefined systems on page 138, such as Power - 120V or Data. The cable tray or conduit that you draw inherits the system's properties, such as its design parameters, display on page 208 properties, and rise and drop style on page 911.
4 Specify dimensions from the following locations:
   ■ For cable tray: In the Add Cable Trays dialog, at Width and Height
   ■ For conduit: On the Properties palette, under Dimensions, at Nominal size

5 Specify how to draw the run:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
</table>
| draw a run at a specified elevation and offset relative to another object | enter the desired elevation, and specify justification on page 160 and offset:  
   ■ For cable tray: In the Add Cable Trays dialog  
   ■ For conduit, on the Properties palette, under Placement |
| Specifying offset from vertical or horizontal object |  
   **TIP** For horizontal offset, select Left, Right, or Center, and then enter the distance between the run and the horizontal object. For vertical offset, select Top, Center, or Bottom, and then enter the distance between the run and the vertical object. |
| draw a run at a specified elevation | enter the desired elevation, as described above. Click (next to Elevation) to prevent the elevation from being changed. |
| extend a cable tray or conduit run at a specified elevation | use Add grips ( ) as described in Adding Conduit or Cable Tray Using Grips on page 629. The new segment inherits the elevation and other properties of the original segment. |
**TIP** Use AutoCAD MEP snaps to locate valid connection points on objects in the drawing.

6 Specify an angle:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify an angle</td>
<td>select an angle from the list or enter a different value, as follows:</td>
</tr>
<tr>
<td></td>
<td>■ For cable tray: In the Add Cable Trays dialog under Use Routing, at Elbow Angle</td>
</tr>
<tr>
<td></td>
<td>■ For conduit: On the Properties palette, under Routing, at Bend angle</td>
</tr>
<tr>
<td>define an angle in the drawing area</td>
<td>specify a point in the drawing area using the compass.</td>
</tr>
<tr>
<td>draw with only the specified angle</td>
<td>click next to Elbow Angle (cable tray) or Bend angle (conduit). All segments you draw next will use the same angle.</td>
</tr>
</tbody>
</table>

7 To show a vertical rise in the drawing area at a specific elevation, do the following:

- For cable tray: Click in the Add Cable Trays dialog. In the Cable Tray Layout Preferences dialog on the Routing tab, select Automatically create riser at new Elevation. Click OK, and then enter an elevation in the Add Cable Trays dialog.

- For conduit: Click (Preferences) on the Properties palette on page 528. In the Conduit Layout Preferences worksheet,
select Automatically create riser at new Elevation. Click OK, and then enter an elevation on the Properties palette.

Automatically create riser at new Elevation selected
(default)

Automatically create riser at new Elevation not selected

8 Specify the rise/run angle (cable tray) or slope (conduit) as follows:
  - For cable tray: In the Add Cable Trays dialog, under Layout Method, click Use Rise/Run, and specify a value in degrees.
  - For conduit: On the Properties palette, under Routing, specify a value for Slope and Slope format.

9 For conduit, you can click (Connection details on page 172) to view the flow direction and connection type for connector #1.

10 Continue specifying points to add more segments to your run.
  The software inserts the appropriate fittings to connect the segments that you draw. For information about temporarily overriding the default fittings, see Adding Cable Tray or Conduit Fittings Manually on page 638.
Adding Conduit or Cable Tray Using Grips

1. Select a conduit or cable tray, and click (Add grip) to draw a run as follows:

<table>
<thead>
<tr>
<th>To start a run from…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>end of segment</td>
<td>click ( ) at one end of the segment.</td>
</tr>
<tr>
<td></td>
<td><img src="image1" alt="Diagram" /></td>
</tr>
<tr>
<td>midpoint of segment</td>
<td>click ( ) at the midpoint of the segment. For conduit, a tee or takeoff is inserted, depending on the connection specified in the routing preferences.</td>
</tr>
<tr>
<td></td>
<td><img src="image2" alt="Diagram" /></td>
</tr>
</tbody>
</table>

Adding Cable Trays and Conduits | 629
To start a run from… then…

<table>
<thead>
<tr>
<th>MvPart</th>
<th>click [ ] on the MvPart connection.</th>
</tr>
</thead>
<tbody>
<tr>
<td>fitting</td>
<td>click [ ] in the direction of the new run.</td>
</tr>
</tbody>
</table>

2 For conduit: On the Properties palette on page 528, under Routing Options, specify the layout method to apply to the new conduit run.

- If you start from an MvPart on page 110, under Dimensions, optionally specify a system and routing preference. The new run inherits the routing preference and system setting of the connected object.
- If you change the nominal size before specifying the first segment of the new run, a transition is inserted.

Tip: If the conduit is not in the conduit routing preferences on page 526, you are prompted to make a part substitution on page 447 to insert into the layout at the appropriate angle.
3 For cable tray: In the Add Cable Trays dialog:
   ■ If you start from an MvPart, specify a system type for System.
   ■ If you start from a segment or fitting, the new run inherites the system.
   ■ If you change a dimension before specifying the first segment of the new run, a transition is inserted.

4 Continue specifying points for the layout geometry.

**RELATED** See *Drawing a Cable Tray or Conduit Run* on page 625.

### Adding a Cable Tray or Conduit Branch

After you draw your cable tray or conduit runs, you can add branches to connect the runs to form a complete network. You can use AutoCAD MEP snaps to help locate valid connection points on the objects in your drawing.

When you start a run at the end of a segment, the nearest valid connection point is not always the endpoint of a segment. You can form a valid connection at any point along the path of another run. In this case, the software inserts an appropriate fitting to connect the 2 runs.

**Drawing a branch**

![Existing cable tray](image)

**Specify cable tray segment curve connection point**

![Specify cable tray segment angle and endpoint](image)

![Resulting tee fitting and cable tray segment](image)
Connecting a cable tray run to a cable tray trunk that is the same size

NOTE When you add cable tray or conduit runs, AutoCAD MEP inserts rise symbols and drop symbols as needed based on the rise/drop style assigned to the system of the run.

To add a cable tray or conduit branch

1. Turn on the Wire Ways Curve or Wire Ways Connector snaps.
2. In the Electrical workspace, click Home tab ➤ Build panel ➤ Cable Tray or Conduit.
3. Using the Wire Ways Connector or Wire Ways Curve snap, select the first segment to connect, and then select the second segment.
   You can modify properties on the command line.
4. Click Close or press Enter to end the command.
   Once you complete your connections, you can use Solution Tips on page 862 to test whether your connections are valid.

Drawing a Parallel Conduit Run

You can draw parallel conduit runs, where bend radius values are automatically calculated as you make turns. Use this procedure to draw parallel routing for a conduit system.

1. Add equipment to your drawing. Select the MvPart, and click (Add grip).
2 Add conduit to the layout.

3 Continue to add more conduit segments (using + on the MvPart).

4 To start parallel routing, click Home tab ➤ Build panel ➤ Conduit drop-down ➤ Parallel Conduits .

TIP You can also enter ParallelRouting at the command line.
5 Select the baseline conduit.

![Baseline conduit]

**TIP** Routing begins at the open end of the baseline conduit segment. If the segment is open at both ends, click near the end where you want the routing to begin.

6 Select the parallel conduit segments and press *Enter.*

![Parallel conduit segments and Enter]

7 Select the next points in the run.

As parallel segments are drawn, each segment is created according to the routing preferences and properties specified for the baseline conduit segment. A constant distance is maintained between the segments where possible.

**Drawing segments along the run**
By default (as shown next), the correct radius is calculated for inside, middle, and outside radius values in each conduit bend. You can adjust Radius of curvature on the Properties palette on page 528 at any time after the conduit runs are laid out.

Completed run

You can change the parallel bend type on the Properties palette on page 528 from Concentric (default) to Fixed radius, when in parallel routing mode. With fixed radius, elbows in the conduit run use their predefined radius values and are not adjusted. For more information, see Specifying Parallel Bends in the Conduit Run on page 635.

NOTE If the routing preference for one or more segments does not specify a required conduit type or fitting or if a discrepancy exists, the Choose a Part dialog prompts you to specify a different part. See Choosing a Part on page 447 for more information.

Specifying Parallel Bends in the Conduit Run

The Properties palette on page 528 provides 2 options for configuring parallel bends: Concentric and Fixed radius. These options let you specify the type of bend radius for use in a parallel conduit run.
Specifying parallel bends in a conduit run

Concentric

Concentric adjusts the bend radius for each elbow so that it maintains a common center radius. AutoCAD MEP automatically calculates the correct radius for inside, middle, and outside radius values for each conduit bend. Concentric radius values are 16", 24", 32", and 40".

Concentric
Fixed Radius

Fixed radius is similar to pipe parallel routing on page 506. Elbows in the conduit run use their predefined radius values and are not adjusted. For fixed radius routing, all the bend radius values are 16”.

Changes to Conduit Segments in the Parallel Run

If you make changes on the Properties palette on page 528 to segments in the parallel run, the following outcomes might result:

- A change to a property that affects the placement of the baseline conduit, such as Justification on page 160 or Compass, applies only to that conduit.
- A change that affects the physical characteristics of a conduit segment being created, such as Size, affects all conduit segments in the run.
- A new Elevation value modifies the elevation of all conduit segments being routed. The distance between the conduit segments is maintained over the elevation change unless it results in a conflict.

Correcting a Parallel Routing Conflict

The following conflicts could occur when drawing a parallel conduit run:

- Distance conflicts when making an invalid turn or changing elevations
- Dimension conflicts because of nominal size differences
See the following example:

If a conflict occurs, take the appropriate action:

- Click Undo to revert to the last point.
- Accept the suggested action. This current settings are maintained between the conduit segments as you continue routing.

Adding Cable Tray or Conduit Fittings Manually

Generally, as you draw a cable tray or conduit run, the software adds fittings based on the default fittings specified in the cable tray or conduit preferences. However, you can also add cable tray or conduit fittings manually. You can add a fitting to an existing segment or run. You can also start a segment or run from a fitting, or customize the connection to an MvPart.

To add a cable tray or conduit fitting

1. To add the desired fitting, in the Electrical workspace, click Home tab ➤ Build panel ➤ Cable Tray Fitting 🔄 or Conduit Fitting 🔄.

2. Specify the part type:
   - For cable tray: In the Add Cable Tray Fitting dialog on the Part tab, select a part type folder, and then select a part subtype in the folder.
NOTE Click Details to expand the contents in the Add Cable Tray Fitting dialog.

- For conduit, on the Properties palette on page 528, click the part image. In the Select a Part dialog, specify a part type.

TIP Select Display/Hide additional part parameters to toggle this option on or off.

3 Specify the filtering criteria:
- For cable tray: In the Add Cable Tray Fitting dialog, on the Part Filter tab, specify a value from the list for a property name. Click Details to view the available sizes.
- For conduit: In the Select a Part dialog, under Filter by Dimensions, specify a dimension and value respectively from each of the lists.

4 Select a part size name (cable tray) or part size (conduit).

5 Specify elevation:
- For cable tray, in the Add Cable Tray Fittings dialog, specify a defined elevation or enter a value.
- For conduit, click OK to close the Select a Part dialog. On the Properties palette, under Placement, enter a value for Elevation.

6 Specify an insertion point in the drawing, and use the compass to specify a rotation angle.

Checking Electrical Systems

AutoCAD MEP includes circuit information tools to help you make decisions about circuit and panel assignments. You can review information for a single circuit or for all circuits in the drawing. You can also calculate power totals for selected devices. If you are using the electrical project database, you can maintain accurate circuit information across all drawings.
Calculating Wire Sizes Using the Circuit Manager

When you check the wire sizes for circuits, the software calculates the sizes from the circuit rating and then compares them to the actual wire sizes in the circuit. You can then optionally resize undersized or oversized wires.

To check the wire sizes for circuits

1 In the Electrical workspace, select a wire and click Wire tab ➤ Circuits panel ➤ Circuit Manager ➤ Circuit Manager .

2 On the right pane of the Circuit Manager, select the circuit (or circuits) to check.

Use SHIFT or CTRL to select multiple rows in the circuit view list to select multiple circuits. Choosing a panel on the left pane selects only the first circuit in the circuit list.

NOTE Before you can calculate wire sizes, you must add wire to the devices in the circuit. You must also set the type of conductor material for the wire style used, for example, copper or aluminium (for more information, see Configuring Styles for Wires on page 549).

3 Click (Calculate Wires).

4 In the Calculate Wire Sizes dialog, specify a resizing option:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>compare wire sizes to calculated values without changing any sizes</td>
<td>select Check only.</td>
</tr>
<tr>
<td>check wire sizes and have undersized wires resized automatically</td>
<td>select Change Under dimensioned.</td>
</tr>
<tr>
<td>check wire sizes and have both undersized and oversized wires resized automatically</td>
<td>select Change All.</td>
</tr>
</tbody>
</table>

5 Click OK.

If you chose to resize any wires, the wire sizes are updated in the right pane under Wires. If you chose only to check the wire sizes, the Calculate Wire Size - Results dialog displays the results of the analysis.
Viewing Circuit Information

You can view the voltage, load, and length of a particular circuit to help you make design decisions, such as whether to extend an existing circuit or how to make panel assignments.

To view circuit information

➤ Select a wire or a device, click Wire tab or Device tab ➤ Circuits panel ➤ Circuit Manager drop-down ➤ Circuit Info.

![Circuit Information](image)

NOTE If you have reloaded the electrical project database in the current drawing, the circuit load reflects the total load from all devices assigned to the circuit. The devices contributing to the total load can reside in multiple drawings.

Checking Circuit Loads

Circuit loads can be automatically tabulated for circuits of the Power and Lighting system type. When you assign devices to a circuit, their loads are automatically added to the circuit load. You can view circuit loads in the Circuit Manager, or you can view circuit information or a circuit report for one or more selected devices.

You can use the circuiting settings in the Electrical Preferences to indicate circuit overload conditions. When turned on, overloaded circuits are displayed in red on the Circuit Manager. You can also turn on a feature to notify you when a circuit is overloaded as you are assigning devices to circuits in the drawing.
Generating a Circuit Report

As you create schedules for your electrical design, you might find it helpful to view information about particular circuits in the drawing. In a circuit report, you can view the assigned panel name, circuit name, voltage, load (in VA), circuit length, and number of devices for one or more selected circuits.

You can copy the information in a circuit report to the Clipboard, and then paste it into another application, such as a spreadsheet or word processing application.

NOTE The Circuit Manager also supports Copy to Clipboard (CTRL + C).
To generate a circuit report

1 To report on a wire or device, select the object, click Wire tab or Device tab ➤ Circuits panel ➤ Circuit Manager drop-down ➤ Circuit Info.

2 If you want to copy the report into another program, click (Copy to Clipboard).

Showing Circuited Devices

You can use the Show Circuited Devices command to highlight all devices that are part of the same circuit. This feature finds all of the devices in the current drawing that are connected to the same circuit.

NOTE You can also check the connectivity of a run or individual object. For more information, see Checking Your Drawings on page 861.

To show circuited devices

1 In the Electrical workspace, use one of the following methods to show circuited devices:
   - Select a wire or device and click Wire tab or Device tab ➤ Circuits panel ➤ Show Circuited Objects drop-down ➤ Show Circuited Objects.
   - Select a device, right-click, and click Connected Objects ➤ Show Circuited Objects.

The devices connected in the circuit are highlighted.
Showing Connected Objects

You can highlight all connected objects in a run or network. For example, you can check a lighting network to ensure connectivity between the lighting devices, wires, junction boxes, and switches. You can also check an equipment drawing to ensure connectivity between MvParts and conduit or cable tray runs.

To show connected objects

1. In the Electrical workspace, select an object, and click the object’s contextual ribbon tab (such as Cable Tray Fitting tab) ➤ Modify panel ➤ Show Connected Objects drop-down ➤ Show Connected Objects.
2. All objects connected to the selected object are highlighted.
3. Press Enter to exit the command and remove the highlighting.

Viewing Power Totals

To avoid overloading circuits, you can calculate a power total for devices before you connect them. You can display a power total for a selection set that includes lighting, receptacles, and other devices, which includes all devices of all other types.
To view power totals

1 In the Electrical workspace, click Analyze tab ➤ Electrical panel ➤ Power Totals  

2 Select the devices for which to view a total, and press Enter.

NOTE Alternatively, you can select a device and click Device tab ➤ Circuits panel ➤ Power Totals  

---

Modifying Electrical Systems

You can modify all aspects of your electrical system designs.

Modifying Circuits

As you change and refine the electrical system design, you might need to adjust the organization of the circuits. Use the Circuit Manager to view how circuits are organized, move circuits between panels, delete circuits that are no longer being used, and resize wires in a circuit. You can also edit some circuit properties, but you cannot edit others, such as the circuit length, without making changes to the actual electrical design.

The Circuit Manager is the only place where you can access circuit objects to make changes. Because circuits are non-graphical elements, nothing changes visually in your drawing when you make circuit changes. However, by accessing circuit information about an electrical component or generating a circuit report about a selection of components, you can see the effects of the changes you have made.
NOTE If you are using an electrical project database, you cannot edit circuits from any linked drawing. To modify circuits, open the electrical project database file and modify them using the Circuit Manager. Save and close the electrical project database file before continuing work on any linked drawings. If circuit modifications affect any linked drawings, you are prompted to open and save them in order to update them with the most current electrical project database information.

Moving Circuits to Manage Demand Load

When you view circuits in the Circuit Manager and see that the load is too high on a panel, move one or more of its circuits to a different panel. All of the information about the circuit and its device connections moves with the circuit to the new panel.

Unless you have used wire to represent the circuit, you can make this move without physically changing anything in your drawing. If you are using an electrical project database, you are prompted to open and save any linked drawings that are affected by the modifications.

To move circuits between panels

1. In the Electrical workspace, select a panel and click Panel tab ➤ Circuits panel ➤ Circuit Manager.
2. In the Circuit Manager, in the expanded panel tree view in the left pane, click the circuit to be moved and drag it onto a different panel.

You can now see the voltage and load information change in the Circuit Manager.

NOTE Anytime you modify circuits, you will need to update any existing panel schedules. See Updating Panel Schedules on page 693

Modifying Circuit Properties

Use the Circuit Manager to change the property information of circuits. You can edit some circuit properties only if there are no devices connected to the circuit.

After you assign one or more devices to a circuit, you can edit only a few of the circuit properties.
Depending on the system type, you can modify the following circuit properties:

- Name
- Description
- System
- Rating (Power and Lighting only)
- Voltage (Power and Lighting only)

**NOTE** Anytime you modify circuit properties, you will need to update any existing panel schedules. See Updating Panel Schedules on page 693.

The Load Category is a style that you can modify using the Style Manager. For more information, see Creating Load Category Definitions on page 536.

**To modify circuit properties**

1. In the Electrical workspace, and click Analyze tab ➤ Electrical panel ➤ Circuit Manager.
2. In the left pane of the Circuit Manager, select the circuit to be modified.
   
   If you want to edit the properties of multiple circuits, select the branch in the left pane that contains the circuits. On the right pane, use `SHIFT` or `CTRL` to select multiple rows in the circuit list view.
3. In the list view in the right pane, double-click the circuit property to be modified.
4. Enter the new information, or select a new property from the list.

**Deleting Circuits**

Use the Circuit Manager to delete circuits. If you delete a circuit that is not attached to any devices, the circuit is deleted without warning. If the circuit is attached to devices, you are prompted to confirm the deletion.

**To delete circuits**

1. In the Electrical workspace, click Analyze tab ➤ Electrical panel ➤ Circuit Manager.
2 In the Circuit Manager, do one of the following:

<table>
<thead>
<tr>
<th>If you want to delete...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>a single circuit</td>
<td>select the circuit in the left pane in the tree view.</td>
</tr>
<tr>
<td>multiple circuits</td>
<td>select the system type in the left pane, and use SHIFT or CTRL to highlight and select the circuits in the right pane.</td>
</tr>
</tbody>
</table>

3 Click (Delete circuit).

NOTE When you delete a circuit, be sure to use the Update Panel Schedule command to update any panel schedules associated with that circuit to remove its data from the schedule.

Modifying Devices and Panels

You can move the devices and panels in a drawing, and you can modify their properties.

If you are using an electrical project database, and you modify the properties of panels in the electrical project database, you must save and close the electrical project database before working on linked drawings.

Moving a Device or Panel

You can move devices and panels using Alignment grips ( ). Unlike the AutoCAD MOVE command, you can optionally use the grips to align the device or panel perpendicular to the object to which you snap, such as a wall.

By default, Alignment grips are displayed at the electrical connector points on devices and panels. However, you can toggle on additional grips by clicking the Show all insertion points grip. The additional grips are located at the justification points available when adding devices and panels, for example,
Top Left, Bottom Center, and Insertion Point. In the following image, one receptacle displays the default Alignment grip. The other also displays the additional grips.

**NOTE** When you move multiple devices or panels at the same time using Alignment grips, you must select a base grip on one device or panel (the base device or base panel) for the move action. If you align the base device or base panel to an object, the other devices in the selection set inherit the same angle of rotation. They also maintain their position relative to the base device or base panel.

**To move a device or panel**

1. Select the device or panel.
2. Select the Alignment grip to use to move the device or panel:
   - **If you want to move the device or panel relative to**
   - **Then...**
     - its electrical connector point
     - another point on the device or panel
     - select the default grip.
     - click the Show all insertion points grip, and select the grip.

**NOTE** To move multiple devices or panels at the same time, while pressing Shift, select the same Alignment grip on each of the devices or panels to create the selection set. Then, on one device or panel, reselect the grip to use it as the base grip.
3 Specify how you want to align the device or panel:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>Then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>snap to an object using object snaps and have the</td>
<td>proceed to the next step. When you select an Alignment grip, this</td>
</tr>
<tr>
<td>software align the device or panel perpendicular to</td>
<td>behavior is active by default.</td>
</tr>
<tr>
<td>the object</td>
<td></td>
</tr>
<tr>
<td>place the device or panel using its current angle</td>
<td>press Ctrl. This toggles off the alignment behavior, but you can still</td>
</tr>
<tr>
<td>of rotation</td>
<td>snap to an object.</td>
</tr>
</tbody>
</table>

**NOTE** The software can align the device or panel perpendicular to a wall, ceiling grid, space boundary, line, polyline, spline, arc, or circle in the current drawing or in a referenced drawing (xref).

4 Move the device or panel:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>Then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>use the base grip point as the base point for the</td>
<td>specify the second point (the insertion point) by doing one of the</td>
</tr>
<tr>
<td>move</td>
<td>following:</td>
</tr>
<tr>
<td>specify a base point and then a second point</td>
<td>- specify a point in the drawing.</td>
</tr>
<tr>
<td></td>
<td>For example, you can snap to a point on a wall.</td>
</tr>
<tr>
<td></td>
<td>- enter the coordinates, and press Enter.</td>
</tr>
<tr>
<td></td>
<td>enter b (base point), specify the base point, and then specify the</td>
</tr>
<tr>
<td></td>
<td>second point.</td>
</tr>
</tbody>
</table>

**NOTE** If you have difficulty snapping and aligning to an object, zoom to the area, or modify the size of the AutoSnap aperture as needed. The aperture size determines how close to a snap point you can be before the magnet locks the aperture box to the snap point. You can modify the size on the Drafting tab of the Options dialog. For more information, see Drafting Tab (Options Dialog Box).
5 Press Esc.

**Example: Moving a Device**

In the following example, a telephone outlet is moved from one wall to another.

![Diagram of a telephone outlet being moved](image)

**Example: Moving a Panel**

In the following example, a recessed panel is moved from one wall to another.
Modifying Device Properties

You modify the properties of devices using the Properties palette. For general information about modifying object properties using the palette, see Modifying Object Properties Using the Properties Palette on page 136.
NOTE For information about moving devices, see Moving a Device or Panel on page 648.

To modify device properties

1 Select the devices:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>manually select the devices in the drawing</td>
<td>select one or more devices individually, or select multiple devices at the same time by creating a window selection, crossing selection, or selection fence. For more information, see Select Multiple Objects.</td>
</tr>
</tbody>
</table>

- Start Circuit Manager.
- In the left pane, select the circuits, and in the right pane, click .
- Press Esc twice.
- Enter deviceprops, enter p (previous), and press Enter.

- Enter deviceprops, enter p (previous), and press Enter.

- While pressing Ctrl, press A to select all of the objects in the drawing. Then enter a modify command:
  - ReceptacleModify - Receptacles
  - LightingModify - Lights
  - SwitchModify - Switches
  - JunctionBoxModify - Junction Boxes
  - CommunicationModify - Communication
  - FireSafetyModify - Fire Safety
  - OtherPowerModify - Other power, i.e., motors
  - SecurityModify - Security
2 If you want to replace the selected devices with those of a different style, on the Properties palette, select a device style:

<table>
<thead>
<tr>
<th>If you want to select a style...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>in the current drawing</td>
<td>expand Basic, expand General, and for Style, select the style.</td>
</tr>
<tr>
<td>in a drawing in the directory specified as the default content location for electrical devices</td>
<td>on the General bar, click (\text{..}). In the left pane of the Select Device worksheet, navigate to the drawing that contains the style, and select the drawing. In the right pane, select the style.</td>
</tr>
</tbody>
</table>

**WARNING** Use caution when replacing devices after you have attached wires. If the replacement devices have different connection points than the original devices, the wires do not connect properly, and the circuit is broken. Additionally, if the replacement devices have default values for connector properties (for example, for Voltage or for Number of poles), you might need to modify the values.

3 On the Properties palette, modify other general properties as needed:

<table>
<thead>
<tr>
<th>If you want to change...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the description</td>
<td>for Description, click (\text{..}), enter a description, and click OK.</td>
</tr>
<tr>
<td>the layer on which the devices are placed</td>
<td>for Layer, select a different layer. You can select from the layers in the current drawing.</td>
</tr>
</tbody>
</table>

4 Expand Location, and modify the location properties as needed:

<table>
<thead>
<tr>
<th>If you want to change...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the rotation</td>
<td>for Rotation, enter a new angle.</td>
</tr>
</tbody>
</table>

**NOTE** You can also use Alignment grips to align the device perpendicular to other floor plan geometry, such as a wall.
<table>
<thead>
<tr>
<th>If you want to change...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the elevation</td>
<td>For Preset elevation, select a defined elevation, or for Elevation, enter an elevation. The difference in the elevation of the devices, the wires, and the panel for a circuit is used to calculate the circuit length. Note that the circuit length can only be calculated if the panel and all of the devices on the circuit are in the current drawing.</td>
</tr>
<tr>
<td>the insertion point or normal. (The normal is the extrusion direction that is used when elevation is applied to the model view.)</td>
<td>click Additional information. On the Location worksheet, enter the coordinates for the insertion point or normal, and click OK. &lt;br&gt;&lt;br&gt;<strong>NOTE</strong> When possible, use Alignment grips to move a device. The grips move connected wires accordingly. Although using the Location worksheet does not break the connection between a device and connected wires, you might need to redraw the wires.</td>
</tr>
</tbody>
</table>

5 Expand Advanced, and modify the advanced properties as needed:<br>**If you want to change...** then...<br>the system expand System, and for System, select the system.<br><br>**NOTE** The system assigned to the device determines its display properties. The system assigned to an electrical connector on the device determines the connections that can be made to the connector. For more information about connectors, see Configuring the Electrical Connectors of a Device on page 583.
If you want to change... then...

the device ID, which is an optional number expand Design Data, and for ID, enter a new ID.

the properties of an electrical connector expand Circuits, and click 📊 Electrical Properties. On the Electrical Properties worksheet, modify the electrical connectors as explained in Modifying the Electrical Connectors of a Device on page 656, and click OK.

6 Press Esc.

**NOTE** Anytime you modify devices, you will need to update any existing panel schedules. See Updating Panel Schedules on page 693

## Modifying the Electrical Connectors of a Device

**NOTE** You should be familiar with Configuring the Electrical Connectors of a Device on page 583 before using the procedure described under this topic.

You modify the electrical connectors of a device using the Electrical Properties worksheet.
When modifying a connector, keep in mind the following:

- If a circuit is specified for the connector, the System value is not editable. If the system type of the connector is Power and Lighting, then the values for Voltage and for Number of poles are also uneditable. This prevents changes that do not agree with the selected circuit. You can make these properties editable by selecting Unassigned for Circuit.

- If a circuit is not specified for the connector, and a property is still not editable, this is because the device style does not allow the override of the value specified in the style. For information about allowing and preventing style overrides, see Configuring Connectors for Device Styles on page 542.

- When you assign or change the circuit of a connector, or when you modify the load or load category of the connector, the affected circuits are updated accordingly and evaluated for overloads. In the circuiting preferences, you can specify whether the software warns you of the overloads, so you can decide whether to proceed or cancel the action. If you overload a circuit, you are not notified of the overload again within the drawing session.
When modifying the connectors on multiple selected devices, also keep in the mind the following:

- If you overload a circuit when you are modifying devices assigned to different circuits, you are still notified of the overload as described above. However, you must use the Circuit Manager to identify the overloaded circuit.

- If a property is not editable for at least one of the selected devices, it is read-only.

- The electrical connectors on all the selected devices are listed by number. If a connector of a given number has a different system type for at least one of the devices, *VARIES* is shown for System Type, and only the properties in common are shown.

- *VARIES* is also shown for any other property that does not have the same value for all of the selected devices.

- **Power and Lighting connectors only:** *VARIES* is also shown for properties with values that are retrieved from different sources (for example, style override versus By Circuit). Additionally, when the value is By Circuit for all of the selected devices, *VARIES* is shown if the selected connector on all of the devices is not assigned to the same circuit. Refer to the following table for example scenarios.

<table>
<thead>
<tr>
<th>Value for connector on device 1</th>
<th>Value for connector on device 2</th>
<th>Value displayed in worksheet</th>
</tr>
</thead>
<tbody>
<tr>
<td>value is the style default</td>
<td>&lt;By Circuit&gt;[same value as for device 1]</td>
<td><em>VARIES</em></td>
</tr>
<tr>
<td>value is a style override</td>
<td>&lt;By Circuit&gt;[same value as for device 1]</td>
<td><em>VARIES</em></td>
</tr>
<tr>
<td>&lt;By Circuit&gt;</td>
<td>&lt;By Circuit&gt;</td>
<td>&lt;By Circuit&gt;</td>
</tr>
<tr>
<td>&lt;By Circuit&gt;[value from assigned circuit]</td>
<td>&lt;By Circuit&gt;</td>
<td>&lt;By Circuit&gt; [<em>VARIES</em>]</td>
</tr>
<tr>
<td>&lt;By Circuit&gt;[value from circuit 1]</td>
<td>&lt;By Circuit&gt;[value from circuit 1]</td>
<td>&lt;By Circuit&gt;[value from circuit 1]</td>
</tr>
<tr>
<td>&lt;By Circuit&gt;[value from circuit 1]</td>
<td>&lt;By Circuit&gt;[value from circuit 2]</td>
<td>&lt;By Circuit&gt; [<em>VARIES</em>]</td>
</tr>
</tbody>
</table>
To modify the electrical connectors of devices

1. Select the devices, and click Device tab ➤ Circuits panel ➤ Circuit Properties ➤ .

2. On the Electrical Properties worksheet, select a connector.

Optionally assign the connector to a circuit

3. If necessary, you can filter the list of available circuits by selecting a panel for Show circuits from panel, and by specifying values for the connector properties.

   The selections available for Circuit include the circuits in the current drawing, and, if specified for the current drawing, in the electrical project database that match the values you have specified for the connector properties, and that have a system type of General. If the system type of the selected connector on all of the devices is the same, the selections also include the circuits that have that system type (Power and Lighting, or Other). However, if the system type of the connector varies across the selected devices, the selections are limited according to their values.

   Beside each circuit name, the current load on the circuit is displayed. The load is the total load on the circuit across all applicable drawings, including the electrical project database.

4. For Circuit, do one of the following:
   - Select a circuit to assign the selected connector on all of the devices to it.
   - Select Unassigned to remove any circuit assignments from the devices.

   **NOTE** Once a circuit is selected, the System value is not editable. If the system type of the connector is Power and Lighting, then the values for Voltage and for Number of poles are also uneditable. This prevents changes that do not agree with the selected circuit.

Specify the connector properties

5. Under Value, specify values for the connector properties.

   For descriptions of each property, see Configuring the Electrical Connectors of a Device on page 583.

   If you are using the electrical project database, and have more than one drawing open, you can reload the electrical project database in each open
drawing. This updates the circuit information for each drawing. For example, if you modify a device load, or change the circuit assignment for the device, you can reload the electrical project database in other open drawings to reflect these changes.

Modifying Panel Properties

You modify the properties of panels using the Properties palette. For general information about modifying object properties using the palette, see Modifying Object Properties Using the Properties Palette on page 136.

NOTE For information about moving panels, see Moving a Device or Panel on page 648.

To modify panel properties

1. Select the panels.
2. If you want to replace the panels with those of a different style, on the Properties palette, select a panel style by doing one of the following:

<table>
<thead>
<tr>
<th>If you want to select a style...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>in the current drawing</td>
<td>on the Properties palette, expand Basic, expand General, and for Style, select the style.</td>
</tr>
<tr>
<td>in a drawing in the directory specified as the default content location for electrical panels</td>
<td>on the General bar, click . In the left pane of the Select Panel worksheet, navigate to the drawing that contains the style, and select the drawing. In the right pane, select the style.</td>
</tr>
</tbody>
</table>

3. Modify other general properties as needed:

<table>
<thead>
<tr>
<th>If you want to change...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the description</td>
<td>for Description, click , enter a description, and click OK.</td>
</tr>
<tr>
<td>the layer on which the panels are placed</td>
<td>for Layer, select a different layer. You can select from the layers in the current drawing.</td>
</tr>
</tbody>
</table>
4 Expand Location, and modify the location properties as needed:

<table>
<thead>
<tr>
<th>If you want to change...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the rotation</td>
<td>for Rotation, enter a new angle.</td>
</tr>
</tbody>
</table>

**NOTE** You can also use Alignment grips to align the panel perpendicular to other floor plan geometry, such as a wall.

<table>
<thead>
<tr>
<th>the elevation</th>
<th>for Preset elevation, select a defined elevation, or for Elevation, enter an elevation. The difference in the elevation of the devices, the wires, and the panel for a circuit is used to calculate the circuit length. Note that the circuit length can only be calculated if the panel and all of the devices on the circuit are in the current drawing.</th>
</tr>
</thead>
</table>

| the insertion point or normal. (The normal is the extrusion direction that is used when elevation is applied to the model view.) | click Additional information. On the Location worksheet, enter the coordinates for the insertion point or normal, and click OK. **NOTE** You can also use Alignment grips to move the panel. |

5 If necessary, expand Advanced, expand System, and for System, select a new system.

6 Expand Design Data, and modify the design data properties as needed:

<table>
<thead>
<tr>
<th>If you want to change...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the panel name</td>
<td>for Name, enter a unique name.</td>
</tr>
<tr>
<td>the panel rating</td>
<td>for Rating, enter a new rating.</td>
</tr>
</tbody>
</table>
If you want to change... then...

<table>
<thead>
<tr>
<th>the number of slots</th>
<th>for Slots, enter a new number.</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOTE</td>
<td>Do not assign more circuits to a panel than allowed for by the number of slots. If a panel has more circuits than slots, some of the circuits cannot be included in the panel schedule. When you create a schedule, the software warns you if this situation exists.</td>
</tr>
<tr>
<td>the voltage</td>
<td>for Voltage, enter a new voltage.</td>
</tr>
<tr>
<td>the phase</td>
<td>for Phases, select 1 or 3.</td>
</tr>
<tr>
<td>NOTE</td>
<td>The rating and voltage of a panel do not affect how the software functions. However, they are made available as automatic properties.</td>
</tr>
</tbody>
</table>

7 Press Esc.

NOTE Anytime you modify panels, you will need to update any existing panel schedules. See Updating Panel Schedules on page 693

If you are using this drawing as an electrical project database, and you modify properties for a panel whose circuits are used in linked drawings, you are prompted to open and save the affected drawings when you save the electrical project database.

**Modifying Wires**

After **drawing or generating wires**, you might need to make changes to the layout or to the wire properties.
Modifying Wire Layouts

You can modify the layout of wires by moving their vertices using Location grips. This can be helpful when you want to clean up the layout by moving the wires around walls, equipment, or other floor plan geometry.

To maintain the connectivity of a circuit, wires are anchored to devices. As a result, you cannot move the wires using the grips at their endpoints. Instead, when you move a device, the connected wires stretch accordingly.

To modify the layout of a wire

1. Select the wire.
2. Click the Location grip at a wire vertex.
3. Move the grip to a new location, and click to specify the point.
4. Press Esc.
Modifying Wire Properties

You modify the properties of wires using the Properties palette. For general information about modifying object properties using the palette, see Modifying Object Properties Using the Properties Palette on page 136.

NOTE For information about moving wires, see Modifying Wire Layouts on page 663.
To modify wire properties

1 Select the wires.

**NOTE** Before you can calculate wire sizes, you must add wire to the devices in the circuit. You must also set the type of conductor material for the wire style used, for example, copper or aluminium (for more information, see Configuring Styles for Wires on page 549).

2 On the Properties palette, expand Basic, and modify the basic properties as needed:

<table>
<thead>
<tr>
<th>If you want to change…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>the description</td>
<td>expand General. For Description, click [    ], enter a description, and click OK.</td>
</tr>
<tr>
<td>the layer on which the wires are placed</td>
<td>expand General, and for Layer, select a different layer. You can select from the layers in the current drawing.</td>
</tr>
<tr>
<td>the wire style</td>
<td>expand General, and for Style, select the style. You can select from the wire styles defined in the current drawing.</td>
</tr>
</tbody>
</table>
| the elevation          | expand Location, and do one of the following:  
  - For Preset elevation, select a defined elevation.  
  - For Elevation, enter an elevation.  
  The difference in the elevation of the devices, the wires, and the panel for a circuit is used to calculate the circuit length. Note that the circuit length can only be calculated if the panel and all of the devices on the circuit are in the current drawing. |

3 Expand Advanced, and modify the advanced properties as needed:
IMPORTANT To use the instant sizing tool to calculate the wire sizes, all of the selected wires must have:

- An assigned circuit whose system type is Power and Lighting
- The same wire style

If you want to change… then...

<table>
<thead>
<tr>
<th>the system</th>
<th>expand System, and for System, select the system.</th>
</tr>
</thead>
<tbody>
<tr>
<td>the wire sizes</td>
<td>expand Dimensions, and specify the wire sizes by doing one of the following:</td>
</tr>
<tr>
<td></td>
<td>On the Dimensions bar, click ( \text{ tool} ) to have the instant sizing tool calculate the sizes. The tool calculates the sizes based on the material and temperature rating of the corresponding wire style; the rating of the specified Power and Lighting circuit; and the ambient temperature specified in the drawing.</td>
</tr>
<tr>
<td></td>
<td>Select or enter wire sizes for the hot, neutral, ground, and isolated ground wires.</td>
</tr>
<tr>
<td>The wires for which you need to specify sizes depend on the design specifications of the selected wire style.</td>
<td></td>
</tr>
</tbody>
</table>

4 Press Esc.

TIP You can add labels to wires to indicate circuit assignments or wire styles. For more information, see Labels on page 832.

**Moving Tick Marks on Wires**

1 Select the wire.
2 Click the Location grip for the tick marks.
3 Move the grip to a new location along the wire, and click to specify the point.
4 Press Esc.

**NOTE** You specify whether to display tick marks on wire segments and home runs in the annotation properties of wire styles.

### Flipping Tick Marks on Wires

1. Select the wire.
2. Click a Flip grip to flip the tick marks in the direction indicated by the arrow.
3. Press Esc.
NOTE You specify whether to display tick marks on wire segments and home runs in the annotation properties of wire styles.

Modifying Electrical Equipment

After you have finished the electrical system layout and checked the calculations for the final design, typically you verify the electrical equipment in the drawing and, if necessary, add or modify equipment. You might also need to do so during the design process due to changes in the requirements.

Changes to equipment might require changes to the associated circuit. For information about modifying circuits, see Modifying Circuits on page 645.

RELATED See Mechanical, Electrical, and Plumbing Equipment in Building Systems on page 110.

To modify electrical equipment

1. Select the MvPart to modify, and click Equipment tab ➤ Modify panel ➤ Modify Equipment.
2. In the Multi-view Part Modify dialog, on the Part tab, under All Installed MvParts, specify a part. Expand subfolders as needed.
3. Specify a part size for Part Size Name.

   NOTE The part size name list displays the available part sizes in the range of the current part. If the part size is not available, proceed to the next step to specify filters and ranges.

4. On the Part Filter tab, under Connections, for Nominal Connection, select a size range (such as in this format: 4-72). To filter the number of sizes available for viewing, for Display, enter a number within the allowable range.

   Shows Display filter

   ![Display filter]

5. Under the part graphic, click or to step through the available part size names in the selected range. Select a size for Part Size Name.
6 Specify an elevation.

NOTE When changing the elevation for an MvPart that is connected to other objects, the objects remain connected and are placed at the new elevation.

Modifying Cable Trays and Conduits

Typically, cable tray and conduit runs are modified frequently during the design process due to architectural or structural changes, or modifications to the system requirements. For example, if the architect increases the overall size of the building, the cable tray layout needs to be modified to accommodate the new size. Cable tray sizes might increase, additional conduits might be added, or you might need to re-route the wiring for the new building size. You might also need to modify fittings, particularly when branches are resized or devices connected to conduit are changed.

Modifying cable tray segments and fittings

Modifying the Layout of a Cable Tray or Conduit Run

1 Select the segment that you want to change.
Do one of the following:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>move cable tray or conduit</td>
<td>Click Home tab ➤ Modify panel ➤ Move ➤ . Specify the distance and direction by specifying a base point (1), and then specifying the second point (2) where to move the object (3). Shows movement of MEP object</td>
</tr>
<tr>
<td>copy and paste cable tray or conduit</td>
<td>Click Cable Tray tab or Conduit tab ➤ General panel ➤ Add Selected ➤ . Specify the distance and direction by specifying a start point and then a second point.</td>
</tr>
</tbody>
</table>

**TIP** You can also move the object by clicking the Location grip.

**RELATED** For more information, see Move Objects or Copy Objects.

### Changing the System of a Cable Tray or Conduit Run

Systems are defined to make it easier to comply with project standards in all drawings within a project. You can modify the system designation of individual connection points. For more information, see Working with Systems on page 138.

**To change the system of a cable tray or conduit run**

1. Select the segment you want to modify.
2 Specify a different system as follows:

■ For cable tray, click Cable Tray tab ➤ Modify panel ➤ Modify Cable Tray. Specify a system in the Modify Cable tray dialog.

■ For conduit, on the Properties palette on page 528, under General, specify a system from the list.

Changing the Elevation of a Cable Tray or Conduit Run

1 Select the segment you want to modify.
2 Specify a defined elevation or enter a new value in the following locations:

■ For cable tray, click Cable Tray tab ➤ Modify panel ➤ Modify Cable Tray in the Modify Cable tray dialog

■ For conduit, on the Properties palette on page 528, under Placement

You can also modify conduit location coordinates, elevation values, and connection types for all conduit connectors.
Expand Advanced, and click (Connection details on page 172) to open the Connection Details worksheet.

To manage changes to cable tray or conduit when elevation changes

3 Check your cable tray or conduit run to find out if you need to add more segments or change the elevation of other segments in order to reconnect the run.

4 Optionally connect segments by adding transitions or bends and additional cable tray or conduit segments.

Connecting cable tray segments at different elevations

- to a cable tray run, select the segment you want to modify.
- Specify dimensions as follows:
  - For cable tray, click Cable Tray tab ➤ Modify panel ➤ Modify Cable Tray ➔, and specify values for width and height.
  - For conduit, on the Properties palette on page 528, under Dimensions, for Nominal size, select from the list or enter a value.

Modifying the Size of a Cable Tray or Conduit Run

Use this procedure to change the size of a cable tray or conduit run. You can change one segment at a time or you can resize the entire run. When changing a single segment, you need to add a transition in order to adjust it to the rest of the run.

1 Select the segment you want to modify.

2 Specify dimensions as follows:

- For cable tray, click Cable Tray tab ➤ Modify panel ➤ Modify Cable Tray ➔, and specify values for width and height.

- For conduit, on the Properties palette on page 528, under Dimensions, for Nominal size, select from the list or enter a value.
TIP If the size is not in the conduit routing preferences on page 526, you are prompted to make a part substitution on page 447.

3 In the Maintain Connection dialog, specify a method for maintaining a valid connection between the segment and the rest of the run:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then select…</th>
</tr>
</thead>
<tbody>
<tr>
<td>modify the entire run to match the parameters of the selected segment</td>
<td>Modify to next junction/transition.</td>
</tr>
<tr>
<td>insert a transition fitting to connect the cable tray or conduit without changing the entire run</td>
<td>Modify to maintain connection to next part.</td>
</tr>
</tbody>
</table>

If you have chosen to modify an entire run that is connected to another run, the junction fitting that connects the 2 runs is replaced. The software inserts an appropriate transition fitting in its place to maintain a valid connection at that junction.

### Modifying the Length of Cable Tray or Conduit Segments

You can modify the length of cable tray and conduit segments using Lengthen grips ( ). Because the grips constrain a segment to its current angle, they are particularly useful for modifying the lengths of runs you have already placed.

When you use the Lengthen grip on an end connected to another object, you must specify whether you want AutoCAD MEP to maintain connectivity between the objects when you modify the length.
To modify the length of a cable tray or conduit segment

1 Select the segment.
2 Select the Lengthen grip on the end you want to modify.
3 If the segment is connected to an object on the end you selected, specify whether and how to maintain connectivity:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>maintain connectivity by adjusting only fittings and segments, and retain the current locations of parts</td>
<td>proceed to the next step.</td>
</tr>
<tr>
<td>maintain connectivity by adjusting all objects, including parts</td>
<td>press Ctrl.</td>
</tr>
<tr>
<td>break connectivity</td>
<td>press Ctrl twice.</td>
</tr>
</tbody>
</table>

4 Specify the segment length:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify the new total length</td>
<td>press Tab to activate the input field for specifying the resulting dimen-</td>
</tr>
<tr>
<td>If you want to...</td>
<td>then...</td>
</tr>
<tr>
<td>------------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td>sion, and enter the new length. Press Enter.</td>
</tr>
<tr>
<td>specify the difference between the current length and new length</td>
<td>Drag the cursor to begin lengthening or shortening the segment, and enter the change in length in the input field that is active by default. Press Enter.</td>
</tr>
<tr>
<td>specify a new endpoint</td>
<td>drag the grip to the endpoint, and click to specify the point.</td>
</tr>
</tbody>
</table>

**NOTE** To use the dimension input fields, both dynamic input (on the application status bar) and the Dimension Input drafting setting must be enabled. They are enabled by default. If you have disabled them, you can specify the new length by selecting a stretch point in the drawing or entering one in the command window.

The following example illustrates how to modify the length of a conduit segment. A horizontal conduit segment is stretched to the right. Because the modification occurs in the moveable MvParts editing mode, connected objects including parts are adjusted to maintain their connectivity. More specifically, the vertical conduit, connected fittings, and the transformer are moved.
Lengthening conduit

select segment

select Lengthen grip, then select editing mode

Chapter 9  Drawing Electrical Systems
NOTE If the cable tray or conduit segment is not connected to another object, you can change both its length and angle using the Start or End grip.

Start and End grips enable you to change the XYZ location of the start point or endpoint of a segment. They are particularly useful when initially designing runs because you can use them to easily connect a segment to an existing run.

Breaking and Merging Cable Tray or Conduit Segments

After you have drafted cable tray or conduit runs, you can break an individual segment, break an entire run, or merge multiple segments. This can be helpful for determining the number of individual segments a manufacturer needs to supply.
When merging segments, you cannot cross fittings to join segments.

**Breaking a conduit into segments**

To break or merge cable tray or conduit

1. Select the cable tray or conduit, and do one of the following to open the dialog:
   - Click Cable Tray tab ➤ Modify panel ➤ Cable Tray Length
   - Click Conduit tab ➤ Modify panel ➤ Conduit Length

**Cable Tray Length dialog**

2. Specify how you want to break or merge the cable tray or conduit:
   - **If you want to**... then...
     - apply the length to the entire run
       - select Apply to Cable Tray Run or Apply to Conduit Run.
     - specify a new segment length
       - select Break.
     - merge segments
       - select Merge.
     - select a cable tray or conduit
       - click (Select Objects), and select specific segments.
If you want to… | then…
---|---
change the length | enter or select a new length for each cut length. The 10 last-used lengths are stored as defined segment lengths. You can also specify the length by specifying points in the drawing.

If you have selected to break segments, the software breaks the selected segment or runs into multiple segments of the specified length. If the segment cannot be broken evenly by the specified length, the last broken segment might be shorter.

### Modifying a Cable Tray or Conduit Fitting

1. Select a fitting.
2. Depending on the selection:
   - For cable tray: click Cable Tray Fitting tab ➤ Modify panel ➤ Modify Fitting to open the Modify Cable Tray Fitting dialog.
   - For conduit: On the Properties palette on page 528, under General, click the part image to open the Select a Part dialog.
3. Select Display/Hide additional part parameters to display or hide more information in this dialog.

**TIP** For cable tray, click Details first to see this option.
4 Modify the fitting:

<table>
<thead>
<tr>
<th>If you want to modify...</th>
<th>then for cable tray...</th>
<th>then for conduit...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the part subtype</td>
<td>select a different subtype in the part type folder.</td>
<td>specify a part from the catalog.</td>
</tr>
</tbody>
</table>

**NOTE** While you can change the part subtype, you cannot change the part type, for example, replace an elbow with a tee.

- parameters, such as connection size or type: click the Part Filter tab, and specify the parameters you want to filter from the list of available part sizes. Then select the part you want for Part Size Name.
- the size: select a size for Part Size Name, and then select a part from the Part Size Name list.
- under Select Part Size, specify a part size.
- under Filter by Dimensions, specify the dimensions to filter.

**Rotating Cable Tray or Conduit Fittings**

You can use arrow-shaped ( ) Rotate grips to rotate cable tray and conduit fittings 180 or 90 degrees in the direction indicated by the grip.
Rotating a cable tray fitting 180 degrees in plan view

In isometric views, you can also use diamond-shaped ( ) Rotate grips to rotate conduit fittings around the centerline to any angle.

A conduit tee fitting in an isometric view

AutoCAD MEP displays Rotate grips on cable tray and conduit fittings with connectors on opposite ends. However, when necessary to preserve the connectivity of runs, the software limits the available rotation options or hides the grips. For example, in the following illustration, you can rotate the unconnected conduit fitting on the left in several ways, but you cannot rotate the conduit fitting on the right due to the connected conduit segments.
A conduit fitting with Rotate grips and another without them

When you rotate a fitting that is connected to other objects, the software adjusts the connected objects to maintain their connectivity. For example, the software might make minor adjustments to the lengths of connected segments after you have flipped a fitting. If it cannot adjust the objects, it disconnects them.

**To rotate a cable tray or conduit fitting**

1. Select the fitting.
2. Rotate the fitting:
   - **If you want to...**
     - **then...**
   - rotate the fitting 180 degrees (flip the fitting)
     - click the Rotate grip ( ).
   - rotate the fitting 90 degrees
     - while pressing Ctrl, click the Rotate grip ( ).
   - rotate the fitting to an angle you specify
     - click the Rotate grip ( ), and do one of the following:
       - enter the new absolute angle in the active dimension input field.
       - drag the cursor to reduce or increase the angle, click Tab to activate the dimension input field for specifying the angle change, and enter the value.
       - drag the grip to a new location.
       - enter a value for Rotation on the Location tab of Fitting Properties
       - enter the value in the command window.
Annotating Electrical System Drawings

The topics in this section describe how to create and modify panel schedules for your electrical drawings. For information about annotating the drawings using other elements, such as labels, tags, and documentation symbols, see Creating Construction Documents on page 813.

Adding Labels to Wire, Conduit, and Cable Tray

You can manually add labels to wires, conduits, and cable trays. For more information, see Labels on page 832. You can also configure layout preferences to add labels automatically to cable tray and conduit as you draw them. For more information, see Specifying Annotation for Cable Tray on page 557.

About Panel Schedules

In AutoCAD MEP, you use the default panel schedule table styles to create the following types of panel schedules:

- Sample 1-phase branch circuit panel schedule

![Sample 1-phase branch circuit panel schedule](image-url)
### Sample 3-phase branch circuit panel schedule

<table>
<thead>
<tr>
<th>HSN</th>
<th>Description</th>
<th>Phase</th>
<th>Circuit</th>
<th>Circuit Code</th>
<th>Type</th>
<th>Load</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>43</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>44</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>46</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>49</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>51</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>52</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>53</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>54</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>56</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>57</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>58</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>59</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>61</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>62</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>63</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>64</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>66</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>67</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>68</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>69</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>71</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>72</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>73</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>74</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>76</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>77</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>78</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>79</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>80</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>81</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>82</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>83</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>84</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>85</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>86</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>87</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>88</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>89</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>91</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>92</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>93</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>94</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>95</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>96</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>97</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>98</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>99</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Notes:**

- [ ] Sample 3-phase branch circuit panel schedule

---

684 | Chapter 9  Drawing Electrical Systems
### Sample switchboard panel schedule

#### SWITCHBOARD LF2

<table>
<thead>
<tr>
<th>Ext No.</th>
<th>Term</th>
<th>Device</th>
<th>Acceptance</th>
<th>R/W</th>
<th>W/R</th>
<th>W/E</th>
<th>W/R Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.5</td>
<td>20/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>7.8</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>6.19</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>11</td>
<td>22/1</td>
<td>Switch</td>
<td>1152</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>12</td>
<td>22/1</td>
<td>Switch</td>
<td>345</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>13</td>
<td>22/1</td>
<td>Switch</td>
<td>1152</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>14</td>
<td>22/1</td>
<td>Switch</td>
<td>1152</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>15</td>
<td>22/1</td>
<td>Switch</td>
<td>1152</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>16</td>
<td>22/1</td>
<td>Switch</td>
<td>1152</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>17</td>
<td>22/1</td>
<td>Switch</td>
<td>1152</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>18</td>
<td>22/1</td>
<td>Switch</td>
<td>1152</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>19</td>
<td>22/1</td>
<td>Switch</td>
<td>1152</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>20</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>21</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>22</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>23</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>24</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>25</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>26</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>27</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>28</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>29</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>30</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>31</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>32</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>33</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>34</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>35</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>36</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>37</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>38</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>39</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>40</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>41</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>42</td>
<td>22/1</td>
<td>Switch</td>
<td>0</td>
<td>202</td>
<td>30</td>
<td>15</td>
<td>0</td>
</tr>
</tbody>
</table>

#### Load Category

<table>
<thead>
<tr>
<th>Load Category</th>
<th>Connected Load (kW)</th>
<th>Bidirectional kW</th>
<th>Connected Load (kA)</th>
<th>Bidirectional kW</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lighting</td>
<td>7.8</td>
<td>1.5</td>
<td>9.9</td>
<td>1.5</td>
</tr>
<tr>
<td>Total, Electrical Power</td>
<td>23.0</td>
<td>11.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stator Cooling</td>
<td>23.9</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

About Panel Schedules | 685
## Sample distribution panel schedule

<table>
<thead>
<tr>
<th>Panel Number</th>
<th>Transformer</th>
<th>Service Rated</th>
<th>Demand Load</th>
<th>KVA</th>
<th>KVAR</th>
<th>Power Factor</th>
<th>Apparent Load</th>
<th>KVA</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>1000 kVA</td>
<td>750 kVA</td>
<td>125 kVA</td>
<td>125kVA</td>
<td>0.85</td>
<td>125kVA</td>
<td>125kVA</td>
<td>125kVA</td>
</tr>
<tr>
<td>02</td>
<td>500 kVA</td>
<td>375 kVA</td>
<td>62.5 kVA</td>
<td>62.5kVA</td>
<td>0.85</td>
<td>62.5kVA</td>
<td>62.5kVA</td>
<td>62.5kVA</td>
</tr>
</tbody>
</table>

**Transformer Specification**
- **KVA**: 1000 kVA
- **KVAR**: 0
- **Power Factor**: 0.85
- **Apparent Load**: 125kVA

**Service Transformer Rating**
- **KVA**: 750 kVA
- **KVAR**: 0
- **Power Factor**: 0.85
- **KVA**: 125kVA

---

686 | Chapter 9  Drawing Electrical Systems
Typically, you would add a panel schedule to a panel schedule sheet that does not contain any panels. But for a smaller project you might add a panel schedule to a drawing that contains one or more panels. You can customize a schedule to define the panel, circuit, wire, and load data that it contains, and how it is organized.

Annotating and Scheduling Devices

To facilitate the annotation and scheduling of devices on page 520, you can specify property sets and tags in the device tools on page 1179 properties, so that they are automatically attached to the devices added to drawings. A property set is a user-defined group of related properties, such as a part number or a manufacturer’s name. A tag is a symbol that can display the data in a property set attached to an object. You use both to annotate electrical drawings.
and create schedules. You can also manually specify property sets and a device tag using the Properties palette when you add devices.

**NOTE** For more information about device tools, see *Creating Tools for Style-Based Content* on page 1179.

### Generating Panel Schedules

You can generate panel schedules for a single drawing, or for circuits that span multiple drawings. Once generated, you can continue to add devices to circuits, or even new circuits and panels.

When you make changes to your drawings that affect the information in a panel schedule, the panel schedule will need updating. Such changes include:

- Adding and deleting circuits
- Deleting a panel
- Linking or unlinking panels
- Attaching or detaching devices to/from a circuit
- Changing the number of load categories used by the panel
- Changing the phase load of a device
- Changing circuit properties, such as rating or description
- Changing panel properties, such as panel name, rating, or wires

Any change to a panel, circuit, or device that makes a panel schedule’s data invalid is noted by a line drawn through that panel schedule. When a schedule becomes out of date, you must update it. You can ensure that the panel data is accurate by executing either a REGEN command, when loads increase/decrease, or an Update Panel Schedule command when you need to add or remove schedule entries. You can select the schedule, right-click, and select Update Panel Schedule from the context menu. Actions that can make a panel schedule out of date include:

- Adding or deleting circuits
- Linking or unlinking panels
- Changing load categories
- Reloading an updated electrical project database
- An externally referenced file uses an electrical project database that is older than the one referenced in the current drawing.

To generate a panel schedule for a panel that does not reside in the current drawing, you must specify an electrical project database (if one has not already been set) on the Electrical Project Database tab of the Electrical Preferences dialog.

To generate a panel schedule on a separate sheet:

1. Create a new general view drawing, and open it.
2. Click Manage tab ➤ Preferences panel ➤ Electrical ➤ .
3. In the Electrical Preferences dialog, click the Electrical Project Database tab.
4. For Project Database, specify the electrical project database file.
5 In the Electrical tool palettes set, click the Tag and Schedule palette.

6 Click a panel schedule tool.

   **NOTE** Alternatively, you can select a panel in the drawing, and click Panel tab ➤ Circuits panel ➤ Panel Schedule.

7 In the Panel Schedule dialog, for Panel, specify the panel for which you want to create the schedule.

   The panels available in the drop-down list are assigned to the electrical project database.
8 Select a panel schedule table style.

![Panel Schedule window]

9 For Show panels from, select Electrical project database, and click OK.

10 Repeat the previous steps as necessary to create additional panel schedules for the same sheet.

To generate a panel schedule in the current drawing, you can use the Panel Schedule tool on the Electrical tool palette. You can also create a panel schedule using the Circuit Manager.

**To generate a panel schedule in the current drawing using the Circuit Manager**

1 Click Analyze tab ➤ Electrical panel ➤ Circuit Manager.

**NOTE** Alternatively, you can select a panel and click Panel tab ➤ Circuits panel ➤ Circuit Manager.
2. Select the name of a panel in the left pane of the Circuit Manager, right-click, and click Insert Panel Schedule.

3. In the Panel Schedule dialog, for Panel schedule table style, select a style.

4. Click OK.

5. Click in the current drawing to place the panel schedule.
Updating Panel Schedules

Update panel schedules when panels, connected circuits, or devices change. For example, if you add light fixtures to an electrical drawing and connect them to a circuit on a panel, the values in the panel schedule do not update automatically. You must update the panel schedule to reflect the changes to the circuit.

■ To update all panel schedules in the drawing, click View tab ➤ Appearance panel ➤ Regenerate drop-down ➤ Regenerate, or enter re (for REGEN) at the command line

■ To update a selected panel, right-click, and select Update Panel Schedule

Exporting a Panel Schedule to Excel

Easily manage a panel schedule by exporting it to a Microsoft® Excel spreadsheet. After it is in Excel, you can modify, remove, and add tables, cells, and values.

NOTE The panel schedule in AutoCAD MEP and the exported panel schedule, in Excel, are not linked, so changing a value in one location will not update the value in the other location.

To export a panel schedule to Excel

1 Select the panel schedule you want to export, right-click, and click Export.
2 In the Export Data dialog, enter a filename and click Save.
The exported panel schedule data is saved as a text file with a .csv file extension. Open the file in Excel and work with the data as needed.
Creating Panel Schedule Table Styles

Create your own custom panel schedule table style to match the layout of your company’s standard panel schedule. First, create the custom table, and then create the panel schedule table style from the table. When creating the custom table, insert placeholder field codes where the panel and circuit data would display. When the custom panel schedule table style is used to generate a panel schedule, the field codes are replaced with the panel and circuit values from the Circuit Manager. For more information about creating schedule table styles see Create and Modify Tables.

The following field codes are available specifically for use in panel schedule tables:

<table>
<thead>
<tr>
<th>Panel Field Names</th>
<th>Panel Field Names</th>
<th>Circuit Field Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Name</td>
<td>Panel Notes</td>
<td>Circuit Name</td>
</tr>
<tr>
<td>Panel Rating</td>
<td>Panel Load Category Name</td>
<td>Circuit Description</td>
</tr>
<tr>
<td>Panel Voltage Phase-to-Phase</td>
<td>Panel Load Category Connected Load</td>
<td>Circuit Total Load</td>
</tr>
<tr>
<td>Panel Voltage Phase-to-Neutral</td>
<td>Panel Load Category Demand Factor</td>
<td>Circuit Rating</td>
</tr>
<tr>
<td>Panel Phases</td>
<td>Panel Load Category Demand Load</td>
<td>Circuit Voltage</td>
</tr>
<tr>
<td>Panel Wires</td>
<td>Panel Connected Load Total KVA</td>
<td>Circuit Number of Poles</td>
</tr>
<tr>
<td>Panel Main Type</td>
<td>Panel Connected Load Total Amps</td>
<td>Circuit Phase</td>
</tr>
<tr>
<td>Panel Main Size</td>
<td>Panel Demand Load Total KVA</td>
<td>Circuit Load Category</td>
</tr>
<tr>
<td>Panel Design Capacity Amps</td>
<td>Panel Demand Load Total Amps</td>
<td>Circuit System</td>
</tr>
<tr>
<td>Panel Type</td>
<td>Panel Design Capacity KVA</td>
<td>Circuit System Type</td>
</tr>
<tr>
<td>Panel Enclosure Type</td>
<td>Panel Slots</td>
<td>Circuit Wires</td>
</tr>
<tr>
<td>Panel Field Names</td>
<td>Panel Field Names</td>
<td>Circuit Field Names</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Panel Mounting</td>
<td>Panel Spare Capacity KVA</td>
<td>Circuit Load Phase A</td>
</tr>
<tr>
<td>Panel AIC Rating</td>
<td>Panel Spare Capacity Amps</td>
<td>Circuit Load Phase B</td>
</tr>
<tr>
<td>Panel Fed From</td>
<td>Panel Spare Capacity Percent</td>
<td>Circuit Load Phase C</td>
</tr>
<tr>
<td>Panel Connected Load Total Phase A</td>
<td>Panel Phase Balance A to B</td>
<td>Circuit Amps</td>
</tr>
<tr>
<td>Panel Connected Load Total Phase B</td>
<td>Panel Phase Balance B to C</td>
<td></td>
</tr>
<tr>
<td>Panel Connected Load Total Phase C</td>
<td>Panel Phase Balance C to A</td>
<td></td>
</tr>
</tbody>
</table>
This section provides an overview of a typical workflow using AutoCAD MEP to design a plumbing system, describes the major components in a plumbing system, and provides step-by-step procedures for performing drawing tasks.

**Plumbing Design Workflow**

A typical workflow using AutoCAD MEP to design a plumbing system includes the following steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>View more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure system settings</td>
<td>Control the form and function of objects in your drawings by specifying design preferences. See <em>Drawing Preferences</em> on page 99 and <em>Configuring Plumbing System Definitions</em> on page 717</td>
</tr>
<tr>
<td>Set up a project</td>
<td>Specify standards (for example, the templates and tool catalogs to use), and integrate the plumbing system plans with the architectural plans. See <em>Working with Projects</em> on page 199</td>
</tr>
<tr>
<td>Set up a pipe sizing table</td>
<td>Specify the fixture unit table and plumbing line sizing table (pipe sizing table). See <em>Configuring Fixture Unit Tables</em> on page 720 and <em>Specifying Plumbing Line Sizing Tables</em> on page 721</td>
</tr>
<tr>
<td>Step</td>
<td>View more information</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open a drawing and attach architectural plan</td>
<td>Use Project Navigator and attach an architectural floor plan as an external reference. See Working with Referenced Drawings on page 245</td>
</tr>
<tr>
<td>Add pumps, water heaters, drains, showers, sinks or other equipment</td>
<td>Place the plumbing equipment and fixtures on the floor plan. See Adding Plumbing Equipment and Fixtures on page 728</td>
</tr>
<tr>
<td>Add pipe to connect equipment</td>
<td>Connect the equipment and fixtures using plumbing lines. See Adding Plumbing Lines on page 730</td>
</tr>
<tr>
<td>Size the plumbing lines</td>
<td>Analyze the plumbing system to properly size the components. See Calculating the Sizes of Supply Plumbing Lines on page 750 or Calculating the Sizes of Sanitary Plumbing Lines on page 760</td>
</tr>
<tr>
<td>Modify the layout</td>
<td>Modify the layout of the system to reflect required design changes, and recalculate sizes as necessary. See Modifying Plumbing Systems on page 739</td>
</tr>
<tr>
<td>Draw a 1-line plumbing isometric</td>
<td>Use schematic tools to produce a drawing of the plumbing system for inspection by code officers. See About Schematic Diagrams on page 772</td>
</tr>
</tbody>
</table>
Plumbing Systems Overview

AutoCAD MEP includes many features you can use to create, modify, and plot plumbing system designs. The topics in this section provide general information on plumbing features.

Plumbing Runs and Lines

After you place the equipment and fixtures in the drawing, you can create a plumbing run. A plumbing run is a set of plumbing lines, consisting of individually drawn segments, that carry gas or fluid from one point to another. A network is the set of interconnected plumbing runs within a system, such as those that carry waste water from the connected toilets, sinks, and showers to the main drain line.

Domestic hot and cold water system

Before you draw a plumbing run, you specify a system for the segment on the plumbing line Properties palette. As you draw the run, the software inserts plumbing fittings based on the default fittings configured for that system definition. However, when necessary, you can override the default fittings for an individual run or manually add an individual fitting. For information on specifying default fittings, see Specifying the Default Fittings for a Plumbing System Definition on page 718.
Plumbing lines are 2-dimensional (2D) and can be system-based and style-based. For this reason, before you add plumbing lines to a drawing, you should define the plumbing systems, plumbing line styles, and plumbing fitting styles.

The plumbing line system determines the system type (i.e., Cold Water, Waste, or Fire Protection), the fittings that the software inserts when necessary, and other properties. Systems help maintain consistency throughout a run and across multiple drawings in a project. Once you define the plumbing systems, you select a system on the Properties palette as you draw plumbing runs. For more information, see Configuring Plumbing System Definitions on page 717.

The plumbing line style determines the appearance and function, such as the available standard sizes and how crossing plumbing lines display in plan view. You can create plumbing line styles based on information such as the size, type, and gauge of the material (i.e., Schedule 40 Carbon Steel or Copper Tube). As with systems, once you define the styles, you can select a style on the Properties palette as you draw plumbing runs.

### Plumbing System Definitions

A plumbing system definition is typically named for the plumbing system for which it will be used, such as domestic hot water or sanitary sewer. The settings for a system definition control many of the display properties of a plumbing system. For example, a layer key style is assigned to a plumbing system definition, which dictates the layer, color, and linetype for the plumbing system.

In the software, plumbing runs that have different systems cannot connect to each other without changing the system for the connecting run. The exception is when the 2 system definitions comprise the same system group. System groups allow different systems to connect to each other.

### Plumbing Fittings

As you specify systems for equipment, fixtures, and plumbing line segments, AutoCAD MEP inserts plumbing fittings based on those specified in the system definition. Therefore, you should specify default fittings for the plumbing system definitions to use on a project. You can specify default fittings for 4 types of fittings: elbows, tees, crosses, and transitions. For example, you can specify that the software place a base tee in the drawing rather than a straight tee. For information on specifying default fittings, see Specifying the Default Fittings for a Plumbing System Definition on page 718.
NOTE When a fitting is required but it cannot fit the layout, plumbing lines are inserted. For example, the next illustration shows 2 instances where elbows could not be inserted, and so the software inserted plumbing lines instead.

In designs that require unique fittings (common to piping or plumbing), you can override the default fittings or you can add a fitting manually.

You can create plumbing fitting styles based on information such as type (i.e., tee, cross, trap, or check valve) and subtype (i.e., 45-degree mitered, 90 degree long Radiused, or 3-way). The style determines the appearance and function of the plumbing fitting. Styles provided with the software include Cross and Sanitary Tee.

While you can manually create elbow fitting styles, the software automatically creates them as you design your layout. The software inserts elbows and then adds corresponding elbow styles to the drawing as needed. The type of elbow you specify as the default for the plumbing system, in conjunction with the angle of the elbow that is added to the layout, determines the name of the elbow style (for example 60 Degree Standard Radiused Elbow).

**Associative Movement**

You can move MvParts, fittings, or plumbing segments without breaking their connections with the rest of the system. Used in conjunction with certain grips, the associative movement feature enables you to move a plumbing run component quickly and accurately.

For example, when you move an MvPart to a new location, the plumbing segments attached to the MvPart can move, shrink, or stretch to maintain a connection with the system. You can also move a plumbing segment without affecting the location of MvParts or other portions of the run.
Movement of a Plumbing Line Segment

The following example shows a plumbing line that is moved. The fittings connected with the plumbing line move with it. However, all other components in the run remain fixed in their original position.

Location grip on plumbing line objected selected

New location specified

Resulting layout

Notice how the elbows connected to the plumbing line moved with it and the plumbing lines connected to the elbows changed length. The system is still connected.
Movement of an MvPart

The following example shows a toilet that is moved. The plumbing lines and fittings move with it. However, all other components in the run remain fixed in their original position.
Location grip on the MvPart selected

New location specified

Resulting layout

Chapter 10  Drawing Plumbing Systems
Plumbing Grips

Grips offer a quick way to add or modify plumbing objects or MvParts. The applicable grips become visible when you select an object in a drawing.

Grips for Adding to a Plumbing Run

Using add grips provides an efficient way to quickly begin drawing a plumbing line. It ensures connectivity between the object and plumbing line.
Add grips on a plumbing line segment

Add grips on a plumbing fitting

Add grips on an MvPart (a sink)

Some fittings also contain add grips that enable you to create a new branch directly from the fitting. For example, an elbow has add grips you can use to automatically convert the elbow to a tee, from which you can then draw a plumbing line. The existing plumbing branches remain connected to the other 2 tee connections.
Grips for Modifying a Plumbing Run

Plumbing runs are typically modified throughout the design process due to architectural or structural modifications to the system requirements. For example, if the architect increases the size of a room, the corresponding plumbing system supplying that room needs to be modified. You might need to lengthen the plumbing lines, add fixtures, or reroute the plumbing lines for the room.

Several grips are available in AutoCAD MEP to modify components in a plumbing system.
**Location Grips**

You can move a plumbing component in the current XY plane using a location grip. Location grips appear on parts at their insertion points and connector points.

Location grips on a plumbing line segment

Location grips on a plumbing fitting

Location grips on an MvPart (a pump)

If the plumbing line segment is not connected to another object, you can change both its length and angle using the Start grip or End grip.
The Start and End grips enable you to change the XY location of the start point or end point of the segment. This is useful when you are initially designing runs because you can easily connect a segment to an existing run.

If the part or plumbing line segment is connected to other objects, you must specify whether you want to maintain their connectivity when you move the part.

**Rotate Grips**

You can use the Rotate grip to rotate plumbing in-line parts, fittings, and takeoffs 180 or 90 degrees in the direction indicated by the grip.

**Rotating a 3-way valve 90 degrees in plan view**

AutoCAD MEP displays Rotate grips on the plumbing line in-line parts, fittings, and takeoffs with connectors on opposite ends. However, when necessary to preserve the connectivity of plumbing runs, the software limits the available rotation options or hides the grips.

When you rotate a part, fitting, or takeoff that is connected to other objects, the software adjusts the connected objects to maintain their connectivity. For example, the software might make minor adjustments to the lengths of...
connected plumbing line segments after you have flipped a fitting. If it cannot adjust the objects, it disconnects them.

The rotate grip turns a part 180 degrees. The flip grip orients a part (in-line or anchored MvParts, fittings, or takeoffs) for flow direction.

Lengthen Grips

You can modify the length of plumbing line segments using lengthen grips. Because the grips constrain a segment to its current angle, they are particularly useful for modifying the length of plumbing line segments you have already placed.

When you use the lengthen grip on an end that is connected to another object, you must specify whether you want AutoCAD MEP to maintain connectivity between the objects.

Lengthen grips on plumbing line segments
The following example illustrates how a plumbing line segment in a vent system is lengthened. To avoid interference with a duct system, the software adjusts connected objects to maintain their connectivity.
Plumbing line segment selected

Lengthen grip selected

New length specified

Resulting layout
Rise/Run Angles and Slope

In a plumbing drainage system, you need a minimum slope at all times. To define the slope, you enter the rise and run values on the Properties palette as you draw the plumbing line, and the software calculates the slope. The software also calculates the rise and run values if you instead enter a slope percentage.

As you draw plumbing lines with a defined slope percentage, the software displays a slope glyph that indicates the direction of the slope and whether the slope angles is in an up or down direction.

Viewing the slope glyph

The elevation reflects the rise value. When you end a segment, the Properties palette reflects the elevation value. As you continue to add segments, the elevation updates to reflect the elevation of the last-drawn segment.

Fixture Units

You access fixture unit information on the Fixture Units tab of the Multi-view Part Properties dialog.

You can specify the fixture unit table to size the following:

- Plumbing line
Type of fixture

Type of occupancy (whether intended for public or private use)

You can also view connector information for each connection point on the fixture.

Calculations

In plumbing system drawings, you can access information about plumbing line sizing calculations for fixtures (MvParts) on the Calculations tab in the Multi-view Part Properties dialog, accessed by clicking a fixture, then clicking Equipment tab ➤ Modify panel ➤ Equipment Properties.

The values on this tab only appear if you have sized the corresponding plumbing line. Because they are read-only, the values cannot be changed. You can view the flow rate and pressure properties for each connector of the fixture along with the minimum and the calculated values. The minimum flow rate and pressure values are required to adequately supply water to the fixture. The calculated flow rate and pressure values are the actual values calculated by the plumbing line sizing commands based on the design layout in the drawing. You can also view the system type of each connector.

Plumbing Line Sizing Tables

The plumbing line sizing feature relies on 2 types of plumbing line sizing tables (also referred to as pipe sizing tables) when performing sizing calculations:

- Supply plumbing line sizing tables specify the equivalent plumbing line length values for fittings and valves.
- Sanitary plumbing line sizing tables specify the maximum permissible fixture unit loads for different types of sanitary runs (stacks, branches, and offsets).

The proper reference and use of plumbing line sizing tables are essential to accurate plumbing line sizing. If you plan to do sizing, you should first identify the plumbing line sizing tables to use and verify their accuracy.

AutoCAD MEP includes sample sizing tables for supply lines and for sanitary lines, based on industry standards. However, you or your CAD manager can...
create your own sizing tables that meet your project requirements and conform to applicable codes. You can use the sample tables as guides for creating your own tables. For more information, see Specifying Plumbing Line Sizing Tables on page 721.

**Design Values for Supply Plumbing Line Sizing**

The Design Values section of the Size Supply Plumbing Line dialog lets you define the design parameter values of the supply run. Before you enter values, you need to know the source of the water and the pounds per square inch of pressure being produced. You also need to know the pressure requirement for the fixture located at the highest elevation in the building model.

**Design Values section of the Size Supply Plumbing Line dialog**

**Plumbing Line Sizing Table**

Select the supply plumbing line sizing table (pipe sizing table) that you created based on applicable codes, such as the Uniform Plumbing Code. To verify the values in the table definition, open it by clicking the Plumbing Line Sizing Table icon, and then click the Equivalent Plumbing Line Lengths tab.

The plumbing module reads the values of the valves and fittings in your drawing and verifies that they are correct for the length of supply line in the run.

**Restrict Velocity**

Selecting Restrict Velocity prevents a plumbing line size with a flow velocity that exceeds the value that you enter. The restricted velocity should be the maximum velocity that you want in the run. This can avoid issues such as water hammer. The default restrict velocity value is 10 ft./s.
Pressure at Source
Pressure at Source defines the amount of water pressure coming into the building. For example, the pressure at the source of the building could be from a booster pump. The default value is 60 psi.

Pressure at Highest Fixture
Pressure-Highest Fixture defines the minimum amount of pressure to be supplied to the highest-level fixture in the supply run to ensure adequate flow. For example, a third-floor toilet fixture at an elevation of 35 feet might require 15 psi in order to flush. The default value is 15 psi.

Friction Loss-Water Meter
If a water meter is included in your design, then you should account for the total friction loss of the water meter. A water meter is considered part of the water utility. Typically it is not a part of the building. Often it is not included in the design. Therefore, the default value is 0 psi.

Hazen-Williams C-factor
The C-factor determines the friction loss of the run using the Hazen-Williams formula. The factor “C” is known as the “Hazen-Williams C” or “friction loss coefficient C.” The C-factor relates the relative roughness of the interior wall of the pipe and varies between different types of pipe. The C-factor is typically 100 for steel pipe and 130 for brass and copper. The default value used in sizing supply plumbing lines is 100.

Customizing Plumbing Content
Typically, CAD managers and other users create plumbing content. AutoCAD MEP provides 2 types of plumbing content:

- **Style-based content** refers to 2D objects that are defined by styles. Styles are sets of properties and associated view blocks. In plumbing drawings, style-based content includes plumbing lines, plumbing fittings, and schematic objects for schematic diagrams.

- **Catalog-based content** refers to 3D objects that are defined by part definitions and associated part models, and are grouped into part catalogs. In plumbing drawings, catalog-based content includes plumbing equipment (called multi-view parts, MvParts, or parts) and plumbing fixtures. You specify systems (a type of style) for catalog-based content. A system stores properties that all building system objects assigned to the system
can share. This gives a consistent look and feel to the systems in a drawing. See Working with Style-Based Content on page 124 and Working with Catalog-Based Content on page 115 for more information on content types.

Creating Style-Based Content

Style Manager lets you create style-based content that defines plumbing lines, plumbing fittings, and schematic objects. You convert batches of existing objects to schematic symbol styles in the following ways:

■ Convert the schematic symbol styles provided with AutoCAD MEP to their individual components (the settings and the view blocks), customize the components, and then convert the components back to schematic symbol styles

■ Convert a batch of AutoCAD blocks in a custom block library to schematic symbol styles

Creating Catalog-Based Content

You can create 2 types of catalog parts, parametric and block-based, using Content Builder. Content Builder is a content creation tool that includes 3D modeling and 2D drawing features. For more information, see Building Parametric Fittings Using Content Builder on page 970 and Creating Block-Based Parts Using Content Builder on page 1127.

Configuring Plumbing System Definitions

This section explains how to configure properties that control the appearance and behavior of objects in your plumbing system designs.

Creating a Plumbing System Definition

1 In the Plumbing workspace, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Plumbing System Definitions.
2 Create the plumbing system definition using the left pane of Style Manager:

<table>
<thead>
<tr>
<th>To</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>create a new definition</td>
<td>1 Right-click Plumbing System Definitions, and click New.</td>
</tr>
<tr>
<td></td>
<td>2 Enter a name, and press ENTER.</td>
</tr>
<tr>
<td>copy an existing definition</td>
<td>1 Right-click an existing system definition, and click Copy.</td>
</tr>
<tr>
<td></td>
<td>2 Right-click Plumbing System Definitions, and click Paste.</td>
</tr>
<tr>
<td></td>
<td>3 Right-click the copied item, and click Rename.</td>
</tr>
<tr>
<td></td>
<td>4 Enter a new name, and press ENTER.</td>
</tr>
</tbody>
</table>

3 On the General tab, enter a name and description.
4 On the Defaults tab, specify the default fittings to use during layout.
5 On the remaining tabs, specify other properties pertaining to this system definition, and then click OK.

**TIP** When defining a sanitary plumbing system that uses gray water or black water, you must define the system type as Waste on the Design Rules tab. Otherwise, the sizing calculator will not recognize the system as a sanitary system, and you will be unable to size the run.

### Specifying the Default Fittings for a Plumbing System Definition

When you specify systems for equipment, fixtures, and plumbing lines as you draw, AutoCAD MEP inserts plumbing fittings based on the default fittings specified for the associated system definition. For this reason, you should specify default fittings for the plumbing system definitions that you are using for a project. You can specify default fittings for 4 types of fittings:

- Elbows
Tees
Crosses
Transitions

For example, you can specify that a base tee be placed as you draw rather than a straight tee.

**NOTE** If your design requires unique fittings, you can override the default fittings for an individual run or add a fitting manually.

**To specify the default fittings for a plumbing system definition**

1. In the **Plumbing workspace**, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Plumbing System Definitions.

   **NOTE** Alternatively, you can select a fitting in the drawing, and click Plumbing Fitting tab ➤ General panel ➤ Edit Style drop-down ➤ Edit System Style.

2. In Style Manager, select the system where you will specify the default fittings.
3. On the Defaults tab, specify the type of fitting and click OK:
   - Elbow

   **TIP** As you draw a system, the software adds elbows as needed and the corresponding elbow styles to the drawing. The type of elbow you specify here, in conjunction with the angle of the elbow that is added, determines the name of the elbow style (for example 60 Degree Standard Radiused Elbow). Because the elbow styles are stored in the drawing, you can apply them to other elbows during layout modification.

   - Tee
   - Tee Up
   - Tee Down
   - Cross
   - Transition
NOTE If a list is empty or does not contain the desired fitting, click Import, select a fitting, and then click OK. Because the software draws elbows dynamically based on the direction of the run, there is no import option for elbows.

## Configuring Fixture Unit Tables

Fixture unit tables specify fixture units by fixture type and occupancy type for the following types of systems: cold water, hot water, and sanitary waste. Fixture unit table definitions are available in Style Manager on the Table tab.

When you add or modify a fixture in your drawing, you specify a fixture unit table and fixture type in the Add Multi-view Parts dialog.

AutoCAD MEP applies a default fixture unit value to each connector on the fixture based on the system type of the connector and the fixture values that you specify in the worksheet. However, you can modify the applied values when necessary.

### Applying a Default Fixture Unit

1. Locate all the rows in the fixture unit table that match the fixture type of the fixture.
2. In those rows, locate the row that matches the subtype of the fixture.
3. If the software cannot identify the specified row, locate the row based on matching keywords in the subtype name of the fixture.

If the software cannot find a match for the fixture in the specified fixture unit table, it does not assign default fixture unit values to the fixture. To take advantage of the application of default values, you should create and use fixture unit tables that correspond to the plumbing fixtures.

When performing sizing calculations for plumbing lines, the software uses the fixture unit values applied to the fixtures in your drawing. If you plan to do plumbing line sizing, you should first identify the fixture unit tables to use and verify their accuracy.

The software includes a sample fixture unit table based on industry standards. However, you or your CAD manager should create fixture unit tables to meet your project requirements and conform to applicable codes, such as the Uniform Plumbing Code. You can use the sample table as a guide.
Creating a Fixture Unit Table

1 In the **Plumbing workspace**, click Manage tab ➤ Style & Display panel ➤ Style Manager.
2 In the left pane of Style Manager, open Plumbing Objects, and then open Fixture Unit Table Definitions.
3 Under Fixture Unit Table Definitions, click Standard, right-click, and click Copy.
4 Select Fixture Unit Table Definitions, right-click, and click Paste.
5 Select Standard (2), right-click, click Rename, enter the name of the fixture unit table definition that you are creating, and press `ENTER`.
6 In the right pane, click the General tab and enter a name and description. You can also click Notes to add text notes or reference documentation.
7 To modify the table, click the Table tab, select the desired rows, use the Add, Modify, and Remove buttons, and click OK.

Importing a Fixture Unit Table into a Drawing

1 With both drawings open, activate the **Plumbing workspace**.
2 Click Manage tab ➤ Style & Display panel ➤ Style Manager.
3 In the left pane of Style Manager, select the fixture unit table to import (located under the drawing that contains it), right-click, and click Copy.
4 Under the drawing where you want to import the table, select Fixture Unit Table Definitions, right-click, and click Paste.

Specifying Plumbing Line Sizing Tables

1 In the **Plumbing workspace**, click Manage tab ➤ Style & Display panel ➤ Style Manager.
2 In the left pane of Style Manager, under Plumbing Objects, click one of the sizing table definitions (supply pipe or sanitary pipe).
3 In the left pane of Style Manager, click Standard, right-click, and click Copy.
4 Click the applicable Sizing Table Definitions item (Supply Pipe or Sanitary Pipe), right-click, and click Paste.

5 Select Standard (2), right-click, click Rename, enter the name of the sizing table you are creating. Then press ENTER.

6 Click the General tab, and change the name and description. Click Notes to add text or reference documentation.

7 Specify definitions that are specific to Supply or Sanitary pipes:
   ■ To create a supply pipe sizing table definition, click the Equivalent Plumbing Line Lengths tab and use the New Row, Remove Row, New Column, Modify Column, and Remove Column buttons to change the table definition as necessary.
   ■ To create a sanitary pipe sizing table definition, choose either the Stacks, Branches, or Offsets tab and use the New and Remove buttons to change the rows in the table definition as necessary.

---

**Configuring Styles for Plumbing Lines and Fittings**

Plumbing line styles and plumbing fitting styles, respectively, determine the appearance and function of plumbing lines and plumbing fittings. For example, a plumbing line style determines how a plumbing line is displayed when crossing other plumbing lines, its available nominal sizes, and its display properties.

This section provides information on styles specific to plumbing. For general information that is applicable to all building systems disciplines, including plumbing, see Configuring Styles on page 896.

**NOTE** The plumbing module does not distinguish between the horizontal branches and main runs in a network. Therefore, consider creating a unique plumbing line style for horizontal branches.

---

**Specifying Annotation for a Plumbing Line Style**

A plumbing line style determines how the line displays when it crosses another line. When the elevations of 2 crossing lines are different, then the crossing style of the line at the higher elevation is used. When the elevations of the
lines are the same, then the software uses the crossing style of the line drawn second.

<table>
<thead>
<tr>
<th>If the crossing style of the 2 lines is...</th>
<th>And if the priority values of the 2 lines are...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>overlap</td>
<td>the same</td>
<td>the line drawn second displays the overlap.</td>
</tr>
<tr>
<td>break</td>
<td>the same</td>
<td>the line drawn first displays the break.</td>
</tr>
<tr>
<td>mixed (one is overlap, and the other is break)</td>
<td>the same</td>
<td>the line drawn second determines the crossing style to use. If the style is overlap, the line drawn second displays the overlap. If the style is break, the line drawn first displays the break.</td>
</tr>
</tbody>
</table>

To specify annotation for a plumbing line style

1 In the **Plumbing workspace**, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Plumbing Line Styles.

    **NOTE** Alternatively, you can select a plumbing line that uses the style in the drawing, and click Plumbing Line tab ➤ General panel ➤ Edit System Style drop-down ➤ Edit Plumbing Line Style.

2 In Style Manager, select the style.

3 On the Annotation tab, under Crossings, select a style for crossing plumbing lines.

You can specify that the crossing lines are displayed as is, with an overlap, or with a break.

4 If you select the overlap style or break style, enter the paper width of the overlap or break, and click OK.
Specifying Standard Sizes for a Plumbing Line Style

Before you draw a plumbing run, you select a style and specify a nominal size on the Properties palette. The nominal sizes available on the Properties palette reflect the same sizes that you previously designated in Style Manager.

To specify standard sizes for a plumbing line style

1. In the **Plumbing workspace**, open the style by doing one of the following:
   - Click **Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Plumbing Line Styles**. In the left pane of Style Manager, click the style to specify, and in the right pane, click the Standard Sizes tab.
   - Select a plumbing line that uses the style in the drawing, and click **Plumbing Line tab ➤ General panel ➤ Edit System Style drop-down ➤ Edit Plumbing Line Style**.

2. On the Standard Sizes tab, specify the standard (nominal) sizes for the plumbing line style:
   - To add a size, click (New Size), enter a value, and press ENTER.
   - To modify a size, double-click the size, enter a different value, and press ENTER.
   - To delete a size, select the size, and click (Remove Size).

Specifying Type and Subtype for a Plumbing Fitting Style

The type and subtype of a plumbing fitting style determine the default fitting behaviors for the style, for example, whether a tee is long-radiused or short-radiused.
To specify the type and subtype for a plumbing fitting style

1. In the Plumbing workspace, open the style by doing one of the following:
   - Click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Plumbing Fitting Styles drop-down ➤ Plumbing Fitting Styles.
   - Select a plumbing fitting that uses the style in the drawing and click Plumbing Fitting tab ➤ General panel ➤ Edit Style drop-down ➤ Edit Style.

2. On the Details tab, select a fitting type from the list, followed by a fitting subtype, and then click OK.

Connectors for a Plumbing Fitting Style

All AutoCAD MEP objects have one or more smart connectors (connection points). These smart connectors enable objects to connect intelligently to appropriate objects and to transfer information such as shape, size, and system. You add connectors to style-based objects such as plumbing fittings by adding the connectors to the styles that define the objects. You can also remove connectors from styles, or change their type and location.

Because plumbing fittings have grips, it is important for the connectors of a plumbing fitting style to be configured correctly. For a given connector, the connection point value must be the length of the segment, and its connection direction must be positive (1) or negative (-1) depending on its orientation from the origin (0,0). In addition, you must define the connectors in a specific order. The following image of an elbow, tee, and cross identifies the order for each type of fitting.
For example, the following table identifies how you would configure an elbow, tee, and cross—all with segments 0.5 inches long.

<table>
<thead>
<tr>
<th>Part Type</th>
<th>X, Y, and Z Values for Connection Direction</th>
<th>X, Y, and Z Values for Connection Direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elbow</td>
<td>Connector 1: 0, 0.5, 0</td>
<td>Connector 1: 0, 1, 0</td>
</tr>
<tr>
<td></td>
<td>Connector 2: -0.5, 0, 0</td>
<td>Connector 2: -1, 0, 0</td>
</tr>
<tr>
<td>Tee</td>
<td>Connector 1: -0.5, 0</td>
<td>Connector 1: -1, 0, 0</td>
</tr>
<tr>
<td></td>
<td>Connector 2: 0.5, 0, 0</td>
<td>Connector 2: 1, 0, 0</td>
</tr>
<tr>
<td></td>
<td>Connector 3: 0, 0.5, 0</td>
<td>Connector 3: 0, 1, 0</td>
</tr>
<tr>
<td>Cross</td>
<td>Connector 1: -0.5, 0</td>
<td>Connector 1: -1, 0, 0</td>
</tr>
<tr>
<td></td>
<td>Connector 2: 0.5, 0, 0</td>
<td>Connector 2: 1, 0, 0</td>
</tr>
<tr>
<td></td>
<td>Connector 3: 0, 0.5, 0</td>
<td>Connector 3: 0, 1, 0</td>
</tr>
<tr>
<td></td>
<td>Connector 4: 0, -0.5, 0</td>
<td>Connector 4: 0, -1, 0</td>
</tr>
</tbody>
</table>

**Configuring Connectors for a Plumbing Fitting Style**

1. Open the drawing that contains the style.
2. In the Plumbing workspace, open the plumbing fitting style by doing one of the following:
   - Click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Plumbing Fitting Styles. In the left pane of Style Manager, select the style.
   - In the drawing, select a plumbing fitting that uses the style, and click Plumbing Fitting tab ➤ General panel ➤ Edit Style drop-down ➤ Edit Style.
3. On the Connectors tab, for Description, enter a descriptive name, such as Cold_Water_Supply.
4. For Domain, select pipe.
5. Specify values for connection points X, Y, and Z. (Typically, you do not use the center points of the view blocks as connectors for plumbing fittings.)
**IMPORTANT** Use caution when modifying the connection points on connectors or removing connectors. Either action can break the connectivity between objects because the connector is modified in or removed from all instances of the style in the drawing.

6 Specify values for connection directions X, Y, and Z.

7 If you want to add a connector, click and configure the connector properties.

8 If you want to remove a connector, select the connector, and click.

9 Click OK.

### Specifying Plumbing Preferences for Labels and Flow Arrows

1 In the **Plumbing workspace**, click Manage tab ➤ Preferences panel ➤ Plumbing.

2 To apply labels as you draw, click the first Apply Labels/Flow Arrows check box, and select a label style from the list.

3 To apply flow arrows as you draw, click the second Apply Labels/Flow Arrows check box, and select an arrow style from the list.

4 Under Layout Method for both the label style and the arrow style, specify the desired method, and then click OK:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>place a fixed number of evenly spaced labels or arrows along the plumbing line</td>
<td>select Space Evenly, and enter the number of labels or arrows to place on the plumbing line (related to By quantity on the Properties palette).</td>
</tr>
<tr>
<td>place the labels or arrows along the plumbing line based on a repeated spacing value</td>
<td>select Repeat Every, and enter the distance to specify equidistant spacing between labels or flow arrows along the plumbing line (related to By distance on the Properties palette).</td>
</tr>
</tbody>
</table>
As you draw, you can specify the label or flow arrow preferences on the Design tab of the Properties palette under Labels and Flow Arrows.

For more on annotation, such as tags, schedules, cross-sectional views, and details, see Annotation on page 814.

Creating Plumbing Systems

The topics in this section describe how to use the features in AutoCAD MEP to create plumbing system designs.

Adding Plumbing Equipment and Fixtures

After attaching an external reference file (xref) of your architectural plan to your drawing, typically you continue by adding plumbing equipment and fixtures. You can place them in specific locations on floor plans and reflected ceiling plans.

See Mechanical, Electrical, and Plumbing Equipment in Building Systems on page 110.

You add plumbing equipment and fixtures using the tools on the Equipment tool palette in the Plumbing tool palette group or ribbon, and following this sequence:

- Select a tool
- Use the Add Multi-view Parts dialog to select a part from the catalog
- Configure its properties
- Add the part to the drawing

To add plumbing equipment or fixtures

1. If necessary, activate the Plumbing workspace.
2. Open the Equipment tool palette, and select an equipment or fixture tool.

Alternatively, you select equipment from the Home tab ➤ Build panel ➤ Equipment drop-down on the ribbon.
The Add Multi-view Parts dialog appears, showing a tree view of the current Plumbing catalog.

3 On the Part tab, select a part subtype in the part type folder that is associated with the tool you selected.

4 Click Details to view the sizes available for the selected part subtype.

5 Because some part subtypes have multiple available sizes, optionally click the Part Filter tab to filter the list and specify the filtering criteria.

**NOTE** The part catalogs and content locations specified in the Options dialog determine the parts available to you when adding a part. For more information, see *Specifying Part Catalogs and Style-Based Content Locations* on page 100. If the part you want is unavailable, you can create a custom part using *Content Builder*.

6 Select a part for Part Size Name.

7 Specify an elevation.

8 If the part is a fixture, click the Fixture Units tab, and specify the following:
   - Fixture unit table
   - Fixture type
   - Occupancy type (public or private)

**TIP** Before adding the fixture, you should verify the accuracy of the selected fixture unit table and ensure it meets your design requirements. When you add the fixture, the software applies a default fixture unit value to each of its connectors based on the system type of the connector and the property values that you specified on the Fixture Unit Table tab. The default values are correct for most design situations. However, you should examine the values and modify them if required. If you subsequently perform plumbing line sizing, the software uses the fixture unit values applied to the fixture in the calculations.

9 Specify an insertion point in the drawing, and use the compass to specify a rotation angle.

10 Press *ENTER* to end the command.
Adding Plumbing Lines

You add plumbing lines using the plumbing line tool palette or ribbon, and the Properties palette to specify plumbing line properties.

NOTE As you draw plumbing runs in plan view and change the elevation, the software inserts an elbow down drop symbol when needed to represent the vertical segments in the run. You can manually insert an elbow up plumbing fitting if needed at the end of the plumbing line.

Drawing a Plumbing Run from Equipment or Fixtures

When you start or end a plumbing run at a piece of equipment or a fixture, the start point or end point of the plumbing line snaps to the nearest connection point on the equipment or fixture. Simple fixtures and equipment, such as a utility sink, typically contain only one connection point. However, complex fixtures and equipment, such as tanks and lavatories, often contain multiple connection points. Some even have connection points that belong to different systems, such as both a supply system and a drain system.

To draw a plumbing run from equipment or a fixture

1 Add the necessary equipment or fixtures.
2 Open the Plumbing Line tool palette, and select a plumbing line tool.

NOTE Alternatively, you can click Home tab ➤ Build panel ➤ Plumbing Line .

3 On the Design tab of the Properties palette, under General, specify a plumbing line style.
The specified plumbing line style determines its appearance and function. For example, it might determine how the line is displayed when it crosses other lines. For more information, see Configuring Styles for Plumbing Lines and Fittings on page 722.

4 Under System, make a selection from the list.
The system specified for a plumbing run determines the fittings that are inserted as you draw, as well as other properties. For more information, see Configuring Plumbing System Definitions on page 717.
With the Pipe Connector snap enabled, select a starting point for the plumbing line at a connector on the equipment or fixture.

**NOTE** If more than one connector is available, the Select Connector dialog appears. Select a connector and click OK.

The elevation and the default run direction of the plumbing line are dependent on the connector assigned to the fixture or MvPart. Typically, the run direction is perpendicular to the fixture or MvPart.

6 Continue specifying points to draw the run as necessary.
7 Press ENTER when done.

**Drawing a Plumbing Run Using Add Grips**

1 Select the object in the drawing, and click (Grips for Adding to a Plumbing Run on page 705) to begin drawing a plumbing line:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>start a run from one of the ends of a plumbing line segment</td>
<td>click the add grip at that end of the segment.</td>
</tr>
<tr>
<td>start a run from the midpoint of a plumbing line segment</td>
<td>click the add grip at the midpoint of the segment. A tee or takeoff is automatically inserted, depending on the connection specified for plumbing layout preferences.</td>
</tr>
<tr>
<td>start a run from an MvPart</td>
<td>click the add grip on the MvPart connection.</td>
</tr>
<tr>
<td>start a run from a fitting, such as an elbow or tee</td>
<td>hold down the Ctrl key and click the add grip pointing in the direction of where you want to start the new run.</td>
</tr>
</tbody>
</table>

2 On the Design tab of the Properties palette, specify a system. The system determines the fittings that are inserted as you draw, as well as other properties. For more information, see Configuring Plumbing System Definitions on page 717.
NOTE If you start from an MvPart, select a system type for System. If you start from a plumbing line segment or fitting, the new run inherits the system.

3 Next, specify a plumbing line style.
   The style determines the appearance and function of the plumbing line, such as how the line is displayed when it crosses other lines. For more information, see Configuring Styles for Plumbing Lines and Fittings on page 722.

4 Specify an elevation for the plumbing segment.

5 For Nominal Size, specify the diameter of the plumbing line.

NOTE If you change the nominal size before specifying the first segment of the new run, a transition is automatically inserted between the object and new plumbing line segment after you specify the first point of the new run.

6 Specify whether the nominal size should be locked from editing. Locking the nominal size prevents an accidental change to sizing values when you are modifying the plumbing line.

7 If desired, for Offset, enter the distance from the run to other drawing objects.

8 Enter values for Rise and Run.

NOTE The software calculates the slope using the rise and run values that you enter. If you specify a slope percentage instead, the software calculates the rise and run values.

9 Specify a start point. For example, you can begin the run by using a Pipe Connector snap to snap to the endpoint of an existing plumbing line or snap to a point along the curve of the line.

10 Specify additional points to add segments to the run. (Fittings are automatically inserted as you lay out the run.) As you specify points, change the elevation when necessary.

   For information on connecting to plumbing lines at a different elevation, see Connecting Plumbing Lines at Different Elevations on page 734.

11 Press ENTER to end the command.
Drawing a Plumbing Run

1 If necessary, activate the Plumbing workspace.

2 On the Plumbing Line tab of the Plumbing tool palette, select a plumbing line tool.

   **NOTE** To draw a plumbing run, you can also click the add grip on an existing plumbing line segment or click Home tab ➤ Build panel ➤ Plumbing Line.

3 On the Design tab of the Properties palette, under General, specify a plumbing line style.
   The style determines the appearance and function of the plumbing line, such as how the line is displayed when it crosses other lines. For more information, see Configuring Styles for Plumbing Lines and Fittings on page 722.

4 Specify a system.
   The system determines the fittings that are inserted as you draw, as well as other properties. For more information, see Configuring Plumbing System Definitions on page 717.

5 Specify an elevation.

6 For Nominal Size, specify the diameter of the plumbing line.

7 If desired, for Offset, enter the distance from the run to other drawing objects.

8 Enter values for Rise and Run.

   **NOTE** The software calculates the slope using the rise and run values that you enter. If you specify a slope percentage instead, the software calculates the rise and run values.

9 Specify a start point. For example, you can begin the run by using a Pipe Connector snap to snap to the endpoint of an existing plumbing line or snap to a point along the curve of the line.

10 Specify additional points to add segments to the run. (Fittings are automatically inserted as you lay out the run.) As you specify points, change the elevation when necessary.
   For information on connecting to plumbing lines at a different elevation, see Connecting Plumbing Lines at Different Elevations on page 734.
11 Press ENTER to end the command.
The system and parameter settings that you specify remain in effect until you change them.

Creating a Plumbing Run from a Polyline
You can define the path of a run using a combination of polylines and lines, and then convert these objects into a plumbing run.

1 Define the curve of the layout path with the AutoCAD® PLINE or LINE command.
2 Select the polyline or line that you want to convert, right-click, and click Convert to ➤ Plumbing Line.
3 Do one of the following:
   - Press ENTER or enter n (no) to leave the layout geometry in the drawing.
   - Enter y (yes) to erase the layout geometry from the drawing.
4 Specify values for the plumbing line on the Design tab of the Properties palette, including style, dimensions, system, etc.
5 Click ESC to save your changes and exit.

Connecting Plumbing Lines at Different Elevations
As you draw a plumbing system, sometimes you need to start or end a run by connecting (snapping) to the endpoint of an existing plumbing line, or to a point along its curve.

If the connecting plumbing line has a different elevation than the one you are starting or ending, you are prompted to decide how to connect the 2 plumbing lines:
**Add a riser to the connecting plumbing line**

If you are connecting to an end connector, the software inserts a drop symbol to represent the change in elevation. If you are connecting to a point on the curve of the plumbing line, the software inserts the tee specified as the default fitting for Tee Up or for Tee Down in the plumbing system definition, depending on the elevation of the 2 lines.

**RELATED** For more information on specifying default fittings, see *Specifying the Default Fittings for a Plumbing System Definition* on page 718.

**Add a riser to the fixture**

If you are connecting from a fixture to a plumbing line, the software adds a riser to the fixture (MvPart), rather than to the end of the connecting line.

**Adjust the slope**

The slope of the plumbing line that you are starting or ending is adjusted based on the difference in elevation. If you are connecting to an end connector, an elbow is inserted. If you are connecting to a point on the curve of the plumbing line, a tee is inserted.

**Adjust the connecting plumbing line elevation**

The elevation of the plumbing line you are starting or ending is changed to match the elevation of the plumbing line to which you are connecting. If you are connecting to an end connector, an elbow is inserted. If you are connecting to a point on the curve of the plumbing line, a tee is inserted.

**Do Not Make a Connection**

Avoid making the connection.

---

**Overriding the Default Plumbing Fittings for an Individual Run**

Before you draw a plumbing run, you specify a system. As you draw the run, the software inserts plumbing fittings based on the default fittings configured in that system definition.

Generally, this insertion behavior for fittings is desirable because all of the runs in a plumbing system typically have the same types of fittings. For example, a sanitary waste system typically has runs with sanitary tee fittings.
However, you can override the default fittings for an individual run that you are drawing. This enables the run to have a unique set of fittings regardless of the system.

**NOTE** You can also add a fitting manually, which is beneficial when you want to add a single unique fitting.

To override the default plumbing fittings for an individual run

1. In the **Plumbing workspace**, select a tool on the Plumbing Line tab of the Plumbing tool palette.

   **NOTE** Alternatively, you can click Home tab ➤ Build panel ➤ Plumbing Line .

2. On the Design tab of the Properties palette, under Default Fitting Overrides, click the desired fitting type to override.

3. On the Select a Style dialog, specify the fittings style override to be used during layout of the current run.

   **If you want to specify a...** then click...

<table>
<thead>
<tr>
<th>Tee</th>
<th>Tee, and click a type of tee.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tee Up</td>
<td>Tee Up, and click a type of tee.</td>
</tr>
<tr>
<td>Tee Down</td>
<td>Tee Down, and click a type of tee.</td>
</tr>
<tr>
<td>Cross</td>
<td>Cross, and click a type of cross.</td>
</tr>
<tr>
<td>Transition</td>
<td>Transition, and click a type of transition.</td>
</tr>
</tbody>
</table>

4. Draw the plumbing run using the new default fittings, and press **ENTER** to end the command.

   Once you end the command, the software restores the default fittings to those specified in the plumbing system definitions.
Adding Plumbing Fittings Manually

Before you draw a plumbing run, you specify a system. The software determines the fittings to insert based on the default fittings configured in that system definition.

When necessary, you can override the default fittings for an individual run, or add a fitting manually. This is useful in design situations that require unique fittings.

When you add a plumbing fitting manually, the fitting breaks into the plumbing line, which results in a separate segment on each side of the fitting.

To add a plumbing fitting manually

1. If necessary, activate the Plumbing workspace.
2. Select a tool on the Fittings tab of the Plumbing tool palette.
3. On the Design tab of the Properties palette, under General, click the image to the right of Style.
4. On the Select a Style dialog, choose the desired plumbing fitting style.
5. On the Design tab of the Properties palette, specify the insertion properties for the selected fitting:

<table>
<thead>
<tr>
<th>If you want to specify...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>plumbing system</td>
<td>select a system.</td>
</tr>
<tr>
<td>an elevation at which to place the fitting</td>
<td>select an elevation.</td>
</tr>
<tr>
<td>a grip point location on the fitting</td>
<td>select a method for Justification.</td>
</tr>
<tr>
<td>a rotation angle</td>
<td>select Specify rotation on screen. Select No, and then enter the number of degrees for Rotation.</td>
</tr>
<tr>
<td>specify the rotation angle upon insertion</td>
<td>select Specify rotation on screen and select Yes.</td>
</tr>
</tbody>
</table>
If you want to specify… then…

specify an identification label enter text for the ID (under Advanced)

6 Click in the drawing to specify the insertion point.
7 If you selected Specify Rotation on Screen, rotate the fitting into position or press ENTER to accept the default rotation.
8 Add additional fittings as needed. You can select different fittings and specify different properties as you add them.

Adding an Expansion Loop to a Plumbing Run

Add an expansion loop to a long hot water run to allow for pipe expansion and contraction as the pipe heats during water flow.

1 Select a segment of the plumbing run, and click Plumbing Line tab ➤ Modify panel ➤ Add Expansion Loop .

**IMPORTANT** If you add an expansion loop after performing size calculations, you need to resize the plumbing run.

2 Specify the start point for the expansion loop.
3 Specify the second point for the expansion loop.
4 Specify the distance away from the run to place the expansion loop.
5 Specify the side of the run on which to place the expansion loop.

Adding an expansion loop

1. Select plumbing line
2. Specify first expansion loop point
3. Specify second expansion loop point
4. Specify expansion loop distance
5. Specify side for expansion loop
6. Resulting expansion loop
Modifying Plumbing Systems

The topics in this section describe how to modify plumbing system designs. AutoCAD MEP lets you modify your plumbing system designs with grip controls in the drawings as well as various tools.

Modifying Plumbing Equipment and Fixtures

After you have finished the plumbing system layout and checked the calculations for the final design, typically you verify the plumbing equipment and fixtures in the drawing and, if necessary, make additions or modifications. You might also need to do this during the design process due to changes in the requirements.

Changes to equipment or fixtures might require changes to connecting plumbing lines. For information on modifying plumbing lines, see Modifying Plumbing Lines and Fittings Using Grips on page 743 or Modifying Plumbing Lines and Fittings on page 746.

RELATED See Mechanical, Electrical, and Plumbing Equipment in Building Systems on page 110.

To modify plumbing equipment or fixtures

1 Select the part to modify and click Equipment tab ➤ Modify panel ➤ Modify Equipment ➤.
2 In the Multi-view Part Modify dialog, on the Part tab, under All Installed MvParts, specify a part. Expand subfolders as needed.
3 Specify a part size for Part Size Name.

NOTE The part size name list displays the available part sizes in the range of the current part. If the part size is not available, proceed to the next step to specify filters and ranges.

4 On the Part Filter tab, under Connections, for Nominal Connection, select a size range (such as in this format: 4-72). To filter the number of sizes available for viewing, for Display, enter a number within the allowable range.

Shows Display filter

Display: 9 of 16 parts
5 Under the part graphic, click << or >> to step through the available part size names in the selected range. Select a size for Part Size Name.

Shows MvPart graphic with Show

6 Specify an elevation.

NOTE When changing the elevation for an MvPart that is connected to other objects, the objects remain connected and are placed at the new elevation.

7 If you are modifying a fixture, click the Fixture Units tab and specify the following:
   ■ a fixture unit table for Fixture Unit Table.
   ■ a fixture type for Fixture.
   ■ an occupancy type (public or private) for Occupancy.

NOTE The software applies a default fixture unit value to each connector on the fixture based on the system type of the connector and the property values specified on the Fixture Unit Table worksheet. The default values are correct for most design situations. However, you should examine the values and modify them if necessary. If you subsequently perform plumbing line sizing, the software uses the applied fixture unit values in the calculations.
Calculating the Slope of a Plumbing Line

You can calculate the start elevation, end elevation, or slope of a plumbing line using the plumbing line slope tool.

**NOTE** Since plumbing lines are 2-dimensional (2D) only, the information provided by the plumbing line slope tool is for calculation purposes only.

To use the plumbing line slope tool, you need to enter at least 1 of the following values for the plumbing line to be calculated:

- Start point
- End point
- Slope

**To calculate the slope of a plumbing line**

1. Select the plumbing line segment.
2. Click Analyze tab ➤ Plumbing panel ➤ Slope Plumbing <.
   
A green dot indicates the start of the selected plumbing line. A red dot indicates the end.

![Plumbing Line Slope](image-url)
3 You can redefine the start point or the end point of the plumbing run.
   In the Plumbing Line Slope dialog, click Select Start Point of Run or Select End Point of Run.

4 In the drawing area, click a new start point or end point for the selected plumbing run.

5 For Calculation, select the parameter you want to calculate.

6 Enter the corresponding values for the selected calculation:
<table>
<thead>
<tr>
<th>If you want to Calculate</th>
<th>then enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Elevation</td>
<td>end elevation and slope</td>
</tr>
<tr>
<td>End Elevation</td>
<td>start elevation and slope</td>
</tr>
<tr>
<td>Slope</td>
<td>start elevation and end elevation</td>
</tr>
</tbody>
</table>

7 Press Tab to perform the calculation and then click OK.
NOTE The slope and elevation of any connected branch lines or MvParts will not change when you modify the slope of a plumbing line. The connected elements will remain connected to the modified plumbing line.

Modifying Plumbing Lines and Fittings Using Grips

You can use grips to modify components in a plumbing run including:

- Location grips
- Lengthen grips
- Rotate grips

Moving Plumbing Lines and Fittings

1. Select the part or plumbing line segment.
2. Select the Location grip to use.
3. If the part or plumbing line segment is connected to another object, specify whether and how to maintain connectivity:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>maintain connectivity by adjusting only plumbing fittings and segments, and retain the current locations of MvParts</td>
<td>proceed to the next step.</td>
</tr>
<tr>
<td>maintain connectivity by adjusting all objects, including MvParts</td>
<td>press Ctrl.</td>
</tr>
<tr>
<td>break connectivity</td>
<td>press Ctrl twice.</td>
</tr>
</tbody>
</table>
Specify the new location:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify the new location relative to the current location</td>
<td>for an offset in the X direction, move the part in the direction of its new location, and enter the offset distance. For an offset in the Y direction, press Tab to toggle to the Y offset, and enter the offset distance.</td>
</tr>
<tr>
<td>manually specify the new location</td>
<td>Move the cursor to the new location, and click. You can use object snaps, AutoCAD MEP snaps, and tracking lines to help you specify the new location point.</td>
</tr>
</tbody>
</table>

**NOTE** To use the dimension input fields, both dynamic input (on the status bar) and the Dimension Input drafting option must be selected, which is the default setting. If you have deselected them, you can specify the new location by moving the cursor and clicking a point in the drawing, or by entering the coordinates in the command window.

You can also modify the location of a plumbing line or fitting using the Properties palette. For more information, see Modifying the Location Coordinates of a Plumbing Line or Fitting on page 748. For examples showing how to move a plumbing line or an MvPart, see Associative Movement on page 701.

**Modifying the Length of Plumbing Lines**

1. Select the plumbing line segment.
2. Select the **Lengthen grip** on the end you want to modify.
3. If the segment is connected to an object on the end you selected, specify whether and how to maintain connectivity:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>maintain connectivity by adjusting only plumbing fittings and segments, and retain the current locations of parts</td>
<td>proceed to the next step.</td>
</tr>
</tbody>
</table>
If you want to... then...

maintain connectivity by adjusting all objects, including parts press Ctrl.

break connectivity press Ctrl twice.

4 Specify the segment length:

If you want to... then...
specify the new total length press Tab to activate the input field for specifying the resulting dimension, and then enter the new length.

specify the difference between the current length and new length drag the cursor to begin lengthening or shortening the segment, and then enter the change in length in the input field that is active by default.

specify a new end point drag the grip to the desired end point location, and click to specify the point.

NOTE To use the dimension input fields, both dynamic input (on the status bar) and the Dimension Input drafting option must be selected, which is the default setting. If you have deselected them, you can specify the new length by moving the cursor to a stretch point in the drawing or by entering the coordinates in the command window.

Rotating Plumbing Fittings

1 Select the object to be rotated.
2 Rotate the object:

If you want to... then...

rotate the object 180 degrees (flip the object) click the Rotate grip .

NOTE To use the dimension input fields, both dynamic input (on the status bar) and the Dimension Input drafting option must be selected, which is the default setting. If you have deselected them, you can specify the new length by moving the cursor to a stretch point in the drawing or by entering the coordinates in the command window.
If you want to... | then...
---|---
rotate the object 90 degrees | while pressing CTRL, click the Rotate grip.

**Modifying Plumbing Lines and Fittings**

The topics in this section describe how to modify plumbing lines and fittings using the Properties palette.

**Modifying the System Assigned to a Plumbing Line or Fitting**

When you change the system assigned to a plumbing line or fitting, the software applies the change to all components having valid connections to the selected segment.

To change the system of a plumbing line or fitting

1. Select a segment or plumbing fitting in the plumbing run in your drawing.
2. Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Properties.
3. On the Design tab of the Properties palette, under System, specify a different system.

**NOTE** Alternatively, you can select a plumbing line, click Plumbing Line tab ➤ Modify panel ➤ Modify Plumbing Line , and select a different system in the Modify Plumbing Lines dialog box.

**NOTE** The plumbing line system determines the system type (i.e., Cold Water, Waste, or Fire Protection) and the associated fittings that the software inserts when necessary. Systems help maintain consistency throughout a run and across multiple drawings in a project. For more information on systems, see Configuring Plumbing System Definitions on page 717.
Reversing the Flow of a Plumbing Run

When you reverse the flow of a plumbing run, you cannot see the change in direction unless flow arrows are applied to the run. However, you can determine it by looking at the sweep on the sanitary tees.

To reverse the flow of a plumbing run

1 Select a segment on the plumbing run in your drawing.
2 Click Plumbing Line tab ➤ Calculation panel ➤ Reverse Flow.

For information on applying flow arrows as you draw, see Specifying Plumbing Preferences for Labels and Flow Arrows on page 727.

NOTE Reversing the flow of a plumbing run does not propagate to the connected objects. If you reverse the flow of a plumbing run after performing sizing calculations, you need to resize the run.

Modifying the Elevation of a Plumbing Line or Fitting

Plumbing lines are two-dimensional (2D). Therefore, the elevation of a plumbing line or fitting is for calculation purposes only.

To modify the elevation of a plumbing line

1 Select the plumbing line or the plumbing fitting in your drawing.
2 Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Properties.
3 On the Design tab of the Properties palette, under Placement, specify a different value for Elevation.
4 Under Slope, specify values for Rise, Run, and Slope (%).

NOTE Alternatively, you can select a plumbing line, click Plumbing Line tab ➤ Modify panel ➤ Modify Plumbing Line ➤ Modify Plumbing Lines, and change the setting for Elevation, Rise, Run, and Slope in the Modify Plumbing Lines dialog.

Changing the elevation of a plumbing line or plumbing fitting might break the corresponding connection to other components. As a result, you should check for disconnections. Changing the
elevation of a plumbing line might also change the elevation of connected objects on the same level.

5 Click View tab ➤ MEP View panel ➤ Solution Tips.

For more information on solution tips, see Showing Solution Tips on page 862.

6 If necessary, reconnect disconnected components in the run by adding connecting segments, changing the elevation of segments, or moving or lengthening components. You can recreate valid connections using AutoCAD MEP snaps.

Modifying the Location Coordinates of a Plumbing Line or Fitting

The preferred method for moving plumbing lines and fittings is to use location grips. However, you can also modify the location of a plumbing line using the Properties palette.

To change the location coordinates

1 Select the plumbing line in your drawing that you want to modify.
2 Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Properties.
3 On the Design tab of the Properties palette, under Placement ➤ Elevation, click Additional Information.
4 In the Location dialog, specify the placement or orientation changes.

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify a new location</td>
<td>under Insertion Point, specify the new X, Y, and Z coordinates, and click OK.</td>
</tr>
<tr>
<td>change the normal axis, and reorient the part along the new normal</td>
<td>under Normal, specify 1 for the normal axis and 0 for the other 2 axes, and click OK.</td>
</tr>
</tbody>
</table>

**IMPORTANT** Using this method to modify the location coordinates of a plumbing line will cause the plumbing line to disconnect from any plumbing runs to which it is currently connected.
Modifying the Nominal Size of a Plumbing Line Segment

1 Select the plumbing line segment in your drawing.
2 Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Properties.
3 On the Design tab of the Properties palette, under Dimensions, specify a different nominal size.
4 Specify a new size for Nominal Size.

**TIP** You can lock Nominal size. When locked, the nominal size list is inactive and the associated diameter cannot be modified. You can, however, still modify the length or elevation of a plumbing object. To turn off a size, unlock this setting on the Properties palette.

**NOTE** Alternatively, you can select a plumbing line, click Plumbing Line tab ➤ Modify panel ➤ Modify Plumbing Line , and change the setting for Nominal Size or lock the setting.

The plumbing line style determines the appearance and function of the line, including size. As a result, the defined plumbing line style dictates the nominal sizes that are available for selection on the Properties palette.

**NOTE** Since plumbing lines are two-dimensional (2D) only, the size of a plumbing line is for calculation purposes only. Changing the size of a plumbing line does not automatically insert the necessary fitting.

Modifying the Style of a Plumbing Line or Fitting

1 Select the plumbing line or plumbing fitting in your drawing.
2 Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Properties.
3 On the Design tab of the Properties palette, under Style, specify a different style.

**NOTE** Alternatively, you can select a plumbing line and click Plumbing Line tab ➤ Modify panel ➤ Modify Plumbing Line , to change the setting for Style.
Plumbing line styles are based on information such as the size, type, and gauge of the material (i.e., Schedule 40 Carbon Steel or Copper Tube). Plumbing fitting styles are based on information such as type (i.e., tee, cross, trap, or check valve) and subtype (i.e., 45-degree mitered, 90 degree long-radiused, or 3-way). The style determines the appearance and function of the plumbing fitting. For more information on styles, see Configuring Styles for Plumbing Lines and Fittings on page 722.

Calculating the Sizes of Supply Plumbing Lines

Before you size a supply plumbing system, you should:

■ Complete a draft of the system.

■ Verify the accuracy of the fixture unit table you are using. For more information, see Configuring Fixture Unit Tables on page 720.

■ Create a sizing table for supply plumbing lines based on applicable codes, such as the Uniform Plumbing Code, or verify the accuracy of the table you are using. For more information, see Specifying Plumbing Line Sizing Tables on page 721.

NOTE You can only size supply plumbing systems whose system type is Hot Water or Cold Water.

Sizing Supply Plumbing Lines

WARNING If you make any modifications to the supply system, you need to resize the plumbing lines.

1 Complete a draft of the supply system.

2 Select a run whose system type is Hot Water or Cold Water. When you select the run, specify the point on the run at which to find the flow rate, velocity, and plumbing line diameter.

3 Click Plumbing Line tab ➤ Calculation panel ➤ Size Plumbing Line .

NOTE To calculate sizing values without resizing the run, access the sizing calculator by clicking Analyze tab ➤ Plumbing panel ➤ Size Plumbing , and then press ENTER at the command prompt.
The software highlights all plumbing lines, fittings, and fixtures connected to, and downstream from, the plumbing line, as illustrated in the following drawing.

4 In the Size Supply Plumbing Line dialog, under Design Values, define the following sizing parameter values:

**Equivalent Plumbing Line Length for the Valves and Fittings**

For Plumbing Line Sizing Table, select the plumbing line sizing table definition that you created based on applicable codes, such as the Uniform Plumbing Code, and verify its accuracy.

**TIP** To examine the table definition in order to verify its accuracy, click the Plumbing Line Sizing Table icon.

**Appropriate Plumbing Line Size**

Select Restrict Velocity, and enter the maximum velocity that you want in the run. This setting ensures that the plumbing line does not exceed a certain value, thus avoiding issues such as water hammer.

**Amount of Water Pressure Coming into the Building**

Enter a value for Pressure at Source. For example, the pressure at the source of the building could originate from a booster pump.
Minimum Amount of Pressure

Enter a value for Pressure-Highest Fixture. For example, a third-floor toilet fixture at an elevation of 80 feet might require 15 psi in order to flush. This setting ensures that the minimum amount of pressure to be supplied to the highest-level fixture in the supply run will guarantee an adequate flow.

For more information on the parameters involved in sizing plumbing lines, see Design Values for Supply Plumbing Line Sizing on page 715.

The non-editable sections in the Size Supply Plumbing Line dialog contain the results of the sizing calculations. For more information, see Reviewing the Sizing Results for Supply Plumbing Lines on page 752.

5 Click OK to resize the system.

Reviewing the Sizing Results for Supply Plumbing Lines

Two sections of the Size Supply Plumbing Line dialog provide you with final calculations:

- Calculations for the Longest Run
Calculations at Selected Component

Calculations for the Longest Run

When you select a supply system to size, the plumbing module highlights all plumbing lines, fittings, and fixtures connected to, and downstream from the specific plumbing line you select. It then identifies the longest run in the system by calculating the equivalent plumbing line lengths of all connected fixtures, fittings, and valves.

The longest run is defined as the longest run in an entire network of connected runs in a system. It is the main run used to determine the sizing requirements. Typically, it connects the booster pump to the limiting fixture (the fixture located at the highest elevation in the building).

The Calculations for the Longest Run section of the Size Supply Plumbing Line dialog contains the non-editable, calculated values for the longest run.

Calculations for the Longest Run section

Reviewing the Sizing Results for Supply Plumbing Lines | 753
Developed Length

Developed Length is the length of the longest run, including the equivalent length of the fittings. The plumbing module passes through the entire plumbing system to obtain the plumbing line length of each fixture. The program then refers to the supply plumbing line sizing table (pipe sizing table) that you selected. The sizing table provides the equivalent plumbing line length values associated with each fitting and valve on the run, so that these values can be included in the calculation. The run that has the highest value for the equivalent plumbing line length is considered to be the limiting run, or the run that requires the most resistance.

Elevation Difference

Elevation Difference is the difference in height between the highest elevation and the lowest elevation in the run. For example, if the run is laid out from a fixture at an elevation of 2'-0" to the main run entering the building at an elevation of 6", then the difference in elevation is 1'-6".

Pressure Drop

Pressure Drop displays the loss of pressure between the limiting fixture and the source, typically a booster pump.

The pressure drop uses the calculated elevation difference, also known as head loss, and adds this value to the total friction loss in the limiting run.

The plumbing module uses the following formula to calculate this value:
Pressure Drop = Head Loss + Friction Drop

The formula is defined as follows:

- Pressure Drop is head loss plus friction drop.
- Head Loss is the elevation difference.
- Friction Drop is the friction loss for the limiting run.

To calculate the friction loss, the plumbing module uses the Hazen-Williams formula:

\[ F = 0.2083 \left( \frac{100}{C} \right)^{1.852} x \left( \frac{d^{1.852}}{C^{4.1855}} \right) \]
The Hazen-Williams formula is defined as follows:

- **F** is friction drop for the longest run per 100 feet (or per 100 meters) of pipe (plumbing line).
- **C** is the inside pipe roughness or friction loss coefficient. The default value is 100.
- **q** is the total flow of the downstream fixture units measured in gpm (or L/s).
- **d** is the inside diameter of the pipe.

**Downstream Fixture Units**

Downstream Fixture Units displays the calculated value of all connected fixtures in the selected system.

To calculate the downstream fixture units value, the plumbing module totals the required fixture units for all connected fixtures on the run that you select.

**Calculations at Selected Component**

When you select a plumbing line in the supply run to size, you specify the point on the run at which the software calculates the flow rate, velocity, and plumbing line diameter. For example, to find the flow rate of the source, you would select the plumbing line closest to the booster pump.

The Calculations at Selected Component section of the Size Supply Plumbing Line dialog contains the non-editable, calculated values for the selected component.

**Calculations at Selected Component section**

<table>
<thead>
<tr>
<th>Calculations at Selected Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow Rate: 1.51 gpm</td>
</tr>
<tr>
<td>Actual Velocity: 2.7 m/s</td>
</tr>
<tr>
<td>Plumbing Line Diameter: 2.5</td>
</tr>
</tbody>
</table>

**Flow Rate**

Flow Rate represents the amount of fluid that travels through the plumbing line that you selected over a period of one minute. The plumbing module calculates the flow rate using the plumbing line diameter and friction loss values. The plumbing module estimates the flow rate using Hunter’s Curve (mixed), which takes into consideration fixtures that only periodically require...
a specific amount of flow. Therefore, the plumbing line is not sized based on the total amount of flow required by all fixtures, but rather on the expected flow based on the probability that each fixture is being used. The calculated value is then used as a basis for the Hazen-Williams formula. The result is the flow rate displayed in the Size Supply Plumbing Line dialog.

Following is the Hazen-Williams formula:

\[ F = 0.2083 \left( \frac{100}{C} \right)^{1.852} \times \left( \frac{q^{1.857}}{d^{4.1866}} \right) \]

The Hazen-Williams formula is defined as follows:

- F is friction drop for the longest run per 100 feet (or per 100 meters) of pipe (plumbing line).
- C is the inside pipe roughness or friction loss coefficient. The default value is 100.
- q is the total flow of the downstream fixture units measured in gpm (or L/s).
- d is the inside diameter of the pipe.

**Actual Velocity**

Actual Velocity is the speed at which the fluid travels through the plumbing line you selected and is based on the calculated values for the plumbing line diameter and minimum friction loss.

The plumbing module uses the following formula to calculate the actual velocity:

\[ V = \frac{Q}{A} \]

The formula is defined as follows:

- V is velocity.
- Q is flow rate.
- A is the inside cross-sectional area of the plumbing line.

The inside cross-sectional area is calculated as follows, where d is the inside diameter of the plumbing line.

\[ A = \frac{\pi d^2}{4} \]
Plumbing Line Diameter

Plumbing Line Diameter displays the diameter necessary to accommodate the flow rate and velocity of the selected plumbing line. The plumbing module estimates the size of each plumbing line at 8 feet per second.

The following information outlines how the plumbing line diameter is calculated:

- The plumbing module calculates the pressure available for friction loss throughout the supply system by subtracting Pressure at Source from Pressure of the Highest Fixture, minus Pressure Drop, minus Friction Loss-Water Meter.

- If the available pressure drop is insufficient, then the plumbing module increases the size of all the components in the run by one size (all sizes go up one plumbing line size) and recalculates Pressure Drop.

- If the Restrict Velocity option is enabled and the calculated actual flow velocity exceeds the restricted velocity, then the plumbing module increases the size of the run by one plumbing line size and recalculates Pressure Drop.

Once the plumbing module has found the correct plumbing line size, the corresponding standard nominal size is found from the calculated standard inside diameter. To view the size iterations used by the plumbing module, see the Standard Plumbing Line Sizing table in the following section.

Standard Plumbing Line Sizing Table

Use the following table as a reference for standard sizing calculations of plumbing lines. All values of d, the inside diameter of the pipe (plumbing line), are in inches and are based on a Schedule 40 Steel Pipe gauge. To size the plumbing line, the calculation rounds up to the nearest standard size. The plumbing module assumes that all plumbing lines being sized are similar to Schedule 40 Standard Steel Pipe when determining an inside diameter.

<table>
<thead>
<tr>
<th>If the nominal size is...</th>
<th>then the inner diameter is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.125</td>
<td>0.269</td>
</tr>
<tr>
<td>0.25</td>
<td>0.364</td>
</tr>
<tr>
<td>0.375</td>
<td>0.493</td>
</tr>
</tbody>
</table>

Reviewing the Sizing Results for Supply Plumbing Lines | 757
If the nominal size is... | then the inner diameter is...
---|---
0.5 | 0.622
0.75 | 0.824
1 | 1.049
1.25 | 1.380
1.5 | 1.610
2 | 2.067
2.5 | 2.469
3 | 3.068
3.5 | 3.548
4 | 4.026
5 | 5.047
6 | 6.065
8 | 7.981
10 | 10.02
12 | 12.000
14 | 13.250
16 | 15.250
18 | 17.250
20 | 19.250
22 | 21.250
24 | 23.250
If the nominal size is... | then the inner diameter is...
---|---
26 | 25.250
28 | 27.250
30 | 29.250
32 | 31.250
34 | 33.250
36 | 35.250

How the Software Performs Calculations to Size Plumbing Lines

The following is for informational purposes only.

1 Determine the friction loss.

The plumbing module determines the friction loss of the run using the Hazen-Williams formula.

\[ F = 0.2083 \left( \frac{100}{C} \right)^{1.852} \times \frac{q^{1.852}}{d^{4.865}} \]

The Hazen-Williams formula is defined as follows:

- \( F \) is friction drop for the longest run per 100 feet (or per 100 meters) of pipe (plumbing line).
- \( C \) is the inside pipe roughness or friction loss coefficient. The default value is 100.
- \( q \) is the total flow of the downstream fixture units measured in gpm (or L/s).
- \( d \) is the inside diameter of the pipe.

2 Calculate the change in elevation.

The plumbing module calculates the change in elevation for the limiting run by subtracting the value of the Highest Fixture from the Pressure at Source.
3 Determine the total pressure drop.
   The plumbing module determines the total pressure drop for the run as follows:
   \[ \text{Total Pressure Drop} = \text{Friction Loss} + \text{Elevation Change} \]

4 Determine the available pressure for Friction Loss.
   The plumbing module determines the pressure available for the Friction Loss by subtracting the Pressure at Source from the Pressure at the Highest Fixture, minus Pressure Drop, minus Friction Loss-Water Meter.

5 Compare the Pressure Drop to the Pressure Available.
   The plumbing module then compares the Pressure Drop to the Pressure Available. These values need to be equal to or greater than the available pressure. If the values do not match because the pressure available is insufficient, then the plumbing module increases the size of the run by one plumbing line size (all sizes go up one size) and recalculates the pressure drop.

6 Display the results.
   When the calculations are completed, the plumbing module displays the calculated values in the Size Supply Plumbing Line dialog. For more information, see Reviewing the Sizing Results for Supply Plumbing Lines on page 752.

---

**Calculating the Sizes of Sanitary Plumbing Lines**

Before you size a sanitary system, you should:

- Complete a draft of the system.
- Verify the accuracy of the fixture unit table you are using. For more information, see Configuring Fixture Unit Tables on page 720.
- Create a sizing table for sanitary plumbing lines based on applicable codes, such as the Uniform Plumbing Code, or verify the accuracy of the table you are using. For more information, see Specifying Plumbing Line Sizing Tables on page 721.

**NOTE** You can only size sanitary plumbing systems whose system type is Waste.
Overview of Sizing Sanitary Plumbing Lines

You can only size sanitary systems whose system type is Waste. For example, if you create system definitions for sanitary black water and sanitary gray water, you must define the system type as Waste. Otherwise, you cannot size the systems. For information on creating system definitions, see Configuring Plumbing System Definitions on page 717.

When you size a sanitary system, you can base the plumbing line sizing on 1 of 4 main types of runs:

- Branch
- Offset/Home Drains
- Stack Spanning 3 Stories or Less
- Stack Spanning More than 3 Stories

The type of run that you specify determines the sizing method that the software uses.

Sanitary Branch Sizing

When you define the sanitary run as a branch, the software performs the sizing calculations using the information on the Branches tab in the sanitary
plumbing line sizing table (pipe sizing table), whose definitions can be found in the Style Manager.

Sanitary Offset Sizing

When you define the sanitary run as an offset or a home drain, the plumbing module performs the sizing calculations using the information on the Offsets
Most sanitary systems are found in buildings that contain multiple floors. Each floor of the building is typically represented in a separate drawing. When sizing a sanitary system that spans multiple floors, you must size the plumbing lines for each drawing separately, starting from the highest floor and working downward. You can then reference the individual calculation values from the higher floors as you perform sanitary plumbing line sizing on the lower floors. For more information, see Sizing Sanitary Plumbing Lines for Multiple Floors on page 765.

The software does not distinguish between a horizontal offset and a horizontal branch. Therefore, you might want to create a style to represent a plumbing line that is a horizontal offset. For example, you could create a style called Black Pipe - Horizontal Offset, and select this style from the list on the Properties palette when you add the plumbing line.
Sanitary Stack Sizing

When you define your sanitary run as a stack spanning 3 stories or less, or more than 3 stories, the plumbing module performs the sizing calculations using the information on the Stacks tab in the sanitary plumbing line sizing table (pipe sizing table), whose definitions can be found in Style Manager.

Sizing Sanitary Plumbing Lines

Sanitary plumbing line sizing is typically required for sanitary black water system types. When you create sanitary system types for gray water, you need to define the system type as Waste in order for the sizing to work.

If you are working on a sanitary system in a building that contains multiple floors, see Sizing Sanitary Plumbing Lines for Multiple Floors on page 765.

WARNING If you make any modifications to the sanitary plumbing system, you need to resize the plumbing lines.
**To size sanitary plumbing lines**

1. Complete a draft of the sanitary system.
2. Select a run whose system type is Waste.

   **NOTE** You cannot size systems whose system type is Storm Drain.

   The software highlights all plumbing lines, fittings, and fixtures connected to, and downstream from the plumbing line.

3. Click Plumbing Line tab ➤ Calculation panel ➤ Size Plumbing Line.

   **NOTE** To calculate sizing values without resizing the run, access the sizing calculator by clicking Analyze tab ➤ Plumbing Panel ➤ Size Plumbing , and then press ENTER at the command prompt.

   The software displays the Size Sanitary Plumbing Line dialog.

4. In the Size Sanitary Plumbing Line dialog, under Design Values, select the plumbing line sizing table definition that you created based on applicable codes, such as the Uniform Plumbing Code. The software uses the table definition to determine the maximum permissible fixture unit loads for the type of run that you specify in the next step.

   **TIP** To examine the table definition in order to verify its accuracy, click the Plumbing Line Sizing Table icon.

5. Select a type of plumbing line for Base Sizing On. You can base the sizing on a branch, offset or home drain, or stack.

   The non-editable sections in the Size Sanitary Plumbing Line dialog contain the results of the sizing calculations. For more information, see Reviewing the Sizing Results for Sanitary Plumbing Lines on page 768.

6. Click OK to resize the system.

**Sizing Sanitary Plumbing Lines for Multiple Floors**

Most sanitary systems are found in buildings that contain multiple floors, and each floor of the building is typically represented in a separate drawing. When
sizing a sanitary system that spans multiple floors, you must size the plumbing lines for each drawing separately, starting from the highest floor and working downward. You can then reference the individual calculation values from the higher floors as you perform sizing on the lower floors.

**To calculate a sanitary system in a 3-story building**

1. Open the third-floor drawing and perform the following actions:

   ![Size Sanitary Plumbing Line](image)

   - **a** Click the plumbing line closest to the second floor riser to select the run to size for the third floor.
   - **b** Under Design Values, verify that Branch is selected for Base Sizing On.
   - **c** Make a note of the calculated value for Fixture Units Upstream. You need to know this value for the subsequent steps.
2 Open the second-floor drawing and perform the following actions:

- Click the plumbing line closest to the first floor riser to select the run to size for the second floor.
- Under Design Values, select Offset/Home Drains for Base Sizing On.
- Enter the Fixture Units Upstream value from the previous step for Fixture Units from Branches Connecting Outside of this Drawing. The selected run is sized appropriately, and the value for Size of Plumbing Line is updated accordingly.
- Make a note of the calculated value for Fixture Units from Upstream Stack. You need to know this value for next step.

3 Open the first-floor drawing and perform the following actions:

- Click the plumbing line closest to the end of the main run that discharges out of the building to select the run to size for the first floor.
- Under Design Values, select Offset/Home Drains for Base Sizing On.
- Add the values for the Fixture Units from Upstream for the third floor (first step) and the Fixture Units from Upstream Stack for the second floor (second step).
Enter the result for Fixture Units from Branches Connecting Outside of this Drawing. The selected run is sized appropriately, and the value for Size of Plumbing Line is updated accordingly.

Reviewing the Sizing Results for Sanitary Plumbing Lines

The lower, non-editable sections of the Size Sanitary Plumbing Line dialog provide you with the final sizing calculations.

Sanitary Branch Sizing

If you based the sizing on branches, the Size Sanitary Plumbing Line dialog displays the results of the sizing for the branches in the drawing.

The Fixture Units Upstream value is the result of all connected fixtures in the drawing. This value assumes that all connected fixtures are in the current drawing. Once the Fixture Unit Upstream value is defined, the software calculates the value for Size of Branch.
Sanitary Offset Sizing

If you based the sizing on offsets or home drains, the Size Sanitary Plumbing Line dialog displays the results of the sizing for the offsets and home drains in the drawing.

The Fixture Units from Upstream Stack value is the result of all connected fixtures in the drawing. To calculate this value, in Fixture Units from Branches Connecting Outside of this Drawing, enter the calculated sum from the floor above. When working with a multiple story building, the drawing for each floor in the sanitary waste system should be saved in a separate file and must be calculated separately. For more information, see Sizing Sanitary Plumbing Lines for Multiple Floors on page 765.

Once the Fixture Unit Upstream Stack value is defined, the software calculates the value for Size of Plumbing Line. You can also view the slope of the selected plumbing line in Slope of Plumbing Line.

<table>
<thead>
<tr>
<th>Design Values</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td>Plumbing Line:</td>
</tr>
<tr>
<td>Base Sizing On:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Calculations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixture Units from Upstream Stack: 14</td>
</tr>
<tr>
<td>Fixture Units from Branches Connecting Outside of this Drawing: 28</td>
</tr>
<tr>
<td>Slope of Plumbing Line: 1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Calculations at Selected Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size of Plumbing Line: 100</td>
</tr>
</tbody>
</table>

Reviewing the Sizing Results for Sanitary Plumbing Lines | 769
Sanitary Stack Sizing

If you based the sizing on stacks, the Size Sanitary Plumbing Line dialog displays the results of the sizing for the stacks in the drawing.

The Fixture Units from Branches Connecting in this Drawing value is the result of all connected fixtures in the drawing. However, when working with a multiple story building, typically each floor is saved in a separate drawing file. To accurately size the sanitary system for each floor, you must size the sanitary system for each floor separately, working downward. For each floor, in Fixture Units from Branches Connecting Outside of this Drawing, enter the Fixture Units from Branches Connecting in this Drawing value from the floor above. For more information, see Sizing Sanitary Plumbing Lines for Multiple Floors on page 765.
A schematic drawing is a two-dimensional (2D), not-to-scale flow diagram that shows the logic and operation of a building system. You draft a schematic or single-line diagram of your system to use as a basis for your complete design layout, or to create plumbing riser diagrams or details associated with your design. Generally, drafting a schematic diagram is one of the first steps in the building systems design process; however, not every project requires a schematic diagram.

Schematic diagrams are useful, for example, for representing how air moves through a building’s heating system or how electrical power, or hot and cold water, are carried through a building. They can also show relationships between equipment and other components in a system. For example, a mechanical schematic diagram can identify the types of equipment required for a system and show the connecting duct or pipe.

Sample mechanical schematic diagram

You create a schematic diagram by connecting symbols with lines to show the basic function of the building system. The diagram typically includes little information about individual parts.

You can create schematic diagrams in an orthographic or an isometric view direction. The orthographic plan view drawing is the more common type of schematic diagram. The isometric
diagram is typically used for a complex layout that requires the representation of additional details.

**NOTE** Do not use a schematic diagram if you want to

- Create elevations or sections based on the drawing
- Use the duct sizing tools or plumbing sizing tools provided with AutoCAD MEP. To use these tools, create the system using ducts and duct fittings, or plumbing lines and plumbing fittings.

---

### About Schematic Diagrams

You draw schematic lines just as you draw regular lines in AutoCAD®, using AutoCAD MEP snaps and tooltips to help you. You add schematic symbols just as you add entities in AutoCAD, using an insertion point for placement and a rotation angle.

However, schematic lines and symbols are more powerful than AutoCAD lines and objects because they recognize the connection points built into each schematic symbol, enabling you to create an intelligent building system diagram.

**Connecting a schematic line to a schematic symbol**

![Diagram](image)

You can assign systems to schematic lines and symbols. Schematic systems store properties that remain constant for all lines and symbols within the schematic diagram. They enable the lines and symbols in a layout to act together as one by maintaining the same look and feel. For example, a layout of schematic symbols and lines can represent a mechanical air supply system, an electrical power supply system, or a cold water supply system. New lines and symbols inherit the current system’s property defaults, such as layer and color, providing a consistent method of drafting the schematic diagram. For more information, see Working with Systems on page 138.
Schematic Lines

You can create schematic lines from AutoCAD® lines, arcs, or polylines.

In addition to assigning systems to schematic lines, you can create schematic line styles to distinguish between different system types. Schematic line styles specify how crossing lines are displayed, the symbol used to represent a connection point, and the list of available designation IDs, among other properties.
Schematic Symbols

AutoCAD MEP provides an extensive library of schematic symbols that snap together to represent the connectivity and logical dependencies of real-world parts and equipment. Schematic symbols are style-based content defined by a variety of style properties. Style properties specify the behavior of each schematic symbol, such as how lines that connect to the symbol are trimmed. For more information, see Configuring Styles on page 896.

There are 2 types of schematic symbols:

- **In-line symbols.** These symbols can be anchored anywhere along a schematic line. Fittings, valves, gauges, and controls such as switches, signals, and devices are examples of in-line symbols. These symbols are attached to the line. They move when the line is moved, and they are erased when the line is erased. You can also relocate the symbol by moving the symbol along the schematic line.

Inserting a schematic symbol into a schematic line

![Diagram showing how to insert an in-line symbol](image)

- **End-of-line symbols.** These symbols typically appear at the start or end of a schematic line. An end-of-line symbol needs to be placed first and then connected to a schematic line. Equipment such as diffusers, pumps, fans, and tanks are examples of end-of-line symbols. End-of-line symbols move with the schematic line, and if the symbol moves the line is stretched with it. End-of-line symbols are not erased when the line is erased, and the line and the symbol can be erased individually.

Connecting a schematic line to a schematic symbol

![Diagram showing how to connect a line to a symbol](image)

For more information on anchors, see Working with Anchors on page 176.
Schematic symbols are organized into categories by type to make them easy to find. You can add, delete, and rename categories to customize the organization of the schematic symbols to meet your needs. You can also create custom schematic symbols or symbol libraries to match company standards or specific project requirements. For more information, see Customizing Style-Based Content on page 891.

**Drawing in Orthographic Mode**

You can draw a schematic diagram in orthographic (plan) mode. Orthographic mode enables you to draw the diagram in a 2D plan view.

When you draw in orthographic mode, you add schematic lines and symbols in the world coordinate system (WCS). In the WCS, the X axis is horizontal, the Y axis is vertical, and the Z axis is perpendicular to the XY plane.

**Orthographic drawing parameters**

As you add or move lines or symbols, you can use several tools to restrict cursor movement:

- Use the **compass** to guide the placement of lines or symbols.
- Use the AutoCAD® Ortho mode to restrict the cursor to the horizontal or vertical axes. The orthogonal alignment depends on the current snap angle, or grid and snap settings.
- Use the grid to help you to align symbols and visualize the distances between them.
- Use snaps for specifying precise points for placement of symbols or lines.

You can turn these tools on or off at any time during drawing and editing. For more information, see Creating a Schematic Diagram on page 782.
Drawing in Isometric Mode

You can draw a schematic diagram in isometric mode. Isometric mode simulates a 3-dimensional (3D) plan view, where lines are drafted on rotated isopanes and symbols appear tilted along the isometric axes. This provides the illusion of a 3D view in a 2D model.

Isometric drawings simulate a 3D object from a particular viewpoint by aligning along 3 major axes. The Isoplane option on the Properties palette restricts cursor movement to appropriate rotated angles along isometric planes. You can work on one of 3 isometric planes, each with an associated pair of axes:

- **Left.** Aligns symbols and lines along 90-degree and 150-degree axes.
- **Top.** Aligns symbols and lines along 30-degree and 150-degree axes.
- **Right.** Aligns symbols and lines along 30-degree and 90-degree axes.

**Viewing isometric planes**

Choosing one of the 3 isometric planes causes the AutoCAD® Ortho mode and the crosshairs to be aligned along the corresponding isometric axes in the WCS. You can switch between planes as you draft. For example, you can start a run on the top plane, switch to the left plane to draw a riser, and then switch to the right plane to complete the run.

Although an isometric drawing appears to be 3D, it is actually a 2D representation. Therefore, you cannot extract 3D distances, display objects from different view ports, or remove hidden lines automatically.

For more information, see Creating a Schematic Diagram on page 782.
Customizing Schematic Content

Schematic lines and schematic symbols are style-based content. This means the objects are defined by styles, which are sets of properties and, for schematic symbols, also include associated view blocks to represent the symbol geometry. For a general introduction to style-based content, see Working with Style-Based Content on page 124.

You can manually create the styles that define schematic lines and symbols using Style Manager. For an overview of this process, see Workflow for Creating Style-Based Content on page 891.

Additionally, there are several ways to convert batches of objects to schematic symbol styles. You can

- Convert the schematic symbol styles provided with AutoCAD MEP to their individual components (the settings and the view blocks), customize the components, and then convert the components back to schematic symbol styles.

- Convert a batch of AutoCAD blocks in a custom block library to schematic symbol styles.

For more information, see Customizing Schematic Symbol Content on page 940.

Configuring Schematic Settings

If you take time to configure schematic settings prior to drawing schematic diagrams, you can lay out your designs more quickly and accurately. Schematic settings are stored in the Style Drawing, and you can import them into the current drawing or open the content drawings.

Creating Schematic System Definitions

A system definition is typically named for the system it will represent, such as return air, lighting, or domestic cold water. The settings for a system definition control many of the display properties of a system. For example, you can specify a layer key for a system, which determines the layer, color, and linetype for the system.

System definitions are stored in the drawing, and you can copy them between drawings.
TIP The default templates contain several system definitions that you can copy or modify.

To create a schematic system definition

1 In the Schematic workspace, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Schematic System Definitions.

2 Create the schematic system definition:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then in the left pane of Style Manager…</th>
</tr>
</thead>
<tbody>
<tr>
<td>create a new, blank system definition</td>
<td>right-click Schematic System Definitions, and click New. Enter a name, and press ENTER.</td>
</tr>
<tr>
<td>copy an existing definition, so you can modify the copy</td>
<td>do the following:</td>
</tr>
<tr>
<td></td>
<td>❘ Right-click the system definition you want to copy, and click Copy.</td>
</tr>
<tr>
<td></td>
<td>❘ Right-click Schematic System Definitions, and click Paste.</td>
</tr>
<tr>
<td></td>
<td>❘ Right-click the copy, click Rename, enter a new name, and press ENTER.</td>
</tr>
</tbody>
</table>

3 On the General tab, enter a description for the schematic system definition.

4 Specify values for the other properties of the system definition that are common to systems in all disciplines: mechanical, electrical, and plumbing. For help, see

- Specifying the Design Rules of a System on page 143
- Specifying the Display Properties of a System on page 146
- Attaching Notes and Files to a System on page 147

Configuring Styles for Schematic Lines

The styles for schematic lines and schematic symbols determine their appearance and function. For example, schematic line styles determine how crossing lines are displayed, the symbol used to represent a connection point, and the designations (IDs) to choose from when adding a schematic line.
NOTE  This section provides information that is specific to styles for schematic lines and schematic symbols. For general information on working with all types of styles, including those for schematic lines and schematic symbols, see Configuring Styles on page 896.

Defining Designations for Schematic Line Styles

When you draw a schematic line, you can select a designation for the line on the Properties palette. The designation is a text ID that helps you to identify the line in the layout. The style you select for the line determines the list of designation IDs from which you can choose; you can select an ID from the list or enter a different one.

Example designation IDs

To define designations for a schematic line style

1 Open the drawing that contains the style.
2 In the Schematic workspace, open the style by doing one of the following:
   ■ Click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Schematic Line Styles. In the left pane of the Style Manager, select the style.
   ■ In the drawing, select a schematic line that uses the style, and click Schematic Line tab ➤ General panel ➤ Edit System Style drop-down ➤ Edit Schematic Line Style.
3 Click the Designations tab.

![Designations tab](image)

4 Define the designations:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>add a designation</td>
<td>click $\circlearrowright$, click the Designation field, enter an ID, and press ENTER.</td>
</tr>
<tr>
<td>edit a designation</td>
<td>click the corresponding Designation field, edit the ID, and press ENTER.</td>
</tr>
<tr>
<td>delete a designation</td>
<td>select a designation, and click $\times$.</td>
</tr>
</tbody>
</table>

**Specifying Annotation for Schematic Line Styles**

When you draw a schematic line, you can select a style for the line on the Properties palette. The style determines the annotation properties for the line, such as the symbols used to represent start points, endpoints, and connections.

The style of a schematic line also determines how crossing lines are displayed. You can display crossing lines as is, or with an overlap or a break of a specific width.
If you select the overlap style or break style, you must also specify a corresponding priority value. In a drawing, if 2 crossing lines have the same priority value in their corresponding styles, the line with the lower Z-axis value will display the overlap or break. If the priority values are different, the priority values determine this. Refer to the following table for more information.

<table>
<thead>
<tr>
<th>If the crossing style of the 2 lines is...</th>
<th>And if the priority values of the 2 lines are...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>overlap</td>
<td>the same</td>
<td>the line drawn second displays the overlap.</td>
</tr>
<tr>
<td>break</td>
<td>the same</td>
<td>the line drawn first displays the break.</td>
</tr>
<tr>
<td>mixed (one is overlap, and the other is break)</td>
<td>the same</td>
<td>the line drawn second determines the crossing style to use. If the style is overlap, the line drawn second displays the overlap. If the style is break, the line drawn first displays the break.</td>
</tr>
</tbody>
</table>

**TIP** To change the draw order of a selected line, right-click, click Display Order, and select a command (for example, Send to Back) on the submenu.

**To specify annotation for a schematic line style**

1. Open the drawing that contains the style.
2. In the Schematic workspace, open the style by doing one of the following:
   - Click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Schematic Line Styles 📝. In the left pane of the Style Manager, select the style.
   - In the drawing, select a schematic line that uses the style, and click Schematic Line tab ➤ General panel ➤ Edit System Style drop-down ➤ Edit Schematic Line Style 📝.
3 Click the Annotation tab.

4 Under Crossings, select a style for crossing schematic lines. You can specify that the crossing lines are displayed as is, with an overlap, or with a break.

5 If you selected the overlap style or the break style, for Break/Overlap Paper Width, enter the width of the overlap or the break, and for Break/Overlap Priority, enter a number.

6 Under Connections, select a connection node symbol for line junctions, and enter a size.

7 Under Start & End Settings, select a symbol for the start and end of a line, and enter a size for each.

**Creating a Schematic Diagram**

You create a schematic diagram by connecting symbols with lines to show the basic function of a building system in the overall design. You drag and drop schematic symbols into a drawing and connect the symbols with schematic lines, drawing the schematic lines just as you draw lines in AutoCAD®. However, schematic lines and symbols are more powerful than AutoCAD lines and objects because they recognize the connection points built into each schematic symbol, enabling you to create an intelligent building system diagram.
Typically, you alternate between drawing schematic symbols and drawing schematic lines, essentially drafting them together. You can add freestanding or end-of-line symbols in a drawing and connect them later. For example, you can add a pump and connect the supply and return lines at a later time, or you can add a fan and connect the wire at a later time. You can also draft the lines first and then add in-line symbols. For example, you might add a duct heater that breaks into a run in a hot air system, or add a device after wire has been run to a panel.

You can draw a schematic diagram in orthographic (plan) or isometric on page 776 mode.

## Adding Schematic Lines in Orthographic Mode

When you are drawing in orthographic mode, you add schematic lines in the world coordinate system (WCS). In the WCS, the X axis is horizontal, the Y axis is vertical, and the Z axis is perpendicular to the XY plane.

You can use the compass to guide your placement of lines. You can also use the AutoCAD® Ortho mode to restrict the cursor movement to the horizontal or vertical axes. The orthogonal alignment depends on the current grid and snap settings. You can turn these tools on or off at any time.

**To add schematic lines in orthographic mode**

1. In the Schematic workspace, start the add command by doing one of the following:
   - Open a schematic tool palette, and select a schematic line tool. If necessary, scroll to display the tool. Because tools contain pre-configured properties for the objects they create, you might not need or be able to specify some of the schematic line properties referenced in this procedure.
   - Click Home tab ➤ Build panel ➤ Schematic Line ➤ .
   - Enter **slineadd**.
**NOTE** On the Properties palette, * indicates a property is available only when you are adding schematic lines, not when you are modifying them.

2 Expand Basic, and for Description, click , enter a description for the schematic line, and click OK.

3 For Style, select a schematic line style.
   You can select from the styles in the current drawing.

4 If you want to change the current system, for System, select the system to which the schematic line belongs.
   You can select from the systems in the current drawing. For more information on systems, see *Creating Schematic System Definitions* on page 777.

**TIP** You can create schematic line tools that reference styles and systems in content libraries (DWG files). For more information, see *Creating Tools for Style-Based Content* on page 1179.

5 For Orientation, select Ortho.

6 Expand Advanced, and for ID, select or enter an ID designation.
The currently selected schematic line style determines the list of available IDs. For more information, see Defining Designations for Schematic Line Styles on page 779.

7 In the drawing, specify the start point for the line, or use schematic AutoCAD MEP snaps to connect the line to a symbol or another line.

8 Continue to specify points to draw the schematic line.

9 If necessary, on the Properties palette, modify the schematic line properties, and add additional lines.

10 Press ENTER to end the add command.

**TIP** You can quickly connect existing schematic lines by extending or trimming them using the AutoCAD command FILLET.

---

**Adding Schematic Symbols in Orthographic Mode**

When you are drawing in orthographic mode, you add schematic symbols in the world coordinate system (WCS). In the WCS, the X axis is horizontal, the Y axis is vertical, and the Z axis is perpendicular to the XY plane.

You can use the compass to guide your placement of symbols. You can also use the AutoCAD® Ortho mode to restrict the cursor movement to the horizontal or vertical axes. The orthogonal alignment depends on the current grid and snap settings. You can turn these tools on or off at any time.

Schematic symbols are connected to lines with anchors. For more information, see Schematic Symbols on page 774.

**To add schematic symbols in orthographic mode**

1 In the Schematic workspace, start the add command by doing one of the following:

   ■ Open a schematic tool palette, and select a schematic symbol tool.
     If necessary, scroll to display the tool. Because tools contain pre-configured properties for the objects they create, you might not need or be able to specify some of the schematic symbol properties referenced in this procedure.

   ■ Select a schematic line, and click Schematic Line tab ➤ General panel ➤ Insert Symbol 🌟.
Click Home tab ➤ Build panel ➤ Schematic Symbol ➨.

Enter symboladd.

**NOTE** On the Properties palette, indicates a property is available only when you are adding schematic symbols, not when you are modifying them.

2 On the Properties palette, if necessary, specify or change the symbol to add by selecting a schematic symbol style:

<table>
<thead>
<tr>
<th>If you want to select a schematic symbol style…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>in the current drawing</td>
<td>expand Basic, and expand General. For Style, select the style.</td>
</tr>
<tr>
<td>in a drawing in the directory specified as the default content location for schematic symbols, or in the style drawing referenced in the properties of a tool you selected</td>
<td>on the General bar, click ➨. In the left pane of the Select Schematic Symbol worksheet, navigate to the drawing that contains the style, and select the drawing. In the right pane, select the style, and click OK.</td>
</tr>
</tbody>
</table>
3 For Description, click , enter a description for the schematic symbol, and click OK.

4 For System, select the system to which the schematic symbol belongs.
   You can select from the systems in the current drawing. For more information on systems, see Creating Schematic System Definitions on page 777.

5 If Orientation is enabled under Drawing Mode, select Ortho.

   NOTE If the style you selected does not have any defined isometric views, Orientation is read-only and set to Ortho. For information on creating views for styles, see Defining the Views of a Style on page 898.

6 For Justification, select the point on the symbol to use as the insertion point.
   You can select either the insertion point of the view block that represents the symbol, or one of 9 other points on the device, such as Top Left or Middle Center.

7 Expand Advanced, and for ID, enter the ID to use to identify this symbol.
   You can add the ID to your diagram as a label. The label style that you select when you add the label determines the font and size of the ID.

8 In the drawing, click to specify the insertion point.
   If you specify a point on a schematic line, the symbol breaks into and aligns with the line. It then behaves like an in-line symbol.

   TIP Use object snaps, such as Nearest or Midpoint, to help place schematic symbols.

9 Rotate the symbol into position, or enter the angle of rotation on the command line.
   Alternatively, to accept the default rotation, press ENTER.

   NOTE The rotation is applied only to end-of-line symbols. The rotation of an in-line symbol is determined by the schematic line into which it is inserted.
10 Repeat the previous 2 steps to insert additional symbols with the same properties.
You can also modify the properties on the palette, and then add additional symbols.

11 Press ENTER to end the add command.

**Adding Schematic Lines in Isometric Mode**

When you are drawing in isometric mode, you add schematic lines on one of the 3 isometric planes: left, top, or right. Each isometric plane has an associated pair of axes. Choosing an isometric plane causes the AutoCAD® Ortho mode and the crosshairs to be aligned along the corresponding isometric axes in the world coordinate system (WCS). Working in isometric mode is beneficial, for example, when creating electrical riser diagrams.

As you draw, you can switch between planes by selecting a different value for Isoplane on the Properties palette. Switching between planes enables you to draw a continuous isometric run, where segments are drafted both horizontally and vertically along the different isoplanes. For example, you might draw one segment on the top plane, switch to the left plane to draw a riser, and then switch to the right plane to complete the run.

**Drawing a schematic line on the left isoplane**

**Drawing a schematic line on the top isometric plane**
To add schematic lines in isometric mode

1 In the Schematic workspace, start the add command by doing one of the following:
   - Open a schematic tool palette, and select a schematic line tool. If necessary, scroll to display the tool. Because tools contain preconfigured properties for the objects they create, you might not need or be able to specify some of the schematic line properties referenced in this procedure.
   - Click Home tab ➤ Build panel ➤ Schematic Line.
   - Enter `slineadd`.

NOTE On the Properties palette, * indicates a property is available only when you are adding schematic lines, not when you are modifying them.
2 Expand Basic, and for Description, click ![enter description](image) enter a description for the schematic line, and click OK.

3 For Style, select a schematic line style. You can select from the styles in the current drawing.

4 For System, select the system to which the schematic line belongs. You can select from the systems in the current drawing. For more information on systems, see Creating Schematic System Definitions on page 777.

   **TIP** You can create schematic line tools that reference styles and systems in content libraries (DWG files). For more information, see Creating Tools for Style-Based Content on page 1179.

5 For Orientation, select Isometric.

6 For Isoplane, select the isoplane on which to start drawing: Left, Top, or Right.

7 Expand Advanced, and for ID, select or enter an identification label.

   The schematic line style that you select determines the list of available IDs. You can select an ID from the list or enter a different one. For more information, see Defining Designations for Schematic Line Styles on page 779.
8 In the drawing, specify the start point for the line, or use schematic AutoCAD MEP snaps to connect the line to a symbol or another line.

9 Continue to specify points to draw the schematic line.

10 To change isoplanes as you draw, on the Properties palette, select a different isoplane for Isoplane, and then continue to specify points to draw the line. The UCS icon and crosshairs adjust to the selected isoplane.

11 If necessary, on the Properties palette, modify the schematic line properties and add additional lines.

12 Press ENTER to end the add command.

**TIP** You can quickly connect existing schematic lines by extending or trimming them using the AutoCAD FILLET command.

---

**Adding Schematic Symbols in Isometric Mode**

When you are drawing in **isometric mode**, you add schematic symbols on one of the 3 isometric planes: left, top, or right. Each isometric plane has an associated pair of axes. Choosing an isometric plane causes the AutoCAD® Ortho mode and the crosshairs to be aligned along the corresponding isometric axes in the world coordinate system (WCS). Working in isometric mode is beneficial, for example, when creating electrical riser diagrams.

As you draw, you can switch between planes by selecting a different value for Isoplane on the Properties palette. Switching between planes enables you to continuously add end-of-line or in-line symbols on the different isoplanes. For example, you might add one symbol on a line on the top plane, switch to the left plane to add a symbol on a riser, and then switch to the right plane to add an end-of-line symbol to complete the run.
Adding a schematic symbol to the left isoplane

Adding a schematic symbol to the top isoplane

Adding a schematic symbol to the right isoplane

Schematic symbols are connected to lines with anchors. For more information, see Schematic Symbols on page 774.

To add schematic symbols in isometric mode

1 In the Schematic workspace, start the add command by doing one of the following:
   - Open a schematic tool palette, and select a schematic symbol tool.
If necessary, scroll to display the tool. Because tools contain preconfigured properties for the objects they create, you might not need or be able to specify some of the schematic symbol properties referenced in this procedure.

- Select a schematic line and click Schematic Line tab ➤ General panel ➤ Insert Symbol.

- Click Home tab ➤ Build panel ➤ Schematic Symbol.

- Enter symboladd.

NOTE On the Properties palette, indicates a property is available only when you are adding schematic symbols, not when you are modifying them.
2 On the Properties palette, if necessary, specify or change the symbol to add by selecting a schematic symbol style:

<table>
<thead>
<tr>
<th>If you want to select a schematic symbol style...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>in the current drawing</td>
<td>expand Basic, and expand General. For Style, select the style.</td>
</tr>
<tr>
<td>in a drawing in the directory specified as the default content location for schematic symbols, or in the style drawing referenced in the properties of a tool you selected</td>
<td>on the General bar, click . In the left pane of the Select Schematic Symbol worksheet, navigate to the drawing that contains the style, and select the drawing. In the right pane, select the style, and click OK.</td>
</tr>
</tbody>
</table>

**NOTE** Not all schematic symbols provided with the software have isometric views. Drawings containing symbols with both orthographic and isometric views are named accordingly.

3 For Description, click , enter a description for the schematic symbol, and click OK.

4 For System, select the system to which the schematic symbol belongs.

For more information on systems, see Creating Schematic System Definitions on page 777 and Working with Systems on page 138.

5 For Orientation, select Isometric, and for Isoplane, select the isoplane onto which to place the symbol.

**NOTE** If the style you selected does not have any defined isometric views, Orientation is read-only and set to Ortho. If this is the case, select a different style. For information on creating views for styles, see Defining the Views of a Style on page 898.

6 For Justification, select the point on the symbol to use as the insertion point.

You can select either the insertion point of the view block that represents the symbol, or one of 9 other points on the device, such as Top Left or Middle Center.
7 Expand Advanced, and for ID, enter the ID to use to identify this symbol.
You can add the ID to your diagram as a label. The label style that you select when you add the label determines the font and size of the ID.

8 In the drawing, click to specify the insertion point, which typically is a point on a schematic line.
If you specify a point on a line, the symbol breaks into and aligns with the line. It then behaves like an in-line symbol.

**TIP** Use object snaps, such as Nearest or Midpoint, to help place schematic symbols.

9 Rotate the symbol into position by doing one of the following:
- In the drawing, use the compass to rotate the symbol.
- On the command line, enter the angle of rotation, and press ENTER.
- Enter `is` (iso rotation), enter the orientation of the symbol within the isoplane (right, up, left, or down), and press ENTER.

Alternatively, you can press ENTER to accept the default rotation.

**NOTE** The rotation is applied only to end-of-line symbols. The rotation of an in-line symbol is determined by the line into which it is inserted.

10 Repeat the previous 2 steps to insert additional symbols with the same properties.

11 To change isoplanes as you draw, on the Properties palette, select a different isoplane for Isoplane, and then continue to add symbols.
The UCS icon and crosshairs adjust to the selected isoplane.

12 If necessary, on the Properties palette, modify the schematic symbol properties, and add additional symbols.

13 Press ENTER to end the add command.
Adding Schematic Lines Using Grips

Use the add grips on existing schematic lines or symbols to quickly and efficiently add schematic lines. The add grips are available in orthographic or isometric mode.

To add schematic lines using the add grip

1. Select a schematic line or symbol, and click the (+) Add grip.
2. Specify additional points for the schematic line layout geometry.
3. Press ENTER to end the command.

Creating a Schematic Line from an AutoCAD Line, Arc, or Polyline

You can create a schematic line from an AutoCAD® line, arc, or polyline.

To create a schematic line

1. Draw an AutoCAD line, arc, or polyline.
2. Right-click the object to convert, and click Convert to ➤ Schematic Line.
3. Do one of the following:
   ■ Press ENTER or enter n (no) to leave the layout geometry in the drawing.
   ■ Enter y (yes) to erase the layout geometry from the drawing.

The software displays the Modify Schematic Lines dialog.
4 In the Modify Schematic Lines dialog, specify a System, Style, and Designation ID.
You can also specify these properties on the command line. Enter sy (system), enter st (style), or enter i (designation ID).

**TIP** To assign the properties of an existing schematic line to the converted schematic line, enter m (match), select an existing schematic line, specify what properties to match, and then press ENTER.

---

**Modifying a Schematic Diagram**

After you add schematic lines and symbols to your drawing, you can edit their properties and make additional modifications. For example, you can move a schematic line or symbol, or assign the line or symbol to a different system.

**Associative Movement**

You can move schematic symbols or line segments without breaking their connections with the rest of the geometry. This feature is called associative movement. Used in conjunction with certain grips, associative movement enables you to move a schematic run component quickly and accurately.

For example, when you move a schematic symbol to a new location, the line segments attached to the symbol can move, shrink, or stretch to maintain a connection with the schematic layout. You can also move a schematic line segment without affecting the location of schematic symbols or other segments of the run.

**Modifying the Properties of a Schematic Line**

You modify the properties of schematic lines using the Properties palette. For general information on modifying object properties using the palette, see [Modifying Object Properties Using the Properties Palette](#) on page 136.

To modify the properties of schematic lines

1 Select the schematic lines.
2 On the Design tab of the Properties palette, modify the properties:

<table>
<thead>
<tr>
<th>If you want to modify...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the description</td>
<td>expand Basic ➤ General. For Description, click on the description, and click OK.</td>
</tr>
<tr>
<td>the layer on which the schematic lines are placed</td>
<td>for Layer, select a layer. You can select from the layers in the current drawing.</td>
</tr>
<tr>
<td>the style</td>
<td>for Style, select a style. You can select from the styles in the current drawing.</td>
</tr>
<tr>
<td>the system</td>
<td>expand System, and for System, select a new system. You can select from the schematic system definitions in the current drawing.</td>
</tr>
<tr>
<td>the location</td>
<td>click Additional information, enter the new coordinates for the insertion point on the Location worksheet, and click OK.</td>
</tr>
</tbody>
</table>

**NOTE** You can also move schematic lines using grips or the AutoCAD® MOVE command. For more information, see Moving Schematic Lines on page 800.

| the ID | expand Advanced ➤ Design Data. For ID, enter an ID. The selected style determines the list of available IDs. For information on defining IDs for schematic line styles, see Defining Designations for Schematic Line Styles on page 779. |

3 Press ESC.

**Modifying the Properties of a Schematic Symbol**

You modify the properties of schematic symbols using the Properties palette. For general information, see Modifying Object Properties Using the Properties Palette on page 136.
To modify the properties of schematic symbols

1 Select the schematic symbols.

2 If you want to change the style of the symbol, on the Properties palette, select a symbol style by doing one of the following:

<table>
<thead>
<tr>
<th>If you want to select a style</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>in the current drawing</td>
<td>expand Basic ➤ General. For Style, select the style.</td>
</tr>
<tr>
<td>in a drawing in the directory specified as the default content location for schematic symbols</td>
<td>under General, click [. In the left pane of the Select Schematic Symbol worksheet, navigate to the drawing that contains the style, and select the drawing. In the right pane, select the style, and click OK.</td>
</tr>
</tbody>
</table>

3 Modify additional properties as needed:

<table>
<thead>
<tr>
<th>If you want to modify...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the description</td>
<td>for Description, click [ to revise the description, and click OK.</td>
</tr>
<tr>
<td>the layer on which the schematic symbols are placed</td>
<td>for Layer, select a layer. You can select from the layers in the current drawing.</td>
</tr>
<tr>
<td>the system</td>
<td>expand System, and for System, select a new system. You can select from the schematic system definitions in the current drawing.</td>
</tr>
<tr>
<td>the orientation</td>
<td>expand Drawing Mode, and for Orientation, select Ortho or Isometric.</td>
</tr>
</tbody>
</table>

RELATED See also Moving Schematic Symbols on page 803 and Rotating Schematic Symbols on page 806.
<table>
<thead>
<tr>
<th>If you want to modify...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the isoplane (for isometric symbols only)</td>
<td>expand Drawing Mode, and for Isoplane, select an isoplane (isometric plane): Left, Top, or Right.</td>
</tr>
<tr>
<td><strong>NOTE</strong> You can also use grips to rotate the symbol around the 3 isoplanes; for more information, see Rotating Isometric Symbols on page 807.</td>
<td></td>
</tr>
<tr>
<td>the rotation (for orthographic, end-of-line symbols only)</td>
<td>expand Location, and for Rotation, enter the number of degrees.</td>
</tr>
<tr>
<td><strong>NOTE</strong> For information on rotating symbols, including in-line symbols, in other ways, see Rotating Schematic Symbols on page 806.</td>
<td></td>
</tr>
<tr>
<td>the location (for end-of-line symbols only)</td>
<td>click Additional information, enter new coordinates for the insertion point on the Location worksheet, and click OK.</td>
</tr>
<tr>
<td><strong>NOTE</strong> You can also move both end-of-line symbols and in-line symbols using Location grips. For more information, see Moving Schematic Symbols on page 803.</td>
<td></td>
</tr>
<tr>
<td>the ID</td>
<td>expand Advanced, expand Design Data, and for ID, revise the value for ID.</td>
</tr>
</tbody>
</table>

4 Press ESC.

### Moving Schematic Lines

You can move a schematic line by

- Selecting a grip and dragging it to a new location
- Using the AutoCAD® MOVE command
Entering new coordinate values for the insertion point of the line using the Properties palette. You can also use the palette to change the normal or the angle of rotation, as described later in this section.

When you move a schematic line, in-line schematic symbols that are anchored to the line are moved along the line.

To move a schematic line in orthographic mode using grips

1 Select the line.
2 Click the Location grip.
3 Move the line:
   If you want to...                then...
   use the grip point as the base point for the move  drag the line to a new location, and click.
   specify a base point, and then specify a second point  enter b (base point), specify the base point, and then specify the second point.

If the schematic line segment is not connected to another object, you can change both its length and angle using the Start grip or End grip. The Start grip and End grip only appear on the schematic line in orthographic mode.

![Start and End grips](image)

The Start and End grips enable you to change the XYZ location of the start point or end point of the segment. This is useful when you are initially designing runs because you can easily connect a segment to an existing run.

To move a schematic line in isometric mode using grips

In isometric mode, the Move Isoplane grip will move the schematic line in the direction which is perpendicular to the plane in which the schematic line lies.

1 Select the line.
2 Click the Move Isoplane grip.
3 Move the line:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>use the grip point as the base point for the move</td>
<td>drag the line to a new location, and click.</td>
</tr>
<tr>
<td>specify a base point, and then specify a second point</td>
<td>enter b (base point), specify the base point, and then specify the second point.</td>
</tr>
</tbody>
</table>

To move or rotate a schematic line using coordinate values

A schematic line has an orientation with respect to the world coordinate system (WCS) or the current user coordinate system (UCS). For example, if the schematic line is parallel to the XY plane, then its normal, or perpendicular, plane is parallel to the Z axis. You can change the orientation of the schematic line by aligning its normal with another axis, such as an isometric axis. You can also rotate the schematic line on its plane by changing the rotation angle.

1 Select the schematic line.

2 On the Properties palette, expand Basic. Under Location, click Additional information for the Location worksheet.

3 Specify the new location for the schematic line:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>relocate the schematic line</td>
<td>enter new coordinate values under Insertion Point.</td>
</tr>
<tr>
<td>If you want to…</td>
<td>then…</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------</td>
</tr>
<tr>
<td>locate the schematic line on the XY plane</td>
<td>make the normal of the schematic line parallel to the Z axis: under Normal, enter 1 for Z, and enter 0 for X and Y.</td>
</tr>
<tr>
<td>locate the schematic line on the YZ plane</td>
<td>make the normal of the schematic line parallel to the X axis: under Normal, enter 1 for X, and enter 0 for Y and Z.</td>
</tr>
<tr>
<td>locate the schematic line on the XZ plane</td>
<td>make the normal of the schematic line parallel to the Y axis: under Normal, enter 1 for Y, and enter 0 for X and Z.</td>
</tr>
<tr>
<td>change the rotation of the schematic line</td>
<td>under Rotation, enter a new value for Angle.</td>
</tr>
</tbody>
</table>

4 Click OK, and press ESC.

For information about the WCS and the UCS, see Use Coordinates and Coordinate Systems (UCS).

**Moving Schematic Symbols**

You can use grips to move orthographic and isometric schematic symbols along schematic lines and drawings. You can also use the AutoCAD® MOVE command for moving symbols not anchored to schematic lines.

**To move a schematic symbol in orthographic mode**

1 Select the symbol.

2 Click the Location grip .

3 Move the symbol:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>use the grip point as the base point for the move</td>
<td>drag the symbol to a new location, and click.</td>
</tr>
<tr>
<td>specify a base point, and then specify a second point</td>
<td>enter b (base point), specify the base point, and then specify the second point.</td>
</tr>
</tbody>
</table>
4 Press ESC.

To move a schematic symbol in isometric mode

In isometric mode, the Move Isoplane grip will move the schematic symbol in the direction which is perpendicular to the plane in which the schematic symbol lies.

1 Select the symbol.

2 Click the Move Isoplane grip.

3 Move the line:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>use the grip point as the base point for the move</td>
<td>drag the line to a new location, and click.</td>
</tr>
<tr>
<td>specify a base point, and then specify a second point</td>
<td>enter b (base point), specify the base point, and then specify the second point.</td>
</tr>
</tbody>
</table>

4 Press ESC.

NOTE You can also move end-of-line symbols by specifying a new insertion point on the Location worksheet. To access the worksheet, select the symbol, and click under Location on the Properties palette.

Modifying the Length of Schematic Lines

You can modify the length of schematic line segments using lengthen grips. Because the grips constrain a segment to its current angle, they are particularly useful for modifying the length of schematic line segments you have already placed.

When you use the lengthen grip on an end that is connected to another object, you must specify whether you want AutoCAD MEP to maintain connectivity between the objects.

Unconnected schematic line segment
### Connected schematic line segment

<table>
<thead>
<tr>
<th>Press Ctrl to toggle between:</th>
<th>Lengthen, Keeps Connected</th>
<th>Lengthen, No Connected</th>
</tr>
</thead>
</table>

**To modify the length of a schematic line segment**

1. Select the schematic line segment.
2. Click the Lengthen grip on the end you want to modify.
3. If the segment is connected to an object on the end you selected, specify whether and how to maintain connectivity:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>maintain connectivity by adjusting only schematic fittings and segments, and retain the current locations of parts</td>
<td>proceed to the next step.</td>
</tr>
<tr>
<td>maintain connectivity by adjusting all objects, including parts</td>
<td>press Ctrl.</td>
</tr>
<tr>
<td>break connectivity</td>
<td>press Ctrl.</td>
</tr>
</tbody>
</table>

4. Specify the segment length:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify the new total length</td>
<td>press Tab to activate the input field for specifying the resulting dimension, and then enter the new length.</td>
</tr>
<tr>
<td>specify the difference between the current length and new length</td>
<td>drag the cursor to begin lengthening or shortening the segment, and then enter the change in length in the input field that is active by default.</td>
</tr>
<tr>
<td>specify a new end point</td>
<td>drag the grip to the desired end point location, and click to specify the point.</td>
</tr>
</tbody>
</table>
NOTE To use the dimension input fields, both dynamic input (on the status bar) and the Dimension Input drafting option must be selected, which is the default setting. If you have deselected them, you can specify the new length by moving the cursor to a stretch point in the drawing or by entering the coordinates in the command window.

Rotating Schematic Symbols

You can rotate schematic symbols after you have placed them.

Rotating Orthographic Symbols

You can use the Rotate (Flip) grip to rotate schematic symbols 180 degrees in the direction indicated by the grip.

When you rotate a schematic symbol that is connected to other objects, the software adjusts the connected objects to maintain their connectivity. For example, the software might make minor adjustments to the lengths of connected schematic line segments after you have flipped a symbol. If it cannot adjust the objects, it disconnects them.
NOTE

When you add an in-line orthographic symbol, the rotation applied to the symbol is determined by the schematic line into which it is inserted. Because the symbol is attached to the line with a curve anchor, you can rotate the symbol by rotating the curve anchor, using the Curve Anchor commands on the context menu. For more information, see Rotating Objects Attached with Curve Anchors on page 180.

You can also rotate the symbol using the Properties palette if you release the anchor first. However, this method requires that you break the relationship between the symbol and the line. You can restore the relationship by reattaching the symbol with a curve anchor, as described in Attaching Objects with a Curve Anchor on page 177. To rotate an orthographic symbol using the Properties palette, first select the symbol. On the Properties palette, expand Basic, and expand Location. For Rotation, enter the number of degrees and press ESC.

Rotating Isometric Symbols

Isometric schematic symbols have 2 types of rotation grips:

- **Rotate grips**: Use these grips to rotate a symbol in its current isometric plane (isoplane).
- **Isometric plane grips**: Use these grips to rotate a symbol around the 3 isoplanes: left, top, and right.
NOTE Because schematic symbols are attached to schematic lines using curve anchors, you can also rotate symbols using the Curve Anchor commands on the context menu. For more information, see Rotating Objects Attached with Curve Anchors on page 180.

To rotate an isometric schematic symbol

1 Select the symbol.

2 Rotate the symbol:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>rotate the symbol, in its current isoplane, in 90-degree increments around its base point</td>
<td>click a Rotation grip as many times as needed.</td>
</tr>
<tr>
<td>change the isoplane (left, top, and right) of the symbol</td>
<td>click the Isometric plane grip as many times as needed.</td>
</tr>
</tbody>
</table>

3 Press ESC.

Rotating a symbol in its current isoplane

In the top isoplane, before rotation

In the top isoplane, after 180 degree rotation
Resizing Schematic Symbols

Use these procedures to change the size of a schematic symbol by scaling the symbol with the AutoCAD® SCALE command. The schematic symbol has a scale factor with respect to your annotation and drawing scale. You can scale an instance of a schematic symbol by a user-defined scale factor, by referencing a specified size, or by using grips and stretching the symbol to the desired size.

**NOTE** To change the default scale factor of a schematic symbol, modify the schematic symbol style. For more information, see Defining the Views of a Style on page 898.

Resizing by Scale Factor

There are 2 ways to resize a schematic symbol using a scale factor. You can specify a base point and a length, which are used as the scale factor based on the current drawing units. You can also enter a scale factor directly.

Resizing a schematic symbol by using a scale factor changes the dimensions of the selected symbol but does not alter the symbol’s aspect ratio. A scale
factor greater than one enlarges the symbol. A scale factor less than one shrinks the symbol.

As an example, in the following procedure you decrease the size of a schematic symbol by half, scaling it by a factor of 0.5. The numbers enclosed in parentheses refer to the illustration that follows the procedure.

To resize a schematic symbol by a scale factor

1. Select the object to scale (1), and click Home tab ➤ Modify panel ➤ Scale.
2. Specify the base point (2).
3. Enter .5 for the scale factor and press ENTER. The selected object is resized appropriately (3).

Resizing a schematic symbol by scale factor

Resizing by Reference

You can resize a schematic symbol by reference. When you resize by reference, you specify the current length of a symbol as a reference for the new length. For example, if one side of a schematic symbol is 2.5 units long, and you want to expand it to 3.5 units, use 2.5 as the reference length and 3.5 as the new length. You can also scale by specifying a base point and 2 reference points and dragging the symbol.

As an example, in the following procedure you increase the size of a schematic symbol by specifying the reference length and 2 reference points, and then dragging the symbol to specify the new length. The numbers enclosed in parentheses refer to the illustration that follows the procedure.

To resize a schematic symbol by reference

1. Select the object to scale (1), and click Home tab ➤ Modify panel ➤ Scale.
2. Specify the base point (2).
3 Enter r (reference).
4 Specify the first reference point (3).

**NOTE** You can also enter a value for the reference length. If you enter a value, skip to step 6.

5 Specify the second reference point (4).
6 Drag the symbol and specify a point (5).

**NOTE** You can also enter a value for the new length.

The selected symbol is resized appropriately.

**Resizing a schematic symbol by reference**

<table>
<thead>
<tr>
<th>Select object</th>
<th>Specify base point</th>
<th>Specify first and second reference points and reference length</th>
</tr>
</thead>
</table>

**Resizing Using Grips**

Schematic symbols can be converted to blocks, by using the BLOCK command, or by using Copy and then Paste as Block. When selected as blocks, they have a single grip at the insertion point that displays as an empty blue box. To scale the symbol, select the blue box at the insertion point as the base grip (base point), select Scale grip mode, and then move the cursor to resize the symbol.

As an example, in the following procedure you decrease the size of a schematic symbol using the Scale grip mode by dragging the symbol to specify a new size. The numbers enclosed in parentheses refer to the illustration that follows the procedure.

**To resize a schematic symbol using grips**

1 Select a schematic symbol (1).
   The software displays a single grip as an empty blue box at the symbol’s insertion point.
2 Select the empty blue box at the symbol’s insertion point to change it to a red solid box (2).

**NOTE** The selected grip is used as the base point for scaling.

3 Select the Scale grip mode by doing one of the following:
   - Enter `sc` (scale).
   - Cycle through the grip modes by pressing the SPACEBAR or ENTER key, and select Scale.

4 Move the cursor to reduce the size of the object, and then click to specify the new size (3).
   The object is scaled appropriately (4).

**Resizing a schematic symbol using grips**

![Diagram showing the process of selecting a symbol, displaying grips, selecting a grip, specifying a resize point, and resulting resized symbol.]

**NOTE** For more information, see GRIPS.
Creating Construction Documents

This section explains how to create construction documents using the tools in AutoCAD MEP.

Construction Document Workflow

It is recommended that project drawings are created, stored, and managed using the drawing management tools in AutoCAD MEP. When you use Project Navigator to manage drawings, you can efficiently create construction documents that reference the building system drawings.

After you create a project, you can manage drawings from a central location. For more information, see Working with Drawing Management Projects on page 199.

A typical workflow for creating documents with AutoCAD MEP is as follows:

1. Create a construct
   - Save your drawing as a construct on the Constructs tab in Project Navigator. See Creating Construction Documents on page 814

2. Create views
   - Create views for drawings and schedules to be included in sheets. See Views on page 845
Creating Construction Documents

AutoCAD MEP includes many features to create and maintain construction documents. You can use drawing management tools such as Project Browser and Project Navigator to create and manage project drawings. By using external reference capabilities, you can create models of systems, and then create construction documents referencing different views and equipment in the model. If you change the model, you can apply the changes automatically to the construction documents.

Annotation

You can annotate your drawings with the tools available in AutoCAD MEP. Annotation can be categorized as follows:

- Object labels, general text, and dimensions
- Annotation symbols
- Tags and schedules
• View and detail marks

Labels and documentation symbols are the primary annotation types for drawings. To display object information such as system name, size, and dimensions, use labels. To add information such as leaders, break marks, title marks, and revision clouds, use annotation symbols from the symbol libraries in DesignCenter™.

Tags are used to mark equipment for scheduling. When a schedule is added to a drawing, it can automatically display property set data for tagged parts. If you modify tagged equipment, you can automatically update the schedule to reflect the changes.

Section, elevation, and detail views can display discrete parts of a building plan. You can generate these views automatically from the system model. If you modify the system model in its construct drawing, you can automatically update detail, section, or elevation views to reflect the changes.

Scaling Annotation

The annotation scale of a viewport allows you to plot annotation at the same height or size regardless of the viewport scale. You can specify an annotation scale for model space and for each viewport in paper space. This means you can use different scales for the viewports in a layout (for example, one for a plan view and one for a detail view), and the annotation will scale and plot at the correct size.

Annotative objects are scaled according to the current annotation scale if they have a corresponding scale representation. If they do not, they are scaled according to the annotation scale in which they were created. Annotative components in other, non-annotative AutoCAD MEP objects are always scaled according to the current annotation scale. For information on when an object or component is considered annotative, see Annotative Objects on page 815.

Annotative Objects

Annotative objects are defined as objects that participate in annotation scaling; that is, they scale accordingly when the annotation scale changes. You can identify whether an object is annotative by doing either of the following:

• Select the object, enter list, and view the value for Annotative in the dialog
Move the cursor over the object. An icon ( ) is displayed if the object is annotative. (Multiple shapes indicate the object supports multiple scale representations.)

An AutoCAD MEP drawing might include:
- AutoCAD MEP objects that are annotative
- AutoCAD MEP objects that are not annotative but have annotative components
- AutoCAD and AutoCAD Architecture objects that are annotative

**Annotative AutoCAD MEP Objects**

In AutoCAD MEP, labels are annotative objects if the corresponding label curve style is configured to be annotative. You configure a label curve style to be annotative in one of 2 ways depending on the type of style.

If the label curve style uses block graphics or flow arrow graphics, and Use Annotation Scale for Block is selected in the style, then the style is considered annotative. (As a convenience, this is selected by default when you select a block whose Annotative property is set to Yes, but you can deselect it.)
Example block-based label curve style

If the label curve style uses a text style, then the configuration of the text style determines whether the label curve style is considered annotative.

Example text-based label curve style
The following table describes how labels are scaled based on the configuration of the text style that is used by a label curve style.

<table>
<thead>
<tr>
<th>If the Annotative property is ...</th>
<th>And the value for Paper Text Height (or Height) is ...</th>
<th>Then labels of the style are scaled to ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>selected or cleared</td>
<td>zero</td>
<td>the annotation plot size (specified in the Drawing Setup dialog) multiplied by the current annotation scale.</td>
</tr>
<tr>
<td>selected</td>
<td>greater than zero</td>
<td>the value specified for Paper Text Height multiplied by the current annotation scale.</td>
</tr>
<tr>
<td>cleared</td>
<td>greater than zero</td>
<td>the value specified for Height.</td>
</tr>
</tbody>
</table>

**NOTE** When the text style is configured in this way, the label curve style is not considered annotative.

When you modify a label curve style to make it annotative or non-annotative (using the methods described above for block-based styles and text-based styles), all labels using the style are updated accordingly in the drawing. In the case of a block-based style, you cannot make the style annotative or non-annotative by modifying the Annotative property in the underlying block definition.

**NOTE** Schedules are not considered annotative. Therefore, they do not scale accordingly when the annotation scale changes. When you insert a schedule into a drawing, it uses the annotation scale that is current at the time of insertion, and its scale does not subsequently change.

### AutoCAD MEP Objects with Annotative Components

Some AutoCAD MEP objects are not annotative, but they have components that are (or can be) annotative. The following table lists these components.

<table>
<thead>
<tr>
<th>Domain</th>
<th>Annotative Components of AutoCAD MEP Objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>■ Rise symbols and drop symbols</td>
</tr>
<tr>
<td></td>
<td>■ View blocks of MvParts if Use Annotation Scale is selected in the corresponding MvPart style definition. You select this on a per-view basis on the Views tab in Style Manager.</td>
</tr>
<tr>
<td>Domain</td>
<td>Annotative Components of AutoCAD MEP Objects</td>
</tr>
<tr>
<td>--------</td>
<td>---------------------------------------------</td>
</tr>
</tbody>
</table>
| HVAC   | ■ Flow markers  
■ Annotation pattern on flexible ducts  
■ Flow arrows on air terminals if Use Annotation Scale for Block is selected in the MvPart properties. You select this on the Flow tab in the Multi-view Part Properties dialog. |
| Piping | ■ Flow markers  
■ Annotation pattern on flexible pipes  
■ Placeholder pipe  
■ In Graphical 1-Line: rise symbols, drop symbols, in-line/anchored MvParts, and reducers |
| Electrical | ■ Home runs, tick marks, and gaps on wires  
■ Pattern on cable trays  
■ View blocks of devices and panels if Use Annotation Scale is selected in the corresponding device style or panel style. You select this on a per-view basis on the Views tab in Style Manager. |
| Plumbing | ■ Plumbing fittings  
**NOTE** Plumbing fittings are always scaled according to the current annotation scale in model space.  
■ Gaps on plumbing lines |
| Schematic | ■ Schematic symbols  
**NOTE** Schematic symbols are always scaled according to the current annotation scale in model space. |
Annotative Components of AutoCAD MEP Objects

- Start symbols, end symbols, connections symbols, and gaps on schematic lines

**TIP** You can use the conversion tools provided with the software to update large numbers of schematic symbols to be annotative. For more information, see Customizing Schematic Symbol Content on page 940.

The Hatch display component is not an annotative component of an object. Therefore, it does not scale accordingly when the annotation scale changes.

**IMPORTANT** Objects with annotative components that are block-based (for example, flow arrows on air terminals, and view blocks for devices) are considered annotative based on whether Use Annotation Scale (for Block) is selected. The Annotative property in the associated block definition has no bearing on whether the object is annotative.

### Other Annotative Objects

The following AutoCAD Architecture objects can be annotative depending on their configuration:

- Multi-view Blocks (MvBlocks)
- AEC dimensions

For more information, see Annotation Scaling in the AutoCAD Architecture Help.

The following AutoCAD objects can be annotative depending on their configuration:

- Text
- MText
- Dimensions
- Leaders
- Blocks
- Hatching
- Linetypes
If the MSLTSCALE system variable is set to 1, linetypes displayed in model space are scaled according to the annotation scale. If the PSLTSCALE system variable is set to 1, linetypes displayed in paper space are scaled according to the viewport scale in paper space. For more information, see MSLTSCALE and PSLTSCALE.

RELATED For more information, see Scale Annotations.

Setting the Annotation Scale

You can specify different annotation scales for model space and for individual viewports in paper space.

When you change the annotation scale, annotative objects and objects with annotative components are scaled accordingly. Connected objects, such as the wires connected to devices, are also updated accordingly. You do not need to regenerate the model.

In paper space, the viewport scale and the annotation scale are synchronized. When you change the viewport scale, the annotation scale is changed to match. However, you can change the viewport scale without affecting the annotation scale by zooming in or out of the viewport with the mouse wheel or by using the zoom commands.

To set the current annotation scale

1 To set the annotation scale for model space, change to the Model tab. To set the annotation scale for a viewport in paper space, select the viewport.
On the drawing window status bar, click the current annotation scale, and select a new scale from the flyout menu.

You can also

- Set the annotation scale for model space by selecting a scale on the Scale tab of the Drawing Setup dialog. To access the dialog, click on the drawing window status bar, and click Drawing Setup.

- Set the current annotation scale for the current space by setting the CANSOSCALE system variable. For more information, see Scale Annotations.

### Displaying and Hiding Annotative Objects

When you add an annotative object to a drawing, the object will support only the annotation scale that is current at that time. In other words, the object has only one scale representation. To support additional annotation scales, you can add scale representations to the object.

In model space or in a layout viewport in paper space, you can display only the annotative objects that support the current annotation scale, or you can display all the annotative objects. You switch between these 2 options, respectively, using and on the drawing window status bar.
If you display all the annotative objects, those that do not support the current annotation scale are displayed using the annotation scale in which they were created.

For more information, see Display Annotative Objects and ANNOALLVISIBLE. For information on adding support for an annotation scale to an object, see Adding and Modifying Scale Representations on page 823.

NOTE Objects that are not annotative but have annotative components, such as devices and air terminals, are always displayed and scaled according to the current annotation scale. They cannot be hidden using this setting.

Adding and Modifying Scale Representations

Scale representations enable you to display the same annotative objects differently in different viewports in paper space. You can add scale representations to objects, remove them, and move their locations in the drawing.

NOTE Objects that are not annotative but have annotative components, such as devices and air terminals, do not have scale representations. Annotative components are always displayed and scaled according to the annotation scale.

Adding the Current Scale Representation

To add the current scale representation to an object, select the object, right-click and click Annotative Object Scale ➤ Add Current Scale.

You can also add and remove scale representations using the commands on the Annotative Scale panel of the context menu.

Automatically Adding Scale Representations

To automatically add a scale representation to all annotative objects, including those in referenced drawings (xrefs), when you change to that scale, click on the drawing window status bar, so that it is displayed as .

In model space, typically you will want to disable this option if you are working in a drawing that has multiple scales so that scales are not unnecessarily added to all of the annotative objects.
WARNING Using this option to add scale representations to the annotative objects in an xref created in a previous version of the software automatically updates the file format of the xref to the current version. This means you can no longer open the drawing in the previous version.

For more information, see Set Annotation Scale and ANNOAUTOSCALE.

Moving Scale Representations

Use the Location grips on an annotative object to move the object:

- Labels and AEC dimensions have a single Location grip for all scale representations. This allows you to specify one location for all of the scale representations of the object. For an example with duct, see Modifying a Label on page 361. For an example with pipe, see Modifying a Label or Flow Arrow on page 485.

- Annotative MvBlocks have 2 Location grips: one for specifying a location for all of the scale representations, and one for specifying a location for only the current scale representation.

- All other annotative objects have a Location grip for each scale representation, which means you can specify different locations for each scale representation. To move the object in all scale representations, use the MOVE command instead.

For more information, see Add and Modify Scale Representations.

Exporting Annotated Drawings to AutoCAD

When you export an AutoCAD MEP drawing to AutoCAD, the annotative objects—like all other objects—are exploded into basic AutoCAD objects that maintain their original layer, color, and linetype.

If you export a drawing with multiple viewports in paper space, the annotative objects are exploded into multiple blocks, one for each viewport, in order to maintain visual fidelity. You can export annotative AutoCAD objects in the same way by selecting Maintain visual fidelity for annotative objects on the Open and Save tab in the Options dialog. For more information, see Save a Drawing.

Beginning with AutoCAD 2009, if you open an exported AutoCAD MEP drawing in AutoCAD, the AutoCAD MEP objects that were annotative prior to export will be annotative in AutoCAD.
Label Curve Styles

Label curve styles define the content and display of annotation labels. When you create, edit, or copy label styles, you use Style Manager. Style Manager provides a central location where you can view and work with label styles from multiple drawings and templates.

You can specify the text style, position of text on the curve, the information displayed in the label, and how the label is displayed in your drawing. When you change a label style, the labels in the current drawing that were created with that style change.

Copying Label Styles Between Drawings

Use this procedure to copy label curve styles between drawings. You can manage label styles by creating them in one template drawing, and copying them into other drawings as needed.

1. Click Manage tab ➤ Style & Display panel ➤ Style Manager .
   Style Manager is displayed with the current drawing expanded in the tree view. The label curve styles in the current drawing are displayed under Label Curve Styles in the Documentation Objects folder.

2. In Style Manager, click File menu ➤ Open Drawing, and browse to the drawing that contains the style that you want to copy to your current drawing.

3. Open the drawing with the style that you want to copy.
   The new drawing opens in Style Manager.

4. Under the new drawing, expand Documentation Objects ➤ Label Curve Styles to display the label styles in the drawing.

5. Right-click the label style that you want to copy, and click Copy.

6. Right-click Label Curve Styles in the destination drawing, and click Paste.
   The style is copied into the destination drawing.
Label Style Properties

You can modify label style properties, such as the text style, position of text on the curve, the information displayed in the label, and how the label is displayed in your drawing.

Specifying General Style Information

Use this procedure to access the general style properties from the General tab for the label curve style. General style properties include label name, description, and notes. You can also assign property set information to objects that have associated schedules.

1 Select a label, and click Label tab ➤ General panel ➤ Edit Style.
2 In the Label Style dialog, click the General tab.
3 Specify the desired information, and click OK.

NOTE The name should be modified with caution. Avoid duplicate names to prevent confusion.

Changing Label Style Annotation Properties

You can use the options on the Label Style Annotation tab to specify how the object information is displayed in the label.

To set label style annotation properties

1 Select a label, and click Label tab ➤ General panel ➤ Edit Style.
2 In the Label Style dialog, click the Label Style Annotation tab.

3 From the Options list, select one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Block graphics</td>
<td>Use a specific block. You can also specify a scale factor to apply to the block. If you want</td>
</tr>
<tr>
<td></td>
<td>the block to scale accordingly when the annotation scale changes, select Use Annotation</td>
</tr>
<tr>
<td></td>
<td>Scale for Block.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> The Use Annotation Scale for Block setting, not the Annotative property in the</td>
</tr>
<tr>
<td></td>
<td>selected block definition, determines whether the label curve style is annotative. For more</td>
</tr>
<tr>
<td></td>
<td>information, see Scaling Annotation on page 815.</td>
</tr>
<tr>
<td>Use Objects Properties</td>
<td>The properties displayed in the label are different for different objects in AutoCAD MEP. The</td>
</tr>
<tr>
<td></td>
<td>ID is displayed for schematic.</td>
</tr>
</tbody>
</table>

Annotation | 827
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Object Properties and Abbreviated System Name</td>
<td>Displays both the object properties and the abbreviation assigned to the system definition for objects except devices, panels, MvParts, and schematic symbols and lines. For devices, panels, and MvParts, the abbreviated system name of the closest connector is displayed. For schematic symbols and lines, the assigned system label is displayed.</td>
</tr>
<tr>
<td>Use Abbreviated System Name</td>
<td>Displays the abbreviation assigned to the system definition for objects except devices, panels, MvParts, and schematic symbols and lines. For devices, panels, and MvParts, the abbreviated system name of the closest connector is displayed. For schematic symbols and lines, the assigned system label is displayed.</td>
</tr>
<tr>
<td>Use Component Description</td>
<td>Specify that the object style description be displayed. You can define the description on the General tab in the object style properties dialog. To open the style properties dialog, click the Style Properties button.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use Component Name</td>
<td>Specify that the name of the component be displayed. You can define the object name for duct and pipe custom fittings, wire, devices, panels, and schematic symbols and lines on the General tab in the style properties dialog for the object. To open the style properties dialog, select the object, right-click, and select Edit (Object) Style.</td>
</tr>
<tr>
<td>Use Flow/Run Arrows</td>
<td>Specify the flow/run direction by an arrow. Flow/run arrows are displayed as block graphics. You can choose that type of block graphic to display. If you would like to use a custom flow/run arrow style that you created, select Use Arrow for Type of flow/run arrow, and then select the style from the Select Custom Arrow Block dialog. If you want the flow arrow graphics to scale accordingly when the annotation scale changes, select Use Annotation Scale for Block.</td>
</tr>
<tr>
<td>Use Property Set</td>
<td>Specify a specific property set to display. Select a property set definition for the object, and specify a property set to display in the label.</td>
</tr>
</tbody>
</table>

**NOTE** The Use Annotation Scale for Block setting, not the Annotative property in the selected block definition, determines whether the label curve style is annotative. For more information, see Scaling Annotation on page 815.
4 Select Mask Display of Curve to hide the centerline of the curve.

5 Specify Dimension String Options. Note that some options may not be available depending on the label option selected in a previous step:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then enter a value in…</th>
</tr>
</thead>
<tbody>
<tr>
<td>insert text before the variable</td>
<td>Prefix</td>
</tr>
<tr>
<td>separate to variables</td>
<td>Separator</td>
</tr>
<tr>
<td>insert text after the variable</td>
<td>Suffix</td>
</tr>
<tr>
<td>insert marks for an AutoCAD control code, such as %%c, (For more information, see Control Codes and Special Characters.)</td>
<td>Diameter</td>
</tr>
<tr>
<td>change the distance between the beginning of the curve display and the beginning of the text (if the text intersects the curve)</td>
<td>Gap Paper Size</td>
</tr>
</tbody>
</table>

**Changing Label Style Offset Options**

You can use the options on the Label Style Offset tab to specify the text style and the position of the label relative to the curve.
To set label style offset properties

1 Select a label, and click Label tab ➤ General panel ➤ Edit Style ➤.

2 In the Label Style dialog, click the Label Style Offset tab.

3 Select Force To Horizontal Justification if you do not want the label to rotate at all.

4 To specify where the label is placed relative to the curve, select one of the following options:

<table>
<thead>
<tr>
<th>Offset option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-Adjust for 2 Line</td>
<td>Use this option to adjust the label display for objects using a 2-line display configuration.</td>
</tr>
<tr>
<td>Auto-Adjust for 1 Line</td>
<td>Use this option to adjust the label display for objects using a 1-line display configuration.</td>
</tr>
<tr>
<td>Force Outside of Bounding Box</td>
<td>Use this option to display the label above the curve.</td>
</tr>
<tr>
<td>None</td>
<td>Use this option when you want to insert the label at the specified point.</td>
</tr>
</tbody>
</table>

5 If desired, enter a value for Clear Distance Paper Offset.
When labels have a clear distance paper offset and Auto-Adjust for 2 Line is specified, the offset is calculated from the outer edge of the curve to the bottom of the text.
When Labels have a clear distance paper offset and Auto-Adjust for 1 Line is specified, the offset is calculated from the centerline of the curve to the bottom of the text.

Labels

You can annotate objects with labels that consist of text or block definitions. The information in the label comes from object properties, such as connection size. Labels anchor to objects, yet you can still move a label without releasing it from its object. It is recommended that you add labels to construct drawings.

Adding Labels

For information on adding labels, see Adding a Label or Flow Arrow to Duct on page 318 and Adding Labels or Flow Arrows to Pipe on page 465. In addition to duct and pipe, you can add labels to plumbing lines, wires, cable tray, conduit, and schematic lines.

Modifying Labels

For more information on modifying labels on pipe objects, see Modifying a Label or Flow Arrow on page 485.

Changing the Label Style

You can change the label style for an existing label in a drawing. For example, you can change a standard size label to a system label.

1. Double-click a label to open the Properties palette.

   NOTE  Alternatively, select a label and then click Home tab ➤ Build panel ➤ Tools drop-down ➤ Properties.

2. On the Design tab, expand General under Basic.
3. Choose a label style for Style.

   The label updates to reflect the properties of the new label style.
Changing the Label Spacing

You can change how labels are spaced along the X axis.

1 Double-click a label to open the Properties palette.

**NOTE** Alternatively, select a label and then click Home tab ➤ Build panel ➤ Tools drop-down ➤ Properties .

2 On the Design tab, expand General ➤ Dimensions under Basic.
3 Choose a layout method under Dimensions.
   One by One is selected by default.
   - If you choose By distance, enter a value for Distance between under Dimensions.
   - If you choose By quantity, enter the number of labels.
4 Expand Advanced.
5 Click Nodes to add, edit, or remove the grips associated with the selected layout curve on the Nodes worksheet.

Adding Annotation Symbols from DesignCenter

You can add design and documentation annotation from DesignCenter to your drawings. Documentation annotation includes symbols such as elevation
labels, chases, revision clouds, and match lines. Design annotation includes symbols for parts such as electrical, mechanical, and plumbing equipment.

**NOTE** The design symbols in DesignCenter are AutoCAD® multi-view blocks (MvBlocks), and they do not connect to AutoCAD MEP objects. They are for drawing annotation only.

1. Click Insert tab ➤ Content panel drop-down ➤ Design Center.
2. On the DesignCenter palette, click the AEC Content tab.
3. Under Custom Applications, expand AutoCAD Architecture, and then expand the directory for the desired units (imperial or metric).
4. Expand the Design or Documentation directories, and continue expanding subdirectories.
   When you select a subcategory that contains annotation symbols, the symbols are displayed in the right pane.
5. Drag the symbol from the right pane of DesignCenter into your drawing.
6. Specify the location and orientation for the symbol.
If you want to use a DesignCenter symbol repeatedly in a project, you can drag the symbol from DesignCenter directly onto a tool palette to create a symbol tool.

Tags

In the software, tags are used primarily to add property set data to a part. After you add tags to parts, you can create equipment schedules for that type of part. The schedule is automatically populated with the property set data you specify for the part.

A tag is used secondarily to annotate a part. For example, you can add a tag to a ceiling diffuser in an HVAC system that displays the air flow assigned to the diffuser.

Property set data can consist of fixed values derived from the part, such as connection size. Data can also contain fields that you specify manually, such as a part manufacturer. For more information, see Property Set Data in the AutoCAD Architecture online help.

Adding a Tag

You must apply tags to equipment in order to create schedules for that equipment. When you add a tag to a part, the property set definitions associated with that tag are added to the part. You can enter values manually as you add the tag, and you can also modify property set data after the tag is added.

A tag is anchored to a part. If you move the part, its tag moves with it. You can, however, move the tag in the drawing without releasing it from its part.
Typically, you add tags to parts after you add the parts to a drawing. For electrical devices, you can add tags automatically as you add parts. For more information, see Creating Tools for Style-Based Content on page 1179.

The default tool palettes contain several tag tools you can use for common equipment. You can also create tag tools. For more information, see Creating a Schedule Tag Tool in the AutoCAD Architecture online help.

To add a tag

1 Open the Tag and Schedule tool palette, and select a tag tool.

   NOTE Alternatively, you can click Annotate tab ➤ Scheduling panel ➤ Tags drop-down, and select a tag.

2 Select the object that you want to tag.

3 Specify the location for the tag:
   - Press Enter to center the tag on the part.
   - Click to specify a point for the tag.

You can move tags after you insert them.

4 On the Edit Property Set Data dialog, enter desired values for fields that can be edited manually.
   Automatic fields are displayed in gray, and cannot be edited.
   If a tag adds property set data that is assigned to a system style or object style, that data may be inactive. You can edit this data from the Properties palette after you add the tag.

5 Click OK.

6 Continue specifying parts to tag:
   - To continue tagging parts one at a time, select an object, specify the tag location, and enter property set values.
   - To tag multiple parts with the same property set values you specified for the first part, enter m, select objects of the same part type that you want to tag, and press Enter. The tags are added in the same location relative to the part as the first tag. Each part also has the same property set values.

7 Press Enter to end the command.
You can locate many tags and schedules on the ribbon. Navigate to the Annotate tab ➤ Scheduling panel and use the drop-down buttons to see a list of available tags or schedules.

**Modifying Property Set Data for a Part**

You can manually change some property set values after you add a tag to a part. If the property set value is derived automatically, such as connection size, you need to modify the part itself to achieve the desired property set value.

If you delete a tag, you also remove the property set definitions that the tag assigned to the part. You lose all property set values defined for the part.

The available property sets are specified by the property set definitions assigned to the tag tool. For more information, see Property Set Definitions in the AutoCAD Architecture online help.

1. In the drawing, select one or more parts or part tags. Because the tag is linked to the object, you can access the same property set values by selecting either the tag or the part.

2. On the Properties palette, click the Extended Data tab.
Example of property set data for a ceiling diffuser

3 Expand Property Sets, if necessary.
4 Edit property set values as desired.
   If property set values are derived from the part style or system style, click the edit button in the property set heading, and edit the values in the Edit Property Set Data dialog.

5 Press Esc to deselect the parts.

Using Part Number Tags and Schedules

You can add part number information to an MEP system by adding part number tags to the objects in the system, including MvParts. Each tagged object has a specific property set, which you can configure according to a required pipe or duct specification. After you have added part number tags to
the objects, you can create duct or pipe schedules for itemizing the objects in the system. These schedules can be sent off to an ordering or fabrication vendor.

Locate the part number tag and schedule tools on the Tags and Schedules palette.

**The Tags and Schedules Tool Palette**

The part number tools let you number tags individually or in a sequence, and allow using the same number for parts of the same type. Part number tags can use either numbers or text labels. While part number tags work with any MEP object, the Tags and Schedules palette provides scheduling tools only for duct and piping systems. For more information, see *Working with Part Number Tags and Schedules* on page 839.

**Working with Part Number Tags and Schedules**

Add part number tags to an MEP system before creating a schedule. You can also modify or remove existing part number tags.

**To add part numbers to an MEP system**

1. Click Annotate tab ➤ Scheduling panel ➤ Tags drop-down ➤ Text Part Numbering Tag.
2. Click the Rectangular, Oval, or Text Part Number tool.
3 Use the Select System button to select the system objects for tagging.

4 Choose whether to tag individual objects or connected objects.

5 Use the Add, Update, or Remove buttons to choose your Part Numbering operation.

| If you want to | Use...
|---------------|--------
| create a new set of part numbers | Add Part Number |
| modify an existing set of part numbers | Update Part Numbers |
| delete an existing set of part numbers, including property sets | Remove Part Number |

6 Set the tag starting value and add any desired tag prefix or suffix information.

The tag starting value can be a number or a letter, or a combination of the two. Valid numbering sequences include:

- 1,2,3...
- A,B,C...Z,AA,AB...
- a,b,c...z,aa,ab...
- A1,A2...A9,B0,B1...
Alphanumeric Part Numbers with the Run Number (H) Followed by a Sequenced Part Number

7 Click **Include run number** to differentiate among separate but connected runs, and enter a run designator value.

8 Click **Use the same part number for identical parts** to set or cancel this option.

9 Click OK to start tag insertion.

Once the system has been tagged, use the Duct Quantity Schedule or Duct Fabrication Contract Schedule (Pipe Quantity Schedule for Piping systems) tool to add schedules to your drawing.
Schedules

You can add schedules to display part information. A schedule displays (in tabular format) a list of tagged parts along with selected attributes for each part. Schedule data is dynamic -- when you change part attributes (or delete a part) in a drawing, the schedule table automatically reflects those changes.

The schedule format is based on the schedule table style assigned to the schedule tool. You can modify schedule table styles to achieve the data format that you want to display. You can also share a schedule table style among drawings. For more information, see Working with Schedule Table Styles in the AutoCAD Architecture online help.

Adding a Schedule

This task shows how to add a schedule to a drawing that contains the tagged parts for which you want to create a schedule. Before creating a schedule, you must add tags to the parts that you want to schedule.

You can also add a schedule in its own drawing, and link to an external drawing that contains the tagged parts.

To add a schedule

1 On the Tag and Schedule tool palette, click the schedule tool for the parts you want to schedule.

   **NOTE** Alternatively, you can click Annotate tab ➤ Scheduling panel ➤ Schedules drop-down, and select a schedule.

2 Select the objects in the drawing that you want to schedule.

   If you use a bounding box to select all objects within an area, you can filter the selection set using Quick Select in the Properties palette. If the schedule table style is configured to use part classifications, you can select more than one type of objects, and only the parts with the appropriate classification are added to the schedule table.

3 After you select all objects to schedule, press *Enter*.

4 Specify the location in the drawing for the upper-left corner of the schedule table.

5 Press *Enter* to size the schedule table automatically.

   You can also manually specify the lower-right corner of the table.
The schedule table is added to the drawing, and its fields are populated with the property set data configured for the scheduled parts.

<table>
<thead>
<tr>
<th>Quantity</th>
<th>FG Module Size</th>
<th>Height Size</th>
<th>Description</th>
<th>Construction</th>
<th>Finish</th>
<th>Manufacturer</th>
<th>Model ID</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>24&quot; x 24&quot;</td>
<td>8&quot;</td>
<td>PERFORATED SUPPLY DIFFUSER WHITE POWDER COAT</td>
<td>PRICE</td>
<td>APH854000002</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>24&quot; x 24&quot;</td>
<td>10&quot;</td>
<td>PERFORATED SUPPLY DIFFUSER WHITE POWDER COAT</td>
<td>PRICE</td>
<td>APH854000002</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>12&quot; x 14&quot;</td>
<td>12&quot;</td>
<td>SEABUL SUPPLY ORLIT WHITE POWDER COAT</td>
<td>PRICE</td>
<td>40456</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Because the schedule tables are dynamically linked to the parts, you can update schedule tables as you add, remove, or modify the scheduled parts in the drawing. You do not have to manually edit the schedule.

**TIP** If the schedule displays each part in its own row, you can modify the schedule table style to group the same parts in a single row. Select the schedule table style in Style Manager ➤ Documentation Objects ➤ Schedule Table Styles. On the Columns tab, select Include Quantity Column, and click OK.

---

**Linking a Schedule to an External Drawing**

This task shows how to add a schedule to its own drawing, and then link it to an external drawing that contains the parts you want to schedule. If you want to have separate sheets for plan drawings and schedule drawings, it is recommended that you add a schedule to its own drawing. This alleviates the need to place the same drawing on 2 separate sheets, and then manipulating the model space view so that only the desired portion of the drawing is visible on the sheet. This will also reduce the file sizes of your sheets.

If you are using Project Navigator to manage project drawings, you can create a new general view drawing, and add the schedule to it. You link the schedule to the construct drawing that contains the parts you want to schedule. After you update the schedule, you can place its view drawing on a sheet.

1. On the Tag and Schedule tool palette, click the schedule tool for the parts you want to schedule.

   **NOTE** Alternatively, you can click Annotate ➤ Scheduling panel ➤ Schedules drop-down, and select a schedule.

2. Press *Enter* to schedule an external drawing.

3. Specify the location in the drawing for the upper-left corner of the schedule table, and press *Enter*.

4. Select the schedule.
5 In the Properties palette, select the Design tab.
6 If necessary, expand Advanced ➤ External Source.
7 For Schedule External Drawing, select Yes.
8 For External Drawing, select Browse.
9 In the Select a drawing file dialog, specify the drawing that contains the parts you want to schedule.
10 With the schedule table still selected, click Schedule Table tab ➤ Modify panel ➤ Update .

The schedule table displays the data from the parts in the external drawing.

Creating an Electrical Panel Schedule

You can automatically generate panel schedules for electrical drawings. For more information, see Generating Panel Schedules on page 688.

Updating a Schedule

If you modify parts or part data included in a schedule, you can update the schedule table automatically to reflect the changes. When part data changes, the schedule table is displayed with a line drawn through it.

If you remove parts, you can update the schedule automatically to reflect the quantity changes. If you add parts, and want to include them in an existing schedule, you simply need to select the new parts to update the schedule.

To update the schedule table for property data changes and deleted parts

1 In the drawing, select the schedule.
2 Click Schedule Table tab ➤ Modify panel ➤ Update .

Optionally, you can select the schedule table and change the Update Automatically setting on the Properties palette from No to Yes to immediately update the schedule any time you make a change.
To add new parts to a schedule

3 Select the schedule table, right-click, and click Selection ➤ Add.

NOTE Alternatively, you can click Schedule Table tab ➤ Scheduled Objects panel ➤ Add .

4 Select the additional objects in the drawing, or press Enter to schedule an external drawing.

■ If you add objects from the current drawing, press Enter to update the schedule.

■ If you want to add objects in an external drawing, see Linking a Schedule to an External Drawing on page 843.

With the Selection commands on the context menu of a schedule table, you can remove parts from the schedule table selection set, or reselect parts to populate the schedule table with the new selection set only.

Exporting a Schedule to a Spreadsheet

You can export a schedule to a spreadsheet at any time.

1 Open the drawing that contains the schedule you want to export, and select it.

2 Click Schedule Table tab ➤ Modify panel ➤ Export .

3 In the Export Schedule Table dialog, specify the output format and file name, and click OK.

Views

Views are the intermediate drawings between the constructs that model the system and the sheets that comprise the construction documents. View drawings typically reference one or more construct drawings. If you change anything in a construct drawing referenced in a view drawing, you can reload the construct reference drawing in the view to automatically update the changes. If you work in this manner, you only need to maintain the construct drawings, and you do not need to manually maintain the view drawings.
Creating a General View

You can create a general view drawing that typically displays a top view of the system design.

1 On the Quick Access Toolbar, click Project Navigator ➤ .
2 On the Project Navigator, click the Views tab.
3 In the Views directory, right-click the subdirectory where you want to add the view, and click New View Dwg ➤ General.
4 In the Add General View dialog, specify the drawing information:
   ■ Name: Specify a file name.
   ■ Category: Use the default directory location, or specify a new directory location.
   ■ Drawing Template: Verify the template to use for the view drawing. This is the template specified in the project settings.
5 Click Next.
6 Specify the floors of the building plan used in the view drawing.
   The constructs that you want to use in the view must be assigned to the same floors.
7 Click Next.
8 Specify what constructs to use in the view. The constructs you select are attached as reference drawings to the view drawing. If a drawing is referenced as an overlay in a view drawing, it will not be included when you add the view drawing to a sheet.

   NOTE If the construct drawing you want to use includes an overlay reference drawing, such as a building floor plan, you must select the reference drawing in addition to the construct drawing in order for it to display on the view drawing.

9 Click OK.
   The new view drawing is created, but it is not opened.
10 To open the new view drawing, double-click it on the Views tab in Project Navigator.
Creating a Detail View

This task shows how to create a new detail view drawing from a general view drawing. The detail mark is added to the general view, and the detail view is created in a new drawing. When you place the detail view on a sheet, the detail number is automatically added to the detail view, and the detail number and sheet number are automatically added to the detail mark in the general view.

1. Open the general view drawing to add the detail mark.
2. On the Annotation tool palette, click the detail mark or detail boundary tool.

**NOTE** Alternatively, use the Annotate ribbon tab and the Callouts panel drop-down to locate detail mark tools.

3. Specify the detail mark location:
   - If using the detail mark tool, specify the points for the mark leader line, and specify the direction for the detail line tail.
   - If using the detail boundary tool, specify the annotation boundary around the detail area, and specify the points for the mark leader line. The boundary displayed on the drawing is for annotation only, and is not used to define the region for the detail view.

4. At the location where you want to add the mark, press Enter.
5. In the Place Callout dialog, for New Model Space View Name, specify a name to display in the title mark of the new detail view.
6. Deselect Generate Section/Elevation.
7. For Scale, specify the drawing scale for the detail view.
8. Under Create in, click New View Drawing.
9. In the Add General View dialog, specify the drawing information:
   - Name: Specify a file name.
   - Category: Specify a directory location. It does not need to be in the same directory as the general view drawing.
   - Drawing Template: Verify the template to use for the view drawing. This is the template specified in the project settings.
10. Click Next.
11 Specify the floors of the building plan used in this detail view drawing. The constructs that you want to show in the view must be assigned to the same floors.

12 Click Next.

13 Specify what constructs to show in the view. The constructs you select are attached as reference drawings to the view drawing. If a drawing is referenced as an overlay in a view drawing, it will not be included when you add the view drawing to a sheet.

**NOTE** If the construct drawing you want to use includes an overlay reference drawing, such as a building floor plan, you must select the reference drawing in addition to the construct drawing in order for it to display on the view drawing.

14 Click OK.

15 Specify the first corner of the rectangular area that will form the boundary for the detail.

16 Specify the opposite corner.

The new detail view drawing is created, but not opened. The detail number and sheet number referenced in the detail mark display as ?.

17 Save and close the general view drawing.

18 To open the new detail view drawing, double-click it on the Views tab in Project Navigator.

When you add the detail view to a sheet, the detail number and sheet number are resolved in the marks on the detail and general view drawings.

### Creating a Section View

You can add a section mark to a view drawing while creating a new section view drawing. Because the section view is generated from a general view, and the general view references a construct, you can automatically update the section view to reflect any changes to the construct.

1 Open the general view drawing to add the section mark.

2 On the Annotation tool palette, click the section mark tool.

**NOTE** Alternatively, use the Annotate ribbon tab and the Callouts panel to locate section mark tools.
3 In the drawing, specify the points for the section line.  
The section line determines one side of the drawing boundary.

4 At the location where you want to add the mark, press Enter.

5 Specify the section extents. The parts of the drawing enclosed by 
the section extents will be included in the new section view 
drawing.

6 In the Place Callout dialog, for New Model Space View Name, 
specify a name to display in the title mark of the new section 
view.

7 Verify that Generate Section/Elevation is selected.

8 For Scale, specify the drawing scale for the detail view.

9 Under Create in, click New View Drawing.
10 In the Add Section/Elevation View dialog, specify the drawing information:
   ■ Name: Specify a file name.
   ■ Category: Specify a new directory location.
   ■ Drawing Template: Verify the template to use for the view drawing. This is the template specified in the project settings.

11 Click Next.

12 Specify the floors of the building plan used in this view drawing. The constructs that you want to use in the view must be assigned to the same floors.

13 Click Next.

14 Specify what constructs to use in the view. The constructs you select are attached as reference drawings to the view drawing. If a drawing is referenced as an overlay in a view drawing, it will not be included when you add the view drawing to a sheet.

   NOTE If the construct drawing you want to use includes an overlay reference drawing, such as a building floor plan, you must select the reference drawing in addition to the construct drawing in order for it to display on the view drawing.

15 Click OK.

16 In the general view drawing, specify the insertion point for the new section view.

   The new section view will not be inserted in the general view drawing; you are specifying its location in the new drawing. It is recommended that you specify a point away from the drawing geometry. You can use the zoom and pan commands to move to an open area in the drawing without closing the generate section view command.
The new section view drawing is created, but not opened. The detail number and sheet number referenced in the section mark display as ?.

17 Save and close the general view drawing.
18 To open the new section view drawing, double-click it on the Views tab in Project Navigator.
19 Zoom extents to display the drawing contents.
   The reference drawings are displayed in plan view. The section view is located at the point you specified in the general view drawing. The layers for each drawing object are preserved through
Creating an Elevation View

You can add an elevation mark to a view drawing while creating a new elevation view drawing. Because the elevation view is generated from a general view, and the general view references a construct, you can automatically update the elevation view drawing to reflect any changes to the construct.

1. Open the general view drawing to add the elevation mark.
2. On the Annotation tool palette, click the elevation mark tool.

   NOTE Alternatively, use the Annotate ribbon tab and the Callouts panel to locate elevation mark tools.

3. In the drawing, specify the location for the elevation mark.
4. Specify the viewing direction for the elevation mark.
5. In the Place Callout dialog, for New Model Space View Name, specify a name that will be displayed in the title mark of the new section view.
6. Verify that Generate Section/Elevation is selected.
7. For Scale, specify the drawing scale for the detail view.
8 Under Create in, click New View Drawing.
9 In the Add Section/Elevation View dialog, specify the drawing information:
   ■ Name: Specify a file name.
   ■ Category: Specify a new directory location.
   ■ Drawing Template: Verify the template to use for the view drawing. This is the template specified in the project settings.
10 Click Next.
11 Specify the floors of the building plan used in this view drawing. The constructs that you want to use in the view must be assigned to the same floors.
12 Click Next.
13 Specify what constructs to use in the view. The constructs you select are attached as reference drawings to the view drawing. If a drawing is referenced as an overlay in a view drawing, it will not be included when you add the view drawing to a sheet.

**NOTE** If the construct drawing you want to use includes an overlay reference drawing, such as a building floor plan, you must select the reference drawing in addition to the construct drawing in order for it to display on the view drawing.

14 Click OK.
15 In the drawing, specify corners of the elevation region. The parts of the drawing in the elevation region will be included in the new drawing.

16 In the general view drawing, specify the insertion point for the new elevation view.

The new view will not be inserted in the general view drawing; you are specifying its location in the new drawing. It is recommended that you specify a point away from the drawing geometry. You can use the zoom and pan commands to move to an open area in the drawing without closing the generate elevation view command.
17 The new view drawing is created, but not opened. The detail number and sheet number referenced in the elevation mark display as ?.

18 Save and close the general view drawing.

19 To open the new elevation view drawing, double-click it on the Views tab in Project Navigator.

20 Zoom extents to display the drawing contents.

The reference drawings are displayed in plan view. The elevation view is located at the point you specified in the general view drawing. The layers for each drawing object are preserved through
the elevation view. The elevation number in the title mark will be resolved when you place the elevation view on a sheet.

Updating a Section or Elevation View

If you modify a construct referenced in a view drawing with section or elevation marks, you can update the section or elevation view drawings to automatically reflect the changes to the construct.

1 On the Quick Access Toolbar, click Project Navigator.
2 On the Views tab of Project Navigator, open the drawing that contains the section or elevation view. You do not need to open the drawing that contains the section or elevation marks.
3 Click directly on the drawing geometry in the section or elevation view.
4 Click 2D Section/Elevation tab ➤ Modify panel ➤ Regenerate.
5 In the Generate Section/Elevation dialog, click OK to regenerate the section or elevation.

If you have already placed the section or elevation view on a sheet, the section or elevation view will update automatically the next time you open the sheet.
Sheets

Sheets are the construction documents that you publish or plot. You create blank sheets, and then place view drawings directly onto the sheets as reference drawings. The sheet references the view, which in turn references the construct. As a result, any changes to the construct are automatically reflected in the affected view and sheet drawings when you open them or reload their referenced drawings.

Creating a Sheet

When you create a sheet, you can add views for general plans, schedules, details, sections, and elevations. You can publish or plot a group of sheets as a sheet set.

1 On the Quick Access Toolbar, click Project Navigator ➤.
2 On Project Navigator, click the Sheets tab.
3 Navigate to the subdirectory where you want to add the sheet.
   You can create subdirectories by right-clicking a directory, and then clicking New ➤ Subset.
4 Right-click the subdirectory, and click New ➤ Sheet.
5 In the New Sheet dialog, specify a number and sheet title, and click OK.
   The new sheet is created, but not opened.
6 Open the new sheet by double-clicking it.
7 On Project Navigator, click the Views tab.
8 In the Views directory, navigate to the view drawing that you want to place on the sheet.

IMPORTANT If you want to place a schedule on a sheet, you must first add a viewport to the sheet. Click View tab ➤ Viewports panel ➤ Named and specify a viewport window on the sheet.

9 Drag the view drawing onto the sheet.
If you want to change the size of the view on the sheet, right-click and select a new scale.

### NOTE
If you are placing a detail, section, or elevation view, only the specific view is added to the sheet. The referenced plan view geometry is not displayed.

10 Specify the insertion point for the view.

11 To turn off grid marks in the viewport, double-click inside the viewport window.

12 Deselect Grid in the application status bar, then double-click outside the viewport window.

13 If desired, you can place more than one view on a sheet. You can also use a view on more than one sheet.

The default sheet templates in the software include a layout grid to aid in locating views on a sheet. This grid is not included in plots or DWF™ output.

To move the viewport on the sheet, select the viewport boundary and use the basic modify tools in the context menu. You can adjust the viewport size to change the viewable portion of the view drawing. You can also activate the model space view by double-clicking inside the viewport. After you activate the model space view, you can move or zoom the view drawing within the viewport. Double-click outside the viewport to deactivate the model space.
view and return to paper space. In paper space, you cannot modify the drawing within the viewport.

If you are placing detail, section, or elevation views on a sheet, the mark number and sheet number resolve on both the source view drawing and model space view drawing. If you change the drawing name or directory location for either view drawing, however, the mark and sheet number link will break. You may need to recreate the mark to automatically resolve the number links.

Creating a Cover Sheet

You can create a cover sheet with a sheet list table that is dynamically linked to the drawings in the sheet set. When you add the sheet list table, it automatically displays sheet names and numbers for all sheets in the sheet set. If you add, reorder, or remove sheets from the set, you can update the sheet list table automatically.

1. On the Quick Access Toolbar, click Project Navigator.
2. On the Sheets tab of Project Navigator, create a new sheet as shown in Creating a Sheet on page 857.
3. Open the new sheet.
4. If necessary, change the Sheets tab to Sheet Set View.
5. Right-click the project name at the top of the sheet set directories, and click Insert Sheet List.
6. In the Insert Sheet List Table dialog, specify the sheet list table settings, and click OK.
7. When prompted with a warning about manually editing the sheet list, click OK.
8. Specify the sheet list location on the sheet.

To update the sheet set

9. Open the sheet that contains the sheet list.
10. Select the outside border of the sheet list table.
11. Right-click, and click Update Sheet List Table.

Ordering Sheets in the Sheet Set

For sheet list tables and sheet set publishing purposes, the default order of the sheets is exactly the same as they are ordered on the Sheets tab of Project
Navigator. To reorder the sheets, drag them to the desired location in the Sheet Set View. For example, if you want your cover sheet to appear first in the sheet set, drag it to the top of the sheet set view. If you do not want to include a drawing in the sheet set, right-click it and click Remove Sheet. This does not delete the sheet; it only removes it from the sheet set.

When plotting or publishing a sheet set, you can reorder, add, or remove sheets in the Publish dialog. Note that these changes will not be reflected in the sheet list table, however, and may result in publishing output of individual drawings rather than a complete set of project drawings in one DWF file.

**Publishing a Sheet Set to DWF™**

You can publish a sheet set to DWF™ directly from AutoCAD MEP. DWF™ files are typically much smaller in file size than regular drawings, and they can be easily shared among all parties involved in facility design and construction.

1. On the Quick Access Toolbar, click Project Navigator.
2. On the Sheets tab of Project Navigator, right-click the directory that contains the sheets you want to publish, and click Publish ➤ Publish Dialog Box.
   
   To publish all drawings, right-click the project name at the top of the sheets directories, and click Publish ➤ Publish Dialog Box.
3. In the Publish dialog, under Publish to, select DWF file.
4. Click Publish.
5. Specify a file location, and click Select.

**Adding Elevation Labels**

You can add elevation labels to your drawings. Elevation labels are useful when creating construction documentation. Adding elevation labels to your drawing helps the building contractor verify that the elevation of the segment or run meets the slope requirements of the building systems. Elevation labels are accessed from DesignCenter. You can drag the elevation symbol from DesignCenter into your drawing, and select the segment to which you want to apply the elevation label. The elevation is read from the properties of the segment. If the elevation label displays the wrong elevation, then you should verify that your object is positioned correctly.
Elevation labels

NOTE You can create default elevations using the MEP Elevations tab in the Options dialog. For more information, see Defining System Elevations on page 106.

To add elevation labels

1. Click Insert tab ➤ Content panel drop-down ➤ Design Center.
2. Click the AEC Content tab.
3. In the left pane, expand Documentation ➤ Elevation Labels, and select the desired subdirectory.
4. In the right pane, select the elevation label that you want to add.
5. Drag the elevation label from DesignCenter into your drawing.
6. Select the object in your drawing to which to apply the elevation label.

WARNING If you change the elevation of the object, you need to move the elevation label to the object to update the elevation displayed in the value.

If you want to use an elevation symbol repeatedly, drag the elevation label from DesignCenter directly onto a tool palette to create an elevation label tool.

Checking Your Drawings

After drafting your building systems layouts, you need to check for valid connections between parts, completed runs from start point to endpoint, and interferences between other building systems components or structural members. You may also need to verify specific object connections. AutoCAD MEP provides tools to assist you in checking your layout:

Show Solution Tips. This command shows invalid connections between components by displaying a solution tip icon at the invalid connection points. For more information, see Showing Solution Tips on page 862.
■ **Show Connected Run.** This command displays a complete run of connected components by highlighting the run from start to end. For more information, see *Showing Connected Runs* on page 864.

■ **Show Connected Objects.** This command highlights the objects that are connected to a selected object. For more information, see *Showing Connected Objects* on page 865.

■ **Interference Detection.** This feature finds interferences between building systems or AEC structural objects by highlighting the intersecting portions of the objects. For more information, see *Finding Interferences* on page 865.

■ **Show Circuited Devices.** In electrical system drawings, you can use this command to highlight the devices that are connected to a selected circuit. For more information, see *Showing Circuited Devices* on page 643.

### Showing Solution Tips

During layout you must create valid connections between components to maintain intelligent building systems networks. Valid connections maintain consistency between components, including size, shape, type of system, and various part properties. You should test for valid connections.

Valid connections are determined by connector style rules, which define properties that must match between objects. A connector style has preset properties for which rules can be defined. For example, you can test for connection type and domain to prevent accidentally connecting a segment or run of the wrong connection type to an MvPart. For more information, see *Connector Styles* on page 919.

Solution tip icons highlight invalid connections between objects. Invalid connections can be fixed by modifying the objects that are causing the invalid connection:

■ You can use grips to modify the object, and connect to adjacent objects.

■ You can modify the object system to match adjacent objects, or change the system to the same system group as the adjacent objects.

■ You can modify the connector style rules that apply to the objects.

■ You can delete a segment or portion of the network and draft new objects using the MEP snaps.
To test for valid connections

1 Verify the connector style rules:
   ■ Click Manage tab ➤ Style & Display panel ➤ Style Manager.
   ■ Expand Multi-Purpose Objects, and then expand Connector Styles.
   ■ Click the Rules tab, and verify the connector style rules.
   ■ Click OK.

To show solution tip icons

2 Click View tab ➤ MEP View panel ➤ Solution Tips.
   The solution tip icons are displayed. You can move your mouse over a solution tip icon to display a tooltip describing the reason for the disconnection.

To change the size of the solution tip icon

3 If desired, you can change the size of the solution tip icon:
   ■ Click View tab ➤ MEP View panel ➤ Solution Tip Size.
   ■ Enter a size.
   The drawing is regenerated and the size of the solution tip icon is updated.

   NOTE Solution tip icons remain on (visible) until you fix the invalid connection and regenerate your drawing. You can turn off solution tip icons by clicking View tab ➤ MEP View panel ➤ Solution Tips.

To control when solution tip icons display

4 Click Options.
5 In the Options dialog, click the AEC Editor tab.

6 Under Solution Tip, select options for displaying solution tip icons.
Select Drafting to display solution tip icons as you work in a drawing file. Select Plotting/Publishing to display solution tip icons when plotting or publishing a drawing file.

**NOTE** You can also control the display of solution tip icons while drafting by clicking View tab ➤ MEP View panel ➤ Solution Tips.

**Showing Connected Runs**

For mechanical, electrical, and piping systems, an entire run can be highlighted. This feature can be helpful when designs are complicated or when you need to verify connectivity.
The connector style rules determine whether valid connections exist between objects. If an invalid connection is detected within the run, the run is highlighted only up to the invalid connection.

In addition to equipment, a branch, such as a tee or cross, typically represents the start point or endpoint of a run. When a branch is detected within a run, the highlighting ends at the branch.

To show a connected run

1. Click Duct/Pipe/Wire etc. tab ➤ Modify panel ➤ Show Connected Objects drop-down ➤ Show Connected Run.

The connected run is highlighted.

2. Press ENTER.

Showing Connected Objects

You can show all objects that are connected to a particular object in a drawing.

1. Click Duct/Pipe/Wire etc. tab ➤ Modify panel ➤ Show Connected Objects drop-down ➤ Show Connected Objects.

2. Press ENTER.

Finding Interferences

When you run interference detection, the software checks for interferences between the types of objects you specify. You can check for interferences between

- Building systems objects, for example, between ducts and pipes
- Building systems objects and architectural/structural objects, for example, between ducts and walls

The software checks for interferences between objects in the current drawing, between objects in referenced drawings (xrefs), or both (that is, between objects in the current drawing that interfere with those in an xref). When an interference is found, a mass element indicating the interference is inserted at the location. The mass element is removed when you exit interference detection mode, unless the setting to keep mass elements is enabled. In addition, you can add tags to the mass elements and insert opening symbols.
to show where openings in walls or other structural objects are needed. Also, tags and symbols are removed when you exit interference detection, unless you specify that they remain.

**IMPORTANT** Interference detection works with 3D objects (whether multi-view block-based or parametric). For plumbing systems, interference detection works only with equipment and fixtures, not plumbing lines.

Running interference detection is helpful for doing the following:

- **Analyzing interferences after routing a service (such as supply and return duct), or analyzing interferences for duct objects and MvParts against walls, doors, windows, columns, and beams.**

- **Coordinating between disciplines for hard and soft clashes.** For example, you can ensure that a supply and return system doesn’t clash into other MEP Systems and that there is enough room to mount and maintain the systems. A hard clash occurs when the geometry or 3D volume of an item or object intersects that of another item or object. A soft clash occurs when the space surrounding an item or object intersects that of another item or object. The surrounding space around an object is defined by an offset value and can be configured for pipe work, duct work, cable trays, conduits, and hangers. Hard clashes are usually more noticeable in drawings, while soft clashes are harder to detect.

- **Communicating the need for holes in structural components, such as holes in load bearing walls for duct work.**

**NOTE** When you run interference detection, the detected interferences are shown by highlighting the intersecting portions of the objects. By default, the interference highlighting color is red for hard clashes and yellow for soft clashes. Prior to running interference detection, you may want to temporarily change the color of any AutoCAD MEP objects and AEC structural members to a color other then red or yellow. As an alternative to changing colors, you may want create a display configuration set to use with interference detection.

### Running Interference Detection

When you run interference detection, you can check for interferences between MEP objects, or between MEP objects and building elements. For example, while designing a supply and return duct system, you can make sure that the supply and return duct do not interfere with each other. You can also make

---

866 | Chapter 12  Creating Construction Documents
sure that the duct systems do not interfere with any architectural or structural objects.

**To start interference detection**

1. Click Analyze tab ➤ Inquiry panel ➤ Interference Detection.

2. In the Interference Detection palette, under MEP Objects, select the types of building systems objects to be checked for interferences against other building system objects, or against architectural and structural objects. To either select all or clear all objects, right-click, and click Select All or Clear All.

3. Under Building Elements, select the types of architectural and structural objects to be checked for interferences against MEP objects. To either select all or clear all elements, right-click, and click Select All or Clear All.

4. For Clearance Check, specify whether to check for clearances and soft interferences. If set to yes, then specify the clearance offsets for each object type.

5. Click Start Interference Analysis.

**NOTE** The Interference Analysis mode works on a per drawing basis. If you switch to another drawing, the Interference Detection palette will be updated, based on the currently active drawing.

The interferences are listed in the Interferences section of the Interference Detection palette, and are highlighted in the drawing. The Interference
Detection panel is available while in Interference Detection mode. For more information, see Viewing and Resolving Interferences on page 868.

NOTE The tolerance for interferences is calculated to 5 decimal places.

**Viewing and Resolving Interferences**

With a drawing open, click Analyze tab ➤ Inquiry panel ➤ Interference Detection 🎥. On the Interference Detection palette, click ☰️ to start the
When the analysis is completed, locate the Edit in Place tab on the ribbon to view the Interference Detection panel.

**Interference Detection panel**

Use the information in the following table to help you view and resolve each interference:

<table>
<thead>
<tr>
<th>To...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>sort the entries displayed in the list view of the Interference Detection palette</td>
<td>click the name of the column heading to sort by that column</td>
</tr>
<tr>
<td>zoom to an interference</td>
<td>in the Interference Detection palette, select an interference</td>
</tr>
<tr>
<td><strong>NOTE</strong> In order to zoom to an interference in the drawing by selecting it from the palette, zoom to mode must be enabled by clicking Activate Zoom To.</td>
<td></td>
</tr>
<tr>
<td>move between the interferences in the list view and in the drawing</td>
<td>click the Previous Interference and Next Interference buttons on the Interference Detection panel</td>
</tr>
<tr>
<td>automatically zoom to one or more interferences</td>
<td>click Zoom To on the Interference Detection panel to toggle zoom mode, and then select one or more interferences in the drawing</td>
</tr>
<tr>
<td>select and highlight an interference object in the list view</td>
<td>click Select interference mass elements to highlight in interference list, select an interference in the drawing, and press Enter</td>
</tr>
</tbody>
</table>
To... then...

remove interferences from the drawing or the list view select one or more interferences in the drawing, and then press Delete

NOTE Selecting and deleting an interference from the drawing does not automatically delete the interference(s) from the list view.

hide the Interference Detection palette to view more of the drawing click Hide Palette

NOTE Use the Next Interference and Previous Interference buttons on the Interference Detection panel to move from one interference to the next.

resolve interferences use tools or commands to add or modify MEP objects

NOTE Resolving interferences does not automatically remove them from the list view and the drawing. You must either run the Interference Analysis again, or manually remove the interferences. You should also run the analysis again to view any new interferences that may have been caused by adding objects.

Tagging Interferences or Openings

You can communicate the need for holes in structural components using interference detection. For example, you might want to create a drawing with information about holes in load bearing walls for duct work. After interference detection locates the interferences in a drawing, you can insert an opening symbol or a tag, with information about the size and elevation for each opening. Also, you might want to add tags to all interferences (mass elements) in a drawing in order to schedule and document the interferences if they are going to be resolved by other people.
To insert an opening symbol for an interference

1 In the list view, select one or more interference objects.
2 On the Interference Detection palette, under Settings, select an opening symbol location and name from the list.

**NOTE** When you specify the location, the names of all opening symbols in the specified drawing are listed.

3 Click Create Opening Symbols 🗻.

The opening symbol is scaled to the size of the interference in plan view.

To create a tag for an interference

1 In the list view, select one or more interference objects.
2 In the Interference Detection palette, under Settings, select a tag location and name from the list.

**NOTE** When you specify the location, the name of all tags and Mvblocks in the specified drawing are listed.

3 Click Create Tags 🗻.

The Interference Tag is anchored to the interference mass element and will be removed if the mass element is removed.

**NOTE** You can create an interference report that lists the interferences in your drawing. You must first tag the interferences that you want to include in the report, and then use the `SCHEDULEADD` command. A default schedule for interferences is provided. For more information about creating a schedule, see Adding a Schedule on page 842.

**Interference Report schedule**

<table>
<thead>
<tr>
<th>Interference Report</th>
<th>Number</th>
<th>Interfering objects</th>
<th>Responsibility/Status</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Duct Fitting &amp; Duct Fitting</td>
<td></td>
<td>New</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Duct &amp; wall</td>
<td></td>
<td>-</td>
<td>New</td>
</tr>
</tbody>
</table>
Exiting Interference Detection

To exit interference detection, click End Interference Analysis. Mass elements created during the session, as well as tags attached to them will be removed. However, opening symbols that were inserted will remain.

You can save the interferences created in a drawing. On the Interference Detection palette, under Settings, for Keep interference mass elements when ending analysis mode, select Yes.

If you want to keep only specific interferences when ending interference detection, prior to exiting, remove the ones you do not want to keep. See Viewing and Resolving Interferences on page 868 for information about how to remove interferences.

**NOTE** When you exit interference detection, the interference analysis is ended for the current drawing only. If you have analyzed multiple drawings, you must exit interference detection for each drawing.

**NOTE** To have collisions appear in red while drawing, turn on collision detection. On the command line, enter `CollisionDetection`. Be sure to turn off collision detection when no longer needed in order to preserve system resources.

Excluding a Material from 2D Section Shrinkwrap

Use this procedure to exclude components with a specific material assigned to them from the shrinkwrap of a 2D section.

When you create a 2D section, you can display a section component named Shrinkwrap. The shrinkwrap is the union of all object faces cut by the section line, merged into one component with one hatch pattern. This is a view frequently used for a 2D section.

By default, all components that are assigned materials are included in the shrinkwrap. However, you may want to exclude certain materials, such as glass, from the shrinkwrap.
2D section shrinkwrap with glass excluded (left)

For more information on shrinkwrap, see the AutoCAD Architecture Help.

1 Select a component with the style definitions group that contains the style you want to change, and then:
   - Click Duct tab ➤ General panel ➤ Edit System Style drop-down ➤ Edit Duct Style .
   - Click Pipe tab ➤ General panel ➤ Edit System Style drop-down ➤ Edit Pipe Style .
   - Click Cable Tray tab ➤ General panel ➤ Edit System Style drop-down ➤ Edit System Style .
   - Click Cable Tray Fitting tab ➤ General panel ➤ Edit System Style drop-down ➤ Edit System Style .
   - Click Pipe tab ➤ General panel ➤ Edit System Style drop-down ➤ Edit System Style .

2 In the left pane of the Style Manager, select the system style that is assigned the material you want to exclude from the shrinkwrap section.

3 Click the Other tab.

4 Select Exclude from 2D Section Shrinkwrap.

5 Click OK.
Collecting Project Data

Collecting project data from your layout in order to create accurate schedules is an important part of any building design project. Scheduling tends to be one of the most complex and time-consuming tasks in creating construction documents. AutoCAD MEP provides the flexibility to create and use schedule tables that are linked dynamically to your AutoCAD MEP objects. Dynamically linked schedule tables allow you to create and update schedules throughout the design process, rather than waiting until the end of the project. Schedule tables also maintain accuracy between your design layouts and the associated schedules. For information on adding schedules to drawings, see Schedules on page 842.

Schedule tables can be added to your drawings or exported to an external spreadsheet. The following steps provide an overview of the process of creating schedules:

- Add property sets to the object type that you want to schedule. You can apply property sets by tagging equipment, or by adding object or style-based property sets from the Extended Data tab of the Properties palette. If you want to create a custom property set, you can create or edit the property set definition in Style Manager.

- Specify property set values as desired for fields that can be edited manually. You can do this when you tag an object or add property sets, or you can do it at any time using the Extended Data tab of the Properties palette.

- Use a schedule tool to add a schedule. The schedule format is based on the schedule table style. The schedule table is populated with the property set values from the selected objects.

- Modify the schedule table style, if necessary, using Style Manager. You can modify the appearance of the headers and columns in the table, and you can specify what property set data to display.

AutoCAD MEP provides a collection of mechanical, electrical, and plumbing-specific schedule tags, such as those for HVAC, piping, equipment, plumbing fixtures, light fixtures, and circuit schedules. AutoCAD MEP also provides a collection of schedule table styles you can use or customize to meet your needs. Available schedule table styles include styles for creating equipment, fixture, and lighting schedules. You can access default schedule tags, property set definitions, and schedule table styles in drawings located in \ProgramData\Autodesk\MEP 2011\enu\Styles.
Schedule tables and the associated object properties are customizable. Customizing can be as simple as rearranging, adding, or deleting columns from a schedule table style, or as complex as creating a custom-defined report specific to a unique design or project.

Defining Property Set Definitions

Property set data that is used to generate schedule tables is created from property set definitions attached to the object. Property set definitions establish object properties that can be dynamically linked to schedule tables.

You can also use classifications to define the type of objects to which to apply the property sets. That means that you can create a certain property set for objects classified as air terminals, and another for objects classified as VAV units.

Property set definitions can be either style-based or object-based. Style-based definitions apply to all objects of a specific style, while object-based definitions apply to individual objects. For example, a Manufacturer property will probably be the same for every instance of a particular damper or MvPart style, so it should be in a style-based property set definition. However, a RegisterNumber property is different for each instance of a damper, so it should be in an object-based property set definition. Your strategy for creating style-based versus object-based property set definitions should be based on how often information might change.

AutoCAD MEP provides a group of property set definitions based on industry-standard schedules. When you use schedule tags and schedule tables, the supplied property set definitions are loaded into your drawing. You can merge, edit, and delete property set definitions. You can share property set definitions between drawings. You can also customize the part catalogs to include part properties that can be added to property set definitions. For more information, see Property Set Definitions in the AutoCAD Architecture online help.

To create your own object properties within a property set definition, you can write your own property definition formula. For example, to estimate the cost of a particular length of pipe, you can create a definition property set formula such as length x $2.00 per foot = cost.
Defining Property Set Data

You define property set data for an object by establishing a link to one or more property set definitions. The property set data assigns a value for each object property in the property set definition(s). Automatic property values are defined based on the attached object or style and are dynamically updated when the object or style is modified. Manual property values are numbers or text strings that you enter, and they can be modified at any time.

Property set data can be attached to an object, object style, or object definition. You can also edit or browse property set data or renumber any property set that increments automatically, such as a register number.

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then on the Properties Palette…</th>
</tr>
</thead>
<tbody>
<tr>
<td>attach property set data to a selected object</td>
<td>click the Extended Data tab, and click Add property sets. In the Add Property Sets dialog, select the property sets to attach to the object. You can also attach property sets to devices by specifying the property sets in the properties of device tools. For more information, see Creating Tools for Style-Based Content on page 1179. <strong>NOTE</strong> To attach property set data to object styles or definitions, assign the property sets to the style or definition in Style Manager.</td>
</tr>
<tr>
<td>edit property set data for one or more selected objects</td>
<td>click the Extended Data tab, and edit the property set values that can be manually edited. If you edit a property set for a scheduled object, you can update the schedule to reflect the change.</td>
</tr>
<tr>
<td>remove property sets from selected objects</td>
<td>click the Extended Data tab, and click Remove property sets. In the Remove Property Sets dialog, select the property set definitions to remove from the object.</td>
</tr>
<tr>
<td>change the property set value to renumber selected objects</td>
<td>click the Extended Data tab, and change the start number and/or increment value.</td>
</tr>
</tbody>
</table>
Using Classifications

Classifications enable you to sort objects by creating a classification style that contains user-defined values to choose from. These classification styles are stored within the object style. You can use the classification styles to display and schedule objects. AutoCAD MEP automatically classifies objects such as multi-view parts (MvParts) and fittings. This means when you insert an air terminal into your drawing, the air terminal is classified as an MvPart with an Air_Terminal type. This enables you to create a schedule that only contains air terminals, without having to include all of the MvParts in your drawing.

Because most equipment in the software are MvParts, many equipment schedule styles use classifications to ensure that the schedule table is only populated with data from the desired part types.

Copying a Schedule Table Style

You can copy a schedule table style from another drawing and modify it to your requirements.

1. Open both drawings: the one that contains the schedule table style you want to copy, and the drawing to receive the schedule table style.

2. Click Manage tab ➤ Style & Display panel ➤ Style Manager.
3 In the left pane, expand the drawing that contains the style you want to copy.
4 Expand Documentation Objects ➤ Schedule Table Styles.
5 Right-click the desired schedule table style, and click Copy.
6 Expand the drawing to receive the schedule table style.
7 Expand Documentation Objects ➤ Schedule Table Styles.
8 Right-click Schedule Table Styles, and click Paste.

Purging AutoCAD MEP Objects

Use this procedure to remove unused AutoCAD MEP objects from a drawing. Removing objects that are not currently used helps to control drawing file size.

NOTE To purge unused system definitions, use the Style Manager. For more information, see Purging Systems on page 149.

To purge AutoCAD MEP objects

1 Click Utilities ➤ Purge AutoCAD MEP Objects. All unused AutoCAD MEP objects are removed from the drawing.
2 When finished, the number of items purged is displayed on the command line.

RELATED You can also run the AutoCAD purge command to remove AutoCAD-based objects such as unused blocks and layers.

Sharing Drawings

Sharing drawings is necessary in many stages of the drawing development cycle. For example, you may be asked to add a mechanical, electrical, or plumbing system to a drawing that was created in another software program. AutoCAD MEP provides an object enabler so that you can work with custom objects contained in the drawing.
You may want to share drawings using an internet-based collaboration tool like Autodesk Buzzsaw. In this case you can use a design web format (DWF) to create a file that others can view.

This section describes the tools available for sharing your AutoCAD MEP drawings. Each segment describes a tool and how it is accessed.

**Displaying Custom Objects**

If you open a drawing that includes a custom object that was not drawn in AutoCAD MEP, AutoCAD MEP installs an object enabler, if one is available. If an object enabler is not available, the software uses proxy graphics to display objects. You can enable proxy graphics in the Options dialog.

**Object Enablers**

Enablers are collaboration utilities that allow users of other Autodesk products to view and manipulate objects created in AutoCAD MEP. Enablers use ObjectDBX technology to allow object data created in AutoCAD MEP to be accessed outside its native environment. This provides data accessibility for design teams that create and receive AutoCAD MEP files.

If you open an AutoCAD MEP drawing that contains an object created in a different Autodesk product, AutoCAD MEP can automatically check [http://www.autodesk.com](http://www.autodesk.com) for an object enabler to use to display the object. If it fails to find one, the object is displayed using proxy graphics instead.

To control whether AutoCAD MEP checks for object enablers, use the Live Enabler options on the System tab of the Options dialog. You can also manually check for object enablers at [http://www.autodesk.com/enablers](http://www.autodesk.com/enablers).

For more information, see Set Interface Options.

**Proxy Graphics**

If a LiveEnabler is not available for an object, the object may be replaced with a proxy graphic. A proxy graphic is a placeholder that represents the object. This placeholder does not have the full display or attributes of the object.
When proxy objects are drawn, AutoCAD MEP displays the Proxy Information dialog. The dialog gives you the following information:

- The total number of graphical and non-graphical proxy objects in the drawing
- The name of the missing application
- The proxy object type and display state

You can use the Proxy Information dialog to control the display of proxy objects.

**Export to AutoCAD**

You can create a new version of a drawing file with all AutoCAD MEP objects exploded into basic AutoCAD objects. The new version of the drawing loses the intelligence of the AutoCAD MEP objects, but the resulting basic objects can be displayed and accessed in earlier versions of AutoCAD when object enablers are not available for those versions.

When you export an AutoCAD MEP drawing to AutoCAD, all objects in the drawing are converted, depending on the selected view, either plan or 3D. AutoCAD converts 3D view objects to AutoCAD solids, and plan view objects to AutoCAD line work. Reference drawing geometry is converted to linework in a block reference. If you want to remove the block reference, use the explode command to convert the block reference to active linework.

Whether you export a drawing to AutoCAD or DXF format, the layers, colors, and linetypes of the AutoCAD MEP objects are preserved in the new drawing. For information on how annotation is handled, see Exporting Annotated Drawings to AutoCAD on page 824.

**To export to AutoCAD**

1. Open the AutoCAD MEP drawing you want to export.
2. Click ➤ Export ➤ AutoCAD ➤ AutoCAD 2000.
3. In the Export drawing name dialog, specify a file name and directory location for the new drawing, and click Save. The new drawing is created, but not opened.
Posting and Plotting Your Drawings

You can create a design web format (DWF) file to share your drawings electronically, or you can plot your drawing to a sheet. You can distribute drawings effectively using either method. For more information, see Publishing a Sheet Set to DWF™ on page 860.

Plotting

Plotter Manager lists plotter configuration (PC3) files for every non-system printer you install. Plotter configuration settings specify port information, raster and vector graphics quality, paper, and custom properties that depend on the plotter type. To open Plotter Manager, click ➤ Print ➤ Manage Plot Styles. To add a new plotter, double-click Add-A-Plotter Wizard.

You can use Plot Style Manager to add, delete, rename, copy, and edit plot style tables. Plot style tables collect groups of plot styles. A plot style controls how an object or layer is plotted by determining plotted properties, such as lineweight, color, and fill style. The Plot Style Manager is a window that shows all the plot style tables available in AutoCAD®. To open Plot Style Manager, click ➤ Print ➤ Manage Plot Styles.

When you want to preview the sheet to be plotted, click ➤ Print ➤ Plot Preview.

Comparing Drawings

A typical project requires multiple reviews at various stages in the project life cycle. When you send drawings out for review and comment, often you receive drawings containing proposed changes in return. The Drawing Compare feature allows you to visually compare the different versions and review proposed changes from architects and other engineering disciplines.

Like the traditional method of overlaying trace onto project drawings, visual cues indicate the status of drawings being compared and the state of the objects being reviewed. In addition, information is provided about changes to the
properties of the objects. For more information, see Starting a Drawing Compare Session in the AutoCAD Architecture online Help.

**NOTE** This feature is available only to customers participating in the Autodesk Subscription Program. For more information, go to [http://pointa.autodesk.com](http://pointa.autodesk.com).

### Using Industry Foundation Classes

The International Alliance for Interoperability (IAI) has established international standards for common architectural and construction objects in the building industry. In particular, the International Alliance for Interoperability developed an Industry Foundation Classes (IFC) data model to define CAD graphic data as 3D real-world objects. The IFC file format provides interoperability between IFC-certified software applications and reduces loss of information when files are transmitted.

You can export drawings saved in AutoCAD MEP to the IFC format and then import the file into another IFC-certified application. The dimensions of any 3D architectural objects, including building system objects, are preserved when exporting to IFC.

Before you can export an MEP drawing file to IFC, you need to map each MEP object to the appropriate IFC classification. This step allows MEP objects developed in AutoCAD MEP to display properly in other IFC-certified applications.

You can assign IFC classifications to the following MEP objects:

- Cable tray
- Cable tray fitting
- Conduit
- Conduit fitting
- Duct
- Duct custom fitting
- Duct fitting
- Duct flex
- Hanger
- Multi-View part
The IfcShareBldgElements (MEP) DWG drawing file contains the IFC classifications for these MEP objects. This file resides at \ProgramData\Autodesk\MEP 2011\enu\Styles. The following IFC object classifications are supported in AutoCAD MEP:

- IfcDistributionChamberElement
- IfcDistributionControlElement
- IfcDistributionFlowElement
- IfcEnergyConversionDevice
- IfcFlowController
- IfcFlowFitting
- IfcFlowMovingDevice
- IfcFlowSegment
- IfcFlowStorageDevice
- IfcFlowTerminal
- IfcFlowTreatmentDevice
- IfcElectricDistributionPoint

Use the following procedure to assign IFC classifications to MEP objects prior to exporting to an IFC file:

**To set up IFC classifications in AutoCAD MEP**

1. Click ➤ Open ➤ Drawing to navigate to \ProgramData\Autodesk\MEP 2011\enu\Styles directory and open the IfcShareBldgElements (MEP).dwg file.
2 Click Manage tab ➤ Style & Display panel ➤ Style Manager ➤.

3 Expand Multi-Purpose Objects ➤ Classification Definitions ➤ ifcObjectClassification in the left pane.

4 Right-click ifcObjectClassification and click Copy.

5 Click Cancel to close the Style Manager.

6 Click ➤ Close to close the IfcShareBldgElements (MEP).dwg drawing file without saving it.

To map MEP objects to IFC

1 Open a drawing file that contains the MEP objects where you will assign IFC classifications.

2 Click Manage tab ➤ Style & Display panel ➤ Style Manager ➤.

3 Expand Multi-Purpose Objects ➤ Classification Definitions.
4 Right-click Classification Definitions and click Paste.

5 Click ifcObjectClassification in the left pane and then the Applies
   To tab in the right pane to see the applicable MEP objects (as
   shown below).
6 Click OK.
7 Select an MEP object in your drawing and click Home tab ➤ Build panel ➤ Tools drop-down ➤ Properties ➤ Properties .
8 Click the Extended Data tab on the Properties palette.
9 Under Classification, click next to IfcObjectClassification to open the Select Classification dialog.
To apply a new IFC classification to the selected MEP object, choose an IfcSharedBuildingServicesElement property from the list and click OK.

Your selection appears next to IFCObjectClassification on the Extended Data tab on the Properties palette. Repeat this step for each MEP object in your drawing.
**TIP** You can also click on the Quick Select icon at the upper right corner of the Properties palette to select multiple MEP objects with the same classification and then classify them on the Extended Data tab.

**NOTE** You might be unable to map some MEP objects directly to IFC. For example, you might choose to map an MvPart to IfcFlowFitting if the classification is Junction_Box, to IfcFlowMovingDevice if the classification is Fan, or to IfcFlowTerminal if the classification is Air_Terminal. Alternately, you can also leave the IFC classification as unspecified.

11 Save your drawing file before exporting it to an IFC file.

**To export or import IFC files**

1 To export, click ➤ Export ➤ IFC (Industry Foundation Classes).

Following the export, you can open the new IFC file in a third-party IFC viewer. The IFC classifications appear for each object that you defined previously.

2 To import a file, click ➤ Open ➤ IFC (Industry Foundation Classes).

The imported IFC file is imported as a referenced drawing (xref). You can check that the MEP objects were properly preserved.

3 To edit objects in the imported file, select an object and click External Reference tab ➤ Edit panel ➤ Edit Reference In-Place.

**NOTE** See Importing and Exporting IFC Files in the AutoCAD Architecture Help for more information.

**Select a Style**

When you add a device, panel, or part to a drawing, you can use the Properties palette to choose a style to represent the new equipment.
To Select a Style

1. Enter DEVICEADD, PIPEADD, PANELADD, or other add-equipment command at the command line.
2. Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Properties .
3. On the Design tab, click the icon in the box labeled Style to display the Select a Style dialog box.

4. Select a drawing file from the drop-down list. These DWG files contain content. You can specify content DWG files on the MEP Options > Catalog tab.
5. Select a category of equipment from the drop-down list.
6. Choose the equipment style you want to insert and then click OK.

You can now add equipment to the drawing as needed.
Customizing Style-Based Content

You create style-based content by creating and configuring a new style.

To create schematic symbols, devices, panels, and plumbing fittings, which can require different appearances in different views (top, left, and so on), you also need to create the AutoCAD blocks (or an MvBlock) for the required views of the styles.

Workflow for Creating Style-Based Content

You create style-based content using the following high-level process:

**Review the steps**

1. Create or open the content library (DWG file) to contain the new style-based content.
2. Create at least one AutoCAD block to assign to a style view.

**View more information**

- See Creating a Style-Based Content Library on page 892.
- You perform this step if you are creating a schematic symbol, device, panel, or plumbing fitting, in the library drawing, create at least one AutoCAD block to assign to a style view. For more information, see Creating the Blocks for a Style on page 893.
Creating a Style-Based Content Library

When you create a style using Style Manager, the style is saved only in the current drawing. If your style-based content needs to be available for use in multiple drawings on a regular basis, create the style in a new or existing drawing that you can use as a library for permanent storage.

For example, if you want to have a library of symbols to use throughout a series of drawings for project ABC, open a new drawing called Project ABC Ortho Iso.dwg and create all of the styles in that drawing. The Project ABC Ortho Iso.dwg file acts as your style-based content library. Naming the drawing according to whether it contains symbols with orthographic and isometric views, or symbols with only orthographic views, helps users during symbol selection.
As you draw a building system, you can access the style-based content in a library if the library drawing is located in a folder specified as a default location for style-based content, or in one of its subfolders.

The following folder contains a set of customizable style-based content libraries: \ProgramData\Autodesk\MEP 2011\enu\MEPContent. The libraries have unique drawing names based on the type of content they contain.

**NOTE** Before customizing the libraries provided with the software, make a copy of the original libraries.

### Creating the Blocks for a Style

To create a new schematic symbol, device, panel, or plumbing fitting, you must have at least one block to assign to a view of the style.

**NOTE** You should draw objects in blocks using line, trace, hatch, or solid, and not polyline.

You can use a simple 2D AutoCAD® block that is displayed the same in all view directions, such as in the view directions of an orthographic symbol. You can also use a Multi-view block (MvBlock) that has a different appearance for each view direction, such as the different views of an isometric symbol. The individual blocks you create are referred to as view blocks.

The number and types of blocks that you need depend on your requirements. For a schematic symbol style, typically you can create one 2D block to represent the symbol in a plan view. If you need to create isometric drawings, you can use this block to generate additional blocks for the 12 isometric views that represent the 12 isometric view directions and orientations.

For other types of style-based content, you need to create the 2D and 3D blocks required to represent the object in plan views and in model views. For example, a plumbing fitting style might require only a 2D block to represent the fitting in a plan view. Similarly, a device style might require a 2D block to symbolically represent the device in a plan view. However, if you need to create sections and elevations that display devices in actual size, the device style will also require a MvBlock for use in a model view (and in other view directions such as Front and Left).

Generally, when you insert style-based content, you want the symbol to inherit the color, linetype, and lineweight properties of the current layer standard. To ensure this, set the color, linetype, and lineweight properties individually for the geometry in each block. Create the geometry on layer 0, and specify
BYBLOCK for color, linetype, and lineweight, and an insertion point of 0,0,0. To ensure the correct view block assignment, assign a unique name to each block. Unique names are also helpful for identification.

**TIP** Use the styles (and blocks) provided with the software as a guide for creating your own custom styles.

For an introduction to orthographic and isometric views, see Orthographic and Isometric Views of Style-Based Content on page 127.

**Creating a Style**

1 In the active workspace, open the Style Manager to access styles by doing one of the following:

<table>
<thead>
<tr>
<th>Workspace</th>
<th>Ribbon Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical</td>
<td>Click Manage tab ➤ Style &amp; Display panel ➤ Style Manager drop-down ➤ Electrical Device Styles.</td>
</tr>
<tr>
<td>Electrical</td>
<td>Click Manage tab ➤ Style &amp; Display panel ➤ Style Manager drop-down ➤ Electrical Panel Styles.</td>
</tr>
<tr>
<td>Electrical</td>
<td>Click Manage tab ➤ Style &amp; Display panel ➤ Style Manager drop-down ➤ Wire Styles.</td>
</tr>
<tr>
<td>Plumbing</td>
<td>Click Manage tab ➤ Style &amp; Display panel ➤ Style Manager drop-down ➤ Plumbing Fitting Styles.</td>
</tr>
<tr>
<td>Plumbing</td>
<td>Click Manage tab ➤ Style &amp; Display panel ➤ Style Manager drop-down ➤ Plumbing Line Styles.</td>
</tr>
<tr>
<td>Schematic</td>
<td>Click Manage tab ➤ Style &amp; Display panel ➤ Style Manager drop-down ➤ Schematic Symbol Styles.</td>
</tr>
<tr>
<td><strong>Workspace</strong></td>
<td><strong>Ribbon Path</strong></td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Schematic</td>
<td>Click Manage tab ➤ Style &amp; Display panel ➤ Style Manager drop-down ➤ Schematic Line Styles.</td>
</tr>
</tbody>
</table>

**NOTE** To create new styles for Conduit, Cable Tray, Custom Duct/Pipe Fittings and other content, click Manage tab ➤ Style & Display panel ➤ Style Manager, and click the + sign to open a domain type. Then, you can access sub-domain styles.

2 Create the style:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then in the left pane of Style Manager…</th>
</tr>
</thead>
<tbody>
<tr>
<td>create a new, blank style</td>
<td>right-click the corresponding styles category (for example, Device Styles), and click New. Enter a name, and press Enter.</td>
</tr>
</tbody>
</table>
| copy an existing style | do the following:  
  ■ Right-click the style you want to copy, and click Copy.  
  ■ Right-click the corresponding styles category (for example, Device Styles), and click Paste.  
  ■ Right-click the copy, click Rename, enter a new name, and press Enter. |

3 On the General tab, enter a description for the style, and click Apply.

4 Specify the general properties the style. For help, see
   ■ Specifying the Design Rules of a Style on page 896
   ■ Defining the Views of a Style on page 898
   ■ Configuring the Connectors of a Style on page 906
   ■ Configuring the Display Properties of a Style on page 908

5 Specify any discipline-specific properties of the style. For help, see
   ■ Device Style Setup on page 541 and Configuring Styles for Wires on page 549
Editing Style-Based Content

You modify style-based content by modifying the properties of a style and, when applicable, its associated view blocks.

You modify the geometry of a view block manually in the drawing. To modify style properties, you can use

- The batch conversion tools available for creating and modifying schematic symbols and devices. For more information, see Customizing Schematic Symbol Content on page 940 and Customizing Device Content on page 921.
- Style Manager

In this case, the style changes are saved only in the current drawing. To apply your changes on a broader scale, open the content library drawing that contains the style, and modify the style within the library drawing. This makes the modified style available in all drawings that specify, in the Options dialog, the content location for the modified library drawing. (See Specifying Part Catalogs and Style-Based Content Locations on page 100.)

Configuring Styles

Styles are sets of properties that you can assign to objects to determine their appearance or function. For example, a schematic line style defines a schematic line's appearance, such as how the line is displayed when crossing other lines. It also controls the line's function, such as the type of segment that the line represents in the drawing.

Specifying the Design Rules of a Style

The design rules of a style determine how schematic lines, wires, and plumbing lines are cleaned up when they are connected to, respectively, schematic symbols, devices or panels, or plumbing fittings.
To specify the design rules of a style for cleaning up lines

1. Open the style in Style Manager by doing one of the following:
   - Verify that the active workspace is Schematic. Click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Schematic Symbol Styles.
   - Verify that the active workspace is Electrical. Click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Electrical Device Styles.
   - Verify that the active workspace is Electrical. Click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Electrical Panel Styles.
   - Verify that the active workspace is Plumbing. Click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Plumbing Fitting Styles.

2. In the left pane of Style Manager, select a style.

3. In the right pane, click the Design Rules tab.
4 Select a cleanup method for schematic lines, wires, or plumbing lines, depending on the style:

<table>
<thead>
<tr>
<th>If you want to end at the...</th>
<th>then select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection point</td>
<td>None.</td>
</tr>
<tr>
<td>edge of a surrounding hidden box</td>
<td>Bounding Box.</td>
</tr>
<tr>
<td>edge of an inscribed circle within a surrounding hidden box</td>
<td>Inscribed Circle.</td>
</tr>
<tr>
<td>edge of a circumscribed circle outside a surrounding hidden box</td>
<td>Circumscribed Circle.</td>
</tr>
<tr>
<td>at the edge</td>
<td>Trace Geometry.</td>
</tr>
</tbody>
</table>

5 Click OK.
Existing content that uses the style is updated automatically. By default, any new content uses the new method.

**Defining the Views of a Style**

Style-based content—devices, panels, plumbing fittings, schematic symbols, and multi-view parts (MvParts)—are multi-view blocks (MvBlocks) that have smart connectors that enable them to connect intelligently to form systems.
An MvBlock is a custom object that can have different appearances in different view directions. To define the appearance (or view) of style-based content, you assign a pre-drawn block to a specified view in the style definition.

The number and types of blocks that you need depend on your requirements. For a schematic symbol style, typically you can create one 2D block to represent the symbol in a plan view. If you need to create isometric drawings, you can use this block to generate additional blocks for the 12 isometric views (that represent the 12 isometric view directions and orientations).

For other types of style-based content, you need to create the 2D and 3D blocks required to represent the object in plan views and in model views. For example, a plumbing fitting style might require only a 2D block to represent the fitting in a plan view. Similarly, a device style might require a 2D block to symbolically represent the device in a plan view, but—if you need to create sections and elevations that display devices in actual size—the device style will also require an MvBlock for use in a model view (and in other view directions such as Front and Left).

**TIP** Use the styles provided with the software as a guide for creating your own custom styles.

For an introduction to orthographic and isometric views, see Orthographic and Isometric Views of Style-Based Content on page 127.

**Defining Style Views for Devices, Panels, and Plumbing Fittings**

1. In the drawing that will contain the style on page 898, create the AutoCAD blocks (or the MvBlock) that will represent the object in the orthographic views and in the model view.
2. Create the style, as described in Creating a Style on page 894.
3. In the left pane of Style Manager, navigate to the style, select it, and click the Views tab.
4 To add a view:
  ■ Click Add.
  ■ For View Name, enter a name, such as Plan or Model.
  ■ For View Block, select a block to represent the view. You can select from the AutoCAD blocks defined in the current drawing.

  **NOTE** Each MvPart creates a unique view block based on the style name and view direction that is retained when inserted into a drawing.

5 Specify when to use the selected view:
  ■ For Display Representation, select the display representation in which to display the view.
  ■ For View Directions, select one or more view directions in which to display the view.
TIP  To determine the view block to use to display a style-based object, the software identifies the active display representation (determined by the active display configuration) and the active view direction in the current drawing, and then searches for a view of the style that has the same specified display representation and view direction. If a matching view is found, the associated view block is used to display the object. If multiple matches are found, all of them are used to display the object. If no match is found, the object is not displayed.

6 If you want the view block to be inserted as an annotation block, select Insert as annotation block.

If desired, you can offset the annotation block from its insertion point by specifying values for Offset in X and for Offset in Y.

NOTE  When you insert a view block as an annotation block, the Annotation display component for the object type (device, panel, or plumbing fitting) determines its display properties, such as its color, linetype, and linewidth.

By defining multiple views with the same specified display representation and view directions, you can display an object using annotative and non-annotative view blocks at the same time, and you can configure the display properties of the view blocks differently. For example, you might have a junction box style that requires a view block to represent the symbology, and a second view block to represent the annotation. This allows you to define the appearance of the annotation view block by configuring the Annotation display component for the junction box, and to define the appearance of the symbol by configuring the other display components for the junction box.

RELATED  See Defining the Views of a Style on page 898.

7 Specify whether to scale the view block:

If you want to scale the view block using then...

the current annotation scale select Use Annotation Scale. This scales the block to the annotation plot size (specified on the Scale tab of the Drawing Setup dialog) multiplied by the scale factor for the current annotation scale.
<table>
<thead>
<tr>
<th>If you want to scale the view block using ...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>a scale factor that you specify</td>
<td>select Override Scale, and for each coordinate direction (X, Y, and Z), enter the scale factor to use to scale the block. A value greater than 1 enlarges the block. A value between 0 and 1 shrinks the block.</td>
</tr>
<tr>
<td>no scale</td>
<td>do not select Use Annotation Scale or Override Scale.</td>
</tr>
</tbody>
</table>

**NOTE** If you select both this and Use Annotation Scale, the block is scaled using the scale factors you enter, and then the result is multiplied by the scale factor for the current annotation scale.

8 If you selected Insert as annotation block, and you want the annotation view block to remain horizontal regardless of the rotation of the object in the drawing, select Keep text horizontal when rotating.

9 Add and configure additional views as previously described.

10 To remove a view, select it, and click Remove.

**WARNING** Use caution when removing views. If there is no view of the style for the current display representation and view direction in the drawing, all of the objects that use the style will not display when the drawing uses that display representation and view direction.
Defining Style Views for Schematic Symbols

1 In the drawing that will contain the style, create an AutoCAD block to represent the symbol in plan view.
2 Create the style, as described in Creating a Style on page 894.
3 In the left pane of Style Manager, navigate to the style, select it, and click the Views tab.

Views tab for an existing schematic symbol style

4 Click Generate Isometric Views.
5 In the Generate Isometric Symbol Blocks dialog, specify the orientation of the symbol in isometric views:

<table>
<thead>
<tr>
<th>If you want the symbol...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>to be oriented based on the direction of the schematic line</td>
<td>select In-line symbol.</td>
</tr>
<tr>
<td>to be oriented vertically with respect to the ground regardless of the direction of the schematic line</td>
<td>select Vertical symbol.</td>
</tr>
</tbody>
</table>
For Plan block to be used, select the AutoCAD block in the current drawing to use for the Ortho/Plan view.

If you want to overwrite existing view blocks with the blocks that will be created, select Use new blocks in the style definition. If you do not select this option, the blocks are created in the drawing, and they are available for selection, but they are not automatically assigned to the views of the style.

Click OK.

The software creates the isometric views and the associated view blocks based on the selected block for the orthographic (plan) view.

Select a view, and under Scaling, specify how to scale the symbol block:

<table>
<thead>
<tr>
<th>If you want to scale the view block using ...</th>
<th>Then ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the current annotation scale</td>
<td>select Use Annotation Scale. This scales the block to the annotation plot size (specified on the Scale tab of the Drawing Setup dialog) multiplied by the scale factor for the current annotation scale.</td>
</tr>
</tbody>
</table>

NOTE The Use Annotation Scale setting for the symbol, not the Annotative property in the selected symbol block definition, determines whether the symbol is annotative (scales according to the annotation scale). Also note that schematic symbols are always scaled according to the current annotation scale in model space; for more information, see Annotative Objects on page 815.

A scale factor that you specify | select Override Scale, and for each coordinate direction (X, Y, and Z), enter the scale factor to use to scale the block. A value greater than 1 enlarges the block. A value between 0 and 1 shrinks the block. |
If you want to scale the view block using ...

<table>
<thead>
<tr>
<th>NOTE</th>
<th>If you select both this and Use Annotation Scale, the block is scaled using the scale factors you enter, and then the result is multiplied by the scale factor for the current annotation scale.</th>
</tr>
</thead>
<tbody>
<tr>
<td>no scale</td>
<td>do not select Use Annotation Scale or Over-ride Scale.</td>
</tr>
</tbody>
</table>

10 Configuring the remaining views as previously described.

11 If necessary, you can click Advanced Editor to add (and remove) views in the Views dialog.

WARNING Use caution when removing views. If there is no view of the style for the current display representation and view direction in the drawing, all of the objects that use the style will not display when the drawing uses that display representation and view direction.

You can also use the Views dialog to specify the display representations and the view directions in which to display the view block, although typically these settings are configured for you when you generate the view blocks.

NOTE To determine the view block to use to display an object, the software identifies the active display representation (determined by the active display configuration) and the active view direction in the current drawing, and then searches for a view of the associated style that has the same specified display representation and view direction. If a matching view is found, the associated view block is used to display the object. If multiple matches are found, all of the associated view blocks are used to display the object. If no match is found, the object is not displayed.

12 Click OK twice.
Configuring the Connectors of a Style

All AutoCAD MEP objects have one or more smart connectors (connection points) that enable them to connect intelligently to appropriate objects and to transfer information such as shape, size, and system. Some objects, such as receptacles, require a single connector. Other objects, such as plumbing elbow fittings, require multiple connectors. You add connectors to style-based objects by adding connectors to the styles that define the objects. You can also remove connectors from styles, or change their type and location.

NOTE For detailed information on configuring connectors for device styles and for plumbing fitting styles, both of which have unique considerations, see Configuring Connectors for Device Styles on page 542 and Connectors for a Plumbing Fitting Style on page 725.

For information on configuring the connectors of catalog-based content, such as MvParts and fittings for ducts, pipes, cable trays, and conduits, see Customizing Catalog-Based Content on page 957.

To configure the connectors of a style

1. Open the drawing that contains the style.
2. Open the style by doing one of the following:
   - Click Manage tab ➤ Style & Display panel ➤ Style Manager. In the left pane, navigate to the style, and select it.
   - In the drawing, select an object that uses the style, then click the object’s contextual ribbon tab ➤ General panel ➤ Edit Style drop-down ➤ Edit Style.
3 Click the Connectors tab.

4 For Description, enter a descriptive name, such as Air_Supply.
5 For Domain, select a domain. For some types of styles, only a single domain is available.
6 Specify values for connection points X, Y, and Z, or click Add Center Points from View Blocks in Top View to create a centered connector.

**WARNING** Use caution when modifying the connection points on connectors or removing connectors. Either can break the connectivity between objects because the connector is modified in or removed from all instances of the style in the drawing.

7 If you want to add a connector, click , and configure the connector properties.
8 If you want to remove a connector, select the connector, and click .
9 Click OK.
Configuring the Display Properties of a Style

By customizing the display properties of a style (in other words, by applying a style override), you can control how building systems objects using that style are displayed in your drawing. You can change individual component display properties, such as the color or layer of connectors. Any change you make affects all instances of content using this style.

For information on how the display of an object is determined when multiple types of display overrides are in effect, see Hierarchy of Display Control on page 217.

To configure the display properties of a style

1 Select an object in your drawing, and then choose one of the following procedures:
   - Click the object's contextual ribbon tab ➤ General Panel ➤ Edit Style command.

   **NOTE** The General Panel shows an Edit System Style drop-down menu for some objects that you can then open to choose from several Edit Style commands.

   - Right-click an object in your drawing, and click the corresponding Edit Style command from the context menu.
2 In the Styles dialog, click the Display Properties tab.

3 Configure the display properties:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>change the display of an object style's components, such as visibility, layer, or color</td>
<td>select the display representation, click Style Override, and edit the component display properties.</td>
</tr>
<tr>
<td>reset the display representation to the drawing default</td>
<td>click Style Override to clear the override.</td>
</tr>
<tr>
<td>change style-specific display settings</td>
<td>select the display representation, click Edit Display Properties, and then click the Other tab to make changes. The Other tab is displayed only in some display representations.</td>
</tr>
</tbody>
</table>

4 Click OK twice.
Attaching Notes and Files to a Style

General style properties include name, description, and notes. You can use general style properties to assign property set information to objects such as MvParts, which typically have associated schedules.

1 Select an object in your drawing, and then choose one of the following procedures:
   ■ Click the object’s contextual ribbon tab ➤ General Panel ➤ Edit Style command.
   **NOTE** The General Panel shows an Edit System Style drop-down menu for some objects, which you can then open to choose from several Edit Style commands.
   ■ Right-click and click the Edit Style command from the context menu.

2 In the Styles dialog, click the General tab.

3 Enter a name and description.
NOTE The name is predefined by the object and should be modified with caution. Avoid duplicate names to prevent confusion.

4 Click Notes.
5 In the Notes dialog, click the Notes tab, and enter the note text. To select all notes, click Select All. You can use the context menu to access the standard Windows® cut, copy, paste, and delete commands for selected text.
6 Click the Reference Docs tab and enter reference information.
7 Click Add to select a reference and enter a description.
8 Click Edit to modify the location or description of a reference.
9 Click Delete to remove a reference from your drawing.
10 Click OK. The Notes dialog closes, and you are returned to the Style Properties dialog.
11 If available in the Styles dialog, click Property Sets. The Edit Property Set Data dialog is displayed.
12 In the Edit Schedule Data dialog, configure property sets for the style.

Copying Styles Between Drawings

In Style Manager, you can copy a style from one drawing to another by dragging the style and dropping it onto the destination drawing. This also copies all of the blocks associated with the style to the destination drawing. For more information on copying styles, see Copying Styles Between Drawings in AutoCAD Architecture Help.

Rise/Drop Styles

In a drawing, rise symbols and drop symbols are used to represent vertically-oriented segments and fittings, and to indicate corresponding rises and drops in elevation in the layout. In AutoCAD MEP, a rise condition exists if an unconnected end on a vertically oriented segment or fitting is visible in the current view. If the segment or fitting is vertically oriented but does not
have a visible, unconnected end, a drop condition exists. Rise/drop styles let you specify the symbols to use in both rise and drop conditions.

A rise/drop style defines not only the symbols to use, but also the 2-line and 1-line displays in which to use them. For duct rise/drop styles, you can also specify different symbols for different shapes of ducts and fittings: round, rectangular, and oval.

Rise/drop styles are used in the orthographic views: Top, Bottom, Left, Right, Front, and Back.

1-line display of a pipe run

You can specify a rise/drop style for each system in a drawing. For example, you can specify one style for a supply system and a different style for a return system. This helps to visually differentiate the systems, as shown in the following plan view of a supply run and a return run, both with vertical components.

Supply duct run

Return duct run
Creating Blocks for Rise Symbols and Drop Symbols

Before you define a rise/drop style, you need to create the AutoCAD blocks that will represent the rise symbols and drop symbols. For information on creating blocks, see Define Blocks. Keep the following guidelines in mind as you create the blocks:

- Rise/drop styles (and, therefore, the associated blocks) must exist in the current drawing if they are to be used. This means you must either create the blocks and styles directly in your drawing templates (which typically are used to create new drawings), or you must create them in a content library (a DWG file), and then copy them to your drawing templates.

- Before you create a block for a rise symbol, set the current color, linetype, and lineweight to ByBlock. When the block is inserted in a drawing, the values for these properties in the Rise Drop display component will be used.

- Before you create a block for a drop symbol, set the current color, linetype, and lineweight to the desired values for the symbol. When the block is inserted in a drawing, the values for these properties will be retrieved from the block definition, and any values for these properties in the Rise Drop display component will be ignored.

**NOTE** Configuring the blocks for rise symbols and drop symbols as just described allows you to specify different values for the display properties of each. You control the visibility of both using the Visibility setting for the Rise Drop display component.

- You can create a block at any size. When it is inserted in a drawing, the block is scaled so that its extents are one unit (for example, one inch or one millimeter); it is then rescaled according to the specifications in the rise/drop style.

- To ensure that the symbol is displayed in the correct location relative to a layout, specify the center of the symbol as the base point of the block.

- Create oval blocks as flat ovals, using the blocks provided with the software as a guide.
The content packs provided with the software each include a style drawing that contains many predefined system definitions, several rise/drop styles for use with the system definitions, and supporting AutoCAD blocks for commonly used rise symbols and drop symbols. Some of the rise/drop styles and AutoCAD blocks are also made available in the drawing templates provided with the software. By default, the default symbols in any new rise/drop style use these AutoCAD blocks. To determine the extents of the blocks in order to support correct scaling, the blocks for 2-line displays include extra geometry on nested, non-plotting, frozen layers.

Defining Rise/Drop Styles

A rise/drop style specifies the symbols to use in 2-line and 1-line displays of rise conditions and drop conditions on segments and fittings.

You can define the following types of rise/drop styles: duct, pipe, cable tray, conduit, and plumbing. Duct rise/drop styles allow you to specify symbols for different shapes: round, rectangular, and oval. You can also specify whether to show a rise or a drop symbol when duct or pipe runs underneath an MvPart, or when a vertical duct has an endcap.

To define a rise/drop style

1. If necessary, create the AutoCAD blocks to be used by the symbols in the rise/drop style. For guidelines, see Rise/Drop Styles on page 911.
2. Click Manage tab ➤ Style & Display panel ➤ Style Manager ➤ Style Manager.
3. In the left pane, expand the folder for the appropriate objects (for example, the Piping Objects folder).
4. Right-click Rise Drop Styles, and click New.
5. Enter a name for the new style, and press ENTER.
6. Select the new style.
7. For Description, enter a description of the style.
8. If desired, attach notes or reference documents to the style.
9. Click the Rise and Drop tab.
Rise and Drop tab for a sample pipe rise/drop style

The top pane lists the default symbols to be created by the software for the new style. The properties for the currently selected symbol are shown below.
IMPORTANT To simplify the process of configuring the symbols in a rise/drop style, it is recommended that you reconfigure as necessary—but do not remove—the default symbols. They make up the minimal set of rise symbols and drop symbols needed for all possible rise conditions and drop conditions in 2-line and 1-line displays. Without this minimal set, the style is not valid. For example, a pipe rise/drop style is not valid without the following symbols: 2-line rise, 2-line drop, 1-line rise, 1-line drop, and 1-line drop for tees and takeoffs only. Similarly, a plumbing rise/drop style is not valid without the following symbols: rise, drop.

10 Select the number of a symbol to configure.
11 For Name, enter a descriptive name that identifies the context in which the symbol will be used.
12 For Display Representation, select the display representation in which the symbol will be displayed.
   For a 2-line display, select a Plan or 2 Line display representation.
   For a 1-line display, select a 1 Line display representation.
13 For Block, select the AutoCAD block (defined in the current drawing) that represents the symbol.
14 If you want to display center lines on the symbol, for Center Line Block, select the AutoCAD block (defined in the current drawing) that represents the center lines.
   A preview image of the symbol, defined by the selected blocks, displays on the right.
15 If the rise/drop style is for ducts and duct fittings, under Shape, select the shape to apply to the symbol.
16 Under Rise/Drop, choose either a Rise or a Drop option as described next:

<table>
<thead>
<tr>
<th>If you select...</th>
<th>Then the current drawing shows the...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Rise Under Mv-Parts</td>
<td>rise symbol under an MvPart.</td>
</tr>
<tr>
<td>Show Rise Under End-caps</td>
<td>rise symbol under an endcap.</td>
</tr>
<tr>
<td>Show Drop Under El-bows</td>
<td>drop symbol under an elbow with a connector in the down direction.</td>
</tr>
<tr>
<td>If you select...</td>
<td>Then the current drawing shows the...</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Show Drop Under Endcaps</td>
<td>drop symbol under an endcap.</td>
</tr>
<tr>
<td>Show Drop Under MvParts</td>
<td>drop symbol under an MvPart.</td>
</tr>
<tr>
<td>Drop Tees/Takeoffs Only</td>
<td>drop symbol only used to represent tees and takeoffs in 1-line displays</td>
</tr>
</tbody>
</table>

**NOTE** In 1-line displays that do not show the contour of an object, this identifies the appropriate symbol to use for tees and takeoffs in drop conditions.

**17** Under Scaling, specify how to scale the symbol block:

<table>
<thead>
<tr>
<th>If you want to scale the symbol block...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>to the actual diameter (in 2-line displays) or the nominal diameter (in 1-line displays) of the segment or fitting</td>
<td>clear Use Annotation Scale, and clear Override Scale.</td>
</tr>
<tr>
<td>using the current annotation scale</td>
<td>select Use Annotation Scale. This scales the block to the annotation plot size (specified on the Scale tab of the Drawing Setup dialog) multiplied by the scale factor for the current annotation scale.</td>
</tr>
<tr>
<td>using a scale factor that you specify</td>
<td>select Override Scale, and for each coordinate direction (X, Y, and Z), enter...</td>
</tr>
</tbody>
</table>
If you want to scale the symbol block ... Then ...

- the scale factor to use to scale the block.

**NOTE** If you select both this and Use Annotation Scale, the block is scaled using the scale factors you enter, and then the result is multiplied by the scale factor for the current annotation scale.

When the symbol block is inserted in a drawing, it is first scaled so that its extents are one unit (for example, one inch or one millimeter); it is then rescaled based on your selection here.

18 If you want to scale the center line block relative to the symbol block, for Center Line Block Scale Factor, enter the scale factor. For example, to scale the center line block to the same size as the symbol block, enter 1. To scale it so it is 50% larger than the scaled symbol block, enter 1.5.

**TIP** The preview image updates dynamically to assist you in specifying the desired scale factor for the center line block.

19 Select the next symbol, and configure it using the same process.

20 If you want to add additional rise graphics or drop graphics, click Add, and configure an additional symbol to be displayed in a specific rise condition or drop condition.

21 If you want to delete a symbol, click Remove.

**NOTE** In a drawing, the display properties of the symbol block—including its visibility—are determined by the settings of the Rise Drop display component for the current display representation. Similarly, the display properties of the center line block are determined by the Center Line display component. This allows you to specify different display properties for the symbols and their center lines. For information on configuring display settings, see *AutoCAD MEP Displays* on page 208.
Connector Styles

Connector styles specify the rules that determine when connections are allowed between building systems objects. The rules determine whether connections are allowed by comparing specific properties. For example, when connecting 2 segments, typically you want to ensure the segments are the same size.

AutoCAD MEP includes the following connector styles:

- Cable Tray
- Conduit
- Electric
- HVAC
- Pipe
- Schematic

**IMPORTANT** It is recommended that you keep the default configuration of the connector styles. Modifying the styles might cause the software to work improperly.

To verify the connector style rules

1. Click Manage tab ➤ Style & Display panel ➤ Style Manager .
2. Expand Multi-Purpose Objects, and then expand Connector Styles.
3. In the left pane, select a connector style.
4. In the right pane, click the Rules tab, and verify the connector style rules.

Categorizing Style-Based Content

You can create categories for related style-based content in the drawings located in the default style-based content locations. Because these drawings typically contain a large number of styles, categorizing the styles makes it easier for users to browse them.
Creating Categories in AutoCAD MEP

You can create categories for various MEP objects, such as devices, panels, schematic symbols, and plumbing fittings. The following steps explain how to categorize a style for plumbing fittings.

NOTE These steps are similar to those when you create other types of categories in AutoCAD MEP.

To categorize plumbing fittings

1. Click Manage tab ➤ Style & Display panel ➤ Style Manager .
2. Expand the specific Objects node in the left pane. In this example, select Plumbing Objects.
3. Right-click the desired category — in this case, Plumbing Fitting Categories. Then click New.
4. Enter a name for the new category, and press ENTER.
5. Click the Plumbing Fitting tab in the right pane.

NOTE The name of this tab relates specifically to the category you selected previously. In this example, it is named Plumbing Fitting.
6 Click Add to add a style to the new category. Repeat to add additional styles.
7 To delete a category, right-click the category name in the left pane and click Purge.

**NOTE** Deleting a category deletes the category and the references to the styles within the category. It does not delete the actual styles.

### Customizing Device Content

This section provides information on several conversion tools you can use to create device content.

For information on creating style-based content manually, see Workflow for Creating Style-Based Content on page 891.

### Converting Blocks and Parts to Devices

You can convert a single AutoCAD block, MvBlock, or MvPart to a device. Because devices are style-based objects, and all style-based objects are defined by styles, this creates an associated device style as well.

**To convert a block or part to a device**

1 Select the AutoCAD block, MvBlock, or MvPart to convert to a device.
   You can select a block or part in the current drawing or in one of its referenced drawings (xrefs).
2 Click Equipment tab ➤ Modify panel ➤ Convert To Device ➤.

![Device Convert - Behavior dialog](image)

3 In the Device Convert - Behavior dialog, for Name, enter a unique name for the device, and for Type, select the type of device to create.

**TIP** The Type property of the device can be useful when you need to modify multiple objects of the same type. You can quickly select all of the objects in the drawing, and then use a modify command, such as LIGHTINGMODIFY, to modify only the objects of a specific type.

4 For Layer Key, click ➤ to open the Select Layer Key dialog, select the layer key to associate with the device, and click OK. The list of layer keys from which you can select is determined by the layer standard and layer key style that is specified for the current drawing. For more information, see Specifying a Layer Standard and a Layer Key Style on page 206.

**NOTE** Since you are creating a device and an associated device style using this process, the layer key determines not only the layer key for the individual device, but also the layer key defined in the device style. For more information, see AutoCAD MEP Layer Standards on page 203.
5 Click Delete the original object to replace the old object with the newly converted one.

6 Click Next.

7 Specify values for the electrical connectors on the device:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>enter a description for the connector</td>
<td>enter the text in Value column for Description. Use a descriptive phrase that identifies what the connector represents, such as Normal Power.</td>
</tr>
<tr>
<td>specify a type of circuit for the connector</td>
<td>select a system type for System Type.</td>
</tr>
<tr>
<td>enter values for Connection Point X, Connection Point Y, and Connection Point Z.</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** If you select Power and Lighting, you can configure additional connector properties, such as voltage and load.
If you want to… then...

add a connector click .

remove a connector select the connector, and click .

For more information on the properties of electrical connectors, see Configuring the Electrical Connectors of a Device on page 583.

8 If the software finds no other additional blocks or parts of the same type as the one you are converting, you can click Finish to convert the object. Otherwise, click Next.

9 If you want to convert the additional blocks or parts to devices that have the same properties, select Convert all additional references to the selected block in the drawing, and click Finish.

Using the settings that you specified as well as the AutoCAD block or the view block currently assigned to the MvBlock or MvPart, the software creates a device style and a new device. However, the device style contains additional settings that you might want to configure. For example, you might want to select a wire cleanup method other than the default method; you might also want to make changes to the default view definitions. For information on configuring device styles, see

Device Style Setup on page 541
Converting Device Styles to Blocks

You can convert a set of device styles to their individual components: the style settings and the AutoCAD® blocks used by the style views. The output of the conversion process includes:

- a set of drawings that contain the AutoCAD blocks. The process creates one drawing per view block per style, so each drawing contains a single block definition.

- a device conversion script (Custom Content File or CCF file) that contains the style settings. The script contains not only the values for the style settings, but also the file path locations of the output drawings that contain the AutoCAD blocks.

Typically, you use this process when you have a set of existing device styles that you want to customize. You convert the device styles to their individual components, customize the components (the blocks and the style settings in the script), and then use the modified script to convert the modified blocks to new device styles.

**NOTE** This conversion process produces only the previously specified output. Your original device style drawings remain unchanged.
To convert a set of device styles to their individual blocks

1. Click Manage tab ➤ MEP Content panel ➤ Decompose Devices.

2. In the Decompose Devices dialog, for File to Decompose, then select the drawing (DWG file) that contains the device styles to convert:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>convert the device styles in the current drawing open in AutoCAD MEP</td>
<td>click Current Drawing.</td>
</tr>
<tr>
<td>convert the device styles in a drawing stored locally on your computer</td>
<td>click the radio button beside the file path, click Browse, select the drawing file, and click Open.</td>
</tr>
</tbody>
</table>

3. For Block, click Browse, and select the folder in which to place the drawings that contain the AutoCAD blocks used by the device style views. Click OK.

If the selected folder already contains drawings, then during the conversion process, you will be prompted about overwriting drawings with the same name.
NOTE Like all AutoCAD® blocks, the blocks in the output drawings are stored in an invisible data area called the block definition table. For more information, see How Blocks Are Stored and Referenced.

4 For Script Path, click Browse, and select the file name of the device conversion script to create:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>create a new script</td>
<td>in the Select File dialog, specify the location for the new script, enter a name, and click Save.</td>
</tr>
<tr>
<td>overwrite the contents of an existing script</td>
<td>in the Select File dialog, select the drawing, click Save, and then click Yes to confirm that the contents of the drawing can be overwritten.</td>
</tr>
</tbody>
</table>

5 Click Decompose.

The software converts the device styles into the blocks used by the style views and generates an associated script based on the style definitions.

NOTE Because a device style specifies only the positions of the connectors and not the method in which they were initially specified, the script sets the default value of the Connector Placement property of all connectors to Specify. As a result, before you reuse the conversion script to create new device styles, you might need to change these values.

You can now modify the blocks and the script, and then use them to create new device styles based on your modifications. For more information, see Converting Blocks to Device Styles on page 927.

Converting Blocks to Device Styles

You can convert a set of AutoCAD® blocks to device styles. The output of the conversion process is a drawing (DWG file) that contains the device styles.

Typically, you use this process in 1 of 2 contexts. In the first context, you want to create device styles using the blocks in your existing block libraries. During the process, you need to create a device conversion script (Custom
Content File or CCF file) that contains the style settings to use to create the
device styles.

In the second context, you have already converted a set of existing device
styles to their individual components, customized the components, and now
you want to create new device styles based on the customizations. In this case,
you already have a conversion script, which you can customize and reuse.

Regardless of the context, you use only one script to produce one drawing
containing device styles. For example, you would use one script to produce
one drawing containing customized styles for receptacles.

To convert a set of blocks to device styles

1 Click Manage tab ➤ MEP Content panel ➤ ➤ Batch Convert Devices

2 In the Batch Convert Devices dialog, under Conversion Script
File, for Path specify the device conversion script (CCF file) to use
to convert the blocks to device styles.
The conversion script contains the device style settings to use, as well as references to the drawings that contain the AutoCAD® blocks to use for the style views.

**If you want to...** | **then...**
---|---
create a script | click Create, and create the script using the Device Conversion Script dialog. For more information, see Creating Device Conversion Scripts on page 930.

use an existing script, such as a customized version of a script generated from converting existing device styles to blocks. | click Browse, select the script, and click Open.

**NOTE** To make changes to the script prior to using it, click Edit, and modify the script using the Edit Device Script dialog. For more information, see Modifying Device Conversion Scripts on page 933.

3 For Device File, click Browse, and specify the drawing (DWG file) to contain the new device styles:

**If you want to...** | **then...**
---|---
create the drawing | in the Select File dialog, specify the location for the new drawing, enter a name, and click Save.

overwrite the contents of an existing drawing | in the Select File dialog, select the drawing, click Save, and then click Yes to confirm that the contents of the drawing can be overwritten.

4 Click Generate.
The software creates the device styles using the conversion script and the block definitions from the referenced drawings.
IMPORTANT If you need to make a few changes to the new device styles, modify the conversion script and repeat the conversion process to apply the changes. If you make the changes using the Style Manager instead, the changes are overwritten if you subsequently repeat the conversion process.

5 If there are errors in the process, click Log to view them. Otherwise, click Close.

Creating Device Conversion Scripts

A device conversion script in a CCF file contains the following information:

- values for device style settings
- references to drawings that contain AutoCAD® blocks

The software uses both the script and the blocks to create the device styles and their associated views.

If you are creating a set of device styles using the blocks in your existing block libraries, you need to create a conversion script. If you are customizing a set of existing device styles, you already have a script as a result of the conversion of the existing styles to their individual components, and you can modify that script instead.

To create a device conversion script

1 Click Manage tab ➤ MEP Content panel ➤ ▼ ➤ Batch Convert Devices.
2 In the Batch Convert Devices dialog, under Conversion Script File, click Create.

3 In the Device Conversion Script dialog, under Convert, specify the file or files that contain the blocks to convert to device styles:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>convert the blocks in a single drawing</td>
<td>click Drawing, click Browse, select the drawing, and click Open.</td>
</tr>
<tr>
<td>convert the blocks in all drawings in a folder</td>
<td>click Folder, click Browse, select the folder, and click OK.</td>
</tr>
</tbody>
</table>

4 Under Conversion Template, for Path specify the conversion template (Custom Content Template or CCT file) to use to create the conversion script:

**NOTE** The conversion template is the mechanism by which you specify default values for the settings in the conversion script that you create. Once the script is created, you can customize the settings as needed.

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>create a template</td>
<td>click Create. In the Open File box, specify the location for the new template, and, for File name, enter its name. Click Save. In the Conversion Template dialog, specify the values of the template settings. Click</td>
</tr>
</tbody>
</table>
If you want to... | then...
---|---
Close to return to the Device Conversion Script dialog.

use an existing template | click Browse. In the Open File box, select the existing template, and click Open.

**NOTE** To make changes to the template prior to using it, click Edit. In the Conversion Template dialog, modify the values of the template settings. Click Close to return to the Device Conversion Script dialog.

5 In the Device Conversion Script dialog, under Conversion Script, click Browse, and specify the location of the CCF file to create for this conversion script:

If you want to... | then...
---|---
create a new conversion script | in the Select File dialog, specify the location for the new script, enter a name, and click Save.
If you want to… then…

overwrite the contents of an existing script

in the Select File box, select the existing script, click Save, and then click Yes to confirm that the contents of the script can be overwritten.

6 Click Generate.
7 After the script is created, click Close to return to the Batch Convert Devices dialog to create the device styles.

For more information, see Converting Blocks to Device Styles on page 927.

Modifying Device Conversion Scripts

During the process of converting blocks to device styles, you might need to modify the device conversion script that you are using.

If the conversion script was initially generated by the software as a result of converting existing device styles to blocks, you need to modify the script to reflect the customizations that you want before you use the same script to convert the blocks to new device styles.

If you created the conversion script, you might want to modify the script to change one or more settings before repeating the conversion process. Although you can also change the settings using the Style Manager, the changes are overwritten if you subsequently repeat the conversion process.

You modify a device conversion script using the Edit Device Script dialog.
In the dialog, the displayed settings change depending on whether you select a device style, a device view, or a connector in the table. For example, in the following images, notice how the heading names differ depending on the selected object.

**Selected style**

**Selected view**

**Selected connector**

934 | Chapter 13  Customizing Style-Based Content
To modify a device conversion script

1 Click Manage tab ➤ MEP Content panel ➤ MEP Content ➤ Batch Convert Devices.

2 In the Batch Convert Devices dialog, under Conversion Script File, for Path specify the device conversion script (CCF file) to use to convert the blocks to device styles. Then, click Edit.

3 In the Edit Device Script dialog, modify the script:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>modify a device style</td>
<td>select the style, and modify its properties using the available options.</td>
</tr>
<tr>
<td>add a device style</td>
<td>click , select the new style, and modify its properties.</td>
</tr>
<tr>
<td>modify a view for a device style</td>
<td>select the view, and modify its properties using the available options. For example, you might want to specify a different source AutoCAD® block for the view. To do so, you can modify the block definition in the drawing specified in the Source Block property, or you can specify the file path of a different drawing.</td>
</tr>
<tr>
<td>add a view to a device style</td>
<td>select the style to which to add the view, and click . Select the view, and modify its properties.</td>
</tr>
</tbody>
</table>
If you want to… then…

modify a connector for a device style

select the connector, and modify its properties using the available options.

NOTE If you are using a script generated using the Decompose Devices command, you might need to specify a value for the Connector Placement property for some connectors. The script sets this property to Specify by default. You can select

- Specify, and then enter the X, Y, and Z coordinates
- Center to place the connector at the center of the view block
- Insert to place the connector at the insertion point of the view block
- Node to place a connector at each AutoCAD point object in the view block

add a connector to a device style

select the view to which to add the connector, and click . Select the connector, and modify its properties.

delete a device style, a view, or a connector

select the style, the view, or the connector, and click .

To assist you in modifying the script, the sections that follow identify where you configure the same device style properties in the user interface. For more information on device style settings, see Device Style Setup on page 541 and Configuring Styles on page 896.

4 Click Close to save your changes and return to the Batch Convert Devices dialog to create the device styles.

For more information, see Converting Blocks to Device Styles on page 927.
**Style Properties**

The Style Name property in the device conversion script displays on the General tab of the Style Manager. On the tab, the property is called Name.

![Style Manager General Tab](image)

The Type, Layer Key, and Masking properties in the script display on the Design Rules tab of the Style Manager. On the tab, the Masking property is called Wire Cleanup.
The Category property in the script does not display in the Style Manager. Device categories are the mechanism by which you group the devices (device styles) in the Select Device worksheet, making it easier to browse the available devices. You create and manage device categories directly in the worksheet; for more information, see Creating Categories in AutoCAD MEP.

If you enter a name in the Category property of the device conversion script, the software adds the device (device style) to the category. If the category does not exist, it is created in the style drawing.

**View Properties**

The view properties in the device conversion script display on the Views tab of the Style Manager. On the tab, the Annotation View property is called Annotation Block.
The Source Block property in the script does not display on the tab. When you create a style view using the Style Manager, you do not specify the file path of the drawing containing the source AutoCAD block, because you are limited to selecting a block in the current drawing.

**Connector Properties**

The connector properties in the device conversion script display on the Connectors tab of the Style Manager. On the tab, the Connector Type property is called System Type.
The Connector Placement property in the script does not display on the tab. In the Style Manager, you can only specify a connector position by entering the X, Y, and Z coordinates, or by placing the connector at the center of the block, using the options shown in the image.

**Customizing Schematic Symbol Content**

This section provides information on several conversion tools you can use to create schematic symbol content.

For information on creating style-based content manually, see Workflow for Creating Style-Based Content on page 891.

**Converting Schematic Symbol Styles to Blocks**

You can convert a set of schematic symbol styles to their individual components: the style settings and the AutoCAD® blocks used by the style views. The output of the conversion process includes:

- a set of drawings that contain the AutoCAD blocks. The process creates one drawing per view block per style, so each drawing contains a single block definition.
a symbol conversion script (Custom Content File or CCF file) that contains
the style settings. The script contains not only the values for the style
settings, but also the file path locations of the output drawings that contain
the AutoCAD blocks.

Typically, you use this process when you have a set of existing schematic
symbol styles that you want to customize. You convert the styles to their
individual components, customize the components (the blocks and the style
settings in the script), and then use the modified script to convert the modified
blocks to new styles.

**NOTE** This conversion process produces only the previously specified output. Your
original schematic symbol style drawings remain unchanged.

**To convert a set of schematic symbol styles to their individual blocks**

1. Click Manage tab ➤ MEP Content panel ➤ Decompose Symbols ➤ Decompose Symbols.
2 In the Decompose Symbols dialog, for File to Decompose, select the drawing (DWG file) that contains the schematic symbol styles to convert:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>convert the schematic symbol styles in the current drawing open in AutoCAD MEP</td>
<td>click Current Drawing.</td>
</tr>
<tr>
<td>convert the schematic symbol styles in a drawing stored locally on your computer</td>
<td>click the radio button beside the file path, click Browse, select the drawing file, and click Open.</td>
</tr>
</tbody>
</table>

3 For Block Path, click Browse, and select the folder in which to place the drawings that contain the AutoCAD blocks used by the views in the schematic symbol styles. Click OK. If the selected folder already contains drawings, then during the conversion process, you will be prompted about overwriting drawings with the same name.

**NOTE** Like all AutoCAD® blocks, the blocks in the output drawings are stored in an invisible data area called the block definition table. For more information, see How Blocks Are Stored and Referenced.

4 For Script Path, click Browse, and select the file name of the symbol conversion script to create:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>create a new script</td>
<td>in the Select File dialog, specify the location for the new script, enter a name, and click Save.</td>
</tr>
<tr>
<td>overwrite the contents of an existing script</td>
<td>in the Select File dialog, select the drawing, click Save, and then click Yes to confirm that the contents of the drawing can be overwritten.</td>
</tr>
</tbody>
</table>

5 Click Decompose.
The software converts the schematic symbol styles into the blocks used by the style views and generates an associated script based on the style definitions.

**NOTE** Because a schematic symbol style specifies only the positions of the connectors and not the method in which they were initially specified, the script sets the default value of the Connector Placement property of all connectors to Specify. As a result, before you reuse the conversion script to create new schematic symbol styles, you might need to modify these values.

You can now modify the blocks and the script, and then use them to create new schematic symbol styles based on your modifications. For more information, see Converting Blocks to Schematic Symbol Styles on page 943.

### Converting Blocks to Schematic Symbol Styles

You can convert a set of AutoCAD® blocks to schematic symbol styles. The output of the conversion process is a drawing (DWG file) that contains the styles.

Typically, you use this process in 1 of 2 contexts. In the first context, you want to create schematic symbol styles using the blocks in your existing block libraries. During the process, you need to create a symbol conversion script (Custom Content File or CCF file) that contains the style settings to use to create the schematic symbol styles.

In the second context, you have already converted a set of existing schematic symbol styles to their individual components, customized the components, and now you want to create new schematic symbol styles based on the customizations. In this case, you already have a conversion script, which you can customize and reuse.

Regardless of the context, you use only one script to produce one drawing containing schematic symbol styles. For example, you would use one script to produce one drawing containing customized styles for HVAC equipment.

**To convert a set of blocks to schematic symbol styles**

1. Click Manage tab ➤ MEP Content panel ➤  ➤ Batch Convert Symbols .
The software displays the Batch Convert Symbols dialog.

2 In the Batch Convert Symbols dialog, under Conversion Script File, for Path specify the symbol conversion script (CCF file) to use to convert the blocks to schematic symbol styles.

The symbol conversion script contains the style settings to use, as well as references to the drawings that contain the AutoCAD® blocks to use for the style views.

If you want to... then...

create a script click Create, and create the script using the Symbol Conversion Script dialog. For more information, see Creating Symbol Conversion Scripts on page 945.

use an existing script, such as a customized version of a script generated from converting existing schematic symbol styles to blocks. click Browse, select the script, and click Open.

NOTE To make changes to the script prior to using it, click Edit, and modify the script using the Edit Symbol Script dialog. For more information, see Modifying Symbol Conversion Scripts on page 949.
3 For Symbol File, click Browse, and specify the drawing (DWG file) to contain the new schematic symbol styles:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>create the drawing</td>
<td>in the Select File dialog, specify the location for the new drawing, enter a name, and click Save.</td>
</tr>
<tr>
<td>overwrite the contents of an existing drawing</td>
<td>in the Select File dialog, select the drawing, click Save, and then click Yes to confirm that the contents of the drawing can be overwritten.</td>
</tr>
</tbody>
</table>

4 Click Generate.
The software creates the schematic symbol styles using the conversion script and the block definitions from the referenced drawings.

**IMPORTANT** If you need to make a few changes to the new styles, modify the symbol conversion script and repeat the conversion process to apply the changes. If you make the changes using the Style Manager instead, the changes are overwritten if you subsequently repeat the conversion process.

5 If there are errors in the process, click Log to view them. Otherwise, click Close.

**Creating Symbol Conversion Scripts**

A symbol conversion script in a CCF file contains the following information:

- values for schematic symbol style settings
- references to drawings that contain AutoCAD® blocks

The software uses both the script and the blocks to create the schematic symbol styles and their associated views.

If you are creating a set of schematic symbol styles using the blocks in your existing block libraries, you need to create a conversion script. If you are customizing a set of existing styles, you already have a script as a result of the
conversion of the existing styles to their individual components, and you can modify that script instead.

To create a symbol conversion script

1 Click Manage tab ➤ MEP Content panel ➤ Batch Convert Symbols ➤ Batch Convert Symbols.

The software displays the Batch Convert Symbols dialog.

2 In the Batch Convert Symbols dialog, click Create.

3 In the Symbol Conversion Script dialog, under Convert, specify the file or files that contain the blocks to convert to schematic symbol styles:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>convert the blocks in a single drawing</td>
<td>click Drawing, click Browse, select the drawing, and click Open.</td>
</tr>
<tr>
<td>convert the blocks in all drawings in a folder</td>
<td>click Folder, click Browse, select the folder, and click OK.</td>
</tr>
</tbody>
</table>
4 Under Conversion Template, for Path, specify the conversion template (Custom Content Template or CCT file) to use to create the conversion script:

**NOTE** The conversion template is the mechanism by which you specify default values for the settings in the conversion script that you create. Once the script is created, you can customize the settings as needed.

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>create a template</td>
<td>click Create. In the Open File box, specify the location for the new template, and, for File name, enter its name. Click Save. In the Conversion Template dialog, specify the values of the template settings. Click Close to return to the Symbol Conversion Script dialog.</td>
</tr>
</tbody>
</table>
If you want to... then...

use an existing template  click Browse. In the Open File box, select the existing template, and click Open.

NOTE To make changes to the template prior to using it, click Edit. In the Conversion Template dialog, modify the values of the template settings. Click Close to return to the Symbol Conversion Script dialog.

In the Symbol Conversion Script dialog, under Conversion Script, click Browse, and specify the location of the CCF file to create for this conversion script:

5 If you want to... then...

create a new conversion script in the Select File dialog, specify the location for the new script, enter a name, and click Save.
If you want to...  

then...

<table>
<thead>
<tr>
<th>if you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>overwrite the contents of an existing script</td>
<td>in the Select File dialog, select the existing script, click Save, and then click Yes to confirm that the contents of the script can be overwritten.</td>
</tr>
</tbody>
</table>

6 Click Generate.

7 After the script is created, click Close to return to the Batch Convert Symbols dialog to create the schematic symbol styles. For more information, see Converting Blocks to Schematic Symbol Styles on page 943.

**Modifying Symbol Conversion Scripts**

During the process of converting blocks to schematic symbol styles, you might need to modify the symbol conversion script that you are using.

If the conversion script was initially generated by the software as a result of converting existing schematic symbol styles to blocks, you need to modify the script to reflect the customizations that you want before you use the same script to convert the blocks to new styles.

If you created the conversion script, you might want to modify the script to change one or more settings before repeating the conversion process. Although you can also change the settings using the Style Manager, the changes are overwritten if you subsequently repeat the conversion process.

You modify a symbol conversion script using the Edit Symbol Script dialog.
In the dialog, the displayed settings change depending on whether you select a schematic symbol style, a view, or a connector in the table. For example, in the following images, notice how the heading names differ depending on the selected object.

**Selected style**

**Selected view**

**Selected connector**
To modify a symbol conversion script

1 Click Manage tab ➤ MEP Content panel ➤  ➤ Batch Convert Symbols.

2 In the Batch Convert Symbols dialog, under Conversion Script File, for Path specify the symbol conversion script (CCF file) to use to convert the blocks to schematic symbol styles. Then, click Edit.

3 In the Edit Symbol Script dialog, modify the script:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>modify a schematic symbol style</td>
<td>select the style, and modify its properties using the available options.</td>
</tr>
<tr>
<td>add a schematic symbol style</td>
<td>click , select the new style, and modify its properties.</td>
</tr>
<tr>
<td>modify a view for a style</td>
<td>select the view, and modify its properties using the available options. For example, you might want to specify a different source AutoCAD® block for the view. To do so, you can modify the block definition in the drawing specified in the Source Block property, or you can specify the file path of a different drawing.</td>
</tr>
<tr>
<td>add a view to a style</td>
<td>select the style to which to add the view, and click . Select the view, and modify its properties.</td>
</tr>
<tr>
<td>If you want to...</td>
<td>then...</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>modify a connector for a</td>
<td>select the connector, and modify its properties using the available</td>
</tr>
<tr>
<td>style</td>
<td>options.</td>
</tr>
</tbody>
</table>

**NOTE** If you are using a script generated using the **Decompose Symbols** command, you might need to specify a value for the Connector Placement property for some connectors. The script sets this property to Specify by default. You can select:

- Specify, and then enter the X, Y, and Z coordinates
- Select Center to place the connector at the center of the view block
- Select Insert to place the connector at the insertion point of the view block
- Select Node to place a connector at each AutoCAD point object in the view block

<table>
<thead>
<tr>
<th>add a connector to a style</th>
<th>select the view to which to add the connector, and click . Select the connector, and modify its properties.</th>
</tr>
</thead>
<tbody>
<tr>
<td>delete a style, a view, or a connector</td>
<td>select the style, the view, or the connector, and click .</td>
</tr>
</tbody>
</table>

To assist you in modifying the script, the sections that follow identify where you configure the same properties of schematic symbol styles in the user interface. For more information on schematic symbol style settings, see **Configuring Styles** on page 896.

4 Click Close to save your changes and return to the Batch Convert Symbols dialog to create the schematic symbol styles. For more information, see **Converting Blocks to Schematic Symbol Styles** on page 943.
**Style Properties**

The Style Name property in the symbol conversion script displays on the General tab of the Style Manager. On the tab, the property is called Name.

The Masking property in the script displays on the Design Rules tab of the Style Manager. On the tab, the property is called Line Cleanup.
The Category property in the script does not display in the Style Manager. Schematic symbol categories are the mechanism by which you group the symbols (symbol styles) in the Select Schematic Symbol worksheet, making it easier to browse the available symbols. You create and manage symbol categories directly in the worksheet.

If you enter a name in the Category property of the symbol conversion script, the software adds the symbol (symbol style) to the category. If the category does not exist, it is created in the style drawing. For more information, see Categorizing Style-Based Content on page 919.

**View Properties**

The view properties in the symbol conversion script display on the Views tab of the Style Manager. On the tab, the Create ISO Blocks property is called Generate Isometric Views.
The Source Block property in the script does not display on the tab. When you create a style view using the Style Manager, you do not specify the file path of the drawing containing the source AutoCAD block, because you are limited to selecting a block in the current drawing.

**Connector Properties**

The connector properties in the script display on the Connectors tab of the Style Manager.
The Connector Placement property in the script does not display on the tab. In the Style Manager, you can only specify a connector position by entering the X, Y, and Z coordinates, or by placing the connector at the center of the block, using the options shown in the image.
This chapter provides information on creating content stored in catalogs, namely, parametric and block-based parts and fittings. For information on creating style-based content, see Customizing Style-Based Content on page 891.

Understanding Parametric and Block-Based Parts

You can create 2 types of content using Content Builder: parametric parts and block-based parts. To determine what type of part to create, it is important to understand how each type is defined, how the parts are used in AutoCAD MEP, and what type is best for certain parts.

**Parametric Parts**

Parametric parts give you the flexibility to create parts that are dynamically sized according to size parameters. You define a parametric part by creating a 3D model of the part and assigning variables, or parameters, to control its shape and size. Parameters are defined by individual values, lists of values, or calculated values based on equations. When the part is placed in your drawing, you specify values for the parameters and the part is dynamically built to reflect the specified shape and size. Parametric parts enable you to create a single 3D model for a part family that can be updated to represent multiple part sizes. Parametric parts enable you to define millions of parts through a single model, depending on the number and type of parameters defined.

RELATED See Workflow for Creating a Parametric Fitting with Content Builder on page 1007 and Workflow for Creating a Parametric MvPart with Content Builder on page 1040 for steps to build parametric parts in AutoCAD MEP.
It is beneficial to create parts like equipment and fittings as parametric parts. Equipment, such as an air terminal, a junction box, or a tank, share the same geometric features; however, the features change in size according to the design. Following are examples of custom parametric parts for each module.

- **Mechanical:** A 4 x 4-inch rectangular floor register looks the same as a 6 x 6-inch rectangular floor register, except for the longer length and width. By creating a parametric part, you can create a 3D model of a rectangular floor register and assign parameters for the length and width that can change in size. When the register is placed in your drawing, you can specify the length and width, and the register is dynamically built to match.

  **Viewing different-sized air terminals**

  ![Air terminal 1](image1) ![Air terminal 2](image2)

- **Electrical:** A 13-hole junction box for 1-inch conduit looks the same as a 13-hole junction box for 3-inch conduit, except for the size of the inlet for the conduit connection. By creating a parametric part, you can create a 3D model of a 13-hole junction box and assign a parameter for the conduit connection that can change in size. When the junction box is placed in your drawing, you specify the size of the conduit and the junction box is dynamically built to match.

  **Viewing different-sized junction boxes**

  ![Junction box 1](image3) ![Junction box 2](image4)

- **Plumbing:** A 120-gallon storage tank looks the same as a 350-gallon storage tank, except for the height and diameter. By creating a parametric part, you can create a 3D model of a storage tank and assign parameters for the height and diameter that can change in size. When the storage tank is placed in your drawing, you can specify the height and diameter, and the tank is dynamically built to match.
Viewing different-sized tanks

Fittings such as elbows, tees, and crosses also share geometric features that change in size according to the design. For example, a round 2-inch elbow looks the same as a round 6-inch elbow, except for the diameter and elbow radius. By creating a parametric part, you can create a single 3D model of a round elbow and assign parameters for the diameter and elbow radius that can change in size as needed. When the elbow is placed in your drawing, you can specify the diameter and radius and the elbow is dynamically built to match.

Viewing different-sized elbows

Block-Based Parts

A block-based part is a multi-view part (MvPart) whose geometry is based on individual AutoCAD® blocks. Each part size is associated with a unique 3D model block, to which you specify basic information such as view representations and connector placement. 2-dimensional (2D) block representations are generated for each part size. When the part is placed in your drawing, you select a specific part size, and the unique representation of the part is added to your drawing.

You create equipment, referred to as MvParts, as block-based parts. MvParts, such as air handling units, motor control centers, or pumps, typically consist
of a group of unique parts with their own geometric features. Shape, size, connection points, and properties such as manufacturer or material may differ.

**NOTE** MvParts that are simple in design, such as air terminals or fans, can also be created as parametric parts.

For example, a gas air handling unit and an electric air handling unit are not only different in shape and size but also in placement of connection points and types of connectors.

**Viewing different air handling units**

![Air handling units](image)

**TIP** Create parametric parts for equipment and fittings that are simple in design and require many part sizes. Create block-based parts for equipment and fittings that are complex in design and require only a few part sizes.

### Approaches to Creating Parts

The Content Builder on page 966 dialog offers several task-specific options to build custom parts in AutoCAD MEP. You can create or modify both parametric and block-based parts.

Depending on the task you select, Content Builder has 2 working environments: parametric building and block-based building.

**Parametric Building Environment**

Content Builder uses the parametric building environment when you choose to create or modify a parametric part. The following example shows Content Builder displaying a rectangular duct to round conical tap tee. For more information, see Starting Content Builder on page 966.
This environment includes the following user interface features:

- The part browser is displayed on the left side of the screen and provides an organized view into the features of your part. As you define your part, additional features are nested in a hierarchy under the appropriate folder. In the browser, you can show as much or as little detail as you wish by expanding or collapsing the folders.

- The modeling area is displayed on the right side of the screen and is designed to give you full view control over your part model. You can use the standard AutoCAD view commands to change the direction in which you view your part model.

- The toolbar provides quick access to select Content Builder commands. Icons are available for saving your part, saving an existing part as a new part, generating a preview image, validating your part, and specifying part options.

- The status bar, located at the bottom of the part browser, provides updated information about part validation when you click the Validate icon on the toolbar. A description of the validation status is provided in addition to a traffic light that displays green when the part is valid and red when the
part is invalid. A details button provides a list of warnings and/or errors found in your model.

■ Feature-specific menus are available when you right-click a part feature in the browser window. Options that are not available are shaded.

The part browser and the modeling area are resizable windows. You can drag a corner of a window to change its shape and size, and you can drag a window to a new location on your screen.

**Block-Based Building Environment**

Content Builder uses the block-based building environment when you choose to create or modify a block-based part.

This environment features 2 modes:

■ You create block-based parts or add part sizes to part families. The Wizard mode steps you through defining part behavior, individual part sizes, AutoCAD blocks used to represent each part size, a preview image to assist during part selection, part connectors, and property set information. For more information, see *Starting Content Builder for Creating a Block-Based MvPart* on page 1131.
You modify block-based parts. Tabs are available for part behavior, assigned blocks and names, preview image, part connectors, and assigned property set information. You can make changes to one or all of the tabs at any
time. For more information, see Starting Content Builder for Modifying a Block-Based Part on page 1142.

Content Builder

The AutoCAD MEP software uses the term content to represent real-world parts, such as fittings and equipment. Content Builder is a content creation tool included in AutoCAD MEP. It is an integrated package of 3D modeling tools and 2D drafting and drawing capabilities that helps you to conceptualize, design, and build content. Each piece of content represents a part family, such as air terminal, junction box, or tank, that contains a collection of part sizes, such as a 4 x 4-inch rectangular floor register, a 1-inch conduit 13-hole square junction box, or a 150-gallon vertical tank, respectively. Content Builder enables you to create and modify part families and individual part sizes.

When you use Content Builder, you build 3D models of parts and generate and assign 2D drawing views of those parts to use in design layouts. The model is defined in terms of the size, shape, and position of the features that make
up the part. You associate the part with a catalog and navigate to that part when you want to add it to your layout. You also add connectors to the part to enable intelligent connections to other building systems objects, in order to create complete building systems networks.

**Tips for Using Content Builder**

The following items are tips you should keep in mind as you use Content Builder.

■ Save a backup copy of the part catalogs before using Content Builder, in case you need to revert to the original catalogs provided with AutoCAD MEP. You can use a browser application, such as Windows® Explorer, to copy and paste the catalogs and their sub-folders to a new location.

■ Determine model dependencies. Analyze the model design to determine how features interrelate; then decide how to create the model.

■ Work in a 3-dimensional (3D) view. Creating the model in a 2-dimensional (2D) view may lead to confusion.

■ Use the order of the folders in the part browser as a guide to the steps involved in the creation process.

■ Do not use the EXPLODE command. Exploding a part deletes the part definition from the catalog.

■ Content Builder generates drawing views of your parametric part. The AutoCAD MVIEW command does not create associative views of your parts.

■ AutoCAD object snaps can be used to assist in object selection.

**Allowing for Automatic Layer Mapping of Part Sizes for Content Builder**

When using Content Builder, you assign a layer key to the part family to allow for automatic layer mapping of part sizes. Only those layer keys predefined in the layer key style selected for your current drawing are available for selection in Content Builder. Therefore, before using Content Builder, you must select a layer standard and layer key style to use for your part sizes. Recommended selections are the MEP - AIA layer standard (AecbLayerStd4.dwg).
and Mech - AIA 256-color layer key style, which are provided with AutoCAD MEP. They include layer keys for all AEC objects.

A layer key style is used to map an AEC object, such as an MvPart, to a defined layer based on a layer standard. When you add an AEC object to a drawing that has a specified layer standard and layer key style, the AEC object is placed on the layer to which it is mapped. This is referred to as layer keying. For example, according to the MEP - AIA layer standard (AecbLayerStd4.dwg) and associated (Mech - AIA) layer key style, the Air Handling Unit layer key is mapped to the M-HVAC-Eqpm layer. Therefore, when you add an air handling unit to your drawing, it is assigned to the M-HVAC-Eqpm layer. For layer keying to work, you must select a layer standard and layer key style for your drawing.

**NOTE** To learn more about layer standards and working with layer keying, see AutoCAD MEP Layer Standards on page 203 in this Help system or Layer Management in AutoCAD Architecture Help.

To select a layer standard and layer key style

1. Click Home tab ➤ Layers panel ➤ ➤ Select Layer Standard .
   The Drawing Setup dialog is displayed.
2. On the Layering tab, under Layer Standards/Key File to Auto-Import, browse to select a drawing that contains the layer standard and layer key style you want to use, and then click Open. It is recommended that you select the AecbLayerStd4.dwg layer standard located in the \ProgramData\Autodesk\MEP 2011\enu\Layers folder to use the standard AutoCAD MEP layers.
3. Under Default Layer Standard, select a layer key style from the list, and then click OK.
   It is recommended that you select the Mech - AIA 256-color layer key style to make all AEC object layer keys available in Content Builder.

**Starting Content Builder**

When you start Content Builder, the Getting Started - Catalog Screen dialog is displayed. This task-specific dialog acts as a toggle, giving you quick access to the different working environments. The Getting Started - Catalog Screen
dialog has a part catalog browser and an icon bar. You select a catalog from the list of loaded part catalogs that are specified on the MEP Catalogs tab in the Options dialog. To learn more about a part catalog and how parts are stored in a catalog, see Working with Catalog-Based Content on page 115.

**IMPORTANT** When selecting a catalog, it is important to analyze the type of part you want to create or modify. MvParts belong to a single catalog; however, they can have a different domain for each connection.

When selecting a part to create or modify, the Getting Started - Catalog Screen dialog detects the part domain, and guides you by activated icons to ensure that you use the correct building environment. Icons are activated based on the selected domain and part in the part catalog browser, whether parametric or block-based. For example, if you select an MvPart part catalog, both the New Block Part and New Parametric Part icons are available. However, if you select a component part catalog such as duct or cable tray, only the New Parametric Part icon is available.

Block-based parts are created and modified through the block-based building environment, and parametric parts are created and modified through the parametric building environment. For more information about the building environments in Content Builder, see Approaches to Creating Parts on page 960.

**To start Content Builder and open a building environment**

1. Click Manage tab ➤ MEP Content panel ➤ Content Builder
The Getting Started - Catalog Screen dialog is displayed.

2 Select a part catalog.

**TIP** Be sure to select the correct catalog when creating a new part. Each catalog domain creates specific data that is added to the parts in the respective catalog. The catalog path is determined by the settings used in the catalog tab of the Options dialog on page 100.
IMPORTANT To facilitate the process of upgrading to a new version of AutoCAD MEP, add all your custom parts to custom catalogs. Do not add custom parts to the catalogs provided with the software. When you upgrade, this allows you to easily move all your custom catalog content as a whole to the catalog folders for the new version (where new versions of the catalogs provided with the software are also located). You can use both types of catalogs during layout if you specify multiple catalogs for a domain, as described in Specifying Part Catalogs and Style-Based Content Locations on page 100.

3 In the Getting Started - Catalog Screen dialog, do one of the following:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then select a chapter and ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>create a new block-based MvPart</td>
<td>click <img src="image" alt="image" />. Enter a name and description for the MvPart, and click OK. The block-based building environment is opened for part creation.</td>
</tr>
<tr>
<td>create a new parametric MvPart</td>
<td>click <img src="image" alt="image" />. Enter a name and description for the MvPart, and click OK. The parametric building environment is opened for part creation.</td>
</tr>
<tr>
<td>add a new chapter for an MvPart</td>
<td>click <img src="image" alt="image" />, and enter a name. You can add chapters to the catalog or to another chapter.</td>
</tr>
<tr>
<td>add a new part size to an existing MvPart</td>
<td>select the MvPart, and click <img src="image" alt="image" />. The appropriate building environment is opened for modifying the part.</td>
</tr>
<tr>
<td>modify an existing part size</td>
<td>select the MvPart, and click <img src="image" alt="image" />. The appropriate building environment is opened for modifying the part.</td>
</tr>
</tbody>
</table>
If you want to... then select a chapter and ...

delete an MvPart

select the MvPart, and click ‒ . The part is deleted from the catalog and is removed from the tree.

NOTE After selecting an MvPart, if the model geometry is unavailable, you are accessing legacy content. Legacy content can only be modified. It is recommended to modify legacy content using Catalog Editor.

Working with Parametric Parts

You can build parametric parts using the following tools:

- **Content Builder.** on page 970 This tool contains a collection of 2D drawing and 3D modeling tools. You can create parts by building them component-by-component or by assembling them from primitives, predefined models that represent basic shapes and connections.

- **Parametric Part Wizard on page 1037.** This wizard enables you to quickly create common parts that require only basic models. You create the parts using templates that are included in the software.

NOTE For an introduction to parametric parts, see Understanding Parametric and Block-Based Parts on page 957.

Building Parametric Fittings Using Content Builder

Content Builder contains a collection of 2D drawing and 3D modeling tools. Content Builder lets you create parts by building them component-by-component or by assembling them from primitives (predefined models that represent basic shapes and connections).

When creating a parametric part, you define the features of the part and how they are associated with one another. Each parametric part represents a unique part family. You should analyze the catalog hierarchy to determine the best place to add part families. It is also important to notice the relationships between the different part sizes you want to create. The features you define in the model determine the flexibility you have to create multiple part sizes.
You should look at the entire part you want to create, decide how to break it down into simple shapes, and determine the relationships to establish between the different shapes.

**Best Practices for Creating a Parametric Fitting**

Content Builder is part of AutoCAD MEP, which is built on AutoCAD®, and uses many of the tools that you may already be familiar with. Content Builder is a unique building environment that enables you to create parametric parts. Therefore, care must be taken to avoid using standard AutoCAD commands. The following tips will help you to create a parametric fitting.

**Tips for Modeling the Part**

The following items are tips you should keep in mind as you model the parametric part.

- Use work planes to control the UCS orientation. Using the AutoCAD UCS command does not associate the current plane with your part.
- Use the AutoCAD Point Style command to increase point sizes. It is recommended to use an absolute point size.
- Use a minimum number of points. Reusing points is less confusing and helps in constraining the model.
- Use both constraints and dimensions. Some constraint combinations may distort unconstrained features of the model. If so, delete the last constraint and consider using a dimension or a different constraint combination.
- Use Content Builder dimensions. AutoCAD dimensions are not parametric and cannot control the size, shape, or position of part content.
- Dimension large features before small features. To minimize distortion, define larger features that have an overall bearing on the model. Dimensioning small features first may restrict overall size. Delete or undo a dimension if the model shape is distorted.
- Define shape before size. If you apply constraints before dimensions, your model shape is less likely to become distorted.
- Determine model dependencies before applying constraints. A single constraint can often be used to define more than one feature's shape. Therefore, analyze the model design to help identify necessary constraints.
Add constraints as needed to define the model shape. Because constraints often restrict more than one feature, use fewer constraints to avoid distorted models.

When using calculated values for model parameters, be aware that calculated values are not available in the part Add Size filter.

**Recommendations for Creating Parametric Fittings Content**

This topic provides recommendations to use when creating or modifying content for custom parametric fittings. The first section lists general recommendations and the other sections defines recommendations specific to the parametric part.

**TIP** Some of the following recommendations refer to male-female parts that you can build. A male-female part includes both male and female connectors on page 403.

**General Recommendations**

- Pipe parts are created in the Piping domain in the Top plane.
- You must build fittings as parametric parts. Parametric refers to a method in Content Builder that uses the values of part parameters to determine the geometric configuration of the part.

**RELATED** For more information about parametric parts, see Parametric Part Creation Overview on page 975 and Workflow for Creating a Parametric Fitting with Content Builder on page 1007. For more information about connectors on a parametric part, see Connectors of a Parametric Part on page 994.

- You should follow the guidelines for connectors that are outlined in Rules for Connector Behavior on page 974.

**NOTE** Content Builder verifies that all pipe connectors have parameters for connection engagement length on page 404 (CEL), angle of deflection on page 405 (AoD), and nominal diameter (ND). The missing parameters are added if necessary, and then you are prompted to accept the changes.

- Part names should use the following conventions:
  Connection Type — Schedule/Pressure Class (if any)
  Part Type — Flanged - Class 2500 - Raised Face Blind Flange
Crosses

- Connector 1 on a male-female part is male. The CEL value for the male connector is equal to 0. Connectors 2 or 3 can be male or female. Connector 4 is female.
- The CEL on page 404 value for each female connector is greater than 0.
- Path angle PathA1 is equal to 180 degrees. Path angle PathA2 and path angle PathA3 can be equal to or less than 90 degrees.

**RELATED** For more information about path angles, see Dimensions on page 981.

Elbows

- Connector 1 on a male-female part is male.
- For elbows with 2 connectors, connector 2 is female. For elbows with 3 connectors, connector 2 or 3 can be male or female.
- Path angle PathA1 can be any angle value.

Offset Wyes (Laterals) and Tees

- Connector 1 on a male-female part is male. Connector 1 has a CEL value of 0.
- Connector 2 is female with a CEL value greater than 0.
- Connector 3 can be male or female.
- Path angle PathA1 is equal to 180 degrees. Path angle PathA2 can be equal to or less than 90 degrees.

Eccentric Transitions

- The female connectors on a male-female part can be located on either of the 2 connectors.
- Male connection types are undefined to allow the connection name to be inherited from the associated female connector.

Grooved - True Wye

- Connectors on a male-female part follow a clockwise orientation. For more information, see Connectors of a Parametric Part on page 994.
As you draw pipe, auto layout on page 370 can generate routing solutions. However, these routing solutions on page 371 do not include the insertion of true wyes.

**Mechanical Joint (Bell, Hub)**

- Connector 1 on a male-female part is male. The CEL on page 404 value is equal to 0 and is set to constant. For more information, see Dimensions on page 981.
- The CEL value for connector 2 (female) is greater than 0 and is determined by the manufacturer.
- The part type is coupling.

**Rules for Connector Behavior**

In the Content Builder, connectors are assigned an undefined type by default. For more information, see Adding Connectors to a Parametric Fitting on page 1019. An undefined connection type creates a valid connection between all types of connectors when inserted into a drawing. The following guidelines apply to connector behavior:

- Connectors are created in the Piping domain with a shape that is round.
- A male connector should be assigned the undefined connection type. Male connectors with this connection type use the connection assignments functionality in the Connection Assignments tab of the Pipe Layout Preferences dialog. For more information, see Connection Assignments on page 436.
- A pipe connector should have only 1 connection name selected on the Connection Type Selection dialog in the Content Builder. However, if more than 1 connector name is selected, then the first one that the software detects will be used. For more information, see Adding Connectors to a Parametric Fitting on page 1019.
- Female connectors should be set to a connection type other than undefined.
- When a female connector is connected to an undefined connection type, that female connector will appear with the male connection type assigned to the female connection type name on the Connection Assignments tab of the Pipe Layout Preferences dialog. For more information, see Connection Assignments on page 436.
Butt-welded connections only connect to other connectors of the same type. A butt welded connector has no CEL value (connection engagement length on page 404). It connects to other butt-welded connectors without a joint.

Connector 1 is on the bell end of the bell/hub, and connector 2 is on the back end. The fitting orientation depends on the Joint direction on page 403 selection on the Pipe Properties palette on page 420. Connector 2 reports the same connection type as connector 1 on the Connection Assignments on page 436 tab of the Pipe Layout Preferences dialog.

The Piping domain has a connection type called Same Connection. When Same Connection is configured for a connector and coupling part types that are attached to a hub, connector 1 inherits the connection type of the connection type on connector 2 of the attached hub.

Parametric Part Creation Overview

This section presents a detailed overview of the fundamentals of parametric part creation using Content Builder. See Workflow for Creating a Parametric Fitting with Content Builder on page 1007 for a high-level outline of the procedures you will perform.

RELATED See How Catalog Parts are Stored and Referenced on page 117 for information about part catalogs and their hierarchical structure.

Part Configuration of a Parametric Part

When the parametric building environment opens, the first folder in the part browser is the Part Configuration folder. The part configuration defines the characteristics and behavior of the part according to the domain, type, and subtype, and it is required to save the part. To ensure that the part can be validated and saved correctly, you should define the part configuration before starting to model the part.
The part configuration is defined once for a part family and remains constant for all part sizes. There are 4 required components of the part configuration:

**Part Description** Describes the part family. You can edit the part description in the part browser. However, you cannot edit the part name here. When you create a new part, you enter the part name and description in the New Part dialog. By default, the description is the same as the part name unless a different description is entered. For existing parts, the part description is predefined.

**Part Domain** Defines the family of parts, such as duct components, pipe components, cable tray components, conduit components, or MvPart components. You cannot edit the part domain in the part browser. The part domain is predefined based on the part catalog you selected in the Getting Started - Catalog Screen dialog of Content Builder. The part domain is selected from a list of predefined domains for building systems.

**Part Type** The actual type of part, such as elbow, tee, fan, damper, or tank. From the list of predefined part types in the part browser, you specify the part type, which is based on the building system and loaded part catalogs. The part type is helpful during part selection.

**Part Subtype** Categorizes part types. In the part browser, you specify the part subtype from the list of predefined subtypes. You can also enter a custom part subtype if you wish. The part subtype is helpful during part selection to filter a large group of parts of similar type.

### Model of a Parametric Part

A model is the graphical representation of a parametric part. In Content Builder, a model consists of various features that have specific relationships to each other and that define the behavior of the parametric part. Some features require that you create simple shapes or points, while others require an
extrusion or path. Some represent visible geometry, and some help you to position geometry precisely on a part. You can modify features to refine and improve your parts over time. You change features by modifying their size and shape or by flipping or moving them. To effectively model a parametric part, it is important to understand how each feature relates to the other features of modeling.

The following illustration shows the features that make up the model. Arrows indicate the direction of the relationship between features. For example, modifying geometry affects a profile, which affects a modifier, and so on.

The following sections introduce the features of modeling. Refer to this illustration as you learn more about each feature to help you understand the relationships between features.

**Work Planes**

A work plane is a modeling feature that defines the location of a plane in 3-dimensional (3D) space. It is an infinite construction plane that can be placed at any orientation in space. It can be offset from an existing work plane, or it can reference 3D geometry. Using a work plane, you define the geometry, dimensions, constraints, and profiles that make up the part model. Work planes help you to place geometry that would otherwise be difficult to position parametrically. By constraining geometry to work planes, you can control their location. Work planes help you to define relationships between features and provide control when placing features.

A work plane is displayed as a rectangular 2-dimensional (2D) object. The work plane display is only a visual representation of the infinite plane and cannot be moved or resized. However, you can control its visibility for ease of viewing the model. Offset and reference work planes are user-defined and provide the flexibility to be moved and redefined.
NOTE To ensure a manageable model size, it is recommended to use a minimum number of work planes.

When you right-click on a work plane in the part browser, it is highlighted in the modeling area. You can change the view direction to match that of the selected work plane when adding geometry or dimensions by using the Set View option on the Work Plane context menu.

IMPORTANT Any features attached to a work plane are restricted to the original plane. If you move a work plane, any features attached to the plane also move. If you delete a work plane, any features attached to the plane are also deleted. Each feature attached to a work plane appears under the Work Plane folder in the part browser.

Content Builder provides 3 default work planes that intersect at the origin of the X, Y, and Z axes. The default work planes help you to get started with modeling a part. You can add work planes at any time during the modeling process. Each work plane has its own internal coordinate system. Work planes can be created on any plane in the current user coordinate system (UCS) or in the World Coordinate System (WCS).

The following preset work planes can be added to a model from the Create Work Plane dialog:

**Default** Creates the standard ZX, YZ, and XY work planes of the WCS.

**Custom** Creates a work plane that is not available by the preset work planes. The work plane has user-defined values for the X and Y direction and the origin of the plane in the current UCS.

**Offset** Creates a work plane that is offset by a specified distance from a selected source work plane. For more information, see Offset and Reference Work Planes on page 979.

**Reference** Creates a work plane that is attached to the extents of a modifier feature. For more information, see Offset and Reference Work Planes on page 979.

**Top** Creates a work plane that matches the standard Top 3D view.

**Bottom** Creates a work plane that matches the standard Bottom 3D view.

**Front** Creates a work plane that matches the standard Front 3D view.

**Back** Creates a work plane that matches the standard Back 3D view.

**Left** Creates a work plane that matches the standard Left 3D view.
Right Creates a work plane that matches the standard Right 3D view.

Viewing default work planes

Offset and Reference Work Planes

Offset and reference work planes are relational and are based on one or more defined features in the model, such as other work planes or modifiers.

Offset Work Planes

An offset work plane is some distance away from another work plane. This work plane can be offset from any existing work plane, including another offset or reference work plane. You define an offset work plane by selecting a source work plane and specifying a distance between the work planes. You can use offset work planes to maintain specified or calculated distances between features, such as profiles, geometry, or modifiers. You can also use offset work planes as construction guides for locating features that would otherwise be difficult to locate parametrically. For example, use an offset work plane to define the length of a transition.

Creating an offset work plane

Reference Work Planes

A reference work plane is defined as a plane on the face of the extents of a modifier. Every modifier has an invisible extent, or boundary box, that defines the extents of the feature. You can create a work plane that references one of the planes of the extent. To define a reference work plane, you select a modifier and a source work plane that represents the plane direction you want to create.
The extents, or boundary box, of the feature is detected, and 2 valid reference work planes are available for selection. If the modifier is moved or resized, the reference work plane is moved with it.

Creating a reference work plane

Geometry

You construct a model bit by bit, building shapes to add to it and using tools to cut away the portions of the shapes you do not need. In Content Builder, these shapes are features of the part you are creating. Geometry features are the basic building blocks for defining the size and shape of the model.

Geometry that you define is 2-dimensional (2D) and must be attached to a work plane. You can switch between work planes to define different geometry. As you add geometry to a work plane, the geometry features appear under the Geometry folder of the associated work plane.

WARNING Avoid using basic AutoCAD® geometry commands. AutoCAD geometry is not valid for work planes and cannot be used to create features for parametric part models.

Viewing geometry types

<table>
<thead>
<tr>
<th>Point</th>
<th>Line</th>
<th>Unbounded Line</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circle</td>
<td>Arc</td>
<td>Rectangle</td>
</tr>
</tbody>
</table>

Content Builder provides 9 types of geometry you can use to build the model:

Point Defined by an X and Y coordinate.
Line Defined by a position and a direction; constrained by a start point and endpoint.

Unbounded Line Defined by a position and a direction; infinite in length because it has no constraining start point or endpoint.

Circle Defined by a center point and a radius.

Arc Defined by a center point and a radius; constrained by a start point and endpoint.

Rectangle Defined by lines and points that are constrained to maintain start points and endpoints for each side and perpendicular angle.

Oval Defined by lines, arc, and points that are constrained to create 2 arcs tangent to 2 lines, with defined start points and endpoints.

Point Reference Defined by a point in the work plane that is based on a source point selected from a different work plane. A point reference is moved or deleted with the source point.

Project Geometry Defined by a projection of a modifier on a specified work plane. The project geometry is fixed and cannot be moved in the work plane. It is linked to the modifier and adjusts as the modifier changes.

Dimensions

Models require dimension information to maintain size and position for the design. Dimensions are typically added after you have finalized the geometric features of the model or when placing a connector; however, you can add dimensions at any time during the creation process. When you add dimensions, you apply rules that control the size and position of features in the model. Dimensions work in conjunction with constraints. The model is updated when changes are made to the dimensions.

Dimensions specify the length, diameter, or rotation angle of geometric elements in the model. When a dimension is added, a corresponding size parameter is also added. This parameter creates a placeholder value for the dimension that provides flexibility for defining the values of dimensions. Dimensions can be defined as default numeric constants or as equations. Although you can use them interchangeably, they each have specific uses.

- Numeric constants are useful when a geometric element has a static or fixed size that is populated as a value in a basic table, list, or constant storage type.
Equations are useful when the size of a feature icon must be mathematically defined relative to the size of another feature.

Content Builder assigns a variable name to each dimension parameter. Letters and numbers are used to signify the type of dimension (such as length or diameter) and the sequence in which the dimension was added to the model (1 for first, 2 for second, and so on). To keep the model shape from becoming distorted as the dimensions resize it, define the large dimensions first. Dimension type depends on the feature you choose and where you place the dimensions.

**NOTE** When adding dimensions it is recommended to select points to specify the start and end locations. It is also helpful to turn off geometry that you are not dimensioning for ease of selection.

**Viewing dimension types**

- **Distance**: Can be defined for pairs of geometry of all types. Defines a value between 2 features. The value of a distance dimension cannot be negative. When adding distance dimensions between 2 lines, it is implied that the lines are parallel with a given separation.

- **Horizontal Distance**: Can be defined for pairs of geometry of all types. Defines a value between 2 features in a horizontal direction. The value of a distance dimension cannot be negative.

- **Vertical Distance**: Can be defined for pairs of geometry of all types. Defines a value between 2 features in a vertical direction. The value of a distance dimension cannot be negative.

- **Parallel Distance**: Can be defined for pairs of geometry of all types. Defines a value between 2 features in a parallel direction. The value of a distance dimension cannot be negative.

Content Builder provides 7 types of dimensions you can add to the model:

- **Distance**: Can be defined for pairs of geometry of all types. Defines a value between 2 features. The value of a distance dimension cannot be negative. When adding distance dimensions between 2 lines, it is implied that the lines are parallel with a given separation.

- **Horizontal Distance**: Can be defined for pairs of geometry of all types. Defines a value between 2 features in a horizontal direction. The value of a distance dimension cannot be negative.

- **Vertical Distance**: Can be defined for pairs of geometry of all types. Defines a value between 2 features in a vertical direction. The value of a distance dimension cannot be negative.

- **Parallel Distance**: Can be defined for pairs of geometry of all types. Defines a value between 2 features in a parallel direction. The value of a distance dimension cannot be negative.
**Perpendicular Distance** Can be defined for pairs of geometry of all types. Defines a value between 2 features in a perpendicular direction. The value of a distance dimension cannot be negative.

**Diameter** Can be defined for circular and arc geometry. Defines a value for the diameter of a circular feature.

**Angle** Can be defined for pairs of linear geometry. Defines a value for the degrees between 2 linear features. See also Path Angle.

**Path Angle** Defines the sweep (angle direction) that the software uses to ensure that the 3D part is built correctly. Path Angle appears as appears as PathA1, PathA2, etc. under Size Parameters in the Content Builder.

**Constraints**

Depending on the geometry of the model, you may need to add one or more constraints to define the shape or size of the model. Constraints enforce rules that you want the model to obey. Constraining a model controls how a model can change in shape or size, called “degrees of freedom.” For example, a circle has 2 degrees of freedom: the location of its center and its diameter. If the center and diameter are defined, the circle is fully constrained and those values can be maintained. Constraints specify the relationships of geometric features; for example, whether 2 features are perpendicular, parallel, tangent, concentric, or have the same midpoint or radius.

**NOTE** After you add geometry, dimensions, or constraints to the model, the degrees of freedom are listed on the command line.

Constraints work in conjunction with dimensions to control the shape and size of the model. Any time you modify the model, the geometry retains the relationships among features in accordance with the applied constraints. You add constraints to indicate your design intent. For example, a parallel constraint could be defined between 2 lines based on the geometry of the model. You could also add a constraint to force both lines to have the same length.

As you apply geometric constraints, continue to analyze the model, reviewing and replacing constraints as necessary. As you gain experience, you will be able to determine which constraints control the model to meet your design requirements. Some constraints work only with lines, while others work only with arcs, circles, or points.
Applying a tangent constraint

Applying a parallel constraint

Applying a perpendicular constraint

Applying a concentric constraint

Content Builder provides 10 geometric constraints. The following list describes these constraints and the features with which they can be used.

**Tangent** Can be defined between curved geometry (such as a circle or arc) and either another curved geometry or a line. Makes 2 curves tangential to one another, even if they do not physically share a point. Tangency is commonly used to constrain a line to an arc or circle.

**Parallel** Can be defined between pairs of geometry with a direction, such as lines. Causes 2 or more lines to be parallel to one another.

**Perpendicular** Can be defined between pairs of geometry with a direction, such as lines. Causes selected lines to lie at right angles to one another.

**Concentric** Can be defined for any combination of circles and points. Fixes the centers of the geometry to the same location. Common uses include circle to circle, where the center of both circles is the same; circle to point, where
the point lies at the center of the circle; and point to point, where the points are the same.

**Coincident** Can be defined between a point and any geometry. Fixes 2 points (including center points) together; essentially, the point lies on the geometry.

**Equal Distance** Can be defined between 2 pairs of geometry. The distance between the first pair of geometries is fixed to the distance between the second pair. Equal distance constraints do not control the actual distance. Each pair of geometries must be one of the following: any combination of points and lines, 2 circles or arcs concentrically constrained, or a point and circle or arc concentrically constrained.

**Equal Radius** Can be defined between 2 circles or 2 arcs. Fixes the radius of both circles or arcs to be of the same value. Equal radius constraints do not control the value of the radii.

**Midpoint** Can be defined between a point and either 2 other points or 2 lines. The point is equal distance from the other 2 geometries. Midpoint constraints do not control the distance. A common use is constraining a point to the middle of a line.

**Symmetric** Can be defined between 2 geometries of the same type and a line. The 2 geometries are symmetrically arranged on opposite sides of the line. The symmetric constraint does not force constrained geometry to maintain an exact mirror image.

**Normal** Can be defined between a line or curve and a curve. (2 lines cannot be made normal; a perpendicular constraint must be used instead.) The curves intersect and the directions of curve tangents are perpendicular at the point of intersection. A common use is constraining a line to the normal of an ellipse.

**Profiles**

A profile is a 2-dimensional (2D) outline of a geometric shape. Using Content Builder, creating a profile is as easy as drawing a closed shape. Profiles are similar to geometry in that they are a visual representation of the 2D shapes that make up the model. Because profiles automatically associate constraints to the geometry, you can use profiles as a source of information from which to create features. You create profiles on a work plane and apply modifiers, such as extrusions, to them.

Content Builder provides 4 types of profiles to use for creating features in the model:
Circular Creates a profile based on a circle defined by a center point and diameter to maintain its shape.

Rectangular Creates a profile based on a rectangle defined by 4 lines, 4 points, and 4 perpendicular constraints to maintain its shape.

Oval Creates a profile based on an oval defined by 2 lines, 2 arcs, 4 points, and 4 tangent constraints to maintain its shape.

Custom Creates a profile from existing geometry in the model. The geometry must be attached to a single work plane. Constraints are assigned as needed to maintain the shape of the geometry as it was selected.

Modifiers

After creating profiles, you can apply modifiers to create 3-dimensional (3D) features of the model. A modifier is a general term for any operation that affects features of the model. You can use modifiers to extrude, add, or subtract features and to sweep a profile along a path. You can also use modifiers to create cut planes and transition features.

Content Builder provides 6 types of modifiers: extrusion, path, transition, cut plane, Boolean add, and Boolean subtract. The extrusion modifier is the most common type used in part modeling and is generally the base feature for a model. When you extrude a profile to create a feature, you specify how the feature will modify the shape by choosing 1 of 4 operations: midplane, plane, from-to, or blind.

Midplane Extrusion Modifier

A midplane extrusion uses a profile as the center of the extrusion and sweeps the profile an equal distance away from each side of the center.

Applying a midplane extrusion modifier

Plane Extrusion Modifier

A plane extrusion sweeps a profile between the profile itself and a specified work plane. If the work plane is a reference work plane, the extrusion is updated when the work plane is moved.
Applying a plane extrusion modifier

![Diagram showing a plane extrusion modifier]

From-To Extrusion Modifier

A from-to extrusion sweeps a profile between 2 work planes.

Applying a from-to extrusion modifier

![Diagram showing a from-to extrusion modifier]

Blind Extrusion Modifier

A blind extrusion sweeps a profile a specified distance along its normal, or perpendicular axis. You can flip the extrusion to sweep the profile in the opposite direction as the default normal.

Applying a blind extrusion modifier

![Diagram showing a blind extrusion modifier]

Path Modifier

A path modifier sweeps a profile along path geometry. It creates a 3D feature based on the start and end profile of a piece of geometry, such as a line or an
arc. The start and end profiles can be different. Path modifiers are helpful in creating elbows.

**Applying a path modifier**

You can also specify the number of segments to use to create a 3D feature, which is helpful when creating gore elbows.

**Transition Modifier**

A transition modifier creates a transition body between 2 profiles. A transition includes both a start and end profile, which cannot be in the same work plane. Point references are useful to ensure that the profiles align between work planes; however, the centers do not need to align.

**Applying a transition modifier**

**Cut Plane Modifier**

A cut plane modifier cuts a feature into 2 parts, only 1 of which is kept. A cut plane modifier enables you to change the end of a feature to a slope, providing for the creation of more advanced features, such as an exhaust vent. You can modify the cut plane by dragging the normal, or perpendicular axis, of the modifier to create custom slopes. Cut planes are updated when the length of the modifier changes.
NOTE  Cut planes cannot be defined parametrically. How they are defined in the model is how they will be displayed when placed in your drawing.

Applying a cut plane modifier

Boolean Add Modifier

A Boolean add modifier combines 2 features to create a single feature. This modifier assumes a basic concept of addition: that geometry inside other geometry, when added together, is removed. This modifier is helpful when creating models of MvParts, such as equipment, that are placed in your drawing exactly as they were created in the model.

Applying a Boolean add modifier

Boolean Subtract Modifier

A Boolean subtract modifier subtracts one or more features from another to create a new feature. The Boolean subtract modifier uses a basic formula when creating the resulting feature: that the subtractor objects are removed from the base object. To see results in the model, the subtractor features must intersect with the base feature. When no intersection of features exists, the
subtractor features are removed from the base feature with no visible change in the model.

**Applying a Boolean subtract modifier**

![Diagram of subtract modifier](image)

**Primitives**

Primitives are limited versions of part models that are designed for repeated use in part creation. They represent basic shapes, such as a box or a torus, and commonly used connections on parts, such as a flanged pipe connector or duct connector.

**Primitives that represent basic shapes**

- **Box**
- **Cone**
- **Cylinder**

**Primitives that represent part connections**

- **Undefined Duct Connector - Round**
- **Flanged Pipe Connector**
- **Grooved Pipe Connector**
Primitives include the following modeling features:

- work planes
- geometry, constraints, dimensions, and model parameters
- profiles (2D outlines of geometric shapes)
- modifiers (operations that create 3D features from profiles)

Primitives that represent the connections on parts also include defined connections.

Because primitives do not represent complete parts, they do not have a defined part type, size parameters, or autolayout data. A primitive is defined by a DWG file that specifies its limited configuration, and a preview image (BMP file) that facilitates its selection when users are adding primitives to parts. Because primitives are not parts, you cannot add them to catalogs. They are stored in a content folder instead.

AutoCAD MEP includes primitives for many of the shapes commonly found in parts as well as for the connections that are typically required. Because the primitives include many of the modeling features that you need to build a custom parametric part, you can use them to quickly build a part model and add connections. For more information, see Modeling with Primitives on page 1048.

**Trim Lengths and Placement Points**

After you finalize the model of your part, you need to define insertion behavior to ensure that your part can be placed correctly in a drawing. Insertion behavior includes specifying the placement point, or insertion point, that is used when placing the part in a drawing, and specifying the trim lengths for parts, such as fittings, that require other components to be trimmed when placing the part in a run.

The Auto Layout option in the Content Builder Options dialog controls whether trim lengths and placement points can be defined for a part. When you enable this option, an Autolayout Data folder is available in the part browser that includes commands for adding trim lengths and placement points.

**NOTE** For parametric MvParts, the Autolayout Data folder is included in the part browser by default, enabling you to define the placement point directly during the modeling process.
**Trim Lengths**

Trim lengths are available only when creating a parametric fitting. Configured to work with the Auto Layout option enabled, trim lengths define the length dimensions used to trim other components to make room for a new fitting. For example, when you add a tee to an existing run in your drawing, the segment is trimmed to the length of the trunk, creating 2 individual segments, 1 on either side of the fitting.

Each trim length is defined from the center, or intersection point, of the fitting to an end, or connection point, of the fitting. To ensure components are trimmed correctly when placing a parametric part into a drawing, you must define trim lengths for the part in a specific order—left to right, then bottom to top. The number of trim lengths required for a part depends on the type of fitting and the number of connection points, as shown next:

**Elbows require 2 trim lengths**

![Elbow Trim Lengths](image1)

**Reducers require 2 trim lengths**

![Reducer Trim Lengths](image2)

**Tees require 3 trim lengths**

![Tee Trim Lengths](image3)

**Crosses require 4 trim lengths**

![Cross Trim Lengths](image4)

To add a trim length, you select valid node points that are displayed in the model and define a distance for the length. The following illustration shows how trim lengths for a tee fitting would be defined:
A tee has 3 trim lengths: 2 are defined from the center point of the trunk to each end of the trunk legs (1 & 2), and the third is defined from the center of the trunk to the end of the branch leg (3).

**Placement Points**

For parametric MvParts, the placement point is the insertion point used to place the part in a drawing. You simply specify a point in your model for the placement point. For parametric fittings, the Auto Layout advanced option in the Content Builder Options dialog enables automatic part insertion during layout. The connection 1 position is the insertion position, which can be toggled through.

**Model Parameters**

Model parameters control the model’s overall shape and size by establishing relationships between defined parameters. As you add dimensions and constraints to the model, parameters appear under the Model Parameters folder in the part browser. The Model Parameters dialog provides a central location where you can view, create, and edit the dimensional parameters of the model. You can define parameters to create additional model relationships or to enhance drawing schedules later.

It is often more efficient to assign numeric values to dimensions and other feature parameters as you build the model. When you finalize the geometry, you can edit the model parameters to add calculated values. An equation assistant is available in the Model Parameters dialog to ensure that the equation you create is valid and can produce a result. Each parameter in the Model Parameters dialog includes the following:

**Name** A unique identifier for the parameter. Model parameters are assigned default names, such as D1, D2, and D3, that can be changed. User-defined parameters must have unique names.
**Value** The result of evaluating the equation.

**Equation** The mathematical expression that defines the value of the parameter. Constants, other model and user-defined parameters, and mathematical operators can be used in an equation. You can use the Equation Assistant to define the equation.

**Description** A narrative, user-defined description of the parameter.

**NOTE** When using a constant value in an equation, be sure to define the constant as a model parameter. You should verify that the result of the equation is non-zero to avoid undesirable results in your model.

### Connectors of a Parametric Part

In the parametric building environment of Content Builder, you can add connectors to a part. Connectors enable the part to be connected intelligently to other building systems objects in your layout. You can define one or more connectors for a part.

When you add a new pipe connector to a pipe segment or MvPart, the software automatically assigns parameter values for CEL (connection engagement length) and AoD (angle of deflection). CEL and AoD are assigned the following criteria:

- Connector number associated with the CEL or AoD value; for example: CEL1 or AoD1 designating connector 1
- Description
- Constant parameter type
- Real number data type
- Units:
  - For CEL: Drawing length in units (inches or millimeters)
  - For AoD: Degrees
- Default value: 0.000
You place connectors in a left to right, then top to bottom orientation in the positive X-Y plane layout, as shown next.

**Fitting connector orientation**

![Diagram of connector orientations: Elbow, Tee, Cross, Reducer, Lateral]

The Piping domain includes fittings with female connectors. Connection types with female connectors include hub, bell, and mechanical joint. The female connector on an elbow or a tee is designated as connector 2. The female connector on non-symmetric fittings, such as crosses, is designated as connectors 2 and 4. When you add a new pipe connector to a pipe segment or MvPart, the software automatically adds CEL and AoD parameters.

**RELATED** See *Recommendations for Creating Parametric Fittings Content* on page 972 for guidelines to build parametric fittings content. See also *Connection Types for Pipe and Pipe Fittings* on page 401 for fitting types in the Piping domain.

**IMPORTANT** The position of the first connector placed in the model defines the axis orientation of the part upon insertion. For example, if you place the first connector on a part with a perpendicular vector into the part, the direction of the vector defines the positive x-axis orientation when inserted into a drawing.

The shape of the connector is determined by the shape of the modifier that the connector is attached to. You define the size of the connector by placing dimensions when you add the connector to the model.

**NOTE** If a single profile defines more than one connector, you add dimensions to the connector only once.

After the connector has been placed, you can assign the connector type that is dependent on the domain assigned to the part. Examples of connector types include flange, slip-joint, and glued.
The domain defines the connection rules for the part. Connectors belonging to a particular domain know how to connect to other parts of the same domain, but they cannot connect to components in other domains. For example, an air terminal assigned to the duct domain cannot connect to a pipe segment.

**Sizes of a Parametric Part**

The **model parameters** of a parametric part define the default part size of the model and act as placeholders for the actual part sizes that you define later. In turn, the size parameters of the part define the actual part sizes. There is a direct connection between the model parameters and the size parameters. When you add a model parameter to the part model, the software adds a corresponding size parameter as well.

**Model and size parameters of a round damper**

You define the part sizes of a parametric part by specifying values for the size parameters in the Size Parameters dialog.
Size parameters of a round damper

The Size Parameters dialog has 3 modes:

- **Parameter Configuration.** You use this mode to view and change the attributes of parameters, such as the description, type of data storage, type of data, units, and visibility. The type of data storage determines whether the parameter values are stored as a list, a table, a constant, or a calculation. For more information about data storage, see How Catalog Parts are Stored and Referenced on page 117.

  NOTE When you add a model parameter, its corresponding size parameter has several attributes that cannot be changed, such as the data type, units, and context.

- **Values.** You use this mode to view and change the values of parameters when they are stored as lists, tables, and constants. You define multiple part sizes by entering multiple values for the size parameters. You can enter the values manually or copy and paste them from another part open in Content Builder, from a part open in Catalog Editor, or from a spreadsheet. For connector parameters, you can also insert the corresponding sizes for the segments used by default during layout.

- **Calculations.** You use this mode to view and change the calculation formulas of parameters, such as the formula for defining part size names or the formula of a custom parameter. You cannot change the formulas of parameters defined in the model in the Size Parameters dialog; use the Model Parameters dialog instead, as shown in Adding Dimensions to a Parametric Fitting on page 1026.
Size Parameters for Conduit

The Size Parameters dialog for conduit content has been updated to include separate dimensions for outside (nominal) diameter (ND1, ND2) and material (Mat), as shown next. In previous releases, only actual diameter (D1, D2), was available in Content Builder.

Non-Graphical Parameters

In the Parameter Configuration mode of the Size Parameters dialog, you can also add non-graphical parameters to the part family. For example, you might want to add information about materials or manufacturers.

You can add non-graphical parameters in 2 ways:

- You can select from a list of optional, predefined parameters, such as Material or Part Source URL. The predefined parameters that are available depend on the part type and the existing parameters defined in your custom part family.

- You can add custom parameters. For these parameters, you can define all of the parameter attributes.

Using non-graphical parameters to store additional part information can help you to identify the parts in your drawings during the design process. It can also enhance the schedules in your construction documents. For more information, see Collecting Project Data on page 874.
Copying and Pasting Part Sizes

When you are adding part sizes to a part, you can copy and paste values from other part families using standard Microsoft® Windows copy and paste functionality: CTRL+C for Copy and CTRL+V for Paste. The Copy and Paste commands are also available on:

- toolbar of the Size Parameters dialog
- context menu accessed by right-clicking a parameter heading or value

You can copy and paste values from another part open in Content Builder, from a part open in Catalog Editor, or from a Microsoft® Excel spreadsheet.

To open Catalog Editor from inside Content Builder, click (Open Catalog Editor) on the toolbar in the Size Parameters dialog.

If you select one or more parameter values, copy them, and then paste them into another parameter, the software pastes only the values.

If you select a parameter heading in order to copy and paste all of its values, the software copies and pastes the data storage type as well. Copying and pasting values in this manner is possible between parameters with the same data storage type, and between parameters whose data storage types are List and Table. In the latter situation, the software prompts you to select whether to paste only the values, to paste the data storage type and the values, or to cancel the operation.

Inserting the Connector Sizes of Default Segments

Layout preferences define—by connection type and shape—the default parts for a domain (duct, pipe, cable tray, or conduit). The default parts are the segments and fittings to use by default during layout. For more information about the Duct Layout Preferences dialog, see Configuring Duct Part Preferences on page 284.

When you are creating custom parts, you can retrieve the sizes defined for the connector parameters of the default segments and insert them into the custom parts. For example, suppose you have a custom square-neck diffuser with a duct connector that is rectangular and banded. To represent the width and height of the duct connector, the diffuser has 2 size parameters named RW1 and RH1. To quickly insert a list of sizes into these parameters, you can retrieve the sizes in the RW1 and RH1 connector parameters for the segment specified as the default during layout of rectangular, banded duct.
Inserting the sizes of the default segments into your custom parts is particularly useful when the list of sizes that you need is long and closely matches the values for the corresponding default segment. Be aware that the software replaces any existing values with the inserted values. After you insert the values, you can add and remove individual sizes as needed.

**NOTE** You can only use this feature with parametric parts. In addition, you can only use this feature when the connector has a specified domain and connection type. This information is required to identify and retrieve the connector sizes of the appropriate segment in the catalog.

### To insert the connector sizes of a default segment into a part

1. If necessary, open the parametric part in Content Builder.
2. In the part browser, right-click Size Parameters, and click Edit Values.
3. In the Size Parameters dialog, select the current value for the size parameter for which you want to insert the sizes of the default segment.

   **NOTE** The selected parameter must have a data storage type of List or Table. If the parameter is for a pipe connector, it must have a data storage type of Table.

4. In the Size Parameters dialog, click (Default Connector Values) on the toolbar.
   Alternatively, you can right-click a value, and click Default.
5. If you selected the value of a pipe connector, in the Choose a Part dialog, select the pipe fitting whose values you want to insert, and click OK.
   For pipe connectors only, you must select a pipe fitting because pipe fittings, not pipe segments, have connection types.
6. If the data storage type of the parameter in the default segment is not the same as that of your custom part, you must select whether to paste only the values, to paste the data storage type and the values, or to cancel the operation.
   The software inserts the values of the connector parameter in the default segment into the selected connector parameter in the custom part.
Specifying Connector Sizes for Pipe Connectors

To add sizes to the pipe connectors on parts, enter the nominal diameter of the connector. This causes the software to retrieve an appropriate physical diameter based on the connection type.

To retrieve the physical diameter, the software searches the active pipe catalog for connectors with the same connection type and nominal diameter. If the part to which you are adding sizes is a fitting, it then filters the results to include only the connectors in the catalog with the same part subtype, if specified. Then, it retrieves the physical diameter for the nominal diameter for the first connector in the results, and inserts the value into your part.

If necessary, you can modify the physical diameter values retrieved by the software.

Part Preview of a Parametric Part

After you finish modeling the part and adding individual part sizes, you can preview each part size to ensure the integrity of the part before inserting the part sizes in your drawings.

NOTE Part Preview supports only parametric parts created with Content Builder.

You access Part Preview from the Size Parameters dialog. You can select any part size, click on the toolbar, and the Parametric Object Viewer is displayed. As you select different part sizes in the Size Parameters dialog, the Parametric Object Viewer is updated with a new part preview display. You can also rotate the part in the object viewer to see different 3-dimensional (3D) previews of the part size.
To preview a part size defined in a table row, you can click any cell in the row, or press *ARROW+UP* and *ARROW+DOWN* to navigate through different sizes. To preview part sizes defined in a list, you can double-click a default list value, or press *CTRL ARROW+UP* or *CTRL ARROW+DOWN* to display a list of sizes to navigate through.

**Preview Image of a Parametric Part**

You can create a preview image before using Content Builder to create the parametric part, or Content Builder can generate the image once you have finalized the model.

**NOTE** The bitmap size must be 200 x 200 pixels, 256 color.

The preview image is helpful in identifying the part during part selection. When using Content Builder to generate a preview image, a bitmap (BMP) image is created based on a specified view direction. You can select from the 10 standard AutoCAD® orthographic and isometric view directions to view the model (top, bottom, left, right, front, back, SW isometric, SE isometric,
Part Insertion Behaviors of a Parametric Part

You can specify several insertion behaviors for parametric MvParts and fittings. There are some insertion behaviors that you specify using the part model. For an MvPart, you specify the placement (insertion) point to use when the MvPart is added to drawings by users. For a fitting, you specify trim lengths and the placement point to use when the fitting is added to drawings by the software during autolayout. Trim lengths are the length dimensions on a fitting that are used to trim other components to make room for the fitting. For more information, see Trim Lengths and Placement Points on page 991.

There are other insertion behaviors that you must specify in the Options dialog, which you can access by clicking in the Content Builder part browser.

Options dialog for a parametric MvPart

The following table describes the behaviors (properties) that you can set in the dialog.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Sizing Flag</td>
<td>Lets you create custom sizes of the part when a needed part size does not exist in the catalog. Custom sizes can be inserted by Auto Layout or by setting part filter/values in the Add dialog.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Hide Part Flag          | Hides the part in the catalogs from which you select parts to add to drawings.  
  **NOTE** By default this setting is enabled. Hiding the part is recommended when you are creating a temporary part or creating a part across multiple sessions. However, when you save a part after successfully validating it, the software prompts you to specify whether to continue to hide it. |
| Anchor Part             | Available for MvParts only. Enables the MvPart to anchor to another object.                                                                     |
| Break Into Part         | Available for MvParts only. Enables the MvPart to break into another object.                                                                    |
| Layer Key               | Available for MvParts only. Specifies the layer to which the MvPart is added in drawings. For more information about layers, see AutoCAD MEP Layer Standards. When you add a fitting to a drawing, the layer to which the fitting is added is determined by the objects to which it is connected. |
| Display Symbol in Plan View | Available for MvParts only. Specifies whether to display the schematic symbol of the part instead of a model-generated view in 1-line and 2-line display representations in Top (plan) view. |
| AutoLayout Flag         | Available for fittings only. Adds autolayout data to the fitting in the part browser, which enables you to specify trim lengths and a placement point. For more information, see Trim Lengths and Placement Points on page 991 and Defining the Part Insertion Behaviors of a Parametric Fitting on page 1031. |
The software automatically adds autolayout data to MvParts.

**NOTE** If you specify that the MvPart can anchor to another object as well as break into another object, the software prompts you to select which behavior to use when adding the part to a drawing. For an example of both behaviors, see Defining the Part Behavior of a Block-Based MvPart on page 1132.

### Schematic Symbol of a Parametric Part

While parametric parts do not require schematic symbols, generally you create them for use in schematic diagrams. If a part does not have a schematic symbol, the part is not visible in schematic representations of a system. If a part does have a schematic symbol, you have the option of also using it in 1-line and 2-line representations of a system in Top (plan) view. This can be helpful for differentiating systems in a design, for example, supply and return HVAC systems.

**Model and schematic representations of parts**

<table>
<thead>
<tr>
<th>Air terminal</th>
<th>Inline pump</th>
<th>Switchboard transformer</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Air terminal symbol" /></td>
<td><img src="image" alt=" Inline pump symbol" /></td>
<td><img src="image" alt="Switchboard transformer symbol" /></td>
</tr>
</tbody>
</table>

**Symbol and Annotation Plane**

You create schematic symbols for parametric parts on the Symbol and Annotation plane, a horizontal plane to which you attach the symbol geometry, associated constraints and dimensions, and annotation.
In many ways, the Symbol and Annotation plane behaves like the work planes to which you attach the features of the part model. You attach the features of the symbol to the Symbol and Annotation plane, and you can make the plane visible or invisible, isolate its contents, or hide its contents. However, unlike the work planes that you create manually, the software automatically creates the Symbol and Annotation plane when you begin a new part in Content Builder.

As shown in the previous illustration, the default position of the Symbol and Annotation plane on the Z axis in the World Coordinate System (WCS) is high above the WCS origin. This keeps the plane and its contents out of the way while you are working on your part model. If desired, you can change the Z position of the plane. To do so, right-click the plane in the part browser, click Change Plane Position, enter a new value for the Z position, and press ENTER.

**Creating Schematic Symbols for Parametric MvParts**

You can create a schematic symbol for a parametric MvPart at any time. However, only parts that you add to drawings after you have created the symbol can use the symbol. You cannot update previously inserted parts to use the symbol.
There are 2 types of schematic symbols that you can add to parametric MvParts:

■ **Parametric.** This type of symbol scales proportionally with the part. You create parametric symbols using parametric features: parametric geometry, dimensions, and constraints.

■ **Block-based.** This type of symbol scales uniformly instead of proportionally. You create block-based symbols using standard AutoCAD objects, such as lines, arc, and circles. You can create the symbol from scratch, or you can insert an existing AutoCAD MEP symbol or 2D AutoCAD block from a DWG file.

For more information, see [Creating a Schematic Symbol of a Parametric MvPart](#) on page 1098.

**Workflow for Creating a Parametric Fitting with Content Builder**

This workflow provides a road map for creating a parametric fitting using Content Builder.

### Review the steps

- **Open the Parametric Building Environment to start building content.**

  You use the Content Builder in AutoCAD MEP to create a parametric fitting. See [Opening the Parametric Building Environment](#) on page 1009.

- **Specify the part configuration.**

  You work in the parametric building environment to create single parametric parts. In this environment, only one part can exist in a drawing. The individual drawings are associated with a part catalog to build a library of parts. You specify the type and subtype of the part to establish basic part behavior. See [Defining the Part Behavior of a Parametric Fitting](#) on page 1010.

- **Create a 3D model of the part.**

  You create models of 3D parts and use them to dynamically generate 2D views of your parts. You build your part from blocks, or features, that are parametrically combined to define the part. The
Review the steps

View more information

Model is defined in terms of the size, shape, and position of its features. You can restrict how the features of the parts fit together. To better conceptualize the size and shape of the part model, you define constraints and dimensions that determine how your part is built. See Modeling a Parametric Fitting on page 1011.

You add connectors to enable the part to intelligently connect to other building systems objects in your layout. A connector is dependent on the model feature it is attached to; therefore, shape and size are defined when the connector is added to the model. See Adding Connectors to a Parametric Fitting on page 1019.

Adding dimensions and other part size information to the model defines the part sizes that can be dynamically generated from the model. This enables a single 3D model to represent multiple part sizes. See Adding Dimensions to a Parametric Fitting on page 1026.

Once you have finalized the model, you generate a preview image for the part by taking a snapshot of the model. Creating an image lets you preview how the part will appear in a drawing. The preview image also helps to identify the part during part selection. See Generating a Preview Image of a Parametric Fitting on page 1031.

You specify the insertion behavior that you use to place the part in your drawing, including layer assignment, placement point, and trim lengths.
Creating a Parametric Fitting with Content Builder

You can create parametric fittings, such as elbows and tees, with Content Builder. The following sections contain step-by-step procedures to help you create a tee fitting using Content Builder. Each section represents a separate phase in the creation process; therefore, you should carefully step through the sections in the following order to avoid creating unusable parts.

NOTE Parametric fittings are not used in plumbing runs. However, parametric fittings are useful for ducts, pipes, cable trays and conduit.

Opening the Parametric Building Environment

1 Click Manage tab ➤ MEP Content panel ➤ Content Builder.

   The Getting Started - Catalog Screen dialog appears.

2 Under Part Domain, select a part catalog.

   For example, if you want to create a duct fitting, select Duct.

3 In the part catalog browser, select a chapter and click .

4 In the New Part dialog, enter a unique name and description for the part family and click OK.
Name indicates the files that are associated with this new part. Description refers to the part family and is referenced in the software.

**RELATED** For more information about the Content Builder parametric building environment, see Approaches to Creating Parts on page 960.

5 Click View tab ➤ Appearance panel ➤  ➤ Point Style .

6 In the Point Style dialog, choose the desired point style, point size, and other size criteria. Changing the style of points improves their visibility in the drawing area and helps you to differentiate them from grid dots.

**Point Style dialog**

![Point Style dialog](image)

**RELATED** For more information, see Point Style Dialog Box.

---

**Defining the Part Behavior of a Parametric Fitting**

1 In the part browser, expand Part Configuration and specify the part description, type, and subtype.

2 To specify the part type, under Part Configuration on page 975, right-click Undefined, click Edit, and then select Tee.
You specify the part type (such as tee, elbow) from a predefined list in the part browser. The selection is based on the building system domain and current part catalog.

You can also enter a new subtype. Part subtype is a sub-category of part types. You can either specify a part subtype from the predefined list or you can enter a custom part subtype.

NOTE Part domain defines the family of parts, such as pipe, duct, cable tray, conduit, MvPart components. Domain is predefined based on the part catalog you selected in the Getting Started - Catalog Screen dialog. This value is read-only and cannot be changed. For more information, see Part Configuration of a Parametric Part on page 975.

3 To specify the part subtype, right-click Undefined, click Edit, and select Transition Straight.

Modeling a Parametric Fitting

Modeling on page 976 is used to create the parametric content, constraints, and dimensions. To model a parametric part, you follow this sequence:

- Establish work planes on which to create the geometry of your model
- Create profiles and apply modifiers to define the shape and default size of the part.
To avoid distortion in the model, start with the larger features, which have more impact on the overall size of the part and then add the smaller features. For example, for a tee fitting, you first create the trunk of the tee and then add the branch.

**Establishing the Work Planes of a Parametric Fitting**

*Work planes* on page 977 define the orientation in which you are working. They provide access to views, such as Front, Side, Top, etc., that let you create content.

Use this procedure to add work planes to create the geometry, paths, and constraints of a model. To avoid confusion, work with only one work plane visible, unless you are using offset or reference work planes. The following instructions refer to the part browser. The part browser is located under the ribbon to the left of the drawing area.

1. In the part browser, expand Modeling.
2. Right-click Work Planes and click Add Work Plane.
   - The Create Work Plane dialog appears.
3. Click Default, and click OK.
   - The ZX plane, YZ plane, and XY plane are created.
4 To view the work planes in the modeling area, on the floating View panel, click View drop-down ➤ SW Isometric.

5 In the part browser, expand Work Planes.
When you select a work plane in the part browser, the work plane is highlighted in the modeling area.

Selecting the ZX Plane

6 To avoid confusion, work with only one work plane visible at a time. In the part browser, right-click ZX Plane and click Visible. Do the same for XY Plane.
The ZX Plane and XY Plane icons are unavailable (shaded). The YZ plane is the only visible work plane in the modeling area.

**Modeling the Trunk of a Parametric Tee Fitting**

Use this procedure to model the trunk of the tee fitting. You add the circular geometry on page 980, create the profile, and apply an extrusion modifier.

1. To create the trunk of the tee, in the part browser, right-click YZ Plane and click Add Profile ➤ Circular. For more information about profiles, see Profiles on page 985.
2. Select a center point in the modeling area and specify a second point, or enter 12" (305 mm), to define the radius.

A circular profile is created and is added to YZ Plane in the part browser.

3. In the part browser, right-click Modifiers on page 986 and click Add Extrusion.
4. Select the circular profile in the modeling area.
The Extrusion Modifier dialog appears.

5 Under Termination, select MidPlane for Type, enter 20" (508 mm) for Distance, and click OK.

A cylinder is created to represent the trunk of the tee and an extrusion modifier is added to Modifiers in the part browser.

**TIP** You can quickly build a part model using primitives. For information, see Primitives on page 990.

**Modeling the Branch of a Parametric Tee Fitting**

Use this procedure to model the branch of the tee fitting based on the center of the trunk. You add the circular geometry, create the profile, and apply an extrusion modifier.

1 To create the transitional branch of the tee, change the work plane. Right-click YZ Plane and click Visible; then right-click ZX Plane and click Visible.
The YZ plane is turned off. Its icon is unavailable (shaded) in the part browser. The ZX plane is the visible work plane in the modeling area.

2 In the part browser, right-click ZX Plane and click Add Profile ➤ Circular.

The circular profile on page 985 defines the diameter of a fitting, such as an elbow, and the connectors. You can add more geometry lines and circular profiles for more complex graphics.

3 Using object snaps with center mode enabled, select the center of the circular profile of the trunk, and enter 6" (152 mm) for the radius.
A circular profile is created and is added to ZX Plane in the part browser.

4 In the part browser, right-click Modifiers and click Add Extrusion.
5 Select the circular profile for the branch in the modeling area. The Extrusion Modifier dialog is displayed.
6 Under Termination, select Blind for Type, and enter 10° (254 mm) for Distance. Click OK.

A cylinder is created to represent the branch of the transitional tee and a second extrusion modifier is added to Modifiers in the part browser.

7 To flip the branch to the other side of the trunk, expand Modifiers in the part browser, right-click the second (branch) extrusion modifier and click Edit.

The Extrusion Modifier dialog appears.

8 Under Termination, select Flip and click OK.
The branch is flipped to the other side of the trunk.

**TIP** To verify which extrusion modifier is associated with a particular feature, click a modifier in the part browser to have the associated feature highlighted in the modeling area. For complex models, you can right-click the modifier in the part browser, and then click Rename to enter a logical name for easy identification, such as “Extruded Branch Modifier.”

**Adding Connectors to a Parametric Fitting**

Use this procedure to add connectors to the model. The shape of the connector is determined by the shape of the modifier selected. After the connector has been placed, you can assign the connector type.

The Content Builder requires a minimum of 3 connectors to create a usable tee fitting. To ensure the fitting can be added in a drawing with valid connections, the connectors must be added in a specific order. In plan view, add connectors left to right, then bottom to top. The following example shows connectors placed on a tee fitting.
1 To add a connector, in the part browser, right-click Connections and click Add Connection.

The software prompts you to select the connector location. As you move the cursor around in the modeling area, it snaps to 4 possible locations for a connector—to both ends of the trunk and both ends of the branch.

2 To specify the first connection point, select the connector location on the left end of the trunk.
IMPORTANT The position of the first connector placed in the model defines the axis orientation of the part upon insertion. For example, if you place the first connector on a part with a perpendicular vector into the part, the direction of the vector defines the positive x-axis orientation when inserted into a drawing.

3 Press ENTER to accept the default value for the first connector number.

TIP The default connector numbers are in ascending numeric order, according to the order in which the connectors are added to the model. For example, the first connector is 1, the second connector is 2, and so on. You can model connections in any order you choose. However, specific parts require specific connections set in a known order. The order given for this example is valid for all tees and other fittings. See Rules for Connector Behavior on page 974 for more information.

4 Select a location to the left of the model to place the dimension for the profile of the trunk.

A diameter dimension (D1) is added to the model for the circular profile of the trunk. The D1 dimension is also added to Size
Parameters in the part browser, and a connector is added to Connections.
To specify the second connection point, right-click Connections in the part browser, click Add Connection, and select the connector location on the right end of the trunk.

Press **ENTER** to accept the default value for the second connector number.

You do not need to select a location for the dimension because the same profile is used for both ends of the trunk. However, the software does add a diameter dimension (D2) defined with the value of D1 to Model Parameters in the part browser. The software also adds a diameter dimension (D2) to Size Parameters and a second connector to Connections.
7 To specify the third connection point, right-click Connections in the part browser, click Add Connection, and select the connector location on the end of the branch.

8 Press ENTER to accept the default value for the third connector number.

9 Pick a location to the left of the model to place the dimension of the circular profile of the branch in the model.

**TIP** Turn off object snaps if you are having problems selecting a position off the model.
A diameter dimension (D3) is added to the model and to Size Parameters in the part browser, and a third connector is added to Connections.

To define the connection type for each connector, in the part browser, right-click a connector in Connections and click Edit. The Connector Properties dialog displays connector details and values, including domain, type, and shape.

**NOTE** Domain and shape are view-only parameters.

For Type, click the type specified for each connector and then click .

In the Connection Types Selection dialog, select the appropriate connection types.

Connector types are dependent on the related parametric fitting domain. For example, the Piping domain includes a connection type called “Same Connection”. When “Same Connection” is configured for a pipe object that is attached to a Hub, the pipe
connection type will not inherit the connection type on connector 1 of the Hub, as happens with other connection types. Rather, it will inherit the connection type on connector 2 of the attached Hub.

**TIP** You can select connection types regardless of gender (male or female). Pipe connectors are assigned as undefined type by default. An undefined connection type creates a valid connection between all types of connectors when inserted in a drawing. See *Rules for Connector Behavior* on page 974 for more information.

---

### Adding Dimensions to a Parametric Fitting

*Dimensions* on page 981 define the default size of a parametric fitting. You can add other sizes, such as a list of values, to create individual part sizes.

### Adding Model Dimensions to a Parametric Fitting

Use this procedure to add dimensions to specify the overall default size of the model.

**TIP** You may find it easier to add model dimensions in the top view, rather than in a model view direction. To change the view, click *View* tab ➤ *Appearance* panel ➤ *Views* drop-down ➤ *Top*.

1. To define the overall length of the trunk, in the part browser, right-click Model Dimensions, and then click Add Distance.

**NOTE** For constant parameter values, you can define a constant dimension, or choose not to add a dimension and use the default value based on the actual size of the geometry. When no dimensions are added, the parameter and its value are not displayed during part size selection.

2. Select the trunk modifier feature in the modeling area, and specify a location to place the dimension.

A length dimension (LenB1) is placed in the model and is added to Model Parameters and Size Parameters in the part browser. The
value of LenB1 is a default value based on the extrusion distance of the feature, and it can be changed.

3 To define the overall length of the branch, in the part browser, right-click Model Dimensions and click Add Distance.
4 Select the branch modifier feature in the modeling area, and specify a location to place the dimension.
A length dimension (LenB2) is placed in the model and is added to Model Parameters and Size Parameters in the part browser. The
value of LenB2 is a default value based on the extrusion distance of the feature, and it can be changed.

5 To modify the default, or to specify a calculated value for the length of the trunk and branch, in the part browser, expand Model Parameters on page 993, right-click a length dimension, and click Edit.

The Model Parameters dialog is displayed.

Example of Model Parameters dialog

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Equation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1</td>
<td>24.0</td>
<td>24</td>
<td>Connection Diameter 1</td>
</tr>
<tr>
<td>D2</td>
<td>24.0</td>
<td>D3</td>
<td>Connection Diameter 2</td>
</tr>
<tr>
<td>D3</td>
<td>12.0</td>
<td>12</td>
<td>Connection Diameter 3</td>
</tr>
<tr>
<td>LenT1</td>
<td>36.0</td>
<td>(D1+6)+0.05</td>
<td>3D Distance 1</td>
</tr>
<tr>
<td>LenB2</td>
<td>18.0</td>
<td>(0.75*D1)</td>
<td>3D Distance 2</td>
</tr>
</tbody>
</table>
6 Double-click the Equation value for LenB1, and enter the equation for the diameter of the trunk plus one-half the diameter of the trunk \((D1 + (D1 * 0.5))\).

**TIP** Click Calculator to access the Equation Assistant.

7 Double-click the Equation value for LenB2, enter the equation \((0.75 \times D1)\), and click Close.

The model features are updated in the modeling area to reflect the modified dimensions.

---

**Adding Individual Part Sizes to a Parametric Fitting**

You create individual part sizes by adding parameter values. Values can be a list or table of values, a constant value, or a calculation.

You can also create unique part size names. Each part size name is generated using a calculation — a formatted string of parameter values and text.
To add individual part sizes to the parametric fitting

1. To add part sizes to the fitting, in the part browser, right-click Size Parameters on page 996 and click Edit Values. The Size Parameters dialog is displayed. In Values mode, the dialog shows the values of the size parameters and other non-graphical parameters.

2. To add sizes to the branch connection, click the D3 parameter value and click on the toolbar.

3. In the Edit Values dialog, click Add and enter a new size. When you are finished adding sizes, click OK.

**TIP** You can copy and paste values from other part families using standard Microsoft® Excel copy/paste functionality. For connector parameters, you can also insert the corresponding values for the segments used by default during layout.

The parameter value list is updated.

**NOTE** You cannot modify the formulas for calculated parameters defined in the model in the Size Parameters dialog. Use the Model Parameters dialog instead, as described in Adding Dimensions to a Parametric Fitting on page 1026.

4. To specify a unique part size name, select Calculations from the list box. The calculation strings are displayed.

5. Double-click the value cell of PrtSN. The Calculation Assistant dialog appears.

6. Define the part size name with a calculated value:

   - Highlight the value of PrtSN: Part Size Name and press DELETE.
   - Select 0 for Precision.
   - Under Insert Variable, select D1 and click Insert.
   - Click the value of PrtSN:Part Size Name and enter inch Dia.
   - Under Insert Variable, select PSTyp and click Insert.
   - Select PTyp and click Insert.
7 Click Evaluate. The calculation result is displayed. Click OK. In the Size Parameters dialog, the calculation value of PrtSN is updated with the valid string and, when selected, the result is displayed in the status bar.

**IMPORTANT** The part size name is generated using VB (Visual Basic) Script's FormatNumber function and simple string substitutions. The correct syntax is crucial. Therefore, use the Calculator to ensure that the string is valid.

### Generating a Preview Image of a Parametric Fitting

Once you have finalized the part model, you generate a preview image on page 1001 (BMP file) of the parametric fitting. The preview image is helpful for identifying the part when users are selecting and adding parts to a drawing. Content Builder generates the preview image based on a specified view direction. You can select from the 10 standard AutoCAD® view directions to view the model (top, bottom, left, right, front, back, SW isometric, SE isometric, NE isometric, and NW isometric).

1 To create a preview image, on the toolbar, click . The Bitmap Preview dialog is displayed.

2 Under Generate View, click a view direction for the preview image of the part.

**TIP** As you select a view, the preview image window in the dialog is updated. This enables you to view all the available preview images for the part before selection.

You can also click Browse to navigate to and select a bitmap image. Predefined images must be 200 x 200 pixels saved with 256 colors.

### Defining the Part Insertion Behaviors of a Parametric Fitting

Once you have finalized the model and generated a preview image, you define the insertion behaviors on page 1003. These include the trim lengths and placement point on page 991 used by the software during autolayout. Trim lengths define the distance that a connecting segment is trimmed in order for the fitting to be placed in the run.
NOTE It is helpful to clean up the appearance of the model before defining trim lengths and the placement point. To turn off all work planes and the associated geometry, profiles, and dimensions on those work planes, in the part browser, right-click each feature and click Visible.

1 In the part browser, click 

The Options dialog is displayed.

2 Select or clear Custom Sizing Flag and Hide Part Flag, as appropriate.

For descriptions of these settings, see Part Insertion Behaviors of a Parametric Part on page 1003.

3 Select Auto Layout Flag to turn on auto layout, and click OK.

In the part browser, Autolayout Data is added to the Modeling folder, and trim length points are displayed on the model in the modeling area.

4 Change the model view to plan view by clicking View tab ➤ Coordinates panel ➤ World .
5 In the part browser, expand Autolayout Data, right-click Layout Data and click Add Trim Length.

**NOTE** To ensure components are trimmed correctly when placing a parametric part into a drawing, you must define trim lengths for the part in a specific order—left to right, then bottom to top.

You are prompted to select the start and end of the trim length. Repeat this for the 3 trim lengths required for auto layout of the tee fitting.

- Define the first trim length.
  For the start of trim length 1, select the point at the center of the trunk. For the end of trim length 1, select the point at the left end of the trunk.
Define the second trim length.
For the start of trim length 2, select the point at the center of
the trunk. For the end of trim length 2, select the point at the
right end of the trunk.

Define the third trim length.
For the start of trim length 3, select the point at the top of the
branch (the center of the trunk). For the end of trim length 3,
select the point at the bottom of the branch.

Trim length lines are displayed between the selected points.

6 In the part browser, right-click Layout Data, and click Select
   Placement Point.
   You are prompted to select a point on your model. This point is
   the location at which connecting segments would intersect if they
   were extended along their logical paths. The placement point is
   used as the insertion point for the fitting when it is added to a
   drawing during autolayout using the Add commands.

7 Select the trim length point at the center of the trunk.
A placement point is displayed at the selected location.

**Validating, Saving, and Previewing a Parametric Fitting**

1. On the Content Builder toolbar, click ![Validate](checkmark) (Validate).
   
   Upon successful completion of these procedures, the part is validated and the status bar at the bottom of the part browser is updated with the traffic light displayed green.

   ![Part family validation successful](green)
   
   If you have errors in your model, the traffic light is red, and a dialog is displayed listing the errors. Review the errors, make necessary modifications, and repeat this step until validation is successful.

   ![Part family validation failed](red)

Building Parametric Fittings Using Content Builder | 1035
Once validation is successful, you can save the parametric fitting.

**To save a parametric fitting**

1. In the part browser, click ![Save](image).
2. Specify whether to make the part available in the catalog:
   - Click Yes to make the part available to users.
   - Click No to keep the part hidden.

   **NOTE** This prompt toggles the Hide Part option in the Options dialog in Content Builder.

   The part is saved in the specified catalog location.

**To preview a parametric fitting**

4. To preview each part size, in the part browser, right-click Size Parameters and click Edit Values.
   The Size Parameters dialog is displayed.

5. Click 1 in the table to select the default part size and click ![Enter](image).
   The Parametric Object Viewer is displayed.

6. Use the view options to preview the parametric tee.
   For more information about working with the Object Viewer, see Object Viewer in the AutoCAD Architecture Help.

7. To preview another part size, click in the Size Parameters dialog, select a different value for D3 from the list of available sizes, and click ![Enter](image) again.
   The part in the Parametric Object Viewer is updated.

   **NOTE** You can work with both the Size Parameters dialog and the Parametric Object Viewer together to preview each part size and make changes as necessary.

8. When you finish previewing part sizes, click Close in the Parametric Object Viewer, and click OK.
9 Click to save any changes made.

10 Click to close the part browser.

Building Parametric Parts Using the Wizard

A part template is a fully configured and fully dimensioned parametric part that has a basic model but does not have any part sizes. The imperial and metric catalogs in AutoCAD MEP include part templates for several, commonly used MEP parts (for example, air terminals and pumps) and fittings. Using the Parametric Part Wizard, you can quickly create a new parametric part with custom sizes based on a part template.

Creating parametric parts using the part wizard is recommended when you require only a basic model to represent the part. The wizard is particularly useful for creating parts with one or a few sizes in real time as you design a building system.

If your custom part requires a more complex model than a part template provides, or if it must be block-based instead of parametric, create the part using the Content Builder instead. You can also use the Catalog Editor to copy parts and add custom part sizes to the copies.

To create a parametric part using the Parametric Part Wizard

1 Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Parametric Part Wizard.
2 Parametric Part Wizard

3 For Part Domain, select the domain of the catalog that contains the part template you want to use. You specify a catalog for a domain in the Options dialog. For more information, see Specifying Part Catalogs and Style-Based Content Locations on page 100.

4 For Part Type, select the part type of the template whose shape resembles the part you want to create.

5 For Part Template, select the name of the part template whose shape resembles the part you want to create.
NOTE The lists of choices for Part Domain, for Part Type, and for Part Template are filtered to include only those for which there are defined part templates.

6 For Name, enter a name for the new part.

The part name is used to name the XML file that defines the part. It is also displayed when the part is opened in Content Builder or Catalog Editor.

7 For Description, enter a description for the new part.

Users select parts by description in add dialogs and modify dialogs. The description is also used to create the names of the part sizes.

8 Under Parameters, enter values for the size parameters shown in the part image.

The values are used to create the list of part sizes. To enter a value in a cell, double-click the cell, and then enter the value. To access the Copy, Paste, and Clear commands, right-click the cell.

NOTE In the part wizard, you enter the values for the size parameters differently depending on how they are stored in the software:

- In a table of values where all of the size parameters (columns) must have the same number of values, and a row across the columns defines a single part size

- In lists of values where the values in the lists are used in all possible combinations to define multiple part sizes

As an example of the latter, the following image shows the values for a custom round-neck diffuser. The values result in 2 part sizes, each with different values for the diameter of the neck.

Example of Parameters showing values for custom round-neck diffuser

<table>
<thead>
<tr>
<th>List</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1</td>
</tr>
<tr>
<td>L</td>
</tr>
<tr>
<td>W</td>
</tr>
<tr>
<td>H</td>
</tr>
<tr>
<td>5'</td>
</tr>
<tr>
<td>6'</td>
</tr>
<tr>
<td>8'</td>
</tr>
</tbody>
</table>

Use the prompts provided by the software to guide you in entering the data. For more information about the different types of data storage for size parameters, see Part Sizes on page 119.
Click OK to create the part in the specified part sizes. The software adds the part to the current catalog, more specifically, to the chapter that corresponds to the part type that you selected. The Add Multi-view Parts dialog is displayed to add the new part to your drawing, if desired.

If necessary, you can also modify the part’s data and add custom data using the Catalog Editor or Content Builder. For example, you can modify the formula used to create the names of part sizes.

NOTE Depending on the parts and part sizes available in your catalogs, you might also need to create additional parts and sizes to use with your new custom part.

Building Parametric MvParts with Content Builder

You can create parametric MvParts, such as air terminals and fans, using Content Builder. The next sections provide a workflow, followed by step-by-step procedures to help you create an air terminal, a junction box, and a tank using Content Builder. Each section represents a separate phase in the creation process. Therefore, you should carefully step through the sections in the following order to avoid creating unusable parts.

Workflow for Creating a Parametric MvPart with Content Builder

This workflow provides a road map for creating a parametric MvPart using Content Builder. Where applicable, topics focus on building specific MvParts, such as an air terminal, a junction box, and a vertical tank.

Review the steps

1. Open the Parametric Building Environment to start building content.
   - You use the Content Builder in AutoCAD MEP to create a parametric MvPart. See Starting Content Builder for Creating a Parametric MvPart on page 1042.
2. Specify the part configuration.
   - You work in the parametric building environment to create a single parametric MvPart. See Specifying the Part Configuration of a Parametric MvPart on page 1043.
You create models of 3D MvParts and use them to dynamically generate 2D views of your parts. You build your part from blocks, or features, that are parametrically combined to define the MvPart. The model is defined in terms of work planes, profiles, and modifiers that define the shape and size of the MvPart. See "Modeling a Parametric MvPart" on page 1045.

You add connectors to enable the MvPart to intelligently connect to other building systems objects in your layout. A connector is dependent on the model feature it is attached to. Therefore, shape and size are defined when the connector is added to the model. See "Adding Connectors to a Parametric MvPart" on page 1074.

Adding dimensions and other part size information to the model defines the part sizes that can be dynamically generated from the model. This enables a single 3D model to represent multiple part sizes. See "Adding Dimensions to a Parametric MvPart" on page 1081.

Once you have finalized the model, you generate a preview image for the MvPart by taking a snapshot of the model. Creating an image lets you preview how the part will appear in a drawing. The preview image also helps to identify the part during part selection. See "Generating a Preview Image of a Parametric MvPart" on page 1093.
Starting Content Builder for Creating a Parametric MvPart

Use this procedure to start Content Builder and open the parametric building environment.

1. Click Manage tab ➤ MEP Content panel ➤ Content Builder.
   
   The Getting Started - Catalog Screen dialog is displayed.

2. Select Multi-view Part for Part Domain.

3. In the part catalog browser, select a chapter and click.
   
   The New Part dialog is displayed.

4. Enter a name and description for the part family and click OK.
   By default, the description is the same as the name until you change it.
   
   The parametric building environment is opened. For more information, see Approaches to Creating Parts on page 960.
Specifying the Part Configuration of a Parametric MvPart

Each parametric part must have a defined part configuration in order for the part to be saved in a catalog and usable in your drawings. To specify the part configuration of a parametric MvPart, you define the part description, select a domain and type, and select or define a subtype. The part configuration defines the part’s behavior when you add the part to a drawing. The domain determines the part types you can select.

Specifying the Part Configuration of a Parametric Air Terminal MvPart

Use this procedure to specify the part configuration to define part behavior of a parametric air terminal MvPart.

1 In the part browser, expand Part Configuration and specify the part description, type, and subtype.

**NOTE** The part domain is defined in the Getting Started - Catalog Screen dialog, is read-only, and cannot be changed.

2 To specify the part type, right-click Undefined, and click Edit.
3 Select Air Terminal for the part type.
   The predefined types are dependent on the selected part domain.
To specify the part subtype, right-click Undefined, and click Edit. Select Diffuser for the part subtype. The list of predefined subtypes is dependent on the selected type. You can also enter a new subtype.

**Specifying the Part Configuration of a Parametric Junction Box MvPart**

Use this procedure to specify the part configuration to define part behavior of a parametric junction box MvPart.

1. In the part browser, expand Part Configuration and specify the part description, type, and subtype.

**NOTE** The part domain is defined in the Getting Started - Catalog Screen dialog, is read-only, and cannot be changed.
2 To specify the part type, right-click Undefined and click Edit.
3 Select Junction Box for the part type.
   The predefined types are dependent on the selected part domain.
4 To specify the part subtype, right-click Undefined and click Edit.
5 Select Square Outlet Box for the part subtype.
   The list of predefined subtypes is dependent on the selected type.
   You can also enter a new subtype.

**Specifying the Part Configuration of a Parametric Vertical Tank MvPart**

Use this procedure to specify the part configuration to define part behavior of a parametric vertical tank MvPart.

1 In the part browser, expand Part Configuration and specify the part description, type, and subtype.

<table>
<thead>
<tr>
<th>NOTE</th>
<th>The part domain is defined in the Getting Started - Catalog Screen dialog, is read-only, and cannot be changed.</th>
</tr>
</thead>
</table>

2 To specify the part type, right-click Undefined, and click Edit.
3 Select Tank for the part type.
   The predefined types are dependent on the selected part domain.
4 To specify the part subtype, right-click Undefined and click Edit.
5 Select Vertical Storage Tank for the part subtype.
   The list of predefined subtypes is dependent on the selected type.
   You can also enter a new subtype.

**Modeling a Parametric MvPart**

To model a parametric part, you must first define work planes on which to add the geometry of the model. You then create profiles and apply modifiers to define the shape and default size of the part. To avoid distortion in the model, start with the larger features, which have more impact on the overall size of the part, and then add the smaller features.
Establishing the Work Planes of a Parametric MvPart

Use this procedure to add work planes on which to create the geometry of the model. To avoid confusion, work with only one work plane visible, unless you are using offset or reference work planes. You can create additional work planes as you need them to build the model. It is helpful to use offset work planes to locate multiple sides of a part, such as both faces of an air terminal. It is helpful to use reference work planes to locate geometry on your parts, such as knockouts for a junction box or taps on a tank.

1. In the part browser, expand Modeling.
2. Right-click Work Planes and click Add Work Plane.
   The Create Work Plane dialog is displayed.
3. Click Default and then click OK.
   The ZX plane, YZ plane, and XY plane work planes are created.
4. To view the work planes in the modeling area, on the floating View panel, click View drop-down ➤ SW Isometric.
5. In the part browser, expand Work Planes.
When you select a work plane in the part browser, the work plane is highlighted in the modeling area.
Selecting the ZX plane

6 To avoid confusion, work with only one work plane visible at a time. In the part browser, right-click ZX Plane and click Visible. Do the same for YZ Plane.

The ZX Plane and YZ Plane icons are unavailable (shaded) and the XY plane is the only visible work plane in the modeling area.

Modeling with Primitives

Primitives are limited versions of part models that are designed for repeated use in part creation. They represent basic shapes, such as a box or a torus, and commonly used connections on parts, such as a flanged pipe connector or duct connector.

Because primitives include many of the modeling features that you need to build a custom parametric part, such as profiles and modifiers, you can use them to quickly build a part model and add connections.
Building a Part Model from Primitives

1. Begin a new parametric part, specify its part configuration, and add the default work planes (ZX plane, YZ plane, and XY plane).

   **RELATED** For more information, see Starting Content Builder for Creating a Parametric MvPart, Specifying the Part Configuration of a Parametric MvPart, and Establishing the Work Planes of a Parametric MvPart.

2. In the part browser, click \( \text{Insert} \).

   **Insert Primitive dialog**

   ![Insert Primitive dialog](image.png)

3. In the Insert Primitive dialog, select the primitive to add to your part model, and click Insert.

4. Select the work plane on your part to which to attach the primitive:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>attach the primitive to an existing work plane</td>
<td>in the modeling area, select the work plane.</td>
</tr>
</tbody>
</table>
If you want to… then…

attach the primitive to the face of an existing primitive or modifier    press ENTER, and, in the modeling area, select the face of the primitive or modifier.

NOTE This creates a reference work plane on the selected face and attaches the primitive to the new plane.

To facilitate the selection of a plane or face, the software highlights the plane or face when you move the cursor over it.

5 Select the work plane on the primitive that you want to align with the work plane selected in the previous step.

Most of the primitives included with the software include multiple work planes. To select the current plane, do nothing. To cycle through the planes on the primitive and make another plane current, enter n (next), and press ENTER. As you cycle through the planes, notice how the software repositions the primitive in the modeling area so the current plane on the primitive aligns with the selected plane on your part.

NOTE This step aligns the centers of the selected planes so they match. As a result, the placement of the primitive on the plane on your part depends on the location of the primitive on its own plane. The primitives included in the software were created in the center of a horizontal plane.

6 If desired, change the orientation of the primitive:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>flip the primitive so it is positioned on the other side of the plane to which it is being added</td>
<td>enter f (flip plane), and press ENTER.</td>
</tr>
<tr>
<td>rotate the primitive around the center of the plane to which it is being added</td>
<td>enter r (rotate). Move the cursor and click to specify the angle change. Alternatively, you can enter the angle change on the command line and press ENTER.</td>
</tr>
</tbody>
</table>
If you want to... then...

insert a mirror copy of the primitive instead enter m (mirror), and press ENTER.

7 When you have positioned and oriented the primitive as desired, press ENTER.

The software copies all of the modeling features in the primitive into your custom part. If the units in the drawing that defines the primitive do not match the units in your part drawing, the software also converts the units appropriately. You can now work with the part model as if you had created all of the features manually.

In the model parameters of your part, the descriptions of the parameters that were derived from a primitive include the name of the primitive. This makes it easier for you to differentiate parameters when you have added multiple primitives, or a mixture of primitives and manually added features, to the part model.

Model Parameters dialog

NOTE For a step-by-step example of adding primitives to a part model, see Example: Building a Part Model from Primitives on page 1051.

Example: Building a Part Model from Primitives

The following procedure describes how to create a round-neck rectangular diffuser using primitives on page 990. Assume you have created the part, specified its part configuration, and created the default work planes.
1 On the floating View panel, click View drop-down ➤ SW Isometric.

To add the base of the diffuser using a primitive

2 In the part browser, click (Add Primitive).
3 In the Insert Primitive dialog, select Pyramid, and click Insert.
4 In the modeling area, select the XY plane.
   This attaches the pyramid to the XY plane.
5 On the command line, enter n (next), and press ENTER to add the
   primitive to the diffuser.
   The Pyramid primitive has 2 work planes: 1 at the top of the
   pyramid and 1 at the bottom. This aligns the plane at the top of
   the pyramid with the XY plane on the diffuser.

To add the neck of the diffuser using a primitive

6 In the part browser, click (Add Primitive).
7 In the Insert Primitive dialog, select Cylinder, and click Insert.
8 In the modeling area, select the XY plane.
This attaches the cylinder to the XY plane.

9 On the command line, enter f (flip plane), and press ENTER.
This flips the cylinder to the other side of the XY plane.

10 Press ENTER to add the primitive to the diffuser.
11 Modify the values of the model dimensions so they reflect a more appropriate default size.
- Expand Model Parameters, right-click a parameter, and click Edit.
- Change the values as desired.
- Click Close.

12 On the XY plane, add a coincident constraint between the top point of the pyramid and the center point of the cylinder face. Although the 2 points currently overlap, this ensures the pyramid geometry and cylinder geometry remain aligned when the part model is changed.

**TIP** To cycle through overlapping objects, move the cursor over the object on top, then press and hold SHIFT while pressing SPACEBAR repeatedly. To cycle through overlapping subobjects (faces, edges, and vertices) on 3D solids, move the cursor over the subobject on top, then press and hold CTRL while pressing SPACEBAR repeatedly.

**To add the duct connector using a primitive**

13 In the part browser, click (Add Primitive).
14 In the Insert Primitive dialog, select Undefined Duct Connector - Round, and click Insert.
15 On the command line, select the XY plane of the cylinder. This attaches the duct connector to the XY plane.
16 Press ENTER to accept the default orientation and add the primitive to the diffuser.

17 Modify the values of the model dimensions:
   - Expand Model Parameters, right-click a parameter, and click Edit.
   - For BdyD1, change the value of Equation to D1. This causes the diameter of the cylinder to change when the diameter of the duct connector (D1) changes.
   - Change the value of Equation for the duct connector parameters so they reflect a more appropriate default size, as shown in the following image.
   - Click Close.

18 Configure the duct connector.
   Specify a connection type, and, if necessary, change the flow direction. For more information, see Connectors of a Parametric Part on page 994 and Adding Connectors to a Parametric MvPart on page 1074.
Specify connection type on Connector Properties dialog

For more information, see Parametric Part Creation Overview on page 975.

Creating Primitives

You can create primitives in several ways:

- Create a primitive from scratch
- Copy and then modify an existing primitive
- Save a part as a primitive

If you add a primitive to a custom part, you must use one of the planes on the primitive to orient the primitive on the part. For this reason, to be valid, a primitive requires at least one work plane that contains parametric geometry.

Creating Primitives from Scratch

1 Click Manage tab ➤ MEP Content panel ➤ Content Builder ➤ .

The Getting Started - Catalog Screen dialog is displayed.
2 In the Getting Started - Catalog Screen dialog, for Part Domain, select Primitives and Re-usable Parts.

3 Select the chapter to which to add the primitive, and click (New Parametric Part).
4 In the New Primitive dialog, enter a name for the primitive, and click OK.

The Content Builder environment is displayed. Because primitives do not have many of the modeling features that parts have, such as part configuration information or size parameters, only a subset of modeling features are available to you.
5 Create the primitive as desired.

**TIP** In the descriptions of the model parameters, enter descriptive text and include a reference to the primitive name. This makes it easier for you to differentiate parameters when you have added multiple primitives, or a mixture of primitives and manually added features, to a part.

6 Generate a preview image (BMP file) of the primitive.

Preview images are helpful when you are selecting primitives to add to custom parts. You can generate the preview image for a primitive, which enables you to select the view direction for the image. If you do not generate an image, the software generates an image using the SW isometric view direction when you save the primitive.

Generating a preview image is the same for a primitive as it is for an MvPart. For more information, see *Generating a Preview Image of a Parametric MvPart* on page 1093.

7 Click to validate the part.

**NOTE** To be valid, a primitive requires at least one work plane that contains parametric geometry.

8 Click .

**Copying and Customizing Primitives**

1 Click Manage tab ➤ MEP Content panel ➤ Content Builder .
2 In the Getting Started - Catalog Screen dialog, for Part Catalog, select Primitives and Re-usable Parts.

Getting Started - Catalog Screen dialog for primitives

3 Select the primitive to modify, and click .

4 Modify the primitive as desired, and click .

5 In the Save Part Family As dialog, select the chapter (folder) in which to save the primitive, enter a new name for the primitive, and click OK.

You can also copy primitives by copying the DWG files and renaming the copies. By default, the DWG and BMP files for primitives are located in the following folder: \ProgramData\Autodesk\MEP 2011\enu\Shared\Primitives.
Saving Parts as Primitives

1 Open the part in Content Builder, and click 🔄.
2 In the Save Part Family As Primitive dialog, select the chapter (folder) in which to save the primitive, enter a name for the primitive, and click OK.
   The software creates the primitive using the part information that is applicable to primitives.

Modeling a Parametric Air Terminal MvPart

Use this procedure to model a parametric air terminal MvPart. You add the rectangular geometry for the top and bottom faces, create the profiles, add constraints to align the faces, and apply the modifiers to create the transition between faces.

To create the face geometry

1 To create the top face of the diffuser, in the part browser, right-click XY Plane and click Add Profile ➤ Rectangular.
   For more information about profiles, see Profiles on page 985.
2 Specify the first corner in the modeling area and then the second corner.

A rectangular profile for the top face is created and is added to the XY plane in the part browser. Constraints for the rectangular profile are also added to the XY plane.

3 To add an offset work plane to help locate the bottom face of the diffuser, in the part browser, right-click Work Planes and click Add Work Plane.
The Create Work Plane dialog is displayed.

4 Click Offset and enter Bottom Face for Name. Click OK.

5 In the modeling area, select the XY plane as the reference work plane, drag the cursor below the XY plane, and enter 12” (305 mm) for the offset distance.

The bottom face work plane is created.

6 To create the bottom face of the diffuser, in the part browser, right-click Bottom Face and click Add Profile ➤ Rectangular.

7 Specify the first corner in the modeling area and then the second corner.

A rectangular profile is created for the bottom face and is added to Bottom Face in the part browser. Constraints for the rectangular profile are also added to Bottom Face.
To add constraints to align the faces

1. In the part browser, right-click XY Plane and click Add Geometry ➤ Point.
2. In the modeling area, specify a point near the center of the top face rectangular profile and press ENTER.
3. In the part browser, right-click XY Plane and click Add Constraints ➤ Equal Distance.
4. In the modeling area, specify the pairs of geometric constraints.
   For the first pair, select the point in the center of the top face, and then the lower-left edge of the top face rectangular profile.
   For the second pair, select the point in the center of the top face, and then the upper-right edge of the top face rectangular profile.
   The model of the top face is updated to the specified constraint.

5. Repeat steps 3 and 4 to constrain the upper-left and lower-right edges of the top face.
The model of the top face is updated to the specified constraint.

**NOTE** When adding constraints, you may be prompted that the geometry is unconstrained by a specific number of dimensions. These prompts are for informational purposes only to assist you during the modeling process. It is recommended that you add a minimum number of constraints to define the shape of the part to avoid undesirable results.

6 To ensure the alignment of the top and bottom faces, in the part browser, right-click Bottom Face and click Add Geometry ➤ Point Reference.

7 Select the existing point in the center of the top face rectangular profile.
A reference point is added to the bottom face work plane.
8 Repeat steps 3 through 5 to constrain all 4 edges of the bottom face using the reference point in the center of the bottom face. The model of the bottom face is updated to the specified constraints.

To apply the modifiers

1 In the part browser, right-click Modifiers and click Add Transition. For more information about modifiers, see Modifiers on page 986.

2 In the modeling area, select the top face rectangular profile for the start profile; then select the bottom face rectangular profile for the end profile. A transitional box is created to represent the diffuser, and a transition modifier is added to Modifiers in the part browser.

3 To add the lip of the diffuser, in the part browser, right-click Work Planes and click Add Work Plane.
The Create Work Plane dialog is displayed.

4 Click Offset and enter Lip Offset for Name. Click OK.

5 In the modeling area, select the XY plane as the reference work plane, drag the cursor above the XY plane, and enter 1" (25 mm) for the offset distance.

The Lip Offset work plane is created.

6 In the part browser, expand Modifiers, right-click Transition Modifier, and click Visible.

The transition modifier display is turned off in the modeling area.

7 In the part browser, right-click Modifiers, click Add Extrusion, and select the top face rectangular profile.

The Extrusion Modifier dialog is displayed.
8 Under Termination, select Plane for Type, and select Lip Offset for To. Click OK.

A box is created to represent the top lip of the diffuser, and an extrusion modifier is added to Modifiers in the part browser.

9 To see the entire model of the part, in the part browser, right-click Transition Modifier and click Visible.

**Modeling a Parametric Junction Box MvPart**

Use this procedure to model a parametric junction box MvPart. You add the rectangular geometry, create the profiles, apply the modifiers to create the box itself, and add geometry for the knockouts.
1 In the part browser, right-click XY Plane and click Add Profile ➤ Rectangular.
   For more information about profiles, see Profiles on page 985.

2 In the modeling area, specify the first corner and then the second corner.

A rectangular profile for the top face is created and is added to XY Plane in the part browser. Constraints for the rectangular profile are added to XY Plane.

3 In the part browser, right-click Modifiers and click Add Extrusion.
   For more information about modifiers, see Modifiers on page 986.

4 In the modeling area, select the rectangular profile.
   The Extrusion Modifier dialog is displayed.

5 Under Termination, select Blind for Type, enter 15” (381 mm) for Distance, and click Flip. Click OK.
A box is created to represent the junction box and an extrusion modifier is added to Modifiers in the part browser.

6 To add the knockout, in the part browser, right-click XY Plane and click Add Geometry ➤ Point.

7 In the modeling area, specify a point near the center of the top of the junction box, and press ENTER.

8 To constrain the point to the exact center of the top of the junction box, in the part browser, right-click XY Plane and click Add Constraints ➤ Equal Distance.

9 In the modeling area, specify the pairs of geometric constraints.
   For the first pair, select the point in the top center of the junction box, and then the lower-left edge of the rectangular profile.
   For the second pair, select the point in the top center of the junction box, and then the upper-right edge of the rectangular profile.

   NOTE When adding constraints, you may be prompted that the geometry is unconstrained by a specific number of dimensions. These prompts are for informational purposes only to assist you during the modeling process. It is recommended that you add a minimum number of constraints to define the shape of the part to avoid undesirable results.

10 Repeat steps 8 and 9 to constrain the center point to the upper-left and lower-right edges of the top face.
   The model of the junction box is updated to the specified constraints.
11 In the part browser, right-click XY Plane and click Add Profile ➤ Circular.

**TIP** You may find it easier to add the knockout in the top view, rather than in a model view direction. To change the view, click View tab ➤ Appearance panel ➤ Views drop-down ➤ Top.

12 In the modeling area, using object snaps, select the point in the top center of the junction box as the center of the circle, enter .5" (13 mm) for the radius, and press ENTER.

A circular profile is created and is added to XY Plane in the part browser.

13 To constrain the circular profile to the center of the top face, in the part browser, right-click XY Plane and click Add Constraints ➤ Concentric.

14 In the modeling area, select the circular profile for the first geometry and the center point of the top face for the second geometry.

15 In the part browser, right-click Modifiers and click Add Extrusion.

16 In the modeling area, select the circular profile.

The Extrusion Modifier dialog is displayed.
17 Under Termination, select Blind for Type, enter 2" (51 mm) for Distance, and select Flip. Click OK.

![Diagram of cylindrical knockout](image)

A cylinder is created to represent the knockout and an extrusion modifier is added to Modifiers in the part browser.

**NOTE** To create additional knockouts, create reference and offset work planes to locate the plane to which to add a knockout, and then repeat steps 6 through 14 to create each knockout.

---

**Modeling a Parametric Vertical Tank MvPart**

Use this procedure to model a parametric vertical tank MvPart; add the circular geometry for the body of the tank, create the profile, and apply an extrusion modifier. Once the body is modeled, you can create taps, such as inlet and outlet taps, based on the body geometry.

**To model the body of the tank**

1. To create the body of the tank, in the part browser, right-click XY Plane and click Add Profile ➤ Circular.
   - For more information about profiles, see Profiles on page 985.

2. In the modeling area, specify a center point, enter 15" (381 mm) for the radius, and press ENTER.


**TIP** You can also enter an exact position such as 15,15 to specify the center point at the center of the workplane.

A circular profile is created and is added to XY Plane in the part browser.

3. In the part browser, right-click Modifiers and click Add Extrusion. For more information about modifiers, see Modifiers on page 986.

4. In the modeling area, select the circular profile. The Extrusion Modifier dialog is displayed.
Under Termination, select Blind for Type, enter 60° (1524 mm) for Distance, and select Flip. Click OK.

A cylinder is created to represent the body of the tank and an extrusion modifier is added to Modifiers in the part browser.

To model a tap

1. To create an offset work plane to help locate the tap, in the part browser, right-click Work Planes and click Add Work Plane. The Create Work Plane dialog is displayed.
2. Click Offset and enter Tap Offset for Name. Click OK.
3. Select the XY plane in the modeling area as the reference work plane, and enter 2" (51 mm) for the offset distance.
The tap offset work plane is created.

4 To create the tap, in the part browser, right-click Tap Offset and click Add Profile ➤ Circular.

**TIP** You may find it easier to add the tap in the top view, rather than in a model view direction. To change the view, click View tab ➤ Appearance panel ➤ Views drop-down ➤ Top.

5 In the modeling area, specify a center point on the top of the tank, enter 1" (25 mm) for the radius, and press ENTER.

A circular profile is created and is added to Tap Offset in the part browser.

6 In the part browser, right-click Modifiers and click Add Extrusion.

7 In the modeling area, select the circular profile for the tap. The Extrusion Modifier dialog is displayed.
8. Under Termination, select Plane for Type and XY Plane for To. Click OK.

A cylinder is created to represent the tap, and an extrusion modifier is added to Modifiers in the part browser.

**NOTE** To create additional taps, create reference and offset work planes to locate the plane to which to add a tap; then repeat steps 4 through 8 to create each tap.

---

**Adding Connectors to a Parametric MvPart**

Connectors are used to create intelligent networks. You can add connectors to the parts you create using Content Builder. The shape of the connector is determined by the shape of the modifier to which it is attached. You define a default size of the connector when you add the connector to the model. After the connector has been placed, you can assign the connector domain and type.

**Adding Connectors to a Parametric Air Terminal MvPart**

Use this procedure to add connectors to a parametric air terminal MvPart. Typically, air terminals have a single connector on the top face of the diffuser to provide a connection point for the flex duct.

1. To create the connector geometry for flex duct, in the part browser, right-click Lip Offset and click Add Profile ➤ Circular.
2 In the modeling area, using object snaps, select the center point of the top face of the diffuser, enter 3” (76 mm) for Radius, and press ENTER.

A circular profile for the flex duct connector is created and is added to Lip Offset in the part browser.

**IMPORTANT** The position of the first connector placed in the model defines the axis orientation of the part upon insertion. For example, if you place the first connector on a part with a perpendicular vector into the part, the direction of the vector defines the positive x-axis orientation when inserted in a drawing.

3 In the part browser, right-click Modifiers, click Add Extrusion, and select the circular profile.
The Extrusion Modifier dialog is displayed.
4 Under Termination, select Blind for Type and enter 4” (102 mm) for distance. Click OK.

A cylinder is created to represent the flex duct connector, and a second extrusion modifier is added to Modifiers in the part browser.

5 To add a connector, in the part browser, right-click Connections and click Add Connection.

You are prompted to select the connector location. As you move the cursor around in the modeling area, it snaps to 4 possible locations for a connector—the top and bottom faces of the diffuser, and the top and bottom of the flex duct connector.

6 Select the center point of the top of the flex duct connector and press ENTER to accept the default value for the connector number.

**NOTE** The default connector numbers are in ascending numeric order, according to the order in which the connectors are added to the model. For example, the first connector is 1, the second connector is 2, and so on. You can model connections for MvParts in any order.

7 Pick a location above and to the right of the model to place the dimension for the diameter of the flex duct connector.
A diameter dimension (D1) is added to the model for the diameter of the flex duct connector and to Model Parameters in the part browser, and a connector is added to Connections.

8 To define the domain and type of connection for the connector, in the part browser, expand Connections, right-click Connector 1, and click Edit.

The Connector Properties dialog is displayed.

9 Select Domain from the list.

Connector domains are dependent on the specified shape of the modifier to which the connector is attached.

10 Select Banded for Type from the list.

Connector types are dependent on the connector domain.

Connection Types Selection dialog
Connectors are assigned an undefined type by default. An undefined connection type creates a valid connection between all types of connectors when inserted in a drawing.

Click OK.

**Adding Connectors to a Parametric Junction Box MvPart**

Use this procedure to add connectors to a parametric junction box MvPart. Typically, junction boxes have multiple knockouts to accommodate the required wiring. This procedure provides steps for adding a single knockout to the top of a junction box. You can repeat this procedure, making the necessary location adjustments to add other connectors.

1. To add a connector, in the part browser, right-click Connections and click Add Connection.

   You are prompted to select the connector location. As you move the cursor around in the modeling area, it snaps to 3 possible locations for a connector—the top and bottom of the junction box and the center of the knockout.

2. Select the center point of the knockout and press *ENTER* to accept the default value for the connector number.

   **NOTE** The default connector numbers are in ascending numeric order, according to the order in which the connectors are added to the model. For example, the first connector is 1, the second connector is 2, and so on. You can model connections for MvParts in any order.

3. Pick a location above and to the right of the model to place the dimension for the diameter of the knockout.
A diameter dimension (D1) is added to the model for the diameter of the knockout, a connector is added to Connections, and D1 size parameter is added to Size Parameters.

**IMPORTANT** The position of the first connector placed in the model defines the axis orientation of the part upon insertion. For example, if you place the first connector on a part with a perpendicular vector into the part, the direction of the vector defines the positive x-axis orientation when inserted into a drawing.

4 To define the domain and type of connection for the connector, in the part browser, expand Connections, right-click Connector 1, and click Edit.

The Connector Properties dialog is displayed.

5 Select Conduit for Domain from the list.

Connector domains are dependent on the specified shape of the modifier to which the connector is attached.

6 Select Glued for Type from the list.

Connector types are dependent on the connector domain.

**NOTE** Connectors are assigned an undefined type by default. An undefined connection type creates a valid connection between all types of connectors when inserted in a drawing.

7 Click OK.

**Adding Connectors to a Parametric Vertical Tank MvPart**

Use this procedure to add connectors to a parametric vertical tank MvPart. Typically, tanks have multiple connectors, an inlet and an outlet. This
procedure provides steps to add a connector for the inlet of a vertical tank. You can repeat this procedure, making the necessary location adjustments to add other connectors.

1 To add a connector, in the part browser, right-click Connections and click Add Connection.

You are prompted to select the connector location. As you move the cursor around in the modeling area, it snaps to 4 possible locations for a connector—the top and bottom of the tank body and the top and bottom of the tap.

2 Select the center point of the top of the tap and press ENTER to accept the default value for the connector number.

NOTE The default connector numbers are in ascending numeric order, according to the order in which the connectors are added to the model. For example, the first connector is 1, the second connector is 2, and so on. You can model connections for MvParts in any order.

3 Pick a location above and to the right of the model to place the dimension for the diameter of the tap.

A diameter dimension (D1) is added to the model for the diameter of the tap and to Model Parameters in the part browser, and a connector is added to Connections.

IMPORTANT The position of the first connector placed in the model defines the axis orientation of the part upon insertion. For example, if you place the first connector on a part with a perpendicular vector into the part, the direction of the vector defines the positive x-axis orientation when inserted into a drawing.
4 To define the domain and type of connection for the connector, in the part browser, expand Connections, right-click Connector 1, and click Edit.

The Connector Properties dialog is displayed.

5 Select Pipe for Domain from the list.

Connector domains are dependent on the specified shape of the modifier to which the connector is attached. When the Piping domain is selected, the System Type property is available.

6 Select Threaded for Type from the list.

Connector types are dependent on the part domain.

NOTE Connectors are assigned an undefined type by default. An undefined connection type creates a valid connection between all types of connectors when inserted in a drawing.

7 Select Cold Water for System Type from the list.

System types are dependent on the connector domain.

---

**Adding Dimensions to a Parametric MvPart**

Dimensions are used to define the default size of a parametric MvPart. You add model dimensions to define the overall size of the model. You can then add other sizes, such as a list of values, to a dimension to create individual part sizes.

**Adding Model Dimensions to a Parametric Air Terminal MvPart**

Use this procedure to add dimensions to specify the lengths and widths of the diffuser faces, the height of the transition, and the height of the lip that lies in the ceiling grid.

**TIP** To avoid distortion of the model, add the overall model dimensions first, and then add the individual dimensions for the geometry.

1 In the part browser, expand Modifiers, right-click each modifier, and click Visible.

This turns off the display of the modifiers in the modeling area to assist you in adding dimensions to the profiles.
2 To add a dimension for the width of the top face, in the part browser, right-click XY Plane and click Add Dimension ➤ Distance.

**NOTE** For constant parameter values, you can define a constant dimension, or choose not to add a dimension and use the default value based on the actual size of the geometry. When no dimensions are added, the parameter and its value are not displayed during part size selection.

3 In the modeling area, select the upper-left and lower-right sides of the top face, and specify a location to place the dimension. A length dimension (LenA1) is placed in the model and is added to Model Parameters in the part browser. The value of LenA1 is a default value based on the geometry distance of the feature, and it can be changed.

4 To add a dimension for the length of the top face, in the part browser, right-click XY Plane, and click Add Dimension ➤ Perpendicular Distance.

5 In the modeling area, select the lower-left and upper-right sides of the top face for the geometry, and select the upper-left edge of the top face for the relative line. Specify a location to place the dimension, and select the top and right corners to specify the dimension value. A length dimension (LenA2) is placed in the model and is added to Model Parameters in the part browser. The value of LenA2 is a default value based on the geometry distance of the feature, and it can be changed.

6 Repeat steps 2 through 5 to add width and depth dimensions to the bottom face. Length dimensions (LenA3, LenA4) are placed in the model and are added to Model Parameters in the part browser. The values of LenA3 and LenA4 are default values based on the geometry distance of the features, and they can be changed.

7 In the part browser, right-click each of the extrusions and click Visible. The flex duct connector extrusion modifier and the lip extrusion modifier are both displayed in the modeling area.

8 To define the length of the flex duct connector, in the part browser, right-click Model Dimensions and click Add Distance.
9 In the modeling area, select the flex duct connector extrusion modifier feature, and specify a location to place the dimension. A length dimension (LenB1) is placed in the model and is added to Model Parameters in the part browser. The value of LenB1 is a default value based on the height distance of the feature, and it can be changed.

10 To specify a constant height for the length of the flex duct connector, in the part browser, expand Model Parameters, right-click LenB1, and click Edit. The Model Parameters dialog is displayed.

11 Double-click the Equation value for LenB1, enter 4” (102 mm), and then click Close.

12 To specify the height of the lip, in the part browser, right-click Model Parameters, right-click WPOf2, and click Edit. The Model Parameters dialog is displayed.

**NOTE** Creating a modifier with a plane termination type enables you to use the distance between work planes as the defined length of the modifier feature. In this procedure, you use the distance between the work planes you created when adding the lip as the height dimension for the lip.

13 Verify that the Equation value for WPOf2 is 1” (25 mm).
If you need to change the value, double-click Equation for WPOf2, and enter a number to change the value.

14 Click Close.

**Adding Model Dimensions to a Parametric Junction Box MvPart**

Use this procedure to add dimensions to specify the length, width, and depth of the junction box.

**TIP** To avoid distortion of the model, add the overall model dimensions first, and then add the individual dimensions for the geometry.

1 To define the overall height of the junction box, in the part browser, right-click Model Dimensions and click Add Distance.

**NOTE** For constant parameter values, you can define a constant dimension, or choose not to add a dimension and use the default value based on the actual size of the geometry. When no dimensions are added, the parameter and its value are not displayed during part size selection.

2 In the modeling area, select the junction box modifier feature and specify a location to place the dimension.

A height dimension (LenB1) is placed in the model and is added to Model Parameters in the part browser. The value of LenB1 is a default value based on the extrusion distance of the feature, and it can be changed.
3 To specify the actual height of the junction box, in the part browser, expand Model Parameters, right-click LenB1, and click Edit. The Model Parameters dialog is displayed.

4 Double-click the Equation value for LenB1, enter 4" (102 mm), and then click Close.

5 To add a dimension for the width of the junction box, in the part browser, right-click XY Plane and click Add Dimension ➤ Horizontal Distance.

6 In the modeling area, select 2 corner points to specify the width of the junction box, and specify a location to place the dimension.

7 On the command line, enter a dimension value of 4" (102 mm), and press ENTER.

A length dimension (LenA1) is placed in the model and is added to Model Parameters in the part browser. The value of LenA1 is a default value based on the geometry distance of the feature, and it can be changed.

8 To add a dimension for the depth of the junction box, in the part browser, right-click XY Plane and click Add Dimension ➤ Vertical Distance.

9 In the modeling area, select 2 corner points to specify the depth of the junction box, and specify a location to place the dimension.

10 On the command line, enter a dimension value of 2" (51 mm), and press ENTER.
A length dimension (LenA2) is placed in the model and is added to Model Parameters in the part browser. The value of LenA2 is a default value based on the geometry distance of the feature, and it can be changed.

---

**Adding Model Dimensions to a Parametric Vertical Tank MvPart**

Use this procedure to add dimensions to specify the height and diameter of the tank body, and the length for the tap of the tank.

**TIP** To avoid distortion of the model, add the overall model dimensions first, and then add the individual dimensions for the geometry.

1. To add the height dimension of the tank body, in the part browser, right-click Model Dimensions and click Add Distance.

   **NOTE** For constant parameter values, you can define a constant dimension, or choose not to add a dimension and use the default value based on the actual size of the geometry. When no dimensions are added, the parameter and its value are not displayed during part size selection.

2. In the modeling area, select the body modifier and specify a location to place the dimension.

   A length dimension (LenB1) is placed in the model and is added to Model Parameters in the part browser. The value of LenB1 is
the height of the extrusion that represents the tank body, and it can be changed.

3 To specify the actual length of the tap, in the part browser, expand Model Parameters, right-click WPOf1, and click Edit. The Model Parameters dialog is displayed.

NOTE Creating a modifier with a plane termination type enables you to use the distance between work planes as the defined length of the modifier feature. In this procedure, you use the distance between the work planes you created to locate the tap as the tap length dimension.

4 Verify that the Equation value for WPOf1 is 2" (51 mm), and then click Close. If you need to change the value, double-click the value, and enter a different number.
Adding Individual Part Sizes to a Parametric Air Terminal MvPart

Use this procedure to add individual part sizes to the model. You create individual part sizes by adding parameters values. Values can be a list or table of values, constant values, or calculations.

You can also create unique part size names. Each part size name is generated using a calculation—a formatted string of parameter values and text.

1. To add part sizes to the part, in the part browser, right-click Size Parameters, and click Edit Configuration.
   The Size Parameters dialog is displayed.

   **NOTE** Calculated values set in the model cannot be edited in the Size Parameters dialog. To change these values you must edit the model.

2. To add a table of available sizes for the lengths and widths of the top and bottom faces of the diffuser, change the data storage type of the LenA1, LenA2, LenA3, and LenA4 parameters to Table.

3. In the toolbar, select Values from the list.
   The parameter values are displayed.

4. To add a new part size, click the first row in the table, and then click on the toolbar.
   A new part size row is added to the Size Parameters dialog. Repeat for each new part size you want to add.

5. For each part size, double-click in the LenA1, LenA2, LenA3, and LenA4 parameters and enter values.

   **TIP** You can copy and paste values from other part families using standard Microsoft® Windows copy and paste functionality (CTRL+C for Copy and CTRL+V for Paste). You can copy and paste values from another part open in Content Builder, from a part open in Catalog Editor, or from a Microsoft® Excel spreadsheet. For connector parameters, you can also insert the corresponding values for the segments used by default during layout.

6. When you finish adding sizes, click OK.

7. To add the size of the transition between faces, expand Model Parameters, right-click WPOf1, and click Edit.
8 In the Model Parameters dialog, double-click the Equation value for WPOF1, enter -4’ (-102 mm), and click Close.

**NOTE** You can also add an equation formula for the value. Click Calculator to access the Equation Assistant.

9 To specify a unique part size name, in the part browser, right-click Size Parameters and click Edit Calculations.
The Size Parameters dialog is displayed.

10 Double-click PrtD in row 1.
The Calculation Assistant is displayed.

11 In the Calculation Assistant, define the part size name.
   - Select 0 for Precision.
   - Under Insert Variable, select LenA1 and click Insert.
   - At the top of the dialog, click the value for Part Size Name (PrtSN), and enter x.
   - Under Insert Variable, select LenA2, and click Insert.
   - Click the value for Part Size Name (PrtSN), and enter inch Louver Face Ceiling Diffuser.

12 Click Evaluate to view the result.
13 Click OK twice.

**Adding Individual Part Sizes to a Parametric Junction Box MvPart**

Use this procedure to add individual part sizes to the model. You create individual part sizes by adding parameter values. Values can be a list or table of values, constant values, or calculations.

You can also create unique part size names. Each part size name is generated using a calculation—a formatted string of parameter values and text.

1 To add part sizes to the part, in the part browser, right-click Size Parameters, and click Edit Configuration.
The Size Parameters dialog is displayed.
NOTE Calculated values set in the model cannot be edited in the
Size Parameters dialog. To change these values you must edit the
model.

To add a table of available sizes for the width of the junction box,
change the data storage type of LenA1 to Table.

In the toolbar, select Values from the list.
The parameter values are displayed.

To add a new part size, click the first row in the table, and then
click New on the toolbar.
A new part size row is added to the Size Parameters dialog. Repeat
for each new part size you want to add.

For each part size, double-click LenA1 and enter a size.

TIP You can copy and paste values from other part families using
standard Microsoft® Windows copy and paste functionality (CTRL+C
for Copy and CTRL+V for Paste). You can copy and paste values from
another part open in Content Builder, from a part open in Catalog
Editor, or from a Microsoft® Excel spreadsheet. For connector
parameters, you can also insert the corresponding values for the
segments used by default during layout.

To specify a unique part size name, in the toolbar, select
Calculations from the list.
The calculation strings are displayed.

Double-click PrtD in row 1.
The Calculation Assistant is displayed.

In the Calculator Assistant, define the part size name.
■ Select 0 for Precision.
■ Under Insert Variable, select LenA1 and click Insert.
■ At the top of the dialog, click the value for Part Size Name
(PrtSN), and enter inch Outlet Box.

Click Evaluate to view the result.
Click OK twice.
Adding Individual Part Sizes to a Parametric Vertical Tank MvPart

Use this procedure to add individual part sizes to the model. You create individual part sizes by adding parameter values. Values can be a list or table of values, constant values, or calculations.

You can also create unique part size names. Each part size name is generated using a calculation—a formatted string of parameter values and text.

1. To add part sizes to the part, in the part browser, right-click Size Parameters, and click Edit Configuration.
   The Size Parameters dialog is displayed.

   **NOTE** Calculated values set in the model cannot be edited in the Size Parameters dialog. To change these values you must edit the model.

2. To add a table of available sizes for the diameter and height of the tank body, click to change the data storage type of ND1 and LenB1 to Table.

3. In the Size Parameters dialog, select Values from the drop-down list.
   The parameter values are displayed.

4. To add a new size, click the first row in the table, and then click on the toolbar.
   A new part size row is added to the Size Parameters dialog. Repeat for each part size you want to add.

5. For each part size, double-click ND1 and LenB1 and enter values.
   The software automatically retrieves an appropriate physical diameter based on the nominal diameter that you specify and the connection type. For more information, see Specifying Connector Sizes for Pipe Connectors on page 1001.
**TIP** You can copy and paste values from other part families using standard Microsoft® Windows copy and paste functionality (CTRL+C for Copy and CTRL+V for Paste). You can copy and paste values from another part open in Content Builder, from a part open in Catalog Editor, or from a Microsoft® Excel spreadsheet. For connector parameters, you can also insert the corresponding values for the segments used by default during layout.

6 To specify a unique part size name, in the Size Parameters dialog, select Calculations from the list.

   The calculation strings are displayed.

7 Double-click PrtD in row 1.

   The Calculation Assistant dialog is displayed.

8 In the Calculation Assistant dialog, define the part size name.
   - Under Precision, select 0.
   - Under Insert Variable, select LenB1, and click Insert (to the right).
   - At the top of the dialog, click the value for Part Size Name (PrtSN), and enter inch Vertical Storage Tank.

9 Click Evaluate to see the result.
Click OK twice.

**Generating a Preview Image of a Parametric MvPart**

Use this procedure to generate a preview image of the parametric MvPart to help during part selection. Content Builder generates the preview image based on a specified view direction. You can select from the 10 standard AutoCAD® view directions to view the model (top, bottom, left, right, front, back, SW isometric, SE isometric, NE isometric, and NW isometric).

1. In the part browser, click (Generate Bitmap).
   The Bitmap Preview dialog is displayed.
Example of bitmap preview of a parametric vertical tank MvPart

2 Under Generate View, click a view for the preview image of the part.

**TIP** As you select a view, the preview image window in the dialog is updated. This enables you to view all the available preview images for the part before selection.

You can also browse to and select a predefined bitmap image. Predefined images must be 200 x 200 pixels and saved with 256 colors.

3 Click OK.

**Defining the Part Insertion Behaviors of a Parametric MvPart**

1 In the part browser, click (Options).
   The Options dialog is displayed.
Options dialog

2 Specify the insertion behaviors for the part, and click OK.
   For descriptions of the settings, see Part Insertion Behaviors of a Parametric Part on page 1003.

3 In the part browser, expand Autolayout Data, right-click Layout Data, and click Select Placement Point.
   Select Placement Point from Layout Data context menu

4 Specify the point on the part model to use as the placement (insertion) point for the MvPart.
   The software adds (a placement point) at the selected location.

Validating, Saving, and Previewing a Parametric MvPart

Use this procedure to validate a parametric MvPart, save the part family, and preview individual part sizes.
To validate a parametric MvPart

1 On the Content Builder toolbar, click ✅. Upon successful completion of these procedures, the part is validated and the status bar is updated with the traffic light displayed green.

If you have errors in your model, the traffic light is red and a dialog is displayed listing the errors. Review the errors, make necessary modifications and repeat this step until validation is successful.

**NOTE** Warnings in the Part Family Validation Results dialog do not make the part invalid.

Once validation is successful, you can save the parametric MvPart.

To save a parametric MvPart

2 On the toolbar, click ☑️.

3 Specify whether to make the part available in the catalog:
   - Click Yes to make the part available to users.
   - Click No to keep the part hidden.

**NOTE** This prompt toggles the Hide Part option in the Options dialog in Content Builder.

The part is saved in the specified catalog location.

To preview a parametric MvPart

4 To preview each part size, in the part browser, right-click Size Parameters and click Edit Values. The Size Parameters dialog is displayed.

5 Click a row in the table to select the default part size.

6 Click 📽️. The Parametric Object Viewer is displayed.
7 Select a different view from the list, or click to view the model using 3D orbit navigation.

8 In the Parametric Object Viewer, select a point on the circle, and drag the cursor along the circumference of the circle to inspect the 3D model dynamically from various viewpoints.

9 With the Parametric Object Viewer open, select a different part size in the Size Parameters dialog.

   The part size is displayed in the viewer.

10 Inspect the model from various viewpoints to verify that the model appears sound.

   If your inspection reveals problems, such as segments that join improperly, make the necessary modifications, and inspect the part sizes again. Repeating this process until all part sizes appear sound.

11 Click to close the Parametric Object Viewer.
Creating a Schematic Symbol of a Parametric MvPart

You can create a schematic symbol for a parametric MvPart at any time. However, only parts that you add to drawings after you have created the symbol can use the symbol. You cannot update previously inserted parts to use the symbol.

There are 2 types of schematic symbols that you can add to parametric MvParts:

- **Parametric.** This type of symbol scales proportionally with the part. You create parametric symbols using parametric features: parametric geometry, dimensions, and constraints.

- **Block-based.** This type of symbol scales uniformly instead of proportionally. You create block-based symbols using standard AutoCAD® objects, such as lines, arc, and circles. You can create the symbol from scratch, or you can insert an existing AutoCAD MEP symbol or 2D AutoCAD block from a DWG file. This allows you to take advantage of existing symbol libraries or block libraries.

Creating a Parametric Symbol

1. If necessary, open the parametric MvPart in Content Builder.
2. In the part browser, right-click Symbol and Annotation Plane, and click Visible.
   
   **NOTE** Although this step makes the plane visible in the drawing area, its position on the Z axis in the World Coordinate System (WCS) is high above the WCS origin, so you might need to zoom out to view the plane. You can also change the position of the plane if desired.

3. Right-click Symbol and Annotation Plane, and click Set View.
   This changes the view direction to Top (plan) view, which is the default view for the plane as well as the most common view for drawing schematic symbols. However, you can select any view that is helpful for drawing the geometry.

4. Create the schematic symbol using parametric geometry, constraints, and dimensions.
   First, use the model geometry that changes with part size to create point references and projected geometry on the Symbol and Annotation plane. Next, create the symbol geometry on the plane.
Finally, add constraints and/or dimensions so that the symbol changes accordingly when the part size changes.

To access the necessary commands, expand Symbol and Annotation Plane, right-click Parametric Graphics, and use the commands on the context menu, as follows. Click Add Geometry, and then click Point Reference.

Symbol and Annotation Plane context menu

To quickly generate the geometry of the model outline on the Symbol and Annotation plane, you can right-click the plane in the part browser, and select Part Boundary. You can use the outline geometry as a guide for the symbol geometry. When you are done, turn off Part Boundary to remove the outline geometry from the plane because it does not change in size.

TIP Use the Isolate Plane Contents, Hide Plane Contents, and End Object Isolation commands on the context menu of a plane to show or hide the geometry on the plane.

5 After you have drawn the symbol geometry and added the necessary constraints and dimensions, verify that when the part changes in size, the symbol changes in size in the same way:

■ In the part browser, expand Model Parameters, right-click a parameter, and click Edit.

■ In the Model Parameters dialog, modify the values of the parameters for the model, and click Close.

■ Examine the changes to the model and symbol in the drawing area.

6 If desired, add annotation to the schematic symbol.
7 If desired, specify the use of the schematic symbol instead of a model-generated view in 1-line and 2-line display representations in Top (plan) view:

- In the part browser, click .
- In the Options dialog, click Display Symbol In Plan View, and click OK.

8 In the part browser, click (Save Part Family).

9 Click to close the part browser.

As an example, the following illustrations show how to create a parametric schematic symbol for an air diffuser. First, to align the edges of the symbol with the edges of the diffuser, point references are created on the Symbol and Annotation plane using 2 of the corner points on the diffuser. Then, for better
viewing, the contents of the Symbol and Annotation plane are isolated. At this point, the 2 point references are the only geometry on the plane.

Create point references

Isolate contents on Symbol and Annotation Plane
Next, using the point references to specify the corner points, a rectangle is drawn to represent the schematic symbol.

Finally, to cause the symbol to scale proportionally with the diffuser, the corner points of the symbol rectangle are constrained to the underlying point references. Because the point references are based on the corner points of the model, this ensures the symbol and the model remain aligned. You can also accomplish this by adding dimensions to the symbol and setting their values to the names of the corresponding model dimensions. This ensures the symbol dimensions change when the model dimensions change.
Creating an AutoCAD-Based Symbol from Scratch

1. If necessary, open the parametric MvPart in Content Builder.
2. In the part browser, right-click Symbol and Annotation Plane, and click Visible.

**NOTE** Although this step makes the plane visible in the drawing area, its position on the Z axis in the World Coordinate System (WCS) is high above the WCS origin, so you might need to zoom out to view the plane. You can also change the position of the plane if desired.

3. Right-click Symbol and Annotation Plane, and click Set View. This changes the view direction to Top (plan) view, which is the default view for the plane as well as the most common view for drawing schematic symbols. However, you can select any view that is helpful for drawing the geometry.

4. Draw the geometry of the schematic symbol using standard AutoCAD objects, such as lines, arcs, and circles.

**TIP** Use the Isolate Plane Contents, Hide Plane Contents, and End Object Isolation commands on the context menu of a plane to show or hide the geometry on the plane.

5. In the part browser, expand Symbol and Annotation Plane, right-click Design Blocks, and click Add Schematic Block.
6. Select the plane along which to orient the 2D symbol, select the geometry of the symbol, and press ENTER. Typically you orient the symbol along the Symbol and Annotation plane. To do so, press ENTER to accept the current plane. However, you can also select a different plane. For example, you might want the symbol to show in side views instead of Top view for use in section and elevation drawings.

You can select any geometry except parametric geometry created using Content Builder, which is filtered from the selection set.
7 Specify whether to erase the source geometry of the symbol:
   ■ Enter n (no) and press ENTER to keep the source geometry in the part.
   ■ Enter y (yes) or press ENTER to erase the source geometry.

The schematic symbol is attached to the Symbol and Annotation Plane regardless of the plane where it is oriented. Therefore, the software adds a Design Block to the Symbol and Annotation Plane under Design Blocks in the part browser.

**Adding design block**

Design Block represents the schematic block that you have added. Typically, you create only one symbol and, therefore, only one Design Block for a part.

8 If desired, add annotation to the schematic symbol.
9 If desired, specify the use of the schematic symbol instead of a model-generated view in 1-line and 2-line display representations in Top (plan) view:
   ■ In the part browser, click 
   ■ In the Options dialog, click Display Symbol In Plan View, and click OK.

10 Click (Save Part Family).
11 Click to close the part browser.

### Creating an AutoCAD-Based Symbol from an Existing Symbol or Block

1 If necessary, open the parametric MvPart in Content Builder.
2 In the part browser, right-click Symbol and Annotation Plane, and click Visible.

---

1104 | Chapter 14  Customizing Catalog-Based Content
NOTE Although this makes the plane visible in the drawing area, its position on the Z axis in the World Coordinate System (WCS) is high above the WCS origin, so you might need to zoom out to view the plane. You can also change the position of the plane if desired.

3 Right-click Symbol and Annotation Plane, and click Set View.
This changes the view direction to Top (plan) view, which is the default view for the plane as well as the most common view for adding schematic symbols.

4 In the part browser, expand Symbol and Annotation Plane, right-click Design Blocks, and click Insert AutoCAD Block.

5 In the Insert dialog, click Browse, navigate to the drawing that contains the symbol or block you want to insert, and select it.

6 For Name, select the name of the symbol or block.

NOTE If the drawing contains only a single symbol or block, you can select the drawing name instead. In this case, also click Explode to explode the drawing-level block that contains all of the blocks in the drawing. This exposes the single block inside the drawing so the software can retrieve it.

7 Specify the insertion point, scale, and rotation angle; and click OK.
Alternatively, you can click Specify On-screen for one or more of these settings to specify the value when you insert the symbol or block.

8 In the drawing, if necessary, specify the insertion point and rotation angle.

9 Enter y (yes) or press ENTER to use the block as the schematic symbol.

10 Specify whether to erase the source geometry of the symbol:
- Enter n (no) and press ENTER to keep the source geometry in the part.
- Enter y (yes) or press ENTER to erase the source geometry.

The software explodes the symbol or block, and adds a Design Block to the Symbol and Annotation Plane in the part browser.
Adding design block

The Design Block represents the schematic block that you have added. Typically, you create only one symbol and, therefore, only one Design Block for a part.

11 If desired, add annotation to the schematic symbol.

12 If desired, specify the use of the schematic symbol instead of a model-generated view in 1-line and 2-line display representations in Top (plan) view:
   - In the part browser, click .
   - In the Options dialog, click Display Symbol In Plan View, and click OK.

13 Click (Save Part Family).

14 Click to close the part browser.

Adding Annotation to a Schematic Symbol

You can add annotation to the schematic symbol of a parametric MvPart regardless of whether the symbol is parametric or block-based. To add the annotation, you create a multiline text (mtext) object, which the software then uses to create the text block to associate with the symbol.

When the symbol is inserted into a drawing, the text block is inserted as well. If the symbol changes in size, the text block is repositioned to maintain the same relative position.

To add annotation to a parametric or block-based schematic symbol

1 If necessary, open the MvPart in Content Builder.

2 In the part browser, expand Modeling, and expand Symbol and Annotation Plane.

3 Right-click Annotation Text, and click Add Annotation Text.

4 In the drawing area, specify opposite corners of a bounding box to define the width of the multiline text object.
5 Use the In-Place Text Editor to enter the annotation text and specify its properties, such as the character height expressed in terms of the drawing units.

For information on using the In-Place Text Editor, see Overview of Multiline Text.

**TIP** If you set the character height of the annotation text in your building systems drawings to 1 unit, you can control the plot size of annotation entirely by the Annotation Plot Size setting on the Scale tab of the Drawing Setup dialog. For example, if the units for a drawing are inches, and the annotation plot size for the drawing is 3/32”, then setting the annotation text in the drawing to 1” results in a text height of 3/32” for the plotted annotation.

6 Save your changes, and exit the editor by doing one of the following:

- Click in the drawing outside the editor.
- Click OK on the toolbar.
- Press **CTRL+ENTER**.

The software creates the text block and attaches it to the Symbol and Annotation plane. The text block now appears in the part browser under Annotation Text.

7 If you want the annotation text to remain horizontal regardless of the rotation angle of the part when it is inserted, select the text block, right-click, and click Keep Text Horizontal.

To delete the annotation text block, you can select the block in the drawing area, and press **DELETE**.

---

**Modifying Parametric Parts Using Content Builder**

You can modify existing parametric parts with Content Builder. For parts in the catalogs provided by AutoCAD MEP, you can change the part behavior, part size parameters, and connectors. For parametric parts you create using Content Builder, you can change the part behaviors, part size parameters, connectors, and part model including geometry, profiles, modifiers, constraints, and dimensions. You can also delete parts that you no longer need. Deleting parts can be helpful when creating custom catalogs to ensure that all associated definition files are managed correctly.
Starting Content Builder for Modifying a Parametric Part

Use this procedure to start Content Builder and open the parametric building environment for modifying a parametric part.

1 Click Manage tab ➤ MEP Content panel ➤ Content Builder.
   The Getting Started - Catalog Screen dialog is displayed.
2 In the part catalog browser, navigate to and select a parametric part.
3 To add a new part size to an existing part, click .
   The existing part is opened in the parametric building environment.
4 To modify a part size, click .
   The existing part is opened in the parametric building environment.
5 To delete a part, click .
   The selected part family is deleted from the part catalog, including all associated definition files (XML, DWG, and BMP files).

Modifying a Parametric Part

As your design develops and parts change, you can modify parametric parts using Content Builder. You can change the part behavior, part size parameters, and connectors. For parts you created using Content Builder, you can also change the part model, including geometry, profiles, modifiers, constraints, and dimensions. You can use the same procedures that guide you through creating a parametric part to modify it. This section outlines how you can modify a parametric part and provides references to the related procedures that you can use to make changes.

IMPORTANT When making changes to a parametric part, refer to the illustration in Model of a Parametric Part on page 976. This illustration shows the relationship dependencies between features that must be maintained to ensure you are creating a usable part.
Modifying the Part Configuration

You can change the part configuration that controls the behavior of the part. In the part browser, expand Part Configuration and change the part type or subtype. For more information, see Defining the Part Behavior of a Parametric Fitting on page 1010 and Specifying the Part Configuration of a Parametric MvPart on page 1043.

Modifying the Part Model

For parts that you created using Content Builder, you can change the model parameters that define the overall size of the model. You can change the geometry, dimensions, and constraints of the model.

You can add, modify, or remove geometry in the model; however, you must append the changed geometry to the profile in order for Content Builder to update the model and assign new geometric constraints.

You can also change the parametric relationships of model elements by modifying the geometric and dimension constraints. Because constraints control the overall shape of the model, you cannot safely make changes until you know the current constraints applied to the model. You can delete an unwanted constraint or add new constraints to reshape the sketch.

Content Builder’s parametric commands ensure that relationships among geometric elements remain intact; however, after changes are made to the model you should re-examine the geometric constraints and dimensions to verify that nothing else in the model needs to be updated. For more information, see Modeling a Parametric Fitting on page 1011 and Modeling a Parametric MvPart on page 1045.

Modifying Connectors

You can add, delete, and edit the connectors of a parametric part. The shape of the connector is determined by the shape of the modifier that the connector is attached to. Therefore, to change a connector’s shape you must modify the associated modifier. For more information, see Adding Connectors to a Parametric Fitting on page 1019 and Adding Connectors to a Parametric MvPart on page 1074.

Modifying Part Sizes

You can change the model dimensions of the part that determine the overall size of the model, such as length and width. You can also change individual size parameters for a specific part size. For example, you can change a constant value to a list of values or add custom parameters for enhancing scheduling.
data. For more information, see Adding Dimensions to a Parametric Fitting on page 1026 and Adding Dimensions to a Parametric MvPart on page 1081.

**Modifying the Preview Image, Schematic Symbol, or Part Insertion Behaviors**

You can change the preview image by selecting a different view direction that Content Builder uses to generate the preview image. You can also attach a predefined image. For more information, see Generating a Preview Image of a Parametric Fitting on page 1031 and Generating a Preview Image of a Parametric MvPart on page 1093.

You can change the insertion behaviors of the part that define how the part is added to a drawing, including layer key, trim lengths for fittings, and the placement point of a parametric part. For more information, see Defining the Part Insertion Behaviors of a Parametric Fitting on page 1031 and Defining the Part Insertion Behaviors of a Parametric MvPart on page 1094.

For parametric MvParts, you can also modify the schematic symbol. Schematic symbols can be predefined symbol blocks or you can create them from scratch in the modeling area of Content Builder. Therefore, you can attach a new schematic symbol or modify the schematic symbol block. For more information, see Creating an AutoCAD-Based Symbol from an Existing Symbol or Block on page 1104.

### Working with Block-Based Parts

A block-based part is a multi-view part (MvPart) whose geometry is based on individual AutoCAD® blocks. Each part size is associated with a unique 3D model block, to which you specify basic information such as view representations and connector placement. You can convert existing AutoCAD blocks or multi-view blocks (MvBlocks) to block-based parts, and you can create block-based parts using Content Builder.

**NOTE** For an introduction to block-based parts, see Understanding Parametric and Block-Based Parts on page 957.

### Converting MvBlocks to Block-Based Parts

Use this procedure to convert AutoCAD® solids, mass elements, blocks, or multi-view blocks (MvBlocks) into multi-view parts (MvParts). MvBlocks, like MvParts, can be viewed from different directions, but MvBlocks cannot connect intelligently with systems.
Architectural drawings referenced in an AutoCAD MEP drawing can contain solids, mass elements, and MvBlock parts that may be useful as MvParts. You can convert MvBlocks to MvParts even if the MvBlock exists in a reference drawing.

This procedure is the same for mechanical, piping, electrical, and plumbing parts.

1. Select the element or block to convert, right-click, and select **Convert to Multi-view Part**.
2. In the Multi-view Part Convert - Behavior dialog, specify a name for the new part.
3. Specify a part type for **Type**.
4. Specify a category for **Subtype**.
5. Specify a layer key for the new part.
6. Click **Next**.
7. In the Multi-view Part Convert - Connectors view, right-click the MvPart name and select a connector type.
8. In the Part Family Connector Properties dialog, specify the properties for the connector.
9. Click **OK**.
10. Continue adding connections for the part.
11. To specify the location of a connection, select a connection, right-click, and select **Edit Placement**. Note that the MvPartBuilder - Connector Editor is displayed in your workspace.
12. Select **Position** for Connector.
13. Specify the placement for the connector on the MvPart.

**NOTE** Use object snaps to snap the connector placement to linework in the block drawing. When you are editing connector placement, you can make it easier to select geometry by using tools such as 3D Orbit and Pan to change the part view.

14. If the connector has a flow direction, you can specify a vector to indicate the direction, or you can specify the coordinates in the **Normal** field under Connector Geometry. For example, a pipe connector with an outflow in the downward direction has the normal coordinates of \(0,0,-1\).

15. To specify the placement of other connectors, select a connector at the top of the Connector Editor and specify the location on the MvPart.
When you have finished, click OK to close the Connector Editor.

If you want to change connector properties, select a connector in the Multi-view Part Convert - Connector dialog, right-click, and select Modify.

If you want to change connector placement, direction, or size, right-click a connector and select Edit Placement. Use the Connector Editor to make changes.

Click Finish.

The resulting MvPart can now be connected to specific building systems. Note that the original block still exists; the MvPart is created as a separate entity and placed in the same location.

An example of a MvBlock sink that was converted to an MvPart. The sink can now connect to piping for the waste system.

The MvPart exists in the drawing but is not added to a part catalog. You can add multiple instances of a converted MvPart by copying and pasting it in a drawing. You can modify a converted MvPart by selecting it, right-clicking, and selecting Edit MvPart Style. If you want to create an MvPart from a block, and include it in a part catalog, use the Content Builder. For more information, see Content Builder on page 964.
Best Practices for Creating a Block-Based Part

The following tips will help you to create a block-based part using Content Builder.

■ Do not save the source files (drawings for the 3D model and schematic symbol) in the catalog folders of AutoCAD MEP. The source files are working files and should be saved in a separate folder.

■ To take advantage of the automatic view block creation tool in Content Builder, create the 3D model from AutoCAD® solids. This also ensures support of the part in AutoCAD MEP and for rendering, shading, and hiding in 3D model views.

■ To ensure correct display control of part sizes when added to a drawing, draw all geometry for the 3D model and schematic symbol on layer 0. Assign BYBLOCK for color and linetype, and BYLAYER for lineweight.

■ Assign a helpful name and description to new parts. The name specified for the part family in the New Part dialog is used to name the files that define the part in the catalog (XML file, BMP file, DWG file). The description is the phrase you see during part selection throughout AutoCAD MEP.

Block-Based Part Creation Overview

When you create a block-based part, you associate a pre-drawn 3D model block with basic information such as part behavior, placement of connectors, and custom data. Block-based parts represent individual part sizes. Using Content Builder, you define a part family and one or more part sizes. You can also create part sizes in an existing part family. It is important to analyze the catalog hierarchy to decide the best place to add new part families. It is also important to notice the relationships between the different part sizes you want to create. Some may be similar in type and should belong to the same part family, while others may be unique and require their own part family.

The following sections provide an overview for creating block-based parts using Content Builder.

3D Model Block for a Block-Based Part

Each part size of a part family represents a real-world building systems part, such as a piece of equipment. For each part size, you must create a 3D model
block to represent the part size as it would look in the real world. All model blocks must be created using AutoCAD® solids in order to support automatic generation of view blocks, as well as rendering, shading, and hiding in 3D model views. Each 3D model block must be saved in an AutoCAD drawing file. You can save one or more model blocks in the same drawing file.

**IMPORTANT** Do not save the model block drawings in the catalog folders of AutoCAD MEP. These are working files and should be saved in a separate, or temporary, folder.

You should create the model block based on the standard AutoCAD UCS orientation to ensure that the individual view blocks generated by Content Builder are correct. Using the SW isometric view, create the model block at an insertion point of 0,0,0 in the world coordinate system (WCS). This ensures that each view block generated aligns to the respective side of the model block as follows:

<table>
<thead>
<tr>
<th>The...</th>
<th>aligns with the...</th>
<th>in the...</th>
</tr>
</thead>
<tbody>
<tr>
<td>top view block</td>
<td>top side of the model block</td>
<td>XY plane.</td>
</tr>
<tr>
<td>bottom view block</td>
<td>bottom side of the model block</td>
<td>XY plane.</td>
</tr>
<tr>
<td>front view block</td>
<td>front side of the model block</td>
<td>XZ plane.</td>
</tr>
<tr>
<td>back view block</td>
<td>back side of the model block</td>
<td>XZ plane.</td>
</tr>
<tr>
<td>left view block</td>
<td>left side of the model block</td>
<td>YZ plane.</td>
</tr>
<tr>
<td>right view block</td>
<td>right side of the model block</td>
<td>YZ plane.</td>
</tr>
</tbody>
</table>

**NOTE** To ensure correct display control of part sizes when a part is added to your drawings, draw geometry for the model block on layer 0, assign BYBLOCK for color and linetype, and assign BYLAYER for lineweight.

Sample 3D model block of an air handling unit

---

1114 | Chapter 14  Customizing Catalog-Based Content
Schematic Symbol of a Block-Based Part

Generally, every part has a schematic symbol that you add to your schematic design layouts. Using Content Builder, you can assign each part a symbol block. You can assign a different symbol to each part size, or assign the same symbol to all part sizes. The symbol block provides a schematic representation of the part size for use in plan views. Typically, the same symbol block is used for all the part sizes in a part family. You must save the symbol block in an AutoCAD® drawing file. You can save one or more symbol blocks in the same drawing file.

**IMPORTANT** Do not save the symbol block drawings in the catalog folders of AutoCAD MEP. These are working files and should be saved in a separate, or temporary, folder.

You can use any drawing command to create the geometry for the blocks. Standard AutoCAD entities such as lines, polylines, or circles are recommended. Once the schematic symbol block is created, Content Builder scales and wraps the symbol block with a bounding box of the 3D model. This ensures that valid connections can be maintained between the schematic symbol and the connecting schematic lines.

**WARNING** Be careful when using AEC-based geometry, such as walls or ducts, to create your symbol. To avoid object enabler problems, be sure to explode the geometry to base AutoCAD entities before running MvPart Builder.

To ensure correct display control of your symbol when it is added to your drawings, draw geometry for the symbol on layer 0, assign BYBLOCK for color and linetype, and assign BYLAYER for lineweight. The insertion point, or base point, is used as a reference for positioning the block upon insertion. The insertion point for the schematic block should be the same as the 3D model block that it represents. When you place the MvPart in a drawing, all associated blocks are part of one object; therefore, you want to maintain a common insertion point.
Content Builder wraps the schematic symbol with a bounding box of the 3D model and places the schematic symbol in the center of the bounding box. The bounding box is stretched around the extents of the 3D model in order to maintain accurate locations of the connection points. For easy identification, you should also use a standard naming convention that represents the part size or part family as you save your symbol block.

Behavior of a Block-Based Part

In the block-based building environment, you begin part definition by specifying the behavior of the part family. Every part size in a part family has the same behavior. You then specify a type, subtype, layer key, and insertion method for each part family.

Part Type

Part type refers to the main category for the part family. It defines unique characteristics and behaviors for the part sizes, such as the ability to assign flow annotation to an HVAC part size. Types are predefined by the application and cannot be modified. Therefore, select a type that is similar to the part sizes.
Example of MVPart Builder (New Part) dialog

**Part Subtype**

Part subtype is the subcategory for the part family. It is useful for grouping similar parts. The subtype can be used as a filter method for part selection in the Add and Modify dialogs. Therefore, you should select a descriptive subtype name for easy identification. You can also enter a new subtype if the desired subtype is not listed.

**Layer Key**

You assign a layer key to the part family for automatic layer mapping of part sizes. The same layer key is used for all part sizes of a part family. When you add a part that has a specified layer key to a drawing, the part is placed on the layer to which it is mapped. For example, according to the Aecb layer standard (AecbLayerStd4.dwg) and associated Mech - AIA 256-color layer key style, the Air Handling Unit layer key is mapped to the M-HVAC-Eqpm layer. When you add an air handling unit to your drawing, it is assigned to the M-HVAC-Eqpm layer. Only those layer keys predefined in the layer key style
selected for the current drawing are available for selection in Content Builder. To learn more about layer keys, see Layer Management.

**Insertion Method**

There are 2 insertion methods for placing parts in your drawing: anchor and breaks into.

When a part is inserted using the anchor method, the part anchors to the segment or object selected. This enables the parts to act together as one. For example, when you add a louver to your drawing, it is anchored to a segment. If the segment is moved, the louver moves with it.

When a part is inserted using the breaks into method, the part breaks into the segment or object selected. The part remains as an individual component. For example, when you add a valve to a segment, the segment is broken into 2 separate segments. You can move the valve along the run and the connecting segments are trimmed or stretched accordingly.

Parts that are inserted using the breaks into method are sometimes referred to as in-line parts.

To have the option of choosing an insertion method when you add the part to a drawing, specify both insertion methods when defining the part. To have the part behave similarly to a standard AutoCAD® block during insertion, specify no insertion method when defining the part.
View Blocks of a Block-Based Part

Each part size represents a real-world building systems part, such as a piece of equipment, that has different representations in different views. In the block-based building environment, 2-dimensional (2D) orthographic view blocks can be generated from the 3D model of the part size. Standard AutoCAD® blocks representing the plan, elevation, and model views of a part are grouped together to create an individual part size. Typically, each part size has 6 orthographic view blocks: 1 for each view direction (top, bottom, front, back, left, right). The following illustrations represent the 6 orthographic view blocks for an air handling unit.

**Top and bottom orthographic view blocks**

**Front and back orthographic view blocks**
Left and right orthographic view blocks

The insertion point, or base point, is used as a reference for positioning the block upon insertion. All view blocks share a common insertion point of 0,0,0 in the world coordinate system (WCS) that reflects the same point on the model block. The location of the insertion point directly affects the placement of the part size when you add it to your drawing.

The previous illustrations show the insertion point of the model view as the right corner of the bottom edge of the front side. The top and bottom views have an insertion point at the right corner of the front edge, with the top-view insertion point offset by the height of the air handling unit. The front and back views have an insertion point at the right corner of the bottom edge, with the back-view insertion point offset by the width of the air handling unit. The left and right views have an insertion point at the bottom-front corner, with the left-view insertion point offset by the length of the air handling unit.

Once view blocks are generated, they are assigned to the appropriate display representation based on view direction, name, and view block. You can change the default assignments as needed. It is possible to assign the same view block to multiple view directions, such as front and back, depending on the part symmetry. The view block assignments are as follows:

<table>
<thead>
<tr>
<th>View Block</th>
<th>Display Representation</th>
<th>View Direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top</td>
<td>1 Line</td>
<td>Top</td>
</tr>
<tr>
<td></td>
<td>2 Line</td>
<td>Top</td>
</tr>
<tr>
<td>Bottom</td>
<td>1 Line</td>
<td>Bottom</td>
</tr>
<tr>
<td></td>
<td>2 Line</td>
<td>Bottom</td>
</tr>
<tr>
<td>View Block</td>
<td>Display Representation</td>
<td>View Direction</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Front</td>
<td>1 Line</td>
<td>Front</td>
</tr>
<tr>
<td></td>
<td>2 Line</td>
<td>Front</td>
</tr>
<tr>
<td>Back</td>
<td>1 Line</td>
<td>Back</td>
</tr>
<tr>
<td></td>
<td>2 Line</td>
<td>Back</td>
</tr>
<tr>
<td>Left</td>
<td>1 Line</td>
<td>Left</td>
</tr>
<tr>
<td></td>
<td>2 Line</td>
<td>Left</td>
</tr>
<tr>
<td>Right</td>
<td>1 Line</td>
<td>Right</td>
</tr>
<tr>
<td></td>
<td>2 Line</td>
<td>Right</td>
</tr>
<tr>
<td>Model</td>
<td>1 Line</td>
<td>3D</td>
</tr>
<tr>
<td></td>
<td>2 Line</td>
<td>3D</td>
</tr>
<tr>
<td></td>
<td>Model</td>
<td>All directions</td>
</tr>
<tr>
<td>Symbol</td>
<td>Schematic</td>
<td>All directions</td>
</tr>
</tbody>
</table>

**NOTE** The Plan display representation is a standard display representation and is not used by AutoCAD MEP. Standard display representations cannot be deleted.

**Preview Image of a Block-Based Part**

Every part family has a graphical preview image that helps during part selection. Using Content Builder, you assign a preview image to the part family. You can create an image before using Content Builder or have Content Builder generate a preview image based on the 3D model. The preview image should be a representative image of the part family, typically a shaded model view of one of the part sizes in the SW isometric view direction. The same preview image is used for all part sizes of a part family.
If you create your own image before using Content Builder, you should save the image as a 256-color bitmap (BMP) image, 200 x 200 pixels in size. When creating your own image, it is also helpful to show dimensions and other information about the part (such as the UCS icon to represent the insertion point or arrows to represent the flow direction) to assist in selecting the part size.

**Connectors of a Block-Based Part**

In the block-based building environment, you can add connectors to the part. Connectors enable the part to be connected intelligently to other building systems objects in your layout. You can define one or more connectors for the part.

**IMPORTANT** The number of connectors must be the same for all part sizes of a part family. When you add or delete a connector from a part family, all part sizes are updated.

When you add a connector, you specify a domain. The domain is a predefined list that specifies the connection rules for a part. The domain is defined once for the part family and remains the same for all part sizes. Connectors belonging to a particular domain can connect to other parts of the same domain, but they cannot connect to components in other domains. For example, an MvPart representing an air handling unit might have the following domains specified for its connections:
<table>
<thead>
<tr>
<th>Connector Name</th>
<th>Description</th>
<th>Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>inlet</td>
<td>air entering the unit</td>
<td>duct</td>
</tr>
<tr>
<td>outlet</td>
<td>air leaving the unit</td>
<td>duct</td>
</tr>
<tr>
<td>power</td>
<td>electrical connection to the motor</td>
<td>conduit</td>
</tr>
<tr>
<td>hot water in</td>
<td>hot water entering the heating coil</td>
<td>pipe</td>
</tr>
<tr>
<td>hot water out</td>
<td>hot water leaving the heating coil</td>
<td>pipe</td>
</tr>
<tr>
<td>cold water in</td>
<td>cold water entering the chilling coil</td>
<td>pipe</td>
</tr>
<tr>
<td>cold water out</td>
<td>cold water leaving the chilling coil</td>
<td>pipe</td>
</tr>
<tr>
<td>drain</td>
<td>condensation drain</td>
<td>pipe</td>
</tr>
</tbody>
</table>

The connector shape is dependent on the specified shape of the part family; however, you can specify the type, size, and location for each connector based on the part size. The connector type is specified from a list of predefined types by domain and defines additional connection rules for a part. Examples of connector types include flange, slip-joint, and glued. The size is a user-defined value and varies by shape. For example, for a rectangular shape you can define the length and width, whereas for a round shape you can define the diameter. However, you can specify whether unsized connections are allowed when defining each connector.

The location of a connector can be specified by entering coordinates based on the 3D model of the part or by picking an insertion point. You must also specify a direction vector, or normal, that sets the direction of the connector when leaving the part, typically pointing in the direction away from the part.
size. If you assign the direction vector correctly, the Compass is aligned when you connect components to the part.

Recommended direction vectors are as follows:

- positive x direction: 1,0,0
- positive y direction: 0,1,0
- positive z direction: 0,0,1
- negative x direction: -1,0,0
- negative y direction: 0,-1,0
- negative z direction: 0,0,-1

For connector faces that are rotated on non-standard planes, specify the connection position using drawing assistance to snap to the center of the connector face, and specify the direction pointing away from the part. You can also specify a rotation; however, the rotation typically is specified by default upon insertion.

**Property Set Information for a Block-Based Part**

For a part family or an individual part size, you can add additional data properties that can be used to help identify parts during design development or to enhance property set information for scheduling. Using Content Builder, you add custom parameters that have user-defined attributes, including description, data storage, data type, units, and visibility. Custom data can be used for properties such as manufacturer, cost, or even paint color. You can also add parameters by selecting from a list of predefined parameters based on part type, such as material or gauge. You can store property values as a table or list of values, a constant value, or a calculated value. For more information, see Part Sizes on page 119.

You can assign added data parameters to a property set to enhance a schedule. To ensure that the parameter is recognized, you must use same name for both the data parameter and the property in the property set. You can add custom properties to any property set in a drawing. You can also create custom property
sets based on new parts you create and the custom data parameters you add to the parts. For more information, see Collecting Project Data on page 874.

**Workflow for Creating a Block-Based Part**

This workflow provides a road map for creating a block-based part using Content Builder.

**NOTE** For more information about part catalogs and their hierarchical structure, see How Catalog Parts are Stored and Referenced on page 117.

<table>
<thead>
<tr>
<th>Review the steps</th>
<th>View more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a 3D model and schematic symbol of your part.</td>
<td>Before you start Content Builder, you must draw a 3D model block for each new part size and save it as an AutoCAD block in a drawing file. You should also create a 2D schematic symbol block to represent the part family. See Creating a 3D Model and Schematic Symbol for a Block-Based MvPart on page 1127.</td>
</tr>
<tr>
<td>Open the Parametric Building Environment to start building content.</td>
<td>You use the Content Builder in AutoCAD MEP to create a block-based part. See Starting Content Builder for Creating a Block-Based MvPart on page 1131</td>
</tr>
</tbody>
</table>
| Define the catalog information and behavior of your part. | You work in the block-based building environment of Content Builder to define part sizes based on the 3D model blocks you created previously. In this environment, the individual part sizes are associated with a part family in a catalog to build a library of parts. You specify a catalog, location, and part name. You also specify the type and behavior of the part family. All part
sizes within a part family are defined as the same type and are placed in your drawing with the same behavior. See Defining the Part Behavior of a Block-Based MvPart on page 1132.

You define part size names, generate 2-dimensional (2D) orthographic views from the 3D model, and assign them to the appropriate view direction of the part size. You also assign to each part size the 2D schematic symbol you created previously. See Assigning Part Size Names and Views of a Block-Based MvPart on page 1133.

You assign a preview image for the part family. You can attach a pre-defined bitmap (BMP) image or have an image generated from the 3D model block. All part sizes in the part family use the same preview image. The preview image helps to identify the part during part selection. See Generating a Preview Image of a Block-Based MvPart on page 1135.

You add connectors so that the part can connect intelligently to other building systems objects in your layout. You assign connectors to the part family, and specify the shape and domain for each connector. Therefore, all part sizes have the same number of connectors predefined with a shape and domain. The shape and domain of a connector can be changed only for the entire part family; however, the size and location of connectors can change for each part size. See Adding Connectors to a Block-Based MvPart on page 1136.
Review the steps

Add property set information to each part.

View more information

You can specify custom data that can be used as property set information for each part size. In turn, the property set information can be used to enhance schedules that you generate during design layout. See Adding Property Set Information to a Block-Based MvPart on page 1139.

Creating Block-Based Parts Using Content Builder

You can create block-based MvParts, such as air handling units and other complex equipment, with Content Builder. The following sections contain step-by-step procedures to help you create an air handling unit MvPart using Content Builder. Each section represents a separate phase in the creation process; therefore, you should carefully step through the sections in the following order to avoid creating unusable parts.

IMPORTANT MvPart Builder, the content creation tool available in previous releases of AutoCAD MEP products, has been integrated into Content Builder. MvPart Builder now exists as the block-based building environment within Content Builder, which you use to create block-based MvParts.

Creating a 3D Model and Schematic Symbol for a Block-Based MvPart

Before starting Content Builder to create a block-based part, you must draw a 3D model on page 1113 block for each new part size of the part family you want to create. Save the part size models as AutoCAD blocks. You should also create a 2D schematic symbol on page 1115 block that represents the part family. All 3D model blocks for the individual part sizes and the schematic symbol for the part family must be saved in the same drawing file.

Creating a 3D Model for a Block-Based MvPart

Use this procedure to create a 3D model for a block-based MvPart. To support automatic generation of view blocks by Content Builder, the model block must be created using AutoCAD® solids in the standard AutoCAD world coordinate system (WCS).
NOTE To ensure correct hidden line display when placing the MvPart in a drawing, be sure to create a single body using AutoCAD solids for the model for the part.

1 Create the 3D model of the part size.

2 To add points on your model to help locate connectors, enter point, press ENTER and, using object snaps, select the center of a connector on the 3D model. Add AutoCAD point objects in the location of the center of all connections. This lets you use Node object snaps to select the connection points when assigning connectors.

3 Click View tab ➤ Coordinates panel ➤ World to set the user coordinate system (UCS) to World before making a block. For more information about coordinate systems, see Control the Display of the User Coordinate System Icon.

4 Verify that the geometry is drawn on layer 0 and is assigned BYBLOCK for color and linetype, and BYLAYER for lineweight. This helps to ensure display control for the part size.

5 Click Insert tab ➤ Block panel ➤ Create Block. The Block Definition dialog is displayed.

6 In the Block Definition dialog, enter a name for the model block. Use a standard naming convention that represents the part family and part size as you save your model block. For example, a model block for a roof-mounted air handling unit for a commercial building, with an outlet size of 24 x 24 inches, could be named AHU Commercial Roof 24x24 model.

7 Under Objects, click the Select Objects option, and then select the geometry that will make up the model block.
8 Under Objects, select one of the following options:

- **Retain.** Keeps selected objects in the current drawing in their original state.
- **Convert to Block.** Replaces selected objects with an instance of the block.
- **Delete.** Removes selected objects after the block is defined.

9 Under Base Point, click the Pick Point option and select the model block insertion point.

The insertion point, or base point, is used as a reference for positioning the block. The location of the insertion point directly affects the placement of the part size when you add it to your drawing.

10 Under Description, enter text to help identify the view block for easy retrieval.

11 To attach a hyperlink to the part, click Hyperlink, select a file or web page, and click OK twice.

The model block is saved in the current drawing.

---

### Creating a 2D Schematic Symbol for a Block-Based MvPart

Use this procedure to create a 2D schematic symbol for a block-based MvPart. You can use any drawing command to make the geometry for the block. It is recommended that all geometry be created using base AutoCAD® entities such as lines, polylines, or circles.

**WARNING.** Be careful when using AEC-based geometry, such as walls or ducts, to create your symbol. To avoid object enabler problems, be sure to explode the geometry to base AutoCAD entities before running Content Builder.

To ensure correct display control of your symbol when added to your drawings, draw all geometry for the symbol on layer 0. Assign BYBLOCK for color and linetype, and BYLAYER for lineweight.
1 Click View tab ➤ Coordinates panel ➤ World, and draw the symbol view of the part.

The symbol block is used as a 2D representation of the part size; therefore, it is recommended that the symbol block be drawn to represent the 2D symbol of the modeled object in plan view.

2 Verify that the geometry for the symbol is drawn on layer 0 and is assigned BYBLOCK for color and linetype, and BYLAYER for linewidth. This helps to ensure display control for the part size.

3 Click Insert tab ➤ Block panel ➤ Create Block. The Block Definition dialog is displayed.

4 In the Block Definition dialog, enter a name for the symbol. Use a standard naming convention that represents the part family as you save the symbol as a block. For example, the symbol block for a roof-mounted air handling unit for a commercial building, with an outlet size of 24 x 24 inches, could be named AHU Commercial Roof 24x24 symbol.

   **TIP** Name the symbol block “symbol” to have Content Builder by default use the symbol block as the source for generating the 3D symbol.

5 Under Objects, click the Select Objects option, and then select the geometry that will make up the symbol block.
The dialog closes temporarily while you select objects for the symbol block. Press ENTER when you finish selecting objects. The dialog reopens.

6 Under Objects, select one of the following options:
   ■ **Retain**. Keeps selected objects in the current drawing in their original state.
   ■ **Convert to Block**. Replaces selected objects with an instance of the block.
   ■ **Delete**. Removes selected objects after the block is defined.

7 Under Base Point, click the Pick Point option and select the block insertion point.
   The insertion point, or base point, is used as a reference for positioning the block.

8 Under Description, enter text to help identify the symbol block for easy retrieval.

9 To attach a hyperlink to the part, click Hyperlink, select a file or web page, and click OK twice.
   The symbol block is saved in the current drawing.

**RELATED**  For more information, see Block Definition Dialog Box.

---

**Starting Content Builder for Creating a Block-Based MvPart**

Use this procedure to start Content Builder and open the block-based building environment.

1 Open the drawing file that contains the 3D model block(s) of the part you want to create.
   Each part size requires a unique 3D model block. You can have one or more model blocks in a single drawing file that represent each part size in a part family.

2 Click Manage tab ➤ MEP Content panel ➤ Content Builder ➤ .
   The Getting Started - Catalog Screen dialog is displayed.

3 Select Multi-view Part for Part Domain.
In the tree view, select a chapter to add the new MvPart to, and click .
The New Part dialog is displayed.

Enter a name and description for the part family, and click OK.
By default, the description is the same as the name until you change it.
The block-based building environment is opened. For more information, see Approaches to Creating Parts on page 960.

**Defining the Part Behavior of a Block-Based MvPart**

Use this procedure to define the part behavior of a block-based MvPart by specifying the type, subtype, layer key, and method of insertion for all part sizes of the MvPart. For more information, see Behavior of a Block-Based Part on page 1116.

1 Select a type from the list.
   Type refers to the main category for the part family; it defines unique characteristics and behaviors for part sizes, such as the ability to assign flow annotation to an HVAC part size. Types are predefined by the application and cannot be modified; therefore, select a type that is similar to the part sizes.

2 To define a layer key for the new part sizes, click next to Layer Key.
3 In the Select Layer Key dialog, select a layer key and click OK.
The layer key list reflects the set of layer keys currently assigned in your drawing, based on the previously selected layer standard and layer key style. To ensure the best possible layering of part sizes, select a layer key that matches the part type.

4 For Subtype, select a subtype from the list, or enter a new subtype.
   Subtype is the subcategory for the part family; it is useful for grouping similar parts. The subtype can be used as a filter method for part selection in the MvPart Add command. Therefore, you should select or specify a descriptive subtype name for easy identification.
5 Select one, both, or none of the following options:

■ This part family automatically BREAKS INTO existing runs. A part size breaks into a run when you add it to your layout. The components remain as individual components. For example, you can move the value without moving either of the connecting pipe segments.

Adding a valve to a pipe segment

■ This part family automatically ANCHORS to existing runs. A part size anchors to a run when you add it to your layout. The components act together as one when anchored. For example, if you move the duct run, the louver moves with it.

Adding a louver to a duct segment

6 Click Next.

If Next is unavailable (shaded), information is missing on this page. Verify that you have completed steps 1 through 5.

Assigning Part Size Names and Views of a Block-Based MvPart

Use this procedure to add part sizes and assign view blocks on page 1119 to the individual part sizes for the MvPart. You can specify a unique name for each
part size. The part size name typically reflects the actual size of the part, such as width and height dimensions or the total cubic-foot-per-minute (cfm) output. It is used for part selection in the MvPart Add dialog. The part size name is also used in the part catalogs and appears as the object name when using tooltips. Therefore, you should specify a descriptive part size name for easy identification.

View blocks are generated and assigned by default for part sizes that are assigned a 3D model block whose name has a suffix of “model”; for example, AHU Commercial Roof 24x24 model. Unassigned view blocks display as empty fields. View blocks that display in red have been assigned a name based on the 3D model block; however, they are missing a defined block. You can assign a view block or generate the missing view blocks using Content Builder. Content Builder generates the 6 standard AutoCAD® view blocks (top, bottom, left, right, front, and back) from the 3D model block. It is possible to assign the same view block to multiple view directions, such as front and back, depending on part symmetry. You also assign to the part family the 2D symbol block you created previously to be used to generate a 3D symbol for each part size. The views determine how the individual part size is displayed in your drawing.

**NOTE** View blocks can be generated for multiple part sizes at one time. You can add multiple part sizes and then generate the missing view blocks for all part sizes.

1 To add a new part size, select a 3D model block and click .

   The list of 3D model blocks reflects the blocks in the active drawing.

   A new part size is added to the part family, and a new row appears in the table. View blocks are assigned by default when the 3D model block name has a suffix of “model.” Assigned view blocks with associated blocks display in black. Any view block assigned a name based on the 3D model block but missing a block displays in red. All unassigned view blocks display as empty fields.

2 Select a 2D symbol block from the list of blocks in the active drawing to be used to generate a 3D symbol block for each part size.

   The 3D symbol blocks are assigned to the schematic views for each part size.

   **NOTE** A schematic symbol is not required. If you do not want to assign a schematic symbol, select None.
3 To create the missing view blocks for those block names that display in red, click Generate Blocks.

The Views dialog is displayed.

View blocks are generated and named based on the associated 3D model block. View block assignments are defined based on the standard display representations and view directions; however, you can change them as needed.

**NOTE** The symbol block is used in Isometric mode and is displayed as a 3D bounding box of the model block with 2D symbology to represent the part itself.

4 To make changes to a view block assignment for a part size, select a part size name, select a view number (#) under Views, and change the Display Representation and View Direction options as necessary.

Repeat for each view block assignment you want to change.

5 Click OK.

The new part size is updated with the generated view blocks.

6 To delete a part size, select the Part Size Name and click .

The selected part size is deleted from the part family, and the associated row is removed from the table.

7 Click Next.

If Next is unavailable (shaded), information is missing on this page. Verify that each part size has a defined name and that all view blocks display in black.

---

**Generating a Preview Image of a Block-Based MvPart**

Use this procedure to generate or assign a preview image to the part family of the MvPart. You can assign an existing bitmap image or have Content Builder generate one based on the 3D model of the specified part size. The same preview image is used for all part sizes of an MvPart. For more information, see *Preview Image of a Block-Based Part* on page 1121.

1 To assign an existing image, click Select a previously drawn image, and click .
The Select Image File dialog is displayed.

2 Browse to select a bitmap image.
   The specified path and name of the image are displayed. The image itself is displayed in the image window.

3 To generate an image, click Generate an image based on a model block from the SW Isometric View.

4 Select a model block from the list.

5 Click Generate.
   A preview image is generated from the model block and assigned to the part family. The image is a shaded, SW isometric view of the model block. However, no text or dimensions are added. The image is displayed in the image window.

6 Click Next.
   If Next is unavailable (shaded), information is missing on this page. Verify that you have selected a preview image for the part family.

## Adding Connectors to a Block-Based MvPart

Use this procedure to add connectors to a block-based MvPart. Defining connectors allows the part size to be connected intelligently to other building systems objects in a drawing. You can define one or more connectors for each part size of an MvPart. You can assign each connector unique part properties, such as domain, system type, shape, and size. Generally, a part has at least one connector. However, you can create a part that has no connectors. For more information, see Connectors of a Block-Based Part on page 1122.

### IMPORTANT

The size and shape of every connector for a part size can be different. However, the number of connectors must be the same for all part sizes of an MvPart.

1 To add a connector, from the tree view of the part family and sizes, right-click the part family, and select the type of connector.

---

**Shows example of context menu for part family**

<table>
<thead>
<tr>
<th>Add Cable Tray Connector...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Conduit Connector...</td>
</tr>
<tr>
<td>Add Duct Connector...</td>
</tr>
<tr>
<td>Add Pipe Connector...</td>
</tr>
</tbody>
</table>
The Part Family Connector Properties dialog is displayed.

Part Family Connector Properties dialog

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Name</td>
<td></td>
</tr>
<tr>
<td>Flow Direction</td>
<td>Bidirectional</td>
</tr>
<tr>
<td>System Type</td>
<td>Undefined</td>
</tr>
<tr>
<td>Connection Domain</td>
<td>Last</td>
</tr>
<tr>
<td>Connection Shape</td>
<td>Rectangular</td>
</tr>
<tr>
<td>Unsized</td>
<td>False</td>
</tr>
</tbody>
</table>

2 Specify a value for each of the properties and click OK:

<table>
<thead>
<tr>
<th>To specify the…</th>
<th>then click the value cell and…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>enter a descriptive name.</td>
</tr>
<tr>
<td>Connection Shape</td>
<td>select a shape from the list. The available shapes are dependent on the domain of the connector.</td>
</tr>
<tr>
<td>additional properties, such as Flow Direction</td>
<td>select from the list. Additional properties that are available are dependent on the domain of the connector.</td>
</tr>
<tr>
<td>Unsized</td>
<td>select True or False. Selecting True allows the connector to be unsized and valid connections to be made with unsized segments.</td>
</tr>
</tbody>
</table>

These properties are assigned to the connector for all part sizes.

NOTE The connector domain is based on the type of connector selected and cannot be changed in the properties dialog. Also, the Unsized value cannot be changed once the connector is defined.

3 To edit connector properties, right-click a connector, and click Edit Placement.
A property palette is displayed.

**Example of connector property palette**

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector Name</td>
<td></td>
</tr>
<tr>
<td>Connection Name</td>
<td>Outlet</td>
</tr>
<tr>
<td>Flow Direction</td>
<td>Bidirectional</td>
</tr>
<tr>
<td>System Type</td>
<td>Undefined</td>
</tr>
<tr>
<td>Connector Domain</td>
<td>Duct</td>
</tr>
<tr>
<td>Connection Type</td>
<td>Undefined</td>
</tr>
<tr>
<td>Connection Shape</td>
<td>Rectangular</td>
</tr>
<tr>
<td>Connection Position</td>
<td>0,0,0</td>
</tr>
<tr>
<td>Connection Normal</td>
<td>0,0,1</td>
</tr>
<tr>
<td>Connection Rotation</td>
<td>0</td>
</tr>
<tr>
<td>Rectangular Connectors</td>
<td>15</td>
</tr>
<tr>
<td>Rectangular Connectors</td>
<td>15</td>
</tr>
</tbody>
</table>

4 Specify the connector properties:

**To specify the...**  **then...**

- position of the connector
  - enter \( p \) (position), or click \( \ldots \) for Connection Position, and select a point on the model. The connection position is updated in the palette. If you added object point to the model at the locations of the connectors, use the Node object snap to snap to the location.

- direction to draw connecting components by a single point
  - enter \( n \) (normal), or click \( \ldots \) for Connection Normal, drag the cursor in the correct direction, and select a point. The connection normal is updated in the palette. To ensure that components are connected perpendicularly to the part,
To specify the... then...

use AutoCAD’s Ortho mode to restrict the cursor when selecting the direction.

direction to draw connecting components by 2 points enter n (normal), select the first point, and then select the second point. The connection normal is updated in the palette.

type of connection in the property palette, select a type for Connection Type.

rotation of the connector in the property palette, enter a number of degrees for Rotation. Typically, the rotation value is 0 (zero).

size of the connector in the property palette, enter a number for the size properties. The size properties vary depending on the shape of the connector.

5 Click OK, and then click Next.

**Adding Property Set Information to a Block-Based MvPart**

Use this procedure to add property set information to a block-based MvPart. Property set information is optional. Therefore, you can click Finish to complete the creation of your part without adding property set information. For more information, see Property Set Information for a Block-Based Part on page 1124.

1 In the MvPart Builder dialog, select the part family or an individual part size, and click Edit Properties.
   The Property Editor dialog is displayed. Parameters for CEL (connection engagement length) and AoD (angle of deflection) appear in the Block-Based Parameter Configuration, allowing a change to the Data Storage and Visibility values under Attribute.

   **NOTE** CEL and AoD only appear for pipe connectors, not for connectors in other domains.
2 To add custom data, on the toolbar in the Property Editor dialog, select Parameter Configuration from the list, and click (New). The New Parameter dialog is displayed.

3 Select a new parameter, or select Custom Data 1 and enter a name, and then click OK. A new parameter column is added as the last column. You may need to scroll over to view the added column.

4 To specify the parameter attributes, click the appropriate cell, and select or enter a new value. You can change the data storage, data type, units, visibility, and description. For more information, see Part Sizes on page 119.

**NOTE** The default data storage type for the PrtSN (Part Size Name) attribute is Table; however, you can change the data storage type to Calculation. Defining the PrtSN attribute as a calculated value enables you to define the name of each part size based on the values of other attributes, such as height and width, and provides additional options in the Blocks & Names section of the block-based building environment.

5 To add a list of values, do the following:
   - Select List for Data Storage, and then select Values on the toolbar.
Click the custom data value cell, and click on the toolbar. The Edit Values dialog is displayed.

- Click Add and enter a new value.
- When you finish adding values, click OK.

6 To add a constant value, do the following:
- Select Constant for Data Storage, and then select Values on the toolbar.
- Double-click the custom data value cell, and enter a value.

7 To add a calculated value, do the following:
- Select Calculation for Data Storage, and then select Calculations on the toolbar.
- Double-click the custom data value cell and, in Calculation Assistant, enter an equation to be used to calculate the value.

8 To add a table of values, do the following:
- Select Table for Data Storage, and then select Values on the toolbar.
- Double-click the custom data cell value for each part size row, and enter a unique table value.

9 When you are finished editing properties of the part sizes, click OK.

NOTE You can also edit the values of custom data attributes on the Properties page of MvPart Builder. Select a part size in the tree view, click Value and enter a new attribute value.

10 Click Finish.

The part is saved and added to the catalog in the specified location.

Modifying Block-Based Parts Using Content Builder

You can use Content Builder to modify an existing block-based part. You can modify the entire part family or an individual part size. Once the part has been saved to a catalog, any modifications you make using Content Builder are made directly to the source files stored in the catalog. You can modify the
3D model block and/or symbol; you can also modify the model and schematic symbol of the part size. You can redefine a part size based on a new 3D model block and reassign the schematic symbol of a part size based on a new symbol block.

**NOTE** When you modify existing part sizes in a part catalog, your changes apply only to part sizes that you add to a drawing after the part catalog is modified. Part sizes existing in a drawing are not affected. You should use Content Builder to modify individual part sizes wherever possible.

### Starting Content Builder for Modifying a Block-Based Part

Use this procedure to start Content Builder and open the block-based building environment for modifying a block-based part.

**IMPORTANT** When adding new part sizes to an existing part family, you must add the new 3D model blocks to the existing DWG file for the part family prior to starting Content Builder. The DWG files for a catalog part are stored in the `\ProgramData\Autodesk\MEP 2011\enu\Tool Catalogs` folder, in the appropriate part catalog subfolder. For example, to add a new part size to the Gas Fired Roof Mounted AC Unit, add the new 3D model block to `\ProgramData\Autodesk\MEP 2011\enu\MEPContent\USI\MvParts\Mechanical\Roof Mounted AC Units`.

1. Click Manage tab ➤ MEP Content panel ➤ Content Builder.
   
   The Getting Started - Catalog Screen dialog is displayed.

2. In the tree view, navigate to and select a block-based part.

3. To add a new part size to an existing part, click .
   
   The block-based building environment is opened and the MvPart Builder (Add Part Size) dialog is opened. The process is the same as that of creating a new part.

   **IMPORTANT** The 3D model blocks created for the new part sizes must exist in the part family DWG file stored in the catalog.

4. To modify a part, click .
   
   The block-based building environment is opened and the MvPart Builder (Modify Part Size) dialog is displayed. This dialog has tabs
that enable you to change only what you need to change, in any order.

5 To delete a part, click .

The selected part family is deleted from the part catalog, including all associated definition files (XML file, DWG file, and BMP file).

Modifying a Block-Based Part

As your design develops and parts change, you can add new part sizes or modify existing part sizes using Content Builder. When you add a new part size, you are guided through the process step by step. When you modify an existing part size a tabbed dialog enables you to change only what you need to change. For more information, see Approaches to Creating Parts on page 960.

For each part size, you can change the 3D model block, schematic symbol, part behavior, view blocks, preview image, connectors, and property set information. You can use the same procedures that guide you through creating a block-based part to modify it. This section outlines how you can modify a block-based part and provides references to related procedures that you can use.

Modifying the 3D Model Block and Schematic Symbol

You can change the 3D model block of an individual part size. You can edit the existing 3D model block or create a new 3D model block for one or more part sizes. Changing the 3D model block requires that you regenerate the view blocks for the part size to ensure the correct display of the part in a drawing. For more information, see Creating a 3D Model for a Block-Based MvPart on page 1127.

You can also change the schematic symbol that is assigned to the part size or attach a new schematic symbol. When you change the schematic symbol, you are changing it for all part sizes in the part family. For more information, see Creating a 2D Schematic Symbol for a Block-Based MvPart on page 1129.

NOTE All changes must be made in the part family DWG file stored in the part catalog prior to starting Content Builder. When modifying an existing 3D model block, modify the block stored in the part family DWG file. When replacing an existing 3D model block with a new 3D model block, delete the existing block and then add the new block in the part family DWG file.
Modifying the Part Behavior

You can change the part behavior that defines how the part is added to a drawing, including type, subtype, layer key, and insertion method. You can make changes to a single part size or to multiple part sizes. For more information, see Defining the Part Behavior of a Block-Based MvPart on page 1132.

NOTE Avoid making changes in the Behavior tab or page in the parametric part wizard unless you want to change the behavior of the part family. Any changes you make to the part family affect every part size for that part.

Modifying the Part Size Name and View Blocks

You can change the part size name and view blocks that are used to display a part size in a drawing. When you change the 3D model block of a part size, you must regenerate the view blocks based on the new model block to ensure correct display. It is possible to assign the same view block to multiple view directions, such as front and back, depending on the part symmetry. You can also manually create individual view blocks for a part size and attach them accordingly. For more information, see Assigning Part Size Names and Views of a Block-Based MvPart on page 1133.

Modifying the Preview Image

You can change the preview image of the part size. In doing so, you change the preview image for all part sizes in the selected part family. You can regenerate a preview image based on a new 3D model block, or attach a predefined image. For more information, see Generating a Preview Image of a Block-Based MvPart on page 1135.

Modifying the Connectors

You can add, delete, and edit the connectors of a part size. You can change the size, type, and location of the individual part size connector; however, the shape and domain are determined by the associated connector defined for the part family. When you delete a connector, you are deleting the connector for all part sizes in the part family. When you add a connector, you are adding a connector to all part sizes in the part family. For more information, see Adding Connectors to a Block-Based MvPart on page 1136.

IMPORTANT The size and shape of every connector for a part size can be different. However, the number of connectors must be the same for all part sizes of a part.
Modifying the Property Information

You can change the property information of a part size. You can add, delete, and edit custom properties for a part size. When you add a custom property, you are adding a custom property to every part size in the part family. You can modify custom property values as needed to enhance schedule data for the parts in your drawing. For more information, see Adding Property Set Information to a Block-Based MvPart on page 1139.

Working with Custom Parameter Groups

Custom parameters store additional, user-defined information about a part, such as manufacturer or product information.

If you have a set of custom parameters that are common to multiple parts, you can create the custom parameters for one part, save the parameters as a group in a Microsoft® Excel® file, and then retrieve the group whenever you need to add the same parameters to additional parts.

Saving Custom Parameters in Groups

When you save a group of custom parameters in a Microsoft® Excel® (XLS) file, you can save parameter attributes as well as parameter values.

NOTE Once you become familiar with how this feature saves the customer parameter data in an XLS file, you can also create the files manually by copying the format. If you do so, make sure to use only the first worksheet in the XLS file. When you add saved parameters to parts, the software reads only the data on the first worksheet.

To save a set of custom parameters

1 In Content Builder, open the part that contains the custom parameters that you want to save.

For information on adding custom data to parts using Catalog Editor, see Adding Custom Data to Parts in Catalog Editor on page 1160. For information on adding custom data to parts using Content Builder, see Sizes of a Parametric Part on page 996 or Adding Property Set Information to a Block-Based MvPart on page 1139.
2 Depending on the type of part, do one of the following:

- If the part is parametric, in the part browser, right-click Size Parameters, and click Edit Configuration. Then, in the Size Parameters dialog, click (Save Custom Parameter Group).

- If the part is block-based, in the MvPart Builder dialog, click the Properties tab, and click Edit Properties. Then, in the Property Editor dialog, click (Save Custom Parameter Group).

The Save a Custom Parameter Group dialog is displayed. It lists all of the custom parameters that have been added to the part that is currently open.

**Save a Custom Parameter Group dialog**

3 Specify the parameters to save as a group:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>save a custom parameter</td>
<td>Select Save in Group for that parameter. You can also click Select All to save all of the custom parameters in the group.</td>
</tr>
</tbody>
</table>
If you want to… | then…
---|---
save the current value for a custom parameter | Select Yes for Save Value(s) for that parameter. This saves the value for the part that is currently open.
not save the value for a custom parameter | Select No for Save Value(s) for that parameter.

4 For File name, specify the file name and location of the XLS file in which to save the group of custom parameters.

**NOTE** The file is saved in a default MEP Parameter Groups subfolder. However, you can optionally browse to a different folder location, such as a project-specific folder.

If you specify the file name and location of an existing file, the custom parameters in the file are overwritten with your current selections.

5 Click OK.

**Adding Groups of Saved Custom Parameters to Parts**

1 Create or open the part to which you want to add a group of saved custom parameters. For help with this step, see Working with Parametric Parts on page 970 or Working with Block-Based Parts on page 1110.

2 Depending on the type of part, do one of the following:
   - If the part is parametric, in the part browser, right-click Size Parameters, and click Edit Configuration. Then, in the Size Parameters dialog, click ![Insert Custom Parameter Group](image).
   - If the part is block-based, in the MvPart Builder dialog, click the Properties tab, and click Edit Properties. Then, in the Property Editor dialog, click ![Insert Custom Parameter Group](image).

3 In the Open dialog, select the Microsoft® Excel® (XLS) file that contains the group of custom parameters.

4 Click Open.
The software adds the custom parameters in the selected file to the part. If the part already has a parameter with the same name as a parameter stored in the file, the parameter in the file is not added to the part.

If the file contains saved values for the parameters, the values are also added to the part.

**Testing Parts Created with Content Builder**

It is important to test each part size before using it in your drawings. You should verify the insertion point, all view representations, and each connector. If testing produces undesirable results, you should modify and retest the appropriate part sizes. Although testing can be a tedious process, following the guidelines presented here will verify that your part sizes work correctly for AutoCAD MEP.

**Testing the Display Representations of a Part**

Depending on whether you test part sizes in a drawing started from scratch or from a template, you verify accurate view representations in 1 of 2 ways: by scrolling through the various display configurations in a viewport, or by scrolling through the various layout tabs in a template. You should see representations on the Model tab similar to the following as you change display configurations for the viewport.

![Graphical representation of display configurations](image)

*TIP* To quickly change display configurations for a viewport, select a display configuration from the list in the bottom-right corner below the drawing area.

**Testing the Connectors of a Part**

Testing every connector is necessary to ensure that the part size can connect intelligently to other building systems objects. Connectors are shown as graphical objects representing the size, shape, and location of connection points on a part size in your drawing. If the connection positions were assigned.
correctly, they should match the model block geometry of the part size. If the connection positions were not assigned correctly, the connectors may appear as graphical objects floating in space. To verify the connection position of each connector, snap to the correct location and connect a segment. A valid connection should be made and you should be able to continue to draft the run.

It is also important to test the connection direction vectors. To do this, you connect a valid building systems object to every part connector for each part size and draft a run. Verify that the default direction of the Compass lets you lay out the building systems objects in the correct direction away from the part size.

**Testing the View Block Orientations of a Part**

Once each view block for a part size has been assigned, you should verify that the part display is correct for each view. When view blocks are generated, you add your part to a drawing based on the AutoCAD MEP template, and scroll through the layout tabs to verify that the display of the part is correct. However, if you created the view blocks from scratch and saved them as individual AutoCAD® blocks, you use a different method to verify the display of the view blocks. Using the SW Isometric view, insert each view block at an insertion point of 0,0,0 in the WCS. Each view block should align to the respective side of the model block as follows:

<table>
<thead>
<tr>
<th>The...</th>
<th>aligns with the...</th>
<th>in the...</th>
</tr>
</thead>
<tbody>
<tr>
<td>top view block</td>
<td>top side of the model block</td>
<td>XY plane.</td>
</tr>
<tr>
<td>bottom view block</td>
<td>bottom side of the model block</td>
<td>XY plane.</td>
</tr>
<tr>
<td>front view block</td>
<td>front side of the model block</td>
<td>XZ plane.</td>
</tr>
<tr>
<td>back view block</td>
<td>back side of the model block</td>
<td>XZ plane.</td>
</tr>
<tr>
<td>left view block</td>
<td>left side of the model block</td>
<td>YZ plane.</td>
</tr>
<tr>
<td>right view block</td>
<td>right side of the model block</td>
<td>YZ plane.</td>
</tr>
</tbody>
</table>
Customizing Catalogs

The default part catalogs provided with AutoCAD MEP include an array of common industry parts.

The Catalog Editor is a standalone utility with Windows® Explorer-like navigation that provides a central location for viewing and working with the default part catalogs, and creating new ones. Use the Catalog Editor to:

- Create a new catalog from an existing catalog
- Create a new catalog from scratch
- Reorganize a part catalog by renaming chapters and moving parts
- Browse available parts
- Create a new part from an existing part
- Add part sizes
- Add custom part properties
- Copy and paste, or drag and drop, part data between catalogs
- Edit part data in Microsoft® Excel

The Catalog Editor provides the flexibility to create and modify part catalogs to meet your company or project requirements. Because the Catalog Editor is a standalone utility, you can access it from inside or outside AutoCAD MEP.

**NOTE** To create new parts from scratch, use Content Builder.
About Catalog Editor

The Catalog Editor user interface is divided into 2 resizable panes—a navigation pane and a details pane—and has a menu bar, a toolbar, and a preview image window.

Example of Catalog Editor

Navigation Pane

The navigation pane on the left organizes the open catalog into a structured tree view that you can navigate by expanding and collapsing the different chapters in the tree.

You can add, delete, copy, paste, and save part data in the tree view. As you select items in the tree view, the software updates the details pane on the right accordingly. For more information about the structure of a part catalog, see *How Catalog Parts are Stored and Referenced* on page 117.
Details Pane
The right pane of Catalog Editor displays a table view of the part data for the part selected in the navigation pane. The table view displays the data in its most primitive, or “uncompiled” form. Each column represents a specific parameter that is used to define the part. Each row represents an attribute description or unique value of the parameter. For clarity, different background colors differentiate the various types of part data.

Parameter attributes determine how the parameter values are used in defining the part. For example, parameter attributes define the type of parameter and the dimensional units of the parameter’s values.

Preview Image Window
The preview image window in the lower-left corner of the Catalog Editor displays the part as a rendered 3-dimensional (3D) image. Parameters that define the part are referenced as dimensions.

Menu Bar and Toolbar
The menu bar and toolbar at the top of the Catalog Editor provide quick access to commands. If you position your pointing device over a toolbar icon, the software displays a tooltip that describes the command associated with the icon.

Opening Catalog Editor
You can open the Catalog Editor from inside or outside of AutoCAD MEP.

RELATED For more information on Catalog Editor, see About Catalog Editor on page 1152.

To open the Catalog Editor from inside AutoCAD MEP

➤ Click Manage tab ➤ MEP Content panel ➤ Catalog Editor.

To open the Catalog Editor outside of AutoCAD MEP

1 On your desktop, open My Computer.
2 Navigate to the \Program Files\AutoCAD MEP 2011 folder.
3 Double-click AecbCatalogEditor.exe.
Opening a Part Catalog in Catalog Editor

1. Open the Catalog Editor.

2. In the Catalog Editor, click ➤ . Alternatively, click File menu ➤ Open.

3. Navigate to the \ProgramData\Autodesk\MEP 2011\enu\Tool Catalogs folder, double-click a catalog folder, and then double-click the Autodesk product catalog (APC) file to open it.

Customizing Catalogs in Catalog Editor

Catalog Editor enables you to work with part data in a spreadsheet fashion within the tree view and the table view.

IMPORTANT If you make changes and then change your mind, you can click Edit menu ➤ Undo to remove your changes and restore the original data.

You can access commands by right-clicking catalogs, chapters, and part families in the tree view; or rows, columns, and cells in the table view. You can also access commands from the Edit menu, and you can cut, copy, and paste using the standard keyboard shortcuts:

- **CTRL+X** for cut
- **CTRL+C** for copy
- **CTRL+V** for paste

In addition, you can drag and drop to move or copy a chapter or part family between chapters or catalogs.

NOTE You can copy and paste, or drag and drop, chapters or part families between catalogs when multiple sessions of Catalog Editor are open.
Working with Part Data in the Tree View

When you work with part data in the tree view of Catalog Editor, the functionality available to you depends upon the type of part data that you select.

You can cut, copy, paste, rename, and move chapters and part families. You can also insert new chapters, and copy and paste part data between catalogs. When you copy and paste a chapter, Catalog Editor copies and pastes the entire chapter including its part families. You can rename the chapter or part family when you paste it into another catalog or accept the predefined (default) name.

Catalog
When selecting a part catalog in the tree view, you can:

■ Insert a chapter.
■ Rename the part catalog description.

Chapter
When selecting a chapter in the tree view, you can:

■ Insert a chapter.
■ Rename the chapter.
■ Cut, copy, and paste the chapter.
■ Delete the chapter.

Part Family
When selecting a part family in the tree view, you can:

■ Cut, copy, and paste the part family.
■ Rename the part family.
■ Delete the part family.
Part Sizes
When selecting a part type in the tree view, you can edit part size values displayed in the Content tab on the right pane:

- Cut, copy, and paste part size values.
- Edit part size values.
- Add and delete part size values.

Storage Type
When selecting a storage type (Basic Table, Constant Lists, Constants, Calculations) in the tree view, you can:

- Insert a custom data column.
- Insert a value row for a component part in a basic table.

Working with Part Data in the Table View
When you work with part data in the table view of Catalog Editor, the functionality available to you depends on the part type and storage type in which the part data is stored.

You can cut, copy, and paste part data between parameters and insert and delete parameter columns. You can also edit and delete parameter value rows and edit a limited number of parameter attribute cells. For more information about storage types, see Part Sizes on page 119.

Basic Table
For part data stored in a basic table, you can:

- Edit the name, description, units, data type, and visible attribute cells for custom data columns.
- Copy, paste, and edit value cells.
- Copy, paste, and delete value rows.
- Insert value rows from scratch and from copied data.
- Insert custom data columns from scratch and from copied data.
- Cut, copy, and delete custom data columns.
Constant Lists
For part data stored in constant lists, you can:
- Edit the name, description, units, data type, and visible attribute cells for custom data columns.
- Copy, paste, and edit value cells.
- Insert custom data columns from scratch and from copied data.
- Cut, copy, and delete custom data columns.

Constants
For part data stored as constants, you can:
- Edit the name, description, units, data type, and visible attribute cells for custom data columns.
- Copy, paste, and edit value cells.
- Copy the value row.
- Insert custom data columns from scratch and from copied data.
- Cut, copy, and delete custom data columns.

Calculations
For part data stored as calculations, you can:
- Edit the name, description, units, data type, and visible attribute cells for custom data columns.
- Copy, paste, and edit value cells.
- Copy the value row.
- Insert custom data columns from scratch and from copied data.
- Cut, copy, and delete custom data columns.

IMPORTANT Be careful when working with calculation formulas. Valid formulas depend on correct formula syntax and the existence of parameters used in the formula. Formulas are calculated in the order the parameters are presented in the table view from left to right. This enables the resulting value of a calculation to be used in a formula calculated later.
Creating Parts in Catalog Editor

You can create a new part using Catalog Editor only by copying an existing part and modifying its parameters. To create a new part from scratch, use Content Builder.

To create a part in Catalog Editor

1. If necessary, open the Catalog Editor, and then open the part catalog.
2. In the tree view, navigate to and select a part family name that is similar to the part you want to create, right-click, and click Copy.
3. Select the chapter in which to add the new part, right-click, and click Paste.
   The software adds a copy of the selected part family.
   
   **NOTE** You can also drag and drop the part between chapters.

4. To rename the new part family, right-click the copied part family name, click Rename, enter a name and a unique text description for that name, and press Enter.
5. In the table view, add or modify size parameter values, or add custom data, if needed. For more information, see Adding Part Sizes in Catalog Editor on page 1158 or Adding Custom Data to Parts in Catalog Editor on page 1160.

6. In the Catalog Editor, click ✂. Alternatively, click File menu ➤ Save.
   The software validates the new part and regenerates the catalog.

   **NOTE** To access the new part during part selection, be sure to load the modified part catalog in your drawing. For more information, see Specifying Part Catalogs and Style-Based Content Locations on page 100.

Adding Part Sizes in Catalog Editor

Use this procedure to add a size to a component, such as a duct, pipe, cable tray, or conduit segment. You can add size parameter values to a basic table or constant lists. For more information about storage types, see Part Sizes on page 119.
IMPORTANT To add a size to an MvPart, such as equipment, use the Parametric Part Wizard or Content Builder. You can also use Content Builder to add a size to a fitting. For more information, see Customizing Catalog-Based Content on page 957.

To add a size to a part in Catalog Editor

1 If necessary, open the Catalog Editor, and then open the part catalog.
2 In the tree view, navigate to the non-MvPart part you want to edit, and expand the part family to show the storage types.
3 Select the storage type of the part parameter to which to add a size.
4 In the table view, add a new parameter value:

<table>
<thead>
<tr>
<th>If you want to add a size to a...</th>
<th>then right-click a...</th>
</tr>
</thead>
<tbody>
<tr>
<td>basic table parameter</td>
<td>value row, and click Insert ➤ Row. A new value row is added above the selected value row.</td>
</tr>
<tr>
<td>constant lists parameter</td>
<td>value cell in the desired parameter column, and click Insert ➤ Cell. A new value cell is added above the selected value cell.</td>
</tr>
</tbody>
</table>

NOTE You can also modify any size parameter value, including calculation formulas. To change a constant value or calculation, click the parameter value cell in the table view and edit the value.

If you add a size and then change your mind, you can click Edit menu ➤ Undo to remove the new size.

5 Click the new parameter value cell and enter a size.
6 In the Catalog Editor, click ➤ . Alternatively, click File menu ➤ Save.

The software validates the new part and regenerates the catalog.

The software validates the part and regenerates the catalog.
NOTE To access the new part size during part selection, be sure to load the modified part catalog in your drawing. For more information, see Specifying Part Catalogs and Style-Based Content Locations on page 100.

Adding Custom Data to Parts in Catalog Editor

Custom data is a unique, user-defined parameter that you use to customize your parts. Custom data can be helpful if you want to expand scheduling data for a part, or access additional values to use in engineering calculations.

Before adding custom data, you must determine the storage type in which to store the custom data, depending on the uniqueness of the data.

<table>
<thead>
<tr>
<th>If the custom data...</th>
<th>then add the custom data to the...</th>
</tr>
</thead>
<tbody>
<tr>
<td>is a value that varies with other part size parameters, such as the material</td>
<td>basic table storage type.</td>
</tr>
<tr>
<td>is a list of values for the part, such as size dimensions</td>
<td>constant lists storage type.</td>
</tr>
<tr>
<td>is a single value that remains constant for all part sizes, such as the manufacturer</td>
<td>constants storage type.</td>
</tr>
<tr>
<td>is a calculated value for all part sizes, such as size dimensions dependent on other constant dimensions</td>
<td>calculations storage type.</td>
</tr>
</tbody>
</table>

For more information about storage types, see Part Sizes on page 119.

To add custom data to a part in Catalog Editor

1. If necessary, open the Catalog Editor, and then open the part catalog.
2. In the tree view, navigate to the part to which to add custom data, and expand the part family to show the storage types.
3. Select the storage type for the custom data parameter.
4. In the table view, right-click a cell, and then click Insert ➤ Column.
The software inserts a new custom data column to the left of the selected cell.

**NOTE** If you add a custom data column and then change your mind, click Edit menu ➤ Undo to remove the custom data parameter.

5 Enter values for Name and Description, and select a value for Units, Data Type, and Visible to define the attribute rows of the parameter.

6 Enter values for one or more value rows to define the custom data, depending on the storage type of the parameter.

7 In the Catalog Editor, click ![Save](https://example.com/save-icon). Alternatively, click File menu ➤ Save.
   The software validates the new part and regenerates the catalog.
   The software validates the part and regenerates the catalog.

### Creating Part Catalogs in Catalog Editor

You can create custom part catalogs in Catalog Editor. Custom part catalogs can serve as company-specific or project-specific catalogs. They can also be used to limit the number of available parts during part selection. It is recommended that custom part catalogs be created by a CAD manager or other user who is experienced with Catalog Editor.

To simplify catalog creation and to ensure that you create valid parts, create new parts by copying parts from an existing catalog into your new catalog and then modifying the part data.

**IMPORTANT** To facilitate the process of upgrading to a new version of AutoCAD MEP, your custom catalogs should contain all of your custom parts; do not add custom parts to the catalogs provided with the software. When you upgrade, this allows you to easily move all of your custom catalog content as a whole to the catalog folders for the new version (where new versions of the catalogs provided with the software are also located). You can use both types of catalogs during layout if you specify multiple catalogs for a domain, as described in **Specifying Part Catalogs and Style-Based Content Locations** on page 100.

To create a catalog in Catalog Editor

1 If necessary, open the Catalog Editor.
2 In the Catalog Editor, click \(\text{(New Catalog)}\) on the toolbar. Alternatively, click File menu ➤ New.

3 In the New Catalog dialog, define the new part catalog:

<table>
<thead>
<tr>
<th>To define the…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>domain type of the catalog</td>
<td>select a domain for Domain Name.</td>
</tr>
<tr>
<td>name of the catalog</td>
<td>enter a value for Catalog Name. The catalog name you specify is the name of the Autodesk product catalog (APC) file that you access through the MEP Catalogs tab in the Options dialog when you load the catalog into your drawing.</td>
</tr>
<tr>
<td>description of the catalog</td>
<td>enter a value for Catalog Description.</td>
</tr>
<tr>
<td>directory location of the catalog</td>
<td>browse to and select a directory location for Catalog Root Directory.</td>
</tr>
</tbody>
</table>

4 Click OK.

5 Customize the catalog:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then in the tree view…</th>
</tr>
</thead>
<tbody>
<tr>
<td>add a chapter</td>
<td>right-click the catalog or chapter, click Insert ➤ Chapter, enter a name, and press Enter.</td>
</tr>
<tr>
<td>copy a chapter or part</td>
<td>right-click the chapter or part, click Copy, and then right-click another chapter and click Paste. You can also copy and paste chapters and parts between part catalogs when multiple sessions of Catalog Editor are open. When you copy and paste a chapter, the Catalog Editor copies and pastes the entire chapter, including its part families.</td>
</tr>
<tr>
<td>move a chapter or part</td>
<td>right-click the chapter or part, click Cut, and then right-click another chapter and click Paste. You can also cut and paste…</td>
</tr>
</tbody>
</table>
Working with Part Data in Excel

You can copy and paste part data between Catalog Editor and Microsoft® Excel. Right-click a cell in Catalog Editor, click Cut or Copy, and then paste the part data into Excel for further manipulation, for use in part schedules, or for performing engineering calculations. You can also cut or copy part data from Excel and paste it into Catalog Editor. Part data can be selected by rows, columns, or individual cells by dragging the cursor over your selection.

When copying part data from Catalog Editor into Excel, you select one or more parameter values to copy, and the rows are pasted into the Excel spreadsheet in order. When copying part data from Excel into Catalog Editor, you select values from the spreadsheet, and they are pasted into the appropriate cells based on data type.

TIP You can also access commands from menus and the toolbar.

6 In the Catalog Editor, click Save. Alternatively, click File menu ➤ Save.

The software validates the new part and regenerates the catalog.
When you save the catalog, the software validates all parts in the entire catalog structure and then regenerates the catalog by updating the APC file. You can only use a part catalog in AutoCAD MEP if it has been regenerated successfully.
Validating and Regenerating Part Catalogs

It is important to validate the parts in your part catalogs to ensure the parts work correctly in AutoCAD MEP and that you are using the most updated catalog data in your engineering designs. When you make changes to a part catalog, you should validate and regenerate the part catalogs to ensure they are current. You can only use part catalogs that have been regenerated. Similarly, during part selection, you can only access parts that have been validated.

The content tools—Content Builder on page 964 and Catalog Editor on page 1152—validate and regenerate the part catalog that is being accessed when a part or part catalog is saved. However, you might want to validate and regenerate part catalogs that you have received from other users or that you are migrating from previous versions of AutoCAD MEP.

Validating the Parts in a Catalog

You validate parts that you have changed or added to a part catalog. Only validated parts are available during part selection.

To validate the parts in a catalog

1. Verify that the catalog you modified is one of the catalogs specified on the MEP Catalogs tab of the Options dialog. Only the catalogs specified on this tab are loaded into the drawing and, therefore, can be validated. For more information, see Specifying Part Catalogs and Style-Based Content Locations on page 100.

2. In AutoCAD MEP, click Manage tab ➤ MEP Content panel ➤ Test Catalog.

3. Note the prompt on the AutoCAD MEP command line: Catalog Test [Cabletray/Conduit/Duct/Minpart/Pipe/All]
Specify the catalogs to validate:

<table>
<thead>
<tr>
<th>If you want to validate ...</th>
<th>Then ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>all of the catalogs</td>
<td>enter a (All), and press Enter.</td>
</tr>
<tr>
<td>the catalogs specified for a single domain, such as Duct or MvPart</td>
<td>enter the appropriate letter, and press Enter. (For example, to validate the catalogs specified for Duct, enter d.)</td>
</tr>
</tbody>
</table>

During the validation process, the software steps through the catalog structure and validates part sizes by verifying the existence of the necessary part size information. For example, it checks that parameters for AoD (angle of deflection) on page 405, CEL (connection engagement length) on page 404) are present. It also tests conduit content that includes the nominal size property. Any such content without nominal size will not pass.

When the catalog test is complete, a dialog containing the results is displayed. As noted in the dialog, you can view the full test results in Validate\Catalog_Validation_Summary.htm; the Validate directory is located in the same directory as the Autodesk part catalog (APC file).

5 Click OK, and press Enter to end the command.

If any errors were found, you can fix them by opening the catalog in the Catalog Editor, navigating to the part, and editing the part data. For more information, see Customizing Catalogs in Catalog Editor on page 1154.

**Regenerating a Part Catalog**

You should regenerate a part catalog that you have modified. Regenerating a part catalog updates the Autodesk part catalog (APC) file. A part catalog can be used in AutoCAD MEP only if it is updated (regenerated).

To regenerate a part catalog

1 Verify that the catalog you modified is one of the part catalogs specified on the MEP Catalogs tab of the Options dialog.
Only the catalogs specified on this tab are loaded into the drawing and, therefore, can be regenerated. For more information, see Specifying Part Catalogs and Style-Based Content Locations on page 100.

2 In AutoCAD MEP, click Manage tab ➤ MEP Content panel ➤ ➤ Regenerate Catalog.

3 Note the prompt on the AutoCAD MEP command line: Catalog Regen [Cable/tray/Conduit/Duct/Mvpart/Pipe/All]

4 Specify the catalogs to regenerate:

<table>
<thead>
<tr>
<th>If you want to regenerate</th>
<th>then ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>all of the catalogs</td>
<td>enter a (All), and press Enter.</td>
</tr>
<tr>
<td>the catalogs specified for a single domain, such as Duct or MvPart</td>
<td>enter the appropriate letter, and press Enter. (For example, to regenerate the catalogs specified for Duct, enter d.)</td>
</tr>
</tbody>
</table>

During the regeneration process, the software updates the catalogs to reflect new or deleted part sizes.

**NOTE** If multiple catalogs are specified for a domain in the Options dialog, the software regenerates all of them in the order listed in the dialog.

When the catalog regeneration is complete, a dialog containing the results is displayed. As noted in the dialog, you can view the full regeneration results in Validate\Catalog_Regen_Summary.txt; the Validate directory is located in the same directory as the Autodesk part catalog (APC file). Examining the text file is helpful when you need to verify that a specific part has been added to or removed from the catalog.

5 Click OK, and press Enter to end the command.
If part sizes are missing or have not been removed, you can make the necessary modifications in the Catalog Editor. For more information, see Customizing Catalogs in Catalog Editor on page 1154.

Migrating Part Catalogs

You can migrate part catalogs in a particular domain. In effect, this functionality lets you upgrade version and parameter information for existing part catalogs, ensuring that you are using the most updated catalog data.

1 In AutoCAD MEP, click Manage tab ➤ MEP Content panel ➤ Migrate Catalogs ➤.

   ➤ Migrate Catalogs ➤.

   NOTE You can also enter CatalogMigrate at the command line.

2 Note the prompt on the AutoCAD MEP command line: Catalog Migrate [Cabletray/cOnduit/Duct/Mvpart/Pipe/All]

3 Specify the catalogs to migrate, as follows:

   If you want to migrate...

   all of the catalogs type a (All), and press Enter.

   the catalogs specified for a single domain (such as Pipe, Duct, MvPart)

   type the appropriate letter, and press Enter. (For example, to regenerate the catalogs specified for Pipe, type p.)

   A progress bar displays the part number, total parts, and the affected catalog being upgraded. This command updates the version number and also integrates changes to connectors in the selected domain, such as connection engagement length on page 404, angle of deflection on page 405, and nominal size.

   When the upgrade is completed, a report summarizes the results, including the number of errors, a list of the affected parts, and a
link to the results file. The report also includes a link to a file that
contains these details.

4 Click OK, and press Enter to end the command.

NOTE You can use the Redefine From Catalog command to update
an existing drawing with the most current pipe fittings and MvParts.
For more information, see Redefining the Catalog Parts in a Drawing
on page 1168.

Redefining the Catalog Parts in a Drawing

Use the Redefine from Catalog command to review the pipe, cable tray,
conduit, duct, fittings, and MvParts in a legacy drawing and then update the
eligible parts in the catalog. This command will only swap a part if it is already
in the drawing and if the part in the catalog matches the part parameters for
the specified domain. This command updates the styles for the selected objects.

1 In AutoCAD MEP, click Manage tab ➤ MEP Content panel ➤
   ➤ Redefine From Catalog .

   NOTE You can also enter RedefineFromCatalog at the command line.

2 Note the prompt on the AutoCAD MEP command line: Redefine
   the parts of the type
   [Cabletray/cOnduit/Duct/Mvpart/Pipe/Select] <Select>:

3 Specify the parts to redefine by typing the applicable letter and
   then press Enter:

   While the command is running, AutoCAD MEP checks each part
   for a match of the part ID and other parameters in the appropriate
domain catalogs in the drawing. If a suitable match cannot be
made, the affected part remains unchanged.

   A progress bar displays the number of parts validated and the
   number remaining. When the redefinition task is completed, a
   report summarizes the results, including the number of parts
   reviewed, and the number of parts successfully updated. The report
   also includes a link to a file that contains these details.
TIP For legacy drawings that contain conduit content, AutoCAD MEP automatically updates the nominal size parameter. Use the Redefine from Catalog command to update bend radius and outside diameter.
This section provides information on advanced customization tasks that are typically performed by CAD Managers or other experienced users of AutoCAD MEP.

Creating Drawing Environment Configurations for Users

You can create profiles and workspaces to customize the drawing environments of users to meet company or project requirements.

Creating Profiles

Profiles store drawing environment settings, such as the following:

- Default search and project file paths
- Template file locations
- Initial folder specified in file navigation dialogs
- Default linetype and hatch pattern files
- Printer defaults

Profile information is typically set on the Files tab of the Options dialog and stored in the system registry. Each time you make a change to an option, setting, or other value, the software updates the current profile.

You create and manage profiles on the Profiles tab of the Options dialog. You can create profiles for different users or projects, and you can share profiles by...
importing and exporting them as ARG files. AutoCAD MEP includes several profiles for working with metric and imperial units. The name of the current profile is displayed at the top of the Options dialog.

To access the Options dialog, click Options. For more information about working with profiles, see Save and Restore Interface Settings (Profiles) and Profiles Tab (Options Dialog Box).

Creating Workspaces

Workspaces are sets of ribbon tabs and palettes that are grouped and organized so you can work in a custom, task-oriented drawing environment. The software includes sample workspaces that are tailored for different disciplines and tasks.

While profiles save environment settings including many of your user options, drafting settings, paths, and other values, workspaces control the display of ribbons and palettes in the drawing area. You create and manage workspaces using the Workspace Settings dialog, and the Customize User Interface (CUI) dialog.

Users can create their own workspaces, or, in design situations where more control over the drawing environment of users is required, CAD managers can create read-only workspaces that are shared by many users. This can be helpful for maintaining company or project standards.

For more information on working with workspaces, see Create Task-Based Workspaces and Create an Enterprise CUIx File.

NOTE The software automatically adds object-specific shortcut commands to the context ribbon of an object. For example, the context ribbon of a duct object includes commands for working with ducts, such as commands for calculating duct system sizes and for specifying duct lengths by breaking or merging segments.

Styles and Support Files

Support files are located in the following locations:

<table>
<thead>
<tr>
<th>Files</th>
<th>Location Windows XP</th>
<th>Location Windows Vista</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plotter Configurations</td>
<td>\ProgramData\Autodesk\MEP 2011\enu\Plotters</td>
<td>\ProgramData\Autodesk\MEP 2011\enu\Plotters</td>
</tr>
<tr>
<td>Files</td>
<td>Location Windows XP</td>
<td>Location Windows Vista</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>Plot Styles</td>
<td>\ProgramData\Autodesk\MEP 2011\enu\Plot Styles</td>
<td>\ProgramData\Autodesk\MEP 2011\enu\Plot Styles</td>
</tr>
<tr>
<td>DesignCenter Content</td>
<td>\ProgramData\Autodesk\MEP 2011\enu\AEC Content</td>
<td>\ProgramData\Autodesk\MEP 2011\enu\AEC Content</td>
</tr>
<tr>
<td>Layer Standards drawing</td>
<td>\ProgramData\Autodesk\MEP 2011\enu\Layers</td>
<td>\ProgramData\Autodesk\MEP 2011\enu\Layers</td>
</tr>
<tr>
<td>Styles drawings</td>
<td>\ProgramData\Autodesk\MEP 2011\enu\Styles</td>
<td>\ProgramData\Autodesk\MEP 2011\enu\Styles</td>
</tr>
<tr>
<td>Drawing templates</td>
<td>\ProgramData\Autodesk\MEP 2011\enu\Template</td>
<td>\ProgramData\Autodesk\MEP 2011\enu\Templates</td>
</tr>
<tr>
<td>Area Evaluation templates</td>
<td>\ProgramData\Autodesk\MEP 2011\enu\Template\Evaluation Templates</td>
<td>\ProgramData\Autodesk\MEP 2011\enu\Template\Evaluation Templates</td>
</tr>
<tr>
<td>Default Used User Interface Catalog</td>
<td>\Documents and Settings&lt;UserName&gt;\Application Data\Autodesk\MEP 2011\enu\Support\WorkspaceCatalog(USImperial/USMetric)</td>
<td>\Users&lt;UserName&gt;\App-Data\Roaming\Autodesk\MEP 2011\enu\Support\WorkspaceCatalog(USImperial/USMetric)</td>
</tr>
<tr>
<td>Stock Tool Catalog</td>
<td>\Program Files\AutoCAD MEP 2011\Catalogs\MEPStockToolCatalogs\MEPStock Tool Catalog.atc</td>
<td>\Program Files\AutoCAD MEP 2011\Catalogs\MEPStock-ToolCatalogs</td>
</tr>
<tr>
<td>Structural Member Catalog</td>
<td>\Program Files\Autodesk\AutoCAD MEP 2011\Catalogs\Structural</td>
<td>\Program Files\AutoCAD MEP 2011\Catalogs\Structural</td>
</tr>
<tr>
<td>Sample Tool Palette Catalogs</td>
<td>\Program Files\AutoCAD MEP 2011\Sample\MEP Sample Palette Catalog</td>
<td>\Program Files\AutoCAD MEP 2011\Sample\Sample Palette Catalog</td>
</tr>
</tbody>
</table>
Customizing Tool Palettes

You can create custom tool palettes to suit company or project requirements. Typically, you create tool palettes according to tool type or design phase. For example, you could place your piping tools on a tool palette called “Piping,” or your schematic tools on a tool palette called “Schematic.”

Because the tool palette set is the collection of tool palettes specified for the current user profile, you can have only one tool palette set active at a time during an AutoCAD MEP session. However, you can create different tool palette sets for different user profiles and customize the tool palette sets. For example, you can add, remove, and rearrange the palettes in the tool palette set. You can also rename the tool palette set.

Creating a Tool Palette

1. In the title bar of the tool palette set, click \_\_\_\_\_\_\_\_\_\_\_\_, and then click New Palette.
2. Enter a name for the new tool palette, and press ENTER.
   The software creates an empty tool palette.
3. Add tools to the tool palette. For more information, see Customizing Tools on page 1178.

NOTE The MEP Sample Palette catalogs include a number of tool palettes that you can use or customize. You can access the Sample Palette catalogs from the Content Browser. Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Content Browser ➤ .

You can create tool palettes directly in the Content Browser, and drag and drop palettes from the library to your tool palette set. When you add a palette to your tool palette set in this manner, you can link it to the Content Browser so that the software refreshes the palette automatically whenever it detects changes to the palette in the Content Browser. Alternatively, you can refresh the palette manually. For more information, see Adding a Tool Palette from a Tool Catalog in the Content Browser in the AutoCAD Architecture Help.
Creating a Tool Palette Set

Use this procedure to create a new tool palette set for a new profile. For information on modifying the tool palette set for the current profile, see Specifying Different Tool Palettes for the Tool Palette Set on page 1177.

To create a new tool palette set for a new profile

1. To access the Options dialog, click ➤ Options.
2. Click the Profiles tab, and then click Add to List.
3. In the Add Profile dialog, enter a name and description for the profile, and click Apply & Close.

**NOTE** By default, the tool palette set for the new profile includes the tool palettes for the current profile.

4. In the list of available profiles, select the new profile, and click Set Current.
5. Click the Files tab, and expand Tool Palettes File Locations.
6. Specify the tool palettes in the tool palette set for the new profile, which is now current:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>modify the set of tool palettes for the current profile</td>
<td>click Browse or Add to change or add tool palettes (ATC files). If desired, you can create copies of the tool palettes provided with the software, modify the copies, and then specify the file locations for the copies.</td>
</tr>
<tr>
<td>create an empty tool palette set</td>
<td>specify the file location of an empty folder. Once you click OK in the next step, this results in a blank tool palette set, to which you can add palettes and tools. For more information, see Creating a Tool Palette on page 1174 and Customizing Tools on page 1178.</td>
</tr>
</tbody>
</table>
Customizing a Tool Palette Set

The tool palette set has several user-definable display options. For example, you can dock the tool palette set to a specific side of the drawing window, minimize it when it is not in use, or configure it to display tool icons only, tool icons and names, or tool icons and names in a list format. You can set these display options according to your preferences. For information on modifying these user-definable settings, see Modifying the Appearance of Tools on page 133.

This section provides information on more advanced customizations to a tool palette set, such as renaming the tool palette set to a company or project name, or changing the collection of tool palettes in the set.
Specifying Different Tool Palettes for the Tool Palette Set

Use this procedure to switch between different palette combinations in the tool palette set. You can do this in one of two ways:

- modify the set of tool palettes for the current profile
- change to a different profile that uses a different set of palettes

For information on working with profiles, see Creating Drawing Environment Configurations for Users on page 1171.

To specify different tool palettes for the tool palette set

1 To access the Options dialog, click ➤ Options.
2 Specify a different set of tool palettes:
   
<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>modify the set of tool palettes for the current profile</td>
<td>click the Files tab, expand Tool Palettes File Locations, and click Browse or Add to change or add tool palettes (ATC files).</td>
</tr>
<tr>
<td>change to a different profile that uses a different set of palettes</td>
<td>click the Profiles tab, select the desired profile, and click Set Current.</td>
</tr>
</tbody>
</table>
3 Click OK.

Renaming the Tool Palette Set

Use this procedure to rename the tool palette set. For example, you might want to name it with a project or company name.

To rename the tool palette set

1 In the title bar of the tool palette set, click Rename Palette Set, and then click Rename Palette Set.
2 Enter a name for the tool palette set, and press ENTER.
Customizing Tools

There are 2 types of tools: object tools and command tools.

Object Tools
An object tool inserts an object, such as a duct or a pipe, into a drawing. When you add an object with a specific object tool, the object has the settings that are defined in the tool, which facilitates the design process and enhances consistency across your project drawings.

Object tools for adding piping objects

Command Tools
A command tool is a graphical representation of an object-related command. For example, the Analyze ribbon and the Analysis tool palette in the HVAC tool palette group contain a Duct System Size Calculator tool. The tool opens the Duct System Size Calculator dialog, in which you can size a duct system that you have designed.

You can create tools for the commands in AutoCAD MEP.

Content Browser
The Content Browser is a library of tool catalogs containing tools and tool palettes. You can browse the catalogs in the Content Browser, and drag and drop tools onto tool palettes. You can also publish catalogs in the Content Browser.
Browser to make them available for use by multiple users on a network. For more information, see Content Browser in the AutoCAD Architecture Help.

**Customizing Tools**

For all tools, you can define the tool name and description. For many tools, you can define additional properties, such as the layer key and layer key overrides of objects inserted with the tool, and the object style.

**NOTE** The tool description you enter for a tool is used as the tooltip. It is also used as the description when the tool is copied to a tool catalog in the Content Browser.

---

**Creating Tools for Style-Based Content**

You can quickly create object tools for the following objects:

- Schematic lines and symbols
- Plumbing lines and fittings
- Devices
- Panels
- Wires
- Conduits

To do so, drag an object from a saved drawing onto a tool palette, and then configure the tool properties. The initial values for the tool properties are determined by the object that you drag and drop onto the palette.

While you can create and configure object tools for other building systems objects using AutoLISP programming, only tools for the aforementioned objects allow you to configure all relevant object properties directly on the Tool Properties worksheet as shown below.
NOTE In the Tool Properties worksheet, ☀ indicates a property is available only when you are adding objects, not when you are modifying them.

For general information on configuring tool properties, see:

- Changing Tool Properties on page 1185
- Changing Tool Icons on page 1187

For information on configuring properties that are specific to an object type, see:

- Adding Schematic Lines in Orthographic Mode on page 783 and Adding Schematic Lines in Isometric Mode on page 788
- Adding Schematic Symbols in Orthographic Mode on page 785 and Adding Schematic Symbols in Isometric Mode on page 791
- Adding Devices on page 577
- Adding Panels on page 596
- Adding Wires on page 611
TIP To facilitate annotation and scheduling, you can use the properties of device tools to specify property sets and tags, so they are automatically attached to devices when they are added to drawings. A property set is a user-defined group of related properties, such as a part number or a manufacturer’s name. A tag is a symbol that can display the data in a property set attached to an object. For more information on annotation and scheduling, see Creating Construction Documents on page 813.

Creating Tools from Routing Preferences

You can transfer a pipe on page 367 or conduit on page 526 routing preference to the relevant tool palette. The new tool uses the name and other characteristics of the original routing preference.

1 Activate the Piping or Electrical workspace.
2 Open the desired Tool palette on page 130.
3 In the applicable domain, click Manage tab ➤ Style & Display panel ➤ Style Manager drop-down ➤ Routing Preference Definitions.
4 In the left pane of Style Manager, click the desired routing preference.
5 Drag the routing preference onto the appropriate tab on the Tool palette.
   The new tool appears in the Tool palette with the same name as the corresponding routing preference. For example, if you transfer Glued to the Pipe Tool palette, the new tool is also named Glued. However, if you drag Standard to the Cable Tray and Conduit Tool palette or the Pipe Tool palette, the new tool is generically named Conduit Tool or Pipe Tool respectively.
6 Select the new tool, right-click, and click Properties.
   In the Tool Properties on page 1185 dialog, the Routing Preference, Routing Preference Location, and Name properties for the new tool reflect values from the original routing preference. The remaining properties in the Tool Properties dialog show “--”. This means that a default value has not been set. The properties will reflect the last value that was used when the Add command was invoked on the corresponding routing preference.
Creating Tools from AEC Content in DesignCenter

Architectural, engineering and construction (AEC) content consists of drawings, symbols, object styles, and annotation routines that you add to drawings to design and document your project. You can create a tool on a tool palette using the predefined AEC content accessed in DesignCenter. You can also create tools from blocks in DesignCenter, but they have slightly different tool options.

NOTE AutoCAD MEP also provides the Stock Tool Catalog and the Documentation Tool Catalog, which you can access in the Content Browser. These catalogs already have tools set up for predefined AEC Content and sample object styles, and they are available for both metric and imperial units. To open Content Browser, click Home tab ➤ Build panel ➤ Tools drop-down ➤ Content Browser.

For more information, see AEC Content and DesignCenter in the AutoCAD Architecture Help.

To create a tool from AEC Content in DesignCenter

1. Click Home tab ➤ Build panel ➤ Tools drop-down ➤ Tools.
2. Open the tool palette where you will create the new tool.
3. Click Insert tab ➤ Content panel ➤ Content drop-down ➤ Design Center.
4 In the DesignCenter, click the AEC Content tab, and navigate to the AEC Content item where you can choose the tool to create.

5 Drag the item to the tool palette. The software inserts a new tool on the tool palette.

6 Define additional properties for the new tool, if necessary. For information on changing tool properties, see Changing Tool Properties on page 1185. For information on changing the icon of the new tool, see Changing Tool Icons on page 1187.

**Creating Command Tools**

Tools usually represent objects or AEC content items. However, you can also create a tool for a command.
**To create a command tool**

1. Create the command tool by copying an existing one:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>copy an existing command tool from a tool palette</td>
<td>navigate to the tool palette, right-click the command tool, and click Copy. Then navigate to the tool palette on which to insert the new command tool, right-click, and click Paste.</td>
</tr>
<tr>
<td>copy the general purpose Command Tool in the Stock Tool catalog in the <strong>Content Browser</strong></td>
<td>Click Home tab ➤ Build panel ➤ Tools dropdown ➤ Content Browser ➤ MEP Stock Tool Catalog. Click a domain (for example, Electrical). Move your pointing device over i-drop icon next to the Command Tool, click, and drag the Command Tool to the tool palette on which to create the new command tool.</td>
</tr>
</tbody>
</table>

2. Right-click the new command tool, and click Properties.

3. For Name, enter a name for the new command tool.
Creating Property-Based Tools

You can create a property-based tool from an existing object in a drawing. This capability is available in the following domains: Piping, Plumbing, Schematic, and Electrical (except cable tray). Use the following procedure depending on the domain in which you are working.

1. To insert a fitting in the drawing, click Home tab ➤ Build panel ➤ [domain] Fitting.
2. Save the drawing.
3. Zoom into the drawing, and then select the fitting object.
4. Drag the selected fitting part onto the particular domain's fitting tool palette.
5. Click the object, right-click, and click Properties.
6. Edit tool properties, as described in Changing Tool Properties on page 1185.

Changing Tool Properties

For all tools, you can define the properties of a tool in a tool palette, such as name and description. For many tools, you can also define additional properties, such as the layer key and layer key overrides of objects inserted with the tool, and the object style.

To change the properties of a tool

1. Open the tool palette that contains the tool you want to modify.
2 Right-click the tool, and click Properties.
3 In the Tool Properties dialog, enter a name for the tool.
4 Click and enter a tool description in the Description worksheet (optional).

**NOTE** The software uses the tool description as the tooltip and also as the description when the tool is copied to a tool catalog in the Content Builder on page 964.

To select a part for property-based tools

5 For property-based tools created on page 1185 from within the drawing, click the part image on the Tool Properties to open the Select a Part dialog.

6 In the Select a Part dialog, choose a part from the catalog and optionally make other part and filtering selections.

**TIP** Select the Use unspecified part type to disable the part selections in this dialog. This selection creates a tool on the tool palette that does not include specified properties. You can use this new tool to start the object’s Fitting Add command as you lay out the pipe run.
To specify other properties

7 (Optional) On the Properties palette, specify other values for additional properties, as follows:

<table>
<thead>
<tr>
<th>If you want to specify...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>a layer key</td>
<td>click the Layer key worksheet, select the layer key in the Select Layer Key dialog, and click OK.</td>
</tr>
<tr>
<td>layer key overrides</td>
<td>click the Layer overrides worksheet, specify the overrides in the Select Layer Overrides worksheet, and click OK.</td>
</tr>
</tbody>
</table>

NOTE If you do not specify a layer key or layer key overrides, the layer assignments specified in the layer key style in the drawing are used.

8 Specify other properties that appear depending on the type of tool, such as System, Current size, Elevation, Nominal diameter, and Insulation thickness.

Changing Tool Icons

When you create a tool, the tool is added to a tool palette with the icon of the tool from which it was copied or with a default icon. You can change the tool icon by selecting a new icon saved as an image file or by selecting an object in the drawing. You cannot create icons from custom blocks. If you need to create an icon based on a custom block, save the block as an image file in any of the formats in the following list.

Sample tool icons

When you change a tool icon by selecting an icon saved as an image file, you can use any of the following image file formats:

- PNG
- GIF
Icons in tool palettes can have a maximum size of 64 x 64 pixels. Larger images are scaled when inserted.

To replace the tool icon using an image file

1. Open the tool palette that contains the tool you want to modify.
2. Right-click the tool, and click Properties.
3. In the Tool Properties dialog, right-click the existing icon, and click Specify Image.
4. In the Select Image dialog, select the image you want to use as a tool icon, and click Open.
5. Click OK.

To replace the tool icon using an object in a drawing

1. Open the tool palette that contains the tool you want to modify.
2. Right-click the tool, and click Set Image from Selection.
3. In the drawing, select the object to use as the tool icon, and press ENTER.
4. Click OK.

NOTE For information on changing the display size of the tools on a palette, see Modifying the Appearance of Tools on page 133.

Deleting Tools

When you delete a tool from a tool palette, objects in your drawing that were inserted with the tool are not deleted.

To delete a tool

1. Open the tool palette that contains the tool.
2 Right-click the tool, and click Delete.
AutoCAD MEP includes a U.K. profile containing content based on the British Standards Institute (BSI) standards and other standards for metric design. The profile includes content and tools that support the design requirements of the U.K. and German markets, such as

- Predefined hanger styles
- Object tools for adding hangers to drawings
- Command tools for adding hanger schedules to construction documents

The U.K. profile also is configured to load a set of related features and commands when you make it the current profile. These features include but are not limited to

- Support for creating hanger styles in Style Manager
- Commands for working with hangers
- Commands for rotating cable trays and connected objects

This chapter provides information on using this set of related features and commands.

**NOTE** If you are not using the U.K profile, see *Using Other Profiles* on page 1191.

**Using Other Profiles**

If you are not using the U.K. profile, you can still use the features and commands discussed in this chapter, but, in some cases, you might need to create supporting content beforehand.
If you make the Global profile (included in the Global content pack) the current profile, the features and commands are loaded by default. If you make a different profile current, you can access them by doing either of the following:

- Enter any command discussed in this chapter when you need it. This action loads the required module on demand.
- Enter `loadmetriccmds` to permanently configure the profile to always load the module at startup.

**NOTE** For information on switching profiles, see Save and Restore Interface Settings (Profiles).

### Working with Hangers

You can add hangers to ducts, pipes, cable trays, and conduits. Hangers are a type of style-based content, which means you create and modify the styles that represent them in Style Manager. For an introduction to style-based content, see Working with Style-Based Content on page 124.

### Configuring Hanger Styles

A hanger style specifies two structural member styles that define

- The type of drop rod to use
- The type of channel to use

You need to create these structural member styles before creating a hanger style.

**TIP** To create a structural member style, switch to the Architecture workspace, click Manage tab ➤ Style & Display panel ➤  ➤ Structural Member Wizard , and create a style using the Structural Member Style Wizard.

To create a hanger style

1. Click Manage tab ➤ Style & Display panel ➤ Style Manager .

1192 | Chapter 17  Working with the U.K Profile
2 In the left pane, expand Multi-Purpose Objects, and select the Hanger Styles category. If the Hanger Styles node is not listed under Multi-Purpose Objects, enter the `hangeradd` command and follow the prompts to add a hanger to your drawing.

3 Create the style, and configure its general properties as described in Creating a Style on page 894.

4 Click the Hangers tab.

<table>
<thead>
<tr>
<th>General</th>
<th>Hangers</th>
<th>Classifications</th>
<th>Display Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Style: Standard</td>
<td>Rod Style: Standard</td>
<td>Rod Offset: 25</td>
<td>Rod Overrun: 50</td>
</tr>
</tbody>
</table>

5 For Channel Style, select the structural member style to represent the channel.

**IMPORTANT** You can select from the structural member styles in the current drawing that include both of the following words in their names or descriptions: hanger and channel.

6 For Rod Style, select the structural member style to represent the rod.

**IMPORTANT** You can select from the structural member styles in the current drawing that include both of the following words in their names or descriptions: hanger and rod.

7 For Rod Offset, enter the distance between the edge of the support and the rod.
For Rod Overrun, enter the distance between the bottom of the support and the end of the rod.

Adding Hangers

You can add hangers to ducts, pipes, cable trays, and conduits. You cannot add hangers to fittings.

When you add a hanger, the midpoint of the hanger top is positioned relative to the midpoint of the bottom of the building system object to which it is anchored. Because the hanger is anchored to the object, when the object moves, the hanger moves with it. When the object is deleted, the hanger is also deleted.

To add hangers

1 Start the add command by doing one of the following:
   - Open the Tools palette, and click the Add Hanger Support tool, if available.
   - On the command line, enter hangeradd.

2 For Hanger Style, select the hanger style to use.
You can select from the hanger styles defined in the current drawing.

3 For Left Channel Offset, enter the distance between the left side of the building systems object and the edge of the channel.

4 For Right Channel Offset, enter the distance between the right side of the building systems object and the edge of the channel.

5 For Support Height, enter the height of the drop rods.

6 Specify how you want the hangers to provide support:

   **If you want the hangers to provide support ...**

   from above the run select Support From Above
   from below the run clear Support From Above

7 Under Insertion Options, specify the number of hangers to insert and how to space them:

   **If you want to add... Then...**

   a single hanger for Insertion, select Single.
   hangers at a specific distance interval do the following:
     - For Insertion, select Along Run.
     - For Distance between, enter the distance between the centers of the hangers.
   a specific number of hangers at a specific distance interval do the following:
     - For Insertion, select Along Run (Fixed Number).
If you want to add... Then...

- For Distance between, enter the distance between the centers of the hangers.
- For Quantity, enter the number of hangers to insert.

8 Click OK.
9 In the drawing, select the building systems object to which to add the hangers.
10 Click to specify the location of the first hanger.
11 If, for Insertion, you selected Along Run or Along Run (Fixed Number), click in the direction you want to place the remaining hangers.

**Modifying Hangers**

You can modify a hanger using several methods:

- **Location grips:** To move a hanger, select it, click the Location grip, and specify a different location on the building systems object.

- **Lengthen grips:** To lengthen the channel or drop rods, select the hanger, right-click, and click Edit Parameters. Then select a Lengthen grip, and drag it to a new location.

- **Commands on the context menu:** Use the commands on the Support Orientation submenu to rotate the hanger around the building systems object, or to change the direction of support (Support From Above or Support From Below).

- **AutoCAD commands:** Use these commands to modify a hanger in other ways. You can access several AutoCAD commands, such as COPY, from the Basic Modify Tools submenu on the context menu.
Rotating Cable Trays

**NOTE** To rotate cable tray runs in model views, make sure the current display configuration uses a Cable Tray Model display representation for both cable trays and fittings. Only these display representations show an open side to cable trays and fittings, as is necessary to visually represent their rotation. If you are using the U.K. profile or the Global profile, the drawing templates are configured to use these display representations by default. If you are using another profile, you must configure the current drawing to do so, and you might also need to run LOADMETRICCMDS beforehand to make the display representations available in Display Manager. For information on loading the module, see Using Other Profiles on page 1191.

**To rotate a cable tray run**

1. Select an isometric view direction, such as SW Isometric.
2. Select a cable tray, right-click, and click Rotate Cable Tray Direction.
   - This action rotates the segment or fitting 90 degrees.
3. Repeat the previous step as required.
4. Select the same segment or fitting, right-click, and click Regenerate Cable Tray System.
5. Specify how you want to rotate connected objects:

   **If you want to apply the same rotation angle to all connected in-line objects...**

<table>
<thead>
<tr>
<th>Then...</th>
<th>If...</th>
</tr>
</thead>
<tbody>
<tr>
<td>in the system</td>
<td>enter n (no).</td>
</tr>
<tr>
<td>to next transition in both directions</td>
<td>enter y (yes).</td>
</tr>
</tbody>
</table>
Glossary Terms

This Glossary defines AutoCAD MEP terms covered in this help.

3D orbit viewing command Used to manipulate the viewpoint for an object or an entire model. See also orbit.

access panel An opening for access to concealed parts or other equipment without disturbing the wall or building systems component.

acid neutralizer A system, either mechanical or chemical, that balances the pH level in water.

actual velocity The flow velocity for the pipe that you have selected. Once the pipe diameter and friction loss are calculated, you can calculate the actual velocity.

adjacent surface A physical wall shared by 2 engineering space surfaces. Specifying adjacent surfaces helps ensure accurate load calculations.

adjust slope To modify the slope (rise or run) of a pipe segment that results in modifying the slope ratio. See also slope.

AEC Object Enabler A distributable utility that allows users without Autodesk AEC applications to use Autodesk AEC objects in AutoCAD®, Volo View Express, AutoCAD Map, and other Autodesk applications.

AEC objects Objects created through AutoCAD Architecture, such as doors, walls, and windows.

anchor (1) A feature that creates a relationship between 2 objects.

anchor (2) To fasten, or anchor, an object to another object, a layout curve, or grid. The anchored object’s movement and/or size is constrained by the object to which it is anchored.

angle A pipe bend at 90 degrees that is used to connect pipe segments. Angles are used because 90-degree elbows are typically not used in plumbing.
angle of deflection The maximum allowable angle specified in the content indicating that male and female connectors are still considered connected. Angle of deflection (AoD) appears as Use fitting tolerance on the Piping Properties palette on page 420.

annotation Text, dimensions, symbols, or reference marks added to drawings for clarification.

annotation scale flag Elevation annotation used in place of linear measurements to show the height of pipes and fittings.

annotation symbols Annotation used to clarify parts of a drawing, such as leaders, break marks, title marks, and revision clouds. See also annotation.

APC For Autodesk Part Catalog. Standard file format for part catalogs within AutoCAD MEP.

architectural elements Architectural objects such as doors, walls, and windows. See also AEC objects.

ASHRAE fitting A duct fitting identified and described in the Duct Fitting Database of the American Society of Heating, Refrigerating, and Air-Conditioning Engineers (ASHRAE).

attribute An AutoCAD object that is included in a block definition to store alphanumeric data. Attribute values can be predefined or specified when the block is inserted. Attribute data can be extracted from a drawing and inserted into external files.

ballast An electrical device used in fluorescent and HID fixtures. It furnishes the necessary starting and operating characteristics to the lamp for proper performance.

base curve A curve used to define particular drawing objects, such as lines, polylines, and arcs. Many objects do not have a base curve and must be used with the curve anchor or layout curve command. See also curve anchor and layout curve.

baseline An established but imaginary line on which objects can rest.

bay In grid layouts, a regularly repeated spatial element defined by grid lines.

bell/hub A joining method where the pipe or fitting has an enlarged end to accept the male end of a pipe or fitting. The depth of the connection is defined by the connection engagement length value. See also connection engagement length (CEL).
bend angle  The radius to use when laying out pipe or conduit using the routing layout method; formerly called elbow angle.

bend radius  See radius of curvature.

bent conduit  A conduit part made during construction at a project site; has a bend radius that is based on the corresponding conduit nominal size and the *One Shot and Full Shoe Benders* radius value in the industry standard specification.

bitmap  The digital representation of an image having bits referenced to pixels. In color graphics, a different value represents each red, green, and blue component of a pixel.

block  A generic term for one or more AutoCAD objects combined to create a single object.

block-based part  A multi-view part (MvPart) whose geometry is based on individual AutoCAD® blocks.

BMP  A part definition file that stores the preview bitmap image of the part; used to help identify the part during part selection.

branch circuits  The circuits that carry power from the service panel to electrical devices.

brazed (1)  Made of brass.

brazed (2)  To unite metal with solder that contains copper, zinc, and other materials with high melting points.

break marks (1)  Annotation used to specify a shortened view of an elongated object or group of objects.

break marks (2)  To signify that an object has been broken or has had a piece removed.

building model  A 2-dimensional (2D) or 3-dimensional (3D) representation of one or more building objects, such as architectural, structural, or building systems objects.

butt weld  A joint type where pipe is welded to other pipe, to fittings, or to equipment. No special joint fixture is required. The pipe end is prepared by grinding, and the pipe end is prepared by grinding, and then the pipe is directly welded.

butt welded  2 pieces of metal that are butted together, with the abutted ends thickened, shortened, and fused using heat.
cable  Electrical wires protected by plastic tubing, metal sheathing, or another protective covering.

cable tray  An assembly of segments and fittings forming a rigid structural system, used to securely fasten or support cables, wires, and raceways.

calculated size  The actual size of a pipe based on a calculated value that is the result of pipe sizing calculations for a plumbing system.

capacity (1)  The quantity of electricity that can be delivered from a unit, such as the output from a generator.

capacity (2)  The air flow used to calculate duct sizes using the instant sizing tool. Capacity is automatically calculated for systems with defined outlet devices, and it can also be manually specified.

Catalog Editor  A tool used to modify the content of the catalogs in some way, such as adding tracking information to a new part. See also content.

catalog part  A part defined by the associated files (DWG, XML, and BMP files) that store the part data.

CCF  For Custom Content File; used to create a device conversion script that contains the settings for devices styles.

ceiling grid  A rectangular arrangement of parallel lines forming a pattern for laying out ceiling tile and fixtures in a building.

cell anchor  A feature that fastens, or anchors, an object to the cell position of a 2D or 3D layout object. The anchored object's movement and size are constrained by the cell.

centerline  A line used to indicate the axes of symmetrical objects, the center of a segment or fitting, and paths of motion.

chapter  A group of related part families comprising a part catalog structure.

chase  A vertical passage in a wall where ducts, pipes, and wires can be run through a building.

circuit  A collection of electrically connected devices, MvParts, or components; used to show how electrical equipment is connected to upstream panels.

circuit breaker rating  A value that provides information found in a panel schedule. It is a property for Power and Lighting circuits only but is not related to the rating associated with the panel.

circuit length  A rough estimate of the total length of the circuit based on where the devices are placed in the drawing. Circuit length is calculated by
adding the XY distances between electrical devices to the rise/drop distances between the wire and device elevations.

**circuit load** Circuit load is the voltage on a circuit that contains the system type Power and Lighting. All devices connected to the circuit must have a voltage in the range of the voltage definition.

**circuit name** A property common to all system types that identifies the circuit based on the circuit naming strategy specified in electrical preferences; can be modified in Circuit Manager.

**circuit voltage** The voltage on a circuit that contains the Power and Lighting system types.

**clean up** Joining appropriate parts of 2 different components by lengthening, shortening, or breaking lines that represent boundaries of the components. For example, when adding an elbow to a run, the segments are trimmed back to allow room for the elbow.

**command line** A text area on screen reserved for keyboard input, prompts, and messages.

**compass** A tool built into AutoCAD MEP used to lay out building systems components.

**component (1)** A fundamental element of an object, such as the centerline of a segment.

**component (2)** A single piece or part of a building systems design.

**conceptual design phase** Initial design phase of a building project. Also referred to as schematic or preliminary design.

**condensate line** A pipe that drains excess water from an air conditioning unit. The water results from vapor condensing on the cool surfaces inside the unit.

**conduit** A tubular material used to encase and protect electrical wiring: typically plastic or metal.

**conduit elbow** A conduit part purchased from the conduit supplier; has a bend radius based on the corresponding conduit nominal size and the *Other bends* radius values in the industry standard specification

**connection type** A property of ducts, pipes, conduits, and cable trays that describes how the segments are mounted together. Normally, connector types must match to form a valid connection, which is defined in connector styles.
connector An AutoCAD MEP element that is placed on an object and that holds information. A connector joins other objects (i.e., pipe segments) to each other.

connector block A block with terminals used to connect wires or cables.

connector engagement length (CEL) The length of pipe that is inserted into a coupling either as a threaded section or socket welded segment for joining the pipe. CEL constitutes part of the overall length of a pipe segment and is the minimum length required for a proper connection.

constrained layout Drawing pipe between 2 existing pipe objects (pipes or fittings)

constraint In Content Builder, an entity that controls the shape of a feature by establishing relationships between features in the model

construction documents The working drawings, schedules, and specifications required to construct a building. Also referred to as CDs.

containment Cable transport mechanisms, such as trays, trunking, ladders, and baskets.

content User-definable, pre-configured elements provided to aid you in getting started on a project. Examples of supplied content are templates, styles, and symbols. See also design content.

Content Builder A utility tool that enables you to create custom parts, such as fittings and equipment, that can be used in your building systems layouts.

continuous load An electrical load where the maximum current is expected to continue for 3 hours or more.

cooling loads The amount of conditioned air required to cool a room or a zone based on engineering space analysis. The cooling load is displayed in the Engineering Properties dialog.

coupling A joint type used to join 2 pipes together. Couplings are typically used for threaded, socket weld, grooved, or glued type piping. The depth of the connection is defined by the CEL value. See also connection engagement length (CEL).

curve The centerline of the geometry along which objects are built.

curve anchor A feature that fastens, or anchors, an object to the base curve of another object. The movement of the anchored object is constrained by the object to which it is anchored.
**custom data** A unique, user-defined part parameter; can be constant for a part family or different for each part size.

**cut height** Elevation for cut plane in the floor plan; breaking level for the Low and High display components

**cut plane** The height at which an object is cut to produce the plan representation; settings for defining elevations for a floor plan (Display Above Range, Cut Height and Display Below Range)

**cutout** (1) A cut in a panel or beam used to insert a fixture.

**cutout** (2) A switch used to cut off the flow of electricity to a circuit.

**DDXML** For Duct Design Extensible Markup Language. An XML format designed to store and transfer design specifications for ductwork.

**default** A predefined value for program input or parameters. Default values and options for commands are denoted by angle brackets (<>).

**definitionsymbol conversion script** A Custom Content File (CCF) file that contains the settings for schematic symbol styles. For more information, see Converting Schematic Symbol Styles to Blocks on page 940.

**degree of freedom** In part modeling, determines how a geometric object such as a line, arc, or circle can change shape or size. For example, a circle has 2 degrees of freedom: center and radius. When these values are known, degrees of freedom are said to be eliminated.

**demand factor** A ratio of the amount of connected load (in kva or amperes) that will operate simultaneously to the total connected load on the electrical circuit. An 80% demand factor, for instance, indicates that only 80% of the connected load on a circuit will ever be operating at the same time. The value is defined with a style name and displayed in Circuit Manager for Power and Lighting system types.

**design content** AutoCAD MEP objects that represent real-world parts used to create complete building systems layouts. Examples include duct, pipe, fittings, and equipment.

**design criteria** Includes information such as the type of design, maximum velocity or load, space requirements, or material specifications.

**design development phase** The phase during which the conceptual design is developed into the complete building model.
**designated ID** An optional number or string of characters that you assign to a schematic line. The designation can also be used to group schematic lines for scheduling purposes.

**DesignCenter™** A display window, similar to the standard Windows® Explorer, in which you use selection aids to find, manipulate, and sort drawings and drawing components. DesignCenter contains hierarchical tree, palette, preview, and description panes. Content can be dragged from the palette into an open drawing.

**detail marks** Annotation that references another drawing, which contains a detail of the original drawing.

**developed length** The length of your longest pipe run, including the equivalent length of the fittings.

**device conversion script** A Custom Content File (CCF) file that contains the settings for devices styles. For more information, see Converting Device Styles to Blocks on page 925.

**diaphragm** A thin partition or dividing membrane.

**dimension (1)** Annotation of the size description of an object or group of objects. Typically specifies the associated linear distances, angles, or size-related notes.

**dimension (2)** In Content Builder, an entity that controls the size of a feature. When changed, the feature is resized. Might be expressed as a constant value, a value as part of a table, a calculated value, or a list of values.

**direct current (DC)** An electrical current that flows in one direction only.

**direction dependent** A condition where the display of an object is dependent on the view direction.

**display above range** Elevation for top of the floor plan; breaking level for the High and Above display components.

**display below range** Elevation for bottom of the floor plan; breaking level for the Low and Below display components.

**display by elevation** A feature that allows users to configure the display of objects based on their elevation; uses cut plane height settings to determine if an object is above or below the display range.

**display configuration** The arrangement of objects in individual viewports. Display configurations can be fixed view or direction-dependent view. Each
display configuration has one or more display representation sets associated with it.

**Display Manager** A central location for all display information in a drawing.

**display properties** Display properties affect the way an object appears in the drawing. You can override the default properties for the current display configuration by changing visibility, layer, color, linetype, hatching, and cut plane height for an object.

**display range** Range of elevation above and below the cut plane.

**display representation** A level of display control in which the user can specify settings such as layer, color, linetype, and visibility for individual components of objects.

**display set** A saved set of display representations, which can be associated with a display configuration. See also display configuration and display representation.

**documentation** Any output records of a building project, consisting of working drawings, specifications, schedules, and other information pertaining to the building.

**documentation phase** The phase of a project in which annotation is added to drawings to clarify and record design specifications as well as to reference together the complete set of construction documents. See also annotation.

**documentation symbols** See annotation.

**domain** In Content Builder a family defined by a set of common characteristics within a specified engineering industry. A fixed list of part groups, where each group is based on one type of building systems component, such as duct, pipe, cable tray, conduit, plumbing, or MvPart. Each group has a unique behavior in AutoCAD MEP according to component type.

**downstream fixture units** The calculated value of all connected fixtures.

**drag point** The point that an AutoCAD block rotates around. Also referred to as the block's insertion point.

**drawing area** The area on screen in which your drawings are displayed and modified. The size of the drawing area varies, depending on the size of the AutoCAD window and on the number of toolbars and other elements that are displayed.

**drawing environment settings** The variables and settings for new drawings as defined by the default template drawing. See also template.
duct and pipe length The actual length of a duct and pipe segment. You can break segments or an entire run into several segments.

DWG A part definition file format that stores model geometry; used for saving vector graphics from within AutoCAD.

DWT Standard file format for AutoCAD template files. See also template.

dge offset The distance from the face of a component to a specific baseline.

e (An angled fitting that changes the direction of a run. Typical angles are from 22 1/2 degrees to 90 degrees.

elbow angle See bend angle.

elevation (1) The default Z value above or below the XY plane of the current user coordinate system; used for entering coordinates and specifying locations.

elevation (2) The vertical distance between the level where fluid enters a pipe and the level where it leaves.

elevation (3) An orthographic projection of a building model. See also model.

elevation difference The difference between the selected pipe and the highest fixture, also known as the limiting fixture.

elevation labels Annotation used to dimension height values in plan and section views. See also annotation symbols.

elevation marks Annotation used to designate where source objects are being cut to generate an elevation view.

don-of-line symbol An AutoCAD block that typically appears at the start or end of a schematic line and is not anchored to the schematic line.

e engineering data Design specifications assigned to spaces, zones, and ductwork; used to calculate energy requirements for rooms and zones.

e engineering properties Energy requirements assigned to spaces and zones. These calculations are derived from analysis by an external tool, and then imported into the drawing and assigned to the appropriate zones.

d entity reference (entref) An object that makes a reference to another object and updates dynamically if the referenced object is altered. Entity references are similar to blocks, except that their definitions must remain as objects in the drawing editor.

estimated demand load The calculated load based on the demand factor definition for a Power and Lighting circuit or device.
explode The conversion of a complex object, such as a block, into its basic objects, such as lines and circles.

**external reference (xref)** A drawing that is linked to another drawing.

**fabrication** The process of manufacturing duct fittings or assembling pipe spool sections.

**feature** In Content Builder a building block of a parametric part model. You combine features to create parametric models.

**feeder** A circuit, such as conductors in conduit or a busway run, that typically provides a high current carrying capacity (larger than branch circuits).

**fitting** Any type of connector used to join 2 or more individual segments, for example, a tee and an elbow.

**fixture (1)** Any electrical device that consumes power.

**fixture (2)** A device (sink, tub, toilet) that either provides or disposes of a supply of water.

**fixture tag** A type of annotation that links property set information to schedule tables for fixtures, such as toilets and sinks.

**fixture unit** The design factor used to determine the load-producing value of various plumbing fixtures.

**flange** A plate or flat ring bolted to the projecting collar at the end of a segment of pipe to close the end or connect it to another segment. A joint type that mates with another flange to connect pipes, fittings, or equipment.

**flange face** The mating surface of a flange that makes contact with the mating flange to complete a connection.

**flat riser diagram** Orthographic riser diagrams are also referred to as flat riser diagrams. See also orthographic riser diagram.

**flexible** A flexible segment used, for example, to connect a segment to a part. Different patterns can be applied to display the flexible segments.

**float** A ball, connected to the ballcock in a tank, that rises or falls when the water level in the tank changes, and actuates or shuts off the ballcock.

**Floating Viewer** A separate window on screen that displays objects with orbit commands. See also orbit.

**floating viewports** Boundaries created in paper space that display views. See also paper space.
flow arrow Annotation used to graphically show the direction that fluid, such as water, travels through a pipe or series of pipes. Typically indicated by an arrowhead in the line representing the pipe(s).

flow diagram A symbolic drawing, typically a 2D plan, that shows the logic and operation of a building system.

flow direction The direction in which a volume of fluid moves.

flow pressure The pressure within the water supply pipe by the faucet or water outlet while water is flowing.

flow rate The volume of fluid that passes through a pipe in a specified period of time.

flush valve A valve used for flushing toilets.

free-standing symbol An AutoCAD block that is inserted into a drawing without connecting it to other objects or anchoring it to a schematic line.

gathering The tapered section of flue duct or air duct that forms a transition between the duct passage and the flue.

gauge The thickness of the material of a part.

gbXML For Green Building Extensible Markup Language. This XML format is designed to store and transfer building information in CAD drawings. gbXML is used to store space and zone data, and can be used in external analysis tools to determine energy requirements.

GFCI (GFI) For Ground Fault Circuit Interrupter. A type of circuit breaker or receptacle device (commonly required in kitchens and bathrooms) that helps to safeguard against shocks.

glued connection A type of permanent pipe connection used to join individual pipe segments; involves applying a watertight adhesive to the pipe segments.

governor A device that gives automatic control of temperature or pressure.

grids AEC objects on which you can anchor other objects, such as columns, to constrain their locations.

grips Control points used to modify objects such as spaces, schematic symbols, and duct segments.

grooved connection A type of detachable pipe connection used to join individual pipe segments. The pipe segments have male or female grooved ends to create a watertight joint.

ground (1) The endpoint for a current.
ground (2) A large conducting body (as the earth) used as a common return for an electrical circuit in order to prevent the buildup of voltages that may result in hazards to connected equipment or to persons.

grounded conductor Also referred to as the neutral conductor. The return path for current in a normal (non-faulted) electrical system.

grounding conductor Also referred to as the safety ground or equipment ground. Removes the potential for electrical shock of persons in contact with energized metal parts due to a ground fault.

hand wheel A wheel, such as a valve wheel, that is turned by hand.

handle A unique alphanumerical tag for an object in the AutoCAD database.

heating load The amount of heating units required for a room or zone based on engineering space analysis.

hidden line Portions of an AutoCAD MEP object that can be displayed with a user-definable linetype when obscured by an object at a higher elevation. For example, a hidden line can be shown as dashed.

home run The wire segment connecting the end of a circuit to the associated electrical panel. Typically, an arrow is used to represent the direction of the panel’s location on an electrical drawing.

hose bib (1) A water faucet to which a hose may be attached.

hose bib (2) A valve with an external threaded outlet for accepting a hose fitting.

I.D. For inside diameter.

ID For identification. A number or string of characters that you can assign to symbols. The ID can also be used to group schematic symbols, devices, or panels for scheduling purposes.

in-line symbol An AutoCAD block that can be anchored anywhere along a schematic line.

instant sizing A tool used to calculate an object size as you draw it. There are instant sizing tools for ductwork and wiring.

insulation thickness The thickness of insulation added to the outside of a part.

invert The part of the interior of a drain or a sewer pipe where the liquid is deepest.
**invert elevation** The elevation of the lowest point along the inner diameter of the end of a pipe.

**invert elevation calculation** The invert elevation determined by the resulting value of a mathematical equation. Typically, the invert elevation of one end of a pipe (A), the slope (B), and the horizontal length (C) are known, and a mathematical equation is used to determine the invert elevation of the other end of the pipe (D). For example, if A is higher in elevation than D, the following equation is used: A2(B3C)5D.

**isometric** A drawing or view in which the X, Y, and Z axes are spaced 120 degrees apart and the Z axis is projected vertically.

**isometric line** A line that represents pressure or temperature changes under conditions of constant volume.

**isometric riser** The vertical segments included in an isometric drawing or view. See also isometric.

**isometric riser diagram** The most common riser diagram for plumbing; provides a 3D representation of the plumbing system in a 2D drawing. Generally not drawn to scale, but shown to be correctly proportioned. In other words, a long run of piping in the plumbing plan is shown as a long run of piping in the riser diagram. Includes symbols for the piping and fittings.

**isometric snap** An AutoCAD drafting option that aligns the cursor with 2 of the 3 isometric axes and displays grid points, making isometric drawings easier to create.

**isometric symbol style** Default symbol properties, such as appearance or connection cleanup type, that are assigned to a specific symbol or a group of symbols in an isometric drawing or view. See also isometric.

**isometric symbols** Symbols used to represent components or equipment within a plumbing system included in an isometric drawing or view. See also isometric.

**isoplane** AutoCAD Architecture command that specifies the current isometric plane (left, top, right).

**joint** A method for attaching pipe segments to each other, to fittings, or to equipment such as flanges, couplings, or butt welds.

**junction box** A plastic or metal box used to protect wire connections. Typically, the boxes are fastened to the structural framing, and devices such as receptacles and switches are attached to the boxes.
justification/offset A value used to determine the orientation of a segment relative to its centerline for layout.

kickpipe A short pipe that guards an electrical wire or cable.

label curve An imaginary curve on which text characters appear to rest.

labels Annotation used to display object or part information in a drawing, such as text, block definition, and dimensions.

lateral A pipe branching away from the central, primary part of the system, especially in a gas distribution or transmission system.

layer A logical grouping of data equivalent to transparent overlays in manual drafting. Layers can be viewed individually or in combination.

layer key style A set of layer keys with their associated layer names. See also layer keying.

layer keying A method of placing objects in a specific layer as they are drawn. A particular layer key can be assigned to any predefined layer name.

layer management tools Tools to help organize, sort, and group layers, as well as to save and coordinate layering schemes.

Layer Manager The central location for all layer information in a drawing.

layer standard A predefined list of layer names or layer group names, and a set of rules for determining how new layer names are created.

layout curve A linear grid that attaches node points to an object with a base curve, for example, polylines.

layout method The ability to select how to draw a duct, pipe, or conduit run.

layout mode A setting by which the nodes in a grid can be spaced evenly, repeatedly, or manually.

layout tabs A tool to switch between model space, where you spend most of your time creating and editing drawings, and other pre-configured page setups.

leader A line that visually connects annotations to a drawing object.

length A unit of measurement for duct, pipe, cable tray, or conduit; useful when determining the number of individual segments for a manufacturer to supply.

lever (1) A rigid bar that transmits and changes force or motion when force is applied at 2 points and it turns about a third point.
lever (2) A projecting piece by which a mechanism is adjusted.

line annotation Line annotation (1 or 2 line annotation) is the type of graphic representation used to represent cable trays. You can select from a list of predefined graphical types.

line cleanup (design rules) Refers to the process of trimming or extending pipe segments or components in order to show connected objects. Design rules define the automatic process that takes place when objects are added together.

lining thickness The thickness of lining added to the inside of a part.

load diagram A symbolic drawing, typically a 2D plan, that shows the layout of an electrical system.

location A part’s actual X, Y, Z coordinate location in a drawing. The insertion point and angle of rotation are also stored as part of the location property.

match lines Annotation referencing another drawing that contains additional sections of a model. For example, a plan view of a building with the east side of the building in one drawing and the west side in another drawing would have a match line on each drawing to show where the building was split.

material The substance that a part is made of, such as plastic, metal, or steel.

mode Determines the drafting view—orthographic or isometric—when creating a schematic diagram using schematic lines and schematic symbols.

model (1) A 2D or 3D representation of one or more objects.

model (2) In Content Builder the parametric shape representing all possible sizes, and defined by parameters, geometry, dimensions, and geometric constraints.

model space One of 2 primary spaces in which objects reside. Typically, a building model is placed in a 3D coordinate space called model space. A final layout of specific views and annotations of this model is placed in paper space. See also paper space.

module An assembly of self-contained, interconnected components that constitutes an identifiable device, instrument, or piece of equipment.

MvBlock For multi-view block. A type of block that can contain multiple AutoCAD blocks set to display differently in different views.

MvPart For multi-view part. An MvPart is a multi-view block with smart connectors. They include parts such as access doors, coils, fans, filters, and pumps. See also MvBlock.
**name** A character string used to identify a part. The name is predefined for parts from the catalog and content, such as schematic symbols, and is user-defined for custom parts you create, such as MvParts.

**ND** The abbreviation for the nominal diameter dimension of a part.

**network** A group of interconnected building system runs.

**node anchor** A feature that fastens, or anchors, an object to the node position of an object. The movement of an anchored object is constrained by the other object. See also cell anchor.

**nodes (1)** An object snap specification to locate points, dimension definition points, and dimension text origins.

**nodes (2)** Points to which an AEC object can be attached, controlling the position and rotation of the object.

**nominal size (1)** A term used to distinguish between the actual size and the industry standard approximation for a particular size. For example, a pipe may be referred to as $\frac{1}{4}$ inch, although the actual dimension on the drawing is 0.2495 inch. Therefore, the nominal size is $\frac{1}{4}$ inch.

**nominal size (2)** For conduit, refers to diameter dimension, based on the conduit’s outside and inside diameters, in compliance with industry standards; also referred to as trade size

**north arrow** A graphical symbol used to designate the north direction in space on a site plan or other plan view drawing.

**number of devices** The total number of connected devices in the drawing and on the circuit; common to all system types.

**O.D.** For outside diameter.

**object** A collection of one or more graphical elements, such as lines, circles, polylines, text, or dimensions, treated as a single element for creation, manipulation, and modification.

**object anchor** See also anchor.

**Object Enabler** See also AEC Object Enabler.

**object snaps** Methods for selecting commonly needed points on an object while you create or edit AutoCAD drawing. See also snaps.

**object type** See type.

**Object Viewer** A separate window that can display any drawing objects. You can manipulate and view the objects with orbit commands. See also orbit.
off center A setting that provides the ability to connect takeoffs at any location within a duct segment.

off-the-shelf parts Regularly manufactured parts typically found in stock and commonly used in the building industry.

offset See justification/offset.

opening symbol Annotation used to designate the need for an opening in a structural component, such as an opening in a load bearing wall for duct work. See also annotation.

orbit To navigate an object in a graphics display window, such as the Floating Viewer or Object Viewer, with user-selected view geometry rotating around a center axis. Using 3D orbit, the user can inspect the object in real time. See also 3D orbit viewing, Floating Viewer, and Object Viewer.

orthogonal Having perpendicular slopes or tangents at the point of intersection.

orthographic projection The flat-projected 2D representation of a 3D object or model. Typically consists of the top, front, and side views of an object or model.

orthographic riser diagram Also called flat riser diagram. Less often used in construction drawings, it shows the plumbing system in elevation. Used for buildings of 2 or more stories that may require more than one orthographic riser diagram to clearly describe the entire plumbing system.

package unit A year-round heating and air conditioning system that has all the components encased in one unit, typically outside the building.

panel name Unique identification used to differentiate a panel when creating circuits.

panelboard A single panel or group of panel units designed for assembly in the form of a single panel. See also panel.

paper space One of 2 primary spaces in which objects reside. Paper space is used for creating a finished layout for printing or plotting, as opposed to doing drafting or design work. Model space is used for creating your model. See also model space.

parallel run (1) Technique to simultaneously lay out parallel routing of pipework (for hot and cold water systems or radiant heating systems) or of conduit
parallel run (2) Technique to draw a duct or pipe run that is offset a specific distance from existing geometry, such as a wall, in a referenced drawing.

parameters Specific part properties, such as height and width, that are required to generate a part.

parametric In Content Builder a solution method that uses the values of part parameters to determine the geometric configuration of the part.

part (1) A specific part size when referenced in AutoCAD MEP.

part (2) A part family when referenced in Catalog Editor or with regard to content.

part catalog A collection of common, industry-specific, real-world parts typically organized into chapter folders of related parts that can be selected for integration into building system designs.

part data A collection of parameters whose values define a part; stored in an XML file.

part family A collection of related part sizes.

part properties Specific details or traits of an individual building systems part.

part size In Content Builder a specific set of values applied to the parametric model to define a single size.

part size name The unique name of a part stored in the part catalog and used when selecting parts during layout.

path angle (1) In Content Builder, defines the sweep (angle direction) that the software uses to ensure that the 3D part is built correctly. Path Angle is a default setting that appears as PathA1, PathA2, etc.

path angle (2) For conduit fitting, angle referencing the arc's scanning path; angle values are stored in the catalog depending on the type of fitting.

perspectives 3-dimensional views of a model that apply the principle that objects appear smaller when they are farther away, resulting in a true-to-life representation of the model. Perspective views are generated using the AEC camera commands.

phase type The type of electrical power, 1-phase or 3-phase.

pigtail A short piece of wire used to extend or connect wires in a junction box.

plan view A view of a drawing from above, looking down the Z axis and perpendicular to the XY plane of the current UCS.
plenum The area where the ductwork connects to a furnace unit. Often containing the evaporator coil—the main indoor component of the air conditioning system.

plumbing fitting A plumbing component, such as an elbow, tee, union, or coupling, for connecting individual pipe segments.

pneumatic Operated by air or by the pressure of air.

pressure drop The pressure drop displays the loss of pressure between the limiting fixture and the source.

pressure-reduction valve Used at the point where water comes into the house, in order to eliminate or reduce the pressure that causes water hammer.

primitive A limited version of a part model that is designed for repeated use in part creation. A primitive can represent a basic shape, such as a box, or a connection on a part, such as a flanged pipe connector.

quick select A sorting filter used to separate selected objects by property (such as layer) or by object type.

quick slice A plane generated from 2 selected points and an entity used to slice through an AEC object. The resulting profile becomes a polyline that is added to the current layer. See also slice.

raceway A routing system used to run electrical wires around a building.

radius of curvature Industry-standard radius specification; varies depending on the part’s nominal size

reducer A fitting that connects different size segments together.

regenerate To step through a part catalog structure and validate all parts.

regenerate (regen) To update the screen display of a drawing by recomputing the screen coordinates from the database.

representation sets See display representation set.

reverse flow The changing of direction of the fluid, such as water, that travels through a pipe or series of pipes.

revision clouds A cloud-like boundary used to designate changes made to the final construction drawings.

rise/run The pitch of an inclined segment, usually expressed as the ratio of the vertical rise to the horizontal run. Rise is the vertical difference in elevation from end to end of the segment. Run is the horizontal distance covered by the segment. Also referred to as slope.
riser (1) A vertical assembly of pipe segments and fittings that distributes a fluid such as water in an upward direction, typically between floors.

riser (2) A vertical assembly of piping that connects a faucet to the water supply stop valve. See also component.

riser diagram See isometric riser diagram and orthographic riser diagram.

riser objects The common symbols used in a riser diagram: drop, riser, tee up, tee down, drop and run, drop and turn, tee off top, tee off bottom, cross and riser, plan elbow, and plan tee.

rotation Specifies the circular turn of an object inserted into the drawing. The rotation controls the X and Y angles of the object in the current UCS.

routing Minimizes the number of steps when completing a layout. It calculates the position of the elbow while drawing the next segment with a specific angle.

routing preferences Used to draw accurate building systems in auto layout and to specify which pipe or conduit part to insert as you lay out the run.

run (1) An assembly of building system components that is used to carry air or water from one point, such as an air terminal or a pump, to another point, such as the junction of another run. See also component.

run (2) A portion of a pipe or fitting lying in a straight line in the same direction of flow as the pipe to which it is connected.

sampling circuit A circuit whose output is a sampling of the values of the input at a series of points in time.

sand filter A filter consisting of graded layers of sand and aggregate for purifying domestic water.

sanitary A gravity drain system that requires piping to slope at a specific angle so that fluid drains properly. The US standard for angles is typically a specific distance over one foot, i.e., 1/4 inch/1 foot.

scale The factor used to physically size the panel object in a drawing.

schedule A tabulation of data extracted from objects in the drawing. Used to create bill of materials, panel loads, and related tabulations.

schedule table The tabular representation of schedule data extracted from the drawing, formatted according to rules set in a schedule table style.
schedule tag A unique annotation tag linked to a drawing object by a schedule anchor for the purpose of extracting schedule data and displaying it in the drawing.

scheduling The process of producing graphical tables showing details of the materials required to purchase and build the system. For example, a panel schedule is a table listing all the circuits and components associated with a specific panel in a building structure.

schematic A not-to-scale 2D drawing or view, used to show the logic or flow of a plumbing system. Schematic design is the initial design phase of a building project and usually includes the general arrangement of equipment and basic system layout.

schematic design phase Initial design phase of a building project. Also referred to as conceptual or preliminary design.

section (1) A representation of an object as it would appear if cut by an imaginary plane, showing the internal structure.

section (2) A representation of a building, or portion thereof, drawn as if it were cut vertically to show the interior.

section (3) An orthographic projection of a model.

section marks Annotation used to designate where source objects are being cut to generate a section view.

segment An individual piece of ductwork or piping connected together by fittings to create a run. Typically, a straight piece of duct or pipe cut to a standard length determined by the design and/or manufacturer.

segment mode The layout method for flexible duct or flexible pipe. You can specify Line mode, Arc mode, or Spline mode.

service disconnect A switch that enables a person to shut off power to the building (normally used for maintenance or in emergency situations).

service drop Run of cables from the power company’s aerial power lines to the point of connection in the building.

service entrance The location where the incoming power supply enters the building.

service equipment The necessary equipment, usually consisting of a circuit breaker or switch and fuses and their accessories, located near the service entrance to a building and intended to act as the main control and cutoff means for the power supply to the building.
service lateral The underground service lines between the street main, including any risers at a pole or other structure or from transformers, and the first point of connection to the service-entrance lines into a building.

service panel The main electrical panel where all the circuits tie into the incoming power supply.

service/supply leads The incoming electrical lines that supply power to the service panel.

shape The physical appearance of a segment or fitting, such as rectangular, oval, or round, of a segment or fitting, that defines which part catalog to use during layout.

single pole A switch that controls a device from one location.

single-line drawing A plan view drawing that uses a single line to show the plumbing system and describes the basic function of the system. The centerline of the pipe, regardless of pipe size, is drawn as a single line to which valve, equipment, and fixture symbols are added. The size of the symbols is left to the discretion of the drafter.

size The actual dimensions of a part, including length, width, height, and diameter.

size parameters A specific type of part data used to define one or more part sizes, depending on how the size parameter is stored in the part family.

slice An object representing a horizontal section, or slice, through any collection of AEC objects. See also quick slice.

slope The pitch of an inclined segment, usually expressed as a ratio of the vertical rise to the horizontal run of the segment. Slope is commonly expressed in a fractional format, 1/4 inch/1 foot or 1/10. See also rise/run.

slope arrow labels Arrows used as annotation to specify the slope of a pipe segment. See also slope.

slots The spaces to install circuit breakers in an electrical panel (also referred to as “poles”).

snap angle The angle around which the snap grid is rotated. See also snap grid and snap mode.

snap grid An invisible grid that locks the cursor into a specific alignment and snap increment when Snap mode is enabled. Snap grid does not necessarily correspond to the visible grid, which is controlled separately by the GRID command. See also snap angle and snap mode.
**snap mode** A drawing mode where the cursor is locked into alignment with an invisible grid, forcing the cursor to snap to the nearest point on the grid. See also snap angle and snap grid.

**snaps** Object methods for selecting commonly needed points on an object while you create or edit a building systems layout. Snaps in AutoCAD MEP are accurate snap points of connection for building systems components. See also object snaps.

**socket weld** A joining method where a pipe is inserted into a socket of a coupling, fitting, or equipment nozzle. The pipe is then welded in the socket. This method is similar to that of a solder joint for tubing. The depth of the connector is defined by the connection engagement length value. See also connection engagement length (CEL).

**socket welded** Threaded metal pieces twisted together and then fused at the socket.

**solution tip** A tooltip that displays when you hover the cursor over a solution tip icon, and describes a potential problem and suggested solution for an invalid connection between two objects.

**space** A tool used to model the interior space and heat transfer elements in a room. The space also stores engineering data, such as design temperatures and air flow requirements. The information for spaces is analyzed to determine energy requirements for a building.

**spatial interferences** When 2 parts intersect or collide in an undesirable way. Hard interferences refer to interferences created by parts that collide with each other, creating a physically impossible design situation, such as a pipe running through a duct. Soft interferences refer to interferences that impact design considerations, such as space allocations, type of material, amount of insulation, and access methods.

**spigot/plain end** A mating pipe or fitting that is inserted into a female coupling

**spline** A blended piecewise polynomial curve passing near a given set of control points. A flex duct can be drawn as a spline.

**storage type** A collection of related parameters with unique characteristics that determine how the part data defines the part; 4 storage types: basic table, constant lists, constants, and calculations.

**Style Manager** Style Manager provides a central location where you can work with styles from multiple drawings and templates.

**style name** A name used to identify part styles. See also styles.
styles A group of preset characteristics assigned to an object that determine appearance and function.

subtype Additional characteristics of a part’s type. For example, a pipe segment’s subtype might be smooth or rigid.

supply air Air produced from an air handling unit that is used to heat or cool a building or room.

supply duct The duct run that air flows through to distribute air to a building or room.

surface height Overall height for an engineering space, including ceiling thickness and any space above the ceiling.

switch-leg The part of a circuit run from a lighting outlet box where a fixture is installed to an outlet box containing the wall switch that turns the light or other load on or off; control leg of the branch circuit.

symbol library A collection of block definitions stored in a single AutoCAD drawing file.

system An optional property used to group parts based on real-world building systems.

system abbreviation A string of characters used to represent the system name; used for labeling and scheduling and is typically defined when a system definition is created.

system group The name of the group associated with a part’s system definition. System groups are used to associate or group together multiple systems.

system label Annotation used for managing system type abbreviations for labeling.

system type A classification for a system; such as the system’s object type.

tangent The angle of a curve.

tee A T-shaped fitting that is used to create branch runs.

template A prototype drawing with predefined settings, borders, and layout tabs that can be used as the basis for creating a new drawing.

terminal A device, typically located in a branch duct, that dispenses or removes air from the duct system to control the temperature and/or quality of the air.

therm A unit of measurement for heat. One therm equals 100,000 BTU.
**threaded** A joining method where a pipe is prepared with a male threaded end. The pipe is then inserted and screwed into a female threaded coupling, fitting, or equipment nozzle.

**title marks** Annotation that identifies a drawing.

**tooltips** Tooltips display a description when you hover the cursor over items such as toolbars and icons.

**transition fitting** See reducer.

**trip lever** The handle that is rotated to initiate the toilet flush cycle.

**trunk** The primary duct from which secondary runs branch; typically, the largest duct of the system.

**type** A part’s object classification, such as duct or pipe, each with unique characteristics and behaviors.

**unconstrained layout** Drawing pipe between an object to a point in space

**UV filter system** A system in which water is sterilized in an ultraviolet chamber, where UV rays purify the water by killing micro-organisms.

**vanes (1)** Stationary plates inside a duct used to control air flow.

**vanes (2)** In building systems, vanes indicate whether an individual duct fitting contains turning vanes. Turning vanes are mounted into fittings to reduce pressure loss. To display the turning vanes in plan view, they must be added to the fittings style using the Add Vane command.

**vertex** A vertex is a location where spline segments meet. It is also the location of the grip points in a spline.

**vertex X** The X coordinate location of a pipe segment or component on an XY axis.

**vertex Y** The Y coordinate location of a pipe segment or component on an XY axis.

**view** A graphical representation of a model from a specific location in space.

**viewport** A bounded area that displays some portion of the model space of a drawing. The TILEMODE system variable determines the type of viewport created.

- When TILEMODE is off (0), viewports are objects that can be moved and resized.
When TILEMODE is on (1), the entire drawing area is divided into non-overlapping viewports.

**water hammer** A pounding or knocking sound in water pipes, resulting from a sudden change in the pressure when a faucet is turned off.

**water hammer arrestor** A piece that absorbs the extra pressure that causes a water hammer condition in domestic use when the problem involves only a few fixtures.

**WCS** For World Coordinate System. The coordinate system used as the basis for defining all objects and other coordinate systems.

**wired circuits** Designates the circuits that are contained in a specific wiring run.

**work plane** An infinite plane related to one or more features of the model. Work planes provide a defined place in space from which to build the model.

**workflow** The general flow process of designing a building system or other design project. Typically includes multiple phases.

**wye** A Y-shaped fitting used to create branch runs.

**XML** An extensible mark-up language (XML) file that contains part definition data for a part family, including common and size parameters.

**xref** See external reference.

**XY angle** The actual angle between 2 segments that is a result of the rise and run values. See also rise/run and slope.

**zone** A group of spaces that model an actual heating and cooling zone in a building. The data associated with a zone is exported in gbXML format, and analyzed to determine energy requirements.
Index

1 line
display representation 211
duct, drawing 299
graphical display 377
pipe display 377, 415
screened display representation 211
2 line
display representation 211
pipe display 377, 415
screened display representation 211
3D models, creating for block-based parts 1127
3D orbit
previewing pipe routing solutions 371
viewing, definition 1199
A
abbreviations 143
access panel, definition 1199
acid neutralizer, definition 1199
actual velocity, definition 1199
add grips
for conduit and cable tray 629
for duct 298
for pipe 385
for plumbing 731
add pipes command 429
adding
block-based parts 1125
connectors to parametric fittings 1019
dimensions to parametric fittings 1026
dimensions to parametric MvParts 1081, 1084, 1086
elevation labels 860
HVAC parts 290
labels 832
parallel conduit runs 632
parallel duct runs (offsets) 307
parallel pipe runs (offsets) 459
parallel pipes to radiators 506
parametric parts 970
part number tags 839
part sizes to parametric fittings 1029
part sizes to parametric MvParts 1088–1089, 1091
radiators to drawing 497
radiators using calculated data 493
radiators using calculation program 492
schematic symbols for block-based parts 1129
adding cable tray
adding fittings manually 638
creating runs 625
grips 629
methods 622
adding conduit
adding fittings manually 638
creating branches 631
creating runs 625
grips 629
methods 622
parallel runs 632
adding duct 298
adding a takeoff 263, 310
adding inline equipment 291
adding sloped 308
connecting through xrefs 310
connecting to MvParts 297
converting polylines to flexible 313
creating from lines 313
described 292
drawing 1-line 299
drawing a run 292
drawing a vertical run 299
fitting 304
flexible 306
grips 298
locking elevation 309
offsetting from geometry 308
parallel runs (offsets) 307
using instant sizing 292
adding pipe
about 429
connecting to MvParts 442
creating systems 419
drawing flexible pipe 457
fittings 452
grips 385
inline equipment 428
joints 452
locking elevation 409
MvParts 428
offsetting from geometry 460
parallel run (offsets) 459
parallel run (radiators) 506
pipe tool palette 429
placeholders 381
preferences override, described 448
properties palette 420
specifying parts manually 447
starting add pipes command 429
takeoffs 462
using routing solutions 371
vertical segments 444
adding plumbing runs using grips 731
adjacent surface 1199
adjust slope, definition 1199
ADSK file 123
AEC content, defined 1182
AEC Model drawing template 241
AEC objects
definition 1199
enabler, definition 1199
AEC Sheet drawing template 241
AECBANCHORFLIPX command 180
AECBANCHORFLIPIPY command 180
AECBANCHORFLIPZ command 180
AECBANCHORRELEASE command 180
AECBCOMPASS command 182
AECBCOMPASSBAR command 182
AECBLAYERSTD command 205
air terminals
configuring for analysis 291
flow annotation 348
modifying flow values 349
ALIGN command 29
aligning
devices 577
faces with constraints 1062
geometry with work planes 977
view blocks with model blocks 1114
alignment grips 503, 605, 648
ambient temperature 611
analyze tab 65
analyzing
importing duct data 339
resizing duct systems 340
anchor method for inserting parts 1118
Anchor Part property 1004
anchoring
release 180
with a curve anchor 177
with a reference anchor 179
with a system anchor 178
anchors
AutoCAD MEP 176–181
curve 177
definition 1199
pipe fittings 469
properties 181
reference 179
releasing 180
schematic symbols 792
system 178
working with 176, 181
ANCHORTOBCURVE command 177
ANCHORTOBCURVEATTACH command 177
ANCHORTOBCURVESETCURVE command 177
ANCHORTOBCURVESETEND command 177
ANCHORTOBCURVESETPOSITIONX command 177
ANCHORTOBCURVESETROTATION command 180
ANCHORTOBCURVESETROTATIONX command 180
ANCHORTOBCURVESETROTATIONY command 180

1228 | Index
ANCHORTOBSMEMBER command 177
angle 983
  definition 1199
angle of deflection
  connection details 174
  definition 1200
  fitting tolerance 426
  male-female connections 405
angles, rise/run 713
ANNOALLVISIBLE system variable 822
ANNOAUTOSCALE system variable 823
annotate tab 65
annotating duct
  adding flow arrows 318
  adding hatching patterns 238, 320
  adding labels 318
annotating pipe
  adding flow arrows 465
  adding labels 465
annotation
  adding to parametric schematic
    symbols 1106
  air terminal flow 348
  configuring for pipe 435
  definition 1200
  elevation labels 860
  for pipes, described 465
  labels 832–861
  preferences, cable trays 557
  preferences, conduits 557
  scale representations, adding 823
  scale representations, modifying 823
  scaling 815
  specifying the annotation scale 821
  style properties for plumbing
    lines 722
  style properties for schematic
    line 780
  style properties for wires 551
  symbols, definition 1200
  using symbols from
    DesignCenter 833
annotation scale
  annotative objects 815
  flag, definition 1200
  specifying 821
annotative objects
  AutoCAD Architecture objects 815
  AutoCAD MEP objects 815
  AutoCAD objects 815
  defined 815
  displaying 822
  hiding 822
AoD 174, 405, 426
APC, definition 1200
application menu 48, 70
  accessing 71
  changing recent files count 75
  displaying recent documents 73–74
  finding commands 61
  locating commands 71
application status bar 81
  modify 84
architectural elements, definition 1200
ARRAY command 30
ARX command 1183
ASHRAE
  fitting, definition 1200
  specifying duct fittings 336
associative movement
  for pipe, described 387
  for plumbing, described 701, 797
attribute, definition 1200
AutoCAD
  exporting drawings to 824
AutoCAD commands 28
AutoCAD MEP
  anchors 176, 181
  objects 43, 152
  overview 41
  overview, user interface 48
  regenerating model 193
  snaps. See snaps
tooltips 107
  updating 47
AutoCAD MEP snaps
  duct, described 264
  electrical 523
  parallel duct runs (offsets) 307
  parallel pipe runs (offsets) 459
  pipe 409
wire ways 523
Autodesk Exchange file (.adsk) 123
Autodesk seek 50
Autodesk subscription program 47, 881
Autodesk, contacting 46
autolayout
  for duct, described 261
  for piping, described 370
  overriding default parts for pipe 448
  sloped piping 374
  using piping routing solutions 371
AutoLayout flag 1004

B

ballast, definition 1200
base curve, definition 1200
baseline, definition 1200
basic tables
  parameters, adding sizes 1159
  storing part data 1156
bay, definition 1200
behaviors
  changing for block-based parts 1144
  defining for block-based parts 1132
  rules for connectors 974
bell/hub
  connector behavior 975
  creating parametric parts 974
  definition 1200
  female connectors 995
bend angle
  conduit 533
  definition 1201
  pipe 423
bend radius. See radius of curvature bends. See plumbing fittings bent conduit, definition 1201
bitmap, definition 1201
BLDSYSPURGE commands 878
blind extrusion modifier 987
block-based parts
  3D model block 1113
  about 959
  assigning layer keys 1117
  behavior 1116, 1144
building environment 962
changing part size names 1144
connectors 1122, 1136, 1144
creating 1125, 1127
creating 3D models 1127
creating schematic symbols for 1129
defining behaviors 1132
definition 1201
direction vectors 1123
modifying 1141
part size names 1133
preview images 1121, 1135, 1144
property set information 1139, 1145
property sets 1124
schematic symbols 1115
starting Content Builder 1131
tips for creating 1113
view blocks 1119, 1133
workflow for creating with Content Builder 1125
block-graphics 815
blocks
  converting to device styles 927
  converting to schematic symbol styles 943
  creating from device styles 925
  creating from schematic symbol styles 940
definition 1201
rise/drop display representations 916
BMP, definition 1201
boolean add modifier 989
boolean subtract modifier 989
branch angle 424
branch circuits, definition 1201
branch fitting 426
braze, definition 1201
BREAK command 30
Break Into Part property 1004
break marks, definition 1201
break/overlap paper width 722
Break/Overlap Paper Width property 551, 780
breaking
  cable trays and conduits 556, 677
chapters, selecting 1155
constant lists 1157
constants 1157
definition 1202
details pane 1153
menu bar 1153
migrate catalogs 1167
navigation pane 1152
opening 1153
opening part catalogs 1154
overview of features 1151
overview of the user interface 1152
part data, modifying 1156
part families, selecting 1155
part sizes, selecting 1156
parts, adding custom data 1160
parts, adding sizes 1158
parts, creating 1158
preview image window 1153
storage types, selecting 1156
table view 1153, 1156
toolbar 1153
tree view 1152, 1155
using 1152
working with Excel 1163
catalog test 1164
catalog-based content
  creating, plumbing 716
electrical 115
CATALOGREGEN command 1165
catalogs 115, 122
  adding sizes for parts 1158
  AutoCAD MEP 115
  creating 1161
  creating parts in Catalog Editor 1158
  customizing 1154–1164
defaults 100
file locations 1154
migrate part catalogs 1167
modifying chapters 1162
modifying part properties in Catalog Editor 1160
opening in Catalog Editor 1154
redefine parts 1168
regenerate 1165
saving 1163
  selecting in Catalog Editor 1155
  selecting parts from 117
structure 117
upgrade catalog data 1167
validate parts 1164
validating 1163
CATALOGTEST command 1164
categories
  part 1116
CCF files 930, 945
definition 1202
CCT files 930, 945
ceiling grids, definition 1202
CEL (connector engagement length) 404
cell anchors, definition 1202
centerlines
  definition 1202
displaying on ducts 236
  pipe 160, 371, 392, 395, 429, 438, 448, 454, 460, 462–463, 472, 481
  straight centerline display 380, 419
CHAMFER command 31
changing
  behaviors 1144
  UCS planes 183
channel style 1192
chapters
  definition 1202
  radiator MvParts 491
  selecting in Catalog Editor 1155
chase, definition 1202
checking. See troubleshooting
Choose a Part dialog, for pipe 447
circuit
  breaker rating, definition 1202
  length, definition 1202
  load, definition 1203
  name, definition 1203
  voltage, definition 1203
circuit information
  accessing 641
tools
  Circuit Manager
  about 517
configuring a circuit 571
creating circuits 569
opening 572
See also circuits
circuit reports, creating 642
circuit settings 596
CIRCUITCONFIGPROJ command 541
CIRCUITINFO command 641
CIRCUITMANAGER command 517
CIRCUITRELOADPROJ command 566
CIRCUITREPORT command 642
circuits
  changing properties of 646
  checking loads 641
  checking wire sizes 640
  configuring 571
  connecting across drawings 568
  creating using Circuit Manager 569
  creating when adding panels 596
  creating with wires 611
  deleting 647
  managing for a project 576
  modifying 645–648
  moving 646
  naming 539
  overload notifications 641
  overview 517
  reports, creating 642
  show circuited devices 643
  system types 519
  using an electrical project database 562
  viewing 572
  voltage definitions 538
  wired, definition 1225
  working with 562
  clean up, definition 1203
  collision detection 861, 865
COMMUNICATIONMODIFY command 652
  comparing drawings 881
  compass 185
    color 183
    customizing 185
    definition 1203
    settings 182, 185
    snap increment 183
  component, definition 1203
  concentric radius
    conduit 636
    parallel bends 635
    Properties palette 532
  conceptual design phase, definition 1203
  condensate line, definition 1203
  ConditionType property 326
  conduit
    bent conduit, definition 1201
    conduit elbow, definition 1203
    configuring layout preferences 560
    configuring routing preferences 527
    connection details 172
    connection type 526
    defining rise/drop styles 914
    definition 1203
    displaying by elevation 223–224
    justification 160
    labels and flow arrows 561
    matching part properties 164
    modifying run 174
    parallel bends 532
    parallel routing 632
    part size not found 318
    Properties palette 528, 534
    routing preferences 526
    slope 628
    specifying parallel bends 635
    straight centerline display 419
  CONDUIT command 524
  Conduit connector style 919
  conduit elbow, definition 1203
  conduit fittings
    adding manually 638
    connection details 172
modifying 679
rotating 680
CONDUITADD command 638
CONDUITADDSELECTED command 638
CONDUITBREAK command 677
CONDUITFITTINGADD command 638
CONDUITFITTINGADDSELECTED command 638
CONDUITFITTINGSTYLEEDIT command 896
CONDUITLENGTH command 673
CONDUITMERGE command 677
CONDUITPREFERENCES command 554
CONDUITRISEDROPSTYLE command 914
conduits. See cable trays and conduits 524
CONDUITSTYLEEDIT command 896
configurations
parametric fittings 1010
parametric MvParts 975, 1043, 1045
configuring duct
breaking at even intervals 281
connections 285
creating system definitions 288
flow arrows 286
insertion justification 279
insulation 286
labels 286
layout preferences 279
lining 286
settings 279
slope 280
configuring pipe
adding flow arrows 435
adding insulation 464
adding labels 435
creating system definition 414
deleting routing preferences 414
insertion justification 438
routing preferences 367
settings 411
CONNECTEDOBJECTS command 865
connecting dissimilar systems 141
connection details
angle of deflection 174
conduit 534
connection type 174
elevation 174
flow direction 174
location 174
nominal size 174
pipe 469
worksheet 172
connections
changing pipe 478
checking for duct 361
checking for pipe 484
checking validity of 861–862
clean up 896
conduit, maintaining 174
configuring for duct 285
details 425
joint direction 403
male-female 403
pipe, described 399
pipe, maintaining 174
rules 103
same connection 402, 975
system assignments for 195
type 402, 975
validation 171
See also connecting and connectors
connector block, definition 1204
connector engagement length (CEL) 404
criminator styles 143, 919
connectors
adding to parametric fittings 1019
adding to parametric MvParts 1074–1080
behavior 974
bell/hub, behavior 975
block-based parts 1122, 1136, 1144
butt-welded, behavior 975
configuring, device styles 542
configuring, devices 583
configuring, panel styles 549
connector styles 919
definition 1204
male or female, behavior 974
modifying, devices 656
non-standard planes 1124
orientation on fittings 994
parametric parts 994
pipe, described 399
piping types 972
plumbing fitting styles 725
properties 1019
same connection 975
specifying domains 1122
specifying location 1123
specifying shape 1123
style properties 171, 906
style properties, plumbing 725
style property rules 171, 862
style-based content 906
testing 1148
types of 972, 1123
working with 171
constant lists
parameters, adding sizes 1159
storing part data 1157
constants, part data stored as 1157
constrained layout
definition 1204
slope value displayed 375
sloped piping 372
constraints
adding to parametric MvParts 1062
definition 1204
parametric parts 983
types of 984
construction documents
creating 814
creating sheets 857
creating views 845
definition 1204
schedules 842
workflow 813
containment, definition 1204
content
definition 1204
See also style-based content
Content Browser 1174, 1178, 1183
Autodesk Exchange Format file (.adsk) 123
building component 123
Content Builder
connector behavior 974
connector properties 1019
definition 1204
dimension, definition 1206
geometry types 980
getting started 966
getting started dialog 960
model, definition 1214
modifying block-based parts 1142
modifying parametric parts 1108
overview
parametric MvParts 1042
starting for block-based MvParts 1131
starting for parametric fittings 1009
testing parts 1148
types of content 957
workflow for creating with block-based parts 1125
workflow for creating with parametric MvParts 1040
workflow for creating with parametric parts 1007
working environments 960
content packs
Global 1191
content tools for creating parts 115
context help 87
context menu
searching 61
context menus 76
contextual ribbon tabs 68
continuous load, definition 1204
conversion scripts
creating for device styles 930
creating for schematic symbol styles 945
defined 930, 945
for device styles, definition 1206
modifying for device styles 933
modifying for schematic symbol styles 949
conversion templates
creating for device styles 930
creating for schematic symbol styles 945
defined 930
convert to MvPart 1110
CONVERTDEVICECONTENT command 927
converting
lines to duct 313
polylines to flexible duct 313
CONVERTSYMBOLCONTENT command 943
CONVERTTODEVICE command 921
cooling loads, definition 1204
COPY command 31
coupling, definition 1204
creating
3D models for block-based parts 1127
block-based parts 1125, 1127
block-based parts, tips for 1113
connectors for parametric fittings 1019
construction documents 814
custom duct fittings 316
duct system definitions 288
duct systems 290
parametric fittings 1009
parametric fittings, recommendations 972
parametric parts 970, 1040
parametric parts, tips for 971
pipe part routing preferences 411
radiator parts 490
rules for parametric fittings 972
schematic symbols
schematic symbols for block-based parts 1129
crossed wires 551
crosses 973
curve anchors, definition 1204
curve, definition 1204
Custom Content File 930, 945
Custom Content Template 930, 945
custom data
adding 1160
definition 1205
storage types 1160
custom display 96
using 96
custom duct fitting 316
custom parameter groups
creating 1145
defined 1145
inserting into parts 1147
custom part sizes
parametric parts 1003
preferences 105
custom parts. See parts
custom pipe fitting 454
custom pipe fittings. See pipe fittings
Custom Sizing flag 1003
customizable style-based content 892
cut height
definition 1205
setting 224
cut length
conduit 531
pipe 404, 406, 421
cut plane 224
definition 1205
global, overriding 232
modifier 988
cutout, definition 1205

D
DDPTYPE command 1009
DDXML 336
definition 1205
exporting systems in 339
importing system data in 339
DECOMPOSEDEVICECONTENT command 925
DECOMPOSESYMBOLCONTENT
command 940
default fittings for plumbing systems 718
default, definition 1205
defining
custom equipment 1125, 1136, 1144
property sets 875
systems 148
work planes for parametric fittings 1012
defining styles
rise/drop for duct, pipe, cable tray, conduit, plumbing 914
degree of freedom, definition 1205
demand factor, definition 1205
demand load (estimated), definition 1208
demand load, managing 646
design content, definition 1205
design criteria, definition 1205
design development phase, definition 1205
design rules
specifying for styles 896
system definition 143
Design Tool catalog 1182
design workflow
for plumbing 697
designation IDs 779
assigning 783, 788, 796
definition 1206
modifying 797
DesignCenter 1182
annotation symbols 833
detail marks, definition 1206
detail view drawing 847
developed length, definition 1206
DEVICE command 520
device conversion scripts. See conversion scripts
device styles
classifications 545
connectors 542
converting to blocks 925
creating 891
creating from blocks 921, 927
creating from parts 921
design rules 541
wire cleanup 541
device type classification definition 545
DEVICEADD command 577
DEVICEADDSELECTED command 577
DEVICEMODIFY command 652
DEVICEPROPS command 197
devices
adding 577
adding and aligning 577
adding tags manually 577
adding, example 588–589, 592, 595
configuring electrical connectors 583
connecting with wires 611
copying 605
copying, example 608
creating 891
creating from blocks 921
creating from parts 921
defining style views 899
display representations 520
matching part properties 169
modifying electrical connectors 656
modifying properties 652
moving 648
moving, example 651
number of, definition 1215
overview 520
property sets, attaching manually 687
property sets, specifying in tools 687
show circuited 643
styles, specifying wire cleanup 896
tags, attaching manually 687
tags, specifying in tools 687
tools 1179
DEVICESTYLE command 541
DEVICESTYLEEDIT command 541
diaphragm, definition 1206
diffusers
configuring for analysis 291
Index | 1239
considerations prior to exporting data 338
duct size calculator, described 277
duct size tools, described 277
exporting duct system data 339
external analysis tools, described 275
importing optimized data 339
instant sizing, described 278
methods, described 275
modifying flow values 349
resizing 340
third party tools, described 275
with external tools 336

duct systems
calculating duct sizes 302
checking connectivity 361
creating 290
modifying, described 341
settings, described 258
snaps, described 264
workflow 252

DUCTADD command 292
DUCTADDSELECTED command 292
DUCTCONVERT command 313
DUCTCUSTOMFITTING command 316
DUCTCUSTOMFITTINGPROPS command 316
DUCTCUSTOMFITTINGSTYLE command 316
DUCTCUSTOMFITTINGSTYLEEDIT command 316
DUCTFITTING command 304
DUCTFITTINGADD command 304
DUCTFITTINGADDNEW command 304
DUCTFITTINGADDSSELECTED command 304
DUCTFITTINGMODIFY command 354
DUCTFITTINGPROPS command 354
DUCTFITTINGSTYLEEDIT command 354
DUCTFLEX command 260
DUCTFLEXADD command 306
DUCTFLEXADDSSELECTED command 292
DUCTFLEXCONVERT command 356

DUCTFLEXMODIFY command 356
DUCTFLEXPROPS command 356
DUCTFLEXSTYLEEDIT command 356
DUCTLENGTH command 272
DUCTMODIFY command 350
DUCTPREFERENCES command 279
DUCTPROPS command 197
DUCTRISEDROPSTYLE command 914
ducts

displaying by elevation 223–224
displaying centerlines by shape 236
flanges, display 282

DUCTSTYLEEDIT command 896
DUCTSYSTEMDEF command 288
DUCTSYSTEMDEFEDIT command 288
DUCTSYSTEMSIZECALC command 288
DUCTVANES command 358
DUCTVANESADD command 314
DUCTVANESREMOVE command 314
DUCTXMLIMPORT command 339
DWF

publishing sheet sets 860

DWG
definition 1208
DWT, definition 1208
dynamic input
command prompts 186
components 186
disabling 187
enabling 187
overview 186
setting 186

E
eccentric transitions 973
edge offset, definition 1208
elbows
creating parametric fittings 973
definition 1208
rise/drop 916
straight centerline display 380, 419

ELECSYSTEMDEF command 534
ELECSYSTEMDEFEDIT command 534

Electric connector style 919
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical catalog-based content</td>
<td>115</td>
</tr>
<tr>
<td>Display configuration</td>
<td>215</td>
</tr>
<tr>
<td>Drawings, creating</td>
<td>513</td>
</tr>
<tr>
<td>Lighting display configuration</td>
<td>215</td>
</tr>
<tr>
<td>Power display configuration</td>
<td>215</td>
</tr>
<tr>
<td>Preferences</td>
<td>538</td>
</tr>
<tr>
<td>Style-based content</td>
<td>124</td>
</tr>
<tr>
<td>System definitions, creating</td>
<td>534</td>
</tr>
<tr>
<td>Systems display configuration</td>
<td>215</td>
</tr>
<tr>
<td>Electrical connectors</td>
<td>583</td>
</tr>
<tr>
<td>Configuring</td>
<td>583</td>
</tr>
<tr>
<td>Modifying</td>
<td>656</td>
</tr>
<tr>
<td>Electrical equipment</td>
<td>290</td>
</tr>
<tr>
<td>Adding</td>
<td>620</td>
</tr>
<tr>
<td>Modifying</td>
<td>668</td>
</tr>
<tr>
<td>Overview</td>
<td>110</td>
</tr>
<tr>
<td>Electrical project database</td>
<td>564</td>
</tr>
<tr>
<td>Creating</td>
<td>564</td>
</tr>
<tr>
<td>How it works</td>
<td>563</td>
</tr>
<tr>
<td>Linking to</td>
<td>565</td>
</tr>
<tr>
<td>Reloading</td>
<td>566</td>
</tr>
<tr>
<td>Unlinking from</td>
<td>568</td>
</tr>
<tr>
<td>Using</td>
<td>517, 562</td>
</tr>
<tr>
<td>Electrical properties worksheet</td>
<td>583, 656</td>
</tr>
<tr>
<td>Electrical snaps</td>
<td>523</td>
</tr>
<tr>
<td>ElectricalPreferences command</td>
<td>538</td>
</tr>
<tr>
<td>Elevations</td>
<td>106</td>
</tr>
<tr>
<td>Difference, definition</td>
<td>1208</td>
</tr>
<tr>
<td>Labels, definition</td>
<td>1208</td>
</tr>
<tr>
<td>Marks, definition</td>
<td>1208</td>
</tr>
<tr>
<td>Preferences</td>
<td>106</td>
</tr>
<tr>
<td>End-of-line schematic symbols</td>
<td>774</td>
</tr>
<tr>
<td>End-of-line symbol, definition</td>
<td>1208</td>
</tr>
<tr>
<td>Endcaps</td>
<td>916</td>
</tr>
<tr>
<td>Engineering data</td>
<td>326</td>
</tr>
<tr>
<td>Adding to spaces</td>
<td>326</td>
</tr>
<tr>
<td>Engineering properties, definition</td>
<td>1208</td>
</tr>
<tr>
<td>Engineering space, definition</td>
<td>1222</td>
</tr>
<tr>
<td>Engineering tools</td>
<td>45</td>
</tr>
<tr>
<td>Entity reference (entref), definition</td>
<td>1208</td>
</tr>
<tr>
<td>EPD</td>
<td>517</td>
</tr>
<tr>
<td>Equation assistant</td>
<td>1029, 1089</td>
</tr>
<tr>
<td>Equipment</td>
<td>290</td>
</tr>
<tr>
<td>Adding HVAC</td>
<td>290</td>
</tr>
<tr>
<td>Adding inline to duct</td>
<td>291</td>
</tr>
<tr>
<td>Adding inline to pipe</td>
<td>428</td>
</tr>
<tr>
<td>Adding piping</td>
<td>428</td>
</tr>
<tr>
<td>As block-based parts</td>
<td>959</td>
</tr>
<tr>
<td>Changing size or elevation</td>
<td>477</td>
</tr>
<tr>
<td>Connecting to duct</td>
<td>297</td>
</tr>
<tr>
<td>Connecting to pipe</td>
<td>442</td>
</tr>
<tr>
<td>Custom, defining connectors for</td>
<td>1136</td>
</tr>
<tr>
<td>Defining</td>
<td>1125, 1136, 1144</td>
</tr>
<tr>
<td>Defining catalogs for custom</td>
<td>1118, 1132</td>
</tr>
<tr>
<td>Defining connectors for custom</td>
<td>1136, 1144</td>
</tr>
<tr>
<td>Defining sizes for custom</td>
<td>1133, 1135</td>
</tr>
<tr>
<td>Defining views for custom</td>
<td>1133, 1135, 1144</td>
</tr>
<tr>
<td>Duct, modifying</td>
<td>347</td>
</tr>
<tr>
<td>Duct, modifying elevation</td>
<td>265</td>
</tr>
</tbody>
</table>
mechanical, described 110
modifying custom 1141, 1145
pipe, matching 477
piping, described 110
plumbing, adding 728
plumbing, described 110
plumbing, modifying 739
See also MvParts
EquipmentLoad property 326
ERASE command 31
Excel, working with part data 1163
exit show all insertion points grip 648
expansion loops 738
EXPLODE command 32
problems with using on custom parts 965
explode, definition 1209
exporting
schedules as spreadsheets 845
to AutoCAD 824
to IFC 888
EXTEND command 32
external reference (xref), definition 1209
external references. See xrefs
external tools for duct sizing 336
extrusion modifier
blind 987
from-to 987
midplane 986
plane 986
tee fittings 1014
female fittings
connector behavior 974
FILLET command 33
fire protection, modifying K-factor 477
FIRESAFETYMODIFY command 652
fitting tolerance
angle of deflection 405, 426
sloped piping 374
fitting See plumbing fittings
branch 426
cable trays and conduits
tolerance 405, 426
See parametric fittings
fixed radius
parallel bends 635, 637
Properties palette 532
Fixture Unit Table tab 729
fixture unit tables 750
defining 720
modifying fixtures 740
specifying for parts 729, 740
fixture units
definition 1209
properties 713
fixtures
adding 728
definition 1209
described 110
modifying 739
tag, definition 1209
type 729, 740
FIXTUREUNITTABLESTYLE command 720
flanges
configuring display 282
definition 1209
face, definition 1209
FLEXDUCTCENTERLINE command 236
flexible duct
adding 306
flexible pipe
  annotation patterns 457
  connection details 172
  converting polylines to 466
  default layout method 457
drawing 457
  modifying layout 483
  flexible, definition 1209
  float, definition 1209
  floating view panel 64
  floating viewer 211
  definition 1209
floating viewports, definition 1209
flow arrows
  adding to duct 318
  adding to pipe 465
  air terminals 348
  configuring for conduit 561
  configuring for duct 286
  configuring for pipe 435
definition 1210
  for duct 190
  for pipe, setting direction 190
  graphics 815
  modifying for pipe 485
  preferences for plumbing 727
See also flow direction
flow coefficient 477
flow diagram, definition 1210
flow direction
  adding flow arrows 318
  connection details 174
definition 1210
  flow arrows 190
  setting for duct 190
  setting for pipe 190
flow markers, turning on or off 190
flow pressure, definition 1210
flow rate, definition 1210
flow, modifying for air terminals 349
flush valve, definition 1210
free-standing symbol, definition 1210
from-to extrusion modifier 987

G
gathering, definition 1210
gauge, definition 1210
gbXML
definition 1210
  exporting data in 45
  file for radiators 492
GBXMLEXPORT command 331
GBXMLIMPORT command 334
general circuit system type 519
general display representation 211
general screened display representation 211
general view drawing 846
generating 3D parts from 2D models 1119
geometry
  aligning with work planes 977
  creating faces 1060
  parametric parts 980
GFI (GFCI), definition 1210
Global content pack 1191
global cut plane, overriding 232
Global profile 1191, 1197
  glued connection, definition 1210
governor, definition 1210
graphical 1-line. See 1 line
  gravity pipe 367–368, 375
grids, definition 1210
grips
  adding cable tray and conduit 629
  adding duct 298
  adding pipe 385
  adding plumbing runs 731
  alignment 503, 605, 648
  constraints 188
definition 1210
  editing modes 189
exit show all insertion points 648
fittings 630
for duct, elevation 265
for duct, lengthen 272
for duct, modifying 342
for pipe, elevation 392
for pipe, lengthen 396
for pipe, rotate 394
for plumbing lines, lengthen 710
for plumbing, rotate 709
for schematic lines, lengthen 804
lengthen 673
location 663, 824
location, moving pipe 387
location, moving plumbing lines 708
modifying labels for duct 361
modifying pipe 387
modifying plumbing lines and fittings 707
moving duct 342
overview 186
pipe, described 385
rotate 680
rotating duct parts 270
show all insertion points 648
tooltips 187
trigger grips 188
grooved connection
definition 1210
true wye 973
ground, definition 1210
grounded conductor, definition 1211
grounding conductor, definition 1211

H

hand wheel, definition 1211
handle, definition 1211
HANGER command 1192
hanger styles, configuring 1192
HANGERADD command 1194
HANGERANCHOR command 1194
HANGERCOPYSTYLEANDASSIGN command 1196
HANGERGRIPS command 1196
HANGERPROPS command 1196
HANGERROTATE command 1196
hangers 1192
adding 1194
displaying by elevation 223–224
modifying 1196
HANGERSTYLE command 1192
HANGERSTYLEEDIT command 1192
HANGERSUPPORTABOVE command 1196
HANGERSUPPORTBELOW command 1196
hatching, adding patterns to duct 238, 320
Hazen-Williams C-factor 716, 754
help
access 50
cache help 87
F1 help 87
menu 86
help resources 47
discussion groups 47
other 47
hidden lines
definition 1211
displaying
Options dialog 234
See also preferences, crossing display
Hide Part flag 1004
hiding parametric parts 1003
hierarchy of display control, described 217
home runs
adding 619
definition 1211
home tab 60, 63
hose bib, definition 1211
hub 1200
HVAC connector style 919
HVAC parts
adding 290
adding inline to duct 291
adding, described 290
changing elevation 265
changing systems 350
configuring for analysis 291

1244 | Index
connecting duct to 297
matching 348
modifying 347
modifying flow values 349
modifying location 346
rotating 270

I
I.D., definition 1211
ID, definition 1211
IFC classification 882
IfcShareBldgElements (MEP).dwg 883
images, preview 1031
import
   building component 123
import file formats
   ADSK file 123
   BDH file (.dat) 491–492
importing
   BDH file formats (.dat) 490
   duct system data 339
   label styles 825
   radiators 493
   schedule tables 877
in-line schematic symbols 774
in-line symbol, definition 1211
Industry Foundation Classes (IFC) 882
InfoCenter 85
initialization preferences
   AutoCAD MEP snaps 109
   catalogs 100
   connection rules 103
   content 100
   elevations 106
   layout rules 103
   part selection 105
   tooltip preferences 107
insert tab 64
insertion behaviors
   defining 991
   for block-based parts 1118
   for parametric parts 1003, 1094
   parametric fittings 1031
instant sizing
   adding duct by 292
deinition 1211
for duct, described 278
for duct, specifying a method 289
for wiring 523
insulation
   adding to pipe 464
   configuring for duct 286
   modifying 484
   modifying duct 360
insulation thickness, definition 1211
intelligent objects, described 43
interference detection 861–862, 865
Inventor 123
invert elevation
   calculation, definition 1212
   definition 1212
invert, definition 1211
isometric
   definition 1212
   line, definition 1212
   previewing pipe routing solutions 371
   riser, definition 1212
   snap, definition 1212
   views, of style-based content 127
isometric mode 776
planes 776
   schematic lines, adding 788
   schematic symbols, adding 791
isometric plane grips 807
isometric planes 776
isometric symbol
   definition 1212
   style, definition 1212
isoplane, definition 1212

J
JOIN command 34
joint direction
   examples 403
   male-female fittings and 403
   modifying for cut or merged pipe 481
   sloped piping 374, 426, 456
joints
  definition 1212
  pipe 405
junction box, definition 1212
JUNCTIONBOXMODIFY command 652
justification
  conduit (Properties palette) 532
  configuring for duct 279
  draw direction 160
  for cable trays 160
  for conduit duct 160
  for pipes 160, 438
  mirror objects 162
  offset, definition 1213
  offsetting pipe 460

K
K-factor, modifying for sprinklers 477
kickpipe, definition 1213

L
label curve properties
  dimension 833
  modifying style 832
label curve, definition 1213
label preferences 727
label style properties
  annotation 826
  general 826
  offset options 830
label styles
  importing 825
  modifying 825
  specifying as annotative 815
labels 832, 861
  adding 832
  adding duct 318
  adding to pipe 465
  configuring for conduit 561
  configuring for duct 286
  configuring for pipe 435
  definition 1213
  modifying 832

modifying duct 361
modifying for pipe 485
preferences, cable trays 557
preferences, conduits 557
rotating nodes 832
style properties
  styles
LABELSTYLEEDIT command 826
lateral, definition 1213
layer key 143
Layer Key property 1004
layer key styles
  definition 1213
  described 203
  selecting 965
  specifying for drawings 205
layer keying 205
  definition 1213
layer keys
  assigning to parts 1117
  described 203
  parametric parts 1003
layer management tools, definition 1213
Layer Manager 203
  definition 1213
layer standards
  definition 1213
  described 203
  selecting 965
  specifying for drawings 205
layers
  assigned to systems 143
  definition 1213
layout
  curve, definition 1213
  method, definition 1213
  mode, definition 1213
  preferences 99, 279, 560
  radiator MvPart 499
  radiators using calculated data 494
tabs, definition 1213
layout preferences
  cable tray 554
  conduit 554
duct 279
pipe 427
layout rules 103
leaders, definition 1213
length. See cut length
length, definition 1213
LENGTHEN command 34
lengthen grips 673
for duct 272
for pipe 396
for plumbing 710
Lengthen grips
for schematic 804
leaver, definition 1213
libraries
for style-based content 126
location of 100
LightingLoad property 326
LIGHTINGMODIFY command 652
line
annotation, definition 1214
cleanup, definition 1214
LINE command 734
lines, converting to duct 313
lining
configuring for duct 286
modifying for duct 360
thickness, definition 1214
load
calculations, specifying data for 326
diagram, definition 1214
LOADCATEGORYDEFINITIONS
command 536
LOADMETRICCMDS command 1191
location
connection details 174
definition 1214
worksheet 531
location grips 663
for moving duct 342
for moving pipe 387
for moving plumbing lines 708
labels 824
locking
conduit elevation 531
duct elevation 275, 309
duct size 352
fitting size 352
pipe elevation 409

M
male-female fittings
connector behavior 974
joint direction 403, 426
manage tab 67
managing demand load 646
mass element to MvPart 1110
match command 163
match lines, definition 1214
matching MEP object properties 163
matching MvParts for piping 477
matching part properties
devices 169
flex pipe 166
MvPart 168
pipe fitting 167
plumbing fittings 168
plumbing lines 168
schematic lines 168
schematic symbols 168
MATCHPROP command 35
material, definition 1214
mechanical - duct - 1 line display
configuration 215
mechanical - duct - 2 line display
configuration 215
mechanical - pipe by size display
configuration 215
mechanical display configuration 215
mechanical joint
creating parametric fittings 974
creating parametric parts 974
female connectors 995
mechanical parts 110
MEMBERSTYLEWIZARD command 1192
MEP Basic 2-Line display
configuration 215
MEP Catalogs tab 100
MEP Design display configuration 215
MEP Elevations tab 106
MEP Layout Rules tab 103, 105
MEP Presentation display
configuration 215

Index | 1247
MEP Schematic Equipment display configuration 215
merging
cable trays and conduits 677
duct 352
joint direction (pipe) 481
pipe manually 480
metric profile 1191
Microsoft Excel, working with part data 1163
midplane extrusion modifier 986
MIRROR command 35
mirrored ducts 162
mode, definition 1214
model
definition 1214
dimensions 981
parameters 993
model blocks
block-based parts 1114
layer assignments 1114
model display representation 211
Model drawing template 241
model screened display representation 211
model space
creating views 846
definition 1214
using 94
model tab 94
modeling
block-based parts 1113
parametric fittings 1011
parametric MvParts 1045, 1074
parametric parts 976
parametric tee fittings 1014
taps 1072
tips for parametric parts 971
modifiers
applying to parametric MvParts 1064
extrusion 1014
parametric parts 986
types of 986
modifying
block-based parts 1141
connected objects 174
custom equipment 1141–1145
label spacing 833
label styles 825
labels 832
object property sets 837
parametric parts 1107
run 174
selecting pipe 157
selecting schematic lines 157
modifying duct
breaking segments 352
changing length with grips 272
changing systems 352
checking connectivity 361
custom fittings 358
described 341, 350
fittings 354
flexible duct layout 356
grips 342
insulation 360
labels 361
lining 360
locking size 352
merging segments 352
moving off-center takeoffs 357
moving with grips 342
rotating with grips 270
selecting components 157
size or shape 350
specifying ASHRAE fittings 336
turning vanes 358
with elevation grips 265
modifying pipe
breaking 480
changing flow direction 190
changing systems 482
checking connectivity 484
described 466, 478
elevation 392
fittings 483
flow arrows 485
grips 387
labels 485
length 396
locking size 482
plumbing, modifying 739
rise/drop 916
rotating piping components 394
See also electrical equipment

N
N.D., definition 1215
name, definition 1215
network
definition 1215
plumbing 699
nodes
anchor, definition 1215
definition 1215
label, rotating 832
nominal size
conduit 530, 1215
connection details 174
definition 1215
modifying run 175
pipe 421, 467, 478
north arrow, definition 1215

O
O.D., definition 1215
object display
by classification 239
See also display system
object enablers 879
definition 1215
using 879
object match. See matching part properties
object properties window 193
object snaps
comparison to AutoCAD MEP
snaps 107
definition 1215
object tools 1178
objects 152
anchor, definition 1215
anchoring 176, 181
annotative, defined 815
connectors, working with 171
definition 1215
properties of 193
purging 878
type, definition 1215
types of 154, 156
viewer, definition 1215
Occupancy property 326
occupancy type 729, 740
off center, definition 1216
off-the-shelf parts, definition 1216
offset
conduit 532
definition 1216
work planes 979
OFFSET command 36
offset wyes (laterals) 973
offsetting
duct from geometry 308
pipe from geometry 460
Open drawing menu 211
opening symbol, definition 1216
operations. See modifiers
Options dialog 99–100, 110
options for parametric parts 1002
orbit, definition 1216
orthogonal
definition 1216
projection, definition 1216
orthographic grips 806
orthographic mode 775
schematic lines, adding 783, 796
schematic symbols, adding 785
orthographic views of style-based content 127
other circuit system type 519
OTHERPOWERMODIFY command 652
outlines of parts 985
OutsideAirFlow property 326
OVALDUCTCENTERLINE command 236
over current, definition 1216
overloads
checking circuits 641
override default plumbing fittings 735
overriding default parts during layout 448
overriding preferences 448
P

package unit, definition  1216
PANEL command  521
panel schedules
  generating  683
panel styles
  connectors  549
  creating  891
  design rules  548
  wire cleanup  548
PANELADD command  596
PANELADDSELECTED command  596
panelboard, definition  1216
PANELMODIFY command  648
PANELPROPS command  660
panels
  adding  596
  adding, example  604
  connecting across drawings  568
  connecting with wires  619
  connector style properties  549
  copying  605
  copying, example  609
  creating  891
  defining style views  899
  display representations  521
  matching part properties  165
  modifying properties  660
  moving  648
  moving, example  651
  name, definition  1216
  overview  521
  styles, specifying wire cleanup  896
  tools  1179
PANELSTYLE command  547
PANELSTYLEEDIT command  547
paper space
  definition  1216
  using  94
parallel bends  532, 635
parallel runs  150
  conduit, adding  632
  conduit, changes to segments  637
  conduit, concentric radius  636
  conduit, fixed radius  637
  conflicts with conduit  637
  definition  1216
  duct, adding offsets  307
  pipe, adding offsets  459
  pipe, adding to radiators  506
PARALLELROUTING command  506, 632
parameters
  definition  1217
  model  993
parametric fittings
  connectors, adding  1019
  creating  1009
  defining work planes for  1012
  dimensions, adding  1026
  insertion behaviors  1031
  modeling  1011
  modeling parametric tee
    fittings  1014
  part sizes, adding  1029
  preview images  1031
  rule for creating  972
  saving  1035
  specifying configuration  1010
  starting Content Builder  1009
  validating  1035
  workflow for creating with Content
    Builder  1007
parametric MvParts
  adding connectors  1074, 1080
  adding constraints  1062
  adding dimensions  1081, 1084,
    1086
  adding part sizes  1088–1089, 1091
  applying  1064
  configurations  1043–1045
  creating  1040
  creating face geometry  1060
  insertion behaviors  1094
  modeling  1045–1074
  starting Content Builder  1042
  validating and saving  1095
  work planes  1046
  workflow for creating with Content
    Builder  1040
Parametric Part wizard  1037
parametric parts
  building environment 960
  configuration 975–976
  connectors 994
  constraints 983
  creating 970–1009
  creating using a wizard 1037
  defined 957
  dimensions 981
  geometry 980
  hiding 1003
  insertion behaviors 991
  modeling 976–994
  modifiers 986
  modifying 1107
  parameters, non-graphical 998
  part preview 1001
  preview image and options 1002
  preview images 1093
  profiles 985
  schematic symbols 1098
  schematic symbols for 1005
  sizes 996
  sizes, copying and pasting 999
  sizes, for connectors 999
  sizes, for pipe connectors 1001
  sizing 957
  tips for creating 971
  parametric, definition 1217
part catalogs
  browser, user-interface controls 969
  definition 1217
  location 44
  migrate 1167
  pipes 381
  redefine parts 1168
  regenerating 1165
  validating 1164
  See also catalogs
  part categories 1116
part data
  basic tables 1156
  calculations 1157
  definition 1217
  modifying 1156
  stored as constants 1157
  table view 1156
  tree view 1155
  part description 976
  part domain 976
  part families 970
  behavior 1116
  definition 1217
  selecting in Catalog Editor 1155–1156
  part group definition 284, 558
  part models, creating with
    primitives 1048
  part number tags 838–839
    adding 839
  part preview, of parametric parts 1001
  part properties
    anchor 181
    definition 1217
    details 197
    devices, matching 169
    dialog box 193
    fixture units 713
    flex pipe, matching 166
    flow annotation 348
    general 193
    home run 1211
    justification/offset 1213
    length 1213
    lining thickness 1214
    location 198
    MvPart, matching 168
    pipe fitting, matching 167
    plumbing fittings, matching 168
    plumbing line sizing
      calculations 714
    plumbing lines, matching 168
    schematic lines, matching 168
    schematic symbols, matching 168
    style 195
    style name 1222
    system 1223
    systems connections 195
    takeoff position 355
    vanes 358
    part selection preferences 105
part size names
  assigning to MvParts 1133
  changing block-based parts 1144
  part, definition 1217
part size not found 318
part sizes 119
  adding in Catalog Editor 1158
  adding to parametric fittings 1029
  adding to parametric MvParts 1088–1089, 1091
  definition 1217
  parameter attributes 121
  parameter storage types 122
part subtypes 976, 1117
  modify 680
part tables
  basic 122
  calculations 122
  constant lists 122
  constants 122
part types 381, 976, 1116
parts
  block-based. See block-based parts
catalogs 115–122
  creating and modifying 966
  creating catalogs 1161
  creating in Catalog Editor 1158
  definition 1217
  fixed size 959
  in Catalog Editor, definition 1217
  overview 119
  parametric, creating 1037
  parametric. See parametric parts
  part sizes 119
  properties of 193
  selecting from catalogs 117
  types of 154–156
  validating 1164
See also objects
parts tab 558
Parts tab 284
path angle 983
  for conduit fitting 529
  definition 1217
  for Content Builer, definition 1217
path modifier 987
patterns
  adding hatching to duct 238, 320
  cable tray 557
  perspectives, definition 1217
  phase type, definition 1217
  pigtai, definition 1217
pipe
  1-line display 377
  2-line display 377
  annotating, described 465
  autolayout, described 370
  centerlines 160, 371, 392, 395, 429, 438, 448, 454, 460, 462–463, 472, 481
  checking connectivity 484
  choosing part 447
  connection details 172
  connection types, described 401
  connections (male-female) 403
  connections, described 399
  connector behavior 974
  connectors, described 399
  defining rise/drop styles 914
  described 365
  display configurations 215
  displaying by elevation 223–224
  gravity 367–368, 375, 429
  grips, described 385
  joint direction 403
  joints 405
  justification 160
  lengths, described 406
  matching part properties 167
  modifying run 174
  overriding default parts 448
  part catalog, described 381
  part types 381
  pressure 367–368, 429
  routing preferences, described 367
  settings for flexible pipe 457
  settings, described 411
  sloped 373
  straight centerline display 380, 419
  system definitions 414
  systems 365

Index | 1253
tool palette pressure 429 
tool palette, gravity 429 
using flow direction 190 
waste 375 
See also adding pipe 
See also configuring pipe 
pipe CEL, described 404 
PIPE command 365 
pipe connection types 401 
Pipe connector style 919 
pipe fitting displaying by elevation 223–224 
pipe fittings adding 452 
connection details 172 
create custom 454 
locking size 482 
matching part properties 167 
modifying 483 
modifying elevation 392 
modifying insulation 484 
rotating 394 
pipe joints adding 452 
pipe layout preferences 427 
adding annotation 435 
adding insulation 464 
configuring justification 438 
pipe part routing preferences described 367 
See also routing preferences 
pipe parts catalog 381 
pipe settings 411 
pipe snaps described 409 
pipe systems 
1-line placeholders 381 
checking connectivity 484 
described 365 
pipe, connection type (same) 402, 975 
pipe, connection types 972 
PIPEADD command 429 
PIPEADDSELECTED command 429 
PIPECONVERT command 429 
PIPECUSTOMFITTING command 454 
PIPECUSTOMFITTINGPROPS command 454 
PIPECUSTOMFITTINGSTYLE command 454 
PIPECUSTOMFITTINGSTYLEEDIT command 454 
PIPEFITTING command 452 
PIPEFITTINGADD command 452 
PIPEFITTINGADDNEW command 452 
PIPEFITTINGADDSELECTED command 452 
PIPEFITTINGMODIFY command 483 
PIPEFITTINGPROPS command 483 
PIPEFITTINGSTYLEEDIT command 483 
PIPEFLEX command 457 
PIPEFLEXADD command 457 
PIPEFLEXADDSELECTED command 429 
PIPEFLEXCONVERT command 466 
PIPEFLEXMODIFY command 483 
PIPEFLEXPROPS command 483 
PIPEFLEXSTYLEEDIT command 483 
PIPELENGTH command 480 
PIPEMODIFY command 478 
PIPEPREFDEF command 411 
PIPEPROPS command 197 
PIPERISEDROPSTYLE command 914 
PESLOPEDISPLAY command 375 
PIPSYSTEMDEF command 414 
PIPESYSTEMDEFEDIT command 414 
PIPESYTLEDIT command 896 
piping. See pipe 
placeholders for pipe 381 
placement point 
parametric fittings 1031 
parametric parts 993 
plain end, see spigot/plain end 1222 
plan 
display representation 211 
high detail display representation 211 
low detail display representation 211 
presentation display representation 211 
screened display representation 211 
view, definition 1217
plane extrusion modifier 986
planes. See UCS planes and work planes
plenum, definition 1218
PLINE command 734
plotting
   configurations 881
   plot preview 881
   plot styles 881
plumbing
   adding expansion loops 738
   calculating sanitary plumbing line
      sizes 760–770
   calculating supply line sizes 750–760
   content, creating 716
   design workflow 697
   display configuration 215
   equipment, adding 728
   equipment, described 110
   equipment, modifying 739
   fixture unit table definitions 720
   fixtures, adding 728
   fixtures, described 110
   fixtures, modifying 739
   plumbing line sizing tables 714, 721
   plumbing line, calculating slope 741
   preferences 727
   systems, configuring label and flow
      arrows
   systems, configuring settings
   systems, creating 728–738
   systems, modifying 739–750
plumbing fitting styles
   described 722
   subtype 724
   type 724
plumbing fittings
   adding manually 737
   defining style views 899
   definition 1218
   described 700
   matching part properties 168
   modifying location 748
   modifying style 749
   modifying system 746
   overriding default fittings 735
   rotating 709
   styles, described 722
   styles, specifying line cleanup 896
   plumbing line sizing calculation
      results 714
   plumbing line sizing tables 714, 721
   plumbing line styles
      annotation properties 722
      described 722
      standard sizes 724
plumbing lines
   adding expansion loops 738
   adding fittings manually 737
   annotation properties for styles 722
   break/overlap paper width 722
   breaking 737
   cleaning up 896
   connecting lines at different
      elevations 734
   creating from polylines 734
   described 699
   drawing from equipment 730
   drawing from fixtures 730
   drawing run 733
   elevation mismatch 734
   matching part properties 168
   modifying elevation 747
   modifying location 748
   modifying size 749
   modifying style 749
   modifying system 746
   overriding default fittings 735
   plumbing preferences 727
   reversing flow 747
   sanitary systems, sizing 760–770
   standard sizes for styles 724
   styles, described 722
   subtypes 724
   supply systems, sizing 750–760
   types 724
plumbing system definitions
   black water 718
   creating 717
   described 700
   gray water 718
   specifying default fittings 718

Index | 1255
POLUMBINGFITTING command 700
POLUMBINGFITTINGADD command 737
POLUMBINGFITTINGADDSSELECTED
POCMMAND 737
POLUMBINGFITTBREAKPIPE
COMMMAND 737
POLUMBINGFITTMODIFY
COMMCMAND 746
POLUMBINGFITTINGPROPS
COMMCMAND 197
POLUMBINGFITTINGSTYLE
COMMCMAND 749
POLUMBINGFITTINGSTYLEEDIT
COMMCMAND 749
POLUMBINGLINE command 699
POLUMBINGLINEADD command 728
POLUMBINGLINEADDSSELECTED
COMMCMAND 728
POLLUMBINGLINECONVER
COMMCMAND 734
POLUMBINGLINEINVERTELEVATION
COMMCMAND 747
POLUMBINGLINEMODIFY
COMMCMAND 707, 746
POLUMBINGLINEPROPS command 197
POLUMBINGLINESIZE command 750,
764
POLUMBINGLINESIZESANITARY
COMMCMAND 764
POLUMBINGLINESIZESUPPLY
COMMCMAND 750
POLUMBINGLINESTYLE command 722
POLUMBINGLINESTYLEEDIT
COMMCMAND 722
POLUMBINGPREFERENCES
COMMCMAND 727
POLUMBINGRISEDROPSTYLE
COMMCMAND 145
POLUMBINGSYSTEMDEF command 717
POLUMBINGSYSTEMDEFEDIT
COMMCMAND 717
pneumatic, definition 1218
point style 1009
polylines
converting to flex pipe 466
converting to flexible duct 313
converting to plumbing lines 734
converting to schematic lines 796
power and lighting circuit system
type 519
power totals, calculating 644
POWERTOTALS command 644
preferences
annotation, cable trays 557
annotation, conduits 557
AutoCAD MEP snaps 109
catalogs 100
circuit names 539
configuring duct layout 279
configuring pipe part routing 367
connection rules 103
content 100
creating pipe part routing 411
default parts 122
drawing 99
drawing environment 99, 110
electrical
elevations 106
flexible duct 283
flexible pipe 457
flow arrows 727
initialization 110
initialization, defined 99
labels 727
layout 99
layout rules 103
layout, defined 99
modifying pipe part routing
preferences 412
part selection 105
pipe, overriding 448
pipe, routing 367
plumbing lines 727
styles
tooltips 107
voltages 538
pressure
drop, definition 1218
pressure pipe 367–368

| Index | 1256 |
pressure-reduction valve,
definition 1218

preview images
  bitmap resolution 1122
  block-based parts 1121, 1135
  changing for block-based parts 1144
  parametric fittings 1031
  parametric parts 1002, 1093

primitives
  creating 1056
  defined 990
  definition 1218
  using for part models 1048

product feedback 47

profiles
  creating 1171
  Global 1191, 1197
  metric 1191
  parametric parts 985
  radiators (D A CH) 491
  types of 985
  U.K. 1197

Project Browser 45

project database
  referencing 568
  See electrical project database

project management tools 45
Project Navigator 45, 85

project setup, modifying display settings 218

Project Standards feature 203

projects
  Drawing Management feature 199
  establishing standards 201
  Project Standards feature 203
  standards, displays 208
  standards, layers 203
  standards, templates 201
  standards, xrefs 245

properties
  accessing 193
  dialog box 193
  label curve
    part 193
  style-based content 893

Properties palette 77, 135
  advanced 534
  basic 528
  conduit 528, 534
  display tab 136
  docking 136
  hiding 137
  modifying appearance 136
  opening 135
  pipe 420, 466
  transparency 137

property set information, adding to parts 1139

property sets
  block-based parts 1124
  definitions 875
  electrical devices 687
  modifying for an object 837
  proxy graphics 879
  PSLTSCALE system variable 821

publishing sheet sets to DWF 860

purge
  AutoCAD MEP objects 878
  systems 149

PURGE command 36

Q

querying
  catalogs 115
  part properties 193
  quick access toolbar 75
  Quick Select
    definition 1218
    for pipe 157
    for plumbing lines 157
    for schematic lines 157
    quick slice, definition 1218

R

raceway, definition 1218

radiator
  adding radiators to drawing 497
  adding value to radiator 501
connecting multiple radiators to parallel pipes 510
connecting target radiators to parallel pipes 511
correcting radiator connection failure 512
creating custom parts 494
creating parallel pipes 506
exporting drawing information 495
routing parallel to baseline pipe 506
rules for existing radiators 495
using connectors to align
MvParts 503
radius (concentric or fixed) parallel bends 635–637
Properties palette 532
radius factor 424
radius of curvature
definition 1218
properties palette (for conduit fitting) 530
RECEPTACLEMODIFY command 652
RECTANGULARDUCTCENTERLINE command 236
reducer, definition 1218
reference work planes 979
REFERENCEANCHORRELEASE command 180
REFERENCEANCHORSETREF command 178
referenced drawings. See xrefs
referencing style-based content 126
reflected display representation 211
regenerate
AutoCAD MEP model 193
catalog 1165
definition 1218
relationships of geometric features. See constraints
reloading project database 566
representation sets, definition 1218
reseller information 46
ReturnAirFlow property 326
reverse flow
definition 1218
plumbing lines 747
REVERSESEGMENT command 190
revision clouds, definition 1218
ribbon 48, 56
contextual tabs 68
displaying 56
locating commands 60
resources 62
static tabs 62
using 57
rise angles 713
rise/drop
creating blocks for symbols 913
elbows 916
endcaps 916
MvParts 916
specifying for a system 145
styles 911, 914
takeoffs 916
See also styles and systems
rise/run
cable tray and conduits 628
cable tray and conduit 627
definition 1219
pipe 373, 423, 434, 455
riser
add from fixture to plumbing line 735
add to connecting plumbing line 735
cable tray and conduit 627
definition 1219
diagram, definition 1219
objects, definition 1219
riser diagram, definition 1212
rod style 1192
ROTATE command 37
rotate grips 680
for duct 270
for pipe 394
for plumbing fittings 709
ROTATE3D command 37
rotating label nodes 832
rotation
definition 1219
fittings 532
1258 | Index
ROUNDDUCTCENTERLINE command 236
routing preferences
changing 478
conduit 526
conduit (Properties palette) 531
configuring for conduit 527
configuring for pipe 367, 412
creating 411, 528
definition 1219
deleting from drawing 414, 528
described 367
gravity pipe 367–368
modifying run 175
overriding parts 448
parallel pipe 508
pipe 467
pipe (properties palette) 421
pressure pipe 367–368
sloped piping support 367–368
routing solutions for pipe 371
3D orbit 371
constrained layout 372
isometric 371
preview and accept solution 450
preview layouts 371
routing, definition 1219
rules
connector behavior 974
creating parametric fittings
content 972
run angles 713
runs
checking connection validity of 643, 861, 864–865
definition 1219
plumbing, defined 699
See also cable trays and conduits

sanitary plumbing line sizing tables 714, 721
sanitary plumbing lines
plumbing line sizing table definitions 714, 721
plumbing line sizing tables 750
sizing 760–770
sizing by branch 761
sizing by offset 762
sizing by stack 764
sizing for multiple floors 765
sanitary, definition 1219
SANIPESIZINGTABLEDEF command 714, 721
saving
parametric fittings 1035
parametric MvParts 1095
style-based content 126
SCALE command 37
scale representations
adding 823
modifying 823
scale, definition 1219
scaling annotation 815
scaling symbols
by reference 810
by scale factor 809
using grips 811
schedule tables
creating property sets for 875
defining schedule data for 876
definition 1219
importing 877
schedule tag, definition 1220
schedules 842
adding to a drawing 842
circuit reports, creating 642
creating 874
defining data 876
definition 1219
exporting as spreadsheet 845
for external drawings 843
updating 844
scheduling, definition 1220
Schematic connector style 919
schematic content, creating 777

S
sales information 46
same connection 402, 975
Sample Palette catalogs 1174
sampling circuit, definition 1219
sand filter, definition 1219
schematic design phase, definition 1220
schematic diagrams
    creating
        described 771
        isometric mode 776
        modifying 797–812
        orthographic mode 775
schematic display representation 211
schematic line styles
    annotation properties 780
    configuring 778
    described 778
    designation IDs 779
schematic lines
    adding, isometric mode 788
    adding, orthographic mode 783, 796
    Break/Overlap Paper Width property 780
    cleaning up 896
    connecting to symbols 772, 774
    converting from polylines 796
    designation IDs, assigning 783, 788, 796
    designation IDs, modifying 797
    location, modifying 800
    matching part properties 168
    modifying 797
    styles, assigning 783, 788, 796
    systems, assigning 772, 783, 788, 796
    systems, modifying 797
schematic screened display representation 211
schematic symbols 774
    adding, isometric mode 791
    adding, orthographic mode 785
    AutoCAD-based, creating from blocks 1104
    AutoCAD-based, creating from scratch 1103
    AutoCAD-based, creating from symbols 1104
    block-based parts 1115
    connecting to lines 772
    creating 891
    creating for block-based parts 1129
    defining style views 903
    end-of-line 774
    for parametric parts 1005
    grips, isometric plane 807
    grips, location 806–807
    grips, orthographic 806
    grips, rotation 806–807
    ID labels, assigning 785, 788
    ID labels, modifying 798
    in-line 774
    location, modifying 803
    matching part properties 168
    modifying 798
    parametric, annotating 1106
    parametric, creating 1098
    repositioning using grips 806–807
    resizing, modifying 809
    rotating, modifying 806
    scaling by reference 810
    scaling by scale factor 809
    scaling with grips 811
    styles, assigning 785, 791
    styles, creating from blocks 940, 943
    styles, specifying line cleanup 896
    systems, assigning 772, 785, 791
    systems, modifying 798
    types 1006
    types for parametric parts 1098
    using in 1-line display representations 1004
    using in 2-line display representations 1004
schematic system definitions,
    creating 777
schematic systems. See schematic diagrams
schematic, definition 1220
section
    definition 1220
    mark, definition 1220
section view drawings
    creating 848
    updating 856
SECURITYMODIFY command 652
see bell/hub 1200
segment
  definition 1220
  mode, definition 1220

select classification 887

select connected branches
  using with pipe 157
  using with plumbing lines 157
  using with schematic lines 157

select device 577
select panel 596
select similar 157
  using with pipe 157
  using with plumbing lines 157
  using with schematic lines 157
select style 888
selecting
  duct components 157
  pipe components 157
  plumbing components 157
  schematic components 157
selecting layer key styles 965
selecting layer standards 965

service
  disconnect, definition 1220
  drop, definition 1220
  entrance, definition 1220
  equipment, definition 1220
  lateral, definition 1221
  panel, definition 1221

service/supply leads, definition 1221

SETACTIVERP command 411
SETFLOW command 190

settings, pipe 411
shape, definition 1221
Sheet drawing template 241
sheet list tables, adding to sheets 859
sheet tabs 94

sheets
  creating 857
  creating a cover 859
  ordering in sheet set 859
  publishing to DWF 860

show all insertion points grip 648
SHOWCIRCUITS command 643
SHOWFLOW command 190

SHOWOBJECTSLIMITINGRUN command 753

size parameters
  define for parametric part 996
  single line drawing, definition 1221
  single line graphics 415, 417
  single pole, definition 1221
size parameters
  define part size for model 996
  definition 1221
  for conduit content 998
  modes 997
  non-graphical 998
size ranges
  for pipe routing preferences 369
sizes
  adding to parametric MvParts 1081
  copying and pasting 999
  definition 1221
  of parametric parts 957, 996
  specifying for connectors 999
  specifying for pipe connectors 1001

sizing duct with external tools 336
sizing methods for duct 275
sizing tools for duct 277
slice, definition 1221
SLINE command 782
SLINEADD command 782–783, 796
SLINEADDSELECTED command 782
SLINEPROPS command 797
SLINESTYLE command 778
SLINESTYLEEDIT command 778

slope 713
  adjust for pipe segment, definition 1199
  angle displayed in drawing 375
  arrow labels, definition 1221
  conduit, adding 533, 628
  configuring for conduit 560
  configuring for duct 280
duct, adding 308ormat (conduit) 533
format (pipe) 422, 468
pipe, adding 423, 468
plumbing line 735
sloped piping
  autolayout 374
definition 373
fitting tolerance 374
joint direction 374
wyes and angled tees 374
slots, definition 1221
snap angle, definition 1221
snap grid, definition 1221
snap mode, definition 1222
snaps
definition 1222
description 107
duct, described 264
electrical 523
entering 107
for pipe 409
wire ways 523
socket weld, definition 1222
socket welded, definition 1222
SOLAR COMPUTER Desktop 490, 492–493, 495
solid to MvPart 1110
solution tips 92
  applying 862
definition 1222
  marker size 862
  radiator connection failure 512
SOLUTIONTIPICONSIZE command 862
SOLUTIONTIPS command 862
SOLUTIONTIPSTOGGLE command 862
space boundaries for radiators 493
SpaceEngineeringObjects property 326
spaces, adding engineering data to 326
spatial interferences
definition 1222
  See also interference detection
specifying pipe parts manually 447
spigot/plain end, definition 1222
spline
  flexible duct 260
  flexible duct, modify 356
spline, definition 1222
spreadsheets
  exporting schedules as 845
working with part data 1163
sprinklers, modifying K-factor 477
SYSTEMDEF command 777
SYSTEMDEFEDIT command 777
standard display configuration 215
standard sizes for plumbing line
  styles 724
standards
  fixture unit table definitions 720
  plumbing line sizing tables 714, 721
  See also projects
static ribbon tabs 62
Stock Tool catalog 1183
storage types
custom data 1160
definition 1222
  selecting in Catalog Editor 1156
storing style-based content 126
straight centerline display 380
STRETCH command 38
style definitions 126
Style Manager
definition 1222
  IFC classification 885
style name, definition 1222
style properties
  connector rules 862
  connectors 171, 549, 906
  connectors, plumbing 725
design rules 896
display 908
general 826, 910
label annotation 826
label curve 832
label offset 830
plumbing line cleanup 896
schematic line cleanup 896
views 898
wire cleanup 896
wire specification 550
style-based content
categorizing
  copying between drawings 911
  creating 891
  creating, plumbing 716
  creating, schematic 777
customizable 892
defined 891
editing 896
electrical 124
overview 124–128
storing and referencing 100, 126
style-level overrides, applying 221
style, selecting 888
styles
connector 919
copying between drawings 911
definition 1223
electrical objects 896
file locations 1172
hanger 1192
labels 825
layout method 534
mechanical objects 896
plumbing objects 896
rise/drop 914
schematic 896
See also schematic line styles
See also plumbing fitting styles
See also plumbing line styles
subscription program 47
subtype, definition 1223
supply air, definition 1223
supply duct, definition 1223
supply plumbing line sizing tables 714, 721
supply plumbing lines
  plumbing line sizing tables 714, 721, 750
  sizing 750–760
SupplyAirFlow property 326
SUPPLYPIPESIZINGTABLEDEF command 714, 721
support file locations 1172
surface height (default), definition 1223
switch-leg, definition 1223
SWITCHMODIFY command 652
Symbol and Annotation plane 1005
symbol blocks 1115
display control 1115
file locations 1115
SYMBOL command 782
symbol conversion scripts. See conversion scripts
symbol library, definition 1223
SYMBOLADD command 782
SYMBOLADDSELECTED command 782
SYMBOLPROPS command 798
system abbreviation, definition 1223
system definitions
  changing for duct 352
  changing for HVAC parts 350
  configuring for duct 288
  creating for pipe 414
  creating, electrical 534
  creating, schematic 777
  duct, creating 288
  for duct 258
  for pipe 376
  for piping MvParts 478
See also plumbing system definitions
system groups
  definition 1223
  overview 140
  specifying 143
system label, definition 1223
system types
  definition 1223
  for circuits 519
  for systems 143
system-level overrides, applying 220
systems
  assigning layers 143
  assignments for connections 195
  connecting 141
  copying 148
  defining 141, 148
  definition 1223
  display properties 146
  mechanical default parts 122
  modifying run 175
  notes and files 147
  predefined 138
  purging 149
  specifying rise/drop styles for 145
  system types, electrical 143
  system types, plumbing 143
  working with 138, 149

Index | 1263
See also plumbing system definitions
systems definitions
for pipe 414

T

tabs
contextual ribbon 68
model 94
sheets 94
static ribbon 62
work 94
tags
adding 835
described 835
electrical devices 687
part number 838
TAKEOFFCENTERLINE command 236
takeoffs
adding 263, 310
adding to pipe 462
configuring for duct 285
off-center, moving 357
position 355
rise/drop 916
tangent, definition 1223
taps
modeling 1072
See also takeoffs
technical support 46

tees
configuring for duct 285
definition 1223
modeling parametric 1014
sloped piping 374
templates 201, 241
creating from drawings 243
creating from other templates 243
creating from scratch 244
defaults 241
definition 1223
terminals, definition 1223
testing
connectors 1148
display representations of parts 1148
parts 1148
view blocks 1149
See also troubleshooting
text styles 815
therm, definition 1223
threaded, definition 1224
tick marks
flipping 667
moving 666
tips for creating block-based parts 1113
title marks, definition 1224
TOGGLEFLOW command 190
tool palette groups
changing 130
tool palettes 77
creating 1174
creating a tool palette set 1175
customizing 1174–1177
modifying appearance 133
renaming the tool palette set 1176
specifying for a profile 129
using 129
See also tool palettes set
Tool Palettes File Locations setting 129
tool palettes sets
adjusting transparency 132
changing palette group 130
creating 1175
described 129
docking 131
hiding 132
modifying appearance 131
modifying included palettes 1177
opening 130
renaming 1176–1177
switching 1177
tools
changing images for icons 1187
changing properties 1185
creating for commands 1183
creating for devices 1179
creating for panels 1179
creating for wires 1179
creating from AEC Content 1182
customizing 1178–1189
deleting 1188
described 1178
for analysis 45
for project management 45
modifying appearance 133
types 1178
unspecified part 1185
tools for creating 891
tooltips 87
command tooltips 88
dialog tooltips 89
extended tooltips 88
object grip tooltips 94
object rollover tooltips 90
palette tooltips 89
property tooltips 90
solution tips 92
thumbnail previews 91
turning on and off 88
tooltips, definition 1224
transition fittings, definition 1224
transition modifier 988
transparency 132, 137
TRAYDATA command 1197
TRAYDATAREGENSYSTEM command 1197
TRAYDATAROTATE command 1197
trigger grips 188
TRIM command 38
trim lengths
parametric fittings 1031
parametric parts 992
trip lever, definition 1224
troubleshooting
connection 861
drawings 861
interference 861
trunk, definition 1224
turning vanes. See vanes tutorials 62
type, definition 1224

U

U.K. profile 1197
UCS planes, changing 183
UCS, problems with 971
unconstrained layout, definition 1224
unspecified part 1185
updating views 856
user profiles, creating 1171
UV filter system, definition 1224

V

valid connection. See connection
validating
parametric fittings 1035
parametric MvParts 1095
vanes
adding to duct 314
configuring display 282
definition 1224
modifying 358
vertex
definition 1224
flexible duct (spline) 356
x, definition 1224
y, definition 1224
vertical duct, drawing 299
vertical pipe
adding 444
connecting to 409
view blocks
assigning to display representations 1120
assigning to MvParts 1133
block-based parts 1119
default assignments 1120
insertion point 1120
testing 1149
view tab 66
viewports, definition 1224
views
adding a detail view 847
adding a general view 846
adding a section view 848
adding an elevation view 852
definition 1224
for construction documents 845
style properties 898
style-based content 127
See also display system

Index | 1265
voltage
  configuring  538

W

water hammer
  arrestor, definition  1225
definition  1225
WCS, definition  1225
where is my command? tool  60
wire cleanup
  device styles  541
  panel styles  548
WIRE command  522
wire segment types
  arc  611
  chamfer  611
  line  611
  polyline  611
  snake  611
  spline  611
wire style properties
  annotation  551
  specifications  550
wire ways snaps  523
  adding cable tray or conduit  632
WIREADD command  611
WIREADDSELECTED command  611
WIRECONVERT command  620
WIREPROPS command  197
wires
  adding home runs  611, 619
  adding manually  611
  adding, example  617
  annotation  551
  break/overlap paper width  551
  checking sizes for circuits  640
  cleaning up  896
  converting from arcs  620
  converting from lines  620
  converting from polylines  620
  generating  611
  instant sizing  523
  matching part properties  165
  modifying layouts  663
  modifying properties  664
See also wire segment types
tick marks, flipping  667
tick marks, moving  666
tools  1179
wire sizes, modifying  664
wire sizes, specifying  611
WIRESTYLE command  549
WIRESTYLEEDIT command  549
wizard, for creating parametric parts  1037
work planes  977
  adding preset  978
  defining for parametric fittings  1012
  offset  979
  parametric MvParts  1046
  reference  979
  restrictions  978
work planes, definition  1225
work tab  94
workflow
  AutoCAD MEP  42
  construction documents  813
  creating radiator pipework  504
  creating radiator systems overview  489
  definition  1225
  placing radiators in drawing  492
working with
  anchors  176, 181
  objects  152
  systems  138
workspaces
  application menu  70
  application status bar  81
  command window  81
  communication center  87
  components  55
  context menus  76
  creating  53
  defaults  52
  drawing window status bar  78
  fundamentals  51
  InfoCenter  85
  overview  49
  Project Navigator palette  85
  Properties palette  77
quick access toolbar 75
ribbon 56
switching 53
tool palettes 77
tooltips 87
  command tooltips 88
dialog tooltips 89
  extended tooltips 88
  object grip tooltips 94
  object rollover tooltips 90
  palette tooltips 89
  property tooltips 90
  solution tips 92
  thumbnail previews 91
  turning on and off 88
wye, definition 1225
wyes, sloped piping 374

X
  XCLIP command 248
  XML, definition 1225
  xrefs
    attaching 246
    changing display configurations 250
    clipping 248
    connecting ducts with 262, 310
    definition 1225
    described 245
    overlaying 246
    reloading 247
    types, described 245
  xrefs. See bend angle
  XY angle, definition 1225

Z
  zone, definition 1225